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FOREWORD 
 
This manual is one of a series of protocols and manuals of operation for the Jackson Heart Study 
(JHS).  The complexity of the JHS requires that a sizeable number of procedures be described, thus 
this rather extensive list of materials has been organized into the set of manuals listed below.  Manual 
1 provides the background, organization, and general objectives of the JHS Study.  Manuals 2 and 10 
describe the operation of the Cohort and Surveillance Components of the study.  Detailed Manuals of 
Operation for specific procedures, including those of reading centers and central laboratories, make 
up Manuals 3 through 9 and 11. 
 
 

JHS Study Protocols and Manuals of Operation 
 
 

MANUAL TITLE 
  
1 General Description and Study Management 
  
2 Cohort Component Procedures 
  
3 Family Study 
  
4 Blood Pressure  
  
5 Electrocardiography 
  
6 Echocardiography 
  
7 Ultrasound Assessment 
  
8 Pulmonary Function Assessment 
  
9 Specimen Collection and Processing 
  

10 Cohort Surveillance 
  

11 Data Management System 
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1.0 SITTING BLOOD PRESSURE PROTOCOL 
 
 
1.1 Introduction 
 
As blood pressure rises, so does risk of ischemic heart disease and its complications.  The range of 
normal blood pressures is wide.  Even within the "normal" range, risk increases as the upper limits 
are approached.  Usually, blood pressures are expressed as systolic pressure/diastolic pressure; 
values exceeding 140/90 mmHg are considered to be hypertensive for adults.  Classification and 
staging of hypertension are more precise where systolic rather than diastolic is the principle criterion.  
Both systolic and diastolic measuring blood pressure are associated with increasing risk for 
cardiovascular disease.  Middle-aged persons with a diastolic blood pressure of 90-104 mmHg (so-
called "mild" hypertension) have a risk of heart attack that is about 70 percent higher than that of 
persons with a diastolic pressure under 80 mmHg (optimal value).  Persons with a diastolic blood 
pressure exceeding 104 mmHg (moderately severe to severe hypertension) have a risk more than 
twice that of those with a normal value.  Hypertension is an especially strong risk factor for stroke 
and, to a lesser extent, for peripheral vascular disease.  Most of the knowledge of the consequences 
of high blood pressure arises from studies of sitting arm blood pressure, as described in this section. 
 
Sitting blood pressure in the first exam (Visit 1) is measured in a resting state, using 2 measurements 
with a random zero sphygmomanometer.  The random zero machine has two advantages over the 
fixed zero manometer.  Digit preference does not appear in the data.  It may still exist in the reading 
itself, but it is "removed" from the data by the use of the randomly chosen zero point.  More 
importantly, it prevents the blood pressure technician from knowing the actual value, and therefore 
removes judgements about blood pressure levels for readings close to critical values such as 90 
diastolic.  It should be noted, however, that the random zero machines tend to yield blood pressures 
which are about 1.5 mmHg less than those obtained when using a fixed zero machine.  Within person 
variation in blood pressure is substantial, even within a few minutes and particularly under conditions 
perceived as stressful.  Use of two replicate readings tends to reduce this short-term variation. 
 
 
1.2 Standardized Clinic Procedures 
 
Correct measurement of blood pressure is of the utmost importance to the success of this study.  It is 
essential that the procedure described below for measuring blood pressure be followed exactly.  
Major differences in blood pressure measurement methodology among health professionals from 
several countries have been observed despite the fact that a joint committee of the American Heart 
Association and the Cardiac Society of Great Britain and Ireland established international 
recommendations on blood pressure measurement in 1939.  Precision is essential for valid 
comparisons of blood pressure between groups of people and in individuals on different occasions. 
 
 
1.3 Description of the Equipment 
 
 
1.3.1 Stethoscope 
 
A standard Littman stethoscope with a bell is used.  Korotkoff sounds, described as Phase 1 through 
Phase 5, are best heard with the bell because of their low pitch.  Stethoscope tubing should be about 
10-12 inches from the bell piece to "Y" branching.  This length provides optimal acoustical properties 
and allows the observer to read the sphygmomanometer at eye level and in a comfortable position.  
Earpieces should fit comfortably and snugly in the ears.  Four points should be observed in using the 
stethoscope. 
 

1. The earpieces should be directed downwards and forwards into the external ear canal. 
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2. The earpieces should be tight enough to exclude outside sound but not so tight that they 
cause discomfort. 

 
3. The valve between the bell and the diaphragm should be turned in the correct direction. 

 
4. The bell of the stethoscope should be placed lightly on the skin overlying the brachial artery - 

immediately below the cuff and medial to the cubital fossa above the medial epicondyle of the 
radius and posterior to the biceps muscle.  Light pressure accentuates low-pitched sound and 
avoids compression murmurs.  Pressing too heavily with the stethoscope over the brachial 
artery causes turbulent flow in the artery and a murmur can be heard which may prolong the 
apparent duration of phase 4. 

 
 
1.3.2 Sphygmomanometers 
 
Standardized Hawksley random-zero instruments are used for all clinic visits.  Standard Baum 
manometers are used for determining peak inflation level. 
 
The mercury manometer consists of a screw cap, a face with numbers, a lined glass column, a 
reservoir containing mercury, rubber tubing, and a metal case.  The rubber tubing from the mercury 
manometer connects to the rubber tubing from the inflatable rubber bladder of the cuff.  As the 
inflatable rubber bladder is filled with air, the air pressure in the bladder travels through the 
connecting rubber tubing.  The pressure pushes the mercury out of the reservoir and into the lined 
glass column.  The number for each line is read when the rounded top of the mercury, the meniscus, 
is level with it.  If the meniscus is exactly between the lines, the reading is made from the line 
immediately above, i.e., rounded up to the nearest even number. 
 
 
1.3.3 Random-Zero Mercury Manometer 
 
The random-zero (R-Z) manometer has all the parts of the standard mercury manometer.  In addition, 
it has a device built into the box-shaped back that changes the level of mercury in the calibrated glass 
tube.  The device includes a second mercury reservoir the size of which can be changed to hold a 
larger or smaller amount of the mercury and therefore allow different amounts of mercury to remain in 
the calibrated glass tube and the outside reservoir.  Turning a wheel on the side of the wooden box 
changes the size of the second reservoir.  The second reservoir is opened and closed with a bellows 
control valve on the face of the manometer. 
 
 
1.3.4 Cuffs and Bulbs 
 
Proper size of the cuff is essential for accurate blood pressure measurement.  The Examination 
Center has four standardized cuffs available - small adult, adult, large adult, and thigh cuff.  The 
standardized cuffs (provided are by the Baum Company) are used for the measurement of sitting 
blood pressure. 
 
The range markings on commercial cuffs overlap from size to size and do not offer a precise 
guideline.  In the JHS Study arm size is measured, and the cuff size is selected as illustrated in Table 
1, below. 
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Table 1. Determination of Cuff Size Based on Arm Circumference 
 
 Cuff Size Arm Circumference   

 Small Adult < 24 cm   

 Adult 24 to 32 cm   

 Large Adult 33 to 41 cm   

 Thigh > 41 cm   
 
 
 
1.4 Blood Pressure Measurement Instructions 
 
Standardizing the measurement technique and the environment in which the measurement is made 
controls some of the many extraneous factors influencing blood pressure.  Uncontrolled factors 
(temperature, time of day, arm circumference, recent use of caffeine, identity of the observer) are 
recorded, so that they can be taken into account during analysis. 
 
JHS participants are reminded during the scheduling of Visit 1 to avoid caffeine (from tea, coffee, 
chocolate, and soft drinks), eating, heavy physical activity, smoking and alcohol intake for twelve 
hours prior to the clinic visit.  Current drug intake, including medications affecting blood pressure and 
non-prescription drugs, is recorded on the day of the examination.  A detailed history of alcohol intake 
history is also recorded. 
 
 
1.5 Staff Preparation for Participant Visit 
 
In relating to the JHS participants, remember that participation in the study is voluntary.  Participants 
are given full explanation and instructions about the preparation for the blood pressure examination 
and an opportunity for questions.  The setting in which blood pressure measurements are made is 
standardized and takes place in a separate, quiet room where no other activity is taking place, and 
where temperature fluctuations are minimal.  Clinic scheduling procedures establish consistent 
appointment times to minimize as much as possible the impact of daily blood pressure variation. 
 
 
1.6 Measurement Procedures 
 
The sitting arm blood pressure is measured two times at Visit 1.  It takes approximately 10 minutes to 
make two blood pressure measurements including the initial five-minute rest. 
 
Once the participant is given instructions and explanations, and the equipment has been checked, 
blood pressure measurement begins.  The following steps must be followed precisely.  The procedure 
is described here employing the JHS paper form.  When using the JHS Direct Data Entry System, 
calculations are performed by the system. 
 
1. If the participant indicates that there is a medical or post-surgical reason for not having the blood 

pressure measured on the right arm (or if the right arm is missing), reverse chairs and proceed 
with the left arm.  Indicate on the Itinerary Form and on the Sitting Blood Pressure form Note Log 
that the left arm is used. If in doubt, or if the participant prefers not to have a blood pressure taken 
on either arm, consult with the supervisor. 

 
2. Determine the arm circumference using the following procedure. 
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The participant stands facing away from the observer with the right arm flexed at 90 degrees at 
the elbow, hand across midsection.  The observer determines and marks the tip of the olecranon 
(elbow). 
 
The participant straightens the arm, allowing it to hang loosely at the side.  The observer then 
determines and marks the posterior tip of the acromion process (shoulder bone).  Using a 
centimeter tape, the observer measures the length of the upper arm between the two marks and 
marks the midpoint (+). 
 
The observer wraps the tape around the arm over the midpoint mark, making sure that the tape is 
level.  The arm circumference is measured to the nearest centimeter, and is recorded. 

 
3. Seat the participant with right arm on table.  The bend at the elbow (cubital fossa) should be at 

heart level.  Legs should be uncrossed and feet comfortably flat on the floor, not dangling.  Be 
sure that the chair head support is comfortable and the participant is able to relax the neck and 
shoulder muscles as much as possible. 

 
4. Palpate the brachial artery (just medial to and above the cubital fossa), and mark this location for 

stethoscope placement.  Choose the correct cuff size and wrap the cuff on the arm with the 
center of the bladder over the artery.  If the participant seems particularly apprehensive, delay 
wrapping the cuff until after the five-minute wait. 

 
5. Record the time.  Start five-minute timer.  Allow a five-minute wait before taking the blood 

pressure.  Conversation should be limited.  However, a brief explanation of the procedure can be 
repeated at this time if necessary.  The smoking and fasting questions may be asked after timing 
is begun. 

 
6. After the 5-minute rest, check and record the 30-second heart rate.  Then, connect the cuff to a 

standard manometer and establish the pulse obliteration pressure by slowly inflating while 
palpating the radial artery until pulse is no longer felt.  Deflate and disconnect the cuff.  Record 
the pulse obliteration pressure.  Record the R-Z maximum zero number (found next to mercury 
column).  Calculate and record the peak inflation level (i.e., pulse obliteration pressure + R-Z 
maximum zero number + 30). 

 
7. Measurement 1: Connect the cuff to the random-zero manometer.  Open the bellows control 

valve and wait until the mercury settles.  Using downstrokes only turn the thumbwheel two or 
three times.  Note: Do not spin the thumbwheel.  Place the bell of the stethoscope on the brachial 
artery.  Inflate rapidly to the R-Z peak inflation level.  Holding the pressure constant with the bulb, 
wait 5 seconds.  Close the bellows control valve.  Slowly deflate the cuff (2 mm per second) while 
listening.  Record the 1st and 5th phases, reading the pressure in mmHg to the nearest even 
number.  The first sound heard in a series of at least two sounds is recorded for systolic blood 
pressure (phase 1).  The first silence in a series of at least two silences is recorded for diastolic 
blood pressure (phase 5), not the last sound heard.  Disconnect the cuff and record the zero 
reading. 

 
8. Measurement 2: Have the participant raise measurement arm for five seconds.  After waiting 

another 25 seconds with the participant's arm on the table, repeat the measurement as in step 7 
above and disconnect cuff. 

 
Blood pressure calculations are made for the first and second readings.  When using paper forms, 
subtract the zero value from the readings to get the actual (corrected) systolic and diastolic blood 
pressure measurement.  This is done on the worksheet at the end of the form.  Because of the 
importance of the blood pressure averages, to inform the participant and for the purpose of referral, 
all arithmetic is done with a calculator. 
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If for any reason the observer is unable to complete, or has forgotten to complete any portion of the 
exam (and the participant is gone), draw two horizontal lines through the space(s) on the form, if 
using paper forms.  This is the correct way to indicate missed information.  If an entire reading is 
missed and the participant is still sitting at the blood pressure workstation, completely deflate the cuff 
and start over with a replacement reading.  However, under no other circumstances may a 
replacement reading be obtained.  Always wait at least 30 seconds between readings. 
 
 
1.7 Procedure for Changing the Peak Inflation Level 
 
Occasionally the Korotkoff sounds may be heard as soon as one places the stethoscope over the 
brachial pulse.  If this happens, the peak inflation level used was too low.  The observer immediately 
deflates the cuff by releasing the thumbscrew and disconnecting the cuff tube.  Then have the 
participant hold the cuff-wrapped arm vertically for five seconds.  As shown below in Table 2, draw a 
line through the previously recorded Pulse Obliteration Pressure and Peak Inflation Level.  Increase 
each number by ten and write the new number above the original one, as shown below.  When using 
the Direct Data Entry system, the Peak Inflation Level values change automatically when the Pulse 
Obliteration Pressure is changed.  Proceed with blood pressure measurement, starting at the new 
Peak Inflation Level. 
 
 
Figure 1. Changing the Peak Inflation Level on paper forms. 
 
    
  130  
 Pulse obliteration pressure 120  
    
 R-Z maximum Zero + 22  
  + 30  
    
    
  =182  
 Peak Inflation Level   172  
 (Random-Zero)   
    
 
 
 
1.8 Reporting the Blood Pressure Results to the Participant 
 
Using a calculator, average the first and second corrected R-Z readings and record the average on 
the form if using paper forms.  Record this average on the transmittal slip or itinerary form in the 
participant's folder, and mention the results to the participant.  State clearly the systolic and diastolic 
pressure, and indicate that the participant will receive a written report with these valves at the end of 
the visit. 
 
 
1.9 Stopping Rules for Elevated Blood Pressure 
 
The classification of blood pressure for adults is summarized in Table 3.  The medical care referral 
guidelines for elevated blood pressure are summarized in Table 4.  When a person has one or more 
sitting blood pressure measurements where the systolic reading exceeds 260 mm Hg or the diastolic 
reading exceeds 130 mm Hg (emergency referral), the JHS physician is consulted and the 
arrangements are made to transport the person to an emergency care facility.  The JHS physician is 
also consulted and the participant is advised to seek immediate medical care (same day) when one 
or more systolic blood pressure measurements are between 210 and 259 mm Hg or the diastolic 
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pressure is between 120 and 129 mm Hg (immediate referral).  In both circumstances, the remaining 
procedures and interviews in Visit 1 are cancelled and Visit 1 is rescheduled as appropriate.  When 
one or more systolic blood pressure levels are between 180 and 209 mm Hg or the diastolic is 
between 110 and 119 (urgent referral); the JHS physician is notified for urgent referral unless the 
physician recommends otherwise. 
 
 
Table 2. Classification of Blood Pressure for Adults 

(Based on Joint National Committee on Detection, Evaluation and Treatment of High 
Blood Pressure JNC-VI, 1997 Guidelines) 

 
Category SBP 

(mm Hg) 
 DBP 

(mm Hg) 
Optimal <120 and <80 
Normal <130 and <85 
High-normal 130-139 or 85-89 
Hypertension    

Stage 1 140-159 or 90-99 
Stage 2 160-179 or 100-109 
Stage 3 180 or 110 

 

1 When SBP and DBP fall into different categories, use the higher category. 
 
 
Table 3. Medical Care Referral Guidelines for Blood Pressure Based on Initial 

Measurements 
 
 

SBP DBP Follow-up Recommended 

< 130 < 85 Recheck in 2 years 

130 – 139 85 - 89 Recheck in 1 year, give lifestyle advice 

140 – 159 90 - 99 Confirm within 2 months, give lifestyle advice 

160 – 179 100  - 109 Evaluate/refer to care within 1 month 

180 - 209 110 - 119 Urgent referral (within 7 days) 

210 – 259 120 - 129 Immediate referral (visit is rescheduled) 

=> 260 => 130 Emergency referral (visit is rescheduled) 

(Non-emergent/urgent categories based on Joint National Committee on Detection, 
Evaluation and Treatment of High Blood Pressure JNC-VI, 1997 Guidelines) 

 
1 If the systolic and diastolic categories are different, follow recommendations for the 

shorter time follow-up. 
2 Unusually low readings (less than 100/70) should be evaluated for clinical 

significance by the JHS physician. 
 
 
1.10 Sitting Blood Pressure Training and Certification 
 
At the examination center a minimum of three clinic staff persons are trained for measuring sitting 
blood pressure.  They need not be health professionals, but they must be trained and certified by JHS 
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in the blood pressure measurement technique.  Observers should also have experience in relating to 
people. 
 
The first training session begins with a description and demonstration of the correct blood pressure 
measurement procedure.  Trainees listen to the 1st (training) audiocassette tape, taking the test 
sequences until they are confident they can identify 1st and 5th phase Korotkoff sounds.  Then, they 
use the 2nd tape until they have passed the test.  After passing the second test, they are given the 
3rd tape test.  Alternated with the tapes are actual practice sessions with live subjects under the 
instruction and observation of the training supervisor.  Some live practices may be done with a 
standard stethoscope, but most employ the Y-tube stethoscope.  After the first day of training, each 
trainee is given a cuff and manometer (no stethoscope) to take home and practice control of the 
valve.  This is done by wrapping the cuff on a jar or bottle and alternately pumping up and dropping 
the mercury at a steady rate of 2 mm per second.  After two or three sessions, trainees are also given 
a stethoscope to practice on family or friends. Out-of-class practice is very important to build 
confidence.  Practice time allowed in class is not enough without outside practice time.  Once each 
trainee has passed the third tape test, he or she does at least two live readings with the training 
supervisor on the Y-tube stethoscope.  The readings must agree within 4 mm and the average must 
agree within 3 mm.  If they do not, the trainee needs additional practice with tapes and live subjects.  
The training supervisor also verifies that the trainee understands and follows proper procedures. 
 
Additional time is allowed for instruction and mastering the use of the Random-Zero device.  Trainees 
are certified after passing tape tests 2 and 3 (tape 4 is held in reserve for recertification) and at least 2 
live readings.  Observers are recertified every six months by taking and passing tape 3 or 4 and two 
readings with the blood pressure supervisor on an Y-tube stethoscope. 
 
It is the responsibility of the Examination Center to conduct recertification procedures and report to 
the Coordinating Center when the procedures are complete. 
 
 
1.10.1 Tapes 
 
The JHS Study uses four tapes of Korotkoff sounds.  Tape 1 is a training tape.  Tape 2 is a practice 
tape.  Tapes 3 and 4 are test tapes.  A new trainee listens to tape 1, goes to tape 2 and repeats it as 
often as necessary.  Tape 3 is taken as a test.  It, too, may be repeated if necessary.  Tape 4 is held 
in reserve for the six-month recertification.  Tapes 3 and 4 are alternated thereafter for recertification. 
 
 
1.10.2 Using the Cronus Stop Watch with the Prineas Blood Pressure Tapes 
 
The Cronus stopwatch, model 3-S, is an interval timer and is the preferred timing device to be used 
with the training tapes.  Of the various options, it seems to be the simplest and easiest to read.  It is 
generally available at a local sporting goods store.  The address of the manufacturer is: 
 
Cronus Precision Products, Inc. 
2895 Northwestern Parkway 
Santa Clara, CA  95051   USA 
 
If only Phase 1 and Phase 5 are learned, two ordinary stopwatches may be used.  Using one in each 
hand, both are started at the beep; one is stopped when the first Korotkoff sounds are heard and the 
other stopped at Phase 5.  The interval watch is preferred even if Phase 4 is not being recorded 
because it is much easier to change one's mind if sounds change, and it is easier to read. 
 
1. Turn on the stopwatch and press the reset button. 
 
2. Start the tape, wearing headphones.  At the beginning of each tape is a timing sequence, with no 

Korotkoff sounds.  When the beep is heard, start the watch by pressing the button at the top.  
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Stop the watch with the button at the top when the second beep is heard.  Record the time 
elapsed to the nearest 10th of a second on the top of the student form. 

 
3. Press reset button.  When the tape announces sequence 1, start the watch at the beep. 
 
4. When the first Korotkoff sound is heard, stop the watch with the button at the top.  Record the 

time elapsed to the nearest 10th of a second.  The watch continues to run internally. 
 
5. When the Phase 5 (disappearance) is heard, stop the watch.  Record the time elapsed to the 

nearest 10th of a second.  Press reset.  Repeat steps 3 through 5 for each sequence.  
Remember that the tapes were designed for a special timing device.  The answers given are 
double the stop watch values.  At the end be sure to turn off the stopwatch in order to save 
batteries. To score the tests, add all the sequences, and divide by the number of sequences.  The 
average should be within plus or minus one second. 

 
 
1.10.3 Y Tube Stethoscope Observations 
 
Y Tube stethoscope observations are made in conjunction with the blood pressure tapes during initial 
training and for biannual quality control.  The trainer has the observer-trainee go through the entire 
blood pressure measurement procedure using a quality control checklist.  The observer and trainer 
listen with the Y Tube and record the values on separate sheets.  Two measurements on one subject 
are obtained.  Measurements by the trainer and the trainee should agree within 4 mmHg on any one 
reading (systolic or diastolic) and averages should agree within 3 mmHg. 
 
 
1.11 Quality Control 
 
To ensure the accuracy of the blood pressure measurements throughout the study, quality control 
measures are developed at the Coordinating Center and applied at the Examination Center.  These 
measures include: 
 
1. recruitment of the most qualified personnel 

2. standardized training and certification 

3. retraining and recertification 

4. biannual observation of data collection by supervisors, using the checklist given in Appendix 3.  
One checklist is used for each technician and sent to the Coordinating Center each quarter. 

5. frequent staff meetings to provide feedback 

6. editing of data, both manual and by computer 

7. a quality assurance program administered by the Coordinating Center 

8. biannual simultaneous Y Tube observation of each technician by the blood pressure supervisor 

9. equipment maintenance program 
 
1.12 Technician Training and Quality Control 
 
Blood pressure technicians are trained by the clinic coordinator or their designee prior to participant 
recruitment.  New technicians hired after the start of the study are trained locally by the Study 
Coordinator or a designated "Blood Pressure Supervisor".  Recertification occurs every six months.  
Prior to certification, each technician is required to have a clinical hearing test. 
 
The Coordinating Center directs a blood pressure quality assurance program to review six-monthly 
data.  This includes quality analysis and review of blood pressure data, comparing means for each 
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technician with the values for all technicians.  These statistics are adjusted for weight, age and sex of 
the participants.  Digit preference is also monitored for each technician. 
 
1.13 Equipment Maintenance 
 
The Examination Center is responsible for the proper operation and maintenance of its equipment.  
Maintenance responsibility is assumed by the blood pressure supervisor and all staff are instructed to 
report any real or suspected equipment problems to that person promptly. 
 
All checks, inspections, cleanings and problems indicated are documented and recorded by date in a 
permanent log.  Problems and solutions are also recorded.  A copy of this log is given in Appendix 4. 
 
 
1.13.1 Random Zero and Standard Sphygmomanometers 
 
The Random Zero manometer is inspected once a week and the standard manometer once a month.  
These inspections include a check of: 
 

1. the zero level of the standard manometer 

2. mercury leakage 

3. manometer column for dirt or mercury oxide deposit 

4. condition of all tubing and fittings. 
 

The equipment is cleaned if inspection indicates it is needed, or at least once a year.  Specific 
instructions for the random zero device are provided in Appendix 1, and for the standard manometer 
in Appendix 2.  In addition, every two months the accuracy of the random zero instrument is checked 
using a standard manometer and an Y connection, as described in Appendix 4. 
 
 
1.14 Referral of Hypertensives 
 
As shown in Table 4, blood pressure referral levels are made based on the findings of the JHS 
examination which are consistent with the recommendations given in the sixth report of the Joint 
National Committee on Detection, Evaluation, and Treatment of High Blood Pressure (1997).  The 
average of the first and second resting blood pressure readings is used. 
 



10 

Exam 1 Blood Pressure Manual.doc 

2.0 ANKLE/BRACHIAL SYSTOLIC BLOOD PRESSURE PROTOCOL 
 
 
2.1 Purpose 
 
The ratio of the ankle blood pressure to the arm blood pressure provides a measure of lower 
extremity arterial disease (circulation problems).  The ankle-arm index (AAI) is reduced to less than 
1.0 when there is obstruction to blood flow in the legs.  The AAI is a non-invasive measure of 
atherosclerosis.  The AAI is associated with atherosclerotic disease in other vascular beds and 
predicts cardiovascular mortality. 
 
 
2.2 Equipment  
 
1. 8 megahertz Doppler pen probe with built-in speakers 

2. 9 volt alkaline batteries 

3. Doppler conducting jelly 

4. Standard mercury column sphygmomanometer: Wall-mounted Baumanometer 

5. Calibrated V-Lok BP cuffs in four sizes: 

• 2 large adult cuff 

• 2 small adult cuffs 

• 4 regular adult cuffs 

• 3 thigh cuffs 

6. Tissues to remove conducting jelly 

7. Black eyeliner pencil  
 
2.3 Exclusions 
 

1. Persons with venous stasis ulceration or other pathology that precludes placing a BP cuff around 
the ankle (e.g. open wounds). 

2. Persons with rigid arteries such that an occlusion pressure cannot be reached.  If the artery 
cannot be occluded before the mercury column reaches 300 mmHg, the participant is excluded. 

3. Persons with bilateral amputations of legs. 

4. Subjects who fit any of the above categories are recorded as missing data. 

5. If a subject has undergone a mastectomy of the right breast or has other reasons to omit right 
arm pressures, the left arm will be used for measures. 
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2.4 Set-Up Procedure 
 

1. Ask participant to remove shoes and stockings so that the ankles are bare to mid-calf. 

2. Participant is positioned on examination in a flat to semi flat position with trunk no more 
than 45 degrees from surface. 

3. Keep participant supine for at least five minutes before measuring BP. 

4. Place three BP cuffs on the participant (be sure to check for appropriate cuff size) 

a) Right arm 

b) Right ankle 

c) Left ankle 
 
If the right arm cannot be used, the left may be used.  This change must be noted on form. 
 
Table 4. Determination of Cuff Size Based on Arm and Ankle Circumference 
 

 Cuff Size Arm  and Ankle 
Circumference 

  

 Small Adult < 24 cm   

 Adult 24 to 32 cm   

 Large Adult 33 to 41 cm   

 Thigh > 41 cm   
 

 
5. Apply ankle cuffs with midpoint of bladder over posterior tibial artery, with lower end of 

bladder approximately 3 cm above medial malleolus (prominence on medial side of 
ankle).  See Figure 1. 

 
 
2.5 Procedure 
 
2.5.1 General Guide to Blood Pressure Readings 

 

1. Following any previous inflation, wait at least 30 seconds after cuff has completely 
deflated. 

2. By closing the thumb valve and squeezing the bulb, inflate the cuff at a rapid but smooth 
continuous rate to the maximal inflation level (30 mmHg above systolic pressure). This 
measure is described in greater detail below. 

3. The examiner’s eyes should be level with the mid-range of the manometer scale and 
focused at the level to which the pressure will be raised. 

4. By opening the thumb valve slightly, and maintaining a constant rate of deflation at 
approximately 2 mmHg per second, allow the cuff to deflate. 

5. Listen throughout the entire range of deflation, past the systolic reading (the pressure 
where the first regular sound is heard) for 10 mmHg.  Two subsequent beats should be 
heard for any valid systolic blood pressure reading. 

6. Deflate the cuff fully by opening the thumb valve. 

7. Neatly enter systolic readings in the spaces provided on the form. 
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2.5.2 Right Arm Systolic Blood Pressure Measurement 
 

1. Attach right arm cuff tubing to manometer. 

2. Apply ultrasound jelly over brachial artery.  The brachial artery is located just medial to 
the center of the cubital fossa. 

3. Locate brachial artery using Doppler pen probe. 

4. Hold the Doppler Probe absolutely still.  It can easily slip off the artery. 

5. Measure the systolic blood pressure: 

a. Inflate cuff quickly to maximal inflation level (30 mmHg above systolic pressure). 

b. Deflate at 2 mmHg/second, to appearance of systolic pressure. 

c. Follow down for 10 mmHg.  Two subsequent beats should be heard for any valid 
systolic blood pressure reading. 

d. Remove Doppler pen probe. 

e. Deflate cuff quickly and completely. 

f. Disconnect the right arm cuff from the manometer and connect to the right ankle 
cuff. 

6. Neatly record systolic blood pressure. 

7. Disconnect the right arm cuff from manometer. 
 
2.5.3 Right and Left Ankle Systolic Blood Pressure Measurement  
 

1. Connect right ankle cuff to the manometer. 

2. Apply ultrasound jelly over posterior tibial artery.  This artery is located on the calf and is 
most easily located at the medial malleolus of the ankle 

3. Locate posterior tibial artery using Doppler pen probe. 

4. Hold the Doppler probe absolutely still.  It can easily slip off the artery. 

5. Measure the systolic blood pressure: 

a. Inflate cuff quickly to maximal inflation level (30 mmHg above systolic pressure). 

b. Deflate at 2 mmHg/second to appearance of systolic pressure. 

c. Follow down for 10 mmHg.  Two subsequent beats should be heard for any valid 
systolic blood pressure reading. 

d. Remove Doppler pen probe. 

e. Deflate cuff quickly and completely. 

6. Neatly record ankle systolic blood pressure. 

7. Disconnect right ankle cuff from manometer.  Connect left ankle cuff to manometer and 
repeat procedure. 

 
NOTE: If the posterior tibial pulse cannot be found with palpation or Doppler pen probe, use the 
dorsalis pedis artery for the measurement.  Have another examiner verify the absent posterior tibial 
pulse. 
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Figure 2. Right and Left Ankle Cuff Placement 
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2.5.4 Repeating the Ankle-Arm 
 
Repeat the sequence in reverse order 

a. left ankle 

b. right ankle 

c. right arm 
 
2.6 Tips for Ankle-Arm Measurements 
 
2.6.1 Using the Doppler 
 
Push button in to turn on and gradually turn the volume up.  Now place the probe over the artery 
(brachial or posterior tibial). 
 
The frequency used is 8 Megahertz (vibrations of 8 million times per second).  In order to hear the 
signal above background noise, the instrument must be pushed in toward the artery.  Angling the 
beam upstream improves the signal.  For deeper vessels, the unit will have to be tilted back toward 
perpendicular, but NOTE: the instrument works poorly or not at all if held fully perpendicular to the 
flow.  It must always be angled into and IN LINE with the flow.  Please see figure below. 
 
Figure 3. Doppler Probe Position  
 

 
 
In some places along the posterior tibial artery, there is anatomical hiding of the vessel by muscle or 
tendons.  Move up or down the vessel a little to find the best signal above background noise. 
 
The purpose of the Doppler is to determine that blood is or is not flowing under the cuff.  For correct 
interpretation, the probe MUST be centered directly over the artery and must not be moved while 
inflating the cuff. 
 
Please note that the Doppler unit turns itself off after 5 minutes automatically.  This may occur in the 
middle of a measurement. 
 

• Mark the location of maximal pulse or Doppler signal on the brachial artery and both posterior 
and tibial arteries with eyeliner pencil to improve the speed and accuracy of localizing them 
the second time and to help maintain position. 
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• Hold the Doppler pen absolutely still while inflating and deflating the cuff; moving a few 

millimeters will lose the pulse. 
 

• Always use enough jelly to ensure good contact. 
 
 
2.6.2 Maintenance of Doppler 
 

• KEY POINT: Use only ultrasound gel  
 

• The probe: The probe consists of two crystals; one for transmitting the ultrasound waves and 
the other for receiving the reflected waves.  If either crystal is damaged, the probe will not 
work properly or will not work at all.  The crystals are covered by epoxy resin.  This resin is 
attacked by any gel or liquid containing the chloride ion.  Therefore, NEVER use ECG paste 
or cream as the contact medium between the skin and the crystals.  Use AQUASONIC or any 
gel made for ultrasonic physical therapy equipment.  In an emergency use any surgical jelly 
or lubricant, even Vaseline or mineral oil.  Remove the gel after use with a soft tissue.  If the 
probe has dried gel on it, wash it off under running water.  Do NOT scrape off the gel 
because this may damage the epoxy coating.  Do NOT autoclave the probe.  Gas sterilization 
is OK. 
 

• KEY POINT: To preserve the battery, turn off the unit immediately after measurements. 
 

• The battery: As the battery runs down, the signal will get weaker to the point where the 
instrument just doesn’t work.  Most batteries run down because the instrument has been left 
turned on.  It takes less than a minute to make a blood pressure measurement.  Turn the unit 
off immediately after removing it from the skin.  Use an alkaline-type replacement 9-volt 
transistor radio battery. 
 

• Abnormal  Doppler Noise: On occasion there are unusual noises from the Doppler that do not 
indicate a problem with the Doppler.  The normal sound will become obvious with experience 
in performing this test.  Following are some common complaints and their causes. 
 

• Popping noises when the probe is first placed on the skin.  Scratchy sound at first.  Cause: 
bubbles in the gel that are moving and/or popping.  Also hair movement can cause noise.  
Remedy: Use a new glob of gel that looks clear, push down enough so hair is immobilized, 
and just wait a few seconds for things to settle down.  If the noise isn’t there when the probe 
is clean (no gel) and suspended in the air, the Doppler and/or probe are probably not at fault. 
 

• Bad static when the dry probe is moved in the air.  Cause: a loose connector where the probe 
connects to the instrument, a broken shield wire in the cable either at the connector or as it 
comes out of the probe.  This can be diagnosed by wiggling the wire or connectors gently.  
There is NORMALLY some static generated when the cable is flexed, but it isn’t severe.  
Remedy: QC Officer will arrange to replace probe or get connectors fixed. 
 

• High-pitched tone.  Cause: radio interference from a mobile service, police station nearby, 
even another Doppler working nearby.  Usually occurs near large open windows, rarely in the 
center of the building.  Remedy: Move to another room. 
 

• Howling noise when the probe with gel on it is held or laid on a table.  Cause: acoustic 
feedback through the probe acting as a microphone.  If it doesn’t occur without gel on the 
probe, everything is OK. 
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2.6.3 Guidelines for Blood Pressure 
  

a. Determining the Maximal Inflation Level (MIL) 
 

Determine the pressure to which to inflate the cuff for the measurement of the systolic 
blood pressure.  This assures that the cuff pressure at the start of the reading exceeds 
the systolic blood pressure and allows you to hear the first Korotkoff sound.  The maximal 
inflation level (MIL) should be measured specifically for the ankle-arm index 
measurement, using the Doppler, independently from its measurement for the regular 
blood pressure measurement.  The procedures for determining MIL are as follows: 

 
• Attach the cuff tubing on the arm to the conventional mercury 

sphygmomanometer.   
 

• Locate the brachial pulse with the Doppler. 
 

• Inflate the cuff until the brachial pulse is no longer heard. 
 

• Deflate the cuff quickly and completely. 
 

• Inflate the cuff to 30 mmHg above the Doppler systolic pressure for all 
subsequent readings. 
 

• Repeat the MIL if the first attempt was unsatisfactory or you have had to readjust 
the cuff after measuring the MIL.  Wait 30 seconds before making a second 
attempt if the first is unsatisfactory. 
 

• If the brachial pulse is still heard at a level of 270 mmHg or higher (which means 
that the MIL is 30 mmHg or higher) repeat the MIL.  If the MIL is still 300 mmHg, 
terminate the blood pressure measurements and write in “300/MIL” on the form.  
On the Report of Findings, indicate the blood pressure at the level heard.  Refer 
the participant to see their doctor based on the blood pressure taken with a 
stethoscope.  The Doppler will always be higher. 

 
b. The systolic value is the pressure level at which you hear the first of two or more swishing 

sounds in the appropriate rhythm.  (Note: A single sound heard in isolation [i.e., not in 
rhythmic sequence] before the first of the rhythmic sounds [systolic] does not alter the 
interpretation of blood pressure). 

 
c. Record all readings to the nearest even digit, rounding up (i.e., read any value that 

appears to fall exactly between the markings on the mercury column to the next higher 
even marking). 

 
d. Make readings at the top of the meniscus, or rounded surface of the mercury columns. 

 
e. When the pressure is released too quickly from a high level, a vacuum is formed above 

the mercury and the meniscus is distorted.  Allow a few moments for it to reappear before 
reading the manometer or doing a repeat measurement. 
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2.7 Quality Assurance 
 
2.7.1 Training Requirements 
 
Staff performing the ankle-arm index measurements should be research technicians or clinicians 
previously trained in taking research blood pressure measurements.  In addition, training should 
include: 
 

• Read and study manual 

• Attend Jackson Heart Study training session on techniques (or observe administration by 
experienced examiner) 

• Practice on volunteers 

• Compare measurements with those made by experienced colleagues (Goal: obtain 
measurements within ± 2 mm Hg of that observed by a trainer) 

• Discuss problems and questions with QC officer 
 
2.7.2 Certification Requirements 
 

• Complete training requirements 

• Recite exclusion criteria 

• Conduct exam on two volunteers while being observed by QC officer listening with Doppler 
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3.0 AMBULATORY BLOOD PRESSURE MONITORING 
 
3.1 Introduction and Equipment 
 
Medifacts, Ltd. is a clinical research company dedicated to the evaluation of pharmaceutical and 
biological products using Ambulatory Blood Pressure Monitoring (ABPM) technology.  The technical 
operations and procedures discussed in this manual have been custom designed for use only in the 
conduct of the Jackson Heart Study (JHS). 
 
3.1.1 Support Personnel:  
 
U.S. Support Staff: 
 

• Michael Hackworth 
• Jeff Heilbraun 
• Keith Klischer 
• Ron Murray 
• Karen Nesmith 
• Meryl Poland 
 

 
3.1.2 Address and Phone Number: 
 
If you have any questions or problems related to conducting ABPM for this protocol, please do not 
hesitate to call (24 hours a day, 7 days a week) at one of the following numbers: 
  
Medifacts, Ltd. 
1401 Rockville Pike 
Suite 300 
Rockville, MD 20852 
301-279-0500 Phone 
1-800-333-6460 Toll Free 
301-424-0675 Fax 
Rmurray@M2CRO.com 
 
3.1.3 Monitor Vs. Mercury Column Calibration Step by Step Instructions 
 
Each ABPM unit must be calibrated prior to its use within the study.  The calibration of an ABPM unit 
need only be done once.  Each unit must be calibrated against each Mercury column to be used in 
correlation readings during the study.  To check the calibration of the monitor, use the following 
procedures: 
 

1. Obtain a full-size mercury sphygmomanometer (mercury column). 

2. Disconnect the cuff hose from the mercury column tube. 

3. Connect the T-Tube to the monitor Luer-Lok connector and the mercury column, and one of the 
cuffs provided by Medifacts.  

4. Wrap the cuff around a rigid cylinder (see below). 

mailto:Rmurray@M2CRO.com
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Figure 4. Calibration Setup 
 

 
5. Turn the monitor ON.  Press the START/STOP button on the monitor.  The monitor display 

should read approximately 165-170mmHg when the cuff is inflated completely.  Note and 
compare the readings on the monitor and the mercury column as the pressure bleeds down.  
Overall, the monitor readings should be within three (3) millimeters or 2% of the mercury column.  
At the end of the procedure, the monitor displays an error code. 

 
6. When completed, turn the monitor off and disconnect the T-tube from the monitor.  Disconnect 

the cuff hose and mercury column from the T-tube.  
 
7. Repeat these steps for each monitor provided and switching the associated cuff.  Each monitor 

must be calibrated against each mercury column to be used during the study.  This procedure will 
be done once with each ABPM and does not need to be repeated with each participant. 

 
8. To complete the table located in Section 3.0, you will record the mean difference between the 

observed mercury column and monitor values during the calibration procedure in the 
corresponding row/column.  In the first row of the table, you will record the serial number of each 
mercury column that your site may be using in this study.  In the first column, you will record the 
serial number of each monitor provided to your site.   

 
9. If the mean difference observed is > 4, please contact Medifacts for return of the ABPM unit. 
 
EXAMPLE:   In this example, we are calibrating monitor 207-00256 and Mercury Column (MC1) serial 
number (SN) 1527954.  After the monitor was manually prompted once, the following readings were 
observed:   
 
    ABPM  MC1   Observed 
    Reading Reading  Difference 
 
     160   162           2 
     135   136           1  
     100   102               2 
        74    76            2 
                           The mean difference is approximately:   2 
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Using the example above the table would appear as follows: 
 
                    MC1   MC2   MC3  MC4  

ABPM SN:  1527954 SN: SN: SN: 

SN:  207-00256            2     
SN:     
SN:     

Note:  Your observations and comparisons will vary during this procedure.  
 
Figure 5. Monitor Vs. Mercury Column Calibration Table  
 
                        MC1   MC2   MC3       MC4 

ABPM SN:  SN: SN: SN: 

SN:                
SN:     
SN:     
SN:                
SN:     
SN:     
SN:                
SN:     
SN:     
SN:                
SN:     
SN:     
SN:                
SN:     
SN:     
SN:                
SN:     
SN:     
SN:                
SN:     
SN:     
SN:                
SN:     
SN:                
SN:     
SN:     
SN:                
SN:     
SN:     
SN:                
SN:     
SN:     
SN:                
SN:     
SN:     
SN:                
SN:     
SN:     
SN:                



21 

Exam 1 Blood Pressure Manual.doc 

SN:     
         MC1    MC2   MC3          MC4 

ABPM SN:  SN: SN: SN: 

SN:                
SN:     
SN:     
SN:                
SN:     
SN:     
SN:                
SN:     
SN:     
SN:                
SN:     
SN:     
SN:                
SN:     
SN:     
SN:                
SN:     
SN:     
SN:                
SN:     
SN:     
SN:                
SN:     
SN:                
SN:     
SN:     
SN:                
SN:     
SN:     
SN:                
SN:     
SN:     
SN:                
SN:     
SN:     
SN:                
SN:     
SN:     
SN:                
SN:     

 
3.1.4 Assembly of the Dell Computers 
 
Follow the instructions below to assemble the computer system for your scheduled training. Please call 
Medifacts if you have any questions or concerns regarding the assembly of the computer system. 
 
1. Turn your computer so that the backside is facing you. 

2. Attach the DATA KEY to the 25 pin parallel port, located on the back of your computer.  The data 
key is a small (2" x 2") black plastic device with a 25 pin serial port on one end and a 25 pin parallel 
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port on the other.  On one side of the data key, there is a white arrow covered by a number.  This 
arrow should be face up and point toward the computer.  Tighten the screws finger tight. 

 
Figure 6. Dell Computer Data Key 

 
3. Attach the gray ABPM Spacelabs MONITOR CABLE to the 9 pin serial port, located just to the right 

of the data key port.  Tighten the screws finger tight. 

4. Insert the TELEPHONE CORD into the computer.  On the right side of the computer with the back 
still facing you there is a small rectangular “modem”. Press the small square on the left side of the 
modem to pop the telephone plug out.  Insert one end of the telephone cord into this jack and plug 
the other end into the dedicated telephone jack on your wall. 

 
Figure 7. Dell Computer Diagram 
 
 
 
 
 
 
 
 
 
 
 
 

5. Connect the male end of the AC Adapter into the back of the computer at the far right end.  Then 
insert the female end of the POWER CORD into the AC adapter and the male end of the power cord  
into a surge protector or the wall outlet. 

6. Turn your computer so that the front faces you.  Open the top lid of your computer by sliding the tab 
located in front center to the right (→).   

7. You are now ready to turn your computer ON.  The ON/OFF or POWER button is located on the left 
side of the computer.  Slide the button towards you.  Listen for a double BEEP tone, which indicates 
that the internal modem is connected. 

8. The MEDICOM programming software will load itself automatically. 
 
3.1.5 Dell Computers: 
 
To adjust the display screen BRIGHTNESS/CONTRAST, do the following: 
 
  Adjustment     Key Combination 
 
• Decrease brightness   Fn      ↓ 
 
• Increase brightness   Fn      ↑ 
 
• Decrease contrast   Fn      → 
 
• Increase contrast   Fn      ← 

On/Off 

Modem 

Telephone Cord  
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3.1.6 Assembly of the IBM Computers 
 
The following are instructions for assembling the IBM computer system.  Please call Medifacts if you 
have any questions or concerns regarding the assembly of the computer system. 
 

1. Turn your computer so that the back side is facing you 

2. Lower the panel covering the back right side.  Connect the male end of the AC Adapter into the back 
of the computer at the far right end.  Insert the end of the POWER CORD into the AC adapter and 
the male end of the POWER CORD into a surge protector or the wall outlet. 

3. Attach the MONITOR CABLE to the 9 pin serial port, located just to the left of the POWER CORD 
attachment. 

4. Attach the DATA KEY to the 25 pin parallel port, located on the back of your computer to the left of 
the MONITOR CABLE.  The data key is a small (2" x 2") black plastic device with a 25 pin serial port 
on one end and a 25 pin parallel port on the other.  On one side of the data key, there is a white 
arrow covered by a number.  This arrow should be face up and point toward the computer.  Tighten 
the screws, finger tight. 

 
Figure 8. IBM Data Key 

 
5. Turn your computer around so that the front is now facing towards you. 

6. The ON/OFF or POWER switch is located on the back left side of the computer.  Slide the button 
backward (away from you). 

7. Inserting the TELEPHONE CORD.  The modem outlet will be located on the back left side below the 
ON/OFF switch.   Insert one end of the TELEPHONE CORD into this space.  Plug the other end of 
the telephone cord into the dedicated telephone line port on your wall. 

8. Open the top of your computer by sliding the tabs located on either side of the computer. You are 
now ready to turn your computer ON.  The MEDICOM software will load itself automatically. 

9. To adjust the display screen BRIGHTNESS/CONTRAST, use the slide switch located on the lower 
right hand side of the display screen. 

10. The computer mouse is a red ball located in the center of the keypad.  The mouse buttons are 
located below the spacebar. 

11. The disk drive to be used during computer “backup” is located on the left front side  of your 
computer. 
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3.1.7 Assembly of the Compaq Computers 
 
The following are instructions for assembling the Compaq computer system.  Please call Medifacts if you 
have any questions or concerns regarding the assembly of the computer system. 
 
1. Turn your computer so that the back is facing towards you. 
 
Figure 9. Compaq Computer Diagram 

 
2. Connect the male end of the AC Adapter into the back of the computer into the round port farthest to 

the left.  Insert the female end of the POWER CORD into the AC adapter and the male end of the 
POWER CORD into a surge protector or the wall outlet. 

3. Lower the panel covering the back left side.  Attach the gray, MONITOR CABLE to the 9 pin serial 
port, located farthest to the left on the back of the computer. 

4. Attach the DATA KEY to the 25 pin parallel port, which is to the right of the MONITOR CABLE.  The 
data key is a small (2" x 2"), black plastic device with a 25 pin serial port on one end and a 25 pin 
parallel port on the other.  On one side of the data key, there is a white arrow covered by a number.  
This arrow should be face up and point toward the computer.  Tighten the screws, finger tight. 

 
Figure 10. Compaq Data Key 

 
5. Turn your computer around so that the front is now facing towards you. 

6. Inserting the TELEPHONE CORD.  The modem outlet will be located on right hand side of the 
computer.   There are two ports for a telephone line.  If you were provided the Compaq telephone 
cord, insert the flat end of the phone cord with “up” displayed into the space farthest left.  If you were 
supplied a generic phone cord, press the pop out button farthest left on the modem card and insert 
cord.  Plug the other end of either telephone cords into the dedicated telephone line port on your 
wall. 

7. Open the top of your computer by sliding the front tabs located on either side of the computer.  The 
ON/OFF or POWER switch is located above the keyboard, in the upper left corner.  Slide the button 
to the right. You are now ready to turn your computer ON.  The MEDICOM software will load itself 
automatically. 

 
To adjust the display screen BRIGHTNESS/CONTRAST, use the slide switch located on the lower right 
hand side of the display screen. 
 
The computer mouse is a blue ball located in the center of the keypad.  The mouse buttons are 
located below the spacebar. 
 
The disk drive to be used during computer “backup” is located on the left front side  of your computer. 
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3.1.8 SpaceLabs 90207 Ambulatory Blood Pressure Monitor 
 
The SpaceLabs Model 90207 Ambulatory Blood Pressure Monitor is a small, lightweight unit 
designed to take blood pressure and heart rate measurements. These measurements are recorded in 
the monitor (shown below) and are downloaded to the Medicom software program. 
 
Figure 11. SpaceLabs ABP Monitor 
 
 

 
The method for measuring blood pressure with the monitor is oscillometry.  The device does not use a 
microphone.  There is a sensor contained in the monitor that measures (senses) pressure changes in the 
artery during cuff deflation.  The device will deflate at a rate of 8 mmHg for every two seconds or two 
pulse beats, stopping to measure the oscillations at each level.  These oscillations are recorded in the 
memory of the monitor and a blood pressure determination is made following the completion of the 
deflation cycle. The monitor will automatically adjust the level of cuff inflation based on the 
participant's systolic blood pressure by inflating 20-30 mmHg over the previous reading. This is 
referred to as "Dynamic Inflation".  Many validation studies have shown a strong correlation between 
the readings taken by this device to pressures taken by a manual mercury column. 
 
As shown below, the monitor front panel includes the LCD display, cuff hose connector, and 
START/STOP button. 
 
Figure 12. SpaceLabs ABP Monitor Front Panel 
 

 
The monitor rear panel contains the communications port as shown below. The type BF equipment 
symbol indicates that the unit meets or exceeds international standards for isolating the participant 
from electrical connection. The rear panel contains program input/data output. The ON/OFF switch is 
also on the rear panel of the monitor. 
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Figure 13. SpaceLabs ABP Monitor Rear Panel 
 

 
The serial and the model numbers are provided above the battery panel.  On the reverse side of the 
battery panel there are abbreviated operating instructions for the monitor.  The monitor runs with 4 
alkaline AA (1.5V) batteries. You will be provided with an adequate supply before the study starts. 
Please make sure that fresh batteries are put into the monitor before each attempted monitoring 
period. 
 
Figure 14. ABPM Battery positions 
 

 
 
If the monitor becomes soiled, use a soft, damp cloth and mild detergent mixed with water to wipe the 
exterior of the monitor.  Clean the air hose connector with isopropyl alcohol. 
 
3.1.9 BPM Cuff and Pouch  
 
 The cuff wrap (with the air bladder removed) and the pouch are machine washable on “delicate” 
cycle only. Do not wash with bed linens, gowns, or in a large, commercial-type washers.  Small soiled 
or stained areas may be cleaned by gentle scrubbing with a sponge or cloth soaked in a mild soap 
and water solution.  Although not necessary, the cuff wrap and carrying pouch may also be sterilized 
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by ethylene oxide (EtO) sterilization methods using standard hospital procedures.  Use standard 
aeration techniques after sterilization. 
 
3.1.9.1 Bladder Insertion 
 
When inserting the bladder back into the cuff use only your fingers, do not use pencils, pens, or other 
hard objects as damage to the bladder may occur.  Fold or roll up the bladder inside the cuff as 
shown below.  Manipulate the cuff as necessary to unroll the bladder so that all the folds have been 
removed.  The bladder should lie flat within the cuff.   
 
Figure 15. Bladder Insertion (1) 
 
 
 
 
 
 
 
 
 
 
 
 
The bladder may be installed with the hose exiting the second cuff opening.  However, the bladder 
must be positioned with its long side toward the center of the cuff. 
 
 
Figure 16. Bladder Insertion (2) 
 

 Right Arm  Left Arm 
  Opening   Opening 
 
 
 
 
 
 
 
 
 
 
 
3.1.9.2 Bladder Removal: 
 
To remove the bladder, pull the bladder through the hose exit opening.  Once the bladder has been 
removed, mate the hook and loop surfaces before washing. 

BLADDER 
(Shown inserted into cuff wrap for left    
arm application) 
 

ARTERY 
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3.2 Operations Overview for Jackson Heart Study 
 
3.2.1 Technology 
 
Ambulatory Blood Pressure Monitoring (ABPM) will be completed using the Medifacts research 
software, Spacelabs 90207 Oscillometric Device, and a laptop with modem.  
 
3.2.2 ABPM Service / Support 
 
Medifacts, Ltd., Rockville, MD (1-800-333-6460) will supply a laptop and a proprietary centralized 
software program to the clinical research center.  Medifacts will also supply ABP monitors, a full range of 
cuffs, carrying pouches, shoulder strap belts, batteries, and any other disposable supplies or equipment 
necessary to perform ambulatory blood pressure monitoring (ABPM) on study participants.   
 
A Medifacts representative will provide, an on site training program on the use of ABPM and will review 
the ABPM instruction manual prior to the first scheduled ABPM. 
 
3.2.3 ABP Monitoring Schedule 
 
The 24-hour ABP monitoring will occur one time during the protocol.  Participants should report to the 
study center during the study-specified time frame.  The Medicom software will evaluate the quality 
control criteria when the device is returned and the data is downloaded to the laptop. 
 
If the ABPM does not meet the quality control criteria, it may be repeated within the next 6 months.  
If a report fails quality control, the clinical center should call Medifacts immediately after transmitting 
the file to discuss the reasons for report QC failure.  
 
• ABPM Application Day  
 
Participants will be instructed in the proper use, application, and removal of the ABPM device during the 
clinic visit.   
 
• ABPM Removal Day 
 
Participants return to the clinic 24 hours after the previous morning’s application, for the removal of 
the ABPM unit.  If the participant is unable to return to the clinic to have the unit removed, a 
representative from the Jackson Heart Study will arrange for device retrieval.  
 
3.2.4 Office Visit 
 
Participants will have the ABPM applied at the end of their visit procedures for the visit day.  There is no 
required time window for ABPM application. 
 
The ABPM will be applied to the participant and correlation readings performed.  After successful 
completion of the correlation procedure, the study investigator or coordinator will prompt a valid 
“Beginning of Test” reading.   
 
3.2.5 ABPM Cuff / Arm Circumference 
 
The ABP monitor will be applied to the participant’s NON-DOMINANT arm.  This will be the arm opposite 
of that being used for office “cuff” BP measurements.  A centimeter measuring tape will be provided to 
determine the participant’s arm circumference measurement, which is obtained on an extended arm at 
the midpoint of the upper arm.  Medifacts will provide a range of ABPM cuffs to each site: 
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• Youth cuff range:  17- 26 cm 

• Adult regular cuff range: 24 - 32 cm 

• Adult large cuff range: 32 - 42 cm 

• Adult extra large range: 38 - 50 cm 
 
The non-dominant arm used for ABPM cuff placement will be recorded on the Pre-ABPM form that will 
be retained as a source document.   
 
3.2.6 Correlation Readings 
 
Each ABPM will be preceded by the correlation of simultaneous blood pressure (BP) readings between 
the ABP monitor and the office mercury sphygmomanometer via a "T" tube connector.  With the 
participant in a SEATED position, three to five valid readings will be taken to compare the office BP with 
the readings taken by the ABP monitor.  These readings will be recorded on the Pre-ABPM form. 
 
The mean of the three selected office diastolic blood pressures and the mean of the three 
corresponding valid ABPM diastolic blood pressures may not differ by more than + 7mmHg.  
 
The ABPM device is automatically programmed for “5 live” readings in order to accomplish this validation 
process.  If the correlation procedure is unsuccessful, the ABPM must be reprogrammed to obtain an 
additional “5 live” readings and the process must be repeated.  When recording the observed readings 
use the time as displayed on the ABP monitor.  After successful completion of the correlation procedure, 
a mark identifying proper placement of the cuff will be drawn on the participants’ arm.  See Section 3.4 
for a detailed instruction. 
 
3.2.7 Beginning of the Test  
 
The beginning of the 24-hour monitoring period is identified after the successful completion of the 
correlation procedure.  The quality control criteria for ABPM readings are based on the 24-hour 
Beginning of Test to Conclusion of Test period.  
 
Following the successful completion of the correlation procedure, the study coordinator will manually 
initiate the ABP monitor to take a reading.  For the purposes of quality control, this initiated reading will 
designate the “Beginning of Test” (Time Monitoring Begun). Using the clock display on the ABP 
monitor, the date and time of this initiated reading will be recorded in the Pre-ABPM form.  
 
All readings obtained prior to the valid “Beginning of Test” reading will be designated with an edit code of 
CR.  The Medicom software program is designed to disregard any reading with an edit code of CR when 
calculating quality control. 
 
3.2.8 ABPM Device - Data Display Blinding 
 
The ABP monitor will be automatically programmed to blind the data.  Five "live" (un-blinded) readings 
will be displayed at the beginning of the monitoring for the correlation readings.  
 
3.2.9 Monitor Inflation Frequency 
 
The monitor will be automatically programmed to inflate at the following frequency: 
 
• Every 20 minutes for 24 hours 
 
3.2.10 Monitor Deflation  
 
The ABPM device will be automatically programmed to deflate at a rate of 8mmHg per 2 heartbeats. 
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3.2.11 ABPM Duration 
 
The total duration of each ABPM will be 24-hours from the “Beginning of Test” initiated reading.  The 
participant must be instructed on the following items: 
 

• Maintain his/her usual activity level during the monitoring period. 

• Do not engage in strenuous exercise or activities during the monitoring period. 

• Hold arm still and extended at his/her side during an automated or, if required, manually prompted 
reading. 

• Avoid removing the ABPM monitor during the monitoring period. 

• Review information regarding the general care of the ABP monitor. 

• The individual is instructed not to shower or take a bath during the ABP monitoring period 

• The individual will be instructed on proper re-application of the ABPM unit if removal is 
necessary during the 24-hour period. 

 
3.2.12 Conclusion of the Test 
 
The conclusion of the monitoring is considered to be the last valid blood pressure reading obtained. 
 
Prior to removal of the ABP monitor, a manual reading must be initiated to conclude the test.  The 
"Conclusion of Test" (Time Monitoring Ended) reading should not be initiated until at least 24-hours 
following the “Beginning of Test” reading.  After assuring that the reading is valid (i.e., no error codes) the 
monitor is then removed.  The “Conclusion of Test” time and date is recorded in the Post-ABPM 
Form using the display clock on the ABP monitor. 
 
If it becomes necessary for a participant to remove the ABPM device, a manual reading should still be 
initiated to conclude the test.  The “Conclusion of Test” time and date should be recorded by the 
participant.  This information is required for the Post-ABPM Form. 
 
3.2.13 Data Editing Criteria 
 
Data is edited based on the following criteria: 

• Minimum Valid Systolic  = 060 mmHg 

• Maximum Valid Systolic  = 261 mmHg 

• Minimum Valid Diastolic  = 030 mmHg 

• Maximum Valid Diastolic  = 151 mmHg 

• Minimum Valid Sys – Dia  = 015 mmHg 

• Maximum Valid Sys - Dia  = 140 mmHg 

• Minimum Valid Heart Rate  = 030 bpm 

• Maximum Valid Heart Rate  = 150 bpm 
 

If a reading falls outside of these limits, it will be considered as not valid and is thereby eliminated from 
the quality control process.  Data will be further edited using a process termed by Medifacts as “Suspect 
Data”. This process identifies readings, which fall within the editing criteria described above, but are two 
standard deviations greater than or less than either the 24-hour mean or the hourly mean for that 
reading. 
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3.2.14 ABPM Quality Control Criteria 
 
The Medicom research software automatically evaluates the quality control criteria.  One of the following 
messages will be displayed on the computer screen to indicate the results of a monitoring: 
 
QUALITY CONTROL = PASSED  
 or  
QUALITY CONTROL = FAILED 
 
The software will automatically place a “QC” code (1 = PASS or 3 = FAIL) on the first page of the ABPM 
report to indicate the quality control results.   
 
The following are the minimum quality control criteria: 

• There must be a minimum of 24-hours of data following the “Beginning of Test” time  

• Each hour must have a minimum of 1 valid reading 

• There must be a minimum of 54 valid readings  (75% of the 72 programmed readings) 
 
If a participant monitoring FAILED to meet the minimum quality control criteria, please contact 
Medifacts to discuss criteria for failure prior to the participant’s departure from the Exam Center.  
There may be allowance for acceptance of this monitoring or the participant may be asked to 
repeat the ABPM procedure. 
 
3.2.15 Repeat ABPM 
 
After discussion with Medifacts, a monitoring failing to meet acceptable quality control criteria may be 
repeated.  All repeat monitorings must be scheduled to occur within 1 month of the failed attempt. 
 
3.2.16 Night Shift Participants 
 
Participants who work third shift (i.e. sleep during the day and work over night) can participate in the 
ABPM. 
 
3.2.17 Participant Documentation  
 
Each participant will be supplied with a Participant Instruction Handout.  An activity diary card will not 
be used during this study 
 
3.2.18 Participant Report   
 
Two hard copies of the participant’s ABPM report will be sent to the clinical center on a weekly basis.  A 
copy of the ABPM report should be kept in the participants’ source documents.  
 
3.2.19 Monthly Activity Report 
 
An ABPM activity report will be sent to the clinical center at the end of each month. The report should be 
reviewed carefully and any discrepancies should be reported to Medifacts.  These updates can be 
communicated via phone, fax or e-mail. 
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3.3 Introduction to the Medicom ABPM Software 
 
3.3.1 Introduction 
 
The Medifacts Ambulatory Blood Pressure Monitoring (ABPM) communications software is a proprietary 
software program written exclusively for use when conducting ABPM research.  Your version of the 
software has been programmed specifically for this protocol.  Do not make any adjustments to the 
programming or setup of the software without first speaking to your Medifacts data manager. 
 
The software will allow you to program a monitor, download the ABPM data, check quality control, run 
data statistics (if applicable), enter required demographic and activity information (if applicable) and 
transfer data to Medifacts via modem.  Actual software applications may vary depending on protocol 
requirements. 
 
3.3.2 Turning the Computer On  
 
Be sure that the data key and monitor cable are attached to their appropriate ports on the computer (see 
Section 3.1).  Turn your computer ON using the computer ON/OFF switch. 
 
The computer will automatically load the MEDICOM program software.  The computer will then display 
the Windows screen.  The desired study protocol must then be selected by double clicking on the 
appropriate icon.  The following logo will then appear on the screen: 
 
 
 
 M E D I F A C T S 
 
 MEDICOM - Version 3.41 
 
 Copyright 1999 Medifacts Ltd. 
 

01-01-2000 09:00:00 
 
 
The date and time that appear are based on a real time clock/calendar inside of your computer.  Please 
verify that the TIME and DATE are correct.  If so, press the <ENTER> key and the "MEDICOM MAIN 
MENU" will appear.  If not, you can update this information the first time you program a monitor. 
 
3.3.3 Software Menus and Their Functions 
 
The MEDICOM software contains two principal menus and two secondary menus. 
 
The two principal menus are: 

• The MAIN MENU 

• The EDIT DATA MENU 
 
The two secondary menus are: 

• The SETUP MENU 

• The DISPLAY DATA MENU 
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All of the programming functions that you require will begin with a selected option from one of these four 
menus.  The following pages provide a visual representation of each menu and a description of each of 
the menu options. 
 
Figure 17. Medicom Main Menu  
 

MEDICOM - MAIN MENU 
 
   1.  Program Monitor 
   2.  Read Monitor Data 
   3.  Edit Data 
   4.  Setup 
   5.  DOS Exit 
 
   Select an Option:  0 

 
The menu options are: 
 
1. Program Monitor: 

This option allows you to program participant information into the monitor prior to attaching it to the 
participant. 

2. Read Monitor Data: 
This option allows you to read or download data from the monitor to the computer after the 
participant monitoring is completed.  The data is then stored on the computer hard drive. 

3. Edit Data: 
When a data file IS ALREADY in the current computer memory, this option allows you to view the 
EDIT DATA menu.  When a data file is not already in the computer’s current memory this option 
allows you to select a data file from the hard drive and then view the EDIT DATA menu. 

4. Setup: 
This option, although rarely used, allows you to revise the program setup.  A Medifacts 
representative will call you with instructions if this option becomes necessary. 
There is a secondary menu behind the setup option.  The EQUIPMENT SETUP menu is explained in 
further detail on the following page. 

5. DOS Exit: 
This option allows you to exit the Medicom program to the Windows main screen.  This option will 
be used once a week for a weekly backup of data (see elsewhere in this section). 

 
To select an option, type the number of your choice and press the <ENTER> key. 

 
Figure 18. Medicom Equipment Setup Menu 
 

EQUIPMENT SETUP 
 
   1.  Communications 
   2.  Printer 
   3.  Test Mode 
   4.  Select Paths & Data 
   5.  Exit & Save 
 
   Select an Option:  0 
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Except to change from TEST MODE to PATIENT MODE this menu is rarely used.  If it becomes 
necessary to make other setup changes, a Medifacts representative will instruct you in its use.   To 
access this secondary menu, type “4” for SETUP from the Medicom MAIN MENU and press the 
<ENTER> key.  You will see the following menu options: 

 
1. Communications: 

This option allows you to setup the modem to transmit ABPM data to Medifacts. 

2. Printer: 
This option allows you to setup the serial port for the monitor cable.  Your version of the Medicom 
software does not contain the print function.  

3. Test Mode: 
This option is used only ONCE during the protocol and allows you to change the automatic file ID 
generator from the TEST MODE to the PATIENT MODE.  This will be done only once during the 
protocol  (see section 8.0 of this tab). The setup screen will usually be to change programming 
modes from TEST MODE to PATIENT MODE.   

4. Select Paths and Data: 
This option allows you to change the data path.  

5. Exit and Save:  
This option allows you save any changes that have been made to the program setup. 

 
To select an option, type the number of your choice and press the <ENTER> key.  
 
Figure 19. Medicom Edit Data Menu 
 

EDIT DATA MENU 
 
   1.   Read Disk Data File 
   2.   Edit Patient Data 
   3.   Edit Activities 
   4.   Display Data 
   5.   Quality Control 
   6.   Send Data 
   7.   Main Menu 
 
   Select an Option:  0 

 
Edit Data Menu Options: 
 
1. Read Disk Data File: 

This option allows you to retrieve a participant data file from the computer’s memory (hard drive) 
where it is stored after "Reading Monitor Data" (downloading). 

2. Edit Patient Data: 
This option allows you to add or change participant information on the participant ABPM data file. 

3. Edit Activities: 
This option allows you to enter or change participant activity information in a participant data file, if 
required in the protocol.  This option allows you to view each reading taken by the ABPM monitor. 

4. Display Data: 
This option allows you to graphically view a data file.  There is a secondary menu behind the display 
data option.  The DISPLAY DATA menu is explained on the following page (section 3.4). 

5. Quality Control: 
This option allows you to re-run the Quality Control analysis. 
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6. Send Data: 
This option allows you to send a copy of the data file to Medifacts via modem. 

7. Main Menu: 
This option allows you to return to the Medicom Main Menu.  

 
To select an option, type the number of your choice and press the <ENTER> key. 
 
Figure 20. Medicom Display Data Menu 
 
DISPLAY DATA MENU 
 
   1.   Display raw data 
   2.   Display hourly average 
 
   Select an Option:  0 
 
Display Data Menu Options: 
 
1. Display raw data: 

This option allows you to graphically display each blood pressure and heart rate reading taken during 
the required monitoring period. 

 
2. Display hourly average: 

This option allows you to graphically display the hourly average of each blood pressure and heart 
rate reading taken during the required monitoring period.  The display will also indicate the number of 
readings used to calculate the average. 

 
To select an option, type the number of your choice and press the <ENTER> key. 
 
3.3.4 ABPM File in Current Memory  
 
In order to work with an ABPM file that has been downloaded from the monitor and stored on the 
computer hard drive, the file must be in the “Current Memory” of the computer.  An ABPM file is in 
“Current Memory” if the “ID” and “NAME” appear across the bottom of the computer screen.  If the ID 
and NAME do not appear across the bottom of the screen or if the information that appears on the 
screen is not the file that you are interested in, you can do one of the following to load the requested 
file into “Current Memory.” 
 
3.3.5 Loading an ABPM File into Current Memory 
 
3.3.5.1 To Load an ABPM File from the Main Menu 
If there is not a file in “Current Memory” and you are looking at the MAIN MENU, type “3” for “EDIT 
DATA” and press the <ENTER> key.   
 
ABPM files are stored by the FILE-ID.  To select the desired FILE-ID, use the appropriate arrow keys 
to move the "highlight" until the FILE-ID# becomes shaded and press the <ENTER> key, or at the 
"Enter file name" prompt, type the correct FILE-ID# in the space provided and press the <ENTER> 
key. Once a file is selected, the EDIT DATA Menu appears on the screen.  The “NAME and ID #” of 
the selected ABPM file will appear in the lower left corner of the screen. 
 
3.3.5.2 To Load an ABPM File from the Edit Data Menu 
 
If there is a file in “Current Memory” and you are looking at the EDIT DATA MENU, type “1” for READ 
DISK DATA FILE and press the <ENTER> key.  After completing this, follow the instructions listed in 
section 5.1. 
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3.3.6 Editing and Saving Data After Entry 
 
To enter data into an ABPM file, the file must first be in Current Memory (see sections 4.0 and 5.0).  
Once the file is in “Current Memory”, make your selection from the EDIT DATA menu. 
 
To enter data onto the EDIT PATIENT DATA screen, use the <ENTER> key to move your cursor 
FORWARD and use the ↑ (Up arrow key) to move your cursor BACKWARD between fields.  The ← (left 
arrow) and → (right arrow) keys will move the cursor left and right within a field. The DEL key will delete a 
character. The HOME key will take the cursor to the beginning of this screen. The END key will take the 
cursor to the last line on this screen.   
 
To save the data, move the cursor to the last line on the screen and press the <ENTER> key. The "Exit 
Editor" message below will appear.  If you would like to save your entries, press the ENTER key. If you 
would like to return to the participant data screen and not save your entries, press the “N” key. The ESC 
key also allows you to escape this screen without saving any entered data. 
 
Figure 21. Medicom Exit Editor Menu 
 
Exit Editor 
 
 Press Enter to Save Patient Data and Exit 
 Press "N" to return to Edit Patient Data 
 
 
 
 
3.3.7 Hard Drive Computer Data Backup  
 
All ABPM data, which resides on the computer’s hard-drive must be backed up (copied) to a diskette on a weekly 
basis.  You have been provided a backup diskette with this notebook.  Follow the instructions below to back up 
your data ONCE A WEEK.  
 

1. From the MAIN MENU, type “5” for DOS EXIT and press the <ENTER> key.  Insert the diskette 
labeled WEEKLY BACKUP into the disk drive of your computer.  

2. You will now be at the “Windows Main Screen” of the computer.  Locate the icon (small picture) for 
BACKUP.  Using the mouse on  your computer, move until the arrow is pointing over the BACKUP 
icon.  Press the mouse key twice in rapid succession (double-click).  A small box will appear to begin 
the backup. 

3. The system will automatically BACKUP or copy your data.  You will see the computer copy all of 
your data files to the diskette.  FINISHED BACKUP will appear at the top of the backup screen or 
you will automatically return to the Windows screen.  Remove the diskette and put it in a safe place.  
Move the cursor to the “x” in the upper right corner of this message to close the screen. 

4. You will return this diskette to Medifacts at the end of the study or earlier if a problem occurs with 
your computer.  If it becomes necessary to retrieve ABPM data files from the backup diskette 
onto your current computer, please call Medifacts.    

 
3.3.8 Changing from Test Mode to Patient Mode  
 
The computer was sent to you in TEST MODE, which allows you to practice with the computer and 
software prior to doing actual study participants.  The FILE ID number that is automatically assigned by 
the software while in the TEST MODE will be your four letter site ID, followed by a sequential “T” number 
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to indicate a test file (Example: KNEX-T01).  When programming a monitor in the TEST MODE, you will 
see a second flashing message box displaying "WARNING TEST MODE ACTIVE". 
 
You MUST change into the PATIENT MODE prior to beginning the study.  Once you have changed to 
PATIENT MODE you may no longer perform monitorings on practice participants.  When you change 
to PATIENT MODE, the FILE ID that is automatically assigned will be the 4 letter, site-specific code 
followed by a three-digit sequential number.  
 
To complete the change from the "EQUIPMENT SETUP" menu, type “3” for TEST MODE and press the 
<ENTER> key.  You will see the message “CHANGE TO PATIENT MODE?”.  Type “Y” for yes in the 
blank box and press the <ENTER> key to return to the "EQUIPMENT SETUP" menu.  Type “5” to EXIT 
& SAVE and press the <ENTER> key.  The computer is now in PATIENT MODE. 
 
3.4 Programming and Downloading the Monitor 
 
3.4.1 Programming the Monitor 
 
To program the monitor, you will do the following: 
 
1. Put fresh batteries in the monitor: 

The battery compartment is located on the back of the monitor.  To open the battery door, pull 
back and up on the battery compartment latch.  The lid will pop open.  Follow the schematic 
diagram on the inside of the lid to insert the batteries.  After inserting the batteries, replace the 
cover and secure the latch. 

 
NOTE:  It is very important to insert new batteries in the ABPM for each subject monitoring.  DO 
NOT attempt to do two monitorings without changing batteries. 

 
2. Attach the monitor to the monitor cable: 

With the monitor turned OFF (see the black ON/OFF switch on the bottom of the monitor), attach 
the "Monitor Programming Cable" to the data INPUT/OUTPUT area on the bottom of the monitor.  
Make sure that the ARROWS on the monitor and on the cable point toward each other.  Attach 
the monitor cable to the computer (See Section 3.1). 

 
3. Turn the monitor ON: 

Turn the monitor ON using the black ON/OFF switch. If the batteries are inserted correctly and the 
connection is satisfactory, "9999" or “1999” will appear on the monitor display screen.  The first digit 
may switch between a nine and a one. 

 
4. Program monitor: 

Each monitor MUST be programmed on the day that it is going to be applied to the participant 
because the ABPM start time and date are programmed by the computer.  If the participant cancels 
their appointment, the monitor MUST be re-programmed on the day of the participant’s rescheduled 
ABPM monitoring visit. 

 
From the "MEDICOM MAIN MENU", type “1” for PROGRAM MONITOR and press the <ENTER> key.  
You will see the "PROGRAM SpaceLabs 90207" screen with the message "Checking SpaceLabs 
Monitor" on the bottom.  You will hear a soft "beep" tone from the monitor and you will see a dark bar 
with a blinking cursor next to the "NAME" FIELD.  The message at the bottom of the screen will tell 
you to "Enter Patient Data". 
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Figure 22. Medicom Program Monitor Screen 
 
Program SpaceLabs 90207 V3.41 

NHLBI-Jackson Heart Study     
 

 Name: __ __ __ - __ __ -__ __ __- __ __ __ __- __ __ 
 ID #:  JSA1-001  
 Note: 
 Date:  04/07/2000  Time:  09:10 

      
 

Press Enter to Continue 
 
 
5. Enter the participant name field: 

When programming a monitor, you will be asked for the NAME.  With the blinking cursor next to 
"NAME", type in the PARTICIPANT NAME FIELD.  The NAME will be created using the following 
components to maintain the participant’s confidentiality rights. 

 
The participant's three initials:   [MAX] 
If there is no middle initial use a hyphen:  [M-X] 
The participant's Date of Birth:   [31-MAY-1985]  
      dd-mmm-yyyy 
The event code:     [11] (ABPM #1) 
      [21] (ABPM #2) 

 
The first digit of the event code represents the ABPM visit and the second digit represents the 
attempt.  

 
 EX: PARTICIPANT NAME FIELD:  MAX-31-MAY-1956-11 

 
If the ABPM for the first visit fails Quality Control, then the repeat attempt will have an event code 
of “12”. 

 
  EX: REPEAT PARTICIPANT NAME FIELD: MAX-31-MAY-1956-12 
 
6. When you finish the  “NAME” field, press the <ENTER> key and record this information on the 

correlation worksheet and FILE ID log which are located in the back of this notebook.  Your cursor 
will move to the “NOTE” field.  Typically, this field is left blank (See section 1.7). 

 
7. Record the File ID: 

The FILE ID is entered automatically by the software and is used to store the ABPM data on the 
computer hard drive.  Record the FILE ID on the correlation worksheet.  Please be sure that the FILE 
ID displayed on the computer corresponds to the correct protocol. 

 
8. Entering “Note” section information: 

There is only one line for notes during programming.  In this study, there is no required information 
for the NOTE lines.  Please leave this line BLANK.  Press the <ENTER> key to move to the “DATE” 
field. 

 
9. Verify the date: 

The “DATE” is usually in the MM-DD-YYYY format for U.S. protocols or DD-MM-YYYY for European 
protocols and is automatically entered for you by the internal clock/calendar in the computer.  Please 
verify that the DATE is correct.  If so, press the <ENTER> key and your cursor will move to the 



 

Exam 1 Blood Pressure Manual.doc 

“TIME” field.  If the date is incorrect, type in the correct “DATE” in the correct format for your protocol 
(i.e., U.S. versus European). 

 
10. Verify the time: 

The “TIME” is in 24-hour format and is automatically entered for you by the internal 
clock/calendar in the computer.  Please verify that the TIME is correct.  If so, press the <ENTER> 
key and the software will program the monitor.  If the time is incorrect, type in the correct “TIME” 
in the HH: MM format. 

 
11. Verify that DONE appears - you have completed programming: 

After pressing the <ENTER> key to program the monitor, you will see the message “WAIT”, followed 
in a few seconds by the message “DONE PRESS ENTER TO CONTINUE”.  When you see this 
message, the programming is complete and you may press the <ENTER> key to return to the MAIN 
MENU.  Turn your monitor OFF, disconnect it and it is ready to apply to the participant.  

 
12. Monitor Labels: 

If this is the only monitor that you are programming for that day, you can turn your computer OFF. At 
the end of this notebook, you will find monitor labels.  After  programming a monitor, record the 
Name field, File ID, and monitoring date on a label.  Affix the label to the programmed monitor so that 
it can be selected and applied to the intended participant.  If you have other monitors to program, 
repeat the above steps.  

 
3.4.2 Using the File ID Logs 
 
At the end of this notebook, you will find sets of FILE ID LOGS containing the FILE IDs that have been 
pre-assigned to your site.  The logs are used to record the NAME FIELD for each ABPM FILE ID done 
during the protocol.  The FILE ID will be automatically assigned to the participant's ABPM file by the 
MEDICOM software each time you program a monitor.  The following are detailed instructions to 
complete the FILE ID logs.  The File ID log MUST be filled in each time a monitoring is done so you 
can readily identify an ABPM file to a particular participant in each of these studies. 
 
• The FILE ID is a numbering sequence made up of a four-letter code and a sequential, three-digit 

number.  The FILE ID is used to label the ABPM file and store it in the computer.   
 
• The PARTICIPANT NAME FIELD is used to identify the participant data recorded during the 

monitoring period.   
 
• The PATIENT ID is also used to identify the participant data recorded during the monitoring period.  
 
• The DATE MONITORED column will indicate the date that the monitor was applied to the participant. 
 
• The FILE SENT column will indicate that the participant monitoring is complete, you have 

downloaded the file from the monitor and stored it in the computer, entered all required participant 
documentation information, and have SENT (transmitted) the file to Medifacts via computer 
modem. 

 
• The REPORT RECEIVED column will be used to indicate that you have received a hard copy of the 

participant report from Medifacts. 
 
When you program your monitor, turn to your FILE ID LOGS and find the FILE ID that the computer has 
assigned in the FILE ID column.  
 
1. Record the "PARTICIPANT NAME FIELD" created when programming the monitor (See section 

1.5). 
 
2. Record the PATIENT ID assigned for the participant. 
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3. Write down the date that you are applying the monitor to the participant in the column entitled "DATE 

MONITORED". 
 
4. After entering the required participant information into the ABPM file, you will SEND (transmit) a copy 

of the file to Medifacts via computer modem.  After successfully sending the file to Medifacts, place a 
check mark in the column entitled FILE SENT. 

 
5. When you receive the hard copy participant ABPM report, place a check mark in the column entitled 

REPORT RECEIVED. 
 
3.4.3 CORRELATION PROCEDURES  
 
When you apply a monitor to a participant, you will initially complete a correlation procedure as shown 
below to evaluate the monitor and your mercury column. 
 

 
 
1. Obtain the Pre ABPM Form to be used for recording correlation blood pressures.  
 
2. Measure the participant’s arm circumference to determine the appropriate cuff size: 
 
   Pediatric: 17 - 24 cm.  
   Adult  Regular: 24 - 32 cm.  
   Adult  Large: 32 - 42 cm. 
   Adult XLarge: 42 - 50 cm. 
 
3. Place the appropriate size cuff on the NON-DOMINANT arm of the participant. 
 
4. Attach the T-Tube to the monitor, and then attach the ABP cuff air hose and the mercury column 

tubing to the T-Tube.  
 
5. Turn the monitor ON.  
 
6. Prepare to take the participant's SEATED BP by positioning the stethoscope directly over the 

brachial artery.  
 
7. Push the START/STOP button once.  After a five-second displayed countdown on the monitor, the 

monitor will inflate to approximately 165-170 mmHg. 
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8. As the monitor measures the SEATED BP electronically, observe the mercury column. Record the 
SEATED systolic and diastolic BP you measured and the SEATED systolic and diastolic BP 
displayed by the monitor on the correlation worksheet.  The monitor displays the systolic BP, diastolic 
BP and heart rate data, respectively, three successive times within 15 seconds of completion of the 
BP measurements.  

 
9. If it is necessary to readjust the cuff and if the difference between the Diastolic BP readings is > 5 

mmHg and/or the difference between the Systolic BP readings is > 10 mmHg then do the following: 
 
10. Reprogram the monitor.  Enter the original “NAME.”  A new File ID will  be assigned. 
 
11. Check position of the cuff. 
 
12. Check tightness around the arm 
 
13. Arm should be motionless 
 
14. Complete a new Pre ABPM Form for the repeat correlation readings. 
 

NOTE:  If the cuff requires adjustment, the correlation readings taken prior to the cuff adjustment 
must be REJECTED.   

 
15. Repeat the prompted correlation readings up to four more times (a total of 5 live readings are 

available for correlation).  Record the BP measurements you measured as well as those displayed 
by the monitor each time.  Wait at least 60 seconds between each BP measurement.   

 
Use three successful readings to calculate the average diastolic BP.  If at any time there are 
problems correlating the monitor with the mercury column, please call MEDIFACTS for assistance.  

 
16. The mean (average) difference between three acceptable simultaneous monitor and office mercury 

column diastolic BP readings should be calculated to determine if you meet your  protocol’s 
correlation criteria (See Section 3.2.6). 

 
17. When the correlation criteria are met, disconnect the T-Tube (you do not need to turn the monitor 

off).  Connect the air hose directly to the monitor and place it in the pouch.  Attach the pouch to the 
participant, using either the shoulder strap or belt. 

 
18. After completing the correlation readings prompt for the “Beginning of Test”.  The “Beginning of Test” 

reading must be valid (i.e., no error codes displayed).   
 
3.4.4 READ MONITOR DATA 
 
Prior to removing the monitor (upon completion of the 24-hour monitoring period), the study coordinator 
will manually initiate a reading to "Conclude the Test".  After verifying that a final valid reading was 
obtained (no error codes observed), the monitor is then removed from the participant, downloaded, and 
the data reviewed immediately by the coordinator for quality control compliance using the MEDICOM 
software.  The "Conclusion of Test" reading MAY NOT be initiated until it has been at least 24-hours post 
“Beginning of Test”.   
 
To read monitor data (download) from the monitor, turn ON your computer and complete the following 
steps: 
 
1. Attach the monitor to the monitor cable: 

With the monitor turned OFF, attach the "Monitor Programming Cable" to the data INPUT/OUTPUT 
area on the rear of the monitor.  Make sure that the ARROWS on the monitor and cable point toward 
each other. 
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2. Turn the monitor ON: 

Turn the monitor ON using the black ON/OFF switch.  If the batteries are in correctly and the 
connection is complete, "9999" or “1999” will appear on the monitor display screen. 

 
3. Read monitor data:  

From the "MEDICOM MAIN MENU", type “2” for READ MONITOR DATA and press the <ENTER> 
key.  You will see the "READ SPACELABS 90207 V3.41" screen with the message "Wait" on the 
bottom.  You will hear a soft "beep" tone from the monitor and you will see the message "Reading 
Initialization Data".  The readings will be counted and the message "Saving data to disk" will be seen. 

 
4. The participant’s ABPM data has now been saved to the computer’s hard drive and is in Current 

Memory.  The monitor may now be programmed for another participant. 
 
5. NOTE:  Existing ABPM data will be permanently deleted from a monitor the next time you program 

the monitor.  Therefore, DO NOT program a monitor (e.g., type “1” from the Main Menu) before 
downloading the existing data to the computer. 

 
6. Verify that DONE appears.  You have completed downloading: 

When the message "DONE PRESS ENTER TO CONTINUE" appears, press the <ENTER> key to 
initiate the automatic "QUALITY CONTROL" process. 

 
If the process of "Reading the Data From the Monitor" is not successful, you may see one of the following 
messages: 
 
• MONITOR READ FAILURE 
 
 Solution: 
 

1. Check to make sure that the batteries are in the monitor correctly. 

2. Check that the monitor is turned on and "9999" or “1999” appears on the screen. 

3. Check that the monitor cable is firmly attached to the monitor. 

4. Check that the monitor cable is firmly attached to the computer. 

5. After checking your connections, repeat the downloading process. 
 
• DATA FILE EXISTS  (Overwrite Existing file) 
 
 This message indicates that a data file with the same FILE ID# is already present in the 

computer. 
 
 If you see this message, you will be asked to "Overwrite Existing File" Y/N. Type <N> and you 

will see the message "ERROR - DATA NOT SAVED".  Call MEDIFACTS immediately. 
 

3.4.5 Automatic Quality Control 
 
To run quality control, you will complete the following steps using the information from your Pre-
ABPM Form:  Identify the beginning of test reading; identify the conclusion of test reading; review the 
results.  The "QUALITY CONTROL" criteria for this protocol have been pre-programmed into the 
software.  The ABPM file will be automatically evaluated and you will receive a message as to its 
status (PASSED or FAILED).   
 
3.3.5.1 Identify the Beginning of Test reading 
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The first step in the "QUALITY CONTROL" process is to choose the "Beginning of Test" reading. You 
will see two prompt boxes.  The "EDIT CORRELATION READINGS" prompt box with the first eight 
readings of the monitoring period on the screen may look like this: 
 
Figure 23. Edit Correlation Readings Prompt Box 
 

 Edit Correlation Readings 
 
 #      TIME SYS DIA PP HR  CODE   EDIT ACTIVITIES 
 
 1    8:48 152 97 55 71 0 
 2    8:50 145 89 56 66        0 
 3    8:52 152 94 58 60        0 
 4    8:54 155 92 63 53        0 
 5    9:02 157 92 65 60        0 
 6    9:17 170 109 61 50        0 
 7    9:32 169 115 54 63        0 
 8    9:47 152 102 50 65 0 
  
 
Below this prompt box, you will see the following “EDIT CORRELATION READINGS” (Beginning of 
test) prompt box. 
 
Figure 24. Edit Correlation Readings (Beginning of Test) Prompt Box 
 

Edit Correlation Readings (Beginning of Test) 
 

Use the arrow keys to move the highlight bar 
to highlight the reading which represents the 

 
BEGINNING OF TEST 

 
Press "B" to select the highlighted reading 

 
 
Using the ↑ and ↓ ARROW keys, move the cursor to highlight the appropriate "BEGINNING OF TEST" 
reading (usually the first reading following the correlation readings) and press "B". At the next prompt box 
(see below ) you are asked to verify your selection.  If you have chosen the correct "BEGINNING OF 
TEST" reading, press the <ENTER> key.  If you selected the incorrect BEGINNING OF TEST reading, 
press the <N> key to select another reading.  
 
Figure 25. Edit Correlation Readings (Beginning of Test) Prompt Box #2 
 

Edit Correlation Readings (Beginning of Test) 
 
Does this reading represent the      "BEGINNING OF TEST"  
 
   4      8:54    155 92   63   53 BEGINNING OF TEST 
 

If Yes press Enter to continue 
If No press "N" to select another reading 
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3.4.5.2 Identify the Conclusion of Test reading 
 
The next step in the quality control process is to choose the reading, which represents the "Conclusion of 
Test".  The Conclusion of Test reading is generally considered to be the last valid prompted reading 
and should occur at least 24-hours following the "Beginning of Test" reading.  You will see the "EDIT 
CORRELATION READINGS" box with eight blood pressure readings on the screen.  The prompt box 
may look like this: 
 
Figure 26. Edit Correlation Readings Prompt Box 
 
 Edit Correlation Readings 
 
#      TIME SYS DIA PP HR    CODE    EDIT ACTIVITIES 
 
101   8:48 152 97 55 71 0 
102   8:50 145 89 56 66        0 
103   8:52 152 94 58 60        0 
104   8:54 155 92 63 53        0 
105   9:02 157 92 65 60        0 
106   9:17 170 109 61 50        0 
107   9:32 169 115 54 63        0 
108   9:47 152 102 50 65        0 
 
Below the eight readings you will see the following "EDIT CORRELATION READINGS (Conclusion of 
Test) prompt box: 
 
Figure 27. Edit Correlation Readings (Conclusion of Test) Prompt Box 
 
  Edit Correlation Readings (Conclusion of Test) 
 
  Use the arrow keys to move the highlight bar 
  to highlight the reading which represents the 
 
   CONCLUSION OF TEST 
 
  Press "C" to select the highlighted reading 
Using the ↑ and ↓ ARROW keys or "PGDN" or "PGUP" keys, move the cursor to the appropriate 
"CONCLUSION OF TEST reading and press "C".  If the appropriate "Conclusion of Test" reading does 
not appear on the first screen of eight readings use the PGDN key to move to the next screen of eight 
readings.  After pressing the "C" key, the following prompt is displayed: 
 
Figure 28. Edit Correlation Readings (Conclusion of Test) Prompt Box #2 
 

Edit Correlation Readings (Conclusion of Test) 
 

Does this reading represent the  "CONCLUSION OF TEST 
 

108    9:47     152   102    50   65           CONCLUSION OF TEST 
 

If Yes press Enter to continue 
If No press "N" to select another reading 
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At this prompt, you are asked to verify your selection.  If you have chosen the correct "CONCLUSION 
OF TEST" reading, press the <ENTER> key  to complete the Quality Control evaluation.  If you 
selected the incorrect CONCLUSION OF TEST reading, press the <N> key to select another reading.  
 
3.4.5.3 Review the Results 
 
After pressing the <ENTER> key, the software will perform the quality control analysis and will display 
results in the "QUALITY CONTROL ANALYSIS" prompt box.  If the report PASSED Quality Control, you 
will see:  Quality Control:  PASSED.  Press your <ENTER> key to continue.  If the report FAILED 
Quality Control, you will see:  Quality Control:  FAILED.  The reasons for failure are listed on the 
screen.  Press the <ENTER> key to continue. 
 
NOTE:  If the report FAILS, call Medifacts immediately after transmitting the file. 
 
3.4.5.4 Failure Analysis Messages: 
 
The following messages may be seen when reviewing the "Quality Control Failure Analysis": 
 
3.4.5.4.1 Test duration - HH:MM - Too Short: 
 
This message indicates that the total time of the test (from the first valid reading to the last valid 
reading) is less than the minimum required by the protocol. 
 
3.4.5.4.2 Incorrect Start time: 
 
This message indicates that the "Beginning of Test" reading was taken outside of the allowable 
Beginning of Test time window. 
 
3.4.5.4.3 Consecutive Invalid Hours: 
 
This message indicates that there were consecutive hours with less than the minimum required number 
of valid readings for a valid hour. 
 
3.4.5.4.4 Too Few Valid Hours: 
 
This message indicates that the report has less than the minimum number of   valid hours.  
 
3.4.5.4.5 Too Few Valid Readings: 
 
This message indicates that the report had less than the required minimum   number of valid 
readings.  
 
3.4.5.4.6 Too Few Valid Hours in Period (X): 
 
This message indicates that during a specific time period there was less than the required minimum 
number of valid hours. 
 
3.4.5.4.7 Too Few Valid Readings in Period (X): 
 
This message indicates that during a specific quality control period there was less than the required 
minimum number of valid readings. 
 
To better understand why the report failed quality control, you can view the actual blood pressure 
data (See "Edit Activities" or "Display Data", hourly averages).  These options are not available with 
blinded protocols. 



46 

Exam 1 Blood Pressure Manual.doc 

 
3.4.6 EDIT PATIENT DATA  
 
The MEDICOM software is programmed to move you directly to the EDIT PATIENT DATA screen 
following the completion of the automatic statistics evaluation.  
 
This protocol requires the following demographic data to be entered onto the EDIT PATIENT DATA 
SCREEN of each ABPM file during the download process.  This information must be entered prior to 
modem transmitting the report to Medifacts.  When you enter this screen, your cursor will be 
positioned next to "NAME". Verify that the name field entered during programming is correct and 
press <ENTER> to continue.  To move the cursor between the fields described below, use the 
<ENTER> or <ARROW DOWN> key (see Section 3.3).  After completing the required entries, you will 
save the data as also described in Section 3.3.  An example of the Edit Patient Data Screen is provided 
at the end of this section. 
 
The information that you recorded on the correlation worksheet should be entered onto this screen.  
Please refer carefully to the correlation worksheet when transferring the information. 
 
• NAME: 

This information will be entered when programming the monitor.  There is no need to re-enter it again 
unless it is incorrect. 

 
 EXAMPLE:  MAX-31-MAY-1956-11  

 
• PATIENT ID: 

This field will indicate the participants’ identification number.  Please enter the seven-digit 
number. 

 
    EXAMPLE:  J000003   
 
• QC CODE: 

This field will be entered automatically by the MEDICOM software.  The field will indicate whether 
or not the report passes quality control.  NO ENTRY NECESSARY. 

 
    EXAMPLE:  QC CODE    1  (PASS)  
            QC CODE    3  (FAIL) 
 
• QC STATUS: 

This field, which is used by Medifacts, will contain a quality control status code if the report does not 
pass quality control.  NO ENTRY IS NECESSARY 

 
• SPONSOR: 

This field will be pre-coded with the sponsor information.  NO ENTRY IS NECESSARY. 
 
• CONTACT OCCASION: 

This field will be pre-coded with the contact occasion number.  NO ENTRY IS NECESSARY. 
 
• FORM CODE: 

This field will be pre-coded with the form code.  NO ENTRY IS NECESSARY. 
 
• VERSION NUMBER 

This is an internal code used by Medifacts.  NO ENTRY IS NECESSARY. 
 
• ID NUMBER: 

This is the File ID. NO ENTRY IS NECESSARY. 
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• NOTES: 

Two note lines are provided for special comments.  NO ENTRY IS NECESSARY. 
 
Figure 29. Documentation Example for Jackson Heart 
 

Edit Patient Data 
 
 
 
    PATIENT DATA           SITE DATA 
 
 
NAME:    MAX-31-MAY-1985-11      NHLBI-JACKSON HEART STUDY PATIENT ID:   J123231
        CONTACT OCCASION: 01 
QC CODE:    1                   FORM CODE: AMBA 
         
          MEDICOM 3.41 FINAL 
 
 
          ID #:  JSA1-001 
         
 
 
    
 
 
 
QC STATUS:    
 
NOTES: 
 
 
 
 
 
 

To Exit, Hold Ctrl then Press Enter 
 
3.4.7 Re-Run Quality Control 
 
QUALITY CONTROL may be re-run at a later time without re-reading (downloading) the data from the 
monitor. 
 

1 Retrieve the desired ABPM File ID from memory (See Section 3.3). 

2 From the "EDIT DATA" menu, type “5” for "QUALITY CONTROL" and press the <ENTER> key.  
The prompts described in section 6.0 will be repeated. 

 
3.4.8 Sending Data Via Modem to Medifacts 
 

1. When you turn on the computer, you should hear tones that indicate the internal modem was 
initialized and you will be able to transmit files to Medifacts.  If you did not hear these tones or do 
not hear dialing tones during the actual transmission into Medifacts, you must restart your 
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computer (Section 3.1).  Prior to sending data, please verify that all required protocol information 
has been added to the participant data file by reviewing the "Edit Patient Data" screen. 

2. Verify that your computer is turned ON and that the telephone cord is connected to the computer 
modem jack and the telephone jack. 

3. Verify that the file that you want to send to Medifacts is in the Current Memory by checking that 
the “Name and File ID” are present in the lower left corner of the screen. 

4. From the "EDIT DATA MENU", type “6” to "SEND DATA" and press the <ENTER> key.  You will 
hear dialing tones and a modem (fax-like) connection. 

5. When the data has been sent, "DONE" will appear on the “SEND DATA" screen.  Press the 
<ENTER> key to return to the "EDIT DATA" menu. 
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3.5 Participant Instructions  
 
3.5.1 Participant Scheduling (Reminder Call, Attire) 
 
The day prior to the ABPM visit, call to remind the participant of his/her visit time.  Schedule enough time 
to do the correlation readings and all other required protocol procedures prior to "Beginning of Test".  The 
participant should wear loose fitting clothing, especially around the arms, as the cuff will be applied 
directly against the skin. 
 
3.5.2 Wearing The Monitor (Dressing & Sleeping)  
 
1. Review the ON/OFF switch.  The participant SHOULD NOT turn the monitor OFF or prompt for any 

blood pressure readings during the monitoring period unless it is an emergency or he/she is told to 
do so by the Study Coordinator. If the monitor is not taking scheduled readings, the participant 
should look at the monitor screen to see if the time is displayed. If the time is absent, the participant 
should check the ON/OFF switch.  If the time is present, then a technical problem may have 
occurred and the participant should call the contact person.  If the participant calls and indicates that 
the monitor is not taking scheduled readings, do the following: have the participant flip the ON/OFF 
switch several times, and then leave it on.  Tell the participant to initiate a reading using the 
STOP/START button.  If the monitor takes the reading, have the participant wait at least one-half 
hour to see if the monitor takes a regularly scheduled reading.  If the monitor does not take the 
reading, have the participant stop the test and return to the office. 

 
2. Show the participant how the monitor is attached to the belt or strap.  Make sure the participant 

understands how to unhook the belt without dropping the monitor.  The monitor SHOULD NOT be 
worn on the participant's own belt.  Use the belt provided. 

 
3. Review dressing procedures.  The cuff must be worn against the participant's skin.  The cuff hose 

must run up the participant's arm over the shoulder and down the other side. Clothing should go on 
over the top of the cuff and cuff hose.  The end of the hose that attaches to the monitor will be visible 
under the clothing.   

 
4. Demonstrate how the Velcro fastener works with a stress loop to take up excess hose. 
 
5. Inform the participant not to shower or to bathe during the monitoring process.  
 
6. The participant SHOULD NOT remove the cuff during the monitoring unless it is an emergency or 

unless instructed to do so by the Study Coordinator. 
 
7. Review undressing procedures.  If the cuff was applied correctly, the clothing should be easy to 

remove.  Remind the participant to be careful not to slide the cuff down the arm when removing a 
shirt or jacket. 

 
8. Review sleeping procedures.  The monitor must be placed in the bed beside the participant. DO 

NOT put the monitor on a night stand or any other piece of furniture outside the bed.  To muffle the 
sound, the monitor may be placed inside a pillow case. 

 
9. Mark a “T” on the participant's arm with an ink pen to indicate proper cuff placement in case of cuff 

shifting. 
 
3.5.3 Monitoring Instructions  
 
1. Write down the name of a contact person and the telephone number on the Participant Instructions 

Handout so the participant can call the office in the event of a monitor problem.  
 
2. Review the Instructions to Participants and Participant handout. 
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3. The monitor will inflate at 20 minutes for 24 hours. The tones will shut off at night in order to 

accommodate sleeping.   
 
4. Demonstrate a monitor error code for the participant (i.e., the hose kink). Explain the five "beep" 

tones heard when an error code occurs and review the error code text on the monitor screen.  The 
error code text will remain on the monitor screen for approximately 10 seconds, then it will return to 
display the time.  By demonstrating the error code, you can test the monitor error code system and 
make sure it is working properly before the participant leaves the office.  If one of these error codes 
occurs, the monitor will then re-try in two minutes to capture the reading.  

 
5. Participants should be instructed that if error codes are continuously observed, that they 

should call the contact person immediately. 
 
6. If the monitor screen returns to the clock before the participant was able to look at it, remind the 

participant that if an error code occurred, the monitor will repeat the reading in two minutes.  If the 
monitor is attempting a reading twice for every scheduled reading, the participant should call the 
contact. 

 
7. If the participant continues to get error codes, instruct him/her to call the contact person indicated on 

the handout.  When speaking to the participant, have him/her relax in a seated position. Then have 
him/her initiate a reading by pressing the monitor stop/start button.  Instruct the participant to read the 
monitor screen and tell you the error code that appears.  Take the appropriate action. 

 
8. Review the double beep tone heard prior to the monitor taking a reading.  Following the tone, there is 

a five second countdown prior to inflation.  If the participant is in a noisy environment, the tone may 
not be heard.   

 
9. Review the single beep tone heard when the monitor is successful in getting a reading.  When the 

participant is in a noisy environment, the tone may not be heard. 
 
10. Beeping tones prior to a reading, following a reading, and following an error code are programmed to 

be heard during the day.  The tone is turned off during the night.   
 
11. Review participant positioning during a reading.  If the participant is moving when the monitor begins 

to inflate, the participant MUST stop all movement.  If standing, instruct the participant to hang 
his/her arm down to the side and relax all muscle tension.  If seated, the participant should rest the 
cuff arm at approximately heart level in the lap and relax all muscle tension. 

 
12. The participant should attempt to perform a normal day of activity during the monitoring period.  

Remind the participant to remain still during a reading.  
 
13. Inform the participant of the ABPM removal /or return to clinic time on the following day.  This time 

MUST be at least 24 hours after the prompted "Beginning of Test". 
 
3.5.4 Error Codes 
 
The monitor is designed to be easily maintained.  If any problems develop, use the following 
information as a guide to solve them.  The monitor will display a two-digit event code whenever an 
event prevents the unit from successfully completing a blood pressure measurement. The two-digit 
code is preceded by the letters EC, for example EC01. 
 
The following list contains a brief description of the event codes which appear on the monitor display. 
 
• EC00 A) Too much participant movement 

  B) Heart rate arrhythmia 
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• EC01 Cuff not inflated above systole. The monitor will automatically  

  inflate the cuff to a higher pressure on the next attempt. 
 
• EC02 A) Cuff not properly applied 

  B) Kinked air hose 
  C) Air leak 

 
• EC03 Participant canceled reading by pressing STOP key.  No retry attempt is made 

following an “EC03” code. 
 
• EC04 Blood pressure measurement not completed in the maximum time allowed.  An 

occasional “EC04” is generally the result of excessive participant movement.  
Numerous “EC04” messages indicate an improperly applied cuff. 

 
• EC05 An occasional “EC05” message indicates the monitor’s internal safety mechanisms 

aborted the measurement.  If these messages appear frequently, the monitor 
requires service by a qualified service person. 

 
• EC08 Usually, no data.  The cuff may have been taken off. 
 
• EC09 Blood pressure result unreasonable. 
 
Table 5. Error Code Solution Table 
 

ERROR CODE DEFINITION SOLUTION 

EC00 
Blood pressure could not be detected. 
 
Motion artifact (movement or vibrations 
such as walking or driving) 

Remain still when reading is being taken. 
 
While driving, rest arm on lap. 

EC01 
Insufficient inflation of cuff 
 
Increase in systolic BP by 20mmHg from 
the previous reading 

Monitor will automatically inflate within 2 
minutes to a higher pressure. 

EC02 

Insufficient pressure in the cuff, <50mmHg. 
 
Cuff wrapped loosely (occurs more 
frequently with the extra large cuff) 
 
Cuff slid down arm 
 
Hose became kinked during inflation 
 
Air leak in cuff bladder or hose 

Inspect hose for air leaks or kinks. 
 
 
Wrap cuff on the arm more securely 

EC04 

Measurement could not be completed within 
110 seconds. 
 
High systolic BP, consistently > 180mmHg. 
 
Excessive participant movement 
 
Cuff wrapped loosely. 

Remain still when reading is taken. 
 
While driving, rest arm on lap. 
 
Wrap cuff on the arm more securely 

 
EC08 

Too few data entries to accurately 
determine blood pressure. 

Monitor will automatically inflate within 2 
minutes  

OTHER CODES Usually denote a monitor type malfunction. Contact Medifacts for further instructions  
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3.5.5 Instructions to Participants 
 
1. The ABP monitor will be worn continually for minimum of 24 hours from the “Beginning of 

Test”. 
 
2. Follow guidelines of medication administration until ABP monitor is removed. 
 
3. Remove the ABP monitor ONLY if instructed to do so by the Study Coordinator or in case of 

emergency. 
 
4. The “STOP/START” button may be used to stop a reading in an emergency. 
 
5. The ABP monitor will take readings automatically at 20minute intervals for 24 hours.  
 
6. The tones will be heard during the day and turned off at night.  Two tones will be heard prior to a 

reading.   A single beep will be heard if the reading is successful.  And five short beep tones will 
be heard if a reading is unsuccessful. 

 
7. If a reading is NOT successful, an “ERROR CODE” (ex: EC00) will be displayed on the ABPM 

LCD.  Refer to the other side of this handout for a list of the error code definitions and solutions. 
 
8. If an error code occurs, the monitor will take a repeat reading in two or three minutes.  Verify that 

the repeat reading is successful by listening for the single beep. 
 
9. If the monitor continually gets error codes (two readings are being attempted for every 

automatically scheduled reading) call the study coordinator. 
 
10. When a reading is being taken, avoid movement:  Lie, Stand or Sit still and relax. 
 
11. Follow a normal daily schedule of activities during the monitoring period. 
 
12. Do not take a shower or get the monitor wet and avoid use around microwave ovens. 
 
13. Periodically check the cuff placement.  Verify that the “Artery Arrow” remains over the “T” placed 

on your arm by the study coordinator during the cuff application.  If the cuff slips you may adjust 
it. 

 
14. When sleeping, insert the monitor between a pillow and its pillowcase and place it in bed with 

you.  Do not place the monitor on a nightstand. 
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3.6 Quality Control Grey Areas 
 
The minimum quality control criteria for the Jackson Heart Study are as follows: 

1. The earliest “Beginning of Test” time = 09:00   
2. The latest “Beginning of Test” time  = 15:00   
3. There must be a minimum duration of 24 hours of data from the “Beginning of Test” time  

4. Each hour must have a minimum of 1 valid readings. 
5. There must be a minimum of 54 valid readings (75% of the 72 programmed readings). 
 
Below is a list of each of the minimum quality control criteria.  Following each criterion is a possible 
reason for failure and a suggested action. 
 
Table 6. Grey Area Decision Table 
 

# Quality Control Reason for Failure Decision 

1 The earliest “Beginning of Test” 
time: 09:00. 

Beginning of Test time  
08:30-08:59 

Over-Ride 

Beginning of Test time  
08:29 or earlier 

Failure, if at all possible 
repeat ABPM 

2 The latest “Beginning of Test” 
time: 15:00. 

Beginning of Test time  
15:01-15:30 

Over-Ride 

Beginning of Test time  
later than 15:31 

Failure, if at all possible 
repeat ABPM 

3 
There must be a minimum 
duration of 24 hours of data from 
the “Beginning of Test” time. 

Total time 23:00 - 23:59 Override * 

Total time less than 23:00 Failure, if at all possible 
repeat ABPM 

4 Each hour must have a minimum 
of 1 valid readings. 

There is 1 hour with  
less than 1 valid reading. 

Over-Ride 

There are consecutive hours with 
less than1 valid reading. 

Failure, if at all possible 
repeat ABPM 

5 
There must be a minimum of 54 
valid readings (75% of the 72 
programmed readings). 

There is total of 50 to 53 valid 
readings (70% of the 72 
programmed readings. 

Over-Ride 

There is a total of less than 50 
valid readings (less than 70% of 
the 72 programmed readings. 

Failure, if at all possible 
repeat ABPM 

 
* Note: ONLY if there is a minimum of one valid reading in the last hour.  If the last hour is invalid (has no 
valid readings) and the total time is 23:00 -23:59, then the ABPM should remain a failure and if at all 
possible repeat ABPM.  
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3.7 ABPM Step-by-Step Procedures 
 
Step 1  LOGIN PROCEDURE (Section 3.3) 

 
a) Turn the computer on.  The computer will automatically load the MEDICOM software 

program and then display the MEDICOM logo screen.   

b) To access the operating menus from the logo screen, press the <Enter> key.  The 
MEDICOM MAIN MENU will then be displayed.  

 
 

Step 2  PROGRAM MONITOR (Section 3.4) 
 

a) Insert fresh batteries into the ABPM device observing the schematic diagram for 
battery position.  

b) With the ABPM unit turned off, attach it to the monitor cable.  The attachment is 
made via the program input/data output port on the bottom of the ABPM unit.  Make 
sure that the arrows on the ABPM and monitor cable point toward each other. 

c) Turn the ABPM unit on.  The units display screen will show “9999” or “1999” for 
satisfactory connection and battery insertion.   

d) From the MEDICOM MAIN MENU type “1” for “Program Monitor”. 

e) With the blinking cursor at “NAME:” type in the participant name field. 

  Example:  MAX–31-DEC-1964-11. 

f) A new FILE ID# is automatically assigned by the MEDICOM software each time a 
monitor is programmed.  Record the “File-ID” that is assigned by the computer on the 
File-ID Log sheet. 

g) Verify that the date and time displayed are correct.  If necessary, complete a monitor 
label and attach it to the monitor. 

 
 

Step 3  CORRELATION READINGS (Section 3.4) 
 

a) Obtain the Pre-ABPM Form to be used for the correlation process and fill in the 
appropriate information. 

b) With the participant in a seated position, wrap the appropriate size cuff around the 
non-dominant arm. 

c) Attach the T-tube between the ABPM unit, mercury column, and cuff. 

d) Take 3-5 valid readings.  The mean (average) difference between three simultaneous 
monitor and office mercury column diastolic BP readings must be within + 7mmHg.  If 
unable to correlate within the first 5 readings the ABPM unit must be reprogrammed. 

e) Upon successful completion of correlation readings, disassemble the T-tube and 
attach the cuff directly to the ABPM.   
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Step 4  BEGINNING OF TEST (Section 3.2) 
 
a) Prompt the ABPM to take a valid reading to Begin the Test (BOT).  Record the BOT 

time and date on the Pre-ABPM Form.  

b) The BOT time will be transcribed into the participant report when downloading the 
ABPM data to your computer.   

 
 

Step 5  REVIEW PARTICIPANT INSTRUCTIONS/PARTICIPANT HANDOUT (Section 3.5) 
   

a) Review the Participant Instructions/Participant Handout to prepare the participant for 
the 24-hour monitoring period. 

b) You may want to demonstrate to your participant an error code by kinking the ABPM 
cuff tubing.  

c) The participant is now ready to leave the office.  
  

Step 6  CONCLUSION OF TEST (Section 3.2) 
 

a) Verify a minimum duration of 24 hours post “BEGINNING OF TEST”.  Prompt the 
ABPM to take a valid reading for the Conclusion of Test.  Record the “CONCLUSION 
OF TEST” time and date on the Post-ABPM Form. 

b) Turn the unit OFF.  And remove the unit from the participant. 

c) Collect the Participant Handout containing GO TO BED and GET UP time 
information.  The handout should be maintained as a source document 

 
 

Step 7  READ (Download) MONITOR DATA (Section 3.4) 
 
a) Attach the ABPM unit to the monitor cable on the computer. 

b) Turn the ABPM unit on.  Verify “9999” or “1999” on the display screen. 

c) At the MEDICOM MAIN MENU, type “2” for “Read Monitor Data”. 
 
 

Step 8  CHECK QUALITY CONTROL (Section 3.4) 
 
a) When “Read Monitor Data” screen says “Done” press the <Enter> key to begin the 

automatic quality control program. 

b) Follow the prompt box directions on the computer screen.  Designate the 
“BEGINNING OF TEST” reading as noted from the Pre-ABPM Form.  Then designate 
the “CONCLUSION OF TEST” reading as noted from the Post ABPM Form. 

c) Review the PASS or FAILED message.  If a test fails Quality Control, complete the 
remaining Step-by-step procedures and call Medifacts at 1-800-333-6460. 

 
 

Step 9  EDIT PATIENT DATA (Section 3.4) 
 

a) Verify the participant “NAME” information entered during programming is correct. 

b) Enter the seven digit patient identification number (PATIENT ID). Exit and save. 
 



56 

Exam 1 Blood Pressure Manual.doc 

 
Step 10  SEND DATA -Transmit to Medifacts (Section 3.4) 

 
a) From the EDIT DATA MENU, type “6” for “SEND DATA” and press ENTER. 

d) If unsuccessful, wait a few minutes and try again.  Our Bulletin Board may be busy 
receiving files from other sites.  If still unsuccessful, call Medifacts at 1-800-333-6460. 
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Appendix 1 Check Procedures and Maintenance Instructions Random Zero 
Sphygmomanometer 

 
 
1. Check cap of manometer column to be sure it fits properly and is tight.  The 0 ring or seal must be 

seated correctly.  Clean cap of any mercury (Hg) beads or dust.  The cap should be firmly finger 
tight.  Any time the mercury seems to 'bounce' in the column of either a standard manometer or 
random zero (R-Z) manometer, it may be due to a loose cap.  Check the opening.  If it becomes 
blocked, the mercury column falls too slowly due to a vacuum effect.  This may result in false high 
readings and an erratically oscillating column.  This procedure should be carried out for both 
standard manometers and R-Z's. 

 
2. Remove back of case (two screws at top of face and two at bottom rear of case).  Swing back 

from the left around the thumbscrew on the right side.  Check for spring placement - it should be 
in line.  Tighten all screws except the one holding the bellows plate in place. 

 
3. Wrap an arm cuff around a bottle or can. 
 
4. With reservoir valve open (newer models do not have a reservoir valve) and bellows valve closed, 

pump mercury to top of column (270-290 mmHg).  If the mercury holds at a steady level for 15 
seconds or drops 2-4 mm, that system is airtight. 

 
5. With the high pressure still in the system, close the reservoir and disconnect cuff to see if that 

valve holds steady pressure.  If a leak is discovered in the reservoir valve, remove hose and 
valve (with Allen wrench).  Valve handle unscrews or lifts off.  There are two 0 rings on the valve 
stem.  Clean stem and replace 0 rings.  Use stopcock grease in 0 rings and valve. 

 
6. If the closed reservoir valve is tight, but there was a leak with it open, check the inflation 

assembly.  There may be a leak in the bulb, valve, or cuff.  To test the inflation assembly, 
immerse each section, especially valves and tubing connections in water while the pressure is 
high and watch for air bubbles.  To test the tubing of the Hg reservoir, put soapy water on it.  Most 
leaks occur at or near tubing connections or from valves.  If a valve leaks sometimes a shot of 
silicone lubricant on the thumbscrew and worked in will solve the problem.  Otherwise it may 
need to be replaced.  Tubing leaks near a connector can be repaired by removing the connector, 
cutting off 1/2 to 3/4 inches and replacing the connector.  Lubricate a sharp knife with soapy 
water to make the cut, and lubricate the cut tube to make it easier to reattach. 

 
7. Turn R-Z with back toward you.  With bellows valve open, retract mercury to just below the 

plexiglass valve chamber.  Close the bellows valve, pump mercury to top and visually check that 
leakage does not occur at that valve point.  If Hg rises into the chamber, the valve needs repair. 
Replacing 0 rings on that valve can be done locally if someone is qualified to do it.  It is a more 
difficult job than on the reservoir valve.  Otherwise it should be sent to Baum.  A serious leak in 
this valve can affect blood pressure readings.  Whenever the manometer tube seems dirty in the 
area of the 'zeros' or if the Hg seems to hang up there, the tube should be cleaned.   A dirty tube 
can affect 'zero' readings.  To clean tube, set cam at lowest zero.  Pump up, close bellows valve, 
and release pressure.  This leaves little mercury in the column.  Tilt manometer, getting rest of 
mercury out of glass and into reservoir.  Close reservoir valve.  Lean manometer at angle so that 
no mercury is in glass.  Remove the tube and clean tube and seats.  Check to be sure that the 
rubber gaskets are seated properly.  Replace tube.  Only a qualified person in a controlled setting 
should do this procedure.  The manometer is set in a catch basin so that no mercury can escape.  
There should be a rap-type vacuum pump available to pick up any small spills. 
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8. Check "maximum" and "minimum" zeros and of bellows and cam function.  (This must be done 

only if there are doubts about the values of those zeros or functions; or if Hg has been added or 
lost.) 

 
a. Release all pressure and open the bellows valve.  The large thumb wheel with the black 

rubber "tire" and the cam against which it is pressed should turn freely without binding.  If 
they do bind, bring in the R-Z. 

 
b. Inflate the system while watching the large (about 2-1/4" diameter) disc above and to the 

left of the bellows valve chamber.  (Bellows valve is still open.)  As pressure rises one 
can see the disc, a piston, pushed toward the back plate until a ring around the center of 
the disc touches the forward rim of the cam.  That rim is tapered, and thus determines 
how far the piston can move, depending on the position of the taper in relation to the ring 
at the center of the piston - a matter of change in normal operation of the R-Z.  The 
distance that the piston can move before being stopped by the cam determines the 
volume of Hg in the bellows chamber; hence the volume of Hg left in the rest of the 
manometer. 

 
c. To read "maximum" zero, release pressure with bellows valve still open.  Turn the cam so 

that the point of its taper nearest the piston will be hit by the ring of the piston.  (It may 
take an inflation and deflation or two before you find the correct cam position, which 
allows the minimum volume of Hg in the bellows chamber, hence maximum Hg in the rest 
of the system.)  Inflate to about 200 mmHg, close the bellows valve, release pressure 
and read the zero as usual; this is the "maximum".  Repeat the procedure once or twice, 
checking the cam position to make sure you get the same reading.  Note that this is not a 
fixed value for if you were to inflate to 300 before closing the bellows valve, the reading 
would be lower; and inflation to 120-130 would give a higher value.  For this reason, 
always record the maximum zero reading when taking blood pressures. 

 
d. "Minimum" zero is measured as in c above, except that the cam is turned so that the 

piston can travel its maximum.  It is usually nearly 20 mm lower than the "maximum" and 
should not be closer than about 4 mm to the 0 on the manometer tube scale. 

 
e. Replace the rear case, putting it over the thumb wheel first.  Start all four screws before 

tightening any.  Take care not to cross thread. 
 

f. After a series of blood pressure readings or before transport, open the bellows valve to 
drain Hg from that chamber, then close it and the reservoir valve.  Between readings, the 
bellows valve should be left on "open" so that pressure on the bellows is not left in the 
device. 
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Appendix 2 Maintenance Procedures for Standard Sphygmomanometer 
 
 
The following checks should be conducted at least every month, and a log kept of the dates and the 
people carrying out the troubleshooting (see Appendix 4). 
 
1. With the instrument placed flat on the table, and the inflation system disconnected, the level of 

mercury should read zero in the standard instrument.  If the reading is either above or below the 
zero mark, mercury should be added or withdrawn until it does read zero.  The top of the 
meniscus is on the zero line when the eyes are level with this line and the mercury is correctly 
adjusted. 

 
2. The inflation system should then be reconnected, and the cuff rolled around a bottle and secured.  

The valve should be closed on the Air Flo system, and the instrument inflated until the mercury 
rises to 240 mmHg.  The Air Flo valve should then be slowly opened and the mercury allowed to 
fall to 200 mmHg.  The valve should then be closed; at which time the mercury column should 
remain stable.  If the column continues to fall, there is an air leak, and the following step should 
be taken: 

 
3. The system should be reinflated until the column rises to 200 mmHg.  The tubing should be 

pinched at various locations to localize the area of the leak.  Appropriate replacement of the 
tubing, cuff, or valve should be performed. 

 
4. With the instrument inflated above full calibration, the screw cap should be examined for mercury 

leaks.  If this happens, the screw cap should be tightened.  If the leak persists or the mercury is 
seen at the bottom of the tube, the silicone rubber, which provides a seat for both ends of the 
glass tube, should be replaced. 

 
5. With time, the mercury will become dirty and an oxide layer will be deposited on the inside of the 

glass tube.  The instrument should be laid nearly on its side (on a tray) so that the mercury will 
return to the reservoir and none can be seen in the glass tube.  The tube should be removed 
carefully and cleaned out using the long pipe cleaner supplied with the instrument.  The tube 
should then be replaced and the zero level rechecked. 

 
Since mercury is a toxic substance all maintenance procedures must be performed carefully and with 
attention to safety.  Mercury should not be allowed to get in contact with rings and other jewelry. 
 
(Maintenance instructions for the standard sphygmomanometer are adapted from those given for the 
MRFIT study in Controlled Clinical Trials, Vol. 7, No. 3 (Supplement), Sept. 1986. 
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Appendix 3 Checklist for Biannual Observation of BP Technicians by BP Supervisor 
 
 
BP Technician Code #_______  Observer Code #_______ 
 
Date Observed  ____/____/_____ 
 
_______________________________________________________________________ 
 
Instructions: For each item, check "yes" or "no" in the space provided to indicate if the procedure is 
carried out correctly.  Record any comments in the blank line between that item and the next.  For 
certain items specific parts of the procedure which are important are listed separately.  Supervisor 
should recheck all measurements and procedures. 
 
 Yes No 
   
Measures arm for correct cuff size (  ) (  ) 
   
Palpates brachial artery (  ) (  ) 
   
Marks pulse point (  ) (  ) 
   
Wraps cuff center of bladder over brachial pulse (  ) (  ) 
   
Leaves subject for five minutes rest (  ) (  ) 
Instructs on Posture (  ) (  ) 
Full five minutes for rest allowed (  ) (  ) 
Work station free of excessive noise (  ) (  ) 
Explanation (  ) (  ) 
   
Count radial pulse 30 seconds, record reading (  ) (  ) 
   
Finds Pulse obliteration point using standard 
manometer 

(  ) (  ) 

   
Calculates peak inflation, standard manometer (  ) (  ) 
   
Calculates peak inflation, R-Z (  ) (  ) 
   
If computer is down use the formula (pulse obliteration 
pressure + R-Z maximum zero number + 30 

  

Explanation (  ) (  ) 
   
Connects R-Z tube to cuff (  ) (  ) 
   
Sure reservoir lever open (newer devices have no 
lever) 

(  ) (  ) 

   
Opens bellows valve and waits full 3 seconds for 
mercury to settle  

(  ) (  ) 

   
Turns thumb wheel (down strokes only) (  ) (  ) 
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 Yes No 
   
Places stethoscope in ears (  ) (  ) 
   
Inflates rapidly to R-Z peak (  ) (  ) 
   
Counts full 5 seconds with pressure steady (  ) (  ) 
   
Closes bellows knob (  ) (  ) 
   
Places bell on brachial pulse (  ) (  ) 
   
Deflates cuff 2 mmHg per second (  ) (  ) 
   
Deflates cuff after 2 absent sounds (  ) (  ) 
   
Records readings (  ) (  ) 
   
Disconnects tubes (  ) (  ) 
   
Reads zero value (  ) (  ) 
   
Subtracts zero value from each BP reading, if using 
paper form 

(  ) (  ) 

   
Instructs to hold arm vertical for full 5 seconds (  ) (  ) 
   
Waits at least 30 seconds before proceeding (  ) (  ) 
   
Repeats R-Z readings (  ) (  ) 
   
Informs participant of average readings (  ) (  ) 
 
Special Comments: 
 
______________________________________________________________________________ 
 
______________________________________________________________________________ 
 
______________________________________________________________________________ 
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Appendix 4 JHS Monthly Log for Sitting Blood Pressure Station 
 
 
Month________Year________ 
 
 
Weekly Check Procedures: 
    Week   
       
  1 2 3 4 5 
       
1. Random-Zero 

Sphygmomanometer: 
     

       
 Date of Check _____ _____ _____ _____ _____ 
       
A. Check Tube for Oxide Dust _____ _____ _____ _____ _____ 
       
B. Check Cap for Tightness   _____ _____ _____ _____ _____ 
 
 
Procedures performed only if there appear to be problems: 
 
C. If mercury bounces even though the cap appears tight, remove cap, clean of any mercury 
beads, and check opening at top of tube for dust 
 
 Check Needed and Performed during weeks  1 2 3 4 5 
 (Circle number of weeks applicable)      
 
D. If tube appears "dirty" (oxidized mercury) remove cap, tip manometer to retract mercury, run 
pipe cleaner down, replace cap  
 
 Needed and Performed during weeks 1 2 3 4 5 
 (Circle number of weeks applicable)      
 
E. List the problem encountered, the date, and the actions taken below: 
 

_________________________________________________________________________ 
 
_________________________________________________________________________ 
 
_________________________________________________________________________ 
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Monthly Check Procedures: 
 
A. Accuracy Check on Random-Zero Sphygmomanometer (to be performed every 2 months): 
 

Date last accuracy check performed: _____________ 
 
Is an accuracy check due this month? (  ) Yes  (  ) No 
 
Date accuracy check performed, if due: _____________ 
 
Problems found on accuracy check? (  ) Yes  (  ) No 
 
If yes, list problems found and corrective action taken: 
 
_________________________________________________________________________ 
 
_________________________________________________________________________ 
 
_________________________________________________________________________ 
 
 
Random Zero Sphygmomanometer Check 
 
Standard 200 170 140 100 60 
      
Random Zero ____ ____ ____ ____ ____ 
      
Zero ____     
      
Corrected      
R-Z Measure* ____ ____ ____ ____ ____ 
 
Corrected R-Z measure = [(Random-Zero) - Zero] 
 
Note that this corrected R-Z measure must be within 2 mmHg of the 
standard. 

 
B. Standard sphygmomanometer check: 
 

Date of check: ______________ 
 
A. Check cap for tightness ______ 
 
B. Check tube for oxide dust ______ 
 
C. Check that mercury is at 

zero with no pressure ______ 
 
List any problems found and corrective action taken: 
 
_________________________________________________________________________ 
 
_________________________________________________________________________ 
 
_________________________________________________________________________ 
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C. Measuring tape for arm circumference worn or stretched 
 

Tape measure has been tested as part 
of Anthropometry station procedures. (  ) Yes  (  ) No 
 
If no, perform tape measure calibration check: 
 
Check by holding the zero mark of the tape against the ruler used to measure standing height 
at the 150 cm. mark.  If the 30 cm. mark on the tape used for arm circumference falls outside 
the range 119.5 to 120.5 on the standing height ruler it should be replaced. 
 
 
Date of check: _____ 
 
Point on height ruler where 30 cm. on tape falls _____ 
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Appendix 5 Accuracy Check on the Random-Zero Sphygmomanometer 
 
 
This check should be performed every two months, using a standard manometer and an Y connector.  
Check that the mercury level of the standard device reads zero with no pressure in the system.  If it 
does, it should be treated as accurate and having an adequate supply of mercury. 
 
To perform the accuracy check on the R-Z instrument, attach the two arms of the Y connector directly 
to the reservoirs of the R-Z and standard devices, using Latex tubing.  Attach the base of the Y 
connector to a cuff with an Air Flo control valve and bulb.  To attach the Latex tubing to the reservoirs 
or to a valve, it may be helpful to moisten the openings of the tubing to allow the tubing to slip onto 
the desired parts.  Wrap the cuff around a bottle or can. 
 
First open the Air Flo valve to insure that all pressure is out of the system.  Check the zero level of the 
standard device.  Next, turn the R-Z valve to the OPEN position.  Close the Air Flo valve and inflate 
both machines until the mercury level in the standard device is at the 250 mmHg level.  After 5 
seconds, close the R-Z valve.  Allow the mercury in the standard manometer to drop to 200 mmHg.  
Record the exact levels of mercury in the RZ and standard device.  Repeat the procedure at 170 
mmHg, 110 mmHg, 80 mmHg and 60 mmHg.  Release the air from the Air Flo valve.  When the 
mercury in the R-Z instrument has stabilized and the standard is at zero, record the zero reading from 
the R-Z.  Subtract this value from the R-Z readings. 
 
The results should agree with the comparable readings on the standard instrument within + 2 mmHg.  
If this agreement is not found at all levels, repeat the procedure.  If the disagreement is constant, stop 
using the instrument and contact the manufacturer. 
 
Worn parts should only be changed as necessary (when there is disagreement between the R-Z and 
standard devices).  Only those parts in the parts kit should be changed.  No attempt should be made 
to change the rubber diaphragm or bellows. 
 
Note: These instructions are adapted from the procedures employed by the MRFIT study, described 
in Controlled Clinical Trials, Vol. 7, No. 3 (Supplement), September 1986. 
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Appendix 6 Form for Recording Simultaneous Blood Pressure Observations on a Volunteer 
by Two Technicians 

 
 
Instructions: 
 
Biannually, each technician should be part of a pair of technicians who simultaneously measure blood 
pressure using an Y-tube on a volunteer (not a JHS participant).  Each technician should separately 
record his/her measurements on a standard paper JHS SBP form.  The blood pressure supervisor 
should then transfer the results to this form and calculate the differences between the two sets of 
measurements.  If the difference on any individual measurement is greater than 4 mmHg, or if the 
averages of the two readings for each technician differ by more than 3 mmHg, the supervisor should 
indicate the corrective action taken on this form.  Any further sets of simultaneous measurements for 
a given pair should appear on a new form. 
 
 
Technician IDs: 1st ID: __________ 2nd ID:__________  Date: _______ 
 
 
  1st Technician 2nd Technician Difference 
     
a. Initial arm circumference (cm) ___________ ___________ ___________ 
     
b. Initial cuff size selected ___________ ___________ ___________ 
     
c. Pulse Obliteration Pressure ___________ ___________ ___________ 
     
d. First SBP ___________ ___________ ___________ 
     
e. First DBP ___________ ___________ ___________ 
     
f. First Zero Reading ___________ ___________ ___________ 
     
g. First Net SBP 

Corrected for Zero 
 

___________ 
 

___________ 
 

___________ 
     
h. First Net DBP 

Corrected for Zero 
 

___________ 
 

___________ 
 

___________ 
     
i. Second SBP ___________ ___________ ___________ 
     
j. Second DBP ___________ ___________ ___________ 
     
k. Second Zero Reading ___________ ___________ ___________ 
     
l. Second Net SBP 

Corrected for Zero 
 

___________ 
 

___________ 
 

___________ 
     
m. Second Net DBP 

Corrected for Zero 
 

___________ 
 

___________ 
 

___________ 
     
n. Average Net SBP ___________ ___________ ___________ 
     
o. Average Net DBP ___________ ___________ ___________ 
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ACTION TAKEN IF DIFFERENCES BETWEEN TECHNICIANS EXCEED LIMITS SPECIFIED: 
 
______________________________________________________________________________ 
 
______________________________________________________________________________ 
 
______________________________________________________________________________ 
 
______________________________________________________________________________ 
 
______________________________________________________________________________ 
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FOREWORD 
 
This manual is one of a series of protocols and manuals of operation for the Jackson Heart Study 
(JHS).  The complexity of the JHS requires that a sizeable number of procedures be described, thus 
this rather extensive list of materials has been organized into the set of manuals listed below.  Manual 
1 provides the background, organization, and general objectives of the JHS Study.  Manuals 2 and 10 
describe the operation of the Cohort and Surveillance Components of the study.  Detailed Manuals of 
Operation for specific procedures, including those of reading centers and central laboratories, make 
up Manuals 3 through 9 and 11. 
 
 

JHS Study Protocols and Manuals of Operation 
 
 

MANUAL TITLE 
  
1 General Description and Study Management 
  
2 Cohort Component Procedures 
  
3 Family Study 
  
4 Blood Pressure  
  
5 Electrocardiography 
  
6 Echocardiography 
  
7 Ultrasound Assessment 
  
8 Pulmonary Function Assessment 
  
9 Specimen Collection and Processing 
  

10 Cohort Surveillance 
  

11 Data Management System 
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1.0 INTRODUCTION 
 
 
The procedures and equipment described in this document are based on those developed for use in the 
Atherosclerosis Risk in Communities (ARIC) study, and are designed to maximize comparability with 
ARIC measurements previously collected on a subset of the Jackson Heart Study cohort. 
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2.0 SCANNING INSTRUMENTATION 
 
 
The ultrasound area instrumentation consists of a Hewlett Packard SONOS 4500 ultrasound imaging 
system, an sVHS Video Cassette Recorder, and an RMI 414B Tissue Mimicking Ultrasound 
Phantom.  A brief description of each piece of equipment follows. 
 
The vascular ultrasound imaging system with a 7.5 mHz transducer is designed for the interrogation 
of relatively shallow anatomical structures such as the extracranial carotid arterial system.  During B-
mode imaging, an ECG tracing can be superimposed on the image screen to assist in the selection of 
images from specific time sequences within the cardiac cycle.  In addition to the B-mode image, 
Doppler signals from the arteries can be obtained, processed and displayed in a frequency versus 
time format.  The Doppler information is used primarily for arterial identification and for evaluation of 
lumen encroaching lesions for possible ultrasound alerts. 
 
A sVHS video cassette recorder (VCR) is connected to the scanner.  The VCR records the ultrasound 
video information coming from the scanner’s video channel and an audio signal capturing the 
sonographer’s verbal commentary during the scan. 
 
A modified RMI 414B tissue mimicking ultrasound phantom with water trough attachment is used 
periodically for performance checks on the scanner.  The phantom has arterial mimicking targets of 
various diameters and depths.  These targets can be scanned from both longitudinal and transverse 
directions, and the images and video information can be evaluated to assess system performance.  
The images are recorded on 1/2" sVHS video cassettes and sent to the URC. 
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3.0 EQUIPMENT MAINTENANCE 
 
 
Detailed records of equipment maintenance are to be kept at the field center. 
 
3.1 Ultrasound Imaging System 
 
The field center will maintain a regular schedule of preventive maintenance checks every six months.  
More frequent service visits may be required if any problems occur between scheduled preventative 
maintenance visits. Service visits may be recommended by the URC if readers or expert reviewers 
note deterioration in image quality or if regular phantom scans indicate a performance problem.  A log 
of all service visits will be kept at the Field Center, indicating the visit date, reason for the visit, 
technician performing the service, and any actions taken. 
 
3.2 Video Cassette Recorder  
 
The Video Cassette Recorder should be cleaned on a regular schedule as indicated in the operator’s 
manual.  Based on the quality of images received, the URC may recommend additional service for 
the VCR at any point during the study. 
 
Before scanning is attempted each day, a short series of ultrasound images should be recorded to 
video cassette and played back to confirm that the VCR settings are appropriate and capable of 
recording both video and audio signals. 
 
3.3 RMI 414 B Tissue Mimicking Ultrasound Phantom 
 
The RMI 414B phantom is checked monthly to be sure all seals are tight and that the tissue 
mimicking gel inside has not dried out.  Proper care and maintenance of the test phantom, along with 
standard specificiations, are described in the instruction manual accompanying the phantom.  The 
phantoms are stored in an airtight, resealable plastic container.  A few drops of water or a wet sponge 
should be added to this container before sealing to minimize desiccation of the tissue mimicking 
material. 
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4.0 ULTRASOUND EQUIPMENT PERFORMANCE CHECK 
 
 
4.1 Overview of phantom scans 
 
An ongoing quality assurance check of scanning instruments is performed once each month at the 
field center and immediately after any service visit or replacement of the transducer.  The QA check is 
based on a standardized scan of the RMI Tissue Mimicking Phantom.  The scans are recorded on 
video cassette and sent to the URC for evaluation.  In each scan, a 6 mm diameter simulated vessel 
and a set of filaments located at different depths within the phantom are visualized. 
 
Regular twice a month phantom scans are performed on the second Wednesday of each month.  The 
RMI 414B ultrasound phantom is placed upright on the examination table with the long side of the 
rectangular case parallel to the longer side of the table.  The end of the phantom containing the 
filaments ranging from 0.5 to 4.0 cm should be positioned closest to the head of the table. 
 
The top surface of the phantom is cleaned with a damp cloth or paper towel to remove residue.  The 
water tray on the top of the phantom is half-filled with tap water to permit efficient coupling of the 
ultrasound transducer to the tissue equivalent medium.  DO NOT USE GEL AS THE COUPLING 
MEDIUM.  Minimal pressure is exerted on the phantom surface with the transducer throughout the 
scan.  Excessive pressure or gel on the phantom surface can cause severe damage to the phantom. 
 
A segment of B-mode phantom images approximately 2 minutes in length is recorded during this 
check as described below.  Selected frames are read at the URC to quantitatively document the 
ultrasound system imaging characteristics. 
 
With the VCR in record mode, adjust the video gain and other settings for optimal imaging.  
Throughout the scan, exert only minimal pressure on the phantom surface with the transducer.  To 
obtain the images in this procedure the long dimension of transducer should be parallel to the long 
dimension of the phantom.  The sonographer obtains a cross-sectional (transverse) view of the most 
superficially (2 cm depth) located simulated vessels and then positions the larger (6 mm diameter) of 
the three vessels in the vertical center of the screen.  Verbally indicate when you have acquired 
satisfactory images of each structure to assist the reader in identification of video cassette frames for 
assessment. 
 
The sonographer then moves the transducer toward the head of the table in order to view the set of 
filaments ranging from 0.5 to 4.0 cm.  These are also viewed in cross-section (transverse), making 
certain the transducer focus setting is in an appropriate position.  The filaments are lined up so that 
they are centered horizontally across the center of the screen.  The reflections of the deeper filaments 
may have gaps in them due to shadowing caused by the filaments superficial to them.  Those gaps 
are used as an aid in lining up the filaments properly.  When a satisfactory image is seen, verbally 
mark this point on the tape for the URC. 
 
This concludes the monthly instrument performance test on the RMI phantom.  The water is carefully 
removed from the phantom, and the phantom is returned to its storage location in the manner 
described in Section 4.3. 
 
4.2 Labeling and shipping phantom scans to URC 
 
Phantom scans may be recorded on the same video cassettes as participant scans.  Phantom scans 
must be identified on the Log Sheet (see Appendix 2) by writing “Phantom Scan” in the space for 
participant ID.  In addition, the gain setting used to obtain optimal images should be recorded in the 
comment field.  A log of phantom scan dates is maintained at the Field Center to ensure these tests 
are performed per the above schedule. 
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4.3 Additional Points to Remember 
 
While scanning the phantoms, the sonographer is to look for changes in the following: 
 
• shape of simulated vessels (these should appear circular) 
• the gain settings required to obtain adequate images, or  
• the focal settings required to obtain images. 

 
If the sonographer notices changes in any of these conditions, he/she should contact the service 
technician authorized to work with this instrument and make a notation of that contact and it’s 
resolution in the Field Center service log.  Following any service call, the chief sonographer is to send 
a copy of the service report to the URC Coordinator and/or Phantom reader. 
 
If the phantom surface begins to cave in or pucker: 
 
1. Call the supplier to arrange service.   

2. Notify the URC Coordinator immediately.   
 

It is important to vary the location of the transducer within the prescribed areas on the phantom when 
performing phantom scans in order to extend the life of the phantom. 
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5.0 EQUIPMENT AND SUPPLIES 
 
 
In addition to the Hewlett Packard SONOS 4500 ultrasound imaging system and sVHS cassette 
recorder, the carotid scanning station should include an examination table, a chair with adjustable 
height control, and an overhead light or room lamp with a dimmer switch to allow the sonographer to 
control the ambient light level in the room. Daily supplies include: 
 

a. sVHS video cassettes 

b. Participant ID Labels - Identification labels are applied to the video cassettes 

c. Aquasonic gel 

d. Paper wipes 

e. Foam wedge 

f. Soft arch apron and clips 

g. Pillow to be placed underneath participant’s knees 
 

In addition to these daily supplies, a VCR head cleaner should be available for use according to the 
manufacturer’s recommended maintenance schedule or in response to noticeable image degradation. 
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6.0 ARTERIAL SITES AND ANATOMIC STRUCTURES TO BE EXAMINED 
 
Ultrasonic imaging methods are used to obtain a non-invasive quantitative measure of early 
atherosclerotic disease.  The carotid arteries, the principal suppliers of blood to the brain, are a 
common location for early disease, primarily within or in close proximity to the bifurcation.  These 
arteries, generally located within a few centimeters of the skin surface, also are well suited to 
examination with high resolution ultrasonic imaging methods.   
 
The ultrasound examination concentrates around the portion of the carotid artery known as the 
carotid bifurcation (See Figure 1).  The JHS carotid ultrasound examination attempts to obtain images 
at 3 defined segments (Common, Bifurcation, and Internal) of the right and left carotid arteries.   
Three circumferential views are at the Common segment (anterior, lateral, and posterior) 
simultaneously imaging the near and far walls in each view.  Three views are also obtained at the 
Bifurcation (one simultaneously imaging both the near and far walls, and two additional views 
focusing separately on the near and far walls to accommodate the curvature typical of the 
bifurcation).  A single view is obtained at the Internal segment.   
 
All views of the Bifurcation and Internal segments, and one view of the Common segment are 
obtained at the optimal interrogation angle (OIA), an internally defined angle that clearly shows the tip 
of the flow divider (TDF) and origination of the internal and external carotid arteries. 
 
Figure 1. Carotid Artery Schematic 
 

TFD

US Beam

Near Wall

Far Wall

CommonBifurcationInternal

Figure 1. Carotid Artery Schematic
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6.1 Priority for Boundary Visualization 
 
In many instances, it is difficult to simultaneously obtain high quality longitudinal images of both the 
near and far wall boundaries of the arterial segment being examined in the same image frame.  This 
condition results primarily from the highly specular nature of the ultrasonic reflections from the blood-
intima boundaries and deviations of the arterial geometry from a cylindrical shape.  Consequently, 
priorities must be placed on the order with which arterial wall boundaries should be visualized.  Low 
priority boundaries should be visualized to the greatest extent possible after optimizing visualization 
of high priority boundaries, but with potentially lesser quality. 
 
Figure 2. Ultrasound Image of Common Carotid Artery Interfaces 
 

 
 
 
The two boundaries to be visualized first are the adventitia-media boundaries on the near and far 
walls.  These boundaries permit an estimate of the arterial diameter to be measured.  The third 
boundary, the far (deeper) wall blood-intima boundary, is then visualized while maintaining good 
images of the first two boundaries. This permits a measurement of the far wall intimal-medial 
thickness.  Fourth, if possible without losing this third boundary, the intima-blood boundary on the 
near (shallower) wall is visualized.  An image of the common carotid artery in which all four 
boundaries are visualized is shown in Figure 2.  This sequence of priorities is used when imaging any 
segment of the carotid arteries that attempts to image the near and far walls simultaneously. 
 
6.2 The Carotid Arteries 
 
6.2.1 Anatomical References 
 
The arterial segments defined for ultrasonic examination are referenced to certain anatomical 
landmarks which are normally identifiable within the carotid system.  One is the tip of the flow divider 
(TDF), the position along the vessel where the internal carotid artery and external carotid artery 
begin.  A second, but less clearly delineated landmark is the location where the common carotid 
artery begins to widen into the carotid bifurcation.  These landmarks are illustrated in Figure 3.  In 
order to image defined segments referenced to these landmarks, longitudinal images are required. 
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Figure 3. Ultrasound Image of Carotid Landmarks 

 
 
 
6.2.2 Optimal Interrogation Angle (OIA) 
 
The optimal interrogation angle (OIA) permits clear identification of the anatomical references on the 
B-mode images and depends upon specific anatomical features of the participant.  This dependence 
of interrogation angle on the individual participant requires that great care be given during the 
preliminary examination to identify this angle.  It depends upon both the ultrasound transducer 
position and the orientation of the head of the participant. 
 
If the proximal segments of the internal and external carotid arteries lie in a common plane, it should 
be possible to interrogate the bifurcation from an angle that provides an image characterized by a "Y" 
appearance.  This is illustrated in Figure 3.  From this angle, the location of the two anatomical 
references, the tip of the flow divider and the beginning of the dilation of the bifurcation, can be seen.  
In some individuals, it may be difficult to sharply define the origin of the bifurcation if a pronounced 
widening does not occur, but it is most likely to be visible from this angle. 
 
If the proximal segments of the internal and external carotid arteries do not lie in a common plane, it 
may be impossible for the sonographer to obtain the characteristic "Y" appearance at the bifurcation 
in a single image.  Either one or the other of the branches can be imaged at a given interrogation 
angle but not both. In many cases, repositioning of the head of the participant (see Section 8.0) may 
permit the two arteries to more closely approach a common plane.  Often careful attention to this 
position and small participant head angle changes will permit the "Y" to be visualized.  A preliminary 
transverse scan as described in Section 8.1.2 permits the optimal interrogation angle to be closely 
approximated even in the more difficult anatomical configurations. 
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6.2.3 Externally defined Interrogation Angles 
 
In addition to the use of the internally defined optimal interrogation angle, it is often convenient to 
refer to certain externally defined interrogation angles, especially when acquiring circumferential 
views in the common carotid segment.  We define external interrogation angles based on the 360 
degrees of a circle centered about the participant’s neck, with the 0 degree point located towards the 
floor and the 180 degree point oriented towards the ceiling (see Figure 4). 
 
Figure 4. Externally defined interrogation angles 
 
 
 
 

 
Interrogation angles on the participant’s right side are numbered from 0 – 180 degrees, although 
angles less than 60 degrees usually cannot be obtained due to restrictions in participant anatomy and 
interference from the examination table.  Interrogation angles on the participant’s left side are 
numbered from 180 – 360 degrees, although angles greater than 300 degrees usually cannot be 
obtained due to similar constraints.  On the participant’s right side, angles between 100 and 140 
degrees are defined as lateral angles, while those from 60 – 100 degrees are defined as posterior 
angles and those from 140 – 180 degrees are defined as anterior.  On the left side, angles from 220 – 
260 degrees are defined as lateral, while those from 260 – 300 are defined as posterior and those 
from 180 – 220 are defined as anterior.  On each side, externally defined interrogation angles can be 
designated either by a specific degree (eg., 210 degrees) or by a region (anterior, lateral and 
posterior). 
 
 
6.2.4 The Common Carotid Artery 
 
Initial longitudinal images of the common carotid artery are obtained at the optimal interrogation angle 
(OIA).   The external region (anterior, lateral or posterior) containing the OIA  should be identified 
verbally by the sonographer in degrees. At the OIA, the boundaries of interest are referenced to the 
origin of the bifurcation where the common carotid begins to widen.  The segment located 10 mm 
proximal to this landmark is the focus of attention.  Both the near wall and far wall interfaces are 
attempted in this view. 
 
If the OIA is a lateral angle, two additional circumferential views are obtained by selecting the most 
extreme anterior and posterior angles that still permit visualization of at least one and preferably both 
blood-intima interfaces.  If the OIA is a posterior angle, the two additional circumferential views are 
obtained at the midpoint of the lateral range (120 or 240 degrees, depending on the side) and at the 

Participant’s Left Side  Participant’s Right Side 
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most extreme anterior angle that still permits visualization of at least one, and preferably both blood-
intima interfaces.  Similarly, if the OIA is an anterior angle, the additional circumferential views are 
obtained at the midpoint of the lateral range (120 or 240 degrees, depending on the side), and at the 
most extreme posterior angle that still permits visualization of at least one, and preferably both blood-
intima boundaries.  After obtaining all 3 views of the common segment, the sonographer should 
return to the OIA and begin to focus on the bifurcation segment. 
 
6.2.5 The Carotid Bifurcation 
 
The segment of the carotid bifurcation extending 10 mm proximal to the tip of the flow divider is 
imaged at the optimal angle.  In some participants this may extend into the common carotid.  The 
initial longitudinal images are acquired while attempting to visualize the near and far walls 
simultaneously, taking care to use the priority sequence of boundary visualization described in 
Section 6.1. 
 
After imaging the far and near walls of the bifurcation segment simultaneously, a series of images are 
acquired that optimize visualization of the far wall boundaries.  At this time, the ultrasound transducer 
is tilted along the arterial axis in such a manner that the far wall of the bifurcation becomes horizontal 
in the center of the display screen, while maintaining the OIA. Small changes in transducer angle and 
instrument settings are made to optimize the blood-intima and media-adventitia interfaces on the far 
wall. The quality of the near wall echoes will deteriorate while visualization of the far wall interfaces is 
optimized. 
 
Then, this process is repeated now optimizing visualization of the near wall interfaces.  Again, the 
transducer is rotated along the axis of the artery so that the near wall of the bifurcation is oriented 
horizontally in the center of the display screen while maintaining the OIA.  Small changes in 
transducer angle and instrument settings are made to optimize the adventitia-media and intima-blood 
interfaces on the near wall.  The quality of the far wall echoes will deteriorate while visualization of the 
near wall interfaces is optimized. 
 
6.2.6 The Internal Carotid Artery 
 
The segment of the internal carotid artery far wall extending 10 mm distal from the tip of the flow 
divider is now imaged at the optimal angle.  It is important to carefully distinguish between the internal 
and external carotid arteries using two criteria:  (1) normally the internal has a significantly larger 
diameter than the external; (2) the blood flow velocity pattern in the two vessels as determined with 
Doppler ultrasound is distinctly different.  (See Appendix I for detailed information on use of the 
Doppler to distinguish between the internal and the external arteries).  Used together, these two 
considerations permit the internal carotid artery to be identified with a high degree of confidence. 
 
During the preliminary scanning procedure it is necessary to distinguish clearly between internal and 
external carotid arteries.  Although tributaries originating from the external carotid artery may 
occasionally be viewed with B-mode ultrasound to help in this differentiation, in most cases Doppler 
ultrasound is more efficient and specific for this separation.  Briefly, the method and criteria for this 
identification are as follows: 
 
A B-mode image is obtained of the carotid bifurcation where the common carotid artery divides.  In 
some instances the best anatomical angle will show the flow divider as well as the proximal internal 
and external carotid arteries.  In the remaining cases the flow divider and only one vessel can be 
seen from a single angle.  In those instances the other artery can be visualized by gently rocking the 
ultrasound probe back and forth in angle or position or both.  Doppler is used to differentiate internal 
and external carotid arteries in these instances.  To obtain a Doppler sample of each artery, the 
Doppler sample volume (0.09mm) is placed into the branch farthest from skin surface.  The 
sonographer observes the tracing on the TV monitor and listens to the Doppler signal.  If the 
ultrasound probe is in the internal carotid artery, the flow pattern will be that of a low-resistance bed.  
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This signal has a rapid upstroke and a quasi-steady flow through systole and diastole.  The flow 
continues throughout the cardiac cycle and begins to increase again at the next systole. 
 
If the Doppler signal does not correspond to the expected pattern, the cursor is placed within the 
other branch.  The external carotid artery is usually nearer the skin surface when viewed from an 
anterior angle and is a high-resistance vessel.  The characteristics of the Doppler signal in this vessel 
are a forward flow with a sharp upstroke and sometimes a reversal of the flow at diastole 
(multiphasic). 
 
Abnormal flow is demonstrated by turbulence within the lumen and disruption of normal flow.  This is 
identified in the Doppler signal by broadening the Doppler spectrum.  Severe narrowing of the artery 
lumen is identified by an increase in the expected peak systolic frequency. Complete occlusions with 
an absence of Doppler signal should be very rare in the JHS cohort. 
 
Because of the more varied positioning and geometry of the internal carotid, the sequence of 
priorities to be used when imaging this segment is modified from that used in the common and 
bifurcation.  The two far wall boundaries should receive highest priority, the near wall adventitia-
media interface next priority and finally the near wall intima-blood boundary. 
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7.0 PARTICIPANT PRELIMINARIES  
 
The participant will have been asked to refrain from smoking, vigorous exercise, and drinking coffee, 
tea and soft drinks containing caffeine during the night preceding and the day of the ultrasound 
examination, since these may alter heart rate and/or blood pressure. 
 
7.1 Participant Orientation to Ultrasound Examination 
 
The participant is positioned on the examination table in a supine position.  The sonographer 
describes in general terms the examination to be done.  A suggested statement follows: 
 

"Ultrasound is a painless and low-risk method to examine arteries using sound waves which 
you cannot hear but which are able to image arteries under your skin.  Before the ultrasound 
exam begins, a thin gel will be applied to the skin, and an instrument will be placed on it.  
This procedure will be used to look at the arteries on both sides of your neck. During the 
examination, you will hear the noise and feel the vibrations of a small motor that is located 
within the instrument.  Occasionally you will also hear the amplified sound of blood flowing 
through your arteries.  The equipment will also record my voice as I name the parts of the 
arteries I scan.  The complete ultrasound examination should be completed within forty-five 
minutes.  Talking or swallowing can cause the arteries in your neck to move out of focus and 
can prolong the exam.  Please try to avoid talking or swallowing as much as possible, 
especially for a period of 4-5 seconds whenever I say the word “Acquire”.   I will also record 
your heart beat during the exam by placing 3 ECG leads on your chest.” 

 
During this discussion, the sonographer should remember that the examination to be done is not 
diagnostic in nature, and that all questions asked by the participant that relate to the presence or 
absence of arterial disease should be referred to the medical director of the Field Center or to his on-
site representative. 
 
7.2 Participant Apparel 
 
The ultrasound component of this examination requires easy access to the skin overlying arteries in 
the neck. Jewelry present on the head and neck, including gold chains, necklaces and earrings, is 
removed prior to scanning. 
 
Before activating the next phase of the study, take a minute to instruct the participant on the "no 
conversation" rule.  Also, remind the participant to "hold questions" about exam results until after the 
last portion of the ultrasound station exam is completed, since it is important that all participants be 
"treated the same way". 
 
7.3 Preparation for Ultrasound Examination 
 
The subject should assume a supine position on the examination table with his/her legs resting 
comfortably on a pillow.  The participant's position should allow head rotation to either side.  The 
sonographer is seated at the end of the exam table that is nearer the participant's head.  The top of 
the participant's head is about one to three inches from the end of the exam table, so as to afford 
easy access to the sonographer of the areas of the neck to be scanned. The soft arch apron is placed 
on the participant’s chest around the neck with the 180 degree mark over the suprasternal notch and 
with the 90 and 270 degree marks at shoulder level and parallel to the table. 
 
7.4 Connection of ECG leads 
 
Monitor leads or electrodes will be attached to the participant’s chest to allow visualization of the 
participant’s electrocardiogram (EKG) during the carotid artery scan.  Conventional locations for the 
chest electrodes are illustrated below.  The “left leg” (LL) electrode is placed below the left pectoral 
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muscle.  The “right arm” (RA) electrode is placed below the right clavicle.  The “right leg” (RL) 
electrode, which acts as a ground, is placed below the right pectoral muscle. 
 
Figure 5. Placement of ECG leads.  
 

 
 
Points to remember: 
 
• the ECG tracing should be positioned at the bottom of the image screen. 

• the amplitude should be sufficient to trigger the rate meter. 

• artifact - if visualized check to be sure electrodes are not loose or dry.  Avoid placing electrodes 
on bone structures.  Limit participant movement during scan. 
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8.0 CAROTID SCANS 
 
Orient the participant's head as follows.  The participant is asked to look straight up at the ceiling.  A 
triangular shaped, firm foam rubber wedge shaped in a 45-45-90 degree form is used to position the 
head in a standard way.    The wedge is placed on the examination table, with largest surface of the 
wedge facing down.  It is placed on the examination table next to the side of the neck to be evaluated 
in such a way that the 90 degree angle is furthest from the midline of the face.  This positions a 45 
degree angle closest to midline.  The wedge is then gently pushed toward the midline of the head 
until the 45 degree angle edge touches the scalp.  The participant is then asked to rotate his head 
toward the foam rubber wedge until the side of the head just above the ear rests against it.  The chin 
may be raised slightly and the shoulder adjusted slightly for better visualization.  The ultrasound 
equipment is positioned so that the sonographer has access to the participant's neck and all 
instrument controls. 
 
8.1 Right Carotid Scan 
 
8.1.1 Positioning the Participant 
 
The head and neck are positioned for the exam of the right carotid.  The foam rubber wedge is placed 
on participant's left side, and the head is rotated toward the foam rubber as outlined in the 
introduction to this section.  
 
8.1.2 Preliminary Scan 
 
A careful transverse scan of the common carotid artery is performed with the patient head position 
and transducer at a lateral interrogation angle.  The purpose of this portion of the scan is to learn the 
arterial geometry of the participant and identify the optimal interrogation angle (OIA).  The preliminary 
scan may also be useful to the reader for identifying the position and severity of suspected lumen 
encroaching lesions.  Using fine transducer angulations to clearly display the blood-intima boundaries 
within the vessel, the transducer is slowly moved toward the mandible until the widening of the carotid 
bulb, and finally the internal and external carotid arteries, are visualized.  Using the knowledge of the 
relative orientation of the internal and external carotids from this scan, the optimal angle which should 
best display the tip of the flow divider may be determined as indicated in Figure 6.   
 
Figure 6. Right Transverse and OIA 
 

Skin

Max Depth

Optimal is Lateral, at or near 
current position

Optimal is 45 degrees Anterior from 
current position

Optimal is 90 degrees Anterior or 
Posterior from current position

Optimal is 45 degrees Posterior to
current position
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The entire length of each carotid system is now scanned longitudinally at this optimal interrogation 
angle to provide an overall qualitative impression of the extent and severity of disease and the quality 
of the image at this interrogation angle.  Unusual anatomic features or possible lesions are observed.  
Oral comments are recorded during the exploratory scan to assist the reader during the reading 
process, although the sonographer should take care to avoid alarming the participant by using terms 
like plaque, lesion, or disease, instead referring to structures or areas of interest. 
 
Next, the sonographer determines which artery is the internal carotid artery.  This is accomplished by 
using the Doppler cursor to sample first one branch and then the other.  Once the internal carotid 
artery is identified, the preliminary scan is complete. 
 
8.1.3 Protocol Scan 
 
To begin the protocol scan, the focus of the ultrasound transducer is moved proximally (toward the 
heart) to view the distal centimeter of the right common carotid artery, immediately below the 
beginning of the dilation of the bifurcation.  Care should be taken to maintain the optimal angle.  Once 
the correct portion of the common carotid is in focus, small manipulations of the transducer are used 
to orient that section of the artery horizontally in the display window.  Additional manipulations of the 
transducer and instrument settings are made to optimize visualization of the adventitia-media and 
blood-intima interfaces on the near and far walls.  Once the sonographer is satisfied that a high 
quality image has been attained at the optimal angle, he/she should verbally state “Acquire, Right 
Common Carotid Optimal Angle in xx region”, where xx is the region (anterior, lateral or posterior) 
that contains the OIA.  This image should be held still for a period of at least 5 cardiac cycles 
(approximately 5 seconds). 
 
This procedure is then repeated for the two additional circumferential views of the common carotid, 
with the external interrogation angles determined as described in section 6.2.4.  When protocol 
quality images are attained for each view, the sonographer should verbally state “Acquire, Right 
Common Carotid Anterior View”, replacing anterior with the regional terms “Lateral” or “Posterior” as 
appropriate. 
 
After obtaining all three views of the common carotid segment, the sonographer should return to the 
OIA and focus on the bifurcation segment, attempting to align the mid-axis of the lumen horizontally 
on the display window.  Once visualization of both the near and far wall interfaces has been 
optimized, the sonographer should state verbally “Acquire, Right Bifurcation Optimal View” and hold 
that image for at least 5 cardiace cycles.  Then the sonographer should manipulate the transducer to 
bring the far wall of the bifurcation into horizontal alignment and adjust the instrumentation to optimize 
visualization of the far wall interfaces, taking care to maintain the OIA.  Once visualization of the far 
wall interfaces has been optimized, the sonographer should state “Acquire, Right Bifurcation Far Wall 
View” and hold the image for at least 5 cardiac cycles.  The same procedure is then repeated for the 
near wall. 
 
After obtaining all three views of the bifurcation segment, the sonographer should focus on the 
internal segment, extending 1 cm from the tip of the flow divider.  In the internal segment, the 
sonographer should bring the far wall into horizontal alignment, and optimize far wall interfaces 
preferentially over those on the near wall (both adventitia-media and blood-intima).  Only after the far 
wall has been optimized should the sonographer attempt to image near wall interfaces, with 
preference given to the near wall adventitia-media boundary over the near wall blood-intima 
boundary.  When the best possible image is obtained the sonographer should verbally state "Acquire 
Right Internal", and hold the image for at least five cardiac cycles. 
 
After the completion of the internal segment, the gel is wiped from the participant's neck, and the 
head and neck are repositioned for the left side scan. 
 



17 

Exam 1 Carotid Ultrasound Assessment Manual.doc 

8.2 Left Carotid Scan 
 
The procedures described in sections 8.1.1 – 8.1.3 are repeated for the left side.  After completion of 
the left carotid scan, the sonographer applies labels appropriately and completes the log sheet (See 
Section 11). The optimal angle may be determined from the lateral transverse view using Figure 7 
below. 
 
Figure 7. Left Transverse and OIA 
  

Skin

Max Depth

Optimal is Lateral, at or near 
current position

Optimal is 45 degrees Anterior from 
current position

Optimal is 90 degrees Anterior or 
Posterior from current position

Optimal is 45 degrees Posterior to
current position
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9.0 SONOGRAPHER TRAINING, CERTIFICATION AND MONITORING 
 
 
9.1 Training 
 
The sonographer training program includes training sessions held at the field center and/or the URC, 
followed by practice scans and certification steps at field center. 
 
9.1.1 Stage 1 
 
During the initial weeks, a new sonographer becomes familiar with the scanning equipment, reads the 
introductory material supplied by the URC, and becomes familiar with this scanning protocol. 
 
9.1.2 Stage 2 
 
The second phase will include several days training by Ultrasound Reading Center staff. Including 
lectures, demonstrations, and practical laboratory experience on the following topics: 
 

1. Overview of the Study. 

2. Role of the URC. 

3. Ultrasonic Physics, including basic concepts, properties of ultrasonic waves, reflection at 
boundaries and scattering from small objects, and the Doppler effect. 

4. Overview of atherosclerosis and a detailed discussion of the normal artery wall. 

5. Pathology of Atherosclerosis. 

6. Principles of Ultrasonic Instrumentation, including pulse-echo imaging systems, pulsed Doppler 
systems, and spectral analysis. 

7. Basic operation of the scanning instrumentation 

8. Instrument Performance Monitoring. 

9. Principles of Ultrasound Arterial Scanning. 
 
The remaining training time at the field center will be spent practicing scanning technique by 
implementing the study protocol on volunteers.  The field center coordinator and experienced 
sonographers, if available, need to help the novice sonographers in their recruitment and provide 
scheduled time for at least one volunteer practice scan per day.  The volunteers should be of 
approximately the same age as the study cohort participants whenever possible.  Volunteers scanned 
for practice cannot be scanned again for certification purposes.  The chief sonographer and/or 
trainer/reviewer at the URC determines when the new sonographer has attained sufficient skills to 
reliably produce protocol quality scans and begin the certification process.  This portion of training is 
done under the direct supervision of the lead sonographer and/or trainer/reviewer at the URC, who 
guide, evaluate, offer suggestions for improvements and answer questions as they arise.  During this 
period of active practice, the trainer/reviewer at the URC should be in contact with novice 
sonographers at the Field Center at least once per week. 
 
9.1.3 Stage 3 
 
When the lead sonographer and/or trainer/reviewer at the URC determines the new sonographer is 
ready to begin the certification process, the new sonographer scans volunteers with minimum 
supervision.   Certification volunteers must be volunteers the novice sonographer has never scanned 
before. The novice sonographer must  demonstrate his\her skill and understanding of the protocol 
while scanning a volunteer without prior knowledge of the participant's anatomy.  The new 
sonographer should review these scans to evaluate compliance with the standards of quality of 
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interfaces, artery placement, zoom box alignment, interrogation angles, and overall quality of 
scanning before shipping tapes to the URC for review.  These scans will be evaluated at the URC for 
effective adherence to protocol, and feedback on overall scan quality and suggested areas of 
improvement will be provided to the new sonographer in a timely fashion.  A minimum of ten scans 
conforming to the study standards are required before the sonographer will be certified to scan 
participants in this study. 
 
The sonographer reviewer/trainer at the URC may suspend the certification review process at any 
point if the novice sonographer fails to demonstrate an ability to consistently implement the study 
protocol, or if the regular submission of scans for review is interrupted for an extended period of time.  
If the review process is suspended, the sonographer reviewer/trainer at the URC will promptly inform 
both the novice sonographer and field center lead sonographer, and recommend additional practice 
or remedial training.  Any scans on certification volunteers that have been approved as conforming to 
study standards prior to a suspension of the review process will typically be excluded from the set of 
ten acceptable scans required for certification.  Exceptions may be made at the discretion of the URC 
director. 
 
 
9.2 Certification 
 
9.2.1 Certification of New Sonographers 
 
When a novice sonographer has successfully met all training requirements, as outlined in Section 9.1, 
written notification is sent to him/her and to the study coordinator at the field center, informing the 
novice sonographer of his/her new status as a certified sonographer. 
 
9.2.2 Retention of Certification by Experienced Sonographers 
 
A sonographer retains certification to scan based upon the demonstrated ability, while following the 
JHS scanning protocol, to visualize arterial walls in a fashion consistent with that of other certified 
sonographers participating in the study.  Study data will be evaluated on a regular basis to examine 
visualization rates and arterial dimensions contributed by each sonographer to assist in the 
identification of individuals performing differently than their peers.  In addition, at least one scan 
performed by each certified sonographer per month will be reviewed at the URC for compliance with 
the study protocol.  So long as a sonographer maintains visualization and arterial dimensions 
consistent with the process average of their peers and the average of monthly review scans meet 
protocol standards, he/she retains certification.  If, however, sonographers exhibit difficulty in 
performing in a fashion consistent with their peers or in passing monthly scan reviews, remedial 
action will be initiated.  If these problems remain unresolved, decertification may become necessary 
as described in Section 9.2.4.  Sonographers who submit no scans suitable for monthly review for two 
consecutive months will be considered to have lapsed certification.  Experienced sonographers may 
be recertified after submitting 5 scans that pass certification review. 
 
9.2.3 Guest Sonographers 
 
During the course of this Study it is expected that, upon occasion, a sonographer will be unavailable 
to scan participants without being able to give sufficient prior notice to allow for a reschedule of the 
participant's visit.  If no provisions were made for such an eventuality, participant's would be unduly 
inconvenienced, or may refuse to return to undergo an ultrasound evaluation.  In such a case, in 
order to prevent a loss of valuable data, the services of a guest sonographer may be used.  A guest 
sonographer is one who is well-versed in the applied principles of carotid ultrasound, and who is 
familiar with the JHS ultrasound scanning protocol and study equipment.  The names and 
qualifications of guest sonographers are to be registered with the URC, where they will be assigned 
ID numbers. 
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Prior to substituting for a certified sonographer for this Study, the guest sonographer is to read the 
protocol, and review it with the lead sonographer or, in her absence, another JHS certified 
sonographer.  Tapes containing scans recorded by the guest sonographer are to be clearly marked to 
that effect.  Likewise, a notation is to be made on the log sheet. 
 
Upon receipt of these tapes at the URC, these tapes will not be logged in with the tapes produced by 
certified sonographers.  They will first be reviewed by the sonographer reviewer/trainer at the URC .  
If the scans are found to conform to protocol, they will be logged in and treated from then on in the 
standard fashion.  If, however, the scans are found not to conform to protocol, the scans will not be 
logged in and will not be read.  The field center coordinator, chief sonographer and guest 
sonographer will be informed of the areas where the scan did not conform to the protocol. 
 
Due to the additional effort required to process these scans, no guest sonographer may scan for 
more than five days or fifteen scans within a two month period without first obtaining special 
permission from the Executive Committee of this Study and the Carotid Ultrasound Center Director.  
Should the field center require additional sonographer support for an extended period, guest 
sonographers must undergo additional training as specified by the URC in order to become certified 
for this study.  The guest sonographer must submit scans for review for certification and become 
certified when scanning longer than a five days or fifteen scans within a two month period.  At least 
five scans must pass review before certification can be attained. 
 
9.2.4 Loss of Certification 
 
When a sonographer's boundary visualization rate or measured arterial dimensions depart 
substantially from those of their or if the average monthly scans reviewed do not meet protocol 
standards, both the sonographer and the study coordinator will be notified of the specific nature and 
extent of the problem and a plan for remedial action will be developed in conjunction with the URC.  
Remedial action may require refresher training at the URC or Field Center. 
 
9.2.5 Scanning Process Control  
 
Timely feedback is critical to the success of this procedure.  Therefore, on a routine basis, based on 
frequency of scanning and sonographer consistency, sonographers will be given detailed reports of 
their performance, and be notified of the extent to which they conform to the quality and quantity of 
data gathering exhibited by the Study sonographers as a group.  Below are indicated the steps to be 
followed based on each sonographer's conformance to these standards. 
 
9.2.6 Conforming 
 
• The sonographer and study coordinator will receive written notification of her scanning 

performance. 

• The sonographer will continue to scan. 

• The URC will continue to monitor levels of visualization. 
 
9.2.7 Non-conforming - slight 
 
• The sonographer and study coordinator will receive written notification of her scanning 

performance. 

• The sonographer will review the scanning protocol. 

• Another sonographer will observe the sonographer perform that part of the scan which was found 
not to conform to standards and make recommendations for improvement. 

• The sonographer will discuss with the reviewer/trainer at the URC ways to improve protocol 
adherence. 
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• The sonographer will report back to the URC on the steps taken to effect the improvement. 

• The sonographer will continue to scan. 

• The URC will continue to monitor levels of visualization. 
 
 
9.2.8 Non-conforming - moderate 
 

• The sonographer and study coordinator will receive written notification of the sonographer's 
scanning performance. 

• The sonographer will review the scanning protocol. 

• The sonographer will review training materials on the principles of physics and anatomy. 

• The URC trainer/reviewer will identify patterns which might reveal the reason for failing to 
conform to the standard, document areas in need of improvement, and communicate her findings 
to the sonographer. 

• Another sonographer will observe the sonographer perform that part of the scan which was found 
not to conform to standards and make recommendations for improvements. 

• The sonographer will practice that part of the scan on volunteers. 

• The sonographer will report back to URC on steps taken to effect improvement. 

• The sonographer will continue to scan. 

• The URC will continue to monitor levels of visualization. 
 
 
9.2.9 Non-conforming - severe 
 

• The sonographer and study coordinator will receive written notification of the sonographer's 
scanning performance. 

• The sonographer will stop scanning cohort participants immediately. 

• The sonographer will review training materials on the principles of physics and anatomy. 

• The sonographer will review the scan protocol. 

• The URC trainer/reviewer will identify patterns which might reveal the reason for failing to 
conform to the standard, document areas in need of improvement, and communicate her findings 
to the sonographer and the study coordinator.    

• The URC and Field Center staff will jointly develop a remedial plan, including detailed steps 
required for recertification. 

• When the URC determines that improvement has been demonstrated, with visualization at or 
above the study average for all sites, the sonographer will be recertified and may resume 
scanning study participants. 

• The URC will continue to monitor levels of visualization. 
 
 
9.3 Monitoring 
 
Sonographer performance is monitored throughout the Jackson Heart Study at both the Field Center  
and the URC. 
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9.3.1 Monitoring at Field Center 
 
Each sonographer should review at least one scan every month.  During the initial phase of the study 
and at infrequent intervals thereafter, the lead sonographer may elect to have all sonographers 
review the same study to help standardize reviewing technique.  Once sonographers are familiar with 
the review process, the lead sonographer should typically assign each sonographer a scan for review 
that was performed by one of their peers.  Reviewing scans performed by another sonographer 
encourages sharing and standardization of techniques for acquiring and optimizing protocol images, 
and helps minimize between sonographer differences in protocol interpretation and implementation.  
The B-mode images are evaluated for overall image quality, the presence and clarity of the arterial 
wall boundaries, and the presence of anatomical landmarks and a cursor indicating the location of an 
anatomical landmark and the vessel lumen.  Copies of all reviews are sent to the URC on a monthly 
basis and a review log should be maintained at the Field Center.  The Field Center is encouraged to 
hold monthly sonographer meetings where equipment issues, protocol interpretation, and review 
results can be discussed. 
 
9.3.2 Monitoring at the Ultrasound Reading Center 
 
Sonographer performance is monitored at the URC using a number of quality assurance procedures.  
The quality assurance procedures include but are not limited to:  (1) comparing results of repeat 
studies ; (2) periodic reports containing statistics of boundary visualization by individual sonographer 
and study wide; (3) visual review of randomly selected participant scans; (4) on-site monitoring of 
sonographer performance by designated URC personnel.  Reports are generated and distributed by 
the URC. 
 
In addition, the URC can review the same participant studies reviewed by sonographers at the field 
center.  The sonographer evaluation form is completed at the URC, and the results are compared to 
the sonographer's form.  Any significant differences between evaluations, or any significant problems 
are discussed with affected sonographers to resolve the differences.  Results of these sonographer 
evaluations are used to help maintain high standards for participant studies and are part of an 
ongoing sonographer recertification process. 
 
The URC readers read the ultrasound images from all the data collection procedures and the quality 
assurance images.  Image interpretation results from study images and quality assurance images 
from the same site and angle are compared for use in sonographer quality assurance procedures.  
The purpose of this evaluation procedure is to determine the consistency and reproducibility of 
scanning and of interpreting ultrasound images.  The results of these evaluations are reported 
periodically to the JHS Coordinating Center and the field centers. 
 
9.4 The B-Mode Study Scan Evaluation Form 
 
The current version of the B-mode study scan evaluation form is on file at the URC in Winston-Salem, 
NC.  This form provides a forum for a detailed accounting of the conformance to scanning protocol as 
described in this document. 
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10.0  SUMMARY OF LEAD SONOGRAPHER DUTIES  
 
 
It may prove useful to designate a single experienced sonographer at the Field Center as a Lead 
Sonographer, with minimal time (10% FTE) set aside for interacting with the URC staff and 
maintaining the quality of the ultrasound data at the field center.  A summary of duties that may be 
assigned to a Lead Sonographer is listed below. 
 
a. Assist the URC in training new sonographers as described in Section 9.l.3, Stage 3. 
 
b. Responsible for reviewing sonographer scanning performance as described in Section 9.3.1.  
 
c. Responsible for reviewing the quality assurance data prepared by the URC for the field center, 

and for each sonographer at that field center.  Current values and trends are reviewed, and if 
problems arise, the lead sonographer and the URC will work together with the sonographer to 
implement solutions. 

 
d. Responsible for reporting ultrasound area equipment problems to the URC. 
 
e. Responsible for scheduling preventive maintenance visits and other service calls as needed. 
 
f. Responsible for communication with the URC. 
 
g. Responsible for sonographer recertification as outlined in Section 9. 
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11.0 LABELING AND MAILING TO THE ULTRASOUND READING CENTER 
 
 
11.1 Labeling of Video Cassettes  
 
Sequentially numbered video cassette labels are provided by the URC.  The numbered label is 
placed along the long axis of the cassette, so it is visible when the cassette is placed in the storage 
case.  In addition, a second label is placed on the face (broad side) of the video cassette, and the 
participant IDs for all scans recorded on the cassette are written on this label.  Typically, 2-3 scans 
may be recorded to a single video cassette.  A diagram illustrating label placement is presented in 
Appendix 3. 
 
11.2 Log Sheets 
 
During the week, the Field Center maintains a log sheet listing the participant ID’s for all scans 
completed, and the number of the tape to which each scan is recorded.  There are also fields to 
record the location of the OIA for the right and left carotids, a flag to indicate that the sonographer 
considered the participant a possible ultrasound alert and conducted a thorough Doppler investigation 
of clinically suspect lesions, and space to record sonographer comments about the scan or 
equipment performance.  This log sheet is included in the weekly shipment of tapes to the URC as 
described in Section 11.2 below, and a copy is kept at the Field Center.  A sample log sheet is 
presented in Appendix 2. 
 
11.3 Content of Mailing 
 
Each weekly mailing from the field centers to the URC contains: 
 
a. Video cassettes for the participant ultrasound studies completed the previous week. 

b. A copy of the week's log sheet. (See Appendix 2) 

c. A copy of the Shipping Log sheet for the week. 

d. A video cassette containing phantom scan(s), if appropriate. 
 
11.4 Frequency of Mailing 
 
The video cassettes and lists described in Section 11.1 are mailed each week no later than Tuesday 
afternoon to the URC.  The URC expects to receive these cassettes no later than Wednesday 
afternoon, and will initiate a trace if delivery is delayed. 
 
11.5 Package Labeling 
 
The address label from each field center has the following information: 
 
a. Field center personnel sending the package. 

b. Field center return address. 

c. The shipping number from the Shipping Log sheet. 

d. Address label to the URC: 
 
  Ultrasound Reading Center 
  4310 Enterprise Drive, Suite C 
  Winston-Salem, North Carolina  27106 
 
Mailing is by services guaranteeing package arrival at the URC no later than mid-afternoon on the 
Wednesday following the mailing. 



25 

Exam 1 Carotid Ultrasound Assessment Manual.doc 

 
11.6 Verification of Mailing Contents 
 
The contents are verified upon receipt of shipment at URC.  If there are any discrepancies, the field 
center will be notified.   
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12.0  POLICIES / PROCEDURES FOR IDENTIFYING CAROTID ULTRASOUND ALERTS 
 
 
Recent studies have demonstrated that subjects with high grade Carotid Artery stenosis may benefit  
from medical intervention even if they are free of signs or symptoms of cerebrovascular or 
cardiovascular disease.  Experience with community based cohort studies, including ARIC, suggest 
that the prevalence of high grade Carotid Artery stenosis in these cohorts is relatively low.  The 
research methods described in this protocol for the measurement of Carotid Artery Intimal-Medial 
Thickness are not designed to assess Carotid Artery stenosis in any clinically relevant manner.  
Moreover, identification and evaluation of individuals with high grade Carotid Artery Stenosis typically 
requires imaging modalities (e.g., color flow doppler) or interrogation angles that are not included as 
routine components of this ultrasound protocol.  Therefore, identification and evaluation of 
participants with high grade Carotid Artery stenosis is primarily the responsibility of sonographers and 
the Jackson Heart Study Field Center staff. 
 
Carotid ultrasound readers at the URC will serve as a backup or failsafe for the detection of 
participants with lumen narrowing that may have been overlooked by sonographers during the 
ultrasound exam.  Readers will flag for further evaluation any scan that appears to have a residual 
lumen of 2mm or less, whether or not the reader is able to obtain a high quality measurement of 
lumen diameter at that site.  The flagged studies will then be reviewed by the Ultrasound Coordinator 
and Reading Center Director to determine whether the reader’s impression, combined with 
information from the transverse scan, other longitudinal views of the artery and any recorded doppler 
signals are consistent with a high grade stenosis.  If the possible existence of a high grade stenosis 
not previously evaluated by the sonographer is confirmed, this information will be communicated 
directly to the JHS Field Center staff for further evaluation and, if necessary, communication with the 
participant.   Our experience with the ARIC study suggests that less than 5% of all high grade Carotid 
Artery stenoses will be first identified by readers in this fashion. 
 
To reduce duplication of effort and possible confusion regarding the reporting of possible high grade 
stenoses, sonographers are instructed to complete a section on the ultrasound log sheet (see 
Appendix 2) indicating whether or not they performed a supplemental scan to evaluate the possibility 
of high grade stenosis in each participant.  The possibility of high grade stenosis will be evaluated at 
the URC only for those participants not receiving special evaluation at the time of their carotid scan.  
Routine results reporting to the data coordinating center will indicate, for each participant, whether (1) 
no abnormalities were identified by either sonographer or reader, (2) high grade stenosis was 
suspected and evaluated by the sonographer at the time of the carotid exam, or (3) a possible high 
grade stenosis not previously evaluated by the sonographer was identified by the reader and reported 
back to the field center staff for further evaluation. 
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Appendix 1 Doppler Signal Identification of the Internal Carotid Artery 
 
It is important to carefully distinguish between the internal and external carotid arteries using two 
criteria.  First, the internal normally has a significantly larger diameter than the external; second, the 
blood flow velocity pattern in the two vessels as determined with Doppler ultrasound is distinctly 
different.  Used together, these two considerations permit the internal carotid artery to be identified 
with a high degree of confidence. 
 
Although tributaries originating from the external carotid artery may occasionally be viewed with B-
mode ultrasound to help in this differentiation, Doppler ultrasound in most cases is more efficient and 
specific for this separation.  The method and criteria for this identification are as follows: 
 
A B-mode image is obtained of the carotid bifurcation where the common carotid artery divides.  In 
some instances, the best anatomical angle will show the flow divider as well as the proximal internal 
and external carotid arteries.  In the remaining cases, the flow divider and only one vessel can be 
seen from a single angle.  In those instances, the other artery can be visualized by gently rocking the 
ultrasound transducer back and forth in angle or position or both.  Doppler is used to differentiate 
internal and external carotid arteries in these instances. 
 
To obtain a Doppler sample of each artery, press the PW button on the instrument panel and using 
the tracking ball on the instrument panel move the Doppler cursor so that it is positioned within the 
lumen of the branch farthest from the skin surface.  The Spectral Doppler button is pressed.  The 
sonographer observes the tracing on the left monitor and listens to the Doppler signal by turning up 
the audio on the instrument panel.  If the ultrasound transducer is in the internal carotid artery, the 
flow pattern will be that of a low-resistance bed.  This signal has a rapid upstroke and a quasi-steady 
flow through systole and diastole.  The flow continues throughout the cardiac cycle and begins to 
increase again at the next systole. 
 
Flow directed toward the head and away from the heart throughout the cycle is represented as a 
tracing above the baseline in Figure 14.  If the Doppler signal does not correspond to the expected 
pattern, the cursor is placed within the other branch of the common carotid artery.  The external 
carotid artery is usually nearer the skin surface when viewed from an anterior angle and is a high-
resistance vessel.  The characteristics of Doppler signal in this vessel are a forward flow with a sharp 
upstroke and sometimes a high-resistance artery is cessation of flow before the onset of the next 
systole as defined in Figure 15.  A Doppler signal for a combination of internal and external carotid 
flow patterns is illustrated in Figure 16. 
 
The extent to which the Doppler effect "occurs" depends upon the relative orientation of the direction 
of blood flow and the direction of propagation of the ultrasound pulse.  If the two directions are 
parallel, the effect is maximum.  If the directions are perpendicular, in principle NO DOPPLER 
EFFECT WILL OCCUR. 
 
While it is impossible get the directions of ultrasound propagation and blood flow exactly parallel, they 
should be as close to parallel as possible in order to obtain a strong Doppler signal. The two 
directions must NOT BE PERPENDICULAR. 
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Appendix 2 Log Sheet 
 
JHS Carotid Scan Log Sheet  Cassette #____    Shipping #____   Page #____ of ____ 
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Appendix 3 Video Cassette Labeling Diagram 
 

Spine

Face

Standard Label
For Participant ID’s

Label from
URC with
Tape #
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Appendix 4 Weekly Shipping Log 
 
 JHS SHIPPING LOG  
  
 
1. BATCH NUMBER:                    (Beginning with 01) 
 
2. SHIPPING TO: ULTRASOUND READING CENTER 
                  WFUSM PUBLIC HEALTH SCIENCES 
                   4310 ENTERPRISE DRIVE, SUITE C 
   WINSTON-SALEM, NC 27106 
 
3. REPORTING PERIOD:     STARTING DATE: __/__/__ (mm/dd/yy) 
      

                            ENDING DATE:   __/__/__ (mm/dd/yy) 
 
4.   ITEMS: 
 
      TYPE OF ITEM            NUMBER SENT    NUMBER RECEIVED 
    
       A.  SVHS TAPES                                 *          
 
       B.  PHANTOM SCAN TAPE                         *          
 
       C.  PAPER FORMS: 
   
               TAPE LOG SHEET                           *          
             
               SCAN REVIEW FORM                       *          
              
             OTHER:                                   *          

 
 
5. COMMENTS CONCERNING SHIPMENT CONTENTS:                      
                                                                  
  
 
6.   DATE SENT:   /   /     
 
 
7.  INITIALS OF STAFF MEMBER PREPARING SHIPMENT:            
 
 
 
8. *COMMENTS ON CONDITION OF TOTAL SHIPMENT ON ARRIVAL:         
                                                                           
9.    *ARRIVAL DATE:   /   /    
 
10.    *INITIALS OF STAFF MEMBER RECEIVING SHIPMENT:         
 
 
*URC RECORDS HERE  
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Appendix 5 URC Contact Information  
 
The JHS URC is located in Winston-Salem, North Carolina and is part of Wake  
Forest University School of Medicine.  Contact information for the URC is given below.   
 
  Greg Evans, Director      
  Department of Public Health Sciences 
  Wake Forest University School of Medicine 
  Winston-Salem, NC 27157 
  Phone: 336-716-6016 
  Fax: 336-716-6427 
  Email: gevans@wfubmc.edu 
 
  Delilah Cook, Ultrasound Coordinator 
  Ultrasound Reading Center 
  4310 Enterprise Drive, Suite C 
  Winston-Salem, NC 27106 
  Phone: 336-759-2137 

 Fax: 336-759-2139 
  Email: drcook@wfubmc.edu 
 
  Teresa Crotts, Sonographer Reviewer/Trainer 
  Department of Neurology 
  Wake Forest University School of Medicine 
  Winston-Salem NC 27157 
  Phone: 336-716-6016 
  Email: tcrotts@wfubmc.edu 
 
  Carolyn Bell, Librarian 
  Ultrasound Reading Center 
  4310 Enterprise Drive, Suite C 
  Winston-Salem, NC 27106 
  Phone: 336-759-2137 

 Fax: 336-759-2139 
   
In general, questions related to equipment, sonographer performance or protocol interpretation 
should be directed to Teresa Crotts; questions related to carotid ultrasound data values, reader alerts 
or technician certification should be directed to Delilah Cook; and questions related to tracking 
shipments, cassette tapes or participant scans should be directed to Carolyn Bell. 
 

 
 

mailto:gevans@wfubmc.edu
mailto:drcook@wfubmc.edu
mailto:tcrotts@wfubmc.edu
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Appendix 6 Reading List 
 
"The Language of Anatomy" 
 From:  Gardner, W.D. & Osburn, W. A. (l973) Structure of the Human Body. (2nd ed.) 
Philadelphia:  W.B. Saunders Company. 
 
 
"Angiology"  
 From:  Williams, P.L. and Warwick, R., eds. (l980) Gray's Anatomy.  (36th ed.) Philadelphia:  
W.B. Saunders Co. 
 
 
"Blood Supply to the Head and Neck" 
 From:  Fried, L.A.  (l976) Anatomy of the Head, Neck, Face, and Jaws.  Philadelphia:  Lea & 
Febiger. 
 
"Systemic and Pulmonary Circulations" 
 From:  Underhill, S.L., Woods, S.L., Sivarajan, E.S. and Halpenny.  C.J., eds. (l982) Cardiac 
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FOREWORD 
 
This manual is one of a series of protocols and manuals of operation for the Jackson Heart Study 
(JHS).  The complexity of the JHS requires that a sizeable number of procedures be described, thus 
this rather extensive list of materials has been organized into the set of manuals listed below.  Manual 
1 provides the background, organization, and general objectives of the JHS Study.  Manuals 2, 3 and 
10 describe the operation of the Cohort Procedures, Family Study and Surveillance Components of 
the study.  Detailed Manuals of Operation for specific procedures, including those of reading centers 
and central laboratories, make up Manuals 4 through 9.  The Data Management System is described 
in Manual 11. 
 

JHS Study Protocols and Manuals of Operation 

MANUAL TITLE 

1 General Description and Study Management 

2 Cohort Component Procedures 

3 Family Study 

4 Blood Pressure  

5 Electrocardiography 

6 Echocardiography 

7 Ultrasound Assessment 

8 Pulmonary Function Assessment 

9 Specimen Collection and Processing 

10 Cohort Surveillance 

11 Data Management System 
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INTRODUCTION 
 
The JHS cohort will be comprised of African-American males and females ages 35-84 living in the 
metropolitan Jackson, Mississippi area. 
 
Chapter 1 of this manual describes the procedures for determining participant eligibility (Section 1.1), 
for scheduling and conducting the recruitment and Home Induction Interview (Sections 1.2 - 1.3) and 
for scheduling the participant's baseline clinical examination (Sections 1.4 - 1.6).   
 
The first portion of Chapter 2 provides an overview of the design, objectives and content of the first 
clinical examination (baseline exam) and describes the logistics for setting up the clinical examination 
(Sections 2.1 - 2.2).  The training and certification required to administer the forms as well as the 
quality assurance activities for all baseline interviews are described in the next section (Section 2.3).  
It then provides the background, rationale and description of each interview, the training and 
certification required to administer the form, the quality assurance activities, and the data collection 
instruments and procedures.   
 
Chapter 3 provides similar information for the procedures performed during baseline exam.   
 
Chapter 4 addresses the same information for the 24-hour monitoring measures of blood pressure, 
urine, as well as the participant take-home questionnaire.   
 
Chapter 5 describes the rationale and procedures of the medical data review performed before the 
participant leaves the Examination Center.   
 
Chapter 6 covers the study's referral and review guidelines.   
 
Chapter 7 describes the procedures associated with the review of the clinically relevant study results 
by the JHS physician prior to release to JHS participants.   
 
Chapter 8 describes the activities associated with reporting results to participants and her/his health 
care providers.   
 
Chapter 9 outlines the procedures at the Examination Center to ensure participant safety.   
 
Chapter 10 describes procedures for annual telephone follow-up of the cohort.   
 
Chapter 11 describes the components of the physical activity and diet subgroup studies.   
 
Chapter 12 overviews the procedures for surveillance and monitoring events of the cohort. 
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1.0 SAMPLING, RECRUITMENT, HOME INDUCTION INTERVIEW, AND RECRUITMENT 
MANAGEMENT 

 
 
1.1 Introduction 
 
The JHS cohort sampling plan is designed to identify a representative sample of participants for this 
longitudinal study.  Over a three year period 6,500 men and women aged 35-84 are selected for the 
baseline examination.  Annually, thereafter, participants are re-contacted by telephone in order to 
maintain correct addresses and to ascertain interim medical and socio-cultural events.  An outline of 
the procedures employed follows: 
 
A. Sampling and Recruitment: 

1. Create sampling frame for Jackson MSA from a list purchased from Accudata 

2. Random sampling selecting age-eligible individuals from sampling frame 

3. Create listing by anniversary date of all ARIC study participants 

4. Sample selected persons by year of study induction to ARIC and month of ARIC Annual-Follow-Up 

5. Household enumeration for eligibility determination 

6. Home interview with each age-eligible household or family member 

7. Invitation to baseline clinic examination 

8. Clinic examination 

9. Pedigree for determination of family sample eligibility 

10. 24-hour examination 

 
B. Follow-up 

1. Annual contacts by telephone (or home visit) 

2. Birth certificate abstraction for birth weight 

3. Record abstraction for hospitalized events 

4. Death certificate abstraction and mortality investigation for cohort deaths 

 
1.2 Sample Inclusion and Exclusion Criteria 
 
Explicit inclusion criteria for the cohort study are established and uniformly applied across Hinds, 
Madison, and Rankin counties, Mississippi.  The criteria discussed below are applied during the 
sampling and recruitment phases of operation.  The reference population for the JHS cohort study is 
all noninstitutionalized African-American persons currently living in those areas who, by the time they 
are enumerated, are 35-84 years of age. 
 
Application of the study’s eligibility criteria first occurs during sample selection.  Area and list frames 
from which the Examination Center samples are drawn are confined to the boundaries of the 
following three Mississippi counties as recognized at the time that the initial cohort sample is drawn. 
 
1. Hinds County, Mississippi 

2. Rankin County, Mississippi 

3. Madison County, Mississippi 
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Within these three geographic areas, only those people living in residential units are included.  The 
following definition from the 1990 Census has been adopted: 
 

Housing Unit – A house, apartment, mobile home or trailer, group of rooms or single room 
occupied or intended for occupancy as separate living quarters.  Separate living quarters are 
those in which the occupants do not live and eat with any person in the structure and which 
have direct access from the outside of the building or through a common hall.  The occupants 
may be a single family, one person living alone, two or more families living together, or any 
group of related or unrelated persons who share living arrangements (except as described by 
the definition of group quarters).  For vacant units, the criteria of separateness and direct 
access are applied to the intended occupants whenever possible.  If the information cannot 
be obtained, the criteria are applied to the previous occupants. 

 
Explicitly excluded from the cohort study are all persons who live in residences called group quarters, 
in which relatively large groups of unrelated people live and share habitation together.  Group 
quarters were defined as follows for the 1990 Census: 
 

Group Quarters – Living arrangements other than households.  Includes institutions such as 
mental hospitals, homes for the aged, prisons, etc., plus other quarters containing ten (10) or 
more persons where 9 or more are unrelated to the persons in charge.  Such quarters are 
commonly found in dormitories, military barracks, etc., but may also be in a house or 
apartment used as a rooming house or occupied on a partnership basis. 

 
The time marker for establishing a person's age eligibility is September 1, 2000.  Individuals born 
after September 1, 1916 and before September 1, 1965 will be age eligible for the random 
component of the sample.  Age eligibility for the family component of the sample will also be a birth 
date between September 1, 1916 and September 1, 1965 with exceptions noted in the family 
sampling protocol (Manual 3). 
 
A number of other explicit exclusions from the study population are established.  First, the sample 
excludes persons who indicate that her/his permanent residence is somewhere outside the study 
areas.  Second, the study excludes persons who, in the judgment of the interviewer, would be 
physically or mentally incapable of full participation in the study.  Third, persons currently living in the 
study area, but who indicate a definite relocation outside of the study area within the following twelve 
months are excluded, since follow-up of these persons would be difficult and incomplete. 
 
There are several groups of people which will receive special enumeration, recruitment and 
scheduling efforts to ensure they are included in the cohort.  The first group is all women who are in 
their third trimester of pregnancy or less than three months postpartum.  Because of the infeasibility 
of certain measurements just prior to delivery, the examinations for these women are rescheduled for 
a later time when obtaining their measurements is more appropriate.  A second group included is 
persons with language difficulties.  Here, efforts are made to obtain an interview from the person, but 
with another family member or friend acting as an interpreter.  Persons with language difficulties but 
with no available interpreters are treated as eligible nonrespondents and dropped from the study.  A 
third group not excluded is persons who are temporarily away from home (e.g., on vacation or 
incarcerated for a time-limited duration within the study recruitment dates).  As with the late 
pregnancies, examinations for this group are rescheduled for a more convenient time after they 
return. 
 
To establish eligibility for the study, information can be obtained from any of the following sources: 
 

1. Data available on the frame; 

2. A knowledgeable adult member or the selected housing unit during enumeration; or 

3. A knowledgeable adult neighbor to the selected housing unit. 
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Gaining information by proxy under the third alternative is allowed only as a last resort (i.e., after all 
required call attempts have been made). 
 
Table 1. Enumeration rules for the JHS cohort: persons staying in housing unit  

at the time of enumeration 
 

Type of person including members of family, lodgers, servants, visitors, etc. Include in 
roster 

1. Ordinarily stay here all the time (sleep here)  Yes 

2. Here temporarily - no living quarters held for person elsewhere Yes 

3. Here temporarily - living quarters held for person elsewhere, but person spends 
(or expects to spend) largest part of the calendar year in this household. 

Yes 

4. Regularly sleep greater part of the week in another locality Yes 

5. Regularly sleep greater part of week in this household Yes 

6. Domestic servant who “lives in” Yes 

7. Student attending college in this locality - living in this household See Table 3 

8. Students away attending college - here only temporarily or on vacation Yes 

9. In Armed Forces - stationed at nearby installation, living in this household No 

10. In Armed Forces - temporarily here on leave - stationed elsewhere Yes 

11. Citizen of foreign countries - studying or working in the U.S. and living in this 
household 

No 

12. Citizen of foreign countries - temporarily traveling or visiting in the U.S. Yes 
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Table 2. Enumeration rules for the JHS cohort for absent persons who would normally 
reside in this housing unit 

 

Type of person including members of family, lodgers, servants, visitors, etc. 
Include in 

roster 

Person in institution where people normally stay for shorter periods of time  
(e.g., general or VA hospitals, short-stay jails, etc)  

Yes 

Person temporarily absent on a visit or vacation Yes 

Person temporarily absent on business trip or in connection with job  
(e.g., traveling salesman, bus driver, railroad man) 

Yes 

Person temporarily absent because of incarceration which will end prior to 
termination of recruitment 

Yes 

In Armed Forces- currently stationed elsewhere or assigned to naval vessel No 

Away attending school - living in a college dorm Yes 

Away attending school - living in a housing unit other than a college dorm No 

              American citizen abroad :  

1. Temporarily on vacation or away in connection with work Yes 

2. Employed by U.S. Government with place of duty abroad No 

3. Any other American working or living abroad for extended period of time No 
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Table 3. ZIP Code listing for the Jackson, Mississippi Metropolitan Statistical Area* 
 

City County ZIP Codes 

Jackson Hinds 39201 39202 

  39203 39204 

  39206 39209 

  39211 39212 

  39213 39216 

Clinton Hinds 39056  

Bolton Hinds 29041  

Edwards Hinds 39066  

Raymond Hinds 39154  

Terry Hinds 39170  

Tougaloo Hinds 39174  

Utica Hinds 39175  

Camden Madison 39045  

Canton Madison 39046  

Flora Madison 39071  

Madison Madison 39110  

Ridgeland Madison 39157  

Sharon Madison 39163  

Jackson/Pearl Rankin 39208 39218 

Brandon Rankin 39042  

Florence Rankin 39073  

Pelahatchie Rankin 39145  

 
*U.S. Census Bureau Map Service 
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1.3 Sampling Procedures for Initial Cohort Selection 
 
The Jackson Heart Study (JHS) sample will consist of 6,500 individuals including the Atherosclerosis 
Risk in Communities (ARIC) Study participants who agree to return for a fifth exam (approximately 
2,000) along with age eligible individuals living in ARIC households (fewer than 100 total expected), 
the family sample (2,000 including approximately 100 informants from ARIC and 100 informants from 
the random cohort), and a random sample of about 2,500 not counting the family sample informants.   
 
A certain proportion of informants (200) for the family sample will be selected from the random 
sample and from ARIC.  This will result in a  total of 6,500 participants when the three components 
are counted together and about 2,600 for the random component counted separately from ARIC 
along with approximately 2,100 returning ARIC participants and eligible household members counted 
separately from the family sample (with 1,800 non informant family sample participants). 
 
The sampling plan will include drawing randomly from the Accudata commercial list for the Jackson 
MSA.  The random selection will be used to generate a random list of households identified by 
householders.  Initially a household will be potentially eligible if the householder from the sampling list 
is living in the household or deceased with spouse living in the household.  From the list of potential 
eligible households, pre-screening will be performed to identify households with at least one age and 
race eligible individual and then all age and race eligible household members will be enumerated as 
potential study participants.  Exceptions and special cases for eligibility include household for which 
the householder is temporarily away, including incarceration and potential eligible participants 
considered physically or mentally unable to participate in the study. The details of eligibility 
determination are discussed in the sections on study eligibility determination.   
 
For areas in the Jackson MSA that are 80% or greater African-American based on census information 
and for households where phone numbers are not available the eligibility screening will be done when 
recruiters visit the household.  Randomly selected households that are from less than 80% African-
American and have phone numbers available on the sampling frame will be pre-screened with a quick 
phone contact to determine eligibility.   
 
Any household that is drawn in this way will be considered a part of the random cross sectional 
sample.  This will hold whether or not individual will eventually be the informant for a family sample 
unit.   Individuals who are both selected randomly and also happen to be members of the ARIC 
cohort or are recruited for the family sample will also be considered members of the random cross 
sectional sample.  In other words random selection by the sampling method described above will be 
the condition for membership in the random cross sectional sample without respect to concomitant 
ARIC participant status or incidental inclusion in the family sample.  
 
1.3.1. Population Sampled 
 
The population to be studied by the Jackson Heart Study consists of all African-Americans ages 35-
84 living within the Jackson MSA which is defined by the county boundaries of Hinds, Madison and 
Rankin counties.  Census statistics are given for the Jackson MSA. 
 
At the time of the 1990 census there were 167,899 African-Americans living in the Jackson MSA of 
which 56,610 were between the ages 35 and 84.  The most recent census projections for  1997 result 
in an expected age eligible African-American population of 68170.   
 
Analyses of the Accudata list to be used as the sampling frame contains 123,403 households in the 
Jackson MSA with householders aged 35 and older.  The Accudata list was selected from among 
several other commercially available lists based on coverage of high density African-American areas 
in the Jackson MSA and good coverage of age and socioeconomic status.  Crude estimates for year 
2000 based on census projections for the Jackson MSA  yield roughly 120,000 households with 
householders aged 35 and older.  About 39,000 of these households have African-American 
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householders aged 35 and older.  Roughly 60.5% or 23,595 of these households are estimated to be 
from neighborhoods that were 80% -100% African-American for 1990 census data .    
 
The Accudata list contains a total of  26,516  households for householders aged 35 and older  from 
the 80% - 100% African-American census areas indicating that the JHS sampling frame does not 
undercount either the total number of households in the Jackson MSA or the total number of 
households in higher density African-American census areas. 
 
1.3.2 Design Summary 
 
The sample design for the JHS incorporates three sub-samples to achieve a total size of 6,500: 
 

1. Community random sample 

2. ARIC cohort and eligible household members 

3. Family sample 
 
Table 4 summarizes the sampling rates and sample sizes expected to obtain the completed cohort. 
 
Table 4. Sampling rates and sample sizes needed to obtain 6500 JHS cohort study participants. 
 

Sample Source Sample 
Size 

Random households 2676 

Home interviews  
(estimated 1.6 eligibles per housing unit and 80% participation) 

3425 

Clinic exams from random households  
(estimated 73%participation) 

2500 

Clinic exams from family sample 2000 

Clinic exams from ARIC cohort 2000 
 
1.3.2.1 Community Random Sample Design  
 
The random sampling frame for participants aged 35-84 consists of the commercial list of residential 
households provided by Accudata America.  The information furnished includes householder name, 
address, zip code, and phone number if available.  Other useful information includes percent white 
from 1990 census data and age group in decades.  The sample list includes household with 
householders aged 35 and older.  In order to create the sampling frame list will be sorted in random 
order and households drawn from the top down until the initial cohort selection is complete. A new 
updated list will be obtained annually on September 1.  
 
Recent changes in federal privacy regulations have prohibited the availability of lists with individual 
information on race/ethnicity and date of birth.  Because of this there is no sampling frame available 
with individual information regarding self described ethnicity.  Methods for dealing with sampling 
frames that contain elements that may not be members of the population of interest include a brief 
screening to screen out elements not belonging to the population of interest (blank listings) after the 
random sample is generated.  This is generally done by selecting a random sample that is known to 
be smaller than that needed to complete the study and then screening for blank listings.  Subsequent 
random sample can then be obtained with knowledge of the proportion of blank listings based on 
previous samples. Arranging the sampling frame in random order and proceeding to draw households 
from the top down avoids potential selection bias from correlation between the density of listings in 
any part of the frame and the content of those listings (Kish, 1995, pp, 384-387). 
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1.3.2.2 ARIC/JHS Sample Design and Selection 
 
Approximately 2000 to 2300 persons in the ARIC cohort along with age eligible household members 
are expected to participate in the JHS baseline visit.  All remaining ARIC participants (all living 
individuals who had an ARIC baseline visit) and age eligible household members are eligible for 
participation in the JHS. 
 
1.3.2.3 Family Sample Design 
 
The sampling frame for the family sample consists of persons selected from either the random 
community sample or the ARIC/JHS cohort sample who complete the baseline visit for the JHS, have 
two siblings and identify 9 or more first-degree relatives living in the sampling area.  A full description 
of the Family Sample Design can be found in Manual 3:  Family Study. 
 
1.3.3 Sample Selection 
 
1.3.3.1 Community Random Sample Selection 
 
Sample lists will be generated every 3-6 months and sorted by zip code, name, age, and address for 
efficiency during recruiting efforts.  Each list will be required to be exhausted before a new list is 
provided to recruiters to maintain the random nature of the sample.  The last list of the three year 
baseline recruiting period will be adjusted based on actual response rates to be approximately 
exhausted by the end of the recruitment phase of the study. Generation of 3-6 months worth of 
potential participants and sorting by zip code, name and address will facilitate focused efforts in 
community awareness and health education and subsequent recruiting without compromising the 
random nature of the sample. 
 
Each 3-6 month sample list will be divided into several sub-lists based on several criteria as follows: 
 
1. Households in greater that 80% African-American areas based on the sampling frame census 

information.   This information is coded in the frame as a character string that indicates “percent 
white” from the 1990 census.  For operational purposes this will be inverted to obtain approximate 
percent African-American for the area in which each household resides. 

 
2. Households not in greater that 80% African-American census areas for which phone numbers are 

available on the Accudata list. 
 
3. Households not in greater that 80% African-American census areas for which phone numbers are 

not available on the Accudata list. 
 
The sample records in item 1 above will be sent directly to the recruiters.  Item 2 will be forwarded to 
the subcontractor for phone screening according to the phone screening protocol and the records 
from item 3 will be forwarded to the Undergraduate Training Center for phone number search.  Once 
item 3 records are returned to the CC then records with phone numbers will be included in the next 
regular transmission of sample records to the phone screening subcontractor.  All other records for 
item 3 for which phone numbers have not been located will then be sent to the recruiters.   
 
Data records that are returned from the phone screening subcontractor will have screened ineligible 
records removed and archived and the remaining eligible and eligibility status unknown records will 
be forwarded to the recruiters.  
 
Prior to recruiting, the sample list will be searched for households of ARIC participants who were 
present at ARIC exam 1 by comparing names and addresses to the ARIC database. These 
households will be removed from the recruiters list to avoid repeat contacts.  This information will be 
archived for reporting rates of ARIC households re-sampled in the random household sample.  Also 
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any ARIC participants found on the sampling list during recruiting or located in random household 
enumeration or family sampling will be noted and information archived. 
 
1.3.3.2 ARIC Cohort Sample Selection 
 
Sampling lists form the Jackson ARIC Field Center participant tracking database will be created every 
two months based on the sequential schedule outlined in Table 5.   Entry into the JHS recruitment 
process will follow the ARIC annual follow up call in a coordinated manner so that all contact 
information will be as current as possible.  ARIC participants whose baseline examination was in Year 
1 of ARIC and are due for annual follow-up in August 2000 will be contacted for a Home Induction 
Interview and subsequent JHS clinic examination beginning with September 2000 recruitment.  The 
selection process will continue in like manner with the following examination year and annual follow-
up months in sequence. 
 
Table 5. Jackson Heart Study ARIC participants recruiting schedule, with expected total 

available for recruitment. 
 

Date of ARIC  
data release Month and Year for ARIC baseline visit Expected  

Total 
September 10, 2000 July 1987, Aug. 1987, Sept. 1987 215 
November 10 , 2000 Oct. 1987, Nov. 1987, Dec. 1986 187 
January 10, 2001 Dec. 1987, Jan 1988, Jan. 1987 179 
March 10, 2001 Feb. 1988, Mar. 1988, Feb. 1987, Mar. 1987 281 
May 10, 2001 April 1988, May 1988, April 1987, May 1987 230 
July 10, 2001 June 1988, July 1988, June 1987 244 
September 10, 2001 Aug. 1988, Sept. 1988 187 
November 10, 2001 Oct. 1988, Nov. 1988 183 
January 10, 2002 Dec. 1988, Jan. 1989 228 
March 10, 2002 Feb. 1989, Mar. 1989 180 
May 10, 2002 April, 1989,  May 1989 260 
July 10, 2002 June 1989, July 1989 262 
September 10, 2002 Aug. 1989, Sept. 1989 241 
November 10, 2002 Oct. 1989, Nov. 1989 256 
January 10, 2003 Dec. 1989, Jan. 1990, Feb. 1990, Mar. 1990 266 
March 10, 2003 ARIC Finished 0 
May 10, 2003 ARIC finished 0 
July 10, 2003 ARIC finished 0 
September 10, 2003 ARIC finished 0 
 
Note:  The expected totals are based on present ARIC annual follow-up information.  This information 
is accurate for the next few months. There are presently about 70 deaths per year or about 6 per 
month.  This will potentially reduce the monthly counts by as much 6 per month one year out and 12 
per month two years out and 18 per month by the end of this schedule. 
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1.3.3.3 Family Sample Selection 
 
Each JHS participant meeting the minimum family size eligibility requirement will be a potential 
informant for the family study.  The final sample for the family study will include approximately 2000 
individuals.  Thus the informant will meet recruitment criteria (age 35-84 years, living in the Jackson 
tri-county area and African-American).  Families of an informant will be eligible for the JHS family 
study if the informant has 2 full siblings meeting JHS recruitment requirements and a minimum of nine 
first degree relatives among them who live in the Jackson recruitment area or elsewhere and are 
willing to travel to Jackson to participate in the clinic visit.  The first-degree relatives do not 
necessarily need to meet the other recruitment requirements.  It may be necessary to sample outside 
of the age range to obtain families of sufficient size.  However, we would restrict the lower bound of 
age to 21 years of age and make all efforts to stay within the 35-84 year age range.  In addition, 
efforts will be made to recruit the largest families available with a minimum family size of twelve 
(outlined above).  In order to assure the most informative and largest families are selected, an 
algorithmic flagging system will alert the clinic to generate a graphical pedigree on each eligible 
informant.  Graphical pedigrees will be reviewed quarterly by the Genetics Committee for final 
selection of potential families (see Manual 3: Family Study). 
 
It is expected that approximately 140 ARIC participants will be selected incidental to drawing the 
random community sample.  Based on the ARIC exam 4 schedule there should be from 42-96 
existing ARIC participants per month leaving 85-139 participants from the family sample and random 
samples per month in order to attain the 180-181 participants per month required for a total of 6,500 
participants over three years.  As family study participants are located they will be scheduled for clinic 
visits along with participants from households selected in the random sample. 
 
1.4 Sample Replication 
 
To facilitate quality control of the laboratory methods used during the three-year examination period, 
samples from the examination are randomized so that the individuals examined during any one-
month period are a random subset of the full sample and, therefore, a representative sampling of the 
study population.  This sample replication serves to remove the effect of inherent differences in the 
observed sample through time.  Sample replication is done by selecting a new sample each quarter. 
 
Departures from the initial replicate assignments occur in those cases where the actual examination 
cannot be conducted in the assigned month due to scheduling conflicts on the part of the participant.  
These departures are not expected to alter significantly the original intent of the replication, however 
individuals examined each month are still a reasonably representative sampling of the study 
population. 
 
1.5 Household Enumeration 
 
Selectees chosen from the lists are first contacted by JHS using a letter sent to the selected individual 
at the listed address (Appendix).  This letter serves to invite participation by introducing and 
explaining the purpose of the study and to assure confidentiality.  The field interviewers are given the 
selected individuals’ names and addressees, grouped geographically to minimize travel.  The 
household containing the selected individual is found and the entire household enumerated for 
eligibility.  If the address listed for the participant is incorrect, s/he is traced using phone directories, 
contacts with neighbors, etc.  If the selectee still lives in the study community, the enumeration is 
completed; if the selectee lives outside the community boundaries, s/he is considered ineligible.  
 
Interviewers are instructed to make her/his initial visit to a sample household in the late afternoon or 
early evening on a weekday or on Saturday, since the chance of finding an eligible enumeration 
respondent (a knowledgeable household member aged 16 or older) is enhanced at these times.  If no 
eligible enumeration respondent is at home on the first attempt, the interviewer attempts to learn from 
other household members (e.g., under age 16) or neighbors when an eligible household member is 
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expected to be at home.  If no contact is made, a door hanger is left to alert the sample household 
that a JHS recruiter has attempted to reach them.  If a suggested time cannot be obtained, the 
interviewer is required to make the second attempt between 5:30-9:00 p.m. on a weekday or during 
the morning of the following Saturday.  At this second call-back, if no contact is made, a second door 
hanger and a small welcoming incentive is left.  Additional call backs are made, as necessary, with 
the interviewer continuing her/his efforts to learn from secondary sources when and how to contact an 
eligible enumeration respondent.  In the absence of better information, successive attempts are made 
at varying time/day intervals in order to increase the probability of finding an adult at home.  After 
three unsuccessful attempts, recruiter/interviewer will supplement household visits with telephone 
contact. 
 
When contact is made with an eligible enumeration respondent, the interviewer introduces 
her/himself, briefly describes the purpose of the visit, shows the respondent her/his credentials, and 
proceeds with enumeration.  Enumeration is the process of completing a household roster to select 
the sample member(s).  To be eligible to be a cohort member for a selected household, the person 
must be a member of the sample household and be ages 35 through 84, as of September 1, 2000.  
Identification of the cohort sample participants is done by the interviewer.  To assure proper selection, 
the enumeration respondent is asked to list all the persons 18 years of age or older who reside in the 
sample unit.  From this listing, the number of eligibles per household is determined.  As described 
previously, all eligible members of a household are selected for the cohort sample. 
 
To assure that comparable efforts are made in obtaining participation for the study, a set of criteria for 
enumeration and clinic recruitment has been established.  Unless early attempts indicate that further 
efforts are fruitless (e.g., an unequivocal refusal), field staff are not allowed to consider a selected 
housing unit as a final non-contact until at least five (5) call attempts have been made, with at least 
one attempt made during a weekday, during a weeknight, and on a weekend (legitimate exceptions 
allowed).  Initial non-respondents not giving an unequivocal refusal are re-contacted for possible clinic 
recruitment.  The Examination Center is allowed to try to reschedule eligible persons for a period of 
up to six months after the month in which the person was initially assigned.  If rescheduling is 
required for reasons such as illness or travel, this time period can be extended up to nine months. 
 
1.6 The Home Induction Interview 
 
The Home Induction Interview is administered to all age 35-84 eligibles (self-identified African-
American ethnicity) within a sampled housing unit.  After identifying those eligible to participate, the 
JHS is explained and those who are eligible are asked to take part in it.  The Home Induction 
Interview is also designed to obtain certain demographic, sociocultural, and medical information from 
the participant.  Any questions the participant has about her/his clinic visit or about the study in 
general are clarified. 
 
1.6.1 Home Induction Interview Procedures 
 
As eligible sample members (respondents) are identified through the enumeration process, the 
interviewer attempts to secure the home interview for all respondents on the same visit to the 
household whenever possible.  When contacting an eligible respondent, the interviewer repeats the 
JHS introduction (assuming the sample respondent is a different person from the enumeration 
respondent) and explains in somewhat more depth the purpose and importance of this study.  A 
brochure and letter explaining the purpose of the study and the examination are used for recruitment.  
The voluntary nature of the study and the confidentiality of the collected data are stressed.  If a 
sample respondent is not at home at the time of enumeration, call backs are made as necessary, to 
secure the household interview and schedule the clinic appointment. 
 
1.6.2 Contacts with Participants 
 
The first contact from the JHS is by a letter sent to the selected individual at the listed address.  When 
the address is a P.O. Box, a postage paid card is included to request street address.  The purpose of 
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the letter is to introduce and explain the purpose of the study and to describe confidentiality 
assurances. 
 
The JHS interviewer, wearing an identification badge and uniform clothing, visits the selected 
household, enumerates the household to determine eligibility, and recruits eligibles to the study.  The 
JHS enumeration protocol and forms, as well as the eligibility requirements are described below. 
 
1.6.3 Recruiter/Interviewer Training, Certification and Quality Assurance 
 
1.6.3.1 Training 
 
Interviewers are centrally trained to use a standardized procedure for administering the Home 
Induction Interview.  Training includes an overview of the JHS and its precursor, ARIC; an overview of 
epidemiological cohort research methods; instructions in research interviewing techniques: 
communication, respecting cultural diversity, and in completing the forms, including: 
 

1. a thorough review of the forms, instructions and protocol to promote adherence to the protocol 

2. practice in the use of nonjudgmental attitude 

3. practice with the degree and nature of prompting permitted 

4. dealing with problem interview situations 

5. use of response cards  

6. practice handling participants' comments and recording relevant information on the note logs 

7. review of post-interview responsibility for the data 

 
More extensive detail of the training component for completing paper forms and interview techniques 
are included in the Appendix. 
 
1.6.3.2 Certification 
 
Interviewers are certified by the Central Trainer at the successful completion of training.  New staff 
are trained and certified using the same format. 
 
1.6.3.3 Quality Assurance 
 
To promote consistency and accuracy in data collection and to minimize inter- and intra-interviewing 
differences, the Director of Recruitment monitors 5% of the interviews done by each 
recruiter/interviewer.  Technique and adherence to protocol are also monitored at least semi-annually 
by Coordinating Center monitors.  In addition, a brief written worksheet/quiz on recruiting, and 
interviewing problems is completed by each interviewer every 6 months.  This worksheet/quiz is 
distributed by the JHS Coordinating Center and reviewed by the JHS Cohort Operations Committee. 
 
1.6.4 Home Induction Interview (HII) 
 
The Home Induction Interview (HII) is a part of the core data collection instruments for the first cohort 
examination.  The HII is actually a composite of forms to elicit participant eligibility and, once 
confirmed, to enumerate the sample respondent’s household identifying all age-eligible JHS potential 
participants.  The interview covers information regarding personal and family health history, global 
stress, tobacco use, physical activity, social support as well as personal and socioeconomic data.  
Upon completion of the HII, a clinic appointment is scheduled to complete the baseline examination. 
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1.6.4.1 Rationale 
 
The HII serves several purposes.  It provides an initial contact with the JHS in a comfortable and 
known environment.  It serves to introduce the participant to the clinic examination and the collection 
procedures to ascertain baseline data concerning a number of core variables for the JHS.  
Information on each of the composite forms is included below. 
 
1.6.4.2 Administration 
 
The HII is divided into three major sections: 

1. Eligibility and enumeration 

2. Interview 

3. Schedule clinic appointment 

Question by question instructions (QxQ’s) are located in the Forms Appendix, immediately following 
each form.  The interviewer determines and records whether the sample respondent meets eligibility 
requirements for the JHS.  Once eligibility is verified and consent to proceed with questions is 
obtained, the interviewer then enumerates all persons living in the household and ascertains 
willingness of eligible household members to complete the interview.  The HII is then conducted with 
each eligible respondent.  Specific instructions for administration of each component of the HII follow 
below in each sub-section.  Instructions for scheduling the clinic visit follow in section 1.6.5. 
 
1.6.4.3 Data Collection 
 
All forms which comprise the HII are paper forms which are designed to be interviewer-administered.  
Data are entered using pencil directly onto the paper form and are subsequently entered into the data 
entry system (DES). 
 
1.6.4.4 Household Enumeration (HEF) and Household Enumeration Supplement (HES) 
 
The Household Enumeration (HEF) and Household Enumeration Supplement (HES) forms are 
intended to confirm the address of the sample individual and gather baseline information on all 
persons living in the household of the identified sample individual.  This form was adapted from ARIC 
and gathers the name, date of birth, ethnicity, gender, and marital status of each person who 
considers the identified address as their residence.  As the only form that obtains ethnicity, the HEF 
also serves to confirm eligibility of the identified sample person as a self-identified African-American.  
Other household residents will be considered eligible for inclusion in JHS if they are within the 35-84 
age range and self-identity as African-American.  The ethnicity eligibility requirement is void for 
participants in the Family Study based on the household sampling unit. 
 
1.6.4.4.1 Rationale 
 
The HEF provides the information necessary for completing the household sampling unit used for the 
JHS.  By identifying each person residing in the identified sample individual's residence, individuals 
eligible for participation in the JHS are identified.  Further, the HEF provides the opportunity for 
confirmation of self-reported African-American ethnicity.  The HEF is used to assign both Household 
ID and Participant ID numbers for each potential household eligible. 
 
1.6.4.4.2 Administration 
 
The HEF is administered by a trained recruiter/interviewer to all identified sample persons (or another 
household resident 18 years of age or older if the identified sample person is not at home) as part of 
the HII.  Detailed instructions for administering each question are contained in the QxQ instructions.  
If there is insufficient space on the HEF to enumerate all the residents of the household, the 
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interviewer is to proceed to the Household Enumeration Supplement (HES), which provides additional 
space for listing more than 5 household members.  
 
1.6.4.5 Household (HER) and Participant Record of Calls (IRC) and Tracing (TRC) and 

Household Induction Record of Calls (IRC) 
 
Several forms provide an ongoing tracking system which documents efforts to contact the sample 
household to complete enumeration and subsequently complete the Home Induction Interview with 
each enumerated eligible.  The Household Enumeration Record of Calls (HER) documents each 
attempted contact with the sample household.  The Tracing form (TRC) is implemented when the 
identified sample person no longer resides at the address provided from the sampling frame.  Tracing 
is initiated to locate the identified sample at another address in order to complete the enumeration 
process.  Upon completion of the HER, and, if needed, the TRC, the Household Induction Record of 
Calls (IRC) provides documentation of all attempts required to complete the Home Induction Interview 
(HII).  Each of these forms are modifications of similar ARIC forms. 
 
1.6.4.5.1 Rationale 
 
Maintaining documentation of the effort required to contact household and individual sample eligibles 
is necessary to determine the response rate for the sample selection process.  Final Results Codes 
will document the number of completed and incomplete HII as well as the number of and reasons for 
refusals.  Information documented on these forms provides the basis for routine reports on 
recruitment and allows adjustment of sampling efforts and workload allocation for the 
recruiter/interviewer staff. 
 
1.6.4.5.2 Administration 
 
The HER is completed as a study tracking form by trained recruiter/interviewers on all participants as 
part of the HII.  It is completed as the first form in the HII forms packet.  A Household Identification 
number is assigned and the identified sample person's name is listed at the top of the form.  The day 
of the week, date and time of initial and all subsequent household contacts are recorded on separate 
lines.  A Result Code is assigned for each contact and notes are entered as needed to further explain 
the code.  Detailed instructions for completing the HER are included in the Forms Appendix. 
 
The TRC is completed only on those participants who are no longer living at the address provided by 
the sample frame by a trained recruiter/interviewer as part of the HII.  This form is initiated based 
upon a Result Code, "Tracing Required," entered on the HER.  For each tracing step attempted, the 
date and information obtained is recorded according to the QxQ instructions. 
 
The IRC is completed on all participants by a trained recruiter/interviewer as a study tracking form.  A 
separate IRC is initiated for the identified sample person and for each enumerated household eligible.  
Both the person's name and the Participant Identification number as assigned from the HER are 
recorded at the top of the form.  The day of the week, date and time of initial and all subsequent HII 
contacts are recorded on separate lines.  A Result Code is assigned for each contact and notes are 
entered as needed to further explain the code.  Detailed instructions for completing the IRC are 
included in the Forms Appendix. 
 
1.6.4.6 Eligibility (ELG) 
 
The Eligibility (ELG) form is intended to assure that each identified sample person and enumerated 
household member are eligible for participation in the JHS  according to the sample criteria discussed 
in Section 1.  Further, it ascertains eligibility for participation in the Family Study by identifying the 
number of living first degree relatives who reside in the study locale, or are willing to travel to 
participate in the JHS.  Finally, the ELG identifies the respondent's level of awareness about the JHS 
and factors important to their participation or non-participation.  The ELG is based on a similar ARIC 
form, but has significant modifications to meet the unique requirements of the JHS. 
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1.6.4.6.1 Rationale 
 
Confirmation of eligibility is essential to assure that the final sample indeed meets the residence, age 
and ethnicity criteria identified for inclusion in the JHS.  Additionally, it is important to recruitment and 
ongoing retention to understand the level of community awareness and issues surrounding 
participation. 
 
1.6.4.6.2 Administration 
 
The ELG form is administered to all participants at the initiation of the HII by a trained 
recruiter/interviewer.  Detailed instructions for administering each question are contained in the QxQ 
instructions. 
 
1.6.4.7 Personal and Family Health History (PFH) 
 
The Personal and Family Health History (PFH) is intended to gather baseline information on the 
personal and family health background of each respondent.  This form was adapted from the ARIC 
Personal History form and additional questions on the health history of full brothers and sisters and 
natural children were added to assure that a wide range of essential family health data can be 
captured.  Likewise, this data provides important baseline information for the family component of the 
JHS. 
 
1.6.4.7.1 Background, Rationale, and Hypotheses 
 
An extensive, well-accepted body of data supports the relationship between health history and risk for 
development of CVD.  Self-perceived health status has likewise been positively correlated with 
disease likelihood.  We hypothesize that these strong relationships will continue with the JHS.  That 
is, the more extensive the history of CVD and other metabolic conditions, the more likely the person is 
to develop CVD over her/his lifetime.  Further, this relationship will be moderated by a variety of 
socioeconomic and psychosocial variables, e.g., discrimination, stress, social support, coping, SES, 
health care access, and so forth. 
 
1.6.4.7.2 Administration 
 
The PFH is administered to all participants during the HII by a trained recruiter/interviewer.  Detailed 
instructions for administering each question are contained in the QxQ instructions.  The initial 
question requires the respondent to rate her/his health status.  Subsequent questions seek specific 
information on self-reported history of hypertension, hyperlipidemia, heart attack, stroke or diabetes 
among the respondent and her/his parents, siblings and children. 
 
1.6.4.8 Physical Activity (PAC) 
 
The JHS Physical Activity Survey (PAC) is an interviewer-administered instrument designed to obtain 
information about respondents’ physical activity habits.  The survey contains 30 items in 4 sections.  
The participant responds to a series of 7 questions about usual level of participation in her/his daily 
routine (active living), 8 questions about occupational activity, and 7 questions about activities in the 
home, yard, and garden.  For the sports/exercise section, respondents are also asked to identify the 
frequency and duration for the three most frequent sports/exercise activities performed in the past 
year. 
 
1.6.4.8.1 Background, Rationale, and Hypotheses 
 
Physical activity is widely recognized as an important and independent risk factor for many chronic 
diseases, including CHD, hypertension, and diabetes (Pate, et al., 1995; U. S. Department of Health 
and Human Services, 1996).  The effect of a sedentary lifestyle on CHD is now recognized as almost 
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as great as smoking and hypertension (Kriska & Caspersen, 1997).  Epidemiologic surveys 
consistently show that prevalence of sedentary lifestyles is greater in minority, lower education, and 
lower income populations (Pate, et al., 1995), although the reasons for the observed differences are 
not yet understood (King, et al., 1992). 
 
Method of Assessment of Physical Activity and Results to Date from ARIC. 
 
For public health surveys, the most frequent choice for physical activity assessment has been 
interviews or questionnaires.  These are favored because they: 1) do not alter the behavior of the 
person being surveyed; 2) are practical in terms of cost of administration and participant convenience 
and, 3) can be adapted to the population being assessed (Kriska & Caspersen, 1997).  The physical 
activity instrument used in the ARIC study was a modified version of a self-report questionnaire 
developed for a study of Dutch men and women (Baecke, et al., 1982): the instrument yields 3 scores 
assessing activity at work, in sport and at leisure.  Researchers (Richardson, et al., 1995) reported 
additional gender-specific reliability and validity data for the ARIC instrument, and concluded the 
instrument is simple and easy to administer, is reliable and assesses heavy activity quite well.  Its 
weaknesses were the relative inability to accurately assess moderate level activity and the absence 
of items involving child care and household activity.  These weaknesses were shared by most of the 
instruments available at the time. 
 
Folsom and others (1994) have examined the physical activity data from ARIC in relation to CHD and 
risk factors.  Work physical activity scores from ARIC showed an inverse dose-response relationship 
with carotid wall thickness in black and white men and women, independent of other risk factors, 
including body mass index (BMI).  In a second study, an association between CHD and the sports 
and leisure scores was observed in white men and women, but no association was observed in the 
black participants (Folsom, et al., 1997).  In this study, the investigators noted that the black 
participants had lower levels of activity than whites and fewer (5% vs. 15%) reported any vigorous 
activity.  This restricted range could have obscured an association between physical activity and 
CHD.  In a more recent study, Pereira, Folsom, et al., (Pereira, Folsom, et al; ARIC manuscript #422), 
examined physical activity in relation to hypertension.  Blacks reported more walking and standing 
and less sitting at work than did whites, and blacks were less likely to report often or very often 
playing a sport or exercising during leisure time compared with whites (47% vs. 72%).  Neither the 
sports nor the work index were associated with reduced odds of hypertension in blacks, but the lack 
of graded inverse association between BMI and waist-hip ratio with physical activity scores once 
again suggested measurement problems. 
 
The positive features of the ARIC methods for assessing physical activity that have been retained in 
the JHS instrument include: 1) evidence that it is a valid and reliable measure of vigorous activity; 2) 
ability to assess activity in different domains (work, sport/leisure); 3) brevity and ease of 
administration.  The ARIC instrument has important limitations and may have not worked as well in 
blacks as in whites.  Fortunately, a modification of the ARIC instrument, known as the Kaiser Physical 
Activity Survey, has recently been validated in a multi-ethnic sample of women (Sternfeld, et al., 
1999; Ainsworth, et al., in press).  Sternfeld’s (1999) study of the modified ARIC instrument with 2,635 
ethnically diverse women ages 20-65 found associations between level of activity and lower BMI, not 
having young children in the home, social support for exercise, and motivation to exercise, and age, 
but these demographic and psychosocial correlates of physical activity differed by domain.  Ainsworth 
and others (under review) compared the summary indices from the modified instrument with Caltrac 
accelerometers and participant physical activity diaries and with fitness and percent body fat 
measures.  One month test-retest reliability correlations were high for all the indices (r=.79 to.91, 
p<.01).  Age-adjusted Spearman rho correlations between the sports/exercise index and the active 
living index were moderate for VOCpeak (r=.34 to .76, p<.01) and percent body fat (r=.30 to -.59, 
p<.05).  Correlations between similar activities for the instrument and participant’s physical activity 
diaries ranged from r=.03 to .64.  These findings show good reliability and validity for the modified 
ARIC instrument and that, at least in women, it works well across ethnic groups.  Some additional 
minor modifications were made to adapt a few items for male respondents for the JHS (Personal 
communication, Barbara Ainsworth, July 31, 1999). 
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Physical Activity Hypotheses for the JHS 
 
Physical activity will be examined in the JHS in order to examine its impact as an independent heart 
disease risk factor in male and female African-Americans and to understand its interaction with both 
established and nontraditional risk factors.  Questions of interest include: 
 
1. Is physical activity protective against heart disease and cardiovascular disease in African-

Americans?  At what levels of intensity and/or energy expenditure can a protective effect be 
observed? 

2. What is the relationship of physical activity to weight and body composition in the adult African-
American population? 

3. Does physical activity in different settings (occupational, household, leisure/recreational) 
contribute similarly to protection against heart disease in African-Americans? 

4. What sociocultural variables are associated with differing levels of physical activity in the JHS 
population in different age-sex groups? 

5. Can environmental variables such as community crime and violence rates be related to activity 
levels of men and women at different ages and with varying employment and home/child care 
responsibilities?  Can perceptions of discrimination be related to lower levels of physical activity? 

6. What are the most frequent intensities and types of activities in various age-sex subgroups of 
African-Americans in the JHS? 
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1.6.4.8.3 Administration 
 
The PAC form is administered by trained interviewers as part of the HII in the participant’s home.  The 
form contains 30 items and 4 sections, “Active Living,” “Occupational Activities,” “Home, Family, Yard  
and Garden,” and “Sports and Exercise.”  Participants are asked to identify the frequency and 
duration for these activities.  Each of these activities is coded based on the effort typically required to 
perform that type of activity.  Detailed instructions for administering each item are found in the QxQ 
instructions. 
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1.6.4.8.4 Coding and Scoring  
 
Activity indices are created for each domain of activity by summing the domain-specific responses 
and dividing by the number of items, giving an average value that ranges from 1 to 5.  The coding and 
scoring are adapted from Ainsworth, Sternfeld, et al. (in press).  For each item, response A=1, B=2, 
C=3, D=4 and E=5. 
 
The ACTIVE LIVING INDEX is calculated as the sum of [Q1,Q3, Q4, (6-Q6) divided by 4. 
 
The OCCUPATIONAL INDEX is calculated as the sum of [Q9, Q10, (6-Q11a), Q11b-e, occupational 
intensity code]/8.  The occupational intensity code comes from the physical demands of the 
occupation of 1=low, 3=medium, and 5=high from the Department of Labor Occupational Codes. 
 
The HOME, FAMLY, YARD, AND GARDEN index will be calculated as the sum of [Q12, Q13, Q14, 
Q15, Q16, Q17, Q18]/7. 
 
The SPORT INDEX calculation requires several steps.  The specific activities are coded by intensity 
and multiplied by hours and months.  The resulting score is mapped to an ordinal scale from 1 to 5 
and used as a fourth sports and exercise item. 
 
1. First, each of the activities reported by the participant must be scored by intensity as < 4 METs/4-

6 METs/>6 METs.  This is done by computer matching the code number for the activity with 
intensity values for each code (Q21,Q25 and Q28). 

METS Intensity 

<4 0.76 

4-6 1.26 

>6 1.76 

 
2. Then the months per year must be converted to a proportion of the year (0.5,1.3, 2.5, 3.5, 4.5).  

This is also done by computer (Q22, Q25 and Q28). 

Months per Year Proportion 

<1 0.5 

1-3 1.3 

4-6 2.5 

7-9 3.5 

>9 4.5 

 
3. The time for each activity is then converted to a proportion: (Q23, Q26 and Q29) 

Hours per Week Time 

<1 0.04 
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At least 1 but < 2 0.17 

At least 2 but < 3 0.42 

At least 3 but < 4 0.67 

4 or more 0.92 

 
4. The simple sport score is calculated as the product of intensity by proportion by time for each 

specified activity and summing over the number of activities (Q22, Q25, Q28). 

5. The simple sport score will take the value of 1-2-3-4-5 corresponding to the resulting values of 0; 
0.01-<4; 4<8; 8-<12; >12.  If no activities were specified, the sum will be 0. 

6. The index can now be calculated as the sum of [Q30, simple sport score] /4. 

1.6.4.9 Tobacco Use (TOB) 
 
The Tobacco Use (TOB) form is administered as part of the HII to document current and past tobacco 
use.  Questions cover all types of tobacco (cigarettes, pipes, cigars, chewing tobacco, and dip / 
snuff).  Additional questions include an estimate of environmental tobacco smoke (ETS) exposure, as 
well as an assessment of nicotine dependence for cigarette smokers (Fagerström Test for Nicotine 
Dependence [FTND], items 4 – 9). 
 
1.6.4.9.1 Background, Rationale and Hypotheses 
 
Tobacco use has been firmly established as a significant, modifiable risk factor for a wide range of 
medical disorders.  The association between the use of tobacco and the development and severity of 
coronary heart disease and cerebrovascular disease is well accepted (USDHHS, 1983, 1998a).  
Evidence attests to its influence on accelerating the progression of atherosclerosis, as well as its role 
as a proximal cause for significant cardiovascular events, including myocardial infarction and 
cerebrovascular accidents. 
 
The detrimental effects of tobacco use on the cardiovascular system are associated with both direct 
and indirect effects of (primarily) nicotine and carbon monoxide, including greater hemodynamic 
stress, increased output of lipids, catecholamines, fibrinogen and thromboxane, and increased 
platelet adhesiveness (Bolinder & de Faire, 1995).  Smoking has been shown to interact with other 
cardiovascular risk factors, often yielding synergistic effects on health beyond the additive influence of 
individual factors (USDHHS, 1983).  Finally, considerable evidence exists attesting to the benefits of 
quitting smoking, with substantial reductions in cardiovascular risk becoming evident once abstinence 
has been attained (USDHHS, 1990). 
 
Several studies have previously reported that African-American smokers produce measurably higher 
levels of cotinine, a primary metabolite of nicotine, than whites (e.g., Wagenknecht, et al., 1990).  
Cotinine levels are a marker for degree of nicotine dependence.  Our own research conducted in 
Jackson is consistent with these data, demonstrating higher scores on the Fagerström Test for 
Nicotine Dependence (FTND: Heatherton, Kozlowski, Frecker, & Fagerström, 1991), a well accepted 
self-report measure of nicotine dependence, for black smokers vs. white smokers (Payne, et al., 
1997).  Recent evidence suggests that blacks absorb more nicotine from smoking, and that cotinine 
may be detected in body fluids of black smokers for a longer duration than for white smokers 
(Caraballo, et al., 1998; Perez-Stable, Herrera, Jacob, & Benowitz, 1998).  These findings may 
provide at least a partial explanation as to why African-American smokers suffer from a 
disproportionately higher rate of tobacco-related diseases, as well as experience greater difficulty 
achieving abstinence (Orleans, et al., 1989). 
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Another recent finding which has important implications for the JHS concerns the role of 
environmental tobacco smoke (ETS) exposure.  Howard, et al. (1998) examined the relationship 
between cigarette smoking and the progression of atherosclerosis in the ARIC population, as indexed 
by intimal-medial thickening in the carotid artery.  The authors noted a relationship with smoking, but 
also that ETS exposure was an independent risk factor, as demonstrated by carotid wall changes in 
individuals who were either past or never smokers.  Thus, greater specificity in the degree and nature 
of ETS exposure seems warranted. 
 
Other lines of research have identified additional issues of interest with respect to the goals of the 
JHS.  For example, a growing literature attests to smokeless tobacco use as a contributor to the 
development of cardiovascular disease (Bolinder, Ahlborg, & Lindell, 1992; Squires, et al., 1984; 
USDHHS, 1998a; Westman, 1995).  Cigar smoking has increased dramatically since 1993 and, in 
more recent years, the greatest increase has occurred within the premium cigar market (USDHHS, 
1998b).  As with many of the previous issues, these issues are understudied, and particularly so for 
the African-American population. 
 
Finally, other data being collected on participants of the JHS will permit a more in-depth examination 
of issues related to tobacco use in African-Americans.  Several psychosocial factors that are related 
to tobacco use will be subject to a more intensive investigation.  For example, higher levels of distress 
(depression, anger) and exposure to environmental stressors are related to tobacco use and difficulty 
in achieving cessation, whereas social support and knowledge of tobacco’s detrimental effects on 
health are associated with a greater likelihood of successful cessation (USDHHS, 1988, 1990, 
1998a).  This study will provide a unique opportunity to examine the complex interactions among 
these variables in a large sample of African-Americans. 
 
1.6.4.9.2 References 
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1.6.4.9.3 Administration 
 
The TOB is administered by a trained interviewer in the participant’s home.  Detailed instructions for 
administering each item are provided in the QxQ’s.  The form systematically gathers information on 
historical and current use of each form of tobacco.  Responses vary from question to question, 
ranging from open–ended questions that are subsequently recorded or coded, to specific ratings of 
frequency, amount, etc. 
 
1.6.4.10 Health Care Access and Utilization (HCA) 
 
The Health Care Access and Utilization (HCA) Form is administered as part of the HII to collect 
baseline information about the access to, use of, and payment for health care services.  Items on this 
form were derived from the Detroit Area Study (DAS), the National Survey of Black Americans 
(NSBA), and other standardized instruments that have been used to measure the availability, 
accommodation, acceptability, and affordability of health care services. 
 
1.6.4.10.1 Background, Rationale and Hypotheses 
 
Access to health care implies that an individual has a place to go as well as the financial means of 
obtaining care (Aday, 1993).  Excess cardiovascular disease (CVD) mortality and morbidity in African-
Americans has been linked to inequities in access to primary and secondary health services  as well 
as to a number of sociocultural factors such as socioeconomic status, health practices, health beliefs, 
stress, violence, and racism (Andersen, 1978; Berk & Schur, 1997; Blustein & Weitzman, 1995; 
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Broadhead, et al., 1983; Carlisle, Leake, Brook, & Shapiro, 1996; Carlisle, Leake, & Shapiro, 1995; 
Carlisle, Leake, & Shapiro, 1997; Ford & Cooper, 1995; Gornick et al., 1996; Hannan, Kilburn, 
O'Donnell, Lukacik, & Shields, 1991; Horner, Oddone, & Matchar, 1995; Lee, Gehlbach, Hosmer, 
Reti, & Baker, 1997; Mitchell & Khandker, 1995; Raczynski, et al., 1994; Sedlis,et al., 1997; Seipel, 
1998; Strogatz, 1990; Wenneker & Epstein, 1989; Whittle, Conigliaro, Good, & Lofgren, 1993).  The 
conceptualization of access in the JHS was derived from the models developed by Aday and 
Anderson (Aday & Andersen, 1974; Anderson, McCutcheon, Aday, Chui, & Bell, 1983; Andersen & 
Davidson, 1996; Berk & Schur, 1997) which suggest that characteristics of the health care delivery 
system and of the population at risk influence the utilization of health services and the satisfaction 
with that service. 
 
Characteristics of the population include predisposing, enabling, and need factors of individuals which 
influence health-seeking behaviors.  Data regarding predisposing characteristics such as 
demographic factors, social structure, and health beliefs will be gathered in other aspects of the JHS.  
HCA will also collect data regarding enabling factors such as the availability of health insurance and a 
regular or a usual source of care.  Having insurance and a usual source of care are measures that 
are used consistently in research regarding access to health care.  These two measures have been 
shown to greatly influence the utilization of other health services as well as health status, morbidity, 
and mortality in African-Americans.  HCA will collect data regarding the utilization of preventive 
services by asking participants about the use of dental and primary health care services over that 
past year.  The use of preventive services is seen as a gatekeeper to the use of secondary services 
such as hospitalization, and interventional procedures such as angioplasty, PTCA, CABG, and 
thrombolytic therapy.  HCA will also collect data regarding accommodation by asking participants 
about difficulty they may have experienced when obtaining health services in relation to a perceived 
need.  Difficulties related to transportation, getting an appointment, or getting time off work may 
present barriers that decrease the utilization of health services by African-Americans.  Finally, HCA 
will collect data regarding the satisfaction with health services by asking about satisfaction with the 
health provider. 
 
Specific hypotheses which will be tested include the following: 
 
1. Having a usual source of care decreases the risk of experiencing CVD mortality and morbidity 

independently of racism, socioeconomic status, and health practices in African-Americans in 
Jackson. 

2. The availability of health insurance decreases the risk of experiencing CVD mortality and 
morbidity in African-Americans in Jackson. 

3. The use of preventive services is related to the risk of experiencing CVD mortality and morbidity 
in African-Americans in Jackson. 

4. The use of dental services is related to the risk of experiencing CVD mortality and morbidity in 
African-Americans in Jackson. 

5. Trust in the health care provider is related to the use of health services in African-Americans in 
Jackson. 

6. Satisfaction with health services is related to the use of health services in African-Americans in 
Jackson. 

1.6.4.10.2 References 
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1.6.4.10.3 Administration 
 
HCA is administered to all participants during the HII by a trained recruiter/interviewer.  Detailed 
instructions for administering each question are provided in the QxQ instructions following the form in 
the Forms Appendix.  The first question asks if the participant has a place to go when feeling sick.  
Additional questions get more specific information regarding the place, the use of professional 
services, the ease of access, and the availability of private health insurance.  All participants are 
asked about the use of government-sponsored insurance such as Medicare, Medicaid, and 
Champus, and about her/his satisfaction with her/his regular health professional. 
 
1.6.4.11 Global Stress (STS) 
 
STS also known as the Global Perceived Stress Scale, is an 8-item, self-report measure of perceived 
chronic stress.  The STS will be administered to all participants as part of the HII.  The STS was 
newly created for use in the JHS.  It assesses perceived stress across 8 broad domains derived from 
subscale factors underlying lengthier measures specific to each content domain (e.g., Family 
Environment Scale, Occupational Stress Inventory, Work Environment Scale, etc.).  Rather than 
assessing discrete episodic stressful event occurrences (major or minor), the STS assesses global 
perceptions of stressors associated with ongoing or enduring stressful conditions, such as work, 
marriage, caregiving, etc. 
 
1.6.4.11.1 Background, Rationale and Hypotheses 
 
Exposure to stress, both acute events and chronic burden, has been related to CHD risk (Lepore, 
1995)  The frequency and types of stressors experienced by an individual may be influenced by 
broad societal factors operating on a given segment of the population.  Stress exposure has been 
related to social class and to a lesser extent ethnicity and thus may contribute to SES or ethnic 
differences in CHD risk.  In the JHS, 3 types of stress exposure will be assessed: major life events (at 
annual follow-up), minor life events, and chronic stress. 
 
Chronic stressors are stressful events or conditions that tend to persist over time (Lepore, 1995).  
Examples of chronic stressors include environmental (e.g., neighborhood crime), economic (e.g., 
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work, financial), or role stressors (e.g., marital, caregiver).  Minor stressors and chronic stressors, in 
contrast to more time-limited and episodic major life events, may provide a more plausible theoretical 
link to the development of diseases that have a gradual long-term onset, such as CHD. 
 
Hypotheses include: 
 
1. High stress will be associated with an increased risk of hypertension and CHD events 

independent of the contribution of traditional CHD risk factors. 

2. The relationship observed between stress, hypertension, and CHD events will be moderated by 
social support, coping style, SES, and education. 

1.6.4.11.2 References: 
 
Lepore, S. J. (1995).  Measurement of chronic stressors.  In S. Cohen, R. C. Kessler, & L. U. Gordon 
(Eds.).  Measuring stress:  A guide for health and social scientists (pp. 102-120).  New York, NY: 
Oxford University Press. 
 
1.6.4.11.3 Administration 
 
The STS will be administered by a trained recruiter/interviewer to all participants in the participant’s 
home as part of the HII.  The interviewer will read the statement explaining the general rationale for 
the stress questions:  “We are interested in the amount of stress that you have experienced over the 
past 12 months.”  Each question begins with the phrase “Over the past 12 months, how much stress 
did you experience,” followed by a specific question.  Each question contains several examples to 
help the participant appreciate the scope of each question.  Detailed instructions for the STS are 
provided in the QXQ instructions located in the Forms Appendix. 
 
1.6.4.11.4 Scoring/Coding 
 
The STS yields a single total score.  The total score is calculated as the sum of the stress ratings 
across items. 
 
1.6.4.12 Social Support (SOC) 
 
The Social Support form (SOC) is one of two measures of social support used in the JHS.  The 
emphasis in the SOC is on the structural component of support, as well as negative functional 
aspects. 
 
1.6.4.12.1 Background, Rationale and Hypotheses 
 
Although the primary assessment of social support will be accomplished via the administration of the 
Interpersonal Social Support Evaluation List (ISL) (see section 1.6.7.1.1), a number of important 
structural and functional aspects are not evaluated by the ISL.  Considerable evidence points to the 
importance of structural components of social support.  In addition, more recent data indicate that 
negative aspects of support may in fact be a very important and relatively overlooked aspect of this 
dimension.  The SOC was constructed using items from other standardized instruments to allow for a 
more comprehensive evaluation of the social support construct.  Most of the questions were taken 
from the Berkman Social Network Index, and address structural components of support (type and 
frequency of contacts).  Other items have been drawn from the East Side Village Study to assess 
negative aspects of social support.  The remainder simply request general information.  The greater 
breadth of assessment made possible by the inclusion of this instrument allows for a more accurate 
evaluation of the relationship between social support and health variables, as well as the indirect, 
moderator functions predicted. 
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1.6.4.12.2 References: 
 
Berkman, L.F., Vaccarino, V., & Seeman, T. (1993). Gender differences in cardiovascular morbidity 
and mortality: The contribution of social networks and support. Annals of Behavioral Medicine, 15, 
112-118. 
 
1.6.4.12.3 Administration 
 
The SOC is to be administered as part of the HII by a trained interviewer in the participant’s home.  
Detailed instructions for the SOC are provided in the QxQ instructions, located in the Forms 
Appendix.  Response formats include open–ended questions that are subsequently coded to ratings 
utilizing Likert-type scales. 
 
1.6.4.13 Personal Data and Socioeconomic Status (PDS) 
 
The Personal Data and Socioeconomic Form (PDS) is the first of several data collection instruments 
spaced over the baseline Home Induction and Annual Follow-up Interviews.  Taken together, the data 
obtained will allow tracking of the participant’s socioeconomic status at different stages of the life 
course.  In the baseline HII, data is obtained on place of birth, marital status, employment or 
retirement status, first full-time job as well as information on personal and spousal education, income 
and occupation, and household wealth; job latitudinal satisfaction (adopted from the Karasek), and 
several measures of thwarted aspirations and relative deprivation.  In subsequent annual follow-up 
interviews additional data is obtained regarding childhood, parental and neighborhood SES factors. 
 
1.6.4.13.1 Background, Rationale and Hypotheses 
 
The direct relationship between socioeconomic status (SES) and health is firmly established.  This 
relationship holds for most of the identified risk factors for CVD including smoking, obesity, physical 
activity, hemostatic factors, diabetes, hypertension as well as access and quality of health care, 
particularly preventive care.  Further, the social class gradient in CVD incidence and survival 
accounts for much of the black disadvantage (Cooper, 1993; Schoenbaum & Waidmann, 1997).  
Multiple mechanisms of socio-cultural effects on health and CVD are hypothesized.  Included are 
early life experiences (Elo & Preston, 1992; Smith et al., 1997), disproportionate exposure to ecologic 
stressors (Harburg, et al., 1973; Karasek, et al., 1981; Markowe, et al., 1985; Meade, et al., 1986), 
harmful materials or vectors of disease (Schell, 1997), poor health practices (Adler & Folkman, 1993; 
Kumanyika, 1987; Lynch, et al., 1996; Sobal & Stankard, 1989; Strogatz, et al., 1991; USDHSS, 
1985), and variations in health enhancing personality characteristics (Mirowsky & Ross, 1989; 
Williams, 1990).  The JHS provides opportunity for the additional research needed to understand the 
ways in which salutogenesis and pathogenesis is shaped by the larger social context. 
 
The comparatively low SES of blacks to whites makes this a plausible explanation for the excess 
CVD morbidity and mortality in blacks.  Clarifying what it is about low SES that influences 
susceptibility to CVD in black Americans remains one of the most important challenges for health 
research (James, 1984) and high priority for the JHS.  Based on current literature, priority was given 
to comprehensive measures which: 1) capture the multiple dimensions of individual, family, and 
neighborhood or community variations of social stratification; 2) address the differential social 
advantage offered African-Americans by equivalent levels of education, income and occupation; and 
3) capture variation in SES over a lifetime, including specific measures of early life SES conditions.  
Traditional individual measures of income, education and occupation as well as measures of 
wealth/assets, dominant member approach family/ household social status, and parental 
occupation/education are included.  Direct measures of neighborhood context which may serve as 
stressors (neighborhood violence and disorder) or buffers (social cohesion and resources) for the 
development of CVD are also included (Sampson, et al., 1997; Diez-Roux, 1997, 1999).  Geo-coded 
census block information will be appended to each participant record for later determination of 
neighborhood/community measures; e.g. neighborhood class will be determined by grouping census 
block-coded occupational and educational data to create a meaningful measure of neighborhood 
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social class according to techniques described by Krieger (Krieger, 1992).  Also, specific measures of 
individual, family/household, and neighborhood/community income, education, occupation, 
wealth/assets, poverty/deprivation, and socioeconomic/prestige ratings across all three levels and 
time will be developed from census data.  Inclusion of individual and group level measures on the 
same traits will allow use of contextual regression analysis (Blalock, 1984; Boyd & Iverson, 1979) to 
determine whether the effects of individual SES are modified by household and neighborhood 
conditions.  These comprehensive measures and analytic approaches during the first five years of the 
study will assure avoidance of either the individualistic or ecological fallacy in accounting for SES 
differences in CVD outcome over the course of the JHS. 
 
Measures of early life SES conditions will be sought as indicators of deprived economic status when 
growing up; for example, parental education and occupation, subjective perceptions of comparative 
economic position.  Class mobility will be assessed by a combination of measures of first job and 
subjective assessment of social class.  Further, global assessments of relative deprivation (Adler, 
1993) and thwarted aspirations (Williams, et al., Detroit Area Study) will be obtained. 
 
Hypotheses include: 
 
1. Family/household social status, including wealth, will be related to risk factors, hypertension, 

subclinical disease and CVD independent of individual level SES. 

2. Neighborhood environment will be related to risk factors, hypertension, subclinical disease and 
CVD independent of individual level SES. 

3. The relationship between race and CVD risk factors and outcomes will be modified by all levels of 
SES. 

4. Measures of social status will interact with identified genetic factors to modify the occurrence of 
subclinical disease and the progression to clinical events. 

1.6.4.13.2 References 

Adler, N. E., & Folkman, S. (1993). Socioeconomic inequalities in health. Journal of American Medical 
Association, 269(24), 3140-3145. 

Cooper RS. (1993).  Health and the social status of blacks in the US.  Annals of Epidemiology, 3:137-
144. 

Diez-Roux, A.V., Nieto, F.J., Muntaner, C., Tyroler, H.A., Comstock, G.W., Shahar, E, Cooper, L.S., 
Watson, R.L., Szklo, M. (1997).  Neighborhood environments and coronary heart disease:  A 
multilevel analysis.  American Journal of Epidemiology, 146(1):48-63. 

Diez-Roux A.V., Nieto FJ, Caulfield L, Tyroler HA, Watson RL, Szklo M. (1999).  Neighborhood 
differences in diet: The Atherosclerosis Risk in Communities (ARIC) Study.  J Epidemiol Comm 
Health, 53:55-63. 

Diez-Roux A, Nieto F, Muntaner C, et al., (1997).  Neighborhood Environments and coronary heart 
disease: A multilevel analysis.  Am J Epidemiol, 146:48-63. 

Elo IT, Preston SH.  Effects of early-life conditions on adult mortality: A review. (1992).  Population 
Index, 58:186-212. 

Harburg E, Chape C, Hauenstein LS, Schull WJ, Schork MA.  Socioecological stressor areas and 
black- white blood pressure: Detroit. (1973). Journal of Chronic Disease, 26:595-611. 
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James, S. A., Strogatz, D. S., Wing, S. B., & Ramsey, D. L. (1987). Socioeconomic status, John 
Henryism, and hypertension in blacks and whites. American Journal of Epidemiology, 126(4): 59-67. 

Karasek R, Baker D, Marxer F, Ahlbom A, Theorell T. (1981)  Job decision latitude, job demands and 
cardiovascular disease: A prospective study of Swedish men.  American Journal of Public Health, 
71:694-705. 

Krieger N.  Overcoming the absence of socioeconomic data in medical records: Validation and 
application of a census-based methodology. (1992).  American Journal of Public Health, 82:703-710. 

Kumanyika, S., and Adams-Campbell, L.L.  Obesity, diet, and psychosocial factors contributing to 
cardiovascular disease in blacks.  In Cardiovascular Disease in Blacks, Saunders, Elijah, (Editor). 
F.A. Davis Company (Philadelphia). 

Lynch, J. W. (1997). Why do poor people behave poorly?  Variation in adult health behaviors ad 
psychosocial characteristics by stages of the socioeconomic lifecourse. Social Science Medicine, 
44(6): 809-819. 

Lynch JW, Kaplan GA, Cohen RD, Tuomiehto J, Salonen JT. (1996).  Do cardiovascular risk factors 
explain the relation between socioeconomic status, risk of all-cause mortality, cardiovascular 
mortality, and acute myocardial infarction.  American Journal of Epidemiology, 144:934-42. 

Markowe HLJ, Marmot MG, Shipley MJ, et al., (1985).  Fibrinogen: A possible link between social 
class and coronary heart disease.  British Medical Journal, 291:1312-1314. 

Meade TW, Brozovic M, Chakrabarti RR, et al., (1986).  Hemostatic function and ischaemic heart 
disease: Principal results of the Northwick Park Heart Study.  Lancet, 533:37. 

Schoenbaum M, Waidmann T.  (1997).  Race, socioeconomic status and health:  Accounting for race 
differences in health.  The Journals of Gerontology, 52B:61-73. 

Smith GD, Hart C, Blane D, Gillis C, Hawthorne V. (1997).  Lifetime socioeconomic position and 
mortality: Prospective observational study.  British Medical Journal, 314:547-552. 

Sobal J, Stunkard AJ.  Socieoeconomic status and obesity:  A review of the literature. (1989).  
Psychological Bulletin, 105:260-275. 

USDHSS. (1985).  Report of the secretary's task force on black and minority health. Washington, DC: 
US Government Printing Office. 

Williams DR. (1997).  Race and health: Basic questions, emerging directions.  Annals of 
Epidemiology, 7:322-333. 

Williams DR. (1990).  Socioeconomic differentials in health: A  review and redirection.  Social 
Psychology Quarterly, 53:81-99. 
 
1.6.4.13.3 Administration 
 
The PDS form is administered to all participants as part of the HII.  Detailed instructions for 
administering each question are provided by the Q x Q instructions.  The first question asks about 
place of birth and then continues with an assessment of participant standing in her/his community.  
Potentially sensitive questions on personal and household income, and wealth conclude the HII.  
Care must be exercised to administer this section in a nonjudgmental fashion. 
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1.6.4.13.4 Instructions for Coding of Occupation 
 
Two certified coders will assign occupational codes.  All field interviewers are trained to ensure proper 
recording of occupational data for coders.  Training includes probing for full and accurate responses. 
 
1.6.4.13.4.1 The Alphabetical Index of Industries and Occupations 
 
The basic resource for coding occupation is the Alphabetical Index of Industries and Occupations.  
1990 Census of Population.  Final Edition.  November 1992.  The document is available from the 
Superintendent of Documents, U.S.  Government Printing Office, Washington, D.C. 20402, or from 
any U.S. Department of Commerce District Office.  (Prepayment is required if ordering by mail.  
Check price before ordering.  For information call GPO, Washington, D.C. 202-783-3238.) 
 
A companion volume, the Classified Index of Industries and Occupations (PHC 80-R4) is available 
from the same source. 
 
Both indexes list some 20,00 industry and 29,000 occupation titles.  The Alphabetical Index lists titles 
in alphabetical order, the Classified Index lists them in numerical order.  The Alphabetical Index is the 
basic resource to use in identifying the appropriate occupational code.  The Classified Index helps the 
user understand how the titles fit into the classification structure.  This volume is also useful when 
dividing between two or more categories.  It gives a broad picture of all the titles included within a 
category. 
 
Both indexes are divided into two sections: the “white pages” list the industry codes; the “yellow 
pages” list the occupation categories.  Each industry and occupation title has a 3-digit number or a 
letter which can be translated into a 3-digit number.  The coder’s task is to identify the 3-digit 
occupational code which best fits the respondent’s answers to the occupation questions.  The 
procedure is similar to looking words up in a dictionary.  Once the coder is familiar with the index, the 
3-digit code is relatively simple to assign for most cases.  Few problems are expected with the cases 
and a mechanism is set up for resolving problem cases.  If not, the Industry “white pages” has a 
section SELF-EMPLOYED with an extensive listing. 
 
The coder uses the description given by the respondent to identify the occupational code in the 
“yellow pages.”  In those cases where specific industries are associated with an occupational title, the 
coder uses the industry information to select the appropriate code.  If industry information happens to 
be incomplete, use the most general or “not elsewhere specified” category.  The use of the 3-digit 
Census occupational codes provides maximum analytic flexibility.  The codes can be aggregated into 
a common system across centers or into a system tailored to particular research objectives. 
 
The Occupational Classification System developed by the Census contains 503 separate categories 
which include the 29,000 titles.  The categories are contained in six summary groups and 13 major 
groups.  This system, expanded to 15 major groups by separating out “writers, artists and athletes” 
and “farm operators and managers,” is shown in Table 6. 
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Table 6. Occupational Classification System: 1990 Census, Fifteen Major Groups 
in Six Summary Groupings1 

 

Occupational Summary Groups Occupational 
Codes 

I. Managerial and Professional Specialty Occupations (003-199) 

 1. Executive, Administrative, and Managerial Occupations Codes 003-037 

 2.  Professional Specialty Occupations Codes 043-179 

 3. Writers, Artists, Entertainers, and Athletes Codes 183-199 

II. Technical, Sales, and Administrative Support Occupations (203-389) 

 4. Technicians and Related Support Occupations Codes 203-235 

 5.  Sales Occupations Codes 243-285 

 6.  Administrative Support Occupations, Including Clerical Codes 303-389 

III. Service Occupations (403-469) 

 7.  Private Household Occupations Codes 403-407 

 8.  Protective Service Occupations Codes 413-427 

 9.  Service Occupations, Except Protective and Private Household Codes 433-469 

IV. Farming, Forestry, and Fishing Occupations (473-499) 

 10. Farm Operators and Managers Codes 473-476 

 11. Other Farming, Forestry and Fishing Occupations Codes 477-499 

V. Precision Production, Craft, and Repair Occupations (503-699) 

 12. Mechanics and Repairers, Construction Trades, Extractive 
Occupations, Precision Production Occupations 

Codes 503-699 

VI. Operators, Fabricators, and Laborers (703-889) 

 13. Machine Operators, Assemblers, and Inspectors Codes 703-799 

 14. Transportation and Material Moving Occupations Codes 803-859 

 15. Handlers, Equipment Cleaners, Helpers and Laborers Codes 863-889 

1 See Appendix for the detailed Bureau of the Census Occupational Classification System. 
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1.6.4.13.4.2 Special Codes 
 
The Bureau of the Census system includes occupation codes for persons in the labor force only.  
Other codes may be developed independently or special codes developed by the Census for other 
studies may be used.  The following list of special cases (Table 7) is a combination of both.  This list 
is updated from time to time. 
 
Table 7. Occupational Codes for Selected Special Cases 
 

Employment Status If No Occupation Information 
is Given, Code as Follows 

If Occupation Information is 
Given, Code as Follows 

Armed Services: For: Military rank 
Military branch 
Military occupation 
(gunner, 
pilot, etc.) 

For: Occupations that could be 
civilian or military, such as 
clerk, etc. 

 Code 905 Code according to regular 
instructions. 

National Guard: Not considered part of Armed 
Services. 

Code occupation according to 
regular instructions. 

Retired: Code 913 Code occupation before 
retirement if information is given. 

Disabled: Code 917 Code occupation before disabled 
if information is given. 

Other  Codes Assigned 

Homemaker or Housewife, 
Not in Labor Force: 

 Code 997 

Never Worked:  Code 998 

No Codable Information, or 
No Answer: 

 Code 999 

 
1.6.4.13.4.3 Specific Rules for Coding 
 
1.6.4.13.4.3.1 Coding “Down” 
 
When there is uncertainty or ambiguity in the responses to the occupation questions, code 
conservatively.  There is apparently a tendency for people to inflate responses.  When there is a 
choice in the selection of a code, follow the principle of “coding down” rather than “coding up.” 
 
Please note that “coding down” results in a higher 3-digit number not in a lower one.  In the 
Occupational Coding system, lower 3-digit numbers describe more professional occupations than the 
higher numbers.  For example, “Managerial and Professional Specialty Occupations” range in codes 
from (003-199), whereas “Operators, Fabricators, and Laborers” range from (703-889). 
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1.6.4.13.4.3.2 Self-Employed 
 
Note that the industry “white pages” include a section on SELF-EMPLOYED with an extensive listing 
of occupations.  The listing starts on page I-140 of the Alphabetical Index.  1990 Census, and 
continues through the middle of page I-142. 
 
In assigning an occupation code for a self-employed individual, first check the Self-Employed section, 
but do not limit search to these pages.  If the appropriate code is not found in the SELF-EMPLOYED 
section, use the regular “yellow pages” to identify the appropriate occupation code. 
 
1.6.4.13.4.3.3 Multiple Jobs 
 
The interviewer probes for the main job if the respondent has more than one.  The main job is defined 
as the job that which the person spends the most hours.  If the hours are equal, the main job is the 
one the person considered the most important.  If the person does not consider one job more 
important than the others, focus on the first job mentioned, making the assumption that the first job 
mentioned is the most salient one. 
 
The Census Occupational Classification System includes a “homemaker” title, code T (407) under the 
heading “Private household cleaners and servants,” which refers to work in someone else’s home.  
The JHS uses a special code, 997, for the unpaid homemaker or housewife who works in her own 
home. 
 
1.6.4.13.4.3.4 Quality Control 
 
At the start of the JHS Cohort study, the first 100 cases assigned are reviewed by a second person.  
Where there is disagreement, the cases are referred to the Cohort Operations Committee. 
 
1.6.5 Making the Clinic Appointment 
 
At the end of the HII, the clinic visit is described to the participant and a request made for an 
appointment.  The interviewer inquires about several items to assist in scheduling the appointment: 
 
1. any medical conditions (e.g., diabetes, dietary restrictions) which might affect the physical 

examination and/or type of snack provided 

2. need for assistance in mobilization 

3. preferred time and date of examination 

4. desire for contact by JHS Council of Elders 

The interviewer schedules appointments for the examination during the 30 days following this 
household visit, using the Clinic Appointment Form (CLA).  Detailed QxQ instructions are specified in 
the Forms Appendix.  The interviewer calls the clinic scheduler while at the home of the respondent to 
set an appointment day and time.  The appointment is recorded on a reminder sheet, which is left for 
the participant.  Participants are scheduled for appointments at her/his convenience, dependent upon 
clinic schedule.  Whenever possible, eligible members of a single household are scheduled for 
examination on the same day.  This makes the examination visit more attractive to the participants. 
 
When examination arrangements have been made, the interviewer provides the participant with the 
JHS information videotape and/or consent brochure (see Appendix) if not already given, and a 
Participant Information Sheet, PART, (see Forms Appendix).  The interviewer thoroughly reviews the 
consent brochure with the participant.  Information provided in the brochure and information sheet 
includes the following: study overview, fasting requirements, description of the examination 
procedures, location of the clinic and so forth.  Participants are asked to complete a form containing 
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her/his identifying information, as well as the names, addresses, and phone numbers of contact 
persons.  Once participants have signed the informed consent at the Examination Center the 
information collected on this form is verified, and added to the database.  At the conclusion of the 
interview, the sample respondent is thanked for her/his participation. 
 
1.6.6 Participant Instructions for the Baseline Clinic Examination 
 
The instructions for the clinic visit are specified on the Participant Information Sheet, PART, and the 
Medication Information Sheet, MIN. 
 
The instructions include: 
 
1. Appointment date and time 

2. Directions to the clinic (a map) and to parking facilities (JHS provides free parking and 
reimbursements) 

3. Preparations: 
a. 12 hour fast 
b. No tobacco or vigorous activity 
c. Clothing to wear for the visit  

4. Things to bring: 
a. Eyeglasses for reading 
b. Name and address of health care provider and clinic 
c. Names, address, and phone number of contact persons 
d. Medications 

A script describing the need for medication information is on the home interview form and is 
read to the participant.  The reminder sheet also indicates which medications should be 
brought.  A bag is provided in which to carry the medications. 

e. Completed Approach to Life Form (see 1.6.7.1) 

5. Clinic Operation 
a. A snack is provided after the initial part of the exam 
b. Clinic hours and phone number 

6. Transportation 
a. The JHS will provide transportation and arrange for participant pick-up for those participants 
       who need this service 
b. Those who drive are asked to record mileage for reimbursement 

7. Optional contact by JHS Council of Elders for additional information about participation 

1.6.7 Contact Form (CON) 
 
The Contact form (CON) provides information on multiple ways to contact an individual participant. 
This form was modified from ARIC CON with the addition of electronic and cellular methods of 
contacting the participant, as well as information to contact the participant's health care provider. 
 
1.6.7.1 Background and Rationale 
 
Having multiple reliable means of contacting study participants over the duration of the JHS is 
essential to ongoing retention.  Similar longitudinal studies have verified the importance of gathering 
at least two additional methods of getting in touch with each participant.  Maintaining current health 
care provider contact information is required for sending study results, if requested. 
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1.6.7.2 Administration 
 
The CON is administered to all participants during the HII by a trained recruiter/interviewer.  Detailed 
instructions for completing each item are contained in the QxQ instructions.  The initial item obtains 
complete contact information on the individual participant, including home, work, electronic and 
cellular contact data.  Additional items gather similar information on family, friends, work colleagues, 
neighbors or others who can serve as a means of contacting the participant should s/he not be 
reached via their primary contact.  At least two contacts are requested of all participants. 
 
1.6.8 Participant “Bring to Clinic” Forms 
 
1.6.8.1 Approach to Life 
 
The Approach to Life form is a self-administered questionnaire completed by participants following 
the home interview and brought with them to the baseline examination clinic visit.  It is designed to 
obtain additional information on aspects of how participants approach and cope with life stressors.  
This form is comprised of three separate standardized measures designed to capture information on 
social support, coping and religion/religious coping. 
 
1.6.8.1.1 Approach to Life A:  Interpersonal Support Evaluation List (ISL) 
 
The Approach to Life Interpersonal Support Evaluation List (ISL) (Cohen & Hoberman, 1983) is 
administered as part of the Approach to Life Form in the Bring to Clinic section.  It will be employed 
as a primary measure of the functional components of social support.  Considerable evidence 
supports the validity and reliability of this instrument.  The 16-item version to be employed in the JHS 
is comprised of four subscales, which assess the following dimensions:  (a) emotional support 
(Appraisal), (b) others with whom one can interact (Belonging), (c) material aid (Tangible), and (d) 
others with whom one believes she/he compares favorably (Self-Esteem).  These factors have 
previously been found relevant to health-related outcomes. 
 
1.6.8.1.1.1 Background, Rationale and Hypotheses 
 
Considerable literature has established the importance of social support as a moderator of morbidity 
and mortality rates across a variety of diseases.  Stressful life events are considered to have a 
deleterious impact on particular physiological processes, which in turn contribute to the likelihood of 
poor health outcomes.  Social support is generally considered to function as a buffer against the 
effects of stressors.  Despite the breadth of this construct, and the many ways in which it has been 
measured (e.g., perceived emotional or tangible support from family / friends / co-workers / etc., 
community involvement, marital status, number of friends, frequency of social contacts), research has 
consistently supported its beneficial effects.  In addition to the positive health-related outcomes, much 
research suggests underlying mechanisms of action, including changes in cardiovascular, immune, 
and endocrine systems (Uchino, Cacioppo, & Kiecolt-Glaser, 1996). 
 
As expected, social support has been found to moderate the relationship between psychological 
variables and health outcome, as well as physiological functions considered to contribute to health 
outcome.  Lepore, Mata Allen, and Evans (1993) demonstrated that the effects of an acute laboratory 
stressor on blood pressure (BP) was moderated by social support (experimental manipulation of the 
supportiveness of a confederate).  In a follow-up study, Lepore (1995) observed once again that 
individuals under a high relative to low social support condition produced smaller BP increases to 
laboratory stressors.  The findings, however, held only for individuals low in cynicism; BP responses 
were not moderated for high cynicism participants.  Brownley, Light, and Anderson (1996) observed 
differential effects of cynicism on ambulatory BP in whites as compared to blacks across three sites: 
home, work, and clinic.  In this study, higher level of appraisal support was related to lower overall BP 
across race and gender.  Of interest was the association between low hostility and higher blood 
pressure in black males.  The authors noted that this finding was best understood in the context of 
low hostility scores coupled with high levels of anger, suggesting the suppression of hostility is an 
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important consideration.  Other findings were more complex, with high hostile black men who 
reported greater levels of tangible support showing lower BP, whereas white women with higher 
scores on belonging support showing lower BP overall.  This representative group of findings 
underscores the importance of understanding the complex interactions that various components of 
social support may have with factors known to contribute to health risk status. 
 
In a review of the literature on the role of social networks and support, Berkman, Vaccarino, and 
Seeman (1993) concluded that both low support (particularly emotional) and social isolation have 
been consistently related to all-cause mortality and cardiovascular death for men and women.  
Currently, the data appear more consistent for men, and there is evidence that men are at greater risk 
for death following the death of a spouse than visa versa.  Despite these findings, the authors 
acknowledge numerous shortcomings and methodological problems with the studies cited, including 
limited range and delineation of social support factors assessed, and differential risk status of men 
compared with women.  Finally, whereas data addressing the relationship to mortality are limited but 
sufficient to draw preliminary conclusions, morbidity data are far less available.  Orth-Gomer, 
Rosengren, and Wilhelmsen (1993) reported one of the few studies predicting CHD based on a 
measure of social integration.  Holahan, Moos, Holahan and Brennan (1995) found that for individuals 
with cardiac illnesses, social support was negatively related to number of depressive symptoms. 
 
Thus, the JHS will permit the investigation of several factors relevant to social support that have as 
yet received insufficient attention.  An accurate characterization of various support dimensions in a 
large African-American sample of men and women across a broad age range comprises one 
excellent opportunity.  Second, an extension of prior work considering the nature of social support 
interactions with other cardiovascular risk factors will be possible.  Finally, beyond the relationship to 
long-term mortality outcome, there will be the ability to examine the relationship between social 
support and morbidity, as well as proximal physiological measures purported to have a relationship 
with ultimate risk, such as ambulatory blood pressure, cortisol measurements, and other vital sign 
data collected at regular visits. 
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1.6.8.1.1.3 Administration 
 
The ISL will be handed to the participant at the conclusion of the HII as part of the Approach to Life 
booklet.  The participant will be instructed to complete this form and bring it with them to the clinic 
exam visit.  Although instructions will be located at the beginning of this form, the interviewer will 
review the instructions and answer any questions that arise to assure the participant’s clear 
understanding of the manner in which to complete the form.  If the participant requests to complete 
this form at the conclusion of the interview, the interviewer will facilitate this.  Specific instructions are 
included in the QXQ instructions.  It is important that no questions be left blank.  Clinic staff will review 
forms for completeness at the baseline clinic examination and assist the participant to complete the 
form if needed. 
 
1.6.8.1.1.4 Scoring for the Interpersonal Support Evaluation List (ISL) 
 
Each item is rated on a 4-point scale: Definitely True (1), Probably True (2), Probably False (3) and 
Definitely False (4).  The instrument is scored by summing all items within each of the four subscales: 
Appraisal, Belonging, Tangible Support, and Self-Esteem. 
 
Minimum score for a subscale is 4, and the maximum is 16.  The four subscales are also summed to 
yield a total score.  The specific item assignment is as follows: 
 

Subscale Items 

Appraisal: 5, 8, 12, 15 

Belonging: 2, 3, 4, 9 

Tangible Support: 6, 7, 11, 14 

Self-Esteem: 1, 10, 13, 16 

 
1.6.8.1.2 Approach to Life B: Coping Strategies Inventory (CSI) 
 
The Approach to Life B: Coping Strategies Inventory (CSI) (Tobin, Holroyd, Reynolds, & Wigal, 1989) 
is administered as part of the Approach to Life booklet in the Bring to Clinic section.  It will be used to 
assess a variety of coping dimensions organized within a hierarchical structure.  The two primary 
dimensions include problem-focused versus emotion-focused coping style.  This factor is considered 
in the context of the second dimension, approach versus avoidance coping.  Although the original 
scale is 85 items in length, a substantially shorter 16-item version has been developed for the JHS, 
based on data collected on research samples in Jackson, Mississippi, including headache sufferers, 
patients with coronary heart disease, and caregivers of Alzheimer’s patients. 
 
1.6.8.1.2.1 Background, Rationale and Hypotheses 
 
The manner in which one copes with environmental stressors is purported to moderate physiological 
responses that influence health outcome.  Coping refers to individuals' cognitive and behavioral 
responses to stressful life circumstances in an attempt to mitigate the effects of those experiences (cf. 
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Lazarus & Folkman, 1984).  The ultimate impact of these actions is considered to be a function of a 
variety of factors, including the specific coping behavior performed, stimulus qualities of the stressor 
and response characteristics of the individual. 
 
A number of efforts have been made to understand the organizational structure of coping.  Two 
approaches are more or less accepted.  The first is the approach-avoidance scheme.  Approach-
based coping includes behaviors that involve direct actions to manipulate the environmental stressor.  
Avoidance-based coping, on the other hand, is comprised of behaviors that attempt to reduce stress 
via reduction in exposure to the stressor.  The second approach emphasizes the type of effect 
sought.  Problem-focused coping emphasizes management of the stressor, whereas the goal of 
emotion-focused coping is the regulation of one's affective response. 
 
A small but growing literature addresses the impact of different coping efforts in the context of the 
particular outcome of interest.  Earlier efforts demonstrated the effects of denial on recovery from a 
myocardial infarction (Levine, et al., 1987).  In this study, it was shown that denial had a positive 
impact in the short term (e.g., earlier release from hospital), but poorer long-term health outcome.  
Several investigations have examined the role of measures of defensiveness in modifying the 
relationship between hostility and physiological function.  Helmers, et al. (1995) demonstrated that 
defensive-hostile (high hostility, high defensiveness) patients with CAD showed increased ischemia 
(laboratory and ambulatory monitoring) and perfusion defects.  Larsen and Langer (1997) similarly 
demonstrated increased reactivity for these individuals.  Holahan, et al. (1995) assessed approach 
and avoidance coping (represented as percentage approach coping) in individuals with cardiac 
illness.  Fewer depressive symptoms were evident for those individuals having higher scores.  These 
data also provide support for the conceptualization of social support as exerting its positive influence 
via its influence on coping (cf. Lazarus & Folkman, 1984). 
 
It would thus appear that coping serves an important moderator role in the relationship between 
environmental stressors and psychological CV risk variables on the one hand, and detrimental 
physiological responses and poor health outcomes on the other.  Assessment of both approach and 
avoidance-based coping appears important.  Recently, in a study examining stress and coping in 
medical students, Mosley, et al. (1994) similarly demonstrated the positive impact of approach 
(engagement) and negative impact of avoidance (disengagement) coping on depressive symptoms.  
They used the original, full-version CSI (CSI; Tobin, Holroyd, Reynolds & Wigal, 1989), which has 
been demonstrated as useful in identifying stress coping patterns in various populations (e.g., 
headache). 
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1.6.8.1.2.3 Administration 
 
The CSI will be given to the participant at the conclusion of the HII as part of the Approach to Life 
booklet in the Bring to Clinic section.  The participant will be instructed to complete this form and bring 
it with them to the clinic exam visit.  Although instructions will be located at the beginning of this form, 
the interviewer will review the instructions and answer any questions that arise to assure the 
participant’s clear understanding and the manner in which s/he may complete the form.  Detailed 
QxQ instructions are specified in the Forms Appendix.  If the participant requests to complete this 
form at the conclusion of the interview, the interviewer will facilitate this.  It is important that no 
questions are left blank.  Clinic staff will review forms for completeness at the baseline clinic 
examination and assist the participant in completing the form if needed. 
 
1.6.8.1.2.4 Scoring for the Coping Strategies Inventory 
 
Each item is rated on a 5-point Likert-type scale from Never (1), to Seldom (2) to Sometimes (3) to 
Often (4) to Almost Always (5).  The instrument is scored by summing the responses to items within 
each of the four subscales.  Minimum score for a subscale is 4 and the maximum is 20.  The specific 
item assignment is as follows: 
 

Dimension Items 

Problem-focused Approach 1,2,8,9 

Problem-focused Avoidance 4,7,12,14 

Emotion-focused Approach 5,6,11,13 

Emotion-focused Avoidance 3,10,15,16 

 
1.6.8.1.3 Approach to Life C: Religion/Religious Coping (RCP) 
 
The Approach to Life C: Religion and Religious Coping (RCP) is administered as part of the Approach 
to Life booklet in the "Bring to Clinic" section of the HII.  It will be employed as a primary measure of 
religious coping.  The form was modified from several standardized measures of religious coping 
currently in testing by the MacArthur Group and included in the General Social Survey. 
 
1.6.8.1.3.1 Background, Rationale and Hypotheses 
 
Studies of religious coping indicate that religion provides solace in confronting physical illness and 
disability (Jenkins & Pargament, 1988; Pargament & Hahn, 1986) as well as other acute and chronic 
threats (Bulman & Wortman, 1977; Kotarba, 1983; Maton, 1989).  Religious coping may be more 
effective than other strategies in reducing negative affective states accompanying physical health-
related stressors (Mattlin, Wethington, & Kessler, 1990).  Religion and its associated rituals assist in 
the process of adjustment to difficult life situations, especially those over which there is little direct 
control.  The few studies of religious coping in black samples show that, on average, black Americans 
are more likely to use religious coping strategies than are whites (Conway, 1985-86; Gibson, 1986).  
Systematic data is lacking, however anecdotal evidence suggests that religious cognitions are 
employed by blacks in confronting health conditions as well as poverty and racism (Neighbors, 
Jackson, Broman, & Thompson, 1996).  The potential for protection against the development of CVD 
may be direct in that it has stress- reducing effects mediated through lowered cortisol secretion from 
the pituitary-adreno-cortical pathway via catecholamine secretion from the sympathetic-adreno-
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medullary pathway.  Alternatively, it may be indirect through the association between 
religion/spirituality and healthy diet or other health practices or improved social support.  
Religion/spirituality is a multidimensional concept and three dimensions are selected for inclusion in 
JHS: organizational religiousness, private religiousness, and daily spirituality. 
 
Regular church attendance has been associated with lower rates of CHD (Comstock, 1972; Medalie, 
1973) and mortality (House, 1982; Berkman, 1979; Seeman, 1987; Strawbridge, 1977; Schoenback, 
1986; Bryant, 1992).  Private religiousness (non-organizational, informal or non-institutional) has been 
associated with lowered blood pressure (Levin, 1989; Chesney, 1987; Caudill, 1987) and reduced 
mortality following cardiac surgery (Oxman, 1995).  Spirituality is intended to go beyond religious 
boundaries and focus on the internalization of religious principles in daily life.  The measures chosen 
for each of these dimensions are state of the art instruments currently being used in the General 
Social Survey and are being studied for psychometric properties. 
 
Hypotheses include: 
 
1. Religiousness/spirituality is associated with hypertension and sub-clinical disease independently 

of diet and social support. 

2. The higher the religiousness/spirituality the less the effects of negative emotions and chronic 
stress on hypertension, sub-clinical disease and progression to events. 
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1.6.8.1.3.3 Administration 
 
The RCP given will be given to the participant at the conclusion of the HII as part of the Approach to 
Life booklet.  The participant will be instructed to complete this form and bring it to the baseline 
examination clinic visit.  Although instructions will be located at the beginning of this form, the 
interviewer will review the instructions and answer any questions that arise to assure the participant’s 
clear understanding and the manner in which she/he may complete the form.  Detailed instructions for 
the RCP are described in the QxQ instructions.  If the participant requests to complete this form at the 
conclusion of the interview, the interviewer will facilitate this.  Clinic staff will review forms for 
completeness at the baseline clinic examination and assist the participant with completing the form if 
needed. 
 
1.6.9 Interviewer Observations Form (OBS) 
 
The Interviewer Observations Form (OBS) provides a context for the HII as well as additional 
information to plan for the subsequent clinic examination and future follow-up calls.  The OBS was 
modified from similar instruments used in several studies of African-Americans including the Detroit 
Area Study and the Eastside Village Study.  It is intended to gather subjective information regarding 
the success of the interview as well as pertinent observations about the participant, which will assist 
with retention across the study duration. 
 
1.6.9.1 Background and Rationale 
 
The initial contact with JHS participants occurs in their home.  This contact allows for a natural 
interview setting for the participant, thus providing important information on the participant's likes and 
dislikes and life situation.  Such information is important to personalizing subsequent contacts with 
the participant.  Likewise, information which rates the overall quality of the interview is important as a 
context or background for the data obtained.  Such information will facilitate ongoing evaluations of 
the quality of the data obtained in the field setting. 
 
1.6.9.2 Administration 
 
The OBS is completed by the trained interviewer/recruiter following the completion of the HII.  It is 
completed after the interviewer/recruiter has left the home, but within 24 hours of completing the 
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interview.  Detailed instructions for completing each item are contained in the QxQ instructions.  The 
initial item provides a rating of the interviewer's estimate of the participant's cooperation in completing 
the HII.  Additional items record observations about degree of talkativeness or engagement in the 
interview, as well as any auditory, visual or physical impairment or any language or comprehension 
issues for this respondent.  Finally, the interviewer rates the overall quality and personal satisfaction 
with this interview. 
 
1.6.10 Clinic Examination Appointments Schedule System 
 
The interviewer delivers all materials from the HII to the supervisor at the Examination Center (EC) 
prior to the scheduled clinic appointment.  The material is reviewed by office staff and entered into the 
data base on a regular basis.  Sufficient appointments are scheduled each day for Tuesday through 
Saturday, to meet the requirement of 45 appointments per week.  The database is updated on a 
regular basis.  The EC maintains: 
 
1. Assignment record of labels for the clinics. 

2. A listing of telephone numbers and dates and times to conduct the telephone reminder calls. 

3. Daily appointment schedule with participant name, ID number, appointment time, and special 
considerations such as health restrictions or child care requests.  This schedule is used to 
structure that day’s appointments and to check in participants as they arrive for her/his 
examination. 

4. Clinic schedules are maintained by clinic schedulers and/or an answering service.  When an 
answering service is used following clinic hours to schedule appointments, duplicate appointment 
books are kept and updated on a daily basis to avoid conflicts in schedules.  When conflicts arise 
due to overbooking of an appointment, they are resolved by clinic personnel. 

1.7 Recruitment for Baseline Clinic Examination 
 
1.7.1 Introduction 
 
The projected clinic response rates (ranging from 60 to 80 percent) are dependent upon the ability to 
recruit eligible participants and to maintain clinic attendance.  Every effort is made to make the clinic 
visit as pleasant and burden free as possible.  Additionally, the following features are part of the effort 
to maximize participation: (1) Qualified interviewers, (2) Pre-appointment contacts, (3)  No show 
procedures, (4) Reimbursement, (5) Community awareness and health education activities and (6) 
Supervision. 
 
1.7.2 Qualified Interviewers 
 
Standard survey procedures assist in maximizing the rate of participation.  Experienced, well-qualified 
and sensitive interviewers are employed to conduct data collection activities.  They generally live in or 
near the area in which they are working. 
 
Interviewers are thoroughly trained to overcome objections and concerns.  The training includes two 
to three months of classes covering issues of cultural sensitivity, interviewing practices, details of the 
JHS, the extent of the interviewer probing and overcoming participant objections and/or concerns. 
 
Interviewers make initial contact with households at optimal times (i.e., late afternoons, evenings, or 
weekends), and schedule appointments for interviews as needed.  Additionally, interviewers make 
call backs as necessary, at varying times of day and week.  No unlocateable code may be entered 
until a minimum of five contacts have been made. 
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1.7.3 Pre-appointment Contacts 
 
To increase respondent participation following recruitment by an interviewer, a pre-appointment 
postcard is mailed prior to the scheduled appointment.  This card reviews the fasting requirements, 
and the examination date and time. 
 
Reminder calls are made to each participant one or two days prior to the examination.  At this time, 
the information concerning the fasting requirements, medications bags, and other details is reviewed 
with the participant.  Participants are asked if they have any special needs and every effort is made to 
answer their questions. 
 
When appropriate, a letter is sent to the participant’s employer explaining the JHS (see Appendix).  
Additionally, participants may be contacted by other JHS cohort members through the JHS Council of 
Elders to reinforce participation. 
 
1.7.4 Contacts for No Shows 
 
Eligible participants who fail to arrive for a scheduled appointment or who cancel her/his 
appointments are contacted by telephone to reschedule the appointment.  At that time, the scheduler 
attempts to address any concerns or fears that the participant may still have. 
 
Each no-show case is individually reviewed by the recruiter/interviewer and when necessary by the 
supervisory staff.  Conversion efforts include a combination of telephone contacts, in-person visits, 
and/or conversion letters.  A participant is considered a refusal following six broken appointments. 
 
1.7.5 Reimbursement 
 
The JHS EC provides for or reimburses transportation.  Parking is free at the Jackson Medical Mall 
site of the JHS clinic.  For those who are reimbursed, detailed records are maintained for accounting 
purposes according to OMB and the UMMC guidelines. 
 
1.7.6 Partnerships for Community Awareness and Health Education 
 
To enhance participation the Coordinating Center Partnerships for Community Awareness and Health 
Education (PCAHE) office maintains close contact with the media, churches, businesses, health 
organizations and professionals, school systems, sponsors and other community sources of 
information.  Information and updates on the study are provided on a regular basis to enhance 
community support.  Community education and provision of heart health information are regular 
components of PCAHE to assure wide community benefit from the study.  The “Friends of the 
Jackson Heart Study” volunteer program provides and encourages ongoing community information 
and involvement. 
 
In addition to the community–wide efforts, PCAHE will target specific local areas approximately two 
weeks prior to recruiters entering that locale in order to increase awareness.  The PCAHE plan 
contains a full description of PCAHE activities. 
 
1.7.7 Supervision 
 
Throughout the entire process, from initial interview to final interview/examination or refusal, close 
supervision helps maximize the response rate.  Supervisors record reasons for non-response, and 
examine performance trends by interviewer and by area.  When deemed appropriate, supervisors 
initiate re-contact with refusing participants to attempt her/his conversion.  Detailed records of all 
contacts are maintained. 
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2.0 INTERVIEWS IN THE BASELINE CLINIC EXAMINATION VISIT 
 
 
2.1 Introduction 
 
Upon completion of the HII, eligible participants are invited to take part in the baseline examination at 
the JHS Exam Center.  Nine or more participants are scheduled daily, Tuesday through Saturday. 
 
Chapter 2, Interviews in the Baseline Clinic Examination Visit, is one of two chapters that present an 
overview of the examination components, interviews and procedures.  This chapter focuses on the 
interviews to be conducted during the baseline visit while Chapter 3 will detail the baseline 
examination procedures.  Tables 8, 9, and 10 summarize all the core components of the JHS 
beginning with the HII and continuing through annual follow-up and surveillance.  Each of these 
components are likewise detailed in separate chapters of this manual. 
 
To orient the reader to the overall clinic flow, information on the sequence of flow for both interviews 
and procedures precedes detailed information on training, quality assurance, and specific interview 
forms included in the baseline clinic visit. 
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Table 8. Core Components of the JHS Baseline Induction and Examination 

COMPONENT DESCRIPTON MANUAL 

Interviews: Home Induction Administer instruments: Household Enumeration; Eligibility; Personal & Family Health History; Health 
Practice: Tobacco Use and Physical Activity; Stress; Social Support; Personal Data/SES; Clinic 
appointment; Contact Information; Medications Instructions; Participant Information Form; Interviewer 
Observations. 

2 

Interviews: Self 
Administered 

At home induction interview provide the following instruments for participant to complete and return at 
clinic visit: Approach to Life: ISEL, CSI, Religion/Coping forms and Health Care Provider Contact 
Information. 

2 

Reception Informed consent for interviews, examination and procedures, DNA collection, medical records, 
release of data, ancillary studies.  Administer Fasting form and update Contact form. 

2 

Anthropometry Weight, height, waist and neck girth 2 

Blood Pressure: Resting, 
Ankle/Arm 

Assess sitting blood pressure, using random zero sphygmomanometer. 
Assess ankle and arm blood pressure using doppler. 

4 

Electrocardiogram: 12-lead Obtain resting 12-lead electrocardiogram. 5 

Echocardiography Use ultrasonography to examine the heart and great vessels to diagnose cardiovascular lesions. 6 

Ultrasonography Obtain b-mode scan of extracranial carotid arteries.  Record heart rate and blood pressure changes. 7 

Venipuncture Obtain blood samples for laboratory tests and storage of specimens. 2, 9 

Pulmonary Function Test Obtain measure of air volume and exhalation rate from the lungs using a volume displacement 
spirometer. 

8 

Snack After venipuncture, participants will be given a nutritious snack. 2 

Interviews: Medical/Health Administer instruments: Medication Survey, Medical History, Stroke Symptoms, Reproductive 
History, Diet-FFQ (food frequency), Family Structure and Parental Identification (Family Study, only). 

2 

Interviews: Sociocultural Administer instruments: Discrimination, Alcohol and Drugs. 2 
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Interviews: Take Home Provide the following forms to be completed at home and picked up with 24-hr study data/equipment: 
Hassles and Mood Inventory (WSI, CES, CHO, STX), Family Contact Form (Family Study only). 

2 

Interview: Exit Ascertain completeness of exam, verify abnormal results, provide clinic summary report, return 
medication, provide instructions on 24-hr /48-hr urine collection, ambulatory blood pressure 
measurements, and physical activity measurements.  Instructions on substudies and ancillary 
studies.  Provide information on results reporting. 

2 

24-hour Exam Procedures 24-Hour Tracking 
Ambulatory Blood Pressure: Pre ABPM, Post ABPM, Return Monitor 
24-Hour Urine and 48-Hour Urine:Pre-24 Hour Urine, Post-24 Hour Urine, 24 Hour Urine Return, 
Second 24 Hour Urine Return,  
24-Hour Physical Activity: Pre- Physical Activity, Post Physical Activity, Return Physical Activity  

2 

Medical Data Review Participant’s responses to standardized questions in the interviews and exams with potential medical 
impact or participant safety implications are reviewed by Examination Center clinical staff. 

2 

Referrals and Review 
Guidelines 

Guidelines for referring participants for further medical care are based on responses to questions 
with cardiovascular disease implications. 

2 

Clinician Reviews Procedures for second level of medical data review by Exam Center medical staff 2 

Participant Safety Guidelines for the safety and welfare of the JHS participants. 2 
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Table 9. Core Components of Annual Follow-up and Surveillance 

COMPONENT DESRIPTION MANUAL 

Annual follow-up ID 
Information 

Update Contact form 2 

Annual follow up interview Annual call to ascertain 1) correct contact information; 2) update tracing information on 3 contact 
persons; 3) ascertain participants vital status; 4) document medical events, life events and functional 
status 

2 

Additional Questions Additional questions to be administered in Yr 1, Yr 2, and Yr 3.  [John Henryism, Lifecourse SES, 
Optimism, Major Life Event Stress, and Neighborhood SES instruments] 

2 

Surveillance: In hospital 
and Out of Hospital 

Forms: Birth Certificate; Death Certificate; Hospital Record Abstraction; Informant Interview; 
Physician Questionnaire; Coroner/Medical Examiner; Cohort Event Eligibility; Cohort Stroke 
Abstraction; Cohort Stroke Supplement 

10 

 
Table 10. Core Components of Baseline Visit Substudies 

COMPONENT DESRIPTION MANUAL 

Diet Sub-study Monitor and record food intake for a 24-hour period. 2 

Physical Activity Sub-study Monitor physical activity for a 3- or 7-day period with ergonometric equipment 2 
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2.2 Participant Flow 
 
The flow of participants will follow a common plan.  This plan is aimed at minimizing the participant 
time burden and reducing variability in the various baseline measurements.  The schedule is divided 
into fixed and non-fixed sequences to accommodate legal requirements, scientific constraints 
regarding the order of measurements, the daily fluctuations in Exam Center staffing patterns and 
unforeseen number of participants who keep scheduled appointments, the configuration of the Exam 
Center's physical layout, equipment availability and function, the integration of ancillary studies, and 
so forth.  Participant flow and the approximate time associated with each workstation are outlined in 
Table 11. 
 
2.2.1 Rationale 
 
The fixed components of scheduling participant flow reflect the requirement to initiate the examination 
with the administration of informed consent, the scientific constraints which establish the grouping of 
procedures which require fasting, and the logistical necessity of conducting medical data reviews 
after all other procedures have been completed.  The flexible components reflect the advantages of 
conducting the majority of the interviews and examinations in accordance with the physical layout and 
the scheduling patterns of the Exam Center.  This approach is intended to minimize participant 
burden to approximately 4.5 hours and reduce variability in study measurements. 
 
2.2.2 Fixed Sequence 
 
The fixed sequence of participant flow reflects the following requisites: signed informed consent prior 
to any examination; participant time is to be kept to approximately 4.5 hours (excepting Family Study 
participants); twelve hours of fasting and one hour of abstinence from smoking are required for 
venipuncture and measurement of sitting blood pressure; sitting blood pressure and anthropometry to 
be measured before venipuncture; 20 minutes in a supine position is required before venipuncture; 
and both the interviews and the physical examination are to be completed prior to the medical data 
review. 
 
After the participant has been welcomed and has signed the consent form, s/he is asked to change 
into a surgical scrub suit, provided by the Exam Center.  The Exam Center provides a safe place to 
store clothing and valuables for the duration of the visit.  Table 11 details anticipated clinic flow.  After 
changing, anthropometry and sitting blood pressure are measured, and either EKG, Echo or 
ultrasound are completed prior to venipuncture.  Following venipuncture, the participant is shown to 
the snack area and provided with a caffeine-free, low fat snack. 
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Table 11. Clinic Flow:  Jackson Heart Study Baseline Visit 
 

     
Participant 

Flow 
Group 1 

4 participants 
Group 2 

4 participants 
Group 3 

4 participants 
Group 4** 

4 participants 
8:00 a.m. Reception Reception   
8:15 Echo & Ultrasound Interview   
8:30   Reception Reception 
8:45    Anthro 
9:00     
9:15  Interview Interview  
9:30 Snack Snack Snack  
9:45 Anthropometry Echo Anthro Anthro 
10:00    Snack 
10:15   Anthro Interview 
10:30 Interviews  Echo  
10:45  Echo   
11:00  Anthro   
11:15    Interview 
11:30 Interview Anthro Echo Wait 
11:45 Exit Exit Exit Wait 
12:00 p.m.  Exit Exit Wait 
12:15 4.50 hrs 4.50 hrs 4.50 hrs Echo 
12:30     
12:45     
1:00     
1:15    Echo 
1:30    Exit 
2:00    Exit 
2:15    5.0 hrs 

 
 
Echo & Ultrasound Includes Echo and Ultrasound, Phlebotomy done.  Time 75 minutes. 

Interviews Personal/Family, Genogram, Contact, Reproductive, Stroke, meds, diet, 
smoking and discrim.  Time: 73 minutes. Phlebotomy done.  Interview rooms 
will require a chair that allows the participant to be supine. 

Anthropometry Anthrometrics, PB, ankle/brachial BP, EKG, PFTs.  30 minutes added for 
phlebotomy.  75 minutes 

Exit Interview 24-hour urine and ambulatory BP, results reporting and exit interview.  30 
minutes 

**   Exam data will be collected to the extent possible 
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2.3 Training 
 
The Exam Center staff is trained before the baseline exam to use a standardized technique for 
administering all baseline interviews.  Training includes an overview of the JHS and its precursor, 
ARIC; an overview of epidemiological cohort research methods; instructions in research interviewing 
techniques: communication, respecting cultural diversity and in specific forms completion including: 
 
1. a thorough review of the forms, instructions and protocol to promote adherence to the protocol 

2. practice in the use of non-judgmental attitude 

3. practice with the degree and nature of prompting permitted dealing with problem interview 
situations 

4. use of response cards 

5. practice handling participants’ comments and recording relevant information on the note logs 

6. review of post interview responsibility for the data 

The Clinic Manager and interviewer team leader are responsible for training new staff based on 
standardized interview techniques (see Appendix), QxQ instructions for each form, practice scripts 
and role playing. 
 
2.4 Certification 
 
Tables 12,13, and 14 summarize certification and re-certification criteria for all elements of the 
baseline visit; interviews and procedures.  Interviewers are certified by the interviewer trainer at the 
successful completion of training.  Certification is achieved by the demonstration of adequate 
technique on five taped interviews, reviewed and approved by the Clinic Manager or interviewer team 
leader.  Re-certification is completed annually and requires the successful completion of one taped 
interview.  With participant approval, all interviews are taped for quality control.  All tapes are included 
in the round robin and are reviewed by the interviewer supervisors selected to monitor each year’s 
round robin.  Special certification criteria beyond these tape reviews are described below with the 
appropriate exam component. 
 
2.5 Quality Assurance 
 
With participant approval, most interviewer-administered forms are taped for quality control.  A non-
systematic sample of forms are reviewed by the Clinic Manager and interviewer team leader monthly.  
Routine quality assurance is provided through observation by the Clinic Manager.  Protocol 
adherence and interviewing techniques are reviewed at least biannually by Coordinating Center 
examination monitors.  Deviations from protocols and possible remedial actions are discussed with 
the Clinic Manager and staff at that time.  Major deviations are brought to the attention of the JHS 
Cohort Operations Committee.  Data quality is monitored by the Quality Control Committee semi-
annually. 
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Table 12. Certification Criteria: Baseline Visit Cohort Exam Procedures and Interviews 

COMPONENT CERTIFICATION 
REQUIREMENT 

CERTIFIER OR 
REVIEWER 

RECERTIFICATION 
REQUIREMENTS 

RECERTIFIER OR 
REVIEWER 

Interviews: Home 
Induction 

Adequate technique on 5 taped 
interviews 

Supervisor or Interviewer 
team leader/CC Central 
Trainer 

Annually, 1 taped participant 
interview  

Supervisor or Interviewer 
team leader 

Interviews: Self-
administered 

Adequate explanation on 5 taped 
introductions to participants 

Supervisor or interviewer 
team leader/CC Central 
Trainer 

Annual review Supervisor or Interviewer 
team leader 

Reception Interviews Adequate technique on 5 taped 
interviews 

Supervisor or Interviewer 
team leader/CC Central 
Trainer 

Annually, 1 taped participant 
interview  

Supervisor or Interviewer 
team leader 

Anthropometry Lead technician1 cm of trainer 
agreement w/ trainer 
Equipment Calibration on Log 

Clinic manager Biannually for technicians 
Annually for Lead Technician  

Lead Technician 

Blood Pressure: 
Resting, Ankle/Arm 

Lead technician training Central trainer or Lead 
Technician 

Biannually.  Annual re-
certification for Lead technician 

Lead technician 

Electrocardiogram: 
12-lead 

Adequate technique on 5 ECG 
tracings 

ECG Reading Center 
reviews ECG quality 

Monitored continuously w/ 
quarterly reports 

ECG reading center 

Echocardiography Central training by ERC staff 
Submit 10 acceptable scans 

ERC/Chief sonographer Monitored continuously at ERC 
Biannual QC review 

ERC and QC committee 

Ultrasonography Central training by URC staff 
Submit 10 acceptable B-mode 
scans 

URC/Chief sonographer Monitored continuously at 
URC 
Biannual QC review 

URC and QC committee 

Pulmonary Function 
Test 

Central training by PFRC staff 
Submit 5 acceptable PFTs 

Chief spirometrist Monitored continuously at 
PFRC 
Biannual QC review 

PFRC and QC committee 

Venipuncture Lead technician training, Pass 
written and practical exams, 2 
acceptable draws/processing 

Lead technician Biannually @ Exam Center Lead Technician 
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COMPONENT CERTIFICATION 
REQUIREMENT 

CERTIFIER OR 
REVIEWER 

RECERTIFICATION 
REQUIREMENTS 

RECERTIFIER OR 
REVIEWER 

Interviews: 
Medical/Health 

Adequate technique on 5 taped 
interviews 

Supervisor or Interviewer 
team leader 

Annually, 1 taped participant 
interview  

Supervisor or Interviewer 
team leader 

Interviews: Socio-
cultural 

Adequate technique on 5 taped 
interviews 

Supervisor or Interviewer 
team leader 

Annually, 1 taped participant 
interview  

Supervisor or Interviewer 
team leader 

Interviews: Take 
Home 

Adequate explanation on 5 taped 
introductions to participants 

Supervisor or interviewer 
team leader 

Annual review Supervisor or Interviewer 
team leader 

Interview: Exit Adequate technique on 5 taped 
interviews 

Supervisor or Interviewer 
team leader 

Annually, 1 taped participant 
interview  

Supervisor or Interviewer 
team leader 

Medical Data Review Local approval Supervisor or PI Methods reviewed annually 
during CC monitoring 

Supervisor or Interviewer 
Team Leader 

Results Reporting Adequate technique on 5 reports Committee Chair or 
Interviewer team leader 

Annually, 1 complete review Committee Chair or 
Interviewer team leader 

Referrals and Review 
Guidelines 

Adequate technique on 5 referrals Committee Chair or 
Interviewer team leader 

Annually, 1 complete review Committee Chair or 
Interviewer team leader 

Physician Reviews Adequate technique on 5 reviews Exam Investigator Annually, 1 complete review Exam Investigator 

Participant Safety Local review of safety procedures Supervisor Annual safety review Supervisor 

Follow-up: Annual 
Follow-up Interview 

Local review of AFU procedures Supervisor or Interviewer 
team leader 

Annual rose Questionnaire 
Exercises annually 

Supervisor or Interviewer 
team leader 

Follow-up: 
Surveillance 

Local review of surveillance 
procedures 

Supervisor or Lead 
Records Administrator 

Excercises annually Supervisor or Lead Records 
Administrator 
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Table 13. Certification Criteria: Baseline Visit 24-hour Exam Procedures 

24-Hour Tracking Adequate completion of 5 
tracking forms 

Central Trainer or 
supervisor 

Annually, 1 completed 
tracking 

Central or Supervisor 

Ambulatory Blood 
Pressure 

Lead technician training 
Adequate explanation and cuff 
placement on 5 exams 

Central trainer or Lead 
Technician 

Biannually.  Annual re-
certification for Lead 
technician 

Lead technician 

24-Hour Urine Lead technician training 
Adequate completion on 5 
forms 

Lead technician Biannually @ Exam Center Lead Technician 

48-Hour Urine Lead technician training 
Adequate completion on 5 
forms 

Lead technician Biannually @ Exam Center Lead Technician 

 
 
Table 14. Certification Criteria: Baseline Visit Sub-study Procedures 

Physical Activity 
Sub-study 

5 Completed instructions to 
participants, monitor 
application and data download 

JHS PA Study 
Investigator 

2 Adequate annual 
completed cycles 

JHS PA Study 
Investigator 

Diet Sub-study Completion of 2-day Delta 
NIRI training.  Completion of 7 
NDS 24-hour recall w/ final 2 
taped with <6% error. 

JHS Diet Study 
Investigator 

Monthly quality assurance 
review with recertification 
exercises if fall below 
desired accuracy 

JHS Diet Study 
Investigator 
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2.6 Reception 
 
The reception workstation welcomes the participant to the clinic and initiates the baseline exam 
interviews and clinical measurements at the Exam Center.  Prior to the participant's arrival, a baseline 
exam folder is assembled which contains labeled data collection forms: the Record of Calls and 
Scheduling (IRC) forms (these may also be filed in a separate, recruitment folder at the discretion of 
the Exam Center, but are available for use during the JHS exam), the Participant Itinerary Sheet 
(PIN), and blank copies of the JHS Baseline exam forms, the Fasting/Tracking (FTR) form and the 
Venipuncture (VEN) (data are collected on paper for delayed data entry) and the Medical History 
(MHX).  Additionally, the Hassles and Moods is included for participant self-administration between 
work stations, if time allows.  Folders also contain Report and Referral forms and ALERT/REFERRAL 
logs for use in baseline exam.  The PIN is attached to the outside of the clinic visit folder. 
 
On arriving at the Exam Center, the participant is greeted and welcomed.  Travel reimbursement and 
participant payment information is obtained.  Approach to Life and Health Care Provider Contact 
forms are collected and checked for completion.  If incomplete, assistance is offered. 
 
Informed Consent for the full JHS exam (see Appendix) is obtained before administering any other 
JHS interviews.  Participant questions are answered.  Demographic and tracking information (CON 
Form) are updated.  Fasting status (Fasting/Tracking form) is determined.  Consent to tape interviews 
for quality assurance assessment is requested and documented on the Itinerary sheet (see Forms 
Appendix).  The Informed Consent Tracking form is completed either during or after the participant 
has left the reception workstation.  Medication bags are logged and labeled. 
 
General instructions on how to administer each interview are given in the text of Chapter 2 under the 
name of the data collection form.  Specific instructions for completing each item on the data collection 
form are given in the question by question (QxQ) instructions that follow each individual form in the 
Forms Appendix. 
 
The schedule for reporting the participant's study results can be reviewed with the participant at the 
reception workstation.  The interviewer explains that some of the study results are reported at the 
conclusion of the exam before the participant leaves the Exam Center.  Results of all studies done 
during the visit are reviewed by the JHS clinician after the participant has left the Exam Center (see 
Appendix).  A final summary report is mailed to the participant and her/his health care provider (with 
her/his permission) 6 - 8 weeks after the clinic visit date, as described in Chapter 8 (RESULTS 
REPORTING).  Letters are mailed to participants and her/his health care providers in conjunction with 
her/his final summary report when all study results are available, or prior to that when study results 
are found to be an alert value (Chapter 8, and Appendix). 
 
When Informed Consent and the Fasting forms have been administered, the participant is shown 
where to change into an examination gown/robe, asked to remove all jewelry, and to place clothing 
and valuables in a secured locker. 
 
Staff are trained for the reception workstation at central training and by the Clinic Manager at the 
Exam Center.  Certification requirements include the successful completion of training on general 
interviewing techniques, Informed Consent, the Fasting/Tracking form, Direct Data Entry System.  
Although no formal certification schedule has been established, interviewers working at the reception 
workstation are observed by the Clinic Manager for quality assurance and standardization. 
 
2.7 Informed Consent 
 
Administration of Informed Consent precedes all other activities at the Exam Center.  The core 
content and consent options of the baseline exam informed consent documents comply with the 
National Institutes of Health and the National Heart, Lung, and Blood Institute guidelines on the 
protection of human subjects, the American Society of Human Genetics' statement on informed 
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consent for genetic research and the approval of the JHS Steering Committee.  The Institutional 
Review Boards of Jackson State University, Tougaloo College and the University of Mississippi 
Medical Center have approved the study protocol and informed consent procedures, maintaining 
annual review. 
 
2.7.1 Rationale 
 
The primary objective of administering the baseline exam informed consent is to affirm that the 
participant understands (1) the purpose of the research; (2) what data collection procedures are used; 
(3) the risks and benefits of participation; (4) alternatives to participation (5) what procedures are in 
place to protect confidentiality; (6) that s/he is free to participate, refuse any procedure or answer any 
question, and to withdraw at any time; (7) and that withdrawing carries no penalties.  The informed 
consent has a record of the project director and a contact person.  Signing permits the participant to 
indicate her/his current preference for the use and disposition of study data, including genetic 
materials, and to change her/his preference at a future date; affirms permission to release clinically 
relevant study data to the health care provider of her/his choice, and gives the participant's 
permission to abstract her/his medical records in the event of hospitalization or death. 
 
2.7.2 Administration 
 
The Informed Consent is administered as the first component of the baseline exam.  The goals of 
JHS at the baseline exam are reviewed with the participant prior to the administration of any other 
data collection instrument.  Consent to participate in the regular JHS examination (baseline exam) is 
documented on the informed consent forms (see Forms Appendix).  Written, audio and visual consent 
forms are available.  Time is allowed for the person to read and ask questions about the informed 
consent documents in a confidential setting.  If the participant is visually handicapped or otherwise 
incapable of reading the study description and informed consent page, the narrative portion is read to 
her/him and then the person is asked to sign the document.  The original Informed Consent 
documents are filed in the participant's JHS study folder.  A copy of the informed consent and 
signature page is given to the participant. 
 
2.7.3 Training 
 
Interviewers are centrally trained in general interviewing techniques and the goals and objectives of 
informed consent.  The Clinic Manager or interviewer team leaders are responsible for providing staff 
training for new staff. 
 
2.7.4 Certification 
 
Although there is no formal certification schedule, interviewers who administer informed consent are 
observed by the Clinic Manager or interviewer supervisor. 
 
2.7.5 Quality Assurance 
 
Routine quality assurance is provided at the Exam Center by means of observation by the Clinic 
Manager.  Administrative techniques and adherence to protocol are also monitored at least semi-
annually by Coordinating Center monitors; frequency distributions of consent preferences recorded 
on the Informed Consent Tracking form (ICT) are monitored by the Quality Control Committee on a 
semi-annual basis. 
 
2.7.6 Data Collection 
 
Descriptions of the study and the signature pages acknowledging informed consent for the baseline 
exam are paper forms.  The participant receives a copy of the full informed consent document and 
the signed consent statement.  In all cases, the original signature page must be kept at the Exam 
Center and stored in the participant's JHS study folder. 
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2.8 Informed Consent Tracking (ICT) 
 
The Informed Consent Tracking (ICT) form is an internal form that applies to the consent given by 
cohort members to participate in the regular JHS study.  It tracks each participant's type of consent 
(full or partial), restrictions on use or storage of DNA (yes or no), type of restrictions on DNA use or 
storage (CVD research, JHS only, no use/storage of DNA, other), other restrictions on procedures or 
use of study data (yes or no), type of restrictions on procedures or use of study data (CVD research, 
JHS only, other), restrictions on release of results to participant's health care provider and permission 
to access medical records and birth certificate.  The form is completed by JHS staff, and NOT 
administered to participants. 
 
2.8.1 Rationale 
 
The purpose of the form is to document and track in the JHS central database the initial level of, and 
subsequent (if any) changes to, participants' restrictions on the use of her/his study data, including 
DNA, by JHS investigators. 
 
2.8.2 Administration 
 
Items 1 - 10 on the ICT form are completed by an interviewer at the reception workstation after 
participants have read and signed the baseline exam Informed Consent form.  Items 11 through 16 
are completed when a participant notifies the study of a desire to either change her/his type of 
consent or access to medical records, or to withdraw from the study.  QxQ instructions are provided 
in the Forms Appendix. 
 
2.9 Fasting Tracking (FTR) 
 
The Fasting Tracking (FTR) form is a core data collection form which confirms the participant has had 
nothing to eat or drink for 12 hours before the baseline visit.  The form is administered at reception 
and documents the participant's fasting status and establishes the participant's official visit date for 
the baseline exam. 
 
2.9.1 Rationale 
 
The participant's fasting status affects the measurement of glucose, and the lipid and hemostatic 
profiles.  To standardize measurements, participants are requested to take nothing by mouth except 
water for 12 hours prior to arriving at the Exam Center. 
 
2.9.2 Administration 
 
The FTR is completed for all participants during the reception for the baseline exam.  QxQ 
instructions for administering the FTR form are provided in the Forms Appendix.  The participant's 
fasting status is verified.  Strict fasting is defined as nothing taken by mouth, except water, for the 
preceding 12 hours.  However, for purposes of results reporting of the clinical chemistries, 
participants can be considered fasting if they have fasted for at least 10 hours or if they have ingested 
no more than one cup of black, unsweetened coffee/tea within the past 10 hours.  Ingestion of more 
substantive liquids or solids constitutes breaking the fast.  The participant's fasting status is recorded 
in number of hours on the FTR form, but the consumption of coffee/tea is recorded in a note log. 
 
Blood samples are drawn on all participants, regardless of fasting status.  If the participant has not 
fasted for 10 hours, the participant is also offered the opportunity to repeat blood drawing in the 
fasting state at a later date.  The FTR is completed; the non-fasting state and rescheduled date of 
venipuncture are noted on the Participant Itinerary Form.  When the participant returns in the fasting 
state for venipuncture, the questions concerning fasting status and recent blood donation on the FTR 
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form are updated, and the Lipid and Hemostasis laboratories are notified that replacement samples 
are being shipped (See Manual 10, Specimen Collection and Processing). 
 
The FTR form also documents whether the participant has given blood within the last 7 days.  It is 
assumed that very few cohort members will have donated blood within the last week as they are 
reminded during both the scheduling calls not to do so, or to reschedule her/his clinic visit if they have 
had to give blood.  Recent donors are not rescheduled once they come for baseline exam; the 
response to question 5 on the Fasting/Tracking form is recorded to reflect the recent blood donation 
and the individual is sent to the venipuncture workstation. 
 
2.10 Family Structure Form (FST) 
 
See Manual 3: Family Study.  The Family Structure Form (FST) is included in the Forms Appendix 
with QxQ instructions. 
 
2.11 Medication Survey (MSR) 
 
The Medication Survey (MSR) is part of the core data collection instruments and is administered to all 
participants during the baseline exam.  The survey covers the use of any prescribed or over-the-
counter medications, including vitamins, mineral supplements or other herbals or home remedies, 
used within the two weeks prior to the participant's interview as well as the current and regular use of 
aspirin and non-steroidal anti-inflammatory drugs in the JHS population.  It also queries usual 
medication – taking practices of participants. 
 
2.11.1 Rationale 
 
The goal of the MSR is to ascertain medication usage by coding prescription and nonprescription 
drugs, home or folk remedies, used by the respondent within the two weeks preceding the interview.  
This information assists in measuring patterns of medication use in the study communities, temporal 
changes in medical care practice, diagnostic classification of cardiovascular diseases, interpretation 
of laboratory results, and predictors of study end points.  A second goal is to document individual 
medication-taking practices to assist in determining adherence to prescribed regimes. 
 
2.11.2 Administration 
 
The MSR is divided into five major sections.  QxQ instructions are located in the Forms Appendix.  
During reception, the interviewer determines and records in Part A of the form whether the participant 
has brought in all medications taken within the last two weeks.  Identification labels are placed on the 
participant's medication bag and MSR form.  If the participant has not brought in any (all) 
medications, inquiries are made to differentiate between non-compliance with pre-visit instructions or 
non-use of medications in the prior two weeks.  In case of inadvertent omissions, arrangements are 
made for obtaining the information, usually by telephone interview.  The deliberate omission to bring 
medications to the Exam Center is recorded on the MSR and on the Participant Itinerary Sheet 
(Forms Appendix) and conversion is attempted later with the participant during the review of medical 
data.  Subsequent parts of the MSR can be administered during reception (if the area affords the 
opportunity for maintaining confidentiality) or later, by trained interviewers or the JHS nurse/clinician 
in areas in the Exam Center usually designated for conducting interviews. 
 
Before starting Part B of the MSR, the name on the medication bag is checked against the name on 
the MSR.  Medication containers are removed from the participant's medication bag and the 
medication name and concentration are transcribed into column (a) of Section B on the form.  
Medications that are not in a container are examined only in front of the participant, with her/his 
permission.  When there are more than 26 medications, recording the name and concentration is 
continued on the back of the page if a paper form is used.  If the Medication Survey DES form is used 
and more than 26 medications need to be entered, the name and concentration of the additional 
medications are written on a piece of paper labeled with the participant's ID, and filed in the 
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participant's folder for future coding.  See below for coding instructions.  If the name of the medication 
exceeds the number of fields in the DES, the name is abbreviated on the screen. 
 
When more than 26 medications have been recorded, the priority algorithm for data entry and coding 
of the medications is as follows: prescription medications first; aspirin and aspirin-containing 
medications (aspirin, Alka Seltzer, headache powders, cold medications, medication for arthritis, 
etc.); anti-inflammatory drugs (ibuprofen, Motrin, Nuprin, etc.); then over-the-counter-medications, 
followed by vitamins and food supplements. 
 
To administer Parts B and C, a trained interviewer or the JHS nurse/clinician shows each container of 
medication to the participant, transcribes its name in column (a) of Section B (MEDICATION 
RECORDS), records medication's concentration in column (b), and asks and records in column (d) 
whether the medication was used within the last 24 hours. 
 
When preparing to ask the participant about each medication, the interviewer removes all containers 
from the bag and sets them in front of the participant.  As each medication is reviewed, it is shown to 
the participant while keeping the other medications in view.  After the participant answers the 
questions for each medication, its container is placed back in the carrying bag to minimize confusion 
and to assure that all medications are returned. 
 
The interviewer verifies the transcription of medication names and makes corrections on the paper (or 
DES) form as required.  Use the American Drug Index and Physician's Desk Reference for unknown 
and incomplete names. 
 
Part C of the MSR ascertains (1) whether any of the participant-reported medications were used to 
treat cardiovascular diseases or symptoms (high blood pressure; high blood cholesterol; angina; 
arrhythmia; heart failure; blood thinning; diabetes; stroke; intermittent claudication) or (2) whether 
aspirin or aspirin-containing medications were used in the last two weeks and the reason for her/his 
use; current, regular use (at least once per week for several months) of aspirin or other non-steroidal 
anti-inflammatory drugs. 
 
Part D of the MSR ascertains any reasons the participant may have for not taking her/his prescription 
medications as prescribed.  It also requests information on the participants current or regular use of 
either aspirin or non-steroidal inflammatory agents. 
 
Part E asks the participant to identify any folk medicine, herbals, roots or teas that they may have 
used for medicinal purposes in the last two weeks.  A separate question ascertains whether such 
remedies have ever been used and for what health-related reason. 
 
2.11.3 Certification 
 
Certification to administer the MSR is achieved by the demonstration of adequate technique on 5 
taped interviews, reviewed and approved by the supervisor or interviewer team leader.  Re-
certification is required annually, and requires the successful completion of one taped interview of an 
actual participant.  This tape is included in the round robin that is reviewed by the four interviewer 
supervisors selected to monitor each year's round robin tapes. 
 
Separate certification is required for medication coding, based on a minimum of 80% correct 
responses on the certification test provided by the Coordinating Center and administered at central 
training.  Re-certification for medication coding is also required annually.  For the Medication-Coding 
Specialist, this includes coding a set of selected medication names circulated for this purpose and 
adequate performance on blinded re-coding of medications recorded during the previous year.  Re-
certification criteria for medication coders require meeting minimum standards of coding repeatability 
(by interviewer/transcriptionist) and a review at the Coordinating Center of the accumulated 
performance on quality control repeat medication coding. 
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2.11.4 Quality Assurance 
 
For each person certified to code medications a ten percent sample of medication coding records is 
identified by the Coordinating Center for blinded repeat coding at the Exam Center. 
 
2.11.5 Data Collection 
 
The six digits medication code numbers are listed in a hard copy or DES version of the Medication 
Coding Dictionary.  The Medispan code in part (c) can be matched to the drug name while 
transcribing the name of the drug in part (a) into the DES screens, or can be ascertained later.  Drug 
names are listed alphabetically.  The medication code of a drug not listed in the dictionary is left 
blank, and its status code is always set to "Q" (questionable) so that the pharmacist at the 
Coordinating Center can develop a code number and update the dictionary.  Detailed instructions for 
coding medications are provided in the QxQ instructions for the MSR. 
 
2.12 Medical History (MHX) 
 
The Medical History (MHX) form is a core data collection form, administered during the flexible 
component of the baseline exam.  In the baseline examination it serves to assess potential sleep 
apnea or other sleep disturbance as well as a number of specific cardiovascular symptoms.  Chest 
pain, possible infarction, intermittent claudication (peripheral vascular disease), and congestive heart 
failure are each detailed.  The occurrence of the participant-reported chest pain is confirmed as 
positive angina and/or myocardial infarction by London School of Hygiene criteria.  The questionnaire 
also documents the occurrence of procedures to diagnose or treat cardiovascular disease as well as 
current or ever renal dialysis. 
 
2.12.1 Rationale 
 
A major objective of the JHS is the assessment of CHD in the study population at each clinical 
examination and across time from the baseline examination.  This is done, in part, by the 
documentation of the symptoms of heart disease and exposure to diagnostic and therapeutic 
procedures of each participant at each visit and annual follow-up call.  Another objective is a similar 
assessment of peripheral vascular disease (PVD).  Questions on claudication provide baseline 
information on PVD symptoms.  Another major contributor to CHD is sleep apnea.  Data also suggest 
a relationship between sleep quality irrespective of sleep apnea, as a correlation with CHD. 
 
2.12.2 Administration 
 
The MHX form is administered by trained and certified interviewers with an understanding of the 
medical terms and diagnostic procedures referred to in this instrument.  The frame of reference for 
questions in section A (chest pain on effort) and sections B and C (invasive/non-invasive diagnostic 
and therapeutic cardiovascular procedures) is the time period prior to the JHS baseline.  Detailed 
procedures for administering the form are provided in the QxQ instructions immediately following the 
form in the Forms Appendix. 
 
2.13 Respiratory Symptoms (RSF) 
 
The Respiratory Symptoms form (RSF) is one of the core data collection instruments to assess 
symptoms of cough, wheezing, breathlessness and asthma administered during the flexible 
component of the baseline exam.  The instrument was adapted from the Adult Respiratory Symptoms 
Questionnaire and is a condensed version of the questions on respiratory symptoms asked in the 
Respiratory Symptoms/Physical Activity form during ARIC Visit 1. 
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2.13.1 Rationale 
 
Relevant questions on respiratory symptoms are necessary for the analysis of the pulmonary function 
tests. 
 
2.13.2 Administration 
 
The RSF form is administered by certified interviewers.  Questions are taken directly from the Adult 
Respiratory Symptoms questionnaire.  Interviewers are instructed to read each question as printed 
and accept unequivocal answers as provided by the respondent.  The wording of the questions and 
the instructions by the interviewer before starting the interview lead to simple “yes” or “no” answers.  
Probing is limited to repetition of the question when possible, and equivocal answers are recorded as 
“no.”  Detailed QxQ instructions are specified in the Forms Appendix. 
 
2.14 Stroke (SSF) 
 
The Stroke Symptoms Form (SSF) is one of the core data collection instruments to assess the 
symptoms of stroke and transient ischemic attack.  The interview is administered during the flexible 
component of the JHS exam. 
 
2.14.1 Rationale 
 
Stroke and transient ischemic attack (TIA) are identified as end points in the JHS study.  A baseline 
history of stroke symptoms will be collected during baseline exam. 
 
2.14.2 Administration 
 
The SSF administered by certified interviewers.  Positive symptoms are recorded during the 
standardized interview along with her/his speed of onset, duration, and co-morbid manifestations.  
QxQ instructions are in the Forms Appendix.  Section A of the form documents the participant's 
medical history of a stroke.  The subsequent sections cover six neurologic symptoms which are 
associated with strokes and TIAs and are administered in a standardized format.  Descriptors of the 
neurologic symptoms (earliest, longest and worst) often require probing, but the definitions are left to 
the respondent. 
 
2.15 Reproductive History (RHX) 
 
The Reproductive History form (RHX) is administered to female cohort members during the flexible 
component of the exam.  The objective of this questionnaire is to determine the menopausal status, 
the use of exogenous gonadal hormones and to obtain her history of gynecological surgery. 
 
2.15.1 Rationale 
 
The questions on menstrual patterns and hormone use have been developed to help establish with 
more certainty whether menopause has taken place.  Questions addressing exogenous gonadal 
hormone exposure are used because of the belief that they may play a role in the development of 
atherosclerosis. 
 
2.15.2 Administration 
 
The RHX is administered by certified interviewers within the flexible sequence of the participant 
examination.  Detailed instructions for administering each question are provided in the QxQ 
instructions.  Questions on menstrual history and the use of female hormones may be considered 
sensitive by participants and care must be exercised to administer each section in a nonjudgmental 
format. 
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The questionnaire is divided into 3 sections: (1) recent menstrual history and onset of menopause; (2) 
the use of exogenous hormones, and (3) a history of gynecological surgery. 
 
Item 1 is not read aloud.  The response category is based on information printed on menopausal 
status on the PIN sheet.  The majority of the questions on the form are closed-ended or pre-coded 
questions designed for direct entry into the computer by the interviewer.  Open-ended questions are 
to obtain names of female hormones being used, age, or some other concept of time. 
 
The exact wording and order of the questions is followed to ensure standardization.  Questions are 
not skipped unless indicated by the skip pattern. 
 
2.16 Delta Nutrition Intervention Research Initiative Food Frequency Questionnaire 
 
The Delta Nutrition Intervention Research Initiative (NIRI) Food Frequency Questionnaire (FFQ) will 
be administered during the baseline examination during the flexible sequence.  This questionnaire will 
measure an individual’s usual dietary intake over a six month time period. 
 
The original FFQ was developed by the Delta NIRI staff and is in the process of being validated within 
the Delta region.  It was critically reviewed by the JHS Diet Workgroup and is thought to be a robust 
diet instrument with significant potential for increased accuracy in the assessment of African-
Americans.  After extensive research (outlined in previous documents) the JHS Diet Workgroup voted 
to adopt the Delta NIRI (FFQ).  At the request of the JHS diet workgroup Delta NIRI agreed to modify 
the original DELTA NIRI FFQ to accommodate the JHS participant burden requirement of 20 minutes 
to allow its use for assessment of diet patterns for the entire 6,500 member JHS cohort. 
 
2.16.1 Background, Rationale and Hypotheses 
 
International variations of cardiovascular diseases (CVD) suggest that dietary and environmental 
influences can explain the CVD differences in Americans, rather than genetics (Fumo, et al., 1992; 
Cappuccio, 1997; Cooper, et al., 1997; Cooper & Rotimi, 1994; Cooper, 1993).  The role of diet, 
particularly electrolyte cations in modulating hypertension, stroke, and cardiovascular diseases 
especially in African-Americans has led to a significant body of scientific investigation (Watson, et al., 
1980; Kagan, et al., 1985; Sasaki, et al., 1995; Khaw & Barrett-Connor, 1987; Alderman, et al., 1995; 
Law, et al., 1991; Schmider, et al., 1988; Liu, et al., 1979; Grim, et al., 1980; Marmot, 1994; Law, et 
al., 1994; Gillum, 1979; Falkner, 1987; Grim, et al., 1980; Falkner,1987). 
 
Most past surveys failed to capture black-white differences in added fat or in fat food sources.  As 
Cooper and Rotimi (1994) noted, many of these studies are driven by contrast of race and gene 
rather than public health concern.  Kumanyika (1991) pointed out the conceptual and methodological 
pitfalls in the poor use and interpretation of the health differentials within the races. 
 
In the Boston Validity Study, the Willett FFQ (62 items) was validated against four 1-week dietary 
records among 173 women in the Boston area.  A moderate correlation was found in most nutrients 
(0.36 for Vit. A to 0.75 for Vit. C.) between these methods.  Only a small percentage of this sample 
was African-American.  Past studies demonstrated that regardless of race and sex, high educational 
attainment is associated with recommended dietary intake patterns.  Intake differences could not be 
separated from race to assess if differences were due to racial or regional influences. 
 
Urban and international studies (Vaughan and Miall, 1979; Bunker, et al., 1992; Mufunda, et al., 1993; 
Adams-Campbell, 1993; Kaufman & Barkey, 1993; Hackland, 1982) reported that rates of 
hypertension were attributed to stress in urban life or high dietary sodium. 
 
Although an absolute "gold standard” does not exist, and even with documented flaws (Ness, et al., 
1997), FFQs are commonly used in epidemiologic research on diet and disease to assess the usual 
food or nutrient intakes of individuals.  There is substantial variation among the few African-American 
focused studies that exist which raises questions about the ability to draw comparisons across 
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populations (Stampfer & Rimm, 1996).  To be effective in addressing the “epidemic” of high blood 
pressure a population approach addressing lifestyle factors such as diet and nutrition is critical 
(Frishman & Sonnenblick, 1992).  The dietary assessment method selected for study of a population 
must be sensitive to the culture being investigated (Traber & Packer, 1995; Boushey, et al., 1995). 
 
Specific areas needing further investigation include (1) diet determinants for obesity (Kumanyika, 
1992; Kumanyika, et al., 1992 & 1993; Kumanyika, et al., 1995; Kumanyika, 1993 & 1987; Kumanyika 
& Charleston, 1992), (2) the relationship between obesity and cardiovascular disease risk (Grim, et 
al., 1980; Jones 1998), (3) the etiology of obesity-associated hypertension, (4) the variation in the 
influence of sodium in hypertension (Liu, et al., 1979; Hixson, 1990; Simmons, et al., 1983; Carvalho, 
et al., 1989; Naiker, 1998; Miller, et al., 1983, Witteman, et al., 1989; Sower, et al., 1988; Falkner & 
Kushner (1990); Sower, et al., 1988; Lever, et al., 1981), (5) the effects of free radicals versus 
antioxidants and homocysteine relationships. 
 
Over the past year, the Lower Mississippi NIRI Food Frequency Working Group has developed a 
specialized food frequency questionnaire for use in the assessment of “usual intake” of the 
participants (Nutrition Assessment Survey) NAS Part II.  The FOODS data set was analyzed at the 
Tufts Human Nutrition Research Center (HNRC) to identify the major food contributors to intake of 
each nutrient and to document the distribution of portion sizes.  Based on this information, a form was 
drafted by a model used previously at Tufts HNRC for a FFQ for use with Hispanics (Puerto Rican 
Study) that was originally modeled on the Block FFQ.  This draft form was reviewed, evaluated and 
revised by the Delta NIRI FFQ Working Group, where specific names of foods, portion size 
assumptions and cooking adjustment questions were adapted to cover the likely food intakes in the 
Delta. 
 
The Delta pilot data used to produce and verify the food list resulted from telephone-administered 24-
hour recalls from adults in the Delta (including Mississippi).  This pilot revealed the need for portion 
size adjustments for some items (especially snacks and soft drinks).  Open-ended techniques are 
being considered for some items with highly variable portion sizes.  The desire of the Delta group to 
automate the FFQ and the additional administration and processing time that will be required to 
accommodate open-ended components are all being considered.  Many items will retain the original 
small, medium and large approach for portion estimation.  Items heavily used with a wide variation in 
portion sizes will have up to 4 more specific choices. 
 
Because the food list and average portion sizes were actually developed with Mississippi Delta 
participants, it was felt to be the most “robust” instrument with the greatest outcome potential.  A 
shortened version of this instrument was developed for use and validation in the JHS. 
 
The following research questions will be considered for investigation: 
 
1. Classic “diet-heart” hypothesis 
 
Does high intake of saturated fats and cholesterol and low intake of polyunsaturated fats increase the 
level of serum cholesterol, lead to the development of CVD? 
 
Do dietary intake behaviors of African-Americans within the JHS differ significantly by age, gender, 
educational level or socioeconomic status? 
 
2. Role of Dietary Sodium and Potassium in Cardiovascular Disease: 
 
What is the role of increased dietary sodium and decreased dietary potassium in hypertension and 
target organ injury in African-American? 
 
Is the relationship between stroke and sodium intake explained by high blood pressure? 
 
Is the relationship between left ventricular mass and sodium intake explained by high blood pressure? 
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Does dietary or supplemental potassium intake correlate with blood pressure control in African-
Americans with hypertension? 
 
3. Diet Determinants of Obesity: 
 
Is there a gender-specific association between energy and macronutrient intake with levels of obesity 
in the JHS cohort?  
 
Are there diet intake behaviors that are associated with increasing levels of obesity in JHS 
participants? 
 
4. Role of Fiber Consumption in Coronary Heart Disease Risk: 
 
What are typical fiber consumption practices of African-Americans? 
 
Do African-Americans consume fiber at levels recommended to decrease her/his risk for CHD? 
 
What effects on plasma lipids or plasma glucose levels are documented at various levels or with 
different forms of fiber intake? 
 
5. Positive Impact of Folic Acid in Reduction of Homocysteine Levels and Reduced CHD Risk: 
 
Do levels of folic acid and other B vitamins consumed by JHS participants correlate with individual 
plasma homocysteine levels? 
 
Is there a relationship between consumption of folic acid and socioeconomic status in JHS 
participants? 
 
6. Role of Antioxidants in Decreasing CVD and CHD Risks: 
 
Are intakes of antioxidants (Vitamins C & E, carotenoids) associated with the development of CVD or 
CHD risk factors? 
 
If so, are these associations due to antioxidant intakes from diet or supplements? 
 
7. Investigation of the impact of socioeconomic status on dietary practices: 
 
Do dietary intake behaviors of African-Americans within the JHS differ significantly by age, gender, 
educational level or socioeconomic status? 
 
Is there a significant association between dietary or supplemental intake of antioxidants (Vitamins A, 
C, E) and socioeconomic status of JHS participants? 
 
2.16.2 Administration 
 
This first page of the FFQ consists of demographic information that will be completed prior to the 
interview by JHS staff.  Participants will be asked to provide information on both the frequency and 
portion of her/his usual intake of food items listed on the FFQ.  Cue cards with frequency measures 
and standard portions will be used during the interview to prompt and remind participants of her/his 
choices.  Selected food models will also be available to provide additional support for portion 
estimations.  Detailed instructions for administrating questions on this FFQ can be found in the QxQ 
instructions (see Forms Appendix). 
 
2.16.3 Quality Assurance 
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1. 5-10% random data checks will be done for the original FFQ forms.  Checks for missing data and 
for unusual portion sizes will be made. 

2. Checks of the dataset will be made by batch for outliers, with nutrient totals, gram weights, 
frequency and serving sizes for both the recalls and FFQ. 

3. Comparison of mean intakes from the recall and the FFQ will be done every 6 months. 

Transfer nutrient analysis to Jackson Heart Study 
 
Every 6 months a SAS transport file will be generated by Tufts, which will include daily totals of the 
recalls and FFQ.  This will be sent to JHS Coordinating Center electronically. 
 
2.16.4 Data Collection 
 
The Delta NIRI FFQ will be administered by JHS interviewers who have completed a required training 
program.  The Delta FFQ will be completed as a paper form.  At the completion of each interview, the 
interviewer will review the form for completeness and clarify any areas of concern.  Dietary data will 
be grouped into batches.  Each batch should include completed FFQ on 50 participants.  A name 
should be given to each batch and each record should have a unique identifier designed to identify 
the participant and the encounter.  For example: the first batch would be batch “01” and so on.  A 
data management roster should keep track of the batch names and what participants are in each 
batch.  This will be done in Microsoft Access according to guidelines provided by Tufts. 
 
Once the interviewer completes her/his review, the FFQ will be placed in the batch file for an 
additional quality assurance check by the nutrition monitor.  Once approved by the nutrition monitor, 
questionnaires will be sent for scanning to Tufts University.  A quarterly mailing will be sent to Tufts 
where each will be scanned and the diet data collection stored in a SAS data set for future analysis. 
 
1. Checking Data (before sending to Tufts) 
 
All FFQ will be reviewed for missing data, bends, rips, folds, stray marks, or incomplete erasures 
before sending to Tufts.  If there are missing data in the FFQ, JHS staff should contact the participant 
for complete data.  If the participant is unable to answer or can not be contacted then the missing 
data should be recorded as "never eaten" and specific notes to this effect kept for future reference.  
Please note: all data must be filled in to get a complete FFQ analysis. 
 
2. Sending Dietary Data to Tufts 
 
JHS staff should send batches of 50 completed FFQs to Tufts on a quarterly basis.  Up to 12 batches 
(600 FFQs) can be sent at one time. 
 
2.17 Alcohol and Drug Form (ADR) 
 
The Alcohol and Drug Form (ADR) is a core data collection form administered during the flexible 
component of the baseline exam to document alcohol and drug abuse.  It uses questions from ARIC 
and several other large epidemiologic studies to provide general information about whether the 
participant has ever used alcohol and several other substances.  Information obtained about alcohol 
will allow classification of participants into lifetime abstainers, ever users, and users during the past 
12 months.  It will assess preferred beverage, history of heavy use (yes/no), and provide quantity-
frequency information about alcohol intake during the past 12 months.  The information about drug 
use will allow classification into lifetime abstainers, ever users of cocaine or other drugs and provide 
an estimate of total number of cocaine uses.  This form is not designed to be sufficient to allow for 
assessment of dependence or history of dependence for alcohol or other substances and will not 
provide lifetime quantitative data about total alcohol or drug exposure. 
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The sources for each item are shown in Table 15 below. 
 
Table 15. Sources for each item in the Alcohol and Drug Form 

ITEM SOURCE 

Alcohol Item 1 ARIC 

Alcohol Item 2 ARIC, 18b. from PHXB 

Alcohol Item 3 NHANES3 

Alcohol Item 4 ARIC 

Alcohol Item 5 NHANES3 

Drug Item 6 NHANES3 

Drug Item 7 NHANES3 

Drug Item 8 NHANES3 

 
2.17.1 Background, Rationale, and Hypotheses 
 
The association of alcohol to CVD risk has been examined in many studies, but some of the findings 
remain controversial (Hanna, 1997).  The lowest CVD death rates appear to occur with light to 
moderate alcohol intake (about 1 drink per day).  Higher death rates are observed in nondrinkers 
(individuals who have never consumed alcohol as well as those who quit drinking) and individuals 
consuming more than 2 or 3 drinks per day (Fuchs, et al., 1995; Klatsky, Armstrong, & Friedman, 
1992; Klatsky, Armstrong, & Friedman, 1997); Thun, et al., 1997).  Plausible mechanisms for the 
beneficial effects of light to moderate drinking, including increased HDL cholesterol and an 
antithrombotic effect, have been proposed and are supported by epidemiologic data.  Yet many 
investigators remain concerned about the potential bias (i.e., the confounding of nondrinking controls 
with people who quit drinking after becoming ill and of subgroups with light-moderate intake with 
relatively affluent, well-educated adults with healthier lifestyles).  Despite all the attention to the 
“beverage effect” in the popular media, the evidence that wine (and particularly red wine) is more 
cardioprotective than other beverages is not consistent or strong when total ethanol and other factors 
are controlled (Klatsky, et al., 1997). 
 
A number of epidemiologic studies have confirmed an association between alcohol and hypertension 
risk when the level of drinking exceeds 1 or 2 drinks per day.  A large prospective study found rates of 
death from all CVD were 30 to 40 percent lower among men and women reporting at least one drink 
daily than among nondrinkers, with little relation to amount of alcohol consumed.  An earlier study of 
72,000 Kaiser Permanente health plan participants which included 30% Blacks found no differences 
by race in the U-shaped relation of alcohol use to coronary disease (Klatsky, et al., 1992).  This group 
(Klatsky, et al., 1997) also reported on a prospective case-cohort study of risk for CAD hospitalization 
almost 129,000 members of a northern California health plan; about 20% of the participants were 
African-American.  Each beverage type showed evidence of CAD protection, but these investigators 
concluded there may be some additional benefits from beer and red or white wine. 
 
About 20 to 30% of cardiomyopathy cases are attributable to chronic alcohol use (Secretary of Health 
and Human Services, 1994).  Cardiac arrhythmias are frequently associated with acute alcohol 
intoxication and/or prolonged drinking at the level of 6 or more drinks per day (Regan, 1990), and 
may at least in part explain the increased risk of sudden death associated with heavy drinking.  
Compared to healthy controls, alcoholic men presenting for outpatient treatment had significantly 
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lower mean ejection fraction, dilation of the left ventricle, and increased left ventricular mass (Urbano-
Masquez, et al., 1989).  Cardiac dysfunction has been demonstrated, even in the absence of 
malnutrition or severe social consequences, in a third of asymptomatic alcoholic men (Regan, 1990). 
 
In comparison to alcohol use, there are as yet few studies of the association between cocaine and 
other “street” drugs with CVD.  Cocaine use is associated with increased acute CVD risk, but limited 
evidence suggests it may not be an independent predictor of hypertension or renal disease (Braun, et 
al., 1997; Brecklin, et al., 1998).  Illegal drug use may be related to personality characteristics and 
psychological states which are known to adversely affect CVD risk. 
 
Early Findings from ARIC 
 
Folsom and others (Folsom, et al., 1991) examined ethanol intake in relation to plasma fibrinogen and 
factor VII in the ARIC cohort.  An inverse association of Factor VII with ethanol intake was observed.  
Patsch, et al., found that alcohol consumption was associated with higher HDL cholesterol levels, with 
one drink per day associated with HDL increases of approximately 2.5 mg/dl in men and 7.5 mg/dl in 
women.  These associations were essentially unchanged after adjustment for BMI, physical activity, 
smoking, and age.  Demirovic, et al. (1993) reported the overall level of alcohol consumption in ARIC 
was low, with age-adjusted means for grams of ethanol per week 72.0 for white and 74.3 for nonwhite 
men and 24.8 for white and 11.2 for nonwhite women.  After adjustment for age, artery depth, 
education, BMI, physical activity, smoking, LDL, and diabetes, the only race-sex group in which an 
hypothesized relationship between alcohol consumption and carotid wall thickness and distensibility 
was observed was in white women; however the significance was borderline.  Duncan, et al.(1995) 
examined beverage-specific effects of alcohol on waist to hip ratio in the ARIC cohort.  They found a 
reasonably graded increase in the waist-hip ratio with increased proportion of ethanol intake from 
beer or liquor (versus wine), which was most pronounced in individuals with BMI<25.  The findings 
were similar across race-gender categories.  The authors noted that very few modifiable factors have 
been found which impact waist-hip ratio, and suggested that the observed effect may be one of the 
mechanisms mediating the cardioprotective effect of wine.  However, they also acknowledged the 
likelihood of differences in diet, drinking pattern (e.g., slowly, with meals), and other factors between 
wine and nonwine drinkers. 
 
Method of Alcohol Use Assessment in ARIC 
 
Information on alcohol use was obtained at each visit by trained interviewers.  10 items queried 
whether the participant had ever used alcohol; whether s/he currently used alcohol (if not, how much 
time had elapsed since the most recent use); the current weekly intake of 4 oz. glasses of wine, 12 
oz. cans of beer, and/or 1.5 oz shots of liquor in total drinks; and number of days each week when 
liquor was consumed.  This would allow evaluation of effects of 1) total ethanol consumed 2) the 
pattern of drinking and 3) type of beverage.  Several ARIC items have been retained for JHS Alcohol 
and Drug Form.  Drug use was not assessed in ARIC. 
 
Hypotheses include: 
 
1. There will be a J- or U-shaped association of alcohol intake and CVD with abstainers having 

greater risk than minimal drinkers, and increased risk beginning with the average of 3-5 or more 
drinks per day. 

 
2. Greater alcohol intake will be associated with other indications of inadequate coping and/or high 

levels of perceived stress and more dysfunctional psychological status. 
 
3. Association of alcohol intake with CVD will be moderated by type of preferred beverage. 

 
4. A history of heavy drinking during the 12 months preceding the examination (more than 2-3 

drinks/day) will be associated with greater CVD risk. 
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5. Cocaine and other drug use will be associated with increased CVD risk. 
Number of times of crack or cocaine use will be associated with demographic and sociocultural 
CVD risk factors. 
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2.17.3 Administration 
 
The ADR is administered to all participants during the baseline examination immediately following the 
food frequency assessment.  There are 5 questions about alcohol use, followed by 3 items on drug 
use.  The participant must have sufficient privacy to feel comfortable talking honestly about her/his 
substance use.  Response cards with photographs of commonly used alcoholic beverages and 
“street” names for drugs will help participants understand the types of substance use we want to 
know about.  Interviewers must be knowledgeable about different quantities and types of alcoholic 
beverages (for example, a “fifth” of whiskey) to accurately assess amounts reported.  It is important 
not to make assumptions.  If the participant says, “one half a beer,” ask questions until you are certain 
of the size of the bottle or can s/he was referring to.  Detailed instructions are included in the QxQ 
instructions following the ADR form in the Forms Appendix. 
 
2.18 Discrimination (DIS) 
 
The Discrimination Form (DIS) is a core data collection form administered during the flexible part of 
the baseline examination to document racial discrimination experiences.  This includes the 
participant’s attributions, day-to-day experiences, major life events, and coping/responses to racial 
discrimination.  Jackson, et al. (1996) concluded key dimensions include racism as major and minor 
stressors, perceptions of racism, responses to racism, and indicators of institutional racism.  No 
single instrument assesses the multiple dimensions.  A multidimensional measure of racism that 
captured these key elements has been adapted from the Discrimination Scale (Kreiger, 1990), the 
Everyday Racial Discrimination Questionnaire (Williams, 1997), and the Perceived Racism Scale 
(McNeilly, et al., 1996). 
 
 
2.18.1 Background, Rationale, and Hypotheses 
 
Several studies have found that exposure to racist provocation in the laboratory setting leads to 
increased cardiovascular and psychological reactivity (Anderson, et al., 1989; Armestead, et al., 
1989).  There is some evidence from epidemiologic and other studies that perceived discrimination 
may adversely affect health as well as blood pressure (Dressler, 1990; James, 1984; Thompson, 
1996; Williams, 1997; Krieger, 1990; Krieger & Stanley, 1996), while others found no association with 
hypertension and cardiovascular disease (Broman, 1996).  The inclusion of a measure of 
discrimination in the JHS will allow for further investigation of whether discrimination, as a source of 
psychosocial stress, contributes (directly or in interaction with other sociocultural measures) to the 
development of hypertension, CVD and subclinical markers of LVH, carotid wall thickness, etc.  If 
perceived discrimination proves to be related to the development and progression of CVD, it may be 
relevant to understanding race and SES discrepancies observed. 
 
Development of discrimination measures is in its infancy though a number of measures have been 
developed over the past several years.  In particular, measurement issues have included attention to 
the acute, every day, and lifetime measures.  Both major life domains as well as explicit exemplars 
(dimensions) have been offered.  Three major measures were considered for the JHS: Krieger's 
questionnaire (used in CARDIA), Williams, et al. (1997) measure of everyday discrimination, and Mac 
Neilly's (1996) Perceived Racism Scale.  By adapting these three measures, JHS captures 
information on acute, episodic, daily and lifetime discrimination.  In addition, because some limited 
research suggests that coping strategies may modify the relation of discrimination to outcomes, a 
question on response to discriminatory situations is included. 
 
Hypotheses include: 
 
1. Perceived discrimination is associated with risk factors, sub-clinical and overt cardiovascular 

disease at baseline. 
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2. Among persons with similar degrees of sub-clinical and overt disease at baseline, those with 
higher levels of perceived discrimination will be at greater risk for subsequent CVD events over 
the course of follow up. 

 
3. Perceived discrimination interacts with SES to modify the effects of other social stressors. 
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2.18.3 Administration 
 
The DIS is administered by certified interviewers during the flexible component of the baseline exam.  
Detailed instructions for administering each question are provided in the QxQ Instructions.  The first 
portion of the DIS ascertains information on the participant’s day-to-day experiences.  The 
subsequent section gathers information on the participant’s lifetime experiences, frequency of those 
experiences and the last time for the experience.  The DIS consists of 20 multiple choice, yes/no, and 
fill-in-the-blank type questions. 
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The exact wording and order of the questions are followed to ensure standardization.  Questions are 
skipped only when indicated by the skip pattern instructions.  Because of the number of skip pattern 
instruction in this form, the interviewer needs to memorize the flow of the questions.  Items in 
PARENTHESES, SHADED BOXES and/or CAPITAL BOLD LETTERS are instructions to the 
interviewer and are not read to the participant.  The questions are read clearly using the exact 
wording on the form.  The nature of the discrimination questions may be considered sensitive and 
care must be taken to ask the questions and to record the responses in a nonjudgmental manner. 
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3.0 PROCEDURES IN THE BASELINE EXAM CLINICAL EXAM 
 
 
3.1 Introduction 
 
Chapter three presents a detailed description of the baseline examination components, and a 
reference to the pertinent manuals of the protocol for those examination procedures not covered in 
detail in Manual 2.  Separate protocol manuals are available for baseline examination components 
that require lengthy description and technical specification, or are of intrinsic substantive interest as 
stand-alone documents. 
 
3.2 Ankle/Brachial Blood Pressure (ABB) 
 
See Manual 4, Blood Pressure.  The Ankle Brachial Blood Pressure (ABB) is found in the Forms 
Appendix with QxQ instructions. 
 
3.3 Anthropometry (ANT) 
 
Height, weight and body size are measured during baseline exam.  All measurements are recorded 
on the Anthropometry form (ANT) (see Forms Appendix).  Procedures for measuring the height, 
weight and waist and neck girths are provided below.  Separate instructions for completing the data 
collection form are provided in the ANT QxQ instructions (Forms Appendix).  At the option of the 
Exam Center, the circumference of the right upper arm (to determine blood pressure cuff size) can 
also be measured at this workstation and recorded on the sitting blood pressure form. 
 
3.3.1 Rationale 
 
Obesity is a risk factor for cardiovascular disease.  Height, weight, body mass index, and girth 
measures provide easily attained indicators for obesity and body fat distribution. 
 
3.3.2 Procedures 
 
Anthropometry is performed before the clinic snack and after the participant has changed into a scrub 
suit or examination gown and been given the opportunity to empty her/his bladder.  All measurements 
are made with the participant wearing light-weight, non-constricting underwear.  Participants wearing 
nylon hose or other forms of constricting undergarments are instructed to remove them.  Weight and 
height are measured without shoes.  Technicians complete the procedures on every participant by 
following the general checklist for performing anthropometric measurements (Forms Appendix). 
 
All anthropometric measurements are taken by either a team of two persons (one serving as 
observer; the other as recorder) or by one technician using a full length mirror to aid in the 
appropriate placement of the tape measure to record the girths.  Using the team approach, the 
observer calls out the name of the next measurement, takes the measurement, and keeps the 
measuring instrument in place until the recorder repeats the number.  The recorder checks the 
position of the examinee and verifies the horizontal placement of the measuring instrument during 
each procedure, and records the result.  When a single technician performs the measurements, s/he 
verifies the horizontal placement of the measuring instrument (using the mirror when appropriate) for 
each measurement and records each measurement immediately after it is taken. 
 
3.3.2.1 Standing Height 
 
The participant stands erect on the floor or the horizontal platform with her/his back against the 
vertical metal centimeter ruler mounted on the wall.  The heels are placed together and positioned 
against the vertical ruler.  The participant is instructed to stand as straight as possible, but with feet 
flat on the floor.  The participant looks straight ahead with her/his head in the Frankfort horizontal 
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plane (i.e., the horizontal plane which includes the lower margin of the bony orbit -- the bony socket 
containing the eye -- and the most forward point in the supratragal notch -- the notch just above the 
anterior cartilaginous projection of the external ear) (Figure 1).  The right angle is brought down 
snugly, but not tightly, on the top of the head.  A footstool is used if the examiner is shorter than the 
participant, such that the examiner's view is level with the point of measurement on the head of the 
participant.  The certified technician follows a checklist for height measurement (Forms Appendix) 
which outlines the procedures for checking the equipment and measuring the participant's height and 
enters study data on the Anthropometry form.  The participant's height is recorded to the centimeter.  
The conversion chart in Table 16 is provided to assist in the converting to and from metric measures.  
A chart converting centimeters to inches is available for use in informing the participant of her/his 
height in inches (Table 17). 
 
The height rule is observed weekly to see that it (a) touches the hard-surfaced floor or platform on 
which measurements are done, and (b) is perpendicular to the floor.  This weekly check is recorded 
on the Anthropometry Equipment Calibration Log (see Appendix). 



75 

Exam 1 Cohort Procedures Manual.doc 

 
Figure 1. Frankfort Plane for Measuring Body Height 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Thyroid Cartilage________ 
Cricothyroid Membrane 
 
ORBITALE: Lower margin of eye socket 
 
TRAGION: Notch above traqui of ear or at upper margin of zygomatic bone at that point 
 
FRANKFORT PLANE: Orbitale-tragion line horizontal 
 
THYROID CARTILAGE: Firm, curtinalyenous providence on neck 
 
CRICOTHYROID MEMBRANE: Below thyroid cartilage 



76 

Exam 1 Cohort Procedures Manual.doc 

 
3.3.2.2 Body Weight 
 
Before a participant is weighed, the scale is balanced so that the indicator is at zero when no weight 
is on the scale. The scale must be level and on a firm surface (not a carpet). The participant is 
instructed to stand in the middle of the platform of the balance scale (Detector, model #437) with 
head erect and eyes looking straight ahead.  Weight is adjusted on the indicator until it is balanced.  
Results are recorded to the nearest kilogram.  A chart converting kilograms to pounds is available for 
use in informing the participant of her/his weight in pounds (Table 17). 
 
To maintain accuracy, the scale is zero balanced daily and calibrated with a known weight (50 lbs) 
every week or whenever the scale is moved.  The daily zero balance and the weekly scale calibration 
are documented on the Anthropometry Equipment Calibration Log (see Appendix).  The scale is 
professionally calibrated and serviced annually.  The certified technician follows a checklist for weight 
measurement (Forms Appendix) which outlines the procedures for checking the equipment and 
measuring the participant's weight and enters study data on the ANT. 
 
3.3.2.3 Abdominal Girth 
 
The participant is instructed to stand erect and relaxed with the feet approximately 6 inches apart and 
the weight equally distributed on both feet.  The participant is asked to lift the scrub suit top just high 
enough to make the area visible (hands must not go above waist level).  An anthropometric tape is 
applied at the level of the umbilicus (navel) and the participant is instructed to breathe quietly. The 
tape should be snug, but not so tight as to compress tissue  (Figure 2).  The full length mirror or 
recorder verify that the participant is standing erect and that the tape is horizontal.  The measurement 
is recorded to the nearest centimeter at the point of relaxation end exhalation.  The technician follows 
a checklist for the measurement of the maximal abdominal girth (Forms Appendix). 
 
3.3.2.4 Neck Circumference 
 
The participant stands erect, looking straight ahead with the head in the Frankfort horizontal plane as 
described in sections 3.3.2.1 and illustrated in Figure 1. The examiner stands at the side of the 
participant on a footstool, if necessary, so that the examiner's view is at the level of the point of 
measurement. The examiner places the index and middle finger on the thyroid cartilage, commonly 
known as the "Adam's apple." The index finger should be at the point of greatest prominence of the 
thyroid cartilage. The tape is placed below the middle finger, approximating the level of the 
cricothyroid membrane.  The tape is wrapped snugly at this level and is recorded to the nearest 
centimeter. 
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Figure 2. Location of Waist Girth Measurement 

 
 
3.3.5 Quality Assurance 
 
In addition to annual recertification, protocol adherence in the performance of each procedure is 
reviewed at least annually by the by Coordinating Center monitors. Deviations from protocol and 
possible remedial actions are discussed with the Clinic Manager and staff at that time.  Quality control 
observations of technicians by an observer are also performed biannually by Exam Center staff in 
January and July of each year and documented on the Report on Use of Observation and Equipment 
Checklist (see Appendix).  These are sent to the JHS Coordinating Center for review.  Major 
deviations from the protocol are brought to the attention of the Cohort Operations Committee. 
 
Anthropometry equipment is calibrated frequently and results are recorded on an Anthropometry 
Equipment Calibration Log (see Appendix).  Scales are zero balanced daily and calibrated weekly, or 
when moved.  Measuring tapes are checked monthly and replaced as needed.  The number of above 
measurements are recorded on the Report on Use of Observation and Equipment Checklist (see 
Appendix) and sent to the Coordinating Center biannually. 
 
Digit preference, systematic differences in location statistics, completion of checklists/logs according 
to schedule are analyzed by the Coordinating Center. Important quality assurance/control measures 
analyzed include training/certification, instrument checks, random repeatability studies and biannual 
observations of technicians by other technicians and Coordinating Center monitors are monitored and 
reviewed by the Quality Control Committee. 

Waist girth at level of umbilicus 
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3.3.6 Data Collection 
 
The ANT is collected by either the technician (observer) or recorder by direct data entry on a data 
entry screen or on a paper form (see Forms Appendix) for delayed data entry according to QxQ 
instructions. 
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Table 16. Converting To and From Metric Measures 
 
Conversion from Metric Measures 

Symbol When you Know Multiply by To Find Symbol 
Height 
Cm Centimeters 0.3937 inches in 
Weight 
Kg Kilograms 2.2046 pounds lb 

 
 
Conversion to Metric Measures 

Symbol When you Know Multiply by To Find Symbol 
Height 
In Inches 2.54 centimeters cm 
Ft Feet 30.7 centimeters cm 
Weight 
Lb Pounds 0.454 kilograms kg 
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Table 17.  Body Size Measurements: Body Height in Centimeters and Inches 
 

Centimeters Inches  Centimeters Inches 
122 48.0  165 65.0 
123 48.4  166 65.4 
124 48.8  167 65.7 
125 49.2  168 66.1 
126 49.6  169 66.5 
127 50.0  170 66.9 
128 50.4  171 67.3 
129 50.8  172 67.7 
130 51.2  173 68.1 
131 51.6  174 68.5 
132 52.0  175 68.9 
133 52.4  176 69.3 
134 52.8  177 69.7 
135 53.1  178 70.1 
136 53.5  179 70.5 
137 53.9  180 70.9 
138 54.3  181 71.3 
139 54.7  182 71.7 
140 55.1  183 72.0 
141 55.5  184 72.4 
142 55.9  185 72.8 
143 56.3  186 73.2 
144 56.7  187 73.6 
145 57.1  188 74.0 
146 57.5  189 74.4 
147 57.9  190 74.8 
148 58.3  191 75.2 
149 58.7  192 75.6 
150 59.1  193 76.6 
151 59.4  194 76.4 
152 59.8  195 76.8 
153 60.2  196 77.2 
154 60.6  197 77.6 
155 61.0  198 78.0 
156 61.4  199 78.3 
157 61.8  200 78.7 
158 62.2  201 79.1 
159 62.6  202 79.5 
160 63.0  203 79.9 
161 63.4  204 80.3 
162 63.8  205 80.7 
163 64.2  206 81.1 
164 64.6  207 81.5 
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Table 18.  Body Size Measurements: Body Weight in Kilograms and Pounds 
 

Kilograms Pounds  Kilograms Pounds 

48 105.8  81 178.6 
49 108.0  82 180.8 
50 110.2  83 183.0 
51 112.4  84 185.2 
52 114.6  85 187.4 
53 116.8  86 189.6 
54 119.0  87 191.8 
55 121.3  88 194.0 
56 123.5  89 196.2 
57 125.7  90 198.4 
58 127.9  91 200.6 
59 130.1  92 202.8 
60 132.3  93 205.0 
61 134.5  94 207.2 
62 136.7  95 209.4 
63 138.9  96 211.6 
64 141.1  97 213.8 
65 143.3  98 216.1 
66 145.5  99 218.3 
67 147.7  100 220.5 
68 149.9  101 222.7 
69 152.1  102 224.9 
70 154.3  103 227.1 
71 156.5  104 229.3 
72 158.7  105 231.5 
73 160.9  106 233.7 
74 163.1  107 235.9 
75 165.3  108 238.1 
76 167.6  109 240.3 
77 168.8  110 242.5 
78 172.0  111 244.7 
79 174.2  112 246.9 
80 176.4  113 249.1 

 



82 

Exam 1 Cohort Procedures Manual.doc 

 
3.4 Echo 
 
See Manual 6, Echocardiography 
 
3.5 Electrocardiogram 
 
See Manual 5, Electrocardiography 
 
3.6 Sitting Blood Pressure 
 
See Manual 4, Blood Pressure.  See Forms Appendix for Sitting Blood Pressure (SBP) form and QxQ 
instructions. 
 
3.7 Spirometry/Pulmonary Function 
 
See Manual 8, Pulmonary Function Assessment 
 
3.8 Ultrasound 
 
See Manual 7, Ultrasound 
 
3.9 Venipuncture  
 
See Manual 9, Specimen Collection and Processing.  See Forms Appendix for the Venipuncture 
(VEN) form and QxQ instructions.  Exam Center (CXI) and Sample Shipping (SMP) Inventory forms 
are located in Forms Appendix. 
 
3.10 Snack 
 
A light snack is scheduled as soon as possible after venipuncture.  Caffeine-free refreshments are 
provided, including decaffeinated coffee and tea, fruit juices and reduced fat or skim milk.  Menus are 
determined by the Exam Center staff, but will include heart-healthy alternatives. 
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4.0 24 HOUR MONITORING AND TAKE HOME QUESTIONNAIRE 
 
The final component of the baseline examination is a 24-hour post-examination monitoring of 
participant’s ambulatory blood pressure and routine physical activity. Also included is collecting a 24-
hour urine specimen and responding to a self-administered questionnaire to assess daily hassles and 
moods.  Participants consenting to this 24-hour component of the examination will be fitted with a 
blood pressure cuff and waist-belt monitor, and a fanny-pack accelerometer and step counter.  These 
monitoring devices will be initialized in the clinic and careful instructions provided to participants. 
 
When possible, 24-hour urine collections will be initiated at the conclusion of the baseline 
examination before the participant leaves the clinic. Instructions for collecting urine until the same 
item on the following day will be provided.  Individual arrangements will be made for participants who 
desire to delay the onset of these 24-hour measures.  All participants will complete a set of take-
home questionnaire to assess daily hassles, minor stressors and moods.  All 24-hour measures will 
be picked up at a place that is convenient for the participant.  If desired, participants may return 
monitors, samples, and questionnaires to the JHS clinic. 
 
4.1 Ambulatory Blood Pressure Monitoring 
 
See Manual 4, Blood Pressure.   
 
4.2 24-Hour Urine Collection 
 
See Manual 7, Specimen Collection and Processing.  
 
4.3 24-Hour Physical Activity Monitoring 
 
Concurrent 24-hour physical activity monitoring (PAM) and ambulatory blood pressure monitoring 
(ABPM) will provide an objective measure of physical activity that, in the absence of participant 
diaries with information about activity preceding and during the cuff inflation, will aid in interpreting the 
blood pressure and heart rate data. Few studies have attempted such concurrent measurement, thus 
data from JHS will make a significant contribution to understanding the correlations between daily 
physical activity and blood pressure. 
 
4.3.1 Background, Rationale, Hypotheses 
 
See sections 1.6.4.8 and 11 for a full discussion of the background, rationale and hypotheses for 
physical activity questions and monitoring. 
 
4.3.2 Data Collection 
 
Data will be collected on all participants who agree to participate in the 24-hour ABPM. Participants 
will be instructed on the PAM equipment and will be fitted with (1) a CSA (Computer Science 
Applications, Inc, Shalimar FL) activity monitor (accelerometer) in its protective pouch and (2) a 
Digiwalker step counter, which are worn secured by a belt at the waist. The CSA monitor and step 
counter will be picked up 24 hours later by the JHS Sample Coordinator. 
 
4.3.2.1 Initializing Measurement Instruments, Collection and Downloading of Activity 
Monitor Data 
 
4.3.2.1.1 CSA Monitor 
 
Prior to fitting the participant, the CSA monitor is initialized by connecting it to its host computer at the 
Exam Center and running the CSA software program for initialization.  The instructions are pasted 
near the computer and activity monitor interface.  The study staff member responds to queries to set 
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the date and time for beginning data collection and checks for the signal that the unit has been 
successfully activated. The monitor will then collect and store data at the intervals specified until it 
receives signals to download via the host computer interface. Data will be downloaded on return of 
the instrument to the Exam Center.  To download, the CSA monitor is connected to its host computer 
using the interface equipment and the stored information is retrieved using the appropriate CSA 
software. The data file is given a unique name to allow linking of the data to the individual participant 
who wore the monitor.  Detailed instructions for use of the accelerometer (CSA monitor), including 
initializing files and downloading data files using the computer interface, can be found in the CSA 
Monitor Manual supplied by the vendor and kept in the Exam Center.  The PAM data will be stored on 
a dedicated computer with the CSA interface system and software, with the data backed up at least 
weekly on a zip disk and transferred at least every three months to the JHS CC. 
 
To facilitate interpretation of the ABPM and CSA monitor data, the time on the ABPM should be set to 
match the time on the host computer for the CSA monitors.  This will be done by setting the date and 
time on both computers to a designated Exam Center clock.  Time synchronization will be checked 
weekly.  Software developed by the manufacturer will be used to interpret the data collected during 
the monitoring period. 
 
4.3.2.1.2 Step Counter 
 
The step counter is  initialized by setting the step counter to "0" just before fitting it to the participant. 
The participant will be instructed not to re-set the counter during the monitoring period. The total 
steps will be recorded when the step counter is retrieved by the Sample Coordinator. 
 
4.3.2.2 Participant Instructions and Fitting of Monitor 
 
Both the CSA monitor and step counter are worn on a belt fitted to the participant.  The CSA monitor 
is worn to the right side and the step counter is worn to the left.  The CSA monitor and step counter 
should be worn while awake except while bathing or swimming. To protect the electronics, the 
equipment should not be immersed in water and should be protected from excess heat and sunlight. 
The accelerometer (CSA  monitor) will be programmed to record activity at one minute intervals. The 
participant will be unaware of the CSA monitoring as the instrument operate silently and there is no 
display to provide feedback. The step counter may click softly as the participant moves about, and the 
cumulative step count is visible when the case is opened. Participants will not be given feedback 
about the meaning of the step counts, such as what is a "good" number of steps to achieve. If they 
ask, they should be told that the purpose of the study is to help get answers to this question.  Experts 
have not determined how many steps are related to healthy activity in women and men of different 
ages and body types.   
 
Prior to leaving the Exam Center with the CSA monitor and step counter, the participant will be given 
an additional opportunity to ask questions or express concerns. S/he will be given a one-page 24-
Hour Physical Activity Monitor Instructions sheet (see Appendix) summarizing information about when 
and how to wear the monitor and providing a contact number if needed. The participant can remove 
the step counter and CSA monitor to bathe and sleep or if necessary for other reasons by simply 
unfastening the belt clasp. No other action is required except placing the belt and monitors in a safe 
place where they will not be dropped, stepped on, or misplaced. The CSA monitor data will reveal 
quiescent periods when the monitor was not moved, so removal of the monitor can often be inferred 
from the data. The step counter data will be most valuable if participants can recall when they 
removed it and when they put it back on so that the cumulative step count can be adjusted for hours 
worn.  Participants will be instructed not to take the CSA monitor out of its pouch.  It is especially 
important that participants do not try to open the monitors because the electronics are easily 
damaged.   
 
Arrangements will be made for the return (pickup) of the activity monitor the following day. Information 
documenting the explanation, participant agreement to wear the monitors, CSA and step counter 
monitor ID numbers initialization and time synchronization with the ABPM and the start time of PAM 
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are recorded on the Pre 24-Hour Activity Monitoring Form (BPA) (see Forms Appendix). Details for 
completing this form are contained in the QxQ instructions in the Forms Appendix. 
 
4.3.2.3 Monitor Retrieval 
 
A Sample  Coordinator will pick up the accelerometer and step counter approximately 24-hours after 
fitting in the clinic. The Post 24-Hour Physical Activity Monitoring form (PPA) (see Forms Appendix) is 
completed to record the date and time of pick-up, any time the participant did not wear the CSA and 
step counter monitors, and any difficulties encountered. Detailed instructions for completing each item 
are included in the QxQ instructions in the Forms Appendix.  The monitors are returned to the Exam 
Center for subsequent data downloading. Upon return of the instrument to the Exam Center, a trained 
staff or research associate will transfer the information to the host computer using the downloading 
procedure.  Additional information will be entered on the PPA form at this time. 
 
4.3.3 Data Management 
 
Upon return of the instrument to the Exam Center, a study staff member will transfer the information 
from the CSA monitor to the host computer and name the data file so that it can be linked to the 
appropriate participant(s). This file name is entered on the PPA form  These individual participant 
CSA files will be named using the participant's JHS identification number as follows C[7 digit JHS 
participant number].dat. 
 
Data from the CSA monitors will be initially stored and checked on the dedicated PAM computer. The 
investigator or a trained study assistant will do initial data screening. Downloaded data from the CSA 
accelerometer monitoring will consist of time markings associated with activity/motion readings. 
Software is also provided to calculate estimates of kilocalorie expenditure per unit of time while the 
monitor is worn. The CSA files will be read into Microsoft Excel for further analysis. The original and 
derived data files will be backed up at least weekly on zip disks and sent to the CC on a quarterly 
basis for merging with other JHS data. 
 
An expert consultant experienced in the use of activity monitors in field trials will provide training to 
the individuals responsible for implementing the CSA PAM. Thereafter, the major investigator for this 
component of the study will direct the data reduction, oversee training for study staff who assist in this 
work, and certify their competency in these activities. Valid activity counts per time period will be 
examined in relation to other variables. 
 
4.3.4 Quality Control 
 
Following training, study staff will give return demonstrations of the procedure for the activity 
monitoring. The PAM principal investigator will certify them after 5 successful demonstrations. 
Thereafter the investigator will request unannounced demonstrations of the procedures at least every 
6 months with re-certification to occur annually. One adequate complete execution of PAM will be 
required for re-certification. The investigator will review the CSA monitor data files on a regular basis 
to check the quality of the data. The software for the CSA instruments assists in filtering out data 
points that are incompatible with human motion. 
 
The outer surface of the step counters will be wiped clean with isopropyl alcohol wipes between  use 
by different participants.  When necessary, the CSA monitors may be wiped clean with a soft cloth 
moistened in soap and water, or their surfaces can be sanitized using isopropyl alcohol wipes.  They 
should not be immersed in liquid or subjected to corrosive substances. When necessary, the belts 
and protective pouches can be washed in cool water with a mild detergent and air-dried. 
Demonstration of procedures for maintaining equipment will be observed on a monthly basis by the 
Clinic Manager and reviewed annually as part of the re-certification requirements. 
 
The CSA monitors will require battery replacement, typically after 9 to 10 hours of continued use. 
Lithium coin cell batteries designated in the industry as CR2430 must be used. Several acceptable 
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brands have been identified in the manual supplied by the vendor. Estimated battery life remaining is 
displayed each time the instrument is initialized. Battery life will be significantly shorter if the monitors 
are used for 3 days or more continuously without downloading data. Battery replacement must be 
done carefully to avoid damaging the electronics and will be done only by staff approved by the 
investigator for the PAM. 
 
4.4 Hassles and Mood Inventory 
 
The Hassles and Mood Inventory is a participant self-administered questionnaire to assess daily 
hassles and minor stress, mood and strong emotions such as anger and hostility.  The Hassles and 
Mood Inventory is comprised of four standardized measures of weekly stress, depression, anger and 
hostility. 
 
Training, certification and quality assurance for the Hassles and Mood Inventory are described in 
sections 2.3, 2.4 and 2.5. 
 
4.4.1 Hassles and Moods A: Minor Stress (WSI) 
 
Minor stressful life events will be assessed using the Hassles and Moods A: Weekly Stress Inventory 
(WSI) (see Forms Appendix), an 87-item checklist of minor stressors (Mosley, et al., 1996).  
Participants are asked to indicate whether an event occurred during the past week, and if so, to rate 
the amount of stress that the event caused on a 7-point Likert-type scale (1 = not stressful; 7 = 
extremely stressful). The WSI is a standardized questionnaire and will be administered to all 
participants in the Take Home Questionnaires following the baseline exam, as one of the measures 
making up the Hassles and Mood Inventory.  The undesirable stressful events on the WSI were 
derived from the stress-monitoring of a large sample of community adults and from selected items 
modified from other established minor life event inventories.  The WSI has been validated in a sample 
of CHD patients in Mississippi (Mosley, et al., 1996). 
 
4.4.1.1 Background, Rationale and Hypotheses 
 
Exposure to stress, both acute events and chronic burden, has been related to CHD risk (Lepore, 
1995).  The frequency and types of stressors experienced by an individual may be influenced by 
broad societal factors operating on a given segment of the population.  Stress exposure has been 
related to social class and, to a lesser extent, ethnicity and thus may contribute to SES or ethnic 
differences in CHD risk.  In the JHS, we will assess 3 types of stress exposure:  major life events (at 
annual follow-up), minor life events, and chronic stress (as part of the HII). 
 
Minor life events differ from major life events in that they occur more frequently and individually have 
a less severe negative impact upon the individual (Brantley, et al., 1997).  Minor stressors and 
chronic stressors, in contrast to more time-limited and episodic major life events, may provide a more 
plausible theoretical link to the development of diseases that have a gradual long-term onset, such as 
CHD. 
 
Hypotheses include: 
 
1. High stress will be associated with an increased risk of hypertension and CHD events 

independent of the contribution of traditional CHD risk factors. 

2. The relationship observed between stress, hypertension, and CHD events will be moderated by 
social support, coping style, SES, and education. 

4.4.1.2 References 
 
Mosley, T. H., Jr., Payne, T. J., Plaud, J. J., Johnson, C. A., Wittrock, D. A., Seville, J. L., Penzien, D. 
B., & Rodriguez, G.  (1996).  Psychometric properties of the Weekly Stress Inventory (WSI):  
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Extension to a patient sample with coronary heart disease.  Journal of Behavioral Medicine, 19, 273-
287. 

Lepore, S. J. (1995).  Measurement of chronic stressors.  In S. Cohen, R. C. Kessler, & L. U. Gordon 
(Eds.).  Measuring stress:  A guide for health and social scientists (pp. 102-120).  New York, NY: 
Oxford University Press. 

Brantley, P. J., Waggoner, C. D., Jones, G. N., & Rappaport, N. B. (1987).  A daily stress inventory: 
Development, reliability and validity.  Journal of Behavioral Medicine, 10, 61-74. 

4.4.1.3 Administration 
 
The WSI will be administered to all participants, as a paper-and-pencil questionnaire, as one of the 
four measures making up the Hassles and Mood Inventory.  Following the JHS baseline exam, 
participants will be provided with the Hassles and Mood Inventory.  Participants will be asked to 
complete the packet of questionnaires at home.  Participants will be read a general statement 
explaining the instructions for completing the packet of questionnaires and briefly explaining the 
rationale (see Appendix).  The completed questionnaires will be picked up from the participant’s 
home by the Sample Coordinator.  When picking up the Hassles and Mood Inventory, Sample 
Coordinator will check the questionnaires for completeness and will offer assistance to those who 
may have had difficulty completing the questionnaires (e.g., due to illiteracy, visual deficit, etc.).  
Detailed instructions for the WSI are provided in the QXQ instructions (see Forms Appendix). 
 
4.4.1.4 Data Collection 
 
The WSI will be completed on paper, self-administered in the participant’s home.  When necessary, 
interviewer assistance will be available.  Subsequently, the WSI data will be entered into the data 
entry system by clinic staff. 
 
4.4.1.5 Scoring/Coding 
 
The WSI yields two summary scores: (a) the number of stressful events endorsed (WSI-Event), and 
(b) the sum of the subjective ratings assigned to the endorsed events (WSI-Impact). 
 
4.4.2 Hassles and Moods B: Depression  (CES-D) 
 
The Hassles and Moods B: Center for Epidemiologic Studies Depression Scale (CES-D) (see Forms 
Appendix) will be used to assess depressive symptoms.  The CES-D is a standardized, 20 item, 
self-report instrument developed by the National Institute of Mental Health to measure the frequency 
of recently experienced depressive symptoms (Radloff, 1977).  Participants are asked about her/his 
mood over the past week, responding to each item as to how often they felt “this way.”  Item ratings 
range from rarely or none of the time, to most or all of the time.  The CES-D will be administered to all 
participants in the Take Home Questionnaires following the baseline exam, as one of the measures 
making up the Hassles and Mood Inventory.  In addition to four subscale factors, a total score may be 
calculated with recommended cut offs suggestive of clinical depression (Radloff, 1997). 
 
4.4.2.1 Background, Rationale and Hypotheses 
 
Depression has been linked to CHD in several studies (Booth-Kewley, 1987; King, 1997).  To date, 
most of the studies on depression have focused on its relationship with morbidity or mortality 
following a coronary event (Frasure-Smith, et al., 1993; 1995).  A literature is accumulating, however, 
that depression also increases risk of incident myocardial infarction and related CHD events in 
community samples (Anda, et al., 1993; Barefoot & Schroll, 1996; Pratt, et al., 1996; Hippersly-Cox, 
et al., 1998; Sesso, et al., 1998; Mendes de Leon, et al., 1998; Whooley, et al., 1998). 
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Hypotheses include: 
 
1. Negative emotions will be associated with an increased risk of hypertension, CHD events, and 

mortality independent of the contribution of traditional CHD risk factors. 

2. The relationship observed between negative emotions, hypertension, and CHD events will be 
moderated by social support, coping style, SES, and education. 

4.4.2.2 References 
 
Radloff, L.S. (1977).  The CES-D scale:  A self-report depression scale for research in the general 
population.  Applied Psychological Measurement, 1, 385-401. 

Booth-Kewley, S., & Friedman, H.S. (1987).  Psychological predictors of heart disease: A quantitative 
review. Psychological Bulletin, 101, 343-362. 

King, K. B. (1997). Psychologic and social aspects of cardiovascular disease. Annals of Behavioral 
Medicine, 19, 264-270. 

Frasure-Smith, N., Lesperance, F., & Talajic, M. (1993). Depression following myocardial infarction: 
Impact on 6-month survival. JAMA, 270, 1819. 

Frasure-Smith, N., Lesperance, F., & Talajic, M. (1995). Depression and 18-month prognosis 
following myocardial infarction. Circulation, 91, 999. 

Anda, R., Williamson, D., Jones, D., et al. (1993).  Depressed affect, hopelessness, and the risk of 
ischemic heart disease in a cohort of U. S. adults.  Epidemiology, 4, 285-294. 

Barefoot JC, Schroll M. (1996). Symptoms of depression, acute myocardial infarction, and total 
mortality in a community sample.  Circulation, 93, 1976-1980. 

Pratt LA, Ford DE, Crum RM, et al. (1996).  Depression, psychortropic medication, and risk of 
myocardial infarction: Prospective data from the Baltimore ECA follow-up. Circulation, 94, 3123-3129. 

Hippisley-Cox J, Fielding K, Pringle M. (1998). Depression as a risk factor for ischaemic heart 
disease in men: Population based case-control study. BMJ, 316, 1714-1719. 

Sesso HD, Kawachi I, Vokonas PS, et al. (1998). Depression and the risk of coronary heart disease 
in the Normative Aging Study. Am J Cardiol, 82, 51-856. 

Mendes de Leon CF, Krumholz HM, Seeman TS, et al. (1998). Depression and risk of coronary 
disease in elderly men and women. Arch Intern Med, 158, 2341-2348. 

Whooley MA, Browner WS for the Study of Osteoporotic Fractures Research Group. (1998). 
Association between depressive symptoms and mortality in older women. Arch Intern Med. 158:2129-
2135. 

4.4.2.3 Administration 
 
The CES-D will be administered to all participants, as a paper-and-pencil questionnaire, as one of the 
four measures making up the Hassles and Mood Inventory.  Following the JHS baseline exam, 
participants will be provided with the Hassles and Mood Inventory.  Participants will be asked to 
complete the packet of questionnaires at home.  Participants will be read a general statement 
explaining the instructions for completing the packet of questionnaires and briefly explaining the 
rationale (see Appendix).  The completed questionnaires will be picked up from the participant’s 
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home by the Sample Coordinator.  When picking up the Hassles and Mood Inventory, the Sample 
Coordinator will check the questionnaires for completeness and will offer assistance to those who 
may have had difficulty completing the questionnaires (e.g., due to illiteracy, visual deficit, etc.).  
Detailed instructions for the CES-D are provided in the QXQ instructions (see Forms Appendix). 
 
4.4.2.4 Data Collection 
 
The CES-D will be completed on paper, self-administered in the participant’s home.  When needed 
interviewer assistance will be available.  Subsequently, the CES-D data will be entered into the data 
entry system by clinic staff. 
 
4.4.2.5 Scoring/Coding 
 
The CES-D yields a total score as well as 4 possible subscale factors.  Total scores range from 0 to 
60, with higher scores indicating greater frequency of depressive symptoms.  The total score is 
computed as the sum of the items, with items scored from 0 to 3 (0 = rarely, 3 = most).  Items 4, 8, 
12, and 16 are reverse-scored (rarely = 3, most = 0). 
 
4.4.3 Hassles and Moods C: Hostility (CHO) 
 
Hostility will be assessed using the Hassles and Moods C: CHOST (CHO) (see Forms Appendix), a 
27-item, true-false, self-report questionnaire (Barefoot, et al., 1989).  The CHO is a standardized 
questionnaire derived from the Cook-Medley Hostility Scale and assesses experiential hostility, that is 
an attitude of cynicism, suspiciousness, mistrust, or resentful feelings towards others.   The CHO will 
be administered to all participants in the Take Home Questionnaires following the baseline exam, as 
one of the measures making up the Hassles and Mood Inventory.  The Composite Hostility Score 
(CHO) has been found to be a better predictor of mortality (Barefoot, et al., 1989), myocardial 
ischemia, (Helmers, et al., 1993) and of cardiovascular responses (Suarez, et al., 1993) compared 
with the total score from the longer Cook-Medley Hostility Scale. 
 
4.4.3.1 Background, Rationale and Hypotheses 
 
Several negative emotions have been identified as possible risk factors for coronary heart disease 
(CHD) (Booth-Kewley, et al., 1987).  The negative or "coronary-prone" emotions have been found to 
influence the incidence, symptom expression, morbidity and mortality associated with CHD. 
 
Chronic anger and hostility have emerged as the primary (toxic) components thought to underlie 
associations between Type A personality and CHD.  Several epidemiologic studies have found that 
chronic anger and/or maladaptive anger coping styles are associated with an increased risk of CHD-
related morbidity and mortality (Barefoot, et al., 1989; Barefoot, et al., 1983; Haynes, et al., 1980).  
Anger has also been associated with all-cause mortality in a number of studies (Miller, et al., 1996).  
Anger is not a unitary construct.  The measures of anger selected for use in the JHS assess key 
components of this multidimensional construct, i.e., cynicism and anger expression. 
 
Hypotheses include: 
 
1. Anger will be associated with an increased risk of hypertension, CHD events, and mortality 

independent of the contribution of traditional CHD risk factors. 

2. The relationship observed between anger, hypertension, and CHD events will be moderated by 
social support, coping style, SES, and education. 
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4.4.3.2 References 
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MedleyHostility Scale: Item content and ability to predict survival. Psychosomatic Medicine, 51, 46-
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Helmers, K. F., Krantz, D. S., Howell, R., Klein, J., Bairey, N., & Rozanski, A. (1993).  Hostility and 
myocardial ischemia in coronary artery disease patients:  Evaluation by gender and ischemic index. 
Psychosomatic Medicine, 55, 29-36. 
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Barefoot, J.C., Dahlstrom, W.G., & Williams, R.B. Jr. (1983).  Hostility, CHD incidence and total 
mortality: A 25-year follow-up study of 255 physicians. Psychosomatic Medicine, 45, 59-63. 

Barefoot, J.C., Larsen, S., von der Lieth, L., et al. (1995).  Hostility, incidence of acute myocardial 
infarction, and mortality in a sample of older Danish men and women. Am J Epidemiol, 142, 477-84. 

Dembroski, T.M., MacDougall, J.M., Costa, P.T. Jr., & Grandits, G.A. (1989). Components of hostility 
as predictors of sudden death and myocardial infarction in the Multiple Risk Factor Intervention Trial. 
Psychosomatic Medicine, 51, 514-522. 

Everson, S.A., Kauhanen, J., Kaplan, G.A., Goldberg, D.E., Julkunen, J., Tuomilehto, J., & Salonen, 
J.T. (1997). Hostility and increased risk of mortality and acute myocardial infarction: The mediating 
role of behavioral risk factors. American Journal of Epidemiology, 146,142-152. 

Kawachi, I., Sparrow, D., Spirro, A. III, Vokonas, P., Weiss, S.T. (1996).  A prospective study of anger 
and coronary heart disease:  The Normative Aging Study. Circulation, 94, 2090-2095. 

Haynes S.G., Feinleib M., Kannel W.B. (1980). The relationship of psychological factors to coronary 
heart disease in the Framingham study: III. Eight-year incidence of coronary heart disease. American 
Journal of Epidemiology, 111, 37-58. 

Miller, T.Q., Smith, T.W., Turner, C.W., Guijarro, M.L., & Hallet, A.J. (1996).  A meta-analytic review 
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4.4.3.3 Administration 
 
The CHO will be administered to all participants, as a paper-and-pencil questionnaire, as one of the 
four measures making up the Hassles and Mood Inventory.  Following the JHS baseline exam, 
participants will be provided with the Hassles and Mood Inventory.  Participants will be asked to 
complete the packet of questionnaires at home.  Participants will be read a general statement 
explaining the instructions for completing the packet of questionnaires and briefly explaining the 
rationale (see Appendix).  The completed questionnaire will be picked up from the participant’s home 
by the Sample Coordinator.  When picking up the Hassles and Mood Inventory, the Sample 
Coordinator will check the questionnaires for completeness and will offer assistance to those who 
may have had difficulty completing the questionnaires (e.g., due to illiteracy, visual deficit, etc.).  
Detailed instructions for the CHO are provided in the QXQ instructions (see Forms Appendix). 
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4.4.3.4 Data Collection 
 
The CHO will be completed on paper, self-administered in the participant’s home.  When necessary 
interviewer assistance will be available.  Subsequently, the CHO data will be entered into the data 
entry system by clinic staff. 
 
4.4.3.5 Scoring/Coding 
 
Three subscale scores are derived from this instrument: Cynicism (13 items), Hostile Affect (5 items), 
and Aggressive Responding (9 items). One point is assigned for each true response, except for items 
18 and 21, which are reverse-scored, i.e., 1 point each for a false response. The specific subscale-
item assignments follow below (“R” indicates reverse scoring): 
 

Dimension     Items 

Cynicism     1, 2, 3, 4, 5, 6. 7, 8, 9, 10, 11, 12, 13 

Hostile Affect     14, 16, 17, 21R, 24 

Aggressive Responding   15, 18R, 19, 20, 22, 23, 25, 26, 27 

 

4.4.4 Hassles and Moods D: Anger (STX) 
 
The Hassles and Moods D: Spielberger Anger Expression Inventory (STX) (see Form Appendix) will 
assess anger expression using the 16-item anger-in and anger-out subscales of the standardized 
STX (Spielberger, et al., 1988).  Participants are asked to describe her/his reactions when feeling 
angry, by rating how often they react in the manner described by each item.  Each item is rated on a 
5-point, Likert-type scale from never (1) to almost always (4).  The STX will be administered to all 
participants in the Take Home Questionnaires following the baseline exam, as one of the measures 
making up the Hassles and Mood Inventory. 
 
4.4.4.1 Background, Rationale and Hypotheses 
 
Several negative emotions have been identified as possible risk factors for coronary heart disease 
(CHD) (Booth-Kewley, et al., 1987).  These negative or "coronary-prone" emotions have been found 
to influence the incidence, symptom expression, morbidity, and mortality associated with CHD. 
 
Chronic anger and hostility have emerged as the primary (toxic) components thought to underlie 
associations between Type A and CHD.  Several epidemiologic studies have found that chronic anger 
and/or maladaptive anger coping styles are associated with an increased risk of CHD-related 
morbidity and mortality (Barefoot, et al., 1989; Barefoot, et al., 1983; Barefoot, et al., 1995; 
Dembroski, et al., 1989; Everson, et al., 1997; Kawachi, et al., 1996; Haynes, et al., 1980).  Anger 
has also been associated with all-cause mortality in a number of studies (Miller, et al., 1996).  Anger 
is not a unitary construct.  The measures of anger selected for use in the study assess key 
components of this multidimensional construct, i.e., cynicism and anger expression. 
 
Hypotheses include: 
 
1. Anger will be associated with an increased risk of hypertension, CHD events, and mortality 

independent of the contribution of traditional CHD risk factors. 

2. The relationship observed between anger, hypertension, and CHD events will be moderated by 
social support, coping style, SES, and education. 
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Miller, T.Q., Smith, T.W., Turner, C.W., Guijarro, M.L., & Hallet, A.J. (1996).  A meta-analytic review 
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4.4.4.3 Administration 
 
The STX will be administered to all participants, as a paper-and-pencil questionnaire, as one of the 
four measures making up the Hassles and Mood Inventory.  Following the JHS baseline exam, 
participants will be provided with the Hassles and Mood Inventory.  Participants will be asked to 
complete the packet of questionnaires at home.  Participants will be read a general statement 
explaining the instructions for completing the packet of questionnaires and briefly explaining the 
rationale (see Appendix).  The completed questionnaire will be picked up from the participant’s home 
by the Sample Coordinator.  When picking up the Hassles and Mood Inventory, the Sample 
Coordinator will check the questionnaires for completeness and will offer assistance to those who 
may have had difficulty completing the questionnaires.  Detailed instructions for the STX are provided 
in the QXQ instructions (see Forms Appendix). 
 
4.4.4.4 Data Collection 
 
The STX will be completed on paper, self-administered in the participants home.  When needed, 
interviewer assistance will be available.  Subsequently, the STX data will be entered into the data 
entry system by clinic staff. 
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4.4.4.5 Scoring/Coding 
 
Two scores are calculated from the STX, anger-in and anger-out.  Each item is rated on a 5-point, 
Likert-type scale from never (assigned 1 point) to almost always (assigned 4 points). The instrument 
is scored by summing the responses to items for each of the two subscales.  Thus the minimum 
score for a subscale is 8 and the maximum is 32. The specific subscale-item assignments are follows: 
 

Dimension    Items 

Anger-In    2, 3, 4, 7, 9, 11, 12, 14 

Anger-Out    1, 5, 6, 8, 10, 13, 15, 16 
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5.0 MEDICAL DATA REVIEW 
 
 
Through the participants’ informed consent and the cover letters for the final results reports sent to 
the cohort and their health care providers it is made clear that the interviews and exam components 
are not a substitute for regular medical care.  One of the benefits to participants, however, is the 
summary of clinically relevant results distributed by the Exam Center at the conclusion of, and several 
weeks following the baseline clinical exam.  At the end of the Exam Center visit, participant interview 
and examination data are reviewed by the trained staff to provide the participant with a summary of 
study results for height, weight, sitting blood pressure and a preliminary report of the ECG and PFTs 
(see Appendix).  Participants are reminded that additional clinically relevant data will be processed at 
the Central Lab and Reading Centers and will not be available for several weeks. 
 
5.1 Rationale 
 
The primary objectives of the Medical Data Review are to safeguard participant safety and to inform 
the participant of findings detected during the clinical components and through responses to the 
interview/questionnaires.  Clinical and interview data are reviewed with participants to confirm 
selected positive symptoms reported during the interviews/exams and to determine if these appear to 
warrant immediate (same day), urgent (same week) or routine medical follow-up.  Conditions 
requiring emergency referral are dealt with as soon as observed and, in general, have been dealt with 
before the Medical Data Review takes place.   For example, cardiac events, blood pressure readings 
> 210/120 mm Hg and acute pattern abnormalities detected on the ECG are attended to as soon as 
observed.  Table 19 indicates the classification of blood pressure for adults.  The JHS physician is 
consulted, the clinic visit terminated, the person referred for immediate medical care, and a return 
visit to complete missed procedures and interviews is scheduled as appropriate.  Persons with 
elevated blood pressures less than 210/120 mm Hg are referred to her/his source of medical care at 
the Medical Data Review following the guidelines shown in Table 20.  Likewise, observations of an 
ECG abnormality identified as major in Table 21 are reviewed by a JHS physician on call before the 
participant leaves the Exam Center. 
 
When clinically relevant laboratory data processed at the study's central agencies (laboratories and 
reading centers) have been received at the Exam Center, the data are again reviewed prior to 
producing summary reports for participants and her/his physicians.  As part of this review, JHS 
clinical personnel again may recommend follow-up if symptoms/conditions appear to warrant further 
medical attention. 
 
At the Exam Center, participants' clinically relevant data are reviewed at three levels.  The first review 
takes place during the Medical Data Review (see below, section 5.3), which is conducted after all 
interviews and physical exams have been completed and data have been assembled as part of the 
data inventory step (section 5.2).  The second and third levels of medical data review take place after 
data processed at the study's central agencies are returned to the Exam Centers and are reviewed by 
study clinicians and summarized for inclusion in the final results reports that are mailed to participants 
and her/his providers of medical care. 
 
5.2 Data Inventory 
 
The data inventory step initiates the last fixed component of the Exam Center examination sequence  
and is done after all interviews and examination procedures have been completed in preparation for 
the Medical Data Review.  Participant data are collected by various means during the course of the 
baseline exam and require summarization and placement in the participant's folder for nurse/clinician 
review. 
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5.2.1 Rationale 
 
Although the JHS study does not diagnose or treat any medical condition, the participant's health and 
safety is of paramount concern.  Therefore, data collected during the examination that could indicate 
the need for immediate (same day), urgent (within one week) or routine (within one to two months or 
first convenient appointment) referral for medical care (Table 21) are put together into one document, 
the Medical Data Review Printout (see Appendix), and reviewed with the participant prior to the 
completion of the examination. 
 
5.2.2 Procedures 
 
A staff person reviews the participant itinerary to determine that all interviews and procedures have 
been completed, checks participants’ folders to verify that they contain the paper versions of the 
forms to be completed by JHS staff, and reviews participants’ self-administered forms to determine 
completeness of the forms and to determine the necessity of assistance in completing the forms.  
After completion of the baseline exam and confirmation of quality control procedures, participants are 
invited to change back into street clothes while the data are being prepared for the medical data 
review. 
 
5.2.3 Training 
 
The Clinic Manager is responsible for training the personnel charged with data inventory, and the 
assembly of study materials for the Medical Data Review. 
 
5.2.4 Certification 
 
Certification for data inventory is the responsibility of the Clinic Manager.  No recertification is 
required, but staff performance is monitored by the Clinic Manager. 
 
5.2.5 Quality Assurance 
  
Quality assurance consists of observation by the supervisor and retraining or corrective action, as 
required. 
 
5.3 Procedures 
 
Trained staff conduct the medical data review to  

1. summarize the results of selected measurements obtained during the baseline exams/interviews 

2. determine whether a reported stroke/TIA symptom(s) constitute a possible CVA 

3. identify potential medical problems 

4. answer participant questions 
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Table 19.  Classification of Blood Pressure for Adults, Based on Joint National Committee on 
Detection, Evaluation and Treatment of High Blood Pressure (JNC-VI, 1997) 
Guidelines 

 
Category 

SBP 
(mm Hg) 

 DBP 
(mm Hg) 

Optimal <120 and <80 

Normal < 130 and < 85 

High normal 130-139  85-89 

Hypertension    

Stage 1 140-159 or 90-99 
Stage 2 160-179 or 100-109 
Stage 3 > 180 or > 110 

 
 
When SBP and DBP fall into different categories, use the higher category. 
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Table 20. Medical Care Referral Guidelines for Blood Pressure, Based on Joint National 
Committee on Detection, Evaluation and Treatment of High Blood Pressure  
(JNC-VI, 1997) Guidelines 

Referral 
Classification 

Examination 
Findings 

Recommendation to Participant1 Explanation 
to 

Participant 

Emergency Referral SBP > 260 

or  
DBP > 130 

Transportation to emergency care 
facility. Stop exam and reschedule 
clinic visit. 

Your BP is 
very high. 

Immediate Referral SBP 210-259 
or  

DBP 120-129 

Consult with JHS MD.  Refer to 
source of care immediately (today). 
Stop exam and reschedule clinic visit. 

Your BP is 
very high. 

Urgent Referral SBP 180-209 
or  

DBP 110-119 

Consult with JHS MD and proceed 
unless otherwise indicated. Refer to 
source of care within 1 week. 

Your BP is 
high. 

Routine Referral SBP 160-179 
or  

DBP 100-109 

Refer to source of care within 1 
month. 

Your BP is 
elevated. 

 SBP 140-159 
or  

DBP 90-99 

Refer to source of care within 2 
month. 

Your BP is 
elevated. 

No Referral SBP 130-139 
or  

DBP 85-89 

Recheck in 1 year (no JHS referral) Your BP is 
high normal. 

 SBP < 1302 
or  

DBP < 852 

Recheck in 2 years (no JHS referral) Your BP is 
normal. 

 

1  If the systolic and diastolic categories are different, follow recommendations for the shorter time 
follow-up (e.g., 160/85 mm Hg should be evaluated or referred to source of care within 1 month). 
2  Unusually low readings should be evaluated for clinical significance. 
 
In summary, factual information is given to participants about her/his results during the Medical Data 
Review, identifying abnormalities and recommending referral as needed, but avoiding medical advice 
about prognosis, prevention or therapy.  Physician back-up is available at all times.  
 
5.4 Training 
 
Staff are trained for the Medical Data Review tasks by the Exam Center Clinic Manager. 
 
5.5 Certification 
 
The Exam Center Clinic Manager is responsible for certification of the clinicians responsible for 
medical data review. 
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5.6 Quality Assurance 
 
The Exam Center PI is responsible for ensuring that the medical data review, referrals and reporting 
of results are done according to procedures in the JHS protocol. 
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6.0 REFERRALS AND REVIEW GUIDELINES 
 
 
6.1 Rationale 
 
Participants are referred based on the guidelines for referral listed below (Table 21).  Prior to the 
Medical Data Review (described in section 5), a data entry utility system retrieves affirmative 
responses (from the questionnaires) to key items indicative of hypertension, diabetes, ischemic heart 
disease, hypercholesterolemia, cancer, uterine bleeding, chest pain on effort, congestive heart failure, 
TIA/stroke, and intermittent claudication.  Guidelines for conducting the Medical Data Review are 
provided in the Medical Data Review instructions. 
 
Referrals for follow-up care can be made at the Medical Data Review or in subsequent 
communications.  Uniform criteria for emergency, immediate, urgent and routine referrals have been 
established, (section 5.1.2), and are summarized in Table 20 and 21.  Sources of medical care for 
participants who do not have a health care provider will be identified in consultation with the 
representatives of the local medical community.  All referrals are documented on a separate 
Report/Referral Form (REF) and the JHS Alert/Referral log (ALT) (see Forms Appendix).  Detailed 
QxQ instructions are specified in the Forms Appendix. 
 
6.2 Procedures 
 
Referrals are made during the Medical Data Review or upon receipt of the study’s clinically relevant 
data, which follow the criteria listed below. 
 
1. Emergency Referral.  Transportation to the nearest emergency care facility is provided or an 

emergency squad is called. 

2. Immediate Referral.  The participant is urged to see her/his health care provider within one day. 

 
The nurse/clinician consults with the JHS physician, and the participant’s health care provider is 
called.  The participant’s health care provider is also sent a letter of explanation (see Appendix). 
 
Participants who have no health care provider are referred based on consultation with a provider in 
the community. 
 
3. Urgent Referral.  The participant is asked to see her/his health care provider in one week. 

The nurse/clinician confirms the decision with the JHS physician, and explains the reason(s) for 
an urgent referral to the participant.  This usually occurs during the Medical Data Review, but can 
occur when alert values are returned to the exam center from a central agency.  The JHS 
physician calls the participant’s health care provider and sends a referral letter (see Appendix).  
Follow-up letters are also sent to the participant (see Appendix). 
 
Participants who have no health care provider are referred based on consultation with a provider 
in the community. 

 
4. Routine Referral.  The participant is asked to see her/his health care provider at the first 

convenient appointment. 

The nurse/clinician advises a visit to the participant’s health care provider.  A referral letter is sent 
to the participant (see Appendix) and her/his health care provider (see Appendix) as a cover letter 
for the final results report. 
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5. No Referral.  The study results are summarized for the participant and her/his health care 
provider and sent along with cover letters (see Appendix). 

 
Procedures/symptom-specific guidelines are summarized in Table 21.  Certain interview items or 
measurements (identified with an asterisk) require confirmation from additional questions during the 
Medical Data Review.  The reviewer determines the acuteness of the findings, and determines 
whether or not a health care provider is monitoring the condition.  If the participant is aware of and 
being followed medically for a condition, judgment is exercised about whether to refer, and the degree 
of urgency.  The types of participant and health care provider referral and results letters used for each 
of the five referral categories are summarized in Table 23; examples of the texts of these letters are 
provided in the Appendix. 
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Table 21. Medical Care Referral Guidelines 
 

Referral  
Classification 

Examination 
Findings 

Recommendation 
to Participant 

Explanation to  
Participant 

IMMEDIATE 
Referral 

*SBP> 210 mm Hg or 
  DBP> 120 mm Hg 
 
*Unstable angina 
 
 
*Neurologic symptoms in 
past week. 
 
*Other severe symptoms or 
findings. 

See health care provider 
Today 

 
 
" 
 
 
" 
 
 
" 

BP very high 
 
 
Your chest pains may 
be important. 
 
Your symptoms may 
be important. 
 
Your symptoms may 
be important. 

URGENT 
Referral 

*Angina, stable but 
untreated/ not being followed 
 
* Neurologic symptoms, 
untreated, one week to six 
months ago. 
 
*Acute congestive heart 
failure 
 
*Other acute, but less 
severe symptoms 
 
*SBP> 180-209mm Hg           
or 
*DBP> 110-119mm Hg 

See health care provider 
within a week 

 
" 
 
 
 
" 
 
 
" 
 
 
 
" 

Your chest pains may 
be important. 
 
Your symptoms may 
be important. 
 
 
Your symptoms may 
be important. 
 
Your symptoms may 
be important. 
 
 
Your BP high. 

ROUTINE 
Referral 

*Old MI (Rose 
questionnaire), previously 
unrecognized 
 
*Neurologic problem (stroke, 
TIA exam, findings) >6 
months unrecognized 
 
*Claudication, previously 
unrecognized 
 
*Other symptoms or findings 
needing evaluation/ not 
being followed 
 
*Uterine bleeding; response 
I,O,D on Reproductive Hx 
form 

See health care provider 
within month or at first earliest 
convenient appointment. 
 

" 
 
 
 
" 
 
 
" 
 

 
 
" 

Your chest pains may 
be important. 
 
 
Your symptoms may 
be important. 
 
 
Your symptoms may 
be important. 
 
Your symptoms may 
be important. 
 
 
Your symptoms may 
be important.  

*Interview items/measurements require confirmation during Medical Data Review 
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(con’t) Table 20. Medical Care Referral Guidelines 
 

Referral 
Classifications 

Examination 
Findings 

Recommendation 
To Participant 

Explanation 
To Participant 

ROUTINE 
Referral 

*SBP 160-179 mm Hg or 
  DBP 100-109 mm       
  Hg 
 
*SBP 140-159 mm Hg or 
  DBP 90-99 mm Hg 

See health care 
provider within one 
month 
 
See health care 
provider within two 
months 

Your BP is high 
 
 
 
Your BP is high 

NO 
Referral 

*Angina, stable on treatment/    
being followed 
 
*MI, previously documented 
 
* SBP 130-139mm Hg  
 or 
   DBP 85-89mm Hg 
 
*SBP<140mm Hg and 
  DBP< 90mm  Hg 
 
Height, weight 

None 
 

 
None 

 
Recheck in one year 

 
 
 

Recheck in two years 
 
 

None 

Confirm only 
 
 
Confirm only 
 
Your reading is high 
normal 
 
 
Your reading was 
normal 
 
Report only 

ECG findings 
requiring review by 
M.D. before 
participant leaves 
Exam Center 
 
 
 
 
 
Other ECG findings 
or Normal ECG 

Acute Pattern abnormalities 
(MI, ischemia)* 
 
Any other ECG finding, alone 
or in conjunction with 
symptoms, causing concern.1 

Per review by health 
care provider 

Would like to review 
with health care 
provider 
 
 
 
 
 
 
 
A copy of the ECG will 
be sent  to your health 
care provider with the 
other results 

 
* Interview items/measurements require confirmation during  Medical Data Review. 
1. Acute pattern abnormalities, 2nd or 3rd degree block, ventricular tachycardia, R on T, atrial fib/flutter with 

ventricular rate <60 or >110, sinus bradycardia <50, sinus tachycardia>110, PR interval >0.26 sec. 
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7.0 CLINICIAN REVIEWS 
 
 
7.1 General Policies 
 
The second level of medical data review is a review of the participant’s data by the Clinic Manager 
within one week of the visit.  This procedure includes the information initially reviewed during the 
Medical Data Review; labs received from the local lab; clinical chemistries, hemostasis or lipid alert 
values reported by telephone or e-mail from the Central Lab; and Reading Center alert values. 
 
This general medical review provides a clinical staff’s interpretation of the study results and an 
overview of referrals and reports from the Exam Center. 
 
7.2 Procedures 
 
The Clinic Manager review is an ongoing activity at the Exam Center.  Once a week the Clinic 
Manager reviews the data of participants seen in the preceding week.  After the examination of the 
participant’s Medical Data Review printout and ECG, the Clinic Manager records the interpretation of 
the Medical Data Review printout and reviews the preliminary interpretation.  The Clinic Manager also 
confirms the local laboratory results for alert values.  Any referrals made during Medical Data Review 
are reviewed at this time, and sent to a JHS physician for review. 
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8.0 RESULTS REPORTING 
 
 
This activity concludes a process that extends over 4 to 8 weeks after the participant completes the 
JHS baseline exam. When all study results are received from the Central Laboratory and Reading 
Centers by the Coordinating Center, they are summarized for final disposition by Exam Center 
medical staff. Final summaries of the study results are compiled, according to the criteria in section 
5.1.2, and mailed to participants and health care providers. 
 
As urgent and immediate alert values are returned from the Central Laboratory and Reading Centers, 
the medical staff reviews them and assumes responsibility for referrals (see Table 21). Routine 
results may bypass physician review until the final report is generated. The JHS physician or Clinic 
Manager reviews all letters and reports sent to the participants and her/his health care provider. 
 
With participant approval, normal and abnormal results of the clinically relevant medical tests are 
reported to the participant's health care provider.  Whenever the therapeutic implications of results 
are not known, a statement to that effect is included in the report to the health care provider. Clinically 
relevant medical tests are differentiated from those with strictly research value based on their 
empirical value for diagnosis and/or treatment. Medical tests with strictly research value are not 
reported. Some results with equivocal clinical utility for cardiovascular outcomes may be reported as 
they have potential implication for therapy in certain subsets of the population, for example, folate 
levels for women of child-bearing age.  Copies of all reports and letters concerning examination 
results sent to participants and health care providers are kept on file at the Exam Center. 
 
Reporting of baseline exam values is made in the context of medical history where relevant.  The 
alert values listed in Table 22 are reported with recommendations for medical follow-up.  The Clinic 
Manager may initiate a telephone follow-up with the participant to clarify prior history.  A copy of the 
abnormal study result, however, is included in the summary of results sent to the participants and 
her/his health care provider. 
 
If verification or follow-up is needed, the participant is advised to discuss the results with the health 
care provider.  JHS personnel provide no specific medical advice or interpretation of results.  This is 
felt to be the responsibility of the participant’s regular health care provider.  Consistent with this 
policy, clear instructions are given to all JHS staff to avoid interpreting study results.  If the participant 
has no health care provider, referral is available. 
 
Even though the JHS is an observational study, the recommendation that the participant’s health care 
provider performs any additional tests or procedures to confirm or evaluate JHS findings is 
considered an acceptable and necessary consequence of study participation. 
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Table 22.  Laboratory Alert, and Normal Reference Values 
 

Chemistries Normal Range for  
JHS Labs** Alert Values* 

Total Cholesterol <200 desirable 
200-239 mildly elevated 
>240 markedly elevated 

N/A 

LDL <130 N/A 
HDL >35 N/A 
Triglycerides <220 >1000 
Creatinine (males) 
Creatinine (females) 

=< 1.4 
=< 1.2 

>2.5 
>2.5 

Fasting glucose 74 – 106 <60; >200 
Sodium 136 – 146 <125; >155 
Chloride 98 – 108 <80; >115 
Potassium 3.5 – 5.1 <3.2; >5.5 
Uric Acid (males) 
Uric Acid (females) 

=< 8.5 
=< 7.5 

>12 
>12 

Hemoglobin (males) 
Hemoglobin (females)  

14.0 – 18.0 
12.5 – 15.5 

<12; >20 
<10; >17 

Hematocrit (males) 
Hematocrit (females)  

42.0 – 49 
39.0 – 45 

<35; >53 
<30; >50 

Platelets 130 – 400 x 103 <50 x 103; >500 x 103 
Vitamin B12 =>223 <150 
Folic Acid =>2.7 N/A 
Hgb A,C =<6.1 >7 
URINE 24-hr.   
Microalbumin =<25 >25 
EXAM COMPONENTS   
EKG Reading Center 

Reading Discretion 
Acute pattern abnormalities, 2nd or 3rd degree 
block, VT, R on T, atrial fib/flutter with ventricular 
rate <60 or >110, sinus bradycardia, <50, sinus 
tachycardia >110, PR interval >0.26 sec. 

Echocardiogram Reading Center 
Reading Discretion 

Emergent: aortic dissection, vegetations, tumors, 
flial leaflet, thrombus, cardiac tamponade urgent: 
LVEF <30%; aortic aneurysm, LVH, AS 

Carotid Ultrasound  < 2mm residual lumen 
Pulmonary Function 
Test 

 FEV1 is <50% predicted 

*Laboratory notifies exam enter; Exam Center MD takes referral/notification action. 
**Reference ranges are provided on JHS Results Reports. 
1  Reference values obtained from University of Mississippi Medical Center Clinical Lab. 
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8.1 Overview of Results Reporting 
 
Figure 3 provides an overview of the process of results reporting and illustrates the interface between 
the review of medical data, the referral process, and the notification of study results.  The figure also 
illustrates that certain results are reported on a routine basis, whereas potentially abnormal study 
results are reported to participants and her/his health care providers on an expedited basis. 
 
The reports to the participant and/or the health care provider provide a minimum, standard set of 
study results.  Reports to participants include a statement indicating either that all study results are 
within ranges considered normal, or that a study result requires confirmation or further evaluation.  
Normal ranges and brief explanatory statements are provided.  Health care providers receive a letter 
of explanation (see Appendix) and a copy of the participant’s result report, and are thus aware of any 
results flagged as being outside the JHS reference range, and the wording and explanations provided 
to her/his patients. 
 
The following is a review of results reporting procedures. 
 
1. At reception, the Schedule of JHS Results Reporting (see Appendix) is reviewed with the 

participant to describe the tests to be reported to the participant.  The participant is also given a 
time range for return of results. 

 
2. At Medical Data Review, a Participant Medical Data Review Printout (see Appendix) is generated 

summarizing findings for the Medical Data Review.  Items flagged for review are automatically 
retrieved from the data base and printed on this form.  The nurse/clinician conducts the Medical 
Data Review with the participant as described in section 5.1.  A pre-printed summary of the exam 
results that do not require processing by the Central Lab or a Reading Center is completed during 
the Medical Data Review and given to the participant (see Appendix). 

 
3. At the Medical Data Review, a referral may be necessary.  Three levels of referral are 

designated: Immediate (same day), Urgent (within one week), Routine (within one or two months, 
depending on study guidelines), and the corresponding referral letters are sent to the participant’s 
health care provider (see Appendix).  (Emergent referrals are made as soon as condition is 
observed and are generally not held for the Medical Data Review).  For immediate or urgent 
referrals, a phone call to the participant’s health care provider may be made to facilitate the 
referral recommendation given to the participant. 

 
4. Once a week, a clinician’s review occurs during which the Clinic Manager reviews participant data 

and interprets ECG tracings.  If an abnormality is detected at this time, a report and referral letter 
is sent to the participant and her/his health care provider (see Appendix). 

 
5. The Central Lab and Reading Centers send the Exam Center the clinically relevant study results 

4-6 weeks after the participant’s exam.  If there are “alert values," the participant is notified using 
the Alert Value Referral Letters (see Appendix) and the health care provider is notified (see 
Appendix).  If there are no “alert values,” normal results reports and cover letters indicating no 
abnormal findings are sent to the participants and her/his health care providers if designated. 

 
6. When all results are available, the Results Report to the participant and health care provider and 

accompanying cover letters are generated.  The types of cover letters are summarized in Table 
23 and prototype letters are found in the Appendix. 

 
7. The Exam Center Clinic Manager or physician reviews all results and letters before they are 

mailed. 
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8. A record is kept of all alert values and referrals on the Report and Referral (REF) form (see 
Forms Appendix) and on the Alert/Referral Log (ALT) (see Forms Appendix).  Copies of all 
referral letters and results reports are filed in participant folders. 
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Figure 3. JHS Referral/Notification Procedures 
 

On Site Findings Results of Analytes Results from Reading Centers 

Blood Pressure 
Electrocardiogram 
Echocardiogram 
Pulmonary Function 
 
 
 
 
 
 
 
 
       Alert   Routine 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
           To                       To 
 
 Part’p a   HCP b  Part’p    HCP 
 
 7.2.1c      7.2.3         7.3.1      7.3.5 
 7.2.2       7.2.4         7.3.2      7.3.6 
 7.4.1       7.4.3         7.3.3 
7.4.2 7.3.4 
 

 
a     Part’p refers to participants 

b     HCP refers to Health care 
Provider 

c     Numbers refer to Appendix for  
letters            

    Lipids                  Glucose 
    CBC                     B12, folate 
    Platelets               Uric Acid 
    Na, K, Cl              24 hr urine protein 
    Creatinine            Hgb A1C 
 
 
 
 
 
 
 
                    Alert  Routine 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
            To                           To 
 
 
Part’p       HCP            Part’p    HCP 
 
7.2.1          7.2.4              7.3.1          7.3.5 
7.2.2                                7.3.2          7.3.6 
                                    7.3.3 
                                        7.3.4 
 

Carotid Ultrasound 
Echocardiogram 
Pulmonary Function Tests 
 
 
 
 
 
 
 
 
 
     Suspicious    Routine 
 
 
 
 
 
 
 
 
 
                         Alert 
                      Cutpoint 
 
 
 
 
 
 
 
 
 
 
 
 
              To                     To 
 
 
 
      Part’p      HCP       Part’p      HCP 
 
      7.5.1        7.5.3       7.3.1        7.3.5 
      7.5.2        7.6.3       7.3.2 
      7.6.1        7.7.3 
      7.6.2 
      7.7.1 
      7.7.2  
  

 

Exam Center 
Medical Data 
Review 

Clinic Manager/ 
Physician 

Routine 
Report 
and 
Letter 

Call  
Or Alert 
Letter 

Routine 
Report 
and 
Letter 
 
 
 
 
 
 
 

Call 
Or Alert 
Letter 

Exam Center 
 

Clinical 
Evaluation 
At Reading 
Center 
 

Reading 
Center 

      Exam     Center 
               MD 

Call  
Or Alert 
Letter 

Routine 
Report 
and 
Letter 

Central Lab/ 
UMC Lab 

  Exam Center 
Nurse/Clinician 



112 

Exam 1 Cohort Procedures Manual.doc 

Table 23. Cover Letters for the Reports to Participants and Health Care Providers 
 

Recipient Type Of Cover Letter For Results Reports 

 
 
 
Health care provider 
 
Participant 
 
 
 
 
 
Health care provider 
 
 
 
Participant 
 
 
 
 
Insurance 

 
REFERRAL LETTERS FOR ALERT VALUES 
 
a) Referral post clinic visit 
 
b) Referral post clinic visit (N / A) 
c) Referral post clinic visit (w / MD) 
d) Referral post clinic visit (no / MD) 
 
COVER LETTERS FOR SUMMARY VISIT RESULTS REPORT 
 
a) Normal results 
b) Abnormal results, no previous referral made 
c) Abnormal results, previous referral made 
 
a) Normal results 
b) Abnormal results 
c) Normal results, no MD designated 
d) Abnormal results, no MD designated  
 
Study results sent to third party 

 
8.2 Report of Ultrasound B-Mode Scan Measurements 
 
The ultrasound study of the carotid arteries will evaluate intimal medial thickness at specified sites in 
three distinct segments of the extra cranial carotid system – common carotid, carotid bifurcation, and 
internal carotid.  The JHS ultrasound examination is oriented toward the detection of early 
atherosclerotic changes in the arterial wall and does not provide clinical documentation of the extent 
of lesions that might be of medical importance.  Portions of the internal carotid artery, which may 
have disease, are not visualized at all.  There are some specific early arterial changes and non-lumen 
encroaching wall thickness measurements that will be documented on JHS participants, but are 
presently of research interest only and of no known medical value.  Such results are not routinely 
reported to the participant and her/his health care provider, and the participant is made aware of this 
during the process of consenting. 
 
Procedures for reporting possible alert values are initiated when the minimum residual lumen in the 
evaluated artery is less than or equal to 2mm.  Identification of these possible alert values is made by 
either the sonographers performing the scans at the JHS Exam Center or by the readers at the 
Ultrasound Reading Center (URC).  The Clinic Manager is notified if in the course of the ultrasound 
scanning the sonographer discovers a minimum residual lumen of 2mm or less.  In addition, if during 
the reading process at the URC, readers confirm measurements revealing a minimum residual lumen 
of 2mm or less, the Clinic Manager is informed of this alert.  The participant and her/his health care 
provider are notified of the findings through letters (see Appendix).  Because the JHS carotid 
ultrasound examination is a limited study and measurements obtained are of research value only, 
obtaining a more complete, clinically-focused carotid ultrasound is recommended in the letter. 
 
8.3 Report of Echo Measurements and Findings 
 
The echocardiogram study will evaluate a variety of structural and functional parameters in the JHS 
participant.  Structural parameters to be studied include LV wall and chamber dimensions, and LV 
mass (calculated from dimensions).  Cardiac functional data will be derived from measurements of 
systolic performance and from Doppler data describing left ventricular diastolic filling. 
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Each echo will be interpreted clinically by one of the Echocardiogram Reading Center (ERC) 
cardiologists within a few days of the exam.  If there is any question raised by the echo technician 
regarding clinically important abnormalities, the echo study is read immediately following the 
completion of the study.  The established echo “alert” (emergent) parameters include aortic 
dissection, vegetations, tumor, flial leaflet, thrombus, or cardiac tamponade.  These will trigger an 
urgent phone call by the Reading Center cardiologist to the Exam Center co-investigator with 
oversight of the JHS participants’ clinical issues.  The ERC cardiologist will contact the participant’s 
health care provider of record, if so directed by the Exam Center physician. 
 
Urgent, not emergent, parameters will be reported promptly, but not emergently to the Exam Center 
PI.  These parameters include: LVEF less than 30%; aortic aneurysm; LV enlargement (LV end-
diastolic dimensions greater than 6.5 cm); aortic stenosis (aortic valve area less than 1 cm squared or 
peak velocity > 4m/sec.).   A cover letter (see Appendix) is sent to the participant and her/his health 
care provider along with the notification of the abnormality. 
 
8.4 Report of Spirometry Testing 
 
The pulmonary function parameters to be assessed include the FEV1, FVC, and maximal inspiratory 
pressures.  Each participant completing a test of acceptable quality will be provided a preliminary 
report of her/his lung function prior to leaving the clinic. 
 
The participant is informed of the usual normal ranges: FEV1 greater than 80% predicted; FVC 
greater than 80% predicted; FEV1/FVC greater than 65% predicted. 
 
The alert value for FEV1 is <1.0 liter and <40% predicted value.  If either the FEV1 or FVC is less 
than 50% predicted normal value the health care provider is notified through an alert letter (see 
Appendix).  A copy of the preliminary report is included with the letter.  A subsequent final report is 
also sent to the health care provider from the PFT Reading Center. 
 
8.5 Routine Notification of Study Results 
 
Results of routine medical examinations, normal or abnormal, are reported to the participant and 
her/his health care provider, unless the participant has not designated a health care provider (refer to 
Appendix for prototype letters).  This is explained to the participant during the baseline clinic visit, and 
the participant is provided a schedule for results reporting. 
 
8.5.1 Results Routinely Reported to the Participant 
 
Results reported to the participant during the clinic visit include current weight and height, current 
blood pressure, preliminary spirometry results, a statement that the ECG tracing will be read for 
inclusion in the summary report, and a statement that only abnormalities of the carotid artery scan will 
be reported. 
 
Within three months after baseline exam, the Summary of the JHS Baseline Exam Results for 
participants and her/his health care providers (see Appendix) is mailed to the participant.  This report 
includes the following confirmed study results from baseline exam: weight and height, blood pressure, 
summary reports of ECG, echocardiogram, PFT’s, B-scan ultrasound exam of the carotid arteries 
(lumen diameter), and blood and urine analytes (total cholesterol, LDL and HDL-cholesterol, 
triglycerides, serum creatinine, fasting glucose, serum electrolytes, B12, folate, hemoglobin A1C, 
CBC results, platelets, and 24-hr urine). 
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8.5.2 Results Routinely Reported to the Health Care Provider 
 
Participants’ health care providers receive a copy of the reports sent to her/his patients.  In addition, 
health care providers are notified of any important symptoms reported by the participant and they are 
provided with a copy of the participant’s electrocardiogram. 
 
8.5.3 Results Reported Only by Request 
 
All other study measurements, i.e. those not routinely reported to participants and/or her/his health 
care provider, are considered to be of research value only.  If a participant requests them in writing, 
these values are provided on an ad hoc basis. 
 
On the rare occasion that the Exam Center receives a request for a participant’s study results from a 
third party medical care payor, a results report can be released according to the following steps. 
 

1. A signed statement from the participant authorizing the release of JHS data to anyone other 
than the participant or her/his identified health care provider is required prior to the release of 
the study data by the JHS.  A copy of the request and the authorization for release of study 
data is kept in the participant’s folder. 

2. The report contains only the information that was released to the participant’s health care 
provider (or the participant), i.e., and exact copy of the cover letter, the results report and the 
ECG tracing. 

3. This information is sent with a cover letter (see Appendix) from the Exam Center stating that 
the JHS does not provide diagnostic services or treatment.  

4. The information is sent directly to the third party with an exact copy to the study participant, 
indicating the date on which the information was sent. 

8.5.4 Reporting of Genetic Data 
 
The results of any genetic study will be handled as any other results not routinely reported as they are 
of research value only (See section 8.5.3). 
 
If, during the course of the JHS, a genetic polymorphism is discovered which has clear clinical 
relevance and is treatable, information will be released study wide to participants regarding these 
polymorphisms.  A description of the polymorphism, its health risk and treatment will appear in the 
JHS participant newsletter along with a mechanism to receive more information and a referral for 
gene testing.  The cost of any such referral is the responsibility of the participant. 
 
8.5.5 Study Results Requiring Special Notification 
 
The JHS protocol identifies certain potentially abnormal findings that require expedited notification to 
the participant or her/his health care provider. These include flagged responses to the medical history 
questionnaire. These items, and the corresponding referral and notification criteria, are described in 
section 7.1. Similarly, “alert value” levels have been defined for the functional tests and laboratory 
measurements. 
 
Laboratory and ultrasound results are not available at the time of the clinic visit. Local laboratory 
results performed at UMC’s lab are reviewed at the Exam Center for alert values within several days 
of the clinic examination. Notification in response to an alert value in laboratory results occurs after 
review of the participant’s record. The Central Laboratory, the Ultrasound Reading Center, the 
Pulmonary Function Reading Center and the Echo Reading Center notify the Exam Center directly of 
“alert values.”  Notification of alert values to the Exam Center is by telephone, electronic mail or FAX 
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abiding by all confidentiality requirements and using only JHS ID numbers as identifiers; confirmation 
and acknowledgement is required. The laboratory alert values are in Table 22. 
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9.0 PARTICIPANT SAFETY 
 
 
The safety and welfare of the JHS participants is protected by: 
 
1. specific measurements taken in the design or conduct of the examination for her/his safety; 

2. the mechanisms established for handling potential emergencies; 

3. routine notification of participants and her/his health care providers regarding the results of the 
examination, and 

4. the procedures JHS staff use to review all potentially medically important results and make the 
appropriate referrals. 

An important factor in participants’ welfare involves her/his expectations regarding the examination. If 
they believe the JHS examination is a substitute for a clinical examination, delay in seeking needed 
medical care could occur. Therefore, the provision of adequate information is a requisite to the JHS 
informed consent procedures (described in section 2.11). 
 
9.1 Measures to Protect the Participant 
 
Examination procedures which convey potential risk to participants include the fasting requirement 
and venipuncture.  Methods by which participant risk is minimized (more fully described elsewhere in 
JHS Manuals) include the following: 

• The possibility of hypoglycemia with a 12-hour fast is diminished by routine inquiry about reasons 
that should exempt the participant from fasting during the scheduling of baseline exam. Other 
medical conditions or dietary restrictions, which may be incompatible with the snack provided in 
the clinic, are also ascertained. 

• Hematomas or prolonged bleeding may result from venipuncture. These are usually avoided if 
well-trained technicians follow the procedures for blood drawing and take the precautions 
described in JHS Manual 9: Specimen Collection and Processing.  Prior to venipuncture, the 
participant is asked: “Do you have any bleeding disorders?” If the participant answers 
affirmatively or is uncertain, s/he is asked about whether s/he has had blood drawn previously 
and if so, whether there were any problems such as swelling or continuing to bleed at the 
venipuncture site. If the answer to this question is “yes,” the Clinic Manager is summoned to 
approve the venipuncture. Occasionally, with any participant, bleeding persists after the 
venipuncture. Procedures described in Manual 9: Specimen Collection and Processing are 
followed. If the measurements taken have not stopped all bleeding within 30 minutes, and there is 
no obvious explanation for the prolonged bleeding, a medical referral is made. Also, the 
participant is instructed to seek medical care promptly if bleeding recurs after leaving the JHS 
clinic. 

• Participants may experience syncope during the venipuncture. Methods for handling major and 
minor emergencies are described in sections 9.3.1 and 9.3.2, respectively. 

• The JHS ultrasound exam involves no more ultrasound exposure that is usually the case when 
examining superficial arteries clinically. See JHS Manual 7: Ultrasound for details. The American 
Institute for Ultrasound in Medicine has issued the following statement concerning the safety of 
ultrasound: 

 
Safety for Training and Research 

 
Diagnostic ultrasound has been in use for over 25 years.  No confirmed adverse 
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biological effects on patients resulting from this usage have ever been reported. 
Although no hazard has been identified that would preclude the prudent and 
conservative use of diagnostic ultrasound in education and research, experience 
from normal diagnostic practice may or may not be relevant to extended exposure 
time and altered exposure conditions. It is therefore considered appropriate to make 
the following recommendations: In those special situations in which examinations are 
to be carried out for the purposes other than direct medical benefit to the anticipated 
exposure conditions, and of how these compare with conditions for normal diagnostic 
practice. 

 
Following the 45-minute ultrasound examination, the participant is asked to rise slowly, sit and then 
stand so that postural changes in blood pressure and pulse rate can be monitored. These procedures 
are described in JHS Manual 7: Ultrasound.  The precautions against adverse effects of orthostasis 
are summarized here. 
 
Before beginning, the procedures for monitoring postural changes are explained to the participant. 
The participant is asked whether or not s/he ever feels faint on standing. If the question is answered 
in the affirmative, permission to make the measurement (postural change) is still sought. Should the 
person decline, the procedure is not performed. In the absence of a reason not to continue, however, 
the participant is asked if s/he is taking medications that produce light-headedness when standing 
(postural effects). When the postural changes are measured, the sonographer is positioned closely 
behind the person as a protective measure should s/he become faint. A sturdy chair is positioned 
close at hand so that the participant may sit down promptly should s/he feel the need. Furthermore, 
examinees are advised to notify staff immediately if not feeling well and to ask for the chair. Clinic 
staff are instructed to watch the participant for signs of distress. In the event that the participant faints, 
the procedures described below in Section 8.3.2 and in Manual 9: Ultrasound, are followed. 
 
9.2 Stopping Rules for Interviews and Procedures 
 
Participant safety and comfort during the clinical examination are monitored throughout the clinic visit. 
Interviewers and technicians observe participants for signs of fatigue or physical and/or emotional 
discomfort. When any one of these conditions are observed, participants are offered the opportunity 
to discontinue the interview or procedure, and are given an opportunity to rest before the next 
procedure. Persons incapable of completing all of the clinical exam are invited to change back into 
her/his street clothes and participate in the medical data review and reschedule the clinic exam on 
another day. 
 
For persons with conditions which require emergency and immediate referrals, such as cardiac 
events, unstable angina, ECGs with acute pattern abnormalities, or blood pressure > 210/120 mm Hg 
(see Tables 16 and 17), the JHS physician is consulted immediately, the clinic exam is terminated as 
soon as the condition is observed, and another appointment for baseline exam rescheduled as 
appropriate. For blood pressures requiring referral within one week (SBP 180-209 mm Hg or DBP 
110-119 mm Hg; the urgent referral category in Table 20), the JHS physician is also consulted, and 
the clinic exam is either continued and the participant advised to seek medical care within one week 
or the clinic exam is terminated and rescheduled, based on the JHS physician’s recommendation. 
The termination of any interview or procedure is documented on the Participant Itinerary Sheet (PIN). 
 
9.3 Methods for Handling Emergencies 
 
While all life-threatening emergencies (e.g., acute MI) require immediate evaluation of the participant 
at an acute care facility, some emergency measures may be required in the clinic before departure 
(e.g., cardiac arrest). In addition, there are minor emergencies (hypotension, fainting, etc.) which may 
require treatment in the clinic only. Although most emergencies are of the less severe nature, the JHS 
Exam Center is prepared for both types. 
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9.3.1 Major Emergencies 
 
In a serious event the primary concern of the Exam Center staff is to implement pre-established 
procedures to get the participant to the nearest medical facility. The JHS clinic is located within a few 
city blocks of a large, general, acute–care hospital. A staff person with certification in basic life 
support is on duty and physically present at every clinic session. Needed life support procedures are 
continued until emergency care arrives or the participant is transported to a hospital. The JHS Exam 
Center, has specific emergency procedures, which define: 
 
1. Who is in charge during the emergency 

2. Who is to administer treatment 

3. Who is to be notified 

4. What action clinic staff is to take 

5. Which reports are to be filed 

In addition to trained personnel and emergency equipment, the Exam Center has posted in a 
conspicuous place (e.g., the reception area): phone number of police and fire stations, ambulance 
services, and specific phone numbers or codes to alert medical teams, if applicable. 
 
In each participant’s folder, the name and phone number of her/his health care provider or usual 
source of medical care and the home and work telephone numbers of one or more contact person are 
available on the CON form. The Exam Center is required to have either a physician or a registered 
nurse on site at all times when participants are interviewed and examined. 
 
All emergency situations are coordinated by the staff person designated, a priori, or by a physician if 
present. The Exam Center has a designated physician on duty for each clinic session. If not 
physically present in clinic, s/he is within immediate reach by phone or paging system and within a 
short distance to the clinic. The physician duty roster is posted with the clinic secretaries and in the 
office of the nurse/clinician so that the name of the responsible physician is readily accessible. 
However, in no case is emergency referral and/or care deferred while staff is attempting to locate a 
clinic doctor. 
 
JHS staff are trained to carry out her/his specific responsibility during an emergency. Retraining is the 
responsibility of the Exam Center, following institutional guidelines. 
 
All emergencies, whether serious or minor, are documented. This requires filling out an institutionally- 
approved form identifying the type of emergency. This is done by the person in charge at the time, 
and all reports are co-signed by a clinic physician and are filed at the Exam Center.  
 
9.3.2 Minor emergencies 
 
The most common minor emergency is simple syncope (fainting) and near syncope. These events 
may occur during the postural blood pressure measurements or venipuncture. Management of simple 
syncope or near syncope is the same whether associated with measuring postural blood pressure 
changes or drawing blood.  Many syncopal episodes can be prevented if clinic staff are alert to early 
signs. In any situation in which syncope is likely, e.g., after the venipuncture, staff verify that the 
participant does not look or feel faint. If the participant looks faint or feels faint in the venipuncture 
area: 
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1. Have the person remain in the reclining position or in the chair, sitting with head between the 
knees  

2. Crush an ampule of smelling salts and wave it under the participant’s nose for a few seconds 

3. Provide the participant with a basin and a towel if s/he feels nauseous 

4. Have the participant stay in the reclining position or chair until s/he feels better and her/his color 
returns 

 
If the participant continues to feel sick, recline the chair, place a cold wet towel on the back of the 
person’s neck, and notify the supervisor. If a participant feels faint, s/he is cautiously lowered to the 
supine position on the floor and one attendant immediately calls for an in-house nurse/clinician to 
assist the patient. The remaining attendant raises the participant’s legs above the plane of the body to 
increase venous return. Prior to this, the staff member momentarily palpates for a carotid pulse and 
checks to be sure the subject is breathing. If life support measures are needed, the procedures 
outlined in section 8.2.1 are followed. 
 
9.4 Emergency equipment 
 
A basic first aid kit is maintained at the Exam Center. The kit contains a reference guide of its 
contents, and is checked every year and immediately after each use.  The Clinic Manager identifies a 
person responsible for this task. 
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10.0 FOLLOW-UP OF THE JHS COHORT 
 
 
10.1 Eligibility Requirements for Annual Follow-up Interviews 
 
Participants who completed at least part of the baseline clinic examination are contacted annually.  
Individuals excluded from annual follow-up (AFU) and subsequent examinations at the beginning of 
the study are only those enumerated residents who completed the home interview, but did not sign 
the informed consent form at the Exam Center examination (baseline exam).   
 
Unless requested otherwise by the participant, or a participant is lost to follow-up, an attempt is made 
annually to contact all surviving JHS cohort members.  This includes participants who have moved 
away from the community in which they were recruited.  Telephone AFU interviews can be conducted 
anywhere in the continental U.S. Addresses and telephone numbers of cohort members with multiple 
residences are kept on file to contact participants on her/his target anniversary date. 
 
10.2 Annual Follow-Up 
 
10.2.1 Annual Contacts between Exams 
 
Each study participant is re-contacted approximately 12 months after her or his initial examination 
and then approximately every 12 months after that for the next two years. These three follow-up 
contacts review the health-related developments occurring since the last contact. Each follow-up is 
completed by telephone (preferred) or in person (if necessary). The follow-up call is preceded by a 
letter sent by mail about two weeks in advance of the call (see Appendix). Information for this mailout 
is taken from the study data base. 
 
10.2.2 Time Window for Annual Contacts between Exam Center Examinations 
 
Study participants are re-contacted annually on her/his initial (anniversary) examination date at 
approximately the same time each year.  The target date for the AFU interview is the date of the 
baseline visit.  Contact years are to be numbered sequentially, starting with the year of the baseline 
examination, i.e., Contact Year 01 is assigned to all participants at baseline exam, regardless of the 
year in which they completed her/his baseline exam (Table 24). 
 
Table 24. Contact Years by Visit Dates 
 

Contact Year 01 
Baseline Exam 

Contact Year 02 
AFU 1 

Contact Year 03 
 AFU2 

Contact Year 04 
AFU 3 

9/26/2000-9/25/2001 9/26/2001-9/25/2002 9/26/2002-9/25/2003 9/26/2003-9/25/2004 

9/26/2001-9/25/2002 9/26/2002-9/25/2003 9/26/2003-9/26/2004 9/26/2004-9/25/2005 

9/26/2002-9/25/2003 9/26/2003-9/25/2004 9/26/2004-9/25/2005 9/26/2005-9/25/2006 

 
Because recruitment is done over a three-year period, all participants will be in any one of three JHS 
baseline examination contact years during the calendar year in which annual contact interviews are 
conducted.  Regardless of the contact year, the optimal time for placing the initial call each year for 
annual contact is generally not more than three weeks before the target (anniversary) date.  A one 
year window, up to 6 months before and 6 months after the target date, is the maximum allowed for 
each annual contact. This window will allow accommodation of ARIC with JHS AFU. 
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When the contact window expires and no contact is made, a final result code for that window is 
entered on the Annual Follow-Up Record of Calls (see Appendix), and a new window begins.  
 
The contact year to which a participant death is assigned is determined by two factors: the date of 
death and whether or not the participant had already been interviewed during the contact year in 
which the death occurred.  For example, if the death is determined during or prior to the regularly 
scheduled AFU interview, the death is assigned to the contact year in which the AFU form was 
administered.  If however, a participant is interviewed in Contact Year 02, dies a short time 
afterwards, and the family notifies the Exam Center of the death, the death is assigned to the next 
contact year, i.e. Contact Year 03. 
 
10.2.3 Follow-up Procedures 
 
Annual follow-up of cohort members is used to (1) maintain contact and correct address information 
on cohort participants, (2) update tracing information on three contact persons, (3) ascertain the 
participant's vital status, and (4) document interim medical events/hospitalizations, life events and 
functional status between the three-year comprehensive examinations.   
 
There are four primary components to annual follow-up: (1) the generation of scheduling material by 
the JHS Coordinating Center; (2) the scheduling of the AFU interview by Exam Center staff; (3) the 
administration of the AFU interview; (4) the ascertainment of medical information relating to 
hospitalizations for cardiovascular disease and documentation of fatal events.  It is anticipated that 
the scheduling of a Exam Center examination every third contact year will occur during the annual 
follow up call in AFU Year 03.  These steps are summarized in Figure 4 and described in the 
following sections.  
 
Figure 4. Interim Contact Procedures between Clinical Examinations in the JHS Cohort 

Study 
 
 
 
 
 
 
 
 
 
 
 
 
 
The Coordinating Center initiates the AFU procedures by generating several times a year AFU 
materials for use in scheduling and conducting the AFU interview.  These materials include the 
Participant Tracing Information Sheet (see Forms Appendix.  The list of participants includes the 
participant name, participant ID, date of baseline exam, and date of Visit 2 (optional), sorted in the 
order requested by the Exam Center.  The Participant Tracing Information Sheet includes the 
participant's name, address, telephone number(s); sex, race, date of birth, state of birth, social 
security number, driver's license state and number; employer's name and address; date of baseline 
exam; and the names, addresses and telephone numbers of two contact persons and the personal 
health care provider.  The Contact (CON) form lists the current data on file for the names and 
addresses of the participant and her/his three contact persons. 
 
The scheduling of AFU interviews at the Exam Center is done year round and involves identifying the 
participants who require scheduling, establishing contact, administering the AFU form, and recording 
participant-reported medical events to JHS surveillance staff.  The procedures for scheduling baseline 
exam and event classification are described in sections 1.6.5 and Manual 10: Cohort Surveillance, 
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respectively. 
 
Using the list of participant anniversary dates, the Exam Center identifies participants for annual 
contact.  All participants will be sent a letter (see Appendix) prior to the AFU interview reminding them 
that they will be contacted by telephone by a staff member from the JHS Exam Center for her/his 
annual interview.  This letter is sent on JHS stationery and “forwarding and address correction 
requested” is stamped on the envelope.  This letter contains: 
 
1. A reminder that the addressee is in the study and that annual contact is involved. 

2. A description of the purpose of the contact. 

3. Information that the participant should obtain to assist with the interview (e.g., hospitalizations, 
physicians visits). 

4. A request to call the JHS office to set up a time to complete the Annual Follow-up Interview. 

Participants who do not have phones, have trouble communicating by telephone, or have special 
needs are not contacted by telephone but are visited in-person.  If these participants can be identified 
in advance, the letter indicates that an interviewer will visit the home, and annual follow-up takes 
place there. 
 
Participants found to have moved or who are otherwise lost to follow-up are traced using the tracing 
information obtained at baseline exam and during subsequent annual follow-up contacts or other local 
sources of information, such as the telephone directory, city directory, etc.  By using the Contact 
Form, Exam Center staff can call or write to the family members, friends, employers, or physicians 
the participants identified as contact persons during previous interviews.  By using Social Security 
numbers, periodic searches of the National Death Index are done.  Every attempt is made to 
schedule and complete an AFU interview for each participant. 
 
AFU interviewers telephone study participants at her/his contact numbers (home or work) at optimal 
times (i.e., late afternoons, evenings, or weekends) to conduct the annual follow-up interview.  When 
the timing of the initial contact is inconvenient for the participant, the interviewer reschedules the AFU 
interview.  When a cohort member can not be reached on the first call, the interviewer makes return 
calls as necessary, at varying times of the day and week until either the participant is contacted or a 
decision is made to initiate tracing procedures.  On the Annual Follow-up Record of Calls (see Forms 
Appendix), a final contact status (result) code indicating the participant cannot be located (i.e., is lost 
to follow-up) is only assigned after all tracing avenues have been exhausted and supervisor approval 
has been obtained.  Experience has shown that participants who are lost to follow-up in one year may 
be located in subsequent years of follow-up and only participants who die or insist on no further 
contact with the JHS should be considered irreparably lost to the study. 
 
10.2.4 Annual Cohort Interview 
 
In Contact Year 01, version "A" the AFU form is administered with AFU Year 1 supplementary 
questions.  In each subsequent Contact Year 02 and Year 03, the baseline "A" version is used with 
the appropriate annual follow-up year supplementary questions.  QxQ instructions for the Record of 
Calls and version "A" of the AFU form and prototype scripts for their administration have been 
prepared for the AFU interview (See Forms Appendix).  The interview includes the use of three forms 
(CON, ARC and AFU) which update address and tracing information of cohort participants (See 
Forms Appendix); and ascertain her/his vital status (AFU, section A), death information (AFU, section 
B); perceptions of general health (AFU, section C); chest pain on effort (AFU, section D); possible 
infarction (AFU, section E); intermittent claudication (AFU, section F); TIA/stroke (AFU, section D); 
hospitalizations (AFU, sections H and K); and functional status, weight loss, and life events (AFU, 
section I) (See Forms Appendix, Annual Follow-up form). The Record of Calls (ARC) is used 
throughout the contacting process to log each participant's interim and final contact and appointment 
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status (when applicable).  At some point after the AFU interview, every participant-reported 
hospitalization is verified and the discharge diagnoses recorded.  Potential cardiovascular events are 
reviewed further by the abstraction of participants' hospital records to document the 
presence/absence of JHS Study endpoint criteria.  Detailed information on diagnostic criteria and 
event determination of the cardiovascular events is provided in Chapters 4 and 5, respectively, of 
Manual 10, Surveillance Component Procedures. 
 
The components of the AFU interview are usually done in the following order: (1) completion of the 
Record of Calls; (2) administration of the AFU questionnaire; (3) documentation of the participant's 
hospitalizations during the past year - section K of the AFU form; (4) scheduling of the appointment 
for Visit 2 exam (Contact Year 4, if funding has been continued); and (5) updating of the contact 
information (CON form). 
 
The Record of Calls (ARC form) is used to keep track of attempts to contact a participant.  The 
participant's name, ID, contact year, and contact year date ranges are pre-printed at the top of the 
form.  Space is provided to document contact attempts, pertinent information for future contacts, and 
the outcome of the contact.  There are ten contact RESULTS CODES.  The final result code is circled 
and entered into the data entry system.  The paper copy of the form is kept in the participant's folder 
to assist in future contacts.  The results codes are as follows: 
 

01 No Action Taken 

02 Tracing (Not yet contacted any source) 

03 Contacted, Interview Complete 

04 Contacted, Interview Partially Complete or Rescheduled 

05 Contacted, interview refused 

06 Reported Alive, Will Continue to Attempt Contact this Year 

07 Reported Alive, Contact Not Possible this Year 

08 Reported Deceased 

09 Unknown 

98 Does Not Want Any Future AFU Contact  
 
Codes 01, 02, 04, and 06 are interim codes.  Codes 03, 05, 07-09, 98 are final codes.  See Forms 
Appendix for detailed instructions for completing the form, and a description of the Results Codes for 
contacts.  It should be noted that these codes are required for all AFU contacts, in contrast to the 
APPOINTMENT CODES which are only used in the Contact Years in which the participant is 
scheduled for a clinic visit. 
 
Once contact has been made, the entire AFU interview is administered to surviving participants.  
When a participant has expired prior to the annual contact, the relevant portions of the AFU form 
(Sections A, B, H and K) are administered to a member of the participant's household (or a contact 
person) in order to officially record the death and to obtain the date and location of death and other 
relevant medical information.   
 
Section A of the AFU form documents the participant's vital status and the date on which the status 
determination was made.  The criteria for establishing participant vital status are defined in the form's 
instructions.  Section B is completed on individuals who have died and records demographic 
information necessary for obtaining a copy of a death certificate.  Sections C-G are administered to all 
surviving participants and document perceptions of health and interim (since the previous AFU 
interview) medical events; the majority of the questions were taken from the London School of 
Hygiene Questionnaire for chest pain on effort, possible infarction, and intermittent claudication. 
Guidelines for administering this section are provided below, in Section 10.2.4.1.  Sections H and O 
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on the AFU form are administered to all respondents (participants and proxies) to document overnight 
hospitalizations in acute or chronic medical care facilities. The surveillance staff is notified of every 
cohort hospitalization and an event investigation is initiated. Section I is administered only to surviving 
participants.  Section J is administered to all respondents to ascertain any changes in stress, coping 
and social support and negative emotions of anxiety or depression.  Additional year questions for 
Contact year 02, 03, and 04 are administered in the corresponding annual follow-up year 1,2, or 3. 
 
Tracing information listed on the pre-printed CON form (see Forms Appendix) is verified at the 
conclusion of the AFU form.  Instructions for administering the form and a prototype script are 
provided at the end of the annual follow-up instructions.  Any changes to tracing information recorded 
on the paper form during the telephone interview are recorded on the computerized version of the 
CON form by staff certified in the use of the JHS Data Entry System.  Prior to making any changes in 
the DES, a hard copy of the current version is printed, dated, and placed in the participant file for 
future reference. 
 
10.2.4.1 Administration of London School of Hygiene Questionnaire 
 
The questions in Sections D-F (CHEST PAIN ON EFFORT, POSSIBLE INFARCTION, and 
INTERMITTENT CLAUDICATION) of the AFU form are based on the London School of Hygiene 
Questionnaire.  The purpose of the London School of Hygiene Questionnaire (generally referred to as 
the 'Rose Questionnaire') is to standardize the identification of 'angina on effort' as defined by Dr. 
Geoffrey Rose.  It is not the purpose of the questionnaire to arrive at a medical diagnosis.  The 
questionnaire will fail to identify angina pectoris in some participants whose pains are regarded by the 
physician as genuinely ischemic.  It may categorize other cases as pain due to a quite different 
cause.  Any special effort, however, to alter the conduct of the interview in such instances would 
destroy the basic purpose of the questionnaire technique, which is to insure uniformity in the eliciting 
of defined symptoms. 
 
Questions must be put to the participant exactly as they are printed: small changes can make 
unexpectedly large differences in responses.  Unequivocal answers must be recorded as such, 
whether they seem reasonable or not. Supplementary questions (probing) should rarely be used.  
When they have to be asked, they should depart as little as possible from the wording of the initial 
question, and must not be such as to suggest any one particular answer to the participant. 
 
If serious doubt arises about the correct interpretation of a particular answer, it is recorded in such a 
way as to exclude the suspected condition. An example of this type of situation is demonstrated in the 
following question and hypothetical response.  
 

{Question} "Do you get it when you walk uphill or hurry?"  
{Response} "Well, I think I might, but I really can't remember." 

 
This answer is recorded as NO and no probes are employed. 
 
An exception is made to this rule only if a negative response to the lead-in question is an 
interpretation or denial of a positive response. 
 

{Question} "Have you ever had any pain or discomfort in your chest?" 
{Response} "No. Only indigestion." 

 
The answer is recorded as YES, because the participant's interpretation of the symptom is 
disregarded. 
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A frequently made error in the administration of the Rose Questionnaire is to extrapolate the 
participant's response to similar, but not defined, situations in the question. 
 

{Question} "Do you get it when you walk uphill or hurry?" 
{Response} "Yes, the chest pain occurs when I cut the grass.” 

 
The answer to this question is recorded as NO, i.e., a strict interpretation is required.  If pain is 
experienced only during some other form of exertion (e.g., cycling, stair climbing, lawn mowing, etc.), 
it must always be recorded NO.  The response 'NEVER HURRIES OR WALKS UPHILL' can only be 
coded if the participant specifically denies walking uphill or hurrying.   
 
For the remaining questions, unequivocal answers need not be probed.  However, responses 
qualified by terms describing frequency of events, such as 'occasionally' or 'sometimes' should be 
probed by a question such as 'Does it happen on most occasions?’  Individual QxQ instructions are 
provided in the Forms Appendix. 
 
10.2.4.2 Psychosocial Annual Follow-up Questions 
 
Five questions will be used to assess global psychological functioning each year at annual follow-up.  
Participants will be asked to rate her/his response to each question on a 6-point Likert-type scale.  
The specific psychological domains assessed include:  major stressors, depressed mood, anxiety, 
coping, and social support. 
 
10.2.4.2.1 Background, Rationale and Hypotheses 
 
Epidemiologic and clinical studies have identified a number of psychosocial risk factors that appear to 
influence the incidence, morbidity, and mortality associated with cardiovascular disorders.  Measures 
of each of these psychosocial domains is assessed at baseline.  An annual global assessment will 
provide valuable information on change over the year’s time. 
 
Hypotheses include: 

1. Greater global distress will be associated with an increased risk of hypertension and CHD events 
independent of the contribution of traditional CHD risk factors. 

2. The relationship observed between global psychological distress, hypertension, and CHD events 
will be moderated by global social support, global coping, SES, and education. 

 
10.2.4.2.2 Administration 
 
The Psychosocial Annual Follow-up Questions will be administered to all participants during each 
year of Annual Follow-up.  Each item is read to the participant and requires a rating on a 6-point 
Likert-type scale.  Detailed instructions for the Psychosocial Annual Follow-up Questions are provided 
in the QxQ instructions (see Forms Appendix). 
 
10.2.4.2.3 Scoring/Coding 
 
One score is derived for each of the Psychosocial Annual Follow-up Questions.  Each rating scale 
ranges from A (assigned 0 points) to F (assigned 5 points). 
 
10.2.4.3 Annual Follow-up Year 01 Questions 
 
10.2.4.3.1 Life Events Scale 
 
Major life events will be assessed using an 11-item life events inventory.  This measure was 
developed for use in the Eastside Village Survey.  Items were derived from existing major life event 
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scales and community focus groups. 
 
10.2.4.3.1.1. Background, Rationale, and Hypotheses 
 
Exposure to stress, both acute events and chronic burden, has been related to CHD risk.  The 
frequency and types of stressors experienced by an individual may be influenced by broad societal 
factors operating on a given segment of the population.  Stress exposure has been related to social 
class and, to a lesser extent, ethnicity and thus may contribute to SES or ethnic differences in CHD 
risk.  In the JHS, we will assess 3 types of stress exposure:  major life events (at annual follow-up), 
minor life events, and chronic stress. 
 
Hypotheses include: 
 
1. High stress will be associated with an increased risk of hypertension and CHD events 

independent of the contribution of traditional CHD risk factors. 

2. The relationship observed between stress, hypertension, and CHD events will be moderated by 
social support, coping style, SES, and education. 

10.2.4.3.1.2 Administration 
 
The Life Events Scale will be administered to all participants in the First Year Annual Follow-up call.  
Each item is read to the participant and requires a “Yes” or “No” response.  Detailed instructions for 
the Life Events Scale are provided in the QxQ instructions (see Forms Appendix). 
 
10.2.4.3.1.3 Scoring/Coding 
 
The Life Events Scale yields a total score.  Each “Yes” response is assigned 1 point.  The total score 
is calculated by summing the “Yes” responses. 
 
10.2.4.3.2 Parental SES 
 
Parental Socioeconomic Status (PSE) (see Forms Appendix) questions incorporated in the Year 1 
Annual Follow-up questionnaire provides information on early life social circumstances (home 
ownership, household amenities and conveniences) and parental education and occupation as a 
supplement to individual level information collected during the HII. 
 
10.2.4.3.2.1 Background, Rationale, and Hypotheses 
 
See section 1.6.4.13 for additional discussion of SES.  Preliminary findings from ARIC suggest there 
is a role of childhood SES in the development of subclincial atherosclerosis.  Variations across the life 
course and association with multiple psychosocial and behavioral intervening variables call for 
additional data, especially in African-Americans.  
 
10.2.4.3.2.2 Administration 
 
The Parental SES questions will be administered to all participants in the First Year Annual Follow-up 
call.  Detailed instructions are provided by QxQ instructions. 
 
10.2.4.4 Annual Follow - up Year 02 Questions 
 
10.2.4.4.1 Life Orientation Test (LOT) 
 
The Life Orientation Test (LOT) (see Forms Appendix) is designed to assess an optimistic approach 
to life. It complements other measures included in the JHS psychosocial assessment that emphasize 
the evaluation of negative perspectives and emotions. This has been shown to be valuable in the 
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prediction of cardiovascular outcomes. 
 
10.2.4.4.1.1 Background, Rationale and Hypotheses 
 
Optimism has been shown to be a predictor of CVD morbidity and mortality. Recent evidence has 
further demonstrated a decrease in re-hospitalizations (various reasons) for patients with post 
coronary artery bypass surgery who rated high in optimism (Carver & Scheirer, 1999; Scheirer & 
Bridges, 1995). The effects associated with optimism are independent of the variance subsumed by 
traditional risk factors, and some research exists demonstrating this relationship is independent of 
depression as well. However, little research exists examining the relationship between optimism and 
CV outcomes once various other psychosocial risk factors are controlled for (e.g., coping, social 
support, hostility, etc.). Further, there is a need to examine interactions between optimism and these 
psychosocial variables as a means to improving outcome predictions. 
 
Consistent with previous research, a primary hypothesis is that optimism will be negatively associated 
with the incidence of CVD. High-optimism individuals with subclinical or clinical CVD will demonstrate 
lower levels of clinical symptom expression, as well as CV-related morbidity and mortality, relative to 
disease-level matched low-optimism individuals. Finally, optimism is expected to interact with other 
psychosocial variables in determining outcomes. For example, optimism should have a greater 
impact on disease parameters for those individuals endorsing higher levels of environmental 
stressors (daily or chronic), and is expected to decrease the impact of stable, personal characteristics 
that previous work has established as predictors of disease development and progression (e.g., 
hostility). 
 
10.2.4.4.1.2 References 
 
Carver, C.S. & Scheier, M.F. (1999). Stress, coping, and self-regulatory processes. In L.A. Pervin and 
O.P. John (Eds), Handbook of personality: Theory and research, 2nd ed. (pp. 553-575). New York, 
NY, US: The Guilford Press. 

Scheirer, M.F. & Bridges, M.W. (1995). Person variables and health: Personality dispositions and 
acute psychological states as shared determinants of disease. Psychosomatic Medicine, 57, 255-268. 

 
10.2.4.4.1.3 Administration 
 
The LOT will be administered during the Second Year Annual Follow-Up, to be administered by a 
trained interviewer. Responses are made based on a global frequency-based Likert-type scale 
ranging from Not At All Like Me (1) to A Lot Like Me (3). The interviewer will instruct the participant to 
listen to each item, and then choose the response that indicates how well that statement describes 
them in general.  Detailed instructions are provided in the QxQ instructions. 
 
10.2.4.4.1.4. Scoring and Coding 
 
Each of the 6 items is rated on a 4-point Likert-type scale with the following descriptors: 
 
Descriptor   Point Value 
A Lot Like Me   3 
Somewhat Like Me  2 
A Little Like Me   1 
Not At All Like Me  0 
 
The instrument is scored by summing all responses to produce a total score. The minimum score is 0, 
and the maximum is 18. 
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10.2.4.4.2 Job Strain 
 
An adaptation of the Karasek job strain measures will be used to assess job satisfaction, job control 
and job strain.  Supervisory or managerial responsibility and ethnic/racial work comparison are also 
assessed. 
 
10.2.4.4.2.1 Background, Rationale, and Hypothesis 

 
Issues of job control including factors such as job satisfaction, security, decision latitude and 
complexity, as well as organization of work have been implicated in the development of CVD. 
Evidence from both laboratory and observational studies indicates that control over the planning and 
execution of work influences blood pressure, smoking and eating habits Schnall, 1994; Schnall, et al., 
1990; Marmot, 1991; Johnson, et al., 1996; Snchall et al., 1992; Alterman, 1994; Fine, 1996) . Recent 
longitudinal studies (Bosmal, et al.,1997) have shown increased risk of CHD with low job control.  
Investigating the relationship of both imputed observer’s rating and worker’s self reports of 
occupational stressors to asymptomatic atherosclerosis, findings from ARIC (Muntaner, et al., 1998) 
provide further support for the notion of a protective effect of job control over work on the etiology of 
CVD. Substantive complexity, skill discretion and decisional authority were all negatively associated 
with intima-medial thickness of the carotid artery wall, an indicator of atherosclerosis. Even with 
adjustment for various risk factors, including income, this potential risk factor deserves closer 
scrutiny.  The need for prospective study of the etiologic role of work organization in atherosclerosis is 
further supported by evidence from a recent Finnish study (Lynch, et al., 1997) showing a significant 
association between work demands and progression of atherosclerosis.  As no psychosocial work 
environment scales were directly administered to ARIC participants, the JHS plans to fill this void by 
including a subset of the measures developed and validated by Karasek (1981, 1982). 
 
10.2.4.4.2.2 References 
 
Alterman, T, Shekelle, RB, Vernon, SW, Burau, KD.  (1994). Decision latitude, psychological demand, 
job strain, and coronary heart disease in the Western Electric study.  American Journal of 
Epidemiology, 139: 620-7. 
 
Bosma, H, Marmot, MG, Hemingway, H, Nicholson, AC, Brunner, E, Stansfeld, SA.  (1997). Low job 
control and risk of coronary heart disease in Whitehall II (prospective cohort) study.  BMJ, 314: 558-
65 
 
Fine, LJ.  The psychosocial work environment and heart disease. (1996).  American Journal of Public 
Health, 86: 301-33. 
 
Johnson, JV, Stewart, W, Hall, EM, Fredlund, P, Theorell, T. (1996). Long-term psychosocial work 
environment and cardiovascular mortality among Swedish men.  American Journal of Public Health, 
86: 324-31. 
 
Karasek, R, Baker, D, Marxer, F, Ahlbom, A, Theorell, T. (1981). Job decision latitude, job demands, 
and cardiovascular disease: A prospective study of Swedish men. American Journal of Public Health, 
71(7): 694-705. 
 
Karasek, RA, Schwartz, JE, Pieper, C (1982). A job characteristics scoring system for occupational 
analysis: Part I. New York: Center for the Social Sciences, Columbia University. 
 
Lynch, J, Krause, N, Kaplan, GA, Salonen, R, Salonen, JT. (1997). Workplace demands, economic 
reward and progression of carotid atherosclerosis. Circulation, 96: 302-7. 
 
Marmot, MG, Smith, GD, Stansfeld, S., et al. (1991). Health inequalities among British civil servants:  
The Whitehall II study.  Lancet, 337: 1387-93. 
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Muntaner, C, Nieto, FJ, Cooper, L, Meyer, J, Szklo, M, Tyroler, H. (1998) Work organization and 
atherosclerosis: Findings from the ARIC study. American Journal of Preventive Medicine, 14(1): 9-17. 
 
Schnall, PL, Pieper, CF, Schwartz, JE, et al.  (1990). The relationship between ‘Job Strain,’ workplace 
diastolic blood pressure, and ventricular mass index. Journal of American Medical Association, 263: 
1929-35. 
 
Schnall, PL, Landsbergis, PA, Baker, D. (1994).  Job strain and cardiovascular disease. Annual 
Review of Public Health, 15: 381-411. 
 
Schnall, PL, Landsbergis, PA, Pieper, CF, et al.  (1992).  The impact of anticipation of job loss on 
psychological distress and worksite blood pressure.  American Journal of Ind. Medicine, 21: 417-32. 
 
10.2.4.4.2.3 Administration 
 
The job strain measures will be administered during the Second Year Annual Follow-up call.  A series 
of 10 items related to job satisfaction and other work-related factors are asked by trained 
interviewers.  The last three questions relate to ethnicity in the work environment and may be 
sensitive for the respondent.  A non judgmental attitude is essential in asking these questions.  
Specific directions included in the QxQ instructions. 
 
10.2.4.5 Annual Follow-up Year 03 Questions 
 
10.2.4.5.1 John Henryism 
 
The John Henryism scale is administered as part of the Year 3 Annual Follow-up Interview. It was 
designed to assess the degree to which an individual believes s/he can overcome environmental 
demands through hard work. The relevance to the JHS is that when this orientation occurs in the 
context of an environment in which the necessary resources are lacking, the risk of poor health 
outcome increases. 
 
10.2.4.5.1.1 Background, Rationale, and Hypotheses 
 
John Henryism is defined as an individual’s self-perception that s/he can meet the demands of the 
environment through hard work and determination. It epitomizes the value of hard work and 
determination even in the face of overwhelming odds. James and colleagues have argued that 
individuals high in John Henryism but with few resources, such as a low level of education, are at 
greater risk for hypertension than those in other John Henryism by education groups (James, Harnett, 
& Kalsbeek, 1983). 
 
Support for the John Henryism hypothesis has been mixed. James, et al. (1983) found support for the 
hypothesis in a study of blood pressure among black men and in a study of hypertension among 
samples of black men and women in the southern United States (James, et al. 1987). Duijkers, et al. 
(1988) also found that the combination of John Henryism and low education was associated with 
elevated blood pressure in a study of white men and women in the Netherlands. However, three 
subsequent studies of John Henryism among blacks in the United States have failed to find support 
for the hypothesis (James, et al., 1992; Wiist & Flack, 1992), including a large prospective study 
including over 5,000 blacks and whites (i.e., CARDIA; McKetney & Ragland, 1996). However, given 
the young age of this latter sample, it seems unlikely that an adequate test of John Henryism by 
socioeconomic status has been conducted. The JHS should provide a better opportunity to address 
this question adequately. 
 
10.2.4.5.1.2 References 
 
Duijkers, T.J., Drigver, M., Kromhout, D., et al. (1988). “John Henryism” and blood pressure in a 
Dutch population. Psychosomatic Medicine, 50, 353-359. 
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James, S.A., Harnett, S.A., & Kalsbeek, W.D. (1983). John Henryism and blood pressure differences 
among black men. Journal of Behavioral Medicine, 6, 259-278. 

James, S.A., Keenan, N.L., Strogatz, D.S., et al. (1992). Socioeconomic status, John Henryism, and 
blood pressure in black adults: The Pitt County study. American Journal Epidemiology, 135, 59-67. 

James, S.A., Strogatz, D.S., Wing, S.B., et al., (1987). Socioeconomic status, John Henryism, and 
hypertension in blacks and whites. American Journal of Epidemiology, 126, 664-673. 

McKetney, E.C. & Ragland, D.R. (1996). John Henryism, education, and blood pressure in young 
adults. American Journal of Epidemiology, 143, 787-791. 

Wiist, W.H. & Flack, J.M.(1992). A test of the John Henryism hypothesis: Cholesterol and blood 
pressure. Journal of Behavioral Medicine, 15, 15-29. 

10.2.4.5.1.3 Administration 
 
The John Henryism Scale will be administered by a trained interviewer in the Third Year of Annual 
Follow-Up call.  Each item is read to the participant and requires a graded response based on how 
closely each item reflects the participant.  Specific directions are included in the QxQ instructions. 
 
10.2.4.5.2 Neighborhood SES 
 
The Neighborhood SES questions (see Forms Appendix) incorporated in the Year 2 Annual Follow-
Up interview are designed to provide an assessment of neighborhood characteristics including 
cohesion, violence and resources.  Questions are adapted from Sampson, et al. (1997). 
 
10.2.4.5.2.1 Background, Rationale, and Hypotheses 
 
Sampson, et al. (1997), among others, note that neighborhood contact may serve as both a stressor 
(neighborhood violence and disorder) or a buffer ( social cohesion and resources) for the 
development of CVD.  Further, social class of a neighborhood may have a direct or indirect effect on 
subclinical or clinical disease.  Geo-coded census block information will be attached to each 
participant record for later determination of neighborhood/community measures of social class 
according to techniques described by Krieger (1992) and Diez-Roux (1997, 1999). 
 
Hypotheses include: 
 
1. Neighborhood environment will be related to risk factors, hypertension, subclinical disease and 

CVD independent of individual level SES. 
 
10.2.4.5.2.2 References 
 
Diez-Roux, A.V., Nieto, F.J., Muntaner, C., Tyroler, H.A., Comstock, G.W., Shahar, E, Cooper, L.S., 
Watson, R.L., Szklo, M. (1997). “Neighborhood environments and coronary heart disease:  A 
multilevel analysis American Journal of Epidemiology. 146(1):48-63. 

Diez-Roux AV, Nieto FJ, Caulfield L, Tyroler HA, Watson RL, Szklo M. (1999). Neighbourhood 
differences in diet: The Atherosclerosis Risk in Communities (ARIC) Study.  J Epidemiol Comm 
Health 53:55-63. 

Krieger N.  (1992). Overcoming the absence of socioeconomic data in medical records: Validation 
and application of a census-based methodology.  American Journal of Public Health. 82:703-710. 

Sampson, R, Raudenbush, S, Earls F. (1997). Neighborhoods and violent crime: A multilevel study of 
collective efficacy.  Science. 227:918-924. 
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10.2.4.5.2.3 Administration 
 
The Neighborhood SES questions are administered by trained interviewers to all participants as part 
of the Year 3 Annual Follow-Up.  A series of questions in each of the three domains of social 
cohesion, neighborhood violence and disorder, and resources are asked.  Respondents reply using a 
Likert- like scale to rate her/his own experience.  A nonjudgmental attitude is essential as the 
interviewer asks these sensitive questions.  Specific instructions are included in the QxQ instructions. 
 
10.3 Retention of JHS Participants 
 
Continuation of JHS participants from completion of the HII through completion of the baseline exam 
and 24-hour measures and beyond is dependent on a variety of participant, organizational, protocol 
and community involvement (POPCI) factors (Wyatt, et al., 1999). A Participant Recruitment Study 
(PRS) for the JHS was conducted in 1999 to ascertain from the study community the issues and 
concerns about study participation over time. Not unexpectedly, one of the major concerns a series of 
issues related to safeguarding political and moral concerns: trust, truth, and honesty; understandable 
consent and protocol; and community co-involvement in all aspects of the study. Further, ways of 
recruiting and retaining as "gathering the JHS family" were uncovered as well as ways of building 
community partnerships as "friends of the JHS family." JHS investigators have seriously heeded each 
of these lessons in planning and developing the full study and strategies for maintaining participation. 
For a full report of the recommendations emanating from the PRS, the reader is referred to the Final 
Report of that study. A summary table of recommendations is included in the Appendix. 
 
Projected recruitment (60-80%) and completed clinic examination (80-90%) rates rely on careful 
attention to the complex interplay among all aspects of the study design and community co-
involvement in decision-making. Building and sustaining community and participant trust is an 
ongoing, iterative process requiring interpersonal effort coupled with an organizational infrastructure 
to assure success. Study investigators and staff makes every effort to maximize each interaction with 
the study community and the participants. An office of Community Partnership for Awareness and 
Health Education (CPAHE) provides ongoing information and education to the community, building 
partnerships will all elements of the community. A plan for engaging the community as beneficiaries 
and supporters of the JHS is enacted through the involvement of the CPAHE (see Community 
Partnership and Health Education Plan). 
 
Every effort is make to make the HII and Exam Center visit as pleasant and burden-free as possible. 
The following selected features are part of the effort to maximize participation across the study: (1) 
qualified interviewers, (2) pre-appointment contacts, (3) clinic greeting/welcoming procedures, (4) no 
show procedures, (5) reimbursement of transportation costs and child/adult care, (6) recognition of 
participant and personal contact, (7) supervision, (8) participant follow-up, and (9) community 
awareness. 
 
10.3.1 Certification of Interviewers 
 
Interviewers are trained and certified in general interviewing techniques and the administration of all 
relevant HII, clinic, or AFU interviews. This requires familiarity with the contents and procedures for 
administering the forms, assigning contact and appointment status codes on the appropriate Record 
of Calls form, schedule an Exam Center appointment, and verifying contact information on the CON 
form. Staff are certified in administering all forms and questionnaires after review of a standardized 
protocol Re-certification is required annually with the recommendation of periodic refresher courses 
and retraining if quality assurance analysis indicate poor performance or inconsistent results. 
 
10.3.2 Pre-appointment Contacts 
 
To increase respondent participation in the baseline exam, a pre-appointment reminder packet is 
mailed following the HII regarding the scheduled baseline examination appointment. The packet 
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thanks the participant for taking part in the HII, confirms the examination date and time, and reviews 
the preparation procedures as listed in section 1.7.3. 
 
Reminder calls are made to each participant one or two days prior to the examination. At this time, 
the information concerning the fasting requirements, medication bags, and other details is reviewed 
with the participant. Participants are asked if they have any special needs and every effort is made to 
answer participant's questions. Participants are specifically reminded to take all medications that can 
be taken without food prior to coming to the clinic appointment. 
 
When appropriate, a letter is sent to the participant's employer explaining the JHS and requesting 
time off during working hours (see Appendix). 
 
10.3.3 Clinic Greeting / Welcoming Procedures 
 
Upon arrival at the Exam Center clinic, the clinic receptionist welcomes each participant. When 
possible, an interviewer/recruiter is assigned to the clinic each week to greet participants and assure 
that there is a smooth transition from the initial contact in the HII and the subsequent clinic exam visit. 
Volunteers will also serve as clinic hostess/hosts to assure that any participant needs are met during 
the clinic visit. These volunteers may assist with reading forms, providing snacks, talking with 
participants between procedures, and so forth. 
 
10.3.4 Contact for No Shows 
 
Eligible participants who fail to arrive for a scheduled appointment or who cancel her/his 
appointments are contacted by telephone to reschedule the appointment. At that time, the scheduler 
attempts to address any concerns or fears that the participant may still have. A volunteer Council of 
Elders contact may also be initiated. (When necessary, the interviewer/recruiter who completed the 
HII may re-visit the home to ascertain any difficulties or answer any questions.)  
Recruiter/interviewers will monitor the show rate of their participant appointments making additional 
contact as needed to encourage rescheduling and completion of the baseline exam. 
 
10.3.5 Reimbursement and Child/Adult Care 
 
The Exam Center provides for, or reimburses, local transportation from the participant's home to the 
JHS clinic. For those who are reimbursed, records are maintained for accounting purposes according 
to the Office of Management and Budget regulations and the University of Mississippi Medical Center 
guidelines. 
 
Additionally, child or adult care will be provided in the JHS clinic for participants who need such 
assistance to enable them to attend the baseline examination. Space for such care is designated 
within the JHS clinic and volunteer staff is scheduled to provide oversight of children or adults when 
requested in advance by the participant. 
 
10.3.6 Recognition of Participant and Personal Contact 
 
A personal thank you is sent to each participant immediately following the HII and each AFU interview 
(see Appendix).  At the time of the clinic visit, each participant receives a small gift of appreciation for 
taking part in the exam as well as a more substantial gift or $25 as selected by the participant. 
Another thank you and formal recognition as a participant in the JHS is mailed immediately after 
completion of the baseline exam and 24-hour measures. This recognition is a certificate of 
membership in the JHS cohort that is suitable for framing (see Appendix).  
 
The Exam Center maintains personal contact with each participant throughout the year on special 
occasions such as birthday, holidays and special cultural events significant to the African-American 
community. The Office of Community Partnership issues a quarterly JHS Participant Newsletter 
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mailed to all cohort participants updating them on study progress including new and emerging 
findings. 
 
10.3.7 Supervision 
 
Throughout the entire process, from HII to baseline examination, annual follow-up, or refusal, close 
supervision helps maximize the rate of response. Supervisors record reasons for non-response and 
examine performance trends by interviewer and by area. When deemed appropriate, supervisors 
initiate re-contact with refusing participants to attempt her/his conversion. Detailed records of all 
contacts are maintained. 
 
10.3.8 Participant Follow-up and Satisfaction 
 
A “Comments and Suggestions" box is prominently located in the reception area of the Exam Center 
clinic. Forms and pencils are provided for participants to comment on their clinic visit.  An Evaluation 
of Clinic Visit (see Appendix) is conducted at the conclusion of the clinic visit to obtain a global rating 
of the visit and suggestions for improvement.  (A Participant Satisfaction Survey (see Appendix) is 
conducted by telephone on a 5-10% random sample of the cohort.  This satisfaction instrument is 
designed to gather information about all components of the HII, clinic and 24-hour examination. 
Additionally, in-depth interviews regarding the experience of participating in the JHS will be conducted 
with a designated percentage of the cohort. Interviewer/recruiters and clinic staff will notify the Exam 
Center co-PI of any participants who have had particularly notable experiences for follow-up 
interviews. These interviews will provide ongoing information for quality improvement and retention of 
the JHS cohort. Findings from the satisfaction surveys and in-depth interviews will be reviewed 
regularly by the Council of Elders, Participant Recruitment, and Cohort Operations Committees who 
will advise on strategies to improve study performance. 
 
10.3.9 Community Awareness, Resources and Education 
 
To enhance continuous participation, the Coordinating Center Office of Community Partnership 
maintains active contact with the media and key community organizations and resources. Updates 
about the study are provided regularly to provide information and enhance community support. 
Community events and educational offerings are sponsored by the JHS to provide benefit from the 
study beyond direct participation in examinations. A regular JHS newsletter is distributed to key 
community sites to ensure regular communication about the JHS and provide heart health education. 
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11.0 DIET AND PHYSICAL ACTIVITY SUB-STUDY  
 
 
11.1 Introduction 
 
The JHS has unique potential for investigating diet and physical activity associations with coronary 
heart disease (CHD) in African-Americans. Most studies have not included adequate samples of 
African-Americans and instruments used to assess these health factors in other studies, including the 
ARIC, have typically not been validated in African-Americans.  Therefore, a primary purpose of the 
Diet and Physical Activity Sub-Study is to provide data for the validation of the diet and physical 
activity instruments used in the entire cohort of the JHS.  The sub-study data, which is collected in 
association with ambulatory blood pressure monitoring (ABPM), 24-hour urine, 24-hour physical 
activity monitoring (PAM), and other data from the home induction interview and clinic exam will 
enhance interpretation of these other measures as well as their interrelationships. A sample including 
500 male and female JHS participants, with representation from varying socioeconomic levels, ages, 
and physical activity levels, will be selected to participate.  
 
11.2 Background, Rationale, and Hypotheses 
 
11.2.1 Diet 
 
The Willett Food Frequency Questionnaire (FFQ) was used in the ARIC study to assess usual diet 
intake patterns.   The Willett FFQ (62 items) was validated against four 1-week dietary records among 
173 women in the Boston area.  It is critical to note that only a small percentage of this sample was 
African-American.  Investigators have raised significant concerns regarding whether another 
instrument would be more appropriate in assessing diet within African-American populations, 
specifically the cohort in Jackson, MS.   The Delta Nutrition Intervention Research Initiative (NIRI) 
Food Frequency Questionnaire (FFQ), developed exclusively with African-Americans in the 
Southeast, was selected as the most robust FFQ for the JHS.  
 
A shortened version of this FFQ will be used to assess the entire JHS cohort. In addition to providing 
more detailed diet information on a subset of the cohort, the diet sub-study will assess the validity of 
the new short form. The integrity of significant items on the modified Delta NIRI FFQ will be 
maintained to allow the short FFQ to be analyzed as a subset of the longer Delta NIRI FFQ.  By 
combining the initial short FFQ with the sub-study data, both the original and shortened versions of 
the Delta NIRI FFQ can be analyzed and validated, expanding nutrient-based research capabilities 
for both studies. 
 
The sub-study is designed to calibrate as well as validate the Delta NIRI FFQ by comparing the 
calculated nutrient intakes from two Delta NIRI FFQs with the average intakes of four 24-hour diet 
recalls per participant.  This will provide data on the validity of the FFQ and detailed information, 
which may be useful to improve the recipes, serving sizes, and other assumptions behind the 
development of the FFQ.  We expect to document the validity of the Delta NIRI FFQ in assessing 
usual dietary intake patterns of African-Americans within the JHS cohort. 
 
11.2.2 Physical Activity 
 
Participants will wear a step counter during the week prior to some of the diet recall return clinic visits.  
The step counter data will provide a measure of average daily physical activity over several days 
across several occasions. The monitoring, coupled with the concurrent ABPM and PAM obtained on 
the full JHS cohort (see section 4.3, Manual 2: Cohort Procedures), will provide objective data for 
validation of the JHS physical activity survey instrument. 
 
The JHS Physical Activity form (PAC) assesses self-reported habitual leisure, home, occupational 
and sport physical activity.  It is administered during the interview at the home induction visit.  A 
validation study for the parent instrument for the JHS survey included representative samples of 
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ethnic minorities, but that study was conducted only with women.  In most population groups, men are 
more active than women and are involved in different types of activities than women; thus this sub-
study validation process is important to the interpretation of the JHS physical activity survey data.  In 
addition, some survey items were changed for the JHS to reduce the time required to administer the 
instrument and to include activities that may be more prevalent in men.  We expect that physical 
activity reported on the JHS survey instrument will be significantly correlated with activity monitoring 
data, step counts, and physical activity reported at the sub-study interview visits. 
 
The physical activity data from the sub-study will also be evaluated in relationship to established and 
potential cardiovascular disease risk factors such as obesity and body composition; diet composition 
and energy intake from the diet instruments; urine components associated with exertion; and 
psychosocial and neighborhood environment characteristics. We expect that physical activity level will 
be correlated with energy intake, body composition, blood pressure, resting heart rate, and 
cardiovascular disease risk factors and endpoints.  The concurrent 24-hour diet assessments and 
multiple day physical activity data collection in this sub-study will provide unique data for improving 
understanding of the correlation of energy intake and expenditure in community samples and 
specifically in the understudied African-American population. 
 
11.3 Sampling Design and Recruitment 
 
11.3.1 Sample Inclusion and Exclusion Criteria 
 
Inclusion criteria are: 1) attendance at JHS clinical examination visit; 2) willing and able to wear the 
step counter and CSA accelerometer for 24-hour study; 3) willing to volunteer for sub-study and 4) 
completion of informed consent.  Exclusion criteria are: 1) unable to walk (may use aid such as cane); 
2) lack of interest in participating; 3) interviewer or JHS investigator determination that participation is 
not in best interest of participant. 
 
 
11.3.2 Sampling Procedures for Sub-study Cohort Selection 
  
The JHS sampling design is described in section 1.3, Manual 2: Cohort Procedures. The cohort is 
comprised of remaining ARIC participants, a community random sample, and a family sample. All 
JHS participants will be asked to wear the activity monitor and step counter during the 24-hour 
monitoring following the clinic exam. Exceptions will occur when equipment is not available, 
participants request to not wear this additional equipment, and when study staff or investigators 
believe it is not in the best interest of the participant. Thus, the 24-hour activity monitoring will be a 
collected on a large sample approximating the sampling distribution of the JHS entire cohort.  
 
All JHS participants having completed PAM are eligible for inclusion in the Diet/Physical Activity Sub-
Study. A total of 500 participants will be recruited to complete the follow-up diet and physical activity 
interviews for the sub-study. Initially every second participant with usable data retrieved from the 24-
hour PAM will be invited to participate in the sub-study.  Eligibility will be established using the Diet 
and Physical Activity Sub-study Eligibility Screening (SEL) form (see Forms Appendix).  A Recruiting 
Roster will be maintained to document those eligible (see Appendix). After the first 100 participants 
have been entered, the investigators will examine their characteristics in terms of gender, SES, age, 
and activity to make a determination of the need for inclusive over-sampling to adequately sample the 
different levels of these characteristics.   
 
Investigators will pre-screen participants to determine sub-study eligibility using data from the Home 
Induction Interview, if this becomes necessary to optimize sub-study recruiting. Using the appropriate 
items on the SEL, they will extract Home Induction Interview data to classify potential participants. 
Gender and age will be obtained from the ELG form completed at the Home Induction Interview. The 
recruiting goal is for one-half the sub-study participants to be women.  The sub-study sampling goal 
also includes approximately equal numbers of participants in younger (34-64) and older (65 and 
older) age groups, from lower and higher socioeconomic status groups, and from lower and higher 
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physical activity groups. Socioeconomic Status (SES) groups will be classified as poverty or non-
poverty level participants.  Classification will be based on the participants’ responses of the Personal 
Data-Socioeconomic Status form.  A poverty classification requires a response of “yes” to items 27e, 
f, g, or h or if the family income reported for item 28a falls on or below income level 3.  Participants 
will be classified in the lower physical activity group if: the response is “0” on Item 7 (indicating no 
leisure time vigorous activity) and the response is A, B, or C on item 9 (indicating work activity is the 
same as or lighter than others of their age) and the response is N on Item 19 (indicating no exercise 
and sports participation) on the Physical Activity form (PAC).  
  
11.3.3 Informed Consent 
 
Participants from the JHS who may be eligible for the sub-study will be given a brochure (see 
Appendix) as they complete their clinic visit. They will be contacted by telephone and invited to 
volunteer for the sub-study.  Those who agree will be given a clinic appointment. Written consent will 
be obtained when the sub-study participant reports to the clinic for the first follow-up visit.  At that 
time, the participant will be asked to sign the IRB-approved Diet and Physical Activity Informed 
Consent Form (see Forms Appendix) documenting their willingness to participate.  
 
11.4 Scheduling and Mail Out Procedures 
  
11.4.1 Scheduling 
 
Within about two weeks following the clinic exam, eligible JHS participants will be contacted by 
telephone using a standard script to invite participation in the sub-study. All contact attempts for 
recruitment and scheduling are documented on the Diet and Physical Activity Sub-study Record of 
Calls (SRC) (see Forms Appendix). Those who agree will be scheduled for a return visit for their first 
follow-up diet interview at the JHS clinic at a time that is convenient for them and about four weeks 
following the baseline clinic exam. The sub-study staff member will record appointments scheduled 
using the sub-study Appointment (SAP) form (see Forms Appendix).  
 
There will be six data collection occasions for the sub-study participants.  Scheduling criteria to 
assure data will include differing days of the week and seasonal variation will include: 
 
FFQ encounter # 1 (short version) followed by 24-hour activity and step counter monitoring: Initial 
JHS exam visit,  (any day of the week except Sunday) 
 
24-hour recall #1 with step counter data collection and past week physical activity: about one month 
after initial exam  
 
24-hour recall # 2 with step counter data collection and past week physical activity: about 2 months 
after initial exam   
 
24-hour recall # 3 with step counter data collection and past week physical activity: three months after 
initial exam   
 
24-hour recall # 4 with past week physical activity: at least five months after initial exam  
 
FFQ encounter #2 (long version): within one week of last 24-hour recall  (any day of the week) 
 
Data collection encounters for each sub-study participant will be scheduled as follows: 
 
Two 24-hour diet recalls and physical activity measures should be scheduled for any of the following: 
 
Monday’s intake:  Assessed on Tuesday 
Tuesday’s intake:  Assessed on Wednesday 
Wednesday’s intake: Assessed on Thursday 
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Thursday’s intake  Assessed on Friday 
 
One 24-hour diet recall and physical activity measure should be scheduled for: 
 
Friday’s intake:  Assessed on Saturday 
 
One 24-hour diet recall and physical activity measure should be scheduled for: 
 
Sunday’s intake:  Assessed on Monday 
 
It is estimated that the time between the initial short version FFQ and final long version FFQ will be 
approximately 6 months, which should allow for variation in seasonal intake and activity. 
 
11.4.2 Mail Out Procedures 
 
After confirming the sub-study participant’s willingness to return for a diet and physical activity 
interview, a Sub-study Appointment Reminder (see Appendix) letter will be mailed. The caller will also 
offer to mail a second copy of the sub-study brochure.  Prior to the second, third, and fourth return 
visits, the mail out will include the step counter in a padded envelope, and the Step Counter Log 
(SCL) Form (see Forms Appendix), which includes instructions on the reverse side for wearing the 
step counter and recording the step count daily.  The step counter and form will be mailed about a 
week prior to the scheduled follow-up visit so the participant can collect data for three days prior to 
the visit. 
 
11.5 Data Collection Procedures and Equipment 
 
Participants will return to the clinic for five follow-up visits over a six-month period of time. All 
interviews will be administered face-to-face at the JHS Exam Center.  Figure 1 contains a schedule of 
data collection measures for the sub-study.   
 
Figure 5. Schedule of Measures 
 
 Visit 1 

(Clinic 
Exam) 

Follow-Up 
Visit 2 

Follow-Up 
Visit 3 

Follow-Up 
Visit 4 

Follow-Up 
Visit 5 

Follow-Up 
Visit 6 

Informed Consent 
for sub-study 

     X     

24 hr ABPM 
 

  X      

24 hr urine 
 

  X      

Anthropometric 
Measures 

  X  
 

 
 

  
 

Weight 

Clinical examination 
and sociocultural 
measures 

  X      

24 hr CSA 
Monitoring 

  X      

Diet FFQ  
 

  X 
Short 

    X 
Long 

Diet 24-hour Recall 
 

   X   X   X   X   

3 day step count 
 

  X   X X  

Past Week PA recall    X X   X   X   X 
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11.5.1 Diet 
 
The 24-hour diet recalls will be administered using the Minnesota Nutrition Data System (NDS). 
During the final follow-up visit, the long form of the Delta NIRI FFQ is administered (see Forms 
Appendix).  Interview tracking, whether it is 24-hour diet recall or FFQ, will be recorded on the Diet 
Interview Tracking (DIT) (see Forms Appendix).   
 
 
11.5.1.1 Administration of 24-hour diet recall and FFQ  
  
This design will include 2000 24-hour dietary recalls (4/participant) using the MN-NDS using a 
multiple-pass approach and 1000 FFQ (2/participant).  Several food models, beverage containers and 
three-dimensional portion size estimation tools will be used to aid participants in estimation of 
portions.  A US Supplement Ingredient Form ( see Forms Appendix) will be administered to record 
the participant’s supplement usage.  For administering 24-hour diet recalls, the NDS Training Manual 
should be referenced.  Refer to the Interviewer’s Training Manual (see Appendix) and the 
Interviewer’s Reference Guide for guidelines on administering the Delta NIRI FFQ.   
 
11.5.2 Physical Activity 
 
Digiwalker step counters will be used to assess physical activity involving walking during the week 
prior to three of the return visits.  Step counts are recorded by the participant on the SCL form (see 
Forms Appendix).  The study staff member will use the Post Step Counter (PSC) form (see Forms 
Appendix) to record whether the step counter was returned and the log completed according to 
instructions. The previous weeks’ physical activity will also be assessed at the follow-up visit by 
interview using the 12-item Past Week Activity (PWA) form ( see Forms Appendix).  The questions 
ask about activity at work, frequency and duration of moderate level activities, frequency and duration 
of vigorous activities, walking frequency and duration, and muscle strength and toning exercise during 
the past week.  Items on this form have been validated in previous studies (Ainsworth, et al., 2000). 
 
11.5.2.1 Administration of Past-Week Physical Activity Recall Form 
 
The interviewer reads each question and records the response on the PWA. See the QXQ (Forms 
Appendix) for detailed instructions. 
 
11.5.2.2 Use of Step Count Form 
 
Special instructions for each physical activity form are contained in the QXQ’s (Forms Appendix). 
Participants will be asked to wear the step counter for three days during the week prior to three of the 
visits and to record the step count each evening on a log that they return to the study staff. 
 
The step counter instructions ask participants to wear the step counter at their waist, above the hip, 
for 3 days.  To get daily step counts as a marker for level of physical activity, participants will be 
asked to record the total number displayed on their Digiwalker each evening on the SCL form and 
then reset the instrument to “0” to begin a new count for the next day. If they do not wear the step 
counter for part of a day, they do not record the total for that day.  They reset the counter to “0” and 
wait until the next morning to wear the counter.  If they forget to reset the counter in the evening, they 
let it count until the end of the next day and make a note on the form that the count is for two days. 
 
Participants will not be given information that would help them interpret whether the number of steps 
recorded is “high” or “low,” or “good” or “poor.”  If they ask, they will be told that this is what the 
investigators are trying to learn.  Steps per day are different depending on the amount of walking 
involved in each person’s physical activity (Welk, et al., 2000). 
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If feasible, a study staff member may phone the participants to remind them to record step counts and 
return the step counter at the visit. The interviewer retrieves the step counter from the participant at 
the beginning of the sub study clinic follow-up visit, examines the information recorded on the SCL 
form by the participant, and completes the sub-study PSC. If participants forget to bring the step 
counter and form to the clinic with them, they are given a padded, addressed, postage-paid envelope 
and asked to mail these back as soon as possible. 
 
11.6 Data Management  
 
11.6.1 Diet Data 
 
Dietary data will be grouped into batches.  Batches will be in SAS format. Each batch should include 
50 participants and contain a complete set of dietary data.  A complete set includes four 24-hour diet 
recalls and two FFQ’s.  Each batch is named in numerical order beginning with “Batch 01.”  An 
Access data management roster will be maintained by DPASS personnel to keep track of the batch 
names and the individual participants ID numbers included in each batch. No data will be sent to 
Tufts until a complete set for 50 participants has been obtained.  Identifiers will be recorded on 24-
hour recall records or FFQ’s, that will be sent to Tuft’s. 
 
11.6.1.1 Checking Data (before sending to Tufts) 
 
24-hour diet recalls and NDS require identification of a unique project name for entering data.  Each 
project name will be named corresponding to its batch number.  Diet data for the first 50 participants’ 
dietary data sets are identified as “Batch 01.” The NDS project name for each will be named 
corresponding to the Batch number (e.g. “Batch 01,” “Batch 02,” etc).  Although personal identifying 
data will be omitted on all diet records, the JHS identification number will allow linkages of diet data to 
other data variables.  Identical to the dietary shipments to Tufts described above, each project name 
will have 50 participants with their four 24-hour recalls.  The 24-hour diet recalls will be entered and 
reviewed for final edits before sending to Tufts by DPASS personnel. 
 
Food Frequency Questionnaires. All FFQs should be assigned the same batch name as the 24-hour 
diet recalls.  All FFQ’s will be reviewed for missing data, bends, rips, folds, stray marks, or incomplete 
erasures before sending to Tufts. If there are missing data in the FFQ, diet sub-study staff should 
contact the participant for complete data.  If the participant is unable to answer or can not be 
contacted, then the missing data should be recorded as “never eaten” and specific notes to this effect 
kept for future reference.  Please note: all data empty spaces must be completed to get a final FFQ 
analysis. 
 
A Diet Shipping form (see Forms Appendix) will be used to accurately keep track of the data transfer.  
See QXQ (see Forms Appendix) for detailed instruction for completion of the form. 
 
11.6.1.2 Data Transfer procedures  (JHS CC/Tufts) 
 
Upon completion of a 50 participant batch file, DPASS personnel will transfer diet data to Tufts using 
a File Transfer Protocol (FTP). 
 
To ensure data accuracy, for the first 50 participants, data from only the first and second 24-hour diet 
recall and first FFQ will be sent to Tufts for review.  The 24-hour diet recall data should include the 
NDS project file and food file and can be sent electronically.  The original FFQ form must be sent by 
mail. 
 
Once these initial 50 participants have completed their third and fourth 24-hour diet recall and last 
FFQ, these completed data sets should be sent to Tufts in the same format described as above. 
 
Thereafter, data batches will be transferred to Tufts as complete sets of 50 participants (two FFQs 
and four 24-hour diet recalls per participant X 50 participants.)        
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Every six months a SAS transport file will be generated by Tufts and shipped electronically to JHS. 
This data file will include daily totals of the 24-hour diet recalls and FFQs.  
 
11.6.2 Physical Activity 
 
The physical activity sub-study data will be managed in Jackson by the JHS study staff and the sub-
study principal investigator. All physical activity sub-study data will be maintained internally by sub-
study staff and exported to the JHS CC on a regular schedule. 
 
11.6.2.1 Step Counter Data 
 
To minimize or explain missing data, study staff will review the portion of the Step Counter Log (SCL) 
form completed by participants with them during the visit. See QXQ (see Forms Appendix) for 
detailed instructions. 
 
11.7 Training, Certification, and Quality Assurance 
 
11.7.1 Diet 
 
Diet sub-study staff will be required to complete an extensive training and certification protocol 
conducted by the JHS diet principal investigators and Tufts. Certification will be completed upon 
satisfactory completion of: 
 
Completion of the Tufts training course and seven accurate Delta NIRI FFQ administrations is 
required prior to administering JHS interviews. The final two FFQ’s are audio taped and must have  
<3% error rate upon review. A 5-10% random check of the original FFQ’s will be conducted by Tufts 
to check for missing data or unused portion sizes. 
 
Completion of a two-day NDS training program and accurate completion of seven NDS 24-hour diet 
recalls must be attained to administering JHS interviews.  The final two are audio taped and must 
have a <6% error rate upon review. 
 
All 24-hour diet recalls will be tape recorded to aid in reviewing and editing for accuracy.   
 
Five percent of FFQ administrations will be audio taped.  A second interviewer will recheck these 
FFQ tapes and 5% of 24-hour diet recalls for quality control.  These reviews will be conducted 
randomly and completed prior to data transfer to Tufts. 
 
Tufts will check the data set by batch for outliers, with nutrient totals, gram weights, frequency and 
serving sizes for both the 24-hour diet recalls and FFQ. Comparison of mean intakes from the 24-
hour recall and the FFQ will be done every six months. 
 
Problematic administration techniques or data entry errors will be discussed during scheduled diet 
study staff meetings.  Specific interviewer deficits will be documented and reviewed with the 
interviewer in private. A Quality Assurance Tape Review form (see Appendix) will be used to identify 
problems and provide solutions. 
 
Maintaining certification will be achieved by ongoing review of data collection. If any interviewer falls 
below acceptable accuracy ranges, they will be required to be complete several recertification 
exercises under the direction of the diet study investigator to bring this accuracy level within the 
desired range.  This review is conducted monthly as an ongoing quality assurance activity. 
 
11.7.2 Physical Activity 
 
All sub-study staff are required to complete physical activity training conducted by the physical activity 
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sub-study principal investigator and consultants. Certification of competency for all forms will follow 
the same procedures as the diet instruments.  Administration of the items on the form will be audio 
taped along with samples of the 24-hour diet recall data.  This will allow verification of accurate 
recording of the responses for a 3% sample by a second interviewer and spot-checking by the 
Physical Activity sub-study principal investigator. 
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FOREWORD 

 
 
This manual is one of a series of protocols and manuals of operation for the Jackson Heart Study (JHS).  
The complexity of the JHS requires that a sizeable number of procedures be described, thus this rather 
extensive list of materials has been organized into the set of manuals listed below.  Manual 1 provides the 
background, organization, and general objectives of the JHS Study.  Manuals 2 and 10 describe the 
operation of the Cohort and Surveillance Components of the study.  Detailed Manuals of Operation for 
specific procedures, including those of reading centers and central laboratories, make up Manuals 3 
through 9 and 11. 
 
 

JHS Study Protocols and Manuals of Operation 
 
 

MANUAL TITLE 
  
1 General Description and Study Management 
  
2 Cohort Component Procedures 
  
3 Family Study 
  
4 Blood Pressure  
  
5 Electrocardiography 
  
6 Echocardiography 
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9 Specimen Collection and Processing 
  

10 Cohort Surveillance 
  

11 Data Management System 
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1.0 INTRODUCTION  
 
 
1.1 Overview 
 
The Data Management System (DMS) is used to collect, process, and store information about 
participants in the Jackson Heart Study (JHS).  This user guide describes the steps in the collection and 
management of data entered in the DMS during a center exam interview, from paper forms, or through 
batch-loading of an ASCII file. 
  
The JHS DMS was developed using the Clintrial 4 (hereafter referred to as Clintrial) clinical research 
system software.  Clintrial consists of a set of integrated core modules for data collection, management, 
and retrieval.  This document specifically discusses the tasks using the Clintrial Enter module and Clintrial 
Manage module. 
 
Clintrial Enter allows for data entry, editing, verification (double data entry), and storage of data in a JHS 
study database.  Data checks are automatically performed during data entry by a check of a data value 
against predetermined edit specifications, and any value that fails a data check can be corrected 
immediately or flagged for future resolution. Built-in Clintrial reports and custom reports are available to 
check status of data entered and to look for any data inconsistencies. 
 
Data are entered into update tables and are referred to as unmerged data in Clintrial while in the update 
tables.  The data manager using the Clintrial Manage module moves data to the data tables.  The update 
and data tables are in an Oracle database, and Clintrial handles the storage and use of these data tables 
in a way transparent to the user. 
 
Using the Clintrial Manage module, a data manager can perform additional tasks in the management of 
the JHS data.  The person in this role has extended access rights to the study data tables and familiarity 
with the Clintrial database structures.  Tasks within the Manage module include batch-loading laboratory 
or ancillary data from an ASCII file, manual coding of medication data from industry-standard dictionaries, 
moving data from update tables to data tables, making global changes or deletions across multiple 
records, and reviewing processing logs and error or change reports. 
 
1.2 Sample Data Management Workflow        
 
Section 2 of this document provides the step-by-step instructions on each task for data entry.  Figure 1 
gives a visual representation of the data entry workflow.   
 
Section 3 of this document describes other tasks that are performed in the management of the JHS data.  
Figure 2 shows a data management workflow of the data entry and management tasks for the DMS. 
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Figure 1 Data Entry Workflow 
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Figure 2 Data Management Workflow 
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1.3 Data Entry Help Menu and Glossary of Terms 
 
The Help menu includes step-by-step instructions to perform tasks in Clintrial along with overviews of 
concepts and descriptions of the menus and options.  A glossary provides an extensive dictionary of 
special Clintrial terms.   
 
To search for information in Help: 
 
1. Select Help > Help Topics. 
2. To find a topic in the Help Topics dialog box: 

a) Click on the Contents tab for topics by category. 
b) Click on the Index tab for index entries. 
c) Click on the Find tab for a search on specific words. 

3. For the glossary of terms, click on the Contents tab and then double-click on Glossary at the top of 
the list.  

 
Additionally for help on an open window or dialog box, press F1. 
 
Some of the Clintrial terms and their descriptions that are found in this document are as follows: 
 
Protocol – a Clintrial account that consists of the data and other components used by the DMS for a 
research study. 
  
Study Book – an online representation of a list of the data collection forms.  Each study book contains an 
ordered list of study pages grouped into blocks. 
 
Block – a group of related study pages in a study book, usually representing a visit or contact occasion. 
 
Study Page – a data entry window that usually corresponds to a single data collection form, however 
some forms have multiple study pages because of a length limitation of the data entry window template. 
 
Study Page Number – a sequential number assigned to the study pages in their alphabetical order 
(usually) by form-version. 
  
Repeating Page – a single block of study pages that can be repeated multiple times for repeated visits 
(only twice in the JHS DMS).  A repeat visit is optional and rare for the baseline visit.  A block repeat key 
value uniquely identifies a repeat of a block and is stored in the block repeat key item that is a visit-related 
context (key field) item.  The block repeat key value is entered during data entry for a repeated visit from 
a drop-down list of values. 
  
Subject – a participant in a research study for whom data are entered in the DMS. 
 
1.4 References 
 
Information for this instruction manual for JHS comes from the Clintrial 4 Release 4.2 software manuals 
and from the Clintrial 4.2 Design Training Guide published by Domain Pharma Corporation.  Clintrial is a 
trademark of Domain Pharma Corporation. 
 
The current release of Clintrial 4.2 stores data in an Oracle8 database. Oracle is a registered trademark 
of Oracle Corporation. 
 
The SAS System Version 8 from SAS Institute Inc. is used in writing the custom reports and for the data 
retrieval process in the JHS DMS. 
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2.0 DATA ENTRY GUIDE 
 
 
2.1 Starting a Data Entry Session 
 
2.1.1 Logging In 
 
You must login to a Clintrial session to access the JHS DMS for data entry.  The steps to login and start a 
data entry session is as follows: 
 
1. From the Windows Desktop, double-click on the JHS Data Entry icon.  As an alternative, select 

Start > Programs > Clintrial 4.2 > Clintrial Enter. 
2. The Database Connection dialog box is displayed.   Login to Clintrial, as follows, with the 

information that was set up for your user account:  
a) Enter your Clintrial User Name. 
b) Enter your Password. 
c) Enter the character string @ORC0 for Database. 

3. Click OK to leave the dialog box.   
 
The first time you start a Clintrial session, the fields in the Database Connection dialog box are empty.  
The next time you start a session, the user name and database that you last used to start Clintrial are 
displayed as defaults in the dialog box. 
 
On a successful login, you are in the Clintrial Enter window. 
 
2.1.2 Changing a Password 
 
If you want to change your Clintrial password for any reason, do the following: 
 
1. From the Clintrial Enter window, select File > Password. 
2. In the Password dialog box, follow the instructions to set up a new password.  Click on OK to finish. 
 
A password must conform to the Clintrial password minimum length currently set at 6, must consist of 
alpha and/or numeric characters (other symbols and spaces not allowed), and cannot begin with a 
number.  A password is not case sensitive. 
 
If you have any difficulty getting started in Clintrial or forget your current user name and/or password, see 
your Database Administrator (DBA). 
 
2.2 Selecting the Protocol and Study Books 
 
2.2.1 Overview 
 
This DMS organizes data for the different components of this study into protocols.  One protocol named 
JHS_COHORT comprises the data from the Baseline Visit (enumeration, home induction interview, 
center exam, and 24-hour exam) and the annual contacts (annual contact details are not yet available).  
The Surveillance and Family Study components of this study will be organized into two additional 
protocols (details are not yet available). 
 
The data in JHS_COHORT are organized into study books.  A study book represents the collection of 
data collection forms called study pages grouped into visits called blocks.  The study books in 
JHS_COHORT are as follows:  
 
• INTERVIEW (enumeration and home induction interview data) 
• EXAM (center exam and 24-hour exam data) 
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• ANNUAL (annual follow-up data, not yet available) 
 
An enrollment study book named ENROLL is available exclusively to enroll new study participants.  A 
participant must be enrolled before any data can be entered for that participant. 
  
2.2.2 Setting the Protocol and Study Book 
 
The first time you start the JHS DMS for data entry, you must set the protocol and study book.   
 
To set the protocol, do as follows: 
 
1. In the Set Protocol dialog box, click to highlight the protocol in which you want to work, for example, 

JHS_COHORT. 
2. Click on OK to continue. 
 
The next time you start the DMS, Clintrial automatically selects the protocol that you last used and asks if 
you want to use the protocol selected.   Click on Yes to select the protocol; click on No to enter the Set 
Protocol dialog box to select another protocol. 
 
After setting the protocol, set the study book as follows: 
 
1. The Set Study Book dialog box opens automatically after you set the protocol.  Click to highlight the 

study book in which you want to work, for example, INTERVIEW. 
2. Click on OK to continue. 
 
Clintrial automatically chooses the study book that you used during your last session on subsequent 
logins to the DMS.  A message is displayed asking you to confirm that this is the study book you want to 
use.  Click Yes to select the study book; click No to enter the Set Study Book dialog box. 
 
2.3 Accessing Forms Using the Clintrial Navigator 
 
2.3.1 Overview 
 
The best method to access forms within each study book is by using the Clintrial Navigator.  The 
Navigator is a browser that graphically displays the blocks, study pages, and subjects in a study book. 
The Navigator uses icons to uniquely identify these objects, and a double-click on an icon opens that 
object in the Navigator.  Figure 3 shows the Navigator in the navigation order of Navigate by Page. 
  
In the Navigator for the JHS DMS, the study pages are listed in ascending order of their study page 
number. Note that some forms have multiple study pages (indicated as Part 1, Part 2, etc.) due to a 
length limitation in the design of the data entry window templates. 
 
The Navigator menu commands offer another method to navigate through the sequence of forms and 
subjects in a study book.  A description of the menu commands is in Figure 4. 
 
The Help menu provides more detailed instruction in the use of the Clintrial Navigator. 
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Figure 3 The Navigator  (Navigate by Page) 
 

 
 
 
 
Figure 4  Navigator Menu Commands 
 
 Menu command Description 
 Go To Open a form by using the Go To dialog box.  Enter ID 

NUMBER, CONTACT YEAR, and PAGE number. 
 Go To Selected Go to the study page highlighted in the Navigator. 
 Next* Go to the next study page in the navigation order. 
 Previous* Go to the previous study page in the navigation order. 
 Next Subject Go to the current study page for the next subject. 
 Next Page Go to the next study page for the current subject. 
 Previous Subject Go to the current study page for the previous subject. 
 Previous Page Go to the previous study page for the current subject. 
 Navigate by Subject Set the navigation order to By Subject (list of subjects 

under each study page). 
 Navigate by Page Set the navigation order By Page (list of study pages 

under each subject). 
 Expand Expand the selected Navigator order. 
 Collapse Collapse the selected Navigator order.  
 Sort Subjects Set the sort order for subjects in Navigator as ascending 

or descending. 
 Navigator Open the Navigator. 
 

*Depending on the Navigation order selected, Next or Previous opens either the next or previous 
page for the current subject (Navigate by Page), or opens the current page for the next subject 
(Navigate by Subject). 
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2.3.2 Using the Navigator 
 
For the JHS DMS, the Navigator is set to open automatically whenever you open a study book.  If 
Navigator does not open automatically, select the Navigate > Navigator menu commands. 
 
This section describes the Navigator in navigation order Navigate by Page that is the recommended 
navigation setting for the JHS DMS.  For Navigate by Page, the Navigator icons as shown in Figure 3 
are as follows: 
 
• Subject – a book (closed if collapsed, open if expanded) 
• Block – a boxed arrow (right arrow if collapsed, down arrow if expanded) 
• Study page – a page  
• Repeating page – overlapping pages 
 
An icon is shaded if any data are present. 
 
As displayed in Figure 3, the study book EXAM is open and contains one block called CENTER EXAM 
with the study pages grouped under each subject.  For JHS, the study pages are listed in alphabetic order 
by form code. To expand or collapse a subject, block, or study page, double-click on its icon. 
 
The Contact Information form in the INTERVIEW study book is designed as a repeating page to allow for 
the possibility of additional data from a repeat contact with a subject.  For the first Contact Information 
form, enter the repeating page number as 0 (zero) when prompted.   Enter repeating pages as 
consecutive numbers 1, 2, etc.  
 
2.4 Enrolling Subjects 
 
2.4.1 Overview 
 
A new subject must be enrolled in a protocol before any data can be entered for that subject.  The DMS 
allows for enrollment of new subjects either in the ENROLL study book or within a study book prior to 
entry of any data.  It is recommended to enter a new subject within a study book from the File menu due 
to current Clintrial limitations that may cause loss of data using the ENROLL study book.  
 
Enrollment data are the subject-related items ID NUMBER, LAST NAME and INITIALS appearing at the 
top of the first page of each form.  These are required fields in the DMS, and the fields must contain data 
to continue data entry. 
 
2.4.2 Adding New Subjects 
 
Enrolling subjects in a data study book (recommended) 
 
If you are only adding a few subjects at a time along with their data, you can enroll the new subjects from 
within a data study books. 
 
To enroll a new subject, do as follows: 
 
1. Select the File > New Subject menu commands to open the New Subject dialog box. 
2. Enter ID NUMBER, LAST NAME and INITIALS in the Enrollment Information section.  

a) ID NUMBER is a unique subject identifier.  If you enter a non-unique subject identifier into the 
DMS, Clintrial displays a message that you cannot enroll the subject since the subject has 
already been enrolled. 

b) Since these are required fields, if INITIALS or LAST NAME is not available then enter X’s in the 
field.  For example, enter the household last name for LAST NAME and X’s for INITIALS for 
enrollment of a Household ID. 
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c) Use the Tab key to move from one field to another.  If you use the Enter key, Clintrial attempts to 
leave the New Subject dialog box, and if any fields are blank, it displays a message to enter data 
in the highlighted fields which you must do before you can leave this dialog box.  

3. After completing the subject enrollment information, click one of the following: 
a) Go To Page to save the subject information and to go to the subject’s first study page. 
b) Add Next to save the subject information and add another new subject (repeat items 2 and 3). 
c) OK to save the subject and to close the New Subject dialog box. 

 
To modify or delete any subject information in the New Subject dialog box that have not yet been saved, 
do one of the following: 
 
1. To modify the subject information, place the cursor in the field you want to modify, delete the old 

information and enter the new information. 
2. To delete the subject information, click on Cancel to delete the information and exit from the New 

Subject dialog box. 
 
Enrolling subjects in the enrollment study book (not recommended) 
 
The enrollment study book contains only one study page that opens automatically when you open the 
ENROLL study book.  Using the enrollment study book is most effective when you are enrolling a group 
of subjects prior to entry of any data, or when you want to view or print a list of enrolled subjects. 
  
To enroll a subject in the enrollment study book, do as follows: 
 
1. Select the File > Set Study Book menu commands.  Highlight ENROLL and click OK to continue. 
2. The SQL Restriction Clause Builder window automatically opens.  Click Cancel or OK to continue.  

SQL restrictions are not being used at this time. 
3. The cursor is on the first field to enter a new subject.  Enter ID NUMBER, LAST NAME and 

INITIALS.  Use either the Tab or Enter key to move to the next field. 
4. To enter additional new subjects, press Ctrl-A or select the Edit > Add Subject menu commands.  

Enter each new subject as in step 3.  Repeat these steps until you enter the last subject. 
5. Close the enrollment study page by clicking on the (X) windows button for the page or select the File 

> Close menu commands. 
 
To modify or delete any subject information in the enrollment study book that have not yet been saved, do 
one of the following: 
  
1. To modify the subject information, place the cursor in a field belonging to the subject you want to 

modify, delete the old information and enter the new information. 
2. To delete the subject information, place the cursor in a field belonging to the subject you want to 

delete and select Edit > Delete Subject from the menu commands. 
 
Modifying and deleting subject information after data have been saved 
 
Once a subject’s enrollment data have been saved by either enrollment method, you cannot modify the 
enrollment data in the Clintrial Enter module.  Modification to saved enrollment data must be done in the 
Manage module by the Data Manager. 
 
2.5 Entering Data 
 
2.5.1 Overview 
 
Data are entered in a study page that is a representation of the data collection forms.  Some forms have 
multiple study pages due to form length limitations in the design of the data entry screen templates.  
Flags and notes are information about data that can be attached to fields or a study page during data 
entry. 
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Figure 5 shows an example a study page open for data entry. 
 
 
Figure 5 Study page 
 

 
 
 
2.5.2 Adding New Data 
 
2.5.2.1 Characteristics of Form Fields 
 
Field Types 
 
Several types of fields appear in a study page: 
 
• Enterable fields are fields in which you can enter data.  These fields have a white background and 

can accept the cursor. 
• Non-enterable fields are fields in which you cannot enter data.  These fields have a colored 

background (usually gray) and will not accept the cursor.  Examples are computed fields and skipped 
fields that follow a skip trigger field. 

 
Data Types 
 
Each field has been assigned a data type attribute.  The following data types are used in the JHS DMS: 
 
Field Type Data Type Description and Example 
Numeric FIXED  An integer that cannot include a decimal point. 
    The integer can be prefaced with a plus or minus sign. 
    Example: 100. 
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Numeric FLOAT  A number that can include a decimal point. 
    The number can be prefaced with a plus or minus sign. 
    Example: 25.6 
Date  DATE  A date in the format mm/dd/yyyy (month/day/year). 
    Leading zeroes are accepted but not required for month and day. 
    Missing date parts must be estimated, e.g., 01 for missing month or day. 
    Enter a slash or hyphen as the delimiter separating date parts. 
    Example: 06/20/2000 
Character TEXT  A character string that can include letters, numbers, punctuation marks, 
    spaces, and special characters.  Enter character strings in upper case. 
    Partial dates (mm/yyyy) and times (hh:mm) are entered as character 
    strings since Clintrial does not have a comparable data type. 
    Examples: J123456, ASPIRIN, 09/2001, 04:45 
 
Note the following for date field types: 
• From the Clintrial Help menu, “Years can be entered as two digits or four. When a two-digit year is 

entered, Clintrial stores numbers 00 to 49 as 21st century (2049) and numbers 50 to 99 as 20th 
century (1950).”  It is important to enter year as a 4-digit number to ensure the correct century. 

• Although the Clintrial date uses the DATE data type, a date is stored with the DATETIME data type in 
the Oracle database.  In rare cases during data entry, you may see a date field type displayed in 
DATETIME format. 

 
Value Ranges 
 
Most numeric and date fields have lower and upper bounds.  You must enter a value within the specified 
limits.  However, if the correct value is outside these bounds, the JHS DMS has been designed to allow 
you to enter a value that overrides these bounds. 
 
If you enter a value outside the bounds, Clintrial issues a message that the item value is outside the 
range and asks if you want to override and accept this value.  You can accept or not accept the value, 
with the following actions: 
 
• If you do accept this value, Clintrial will attach a flag to the field and a red flag icon will appear to the 

right of the field (see Using Flags for more information).  The cursor will move to the next field. 
• If you do not accept this value, the value of the field will return to its previous state (either blank or a 

previously entered value), and the cursor will move to the next field (unfortunately a Clintrial feature 
with the autoskip functionality).  You must return to the previous field that invoked the message by 
pressing Ctrl-Tab or clicking on the field to enter the correct value. 

 
Drop-Down Boxes 
 
Drop-down boxes are used for fields that have a list of acceptable values, such as a list containing Yes, 
No and Don’t Know.  You can only select the values that appear in the list for the field.  You can enter a 
value in the field in one of the following ways: 
 
• Enter the code associated with the value in the list, such as Y for Yes.  The value appears in the field. 
• Click on the down arrow button to display the list.  To select a value, press the keyboard key that 

corresponds to the value’s first letter or click on the value.  The value appears in the field.  Long lists 
will have a scroll bar to move down the list of values. 

 
You may encounter a value in a drop-down list that cannot be selected if that value has become obsolete.  
The value will be displayed as red text.  
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Missing Data 

There are no special character or numeric entries for missing data in the JHS DMS.  Simply leave the 
value blank.  For the JHS DMS, it is recommended to add a flag called PERMANENTLY_MISSING to the 
field (see Using flags).  Add a comment in the Item Flag dialog box to indicate the reason for permanently 
missing. 

To change a field with data to missing, delete the value in the highlighted field by pressing the keyboard 
Backspace key or selecting the Edit > Clear menu commands.  To change data to missing for a field with 
a drop-down list, select (None) from the drop-down list. 
 
Using Item Help 
 
You can view the attributes of any enterable field on a study page in the Help menu.  Item Help displays 
the attributes of a field defined during the development of the DMS.  To open Item Help, do the following: 
 
1. Highlight the field whose attributes you want to view. 
2. Select Help > On Current Item from the menu commands, or press Shift-F1. 
3. Close the Item Help window by clicking on the (X) windows button. 
 
2.5.2.2 Navigating in a Form 
 
Navigating between fields 
 
The following keyboard commands allow you to navigate between fields on a study page: 
 

Command Description 
Tab or Enter Next field. 
Shift-Tab or Shift-Enter Previous field. 
Ctrl-Home First field in page section (a partition of the study page). 
Ctrl-End Last field in page section (a partition of the study page). 

 
Navigating within a single field 
 
The following keyboard commands allow reposition of the cursor and selection of text within a field: 
 

Command Description 
Home Moves cursor to the beginning of the field. 
End Moves cursor to the end of the field. 
Ctrl-Right Arrow Moves cursor one word to the right. 
Ctrl-Left Arrow  Moves cursor one word to the left. 
Escape  Restores a non-coded field to its original value. 
Shift-Home Selects text from cursor position to the beginning of the field. 
Shift-End Selects text from cursor position to the end of the field. 
Shift-Right Arrow Selects one character to the right. 
Shift-Left Arrow Selects one character to the left. 
Ctrl-Shift-Right Arrow Selects one word to the right. 
Ctrl-Shift-Left Arrow  Selects one word to the left. 

 
Autoskip (currently disabled in the JHS DMS) 
 
The JHS DMS uses the Clintrial automatic skipping feature that automatically advances the cursor to the 
next enterable fields.  This feature is not available from fields with drop-down boxes.  Autoskip will only 
advance if the maximum number of characters have been entered in the current field, so if the entry is 
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less than the maximum length, you will need to advance to the next field using the Tab or Enter key or 
clicking on the field. 
 
Go To skips 
 
A field in a form may display an instruction that entry of a particular value for that field causes a skip of 
one or more fields to a latter field.  The field that causes a skip is called a trigger field, and the field to 
skip to is the target field.  For a trigger field, the paper copy of the form displays a ‘Go to’ statement 
beside the trigger value for that field, and the data entry window displays an asterisk (*) beside the trigger 
value for that field. 
 
If you enter a trigger value in a trigger field in the DMS, then the cursor goes to the target field and marks 
the skipped fields as non-enterable fields.  If the value of a trigger field is changed, the skipped fields 
become enterable. 
 
A few exceptions for skips in the JHS DMS are as follows: 
 
• The target field may be too far from the trigger field for a skip in Clintrial.  Therefore, a message is 

displayed to skip to the target field, and then the skip will go to the farthest field it can reach.  Use the 
Tab or Enter keys to go the remaining distance to the target field. 

• The skipped fields may not be marked as non-enterable due to Clintrial limitations in certain locations 
in a page design. 

 
Scrolling in a study page 
 
As you perform data entry in a study page, the Tab or Enter key move the cursor to the next enterable 
field on the study page, automatically scrolling down the page and displaying the fields in the data entry 
window.  You can manually scroll down a page by using the vertical scroll bar on the right side of the 
window. 
 
Some study pages are designed from forms with a landscape layout and require scrolling left to right. The 
Tab or Enter key moves the cursor to the next enterable field, automatically scrolling to the right on a 
page and displaying the fields in the data entry window.  For these wide pages, a horizontal scroll bar is 
available at the bottom of the data entry window that you can use to scroll manually from left to right. 
 
Search field  
 
At the bottom of the Navigator window is a Search field in which you can enter text (case sensitive) to 
search for a particular study page.  The search begins at the currently selected icon and proceeds within 
the hierarchy until the first match is found.  You can only search expanded icons.   
 
For example, to find the next occurrence of the SBPE Sitting Blood Pressure study page in the CENTER 
EXAM block for subject J000000, expand the subject and CENTER EXAM icons and then enter "S" in the 
Search field.  The search begins as soon as you enter any text.  Continue to enter additional characters in 
the text until the search takes you to the SBPE study page. 
 
Last field action 
 
When the cursor is on the last field of the study page, pressing the Tab or Enter key will move the cursor 
to the first field of the study page. You do not exit from the study page. 
 
Printing study pages 
 
You can print study pages from the Navigator without having to open them.  Only study pages that 
contain data can be printed, and only study pages and subjects included in the current subject list and 
page list can be selected for printing. 
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The Navigator provides several options to print for selecting one or more individual study pages or 
subjects or selecting a selected group of study pages or subjects.  These options differ depending on the 
current navigation order setting.   
 
From the Navigator window in the navigation order Navigate By Page, you can select for printing as 
follows: 
 
1. Select subject(s) or study page(s) to print.   

a. Selecting an individual subject prints all study pages for the subject 
b. Selecting one or more individual study pages for a subject prints the individual study page(s) for 

the subject. 
c. Selecting the Edit > Select All menu command prints all the study pages in the study book. 

2. Select File > Print from the menu commands.  In the Print Options dialog box, you can make further 
selections on study pages to print, if desired. 

3. Click on OK to print and to close this dialog box. 
 
2.5.2.3 Using flags 
 
Flags can be attached to an individual field as an Item Flag or to a form by way of a Record Flag.  Flags 
are typically used to: 
 
• Label and monitor data quality problems. 
• Capture information that cannot be entered in the fields on a screen. 
 
For example, a flag might be added to a field where the data are missing or where the data are outside a 
specified range of values. 
 
Flags have two parts: 
 
• A flag category is used to indicate the type of problem or assertion found with the data, such as 

ILLEGIBLE or MISSING. 
• A flag name is associated with a single flag category.  
 
In the JHS DMS, there are four categories of flags with each category associated with a single name (the 
same value as the category).  The categories (and names) and their description are as follows: 
 

FLAG CATEGORY (AND FLAG 
NAME) 

Action 

OVERRIDE Use when overriding an edit range. 
PERMANENTLY_MISSING Use when a field value or form is permanently 

missing. 
CANT_ENTER Use to indicate when a value cannot be entered 

into the field (e.g., if a field is too short or if a 
value is different from the field type). 

QUERY Use only when entering data from paper forms 
to indicate that a field should be queried. 

 
There are other flag categories supplied by Clintrial that cannot be removed but are not used for JHS.  
The flag categories to ignore for JHS are CDR, GENERAL, CLASSIFY, and LABLOADER. 
 
To attach a flag to a field, do the following: 
 
1. With the cursor in the field, select Flags > Item Flag menu commands. 
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2. In the Item Flag dialog box, select a Category from the list.  Select a Name from the list (same as 
Category).  Enter text in the Comment field to provide a reason for the flag. 

3. Click OK to continue. The dialog box closes, and a red flag icon appears next to the field. 
 
You attach a flag to a record for a form-level flag, for example, if the entire form is permanently missing.  
A single form is usually comprised of multiple records appended together, with each record containing a 
subset of the form fields.  Only attach a flag to the first record for a form-level flag.  To attach a flag to the 
first record, do the following: 
 
1. With the cursor in the first field on a study page, select Flags > Record Flag.  Note that the cursor is 

automatically positioned in the first field of the study page when the study page is opened. 
2. In the Record Flag dialog box, select a Category from the list.  Select a Name from the list (same as 

Category).  Enter text in the Comment field to provide a reason for the flag. 
3. Click OK. The dialog box closes, and a red flag icon appears next to the record (top right of form). 
 
Multiple flags can be attached to an item or a record, but only one red flag icon will appear. 
 
2.5.2.4 Using notes 
 
Notes are used to enter comment fields and ‘Other’ responses or to make notes about an individual field 
in a study page or about an entire study page.  A note for a field is attached as an Item Note.  An 
example: a note for the reason text to the field ‘Other Reason’.  A note for a form is added as a Record 
Note.  An example: if a study page cannot be completed, then a record note can indicate why the data 
are unattainable. 
 
Notes have two parts: 
 
• Note category defines the source of the note. 
• Note name defines a subcategory for the source of the note. 
 
Clintrial supplies two note categories of SPONSOR and INVESTIGATOR, and in INVESTIGATOR, there 
is one note name.  For JHS, all notes will be note category INVESTIGATOR with note name 
UNSPECIFIED.  The other note categories are not meaningful in JHS, but cannot be removed in Clintrial. 
 
To attach a note to a field, do the following: 
 
1. With the cursor in the field, select Notes > Item Note menu commands 
2. In the Item Note dialog box, select INVESTIGATOR from the Category list.  Select UNSPECIFIED 

from the Name list.  Enter the text in the Note Text field to provide a comment or ‘Other’ reason. 
3. Click OK to continue. The dialog box closes, and a yellow note icon appears next to the field. 
 
You attach a note to a record for a form-level note.  A single form is usually comprised of multiple records 
appended together, with each record containing a subset of the form fields.  Only attach a note to the first 
record for a form-level note.  To attach a note to the first record, do the following: 
 
1. With the cursor in a field belonging to the record, select Notes > Record Note.  Note that the cursor 

is automatically positioned in the first field of the study page when the study page is opened. 
2. Select a Category from the list.  Select a Name from the list.  Enter text in the Note Text field to 

provide a reason for the note. 
3. Click OK.  The dialog box closes, and a yellow note icon appears next to the record (top right of 

form). 
 
Multiple notes can be attached to an item or a record, but only one yellow note icon will appear. 
 
2.5.2.5 Saving data and exiting a study page 
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Data entered in a study page are not permanent until the study page is saved.  You can save at any time 
during data entry in a study page or when you exit from a study page. 
 
 The following options are available to save data and/or to exit from a study page: 
 
• Select File > Save menu commands to save data without exiting from the study page. 
• Select File > Close menu commands or click the study page (X) windows button to save data and 

exit from the study page. 
• Select File > Close Without Saving to exit the study page without saving data.   
 
2.5.3 Creating and Selecting Subject Lists 
 
Long lists of subjects in the Navigator can make data entry cumbersome.  To limit the number subjects 
displayed in the navigation window, such as to those attending the center that day or to those who are in 
the stack of forms for data entry, you can specify a subset of subjects by using subject lists.  You can 
create as many subject lists as needed and save these lists indefinitely. 
 
Every Clintrial protocol has a default subject list called All that includes all subjects enrolled in the study. 
This list cannot be deleted or modified. 
  
You create and modify subject lists using the List Wizard.  The Wizard is a series of dialog boxes to 
guide you through the steps of entering or modifying list criteria.  To create a list in the Wizard, select 
specific subjects to include.  You can optionally include or exclude subjects based on a SQL restriction. 
You can also create a list that includes or excludes subjects based upon the presence or absence of flags 
or notes.  Once created, a list can be modified as needed.  
 
To open the List Wizard, select one of the following menu commands appropriate to what you want to do:  
 
• List > Create List 
• List > Edit Subject List 
 
You can select a particular subject list for the Navigator to display, and only those subjects belonging to 
the list will be displayed.  To select a subject list, do one of the following: 
 
• From the Subject List drop-down box at the top left of the Navigator window, select the list you want. 
• Select List > Select Lists from the menu commands.  In the Select Lists dialog box, select the 

subject list you want and click OK to continue. 
 
2.5.4 Browsing, Changing, Deleting, or Printing Data in the Enter Module 
 
Browsing Data 
 
To browse data in a saved study page in the update table, double-click on the study page icon to re-open 
the study page in the Navigator.  Use the scroll bar or the Tab or Enter key to browse through the data, 
being careful not to change inadvertently any data.  Select File > Close Without Saving to exit from the 
study page. 
 
Changing Data 
 
There are three edit modes available in an Enter session to change data: 
 
• Edit Update Data (default) - enter new data or edit unmerged data. 
• Verify - perform verification of previously entered data. 
• Edit Merged Data - edit data that have been validated and merged (moved) to the data table 

(merging data is described later in Managing Data). 
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By default, when you start Enter, the edit mode is set to Edit Update Data.  If you want to perform 
verification or edit merged data, you must set the edit mode to one of these other options.  All study 
pages must be closed before you set the edit mode.  The name of the current edit mode is displayed in 
the title bar of the study page.  To change the edit mode, select File > Edit Mode.  Select an edit mode, 
then click OK to continue. 
 
To change data in a saved study page, double-click on a study page icon to re-open the study page in the 
Navigator.  Use the scroll bar or the Tab or Enter key to move through the study page.  Select a field to 
change, then enter the data.  Select File > Save to save the changed data without exiting or File > Close 
to save and exit from the study page. 
 
Deleting Data 
 
Depending on the situation, you can delete data in an open study page in following ways: 
 
• Close a study page without saving new or updated data 
• Undo data entered since the last save 
• Delete data from a field 
• Delete all data for a study page 
 
To close an open study page and not save data, select File > Close Without Saving.  For example, if 
you inadvertently open the wrong study page from the Navigator, close the study page without saving to 
avoid creation of any blank records in an update table and to not shade the study page icon. 
  
If you want to undo data entered since last save in an open study page, select Edit > Undo Page Edits. 
 
If you want to delete data from a field in an open study page, highlight the field and select Edit > Clear or 
use the Delete key.  To delete or clear a value from a codelist field, highlight the field and select (None) 
from the drop-down list.  Select File > Save to save data deletions without exiting or File > Close to save 
and exit from the study page. 
 
If you want to delete all data in a previously saved study page, select Edit > Delete Page Data in the 
open study page and click on Yes to confirm the deletion.  The study page will automatically close, and 
the study page icon will not be shaded. 
 
Printing Data 
 
You can print Clintrial reports, most non-report windows, and study pages.  You can open a study page 
for printing or print from the Navigator window.  If the Print or Print Preview command is not available for a 
displayed window, then that window does not have the print or preview capability. 
  
Select File > Printer Setup to specify which local or network printer to use.  Depending on your printer, 
you can also adjust certain printer defaults like page orientation, paper size, and print resolution. Consult 
your printer's documentation or your Clintrial Data Manager for more information. 
 
To print from within a report, window, or open study page, do as follows:  

 
1. Select File > Print. 
2. The Print Options dialog box opens. Accept default settings or modify any of these values as needed. 
3. Click OK to print. 
 
To preview a document, select File > Print Preview.  Previewing a document before printing lets you see 
how the text will look when printed, shows certain report features that do not normally display on the 
screen (e.g., headers and page numbers), and allows an opportunity for an adjustment to page 
orientation for best printing results. 
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You can print study pages from the Navigator without having to open them.  Only study pages that 
contain data are printed.  Only study pages and subjects included in the current page list and subject list 
can be selected for printing.  However, use this print capability with caution.  To print multiple study pages 
at a time is dependent on the number of allowable open study pages set for system parameter 
ENT_OPEN_PAGES (default is 1).  Set ENT_OPEN_PAGES temporarily to the maximum of 10 to print 
study pages from the Navigator.  Otherwise, you will get a Clintrial error that terminates Enter if the 
number of study pages to print exceeds the number specified by this parameter except if set to 10. 
 
To print study pages from the Navigator, do as follows (assumes Navigate By Page navigation order): 
 
1. Select the page(s) that you want to print in one of following ways: 

a. Click on one or more individual study pages within a subject (Shift-click for more than one) 
b. Click on a block (i.e., CLINIC EXAM) to print all study pages in the block for that subject 
c. Select Edit > Select All to print all the study pages for all subjects in the study book 

2. Select File > Print. 
3. The Print Options dialog box opens. Accept default settings or modify any of these values as needed. 
4. Click OK to print. 
 
2.6 Clintrial-Supplied and Custom Reports 
 
Clintrial-Supplied Reports 
 
Clintrial provides Enter reports that you create through the use of a Report Wizard.  Within the Wizard, 
you enter criteria that determine the report's format and content in a series of dialog boxes. 
 
You can create one of the following reports: 
 
• A Flag Report, which displays information about flags that have been attached to data in the current 

study book. 
• A Note Report, which displays information about notes that have been attached to data in the current 

study book. 
• A Subject Report, which displays information about the status of data entered for study subjects. 
• A Verification Report, which displays information about records that have failed to pass blind 

verification. 
 
The Flags, Notes, and Subject reports are available in two basic formats: detailed and summary.  The 
detailed format provides in-depth information on each record matching the selection criteria.  The 
summary format gives a count and categorical breakdown of records matching the selection criteria.  
 
To create a Clintrial-supplied report, do as follows:  
 
1. To open the Report Wizard, select Reports from the Enter menu and then select the type of report: 

Subject, Flag, or Note. 
2. Select the criteria for the report.  Click Next to move to the next dialog box.  Click Back to return to a 

previous dialog box to change an earlier entry. 
3. Select Finish to end your selection and view the report.  As soon as the Finish button is available, it 

indicates that the minimum amount of necessary information has been entered. 
4. The report appears on the screen.  You can also print the report (File > Print) or save the report to a 

file in a directory of your choice (File > Save As). 
 
Custom Reports 
 
Custom reports developed for JHS such as recruitment status, participant profiles, and lab results can be 
run from the Custom menu in Enter.  The Custom menu is a user-modifiable menu in which you can set 
up shortcuts to Windows applications (e.g., Notepad, Excel), to specific document files (e.g., text files, 
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spreadsheets), and to the SAS System to run JHS data reports.  These applications and documents can 
be directly opened from Clintrial in the Custom menu. 
 
When creating a shortcut, you can specify whether the shortcut appears in every Clintrial module you use 
(create in Common Menu Items) or in only the module from which it was created (create in Module 
Specific Menu Items).  You can create up to eight shortcuts of each type. 
 
Custom menu items will appear only on the workstation on which they were created since they are stored 
in the Windows Registry.  For computers running under Windows NT, Custom menu settings are also 
particular to the user who created them. 
 
2.7 Closing Windows 
 
When you have completed data entry using the Navigator or completed other tasks in a DMS window, 
you need to close the active task window. 
 
To close a window, you can use one of several options: 
 
• Click on the rightmost (X) windows button at the far top right of a window. 
• Select the File > Close menu commands. 
• Click on the OK button, if provided (in dialog boxes). 
• Click on the Finish button, if provided (in List or Report Wizard). 
 
2.8 Ending a Data Entry Session 
 
To close the Clintrial Enter window and end your DMS session, click on the rightmost (X) windows button 
or select the File > Exit menu commands. 
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3.0 PROGRAMMER GUIDE TO MANAGING DATA 
 
 
3.1 Overview 
 
In the Clintrial Manage module, a Clintrial Data Manager can perform data management tasks such as 
the following: 
 
• batch-load data 
• assign codes based on field values from industry-standard dictionaries  
• validate data, that is, calculate derived fields and run consistency checks 
• merge or move data that have passed validation from update to data tables 
• globally change or delete records 
• view processing logs and reports 
• view error reports and make corrections 
• view audit trail reports 
 
A typical data management workflow in the Manage module is displayed in the introduction of this 
manual. 
 
A person using the Manage module has privileged access rights to the study data tables and has 
familiarity with the Clintrial database structures.  
 
3.2 Batch-Loading Data 
 
3.2.1 Overview 
 
Batch-loading is the process of loading data from ASCII files directly into update tables in the Clintrial 
database. You can batch-load study data, enrollment data, and thesaurus (dictionary) data. 
 
Enrollment data must be previously entered for a subject whose data are batch-loaded.  Either the subject 
is enrolled in the Enter module, or the enrollment data are batch-loaded, screened, validated, and merged 
before study data can be entered for the subject. 
 
The input ASCII file contains records composed of data fields. The data fields on a record correspond to 
items in a pre-defined panel into which the data are batch-loaded.  You can only batch-load into one 
panel at a time.  To load data from one input ASCII file into more than one panel is a complicated, 
multiple control files, multiple runs process not discussed in this manual. 
  
The data fields on a record in the input ASCII file are in either a fixed format or variable format.  Fixed 
format records contain data values of specified length beginning in fixed locations in the record with no 
delimiter separating the values.  Variable format records contain data values without a specified length 
and not necessarily in the same location in each record, and these records include a delimiter to separate 
the values for fields. 
 
A control file is created as an interface between the input ASCII file and the Clintrial database table for 
the batch-loading.  The control file interprets the organization and format of data in the input ASCII file 
and provides the instructions on the loading process. 
 
All batch-loaded data are automatically loaded into the Clintrial database's update tables. The data must 
pass screening before the data can be edited, coded, validated, and merged to the study data tables.  
Screening is the process that includes updating internal system items to uniquely identify the records, 
grouping the records into observations (not used in JHS), and applying data checks to data that has been 
batch loaded into the update table. The data checks confirm that subjects are enrolled and that 
mandatory items are defined, and they apply the range checks (lower and upper limits) and checklist tests 
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(checklists not currently used in JHS) for an item.  Records that have been batch loaded and screened in 
Manage appear identical to those records entered interactively in Enter. 
 
Once data have passed screening, the data are ready to be edited, coded, validated, and merged.  You 
can view the results of batch-loading in the SQL*Load Log from the Reports menu. 
 
3.2.2 Preparing Data for Batch Loading 
 
3.2.2.1 Creating a Control File  
 
To create a control file, do as follows: 
 
1. Select Load > Control File > New from the Manage window. 
2. In the Open dialog box, select the panel for which you are creating the control file and the file format 

of the input ASCII file (fixed format or variable format). 
3. Click OK to continue.  The default version of the control file is displayed in the Control File window. 
4. You can optionally edit the default control file at this time.  See edit instructions below. 
5. To save the control file, select File > Save or File > Save As to write the control file to the default 

C:\CT42 Clintrial directory or a directory of your choice.  By default, the file name is panelname.ctl. 
6. To close the Control File window, select File > Close or click on the window’s X button. 
 
To edit the default control file, do as follows: 
 
1. If the Control File window is not opened, select Load > Control File > Edit to open the control file for 

editing.  Indicate the directory location and file name in the Open dialog box.  Click on Open to open 
the control file in the Control File window. 

2. Edit the control file to correspond to the input ASCII file format, as follows: 
a. Reorder items in the control file to match the order of values in the input ASCII file. 
b. Delete items for which the input ASCII file does not contain values. 
c. Add conversion instructions, such as instructions to convert date formats. 
d. The control file must specify the character used to indicate character strings in the input ASCII 

file.  Change the ENCLOSED By clause to contain this character.  Default is the double quotation 
mark, for example, OPTIONALLY ENCLOSED BY ‘ “ ‘. 

e. For a variable format control file, change the default delimiter ‘@’ to the character that is used as 
a field delimiter in the input ASCII file, for example, FIELDS TERMINATED BY ‘,’ for a comma-
separated file (.cvs). 

f. For a fixed format control file, change an item fixed size if needed. 
g. By default, a control file includes the line TRAILING NULLCOLS to indicate that, if not enough 

values are supplied for a record in the input ASCII file, items in the panel will be given the value of 
Null when the record is batch loaded. 

h. For probably all date fields, you will want to change the date format of the item.  For example, 
specify the date format as DATE “MM/DD/YYYY” if the input ASCII file contains the date 
10/03/2000 (has not yet been tested in JHS). 

i. For items of data type NUMBER or DATE, the default control file contains a NULLIF clause.  The 
NULLIF clause in the default control file specifies an item as Null if the value in the input ASCII 
file is blank.  Specify another value if the input ASCII file contains a value other than blank for 
Null, for example, a period (.). 

j. Items of data type TEXT contain an LTRIM clause to trim leading blanks and a RTRIM clause to 
trim trailing blanks. 

3. Select File > Save or File > Save As to save the edited control file. 
4. Select File > Close or click on the window’s X button to close the Control File window. 
 
3.2.2.2 Loading the Data 
 
To batch load data requires that the Oracle SQL*Loader is installed on the computer (use the 32-bit 
version).  Consult Oracle SQL*Loader documentation for more detailed information on loading data. 
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It is recommended that you check a batch-load of a sampling of records in the input ASCII file to ensure 
that positions and formats of fields in the input ASCII file match the corresponding control file. 
 
To batch-load data, do as follows: 
 
1. Select Load > Load Data from the Manage window.  The Batch SQL Loader dialog box opens. 
2. In the dialog box, specify the names and locations of the control file for Control File and the input 

ASCII file for Data.  Clintrial saves the files specified in this dialog box as defaults for the next 
session, but you can change these defaults if needed.  You can also specify names and locations of 
files created by the batch-load process: the Log file, the Bad file, and the Discard file.  The Log file 
is a report file of the batch-loading process.  The Bad file lists records that were rejected.  The 
Discard file lists records that did not meet the selection criteria for batch loading. 

3. If you click Advanced in the Batch SQL Loader dialog box, the Advanced Batch Loader Options 
dialog box opens.  You can select addition options as needed such as Records to Skip, Records to 
Load, Rows per Commit, Maximum Errors, Maximum Discards, and Maximum Bind Array.  In most 
cases, you will probably use the Clintrial defaults.  Click OK to continue. 

4. From the Batch SQL Loader dialog box, click Load to batch load the data into an update table.  Click 
OK to close message that job was submitted.  The Batch SQL Loader dialog box closes after the job 
has run. 

5. From the Manage window, select Reports > SQL*Load Log to view the results of the job run.  The 
Open dialog box opens.  Select the path and name of the load log file, then click Open.  The Oracle 
Batch Log window opens.  For information on the log's entries, see your Oracle documentation. You 
can print the report from File > Print.  Close the Oracle Batch Log window from File > Close or from 
the window's X button to return to the Manage window. 

 
3.2.2.3 Screening Batch-Loaded Data 
 
You screen records after data are batch loaded into an update table.  Screening combines the following 
processes running concurrently: 
 
• Applies data checks to record data 
• Updates the system items 
• Groups records into observations as needed (not used in JHS) 
 
The data checks include the same checks applied during interactive data-entry.  Records that have been 
successfully batch-loaded and screened appear identical to records that were entered interactively. 
 
You can only screen records whose record status is Unscreened (3) or Screening Error (-3).  Records 
that pass screening are assigned the status Verified (1).  Records that fail screening are assigned the 
status Screening Error (-3). 
 
To screen batch-loaded data, do as follows: 
 
1. Select Load > Screen from the Manage window.  The Screen dialog box opens. 
2. In the Screen dialog box, select the panel(s) from Panels that you want to screen.  To screen 

records, check Release for Validation.  To override data-entry checks on the data, check Override 
Checks.  To select records for screening by using a SQL restriction, click SQL.  To screen data as a 
batch process, check Submit Batch. 

3. Click OK to screen the records.  Click OK in the message box at the completion of the screening 
process. 

4. To view the results of screening in Screen Log, select Reports > Screen Log > View in the Manage 
window.  The Screen Log is a cumulative report that describes the results of the screening process 
with entries for each panel that was screened.  You can print the Screen Log report from File > Print 
or save from File > Save As.  Close the Screen Log window from File > Close or from the window's 
X button to return to the Manage window. 
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Once a record passes screening, it can be edited, coded, validated, and merged. 
 
3.3 Coding Data – not available at this time 
 
3.3.1 Overview 
 
3.3.2 Coding Thesaurus 
 
3.3.3 Coding Techniques – Automatic, Interactive 
 
3.3.4 Items To Be Coded 
 
3.4 Validating and Merging Data 
 
3.4.1 Overview 
 
Validation is a data cleaning process that checks the integrity of study data in the update tables by finding 
errors and data inconsistencies.  Records must pass validation before they can be merged to the data 
tables. 
 
Merging is the process of moving data that has passed validation from the update tables to the data 
tables. 
 
3.4.2 Validating Data 
 
During validation, a validation procedure is run against the data in the update tables.  A validation 
procedure is a PL/SQL procedure that is built automatically from derivations and rules.  Derivations and 
rules are specified during the design of the DMS for a protocol panel.  Derivations calculate derived 
values in the records being validated.  Rules check that the data meet certain requirements of the study 
protocol.  There is one validation procedure for each panel. 
 
Records in the update tables must pass validation before they can be merged (moved) to the data tables. 
  
You can view the results of the validation process in the Validation Log.  An evaluation of a rule to False 
during validation also generates an entry in the Error Log. You can then review and edit the record from 
the Error Log. 
 
To validate data, do as follows: 
 
1. You can select records for validation either by panel (the Clintrial default) or by study page (the JHS 

DMS preference).  To validate records by study page, set the Manage user preference 
SELECT_BY_PAGE to Yes from File > Preferences in the Manage window. 

2. Select Manage > Validate in the Manage window.  The Set Study Book dialog box may open if a 
study book has not been selected (go to 3), otherwise the Validation dialog box opens (go to 4). 

3. In the Set Study Book dialog box, select the study book for the data that you want to validate.  Click 
OK to continue.  The Validation dialog box opens. 

4. To validate records by study page, do as follows: 
a. From the Page List drop-down list, select the page list that you want to use.  You can create a 

new list from List > New List or edit an existing list from List > Edit Page List using the List 
Wizard. 

b. Select either All pages or Selected pages to validate.  Select the specific pages to validate from 
the list for Selected pages. 

c. Optionally you can restrict the data included in the validation as follows:  
1) For the date and time that records were last modified, enter a Date and Time Range. 
2) For record status, select a Status. 
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3) For flags present, select one or more Flags. 
4) For notes present, select one or more Notes. 
5) For a SQL restriction, select Edit > SQL Restriction. 

d. Check the type of database table(s) you want to validate in Table(s): UPDATE, DATA, or both. 
e. If you are running a test validation, clear the Release for Merge check box.   Otherwise check 

Release for Merge. 
f. To run the validation as a batch process, check Submit Batch.  Otherwise the validation runs 

interactively. 
g. Select File > Run.  Click OK in the message box at the completion of the validation run.  You 

return to the Validation dialog box. 
h. Select Reports > Validation Log to view the results of validation in the Validation Log.  You can 

print the Validation Log from File > Print or save from File > Save As.  Close the Validation Log 
window from File > Close or from the window’s X button. 

i. Close the Validation dialog box at the completion of the validation process from File > Close or 
from the window’s X button. 

 
3.4.3 Merging Data 
 
Once data have been validated, then data can be merged (moved) from the update tables to the data 
tables where the clean data are stored. 
 
To merge records, do as follows: 
 
1. You can select records for merging either by panel (the Clintrial default) or by study page (the JHS 

DMS preference).  To merge records by study page, set the Manage user preference 
SELECT_BY_PAGE to Yes from File > Preferences in the Manage window. 

2. Select Manage > Merge in the Manage window.  The Set Study Book dialog box may open if a study 
book has not been selected (go to 3), otherwise the Merge dialog box opens (go to 4). 

3. In the Set Study Book dialog box, select the study book for the data that you want to validate.  Click 
OK to continue.  The Merge dialog box opens. 

4. To merge records by study page, do as follows: 
a. From the Page List drop-down list, select the page list that you want to use.  You can create a 

new list from List > New List or edit an existing list from List > Edit Page List using the List 
Wizard. 

b. Select either All pages or Selected pages to merge.  Select the specific pages to merge from 
the list for Selected pages. 

c. Optionally you can restrict the data included in the merge as follows: 
1) For the date and time that records were last modified, enter a Date and Time Range. 
2) For record status, select a Status. 
3) For flags present, select one or more Flags. 
4) For notes present, select one or more Notes. 
5) For a SQL restriction, select Edit > SQL Restriction. 

d. To validate the panels of the selected study pages before merging, if not done in Manage > 
Validate, check Validate First. 

e. To run the merge as a batch process, check Submit Batch. Otherwise merge runs interactively. 
f. Select File > Run.  Click OK in the message box at the completion of the merge run.  You return 

to the Merge dialog box. 
g. Select Reports > Merge Log to view the results of the merge in the Merge Log.  For information 

on any errors, see the Help menu for the Manage module on Validation and Merging: Error 
actions.  You can print the Merge Log from File > Print or save from File > Save As.  Close the 
Merge Log window from File > Close or from the window’s X button. 

h. Close the Merge dialog box at the completion of the merge from File > Close or from the 
window’s X button. 
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3.5 Global Data Changes and Deletions 
 
3.5.1 Introduction 

 
Global change is the process of changing one or more values in multiple records simultaneously.  You 
can make global changes to individual or multiple panels, and to records in the update table, data table, 
or both.  You cannot directly change any derived item values.   
 
Global deletion is the process of deleting multiple records simultaneously.  You can make global 
deletions to individual or multiple panels, and to records in the update table, data table, or both. You can 
view the results of global deletion in the Global Delete Log.  
 
Global change and global deletion are powerful processes that alter records irrevocably.  Because of this, 
before you save any global changes or deletions, you should preview the results of the global change or 
deletion process to ensure that the desired change is made or that the correct records have been 
selected for deletion.  If the preview results are correct, you can then run the global change or deletion 
process and save the results. 
 
If you want to change or delete enrollment data for study subjects, that is, records in the enrollment panel, 
you must perform a global change or global deletion.  You cannot change or delete enrollment data using 
any other method.  To change or delete subject item values or any subject-related context items, you 
must select only the enrollment panel.  If you change or delete the subject item, when the global change 
is successful, records are changed or deleted in all panels in which the subject item is stored.  To change 
other context item values, select all the panels you want to change, excluding the enrollment panel and 
any type 0 panels (non-subject data). 
 
You can view the results of global change in the Global Change Log.  Errors that occur during global 
change are recorded in the Error Log with the error types of GLOBCHG. 
 
You can view the results of global deletion in the Global Delete Log.  Errors that occur during global 
deletion are recorded in the Error Log with the error types of GLOBDEL. 
 
3.5.2 Global Change 
 
To make a global change, do as follows: 
 
1. Select Manage > Global Change in the Manage window.  The Select dialog box opens. 
2. In the Select dialog box, select the panels and tables whose records you want to change.  When you 

click OK, the Global Change dialog box opens. 
3. In the Global Change dialog box, do as follows: 

a. Select the subjects you want to make changes to, except for type 0 panels.  To select the 
subjects, do one of the following: 
1) For all subjects, click All Subjects. 
2) For individual subjects, click Selected Subjects.  Select the subjects you want to change. 

b. Under Restrict Data, select records to change as follows: 
1) For the presence of flags, select one or more Flags.  
2) For the presence of notes, select one or more Notes. 
3) For a SQL restriction, click the SQL Restriction box. 

c. To override data-entry checks on the new values, check Override Checks. 
d. To run the changes as a batch process, check Submit Batch. Otherwise global changes are 

done interactively. 
e. Enter the new values for the items you want to change in the Change To field.  To specify global 

change values, note the following: 
1) The new value must match the database format of the item. 
2) For items with data type TEXT, you must enclose the new value in single quotes. 
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3) The new value can be a constant, or a calculated value that can refer to other items in the 
panel. 

4) To specify a calculated value, enter a valid SQL UPDATE statement. The SQL statement can 
contain any valid Oracle function or operator. 

f. To preview your changes before running them (recommended), select View > Preview. 
i. To run the changes, select File > Run.  Click OK in the message box at the completion of the 

global change run.  You return to the Global Change dialog box. 
g. Select Reports > Global Change Log to view the results of a global change in the Global 

Change Log. You can print the Global Change Log from File > Print or save from File > Save 
As.  Close the Global Change Log window from File > Close or from the window’s X button to 
return to the Manage window. 

h. Close the Global Change dialog box at the completion of the global change from File > Close or 
from the window’s X button. 

 
3.5.3 Global Deletion 
 
To make a global deletion, do as follows: 
 
1. Select Manage > Global Delete in the Manage window.  The Select dialog box opens. 
2. In the Select dialog box, select the panels and tables whose records you want to delete.  When you 

click OK, the Global Delete dialog box opens. 
3. In the Global Delete dialog box, do as follows: 

a. Select the subjects you want to delete, except for type 0 panels.  To select the subjects, do one of 
the following: 
1) For all subjects, click All Subjects. 
2) For individual subjects, click Selected Subjects.  Select the subjects you want to delete. 

b. Under Restrict Data, select records to delete as follows: 
1) For the presence of flags, select one or more Flags.  
2) For the presence of notes, select one or more Notes. 
3) For a SQL restriction, click the SQL Restriction box. 

c. To run the deletions as a batch process, check Submit Batch. Otherwise global deletions are 
done interactively. 

d. To preview your deletions before running them (recommended), select View > Preview. 
j. To run the deletions, select File > Run.  Click OK in the message box at the completion of the 

global deletion run.  You return to the Global Delete dialog box. 
e. Select Reports > Global Delete Log to view the results of a global deletion in the Global Delete 

Log. You can print the Global Delete Log from File > Print or save from File > Save As.  Close 
the Global Delete Log window from File > Close or from the window’s X button to return to the 
Manage window. 

f. Close the Global Delete dialog box at the completion of the global deletion from File > Close or 
from the window’s X button. 

 
3.6 Logs and Reports 
 
Clintrial contains twelve logs and reports in the Manage module that show the results of various data 
management processes.  Logs and reports can be viewed online, printed, and saved to a file. 
 
No JHS DMS custom logs and reports are available at this time. 
 
The Manage logs and reports are as follows: 
 
Audit History Report – a report that shows the history of changes to the audit start point for all audited 
panels, including the current and past audit start points for each panel, and the dates at which the audit 
start points became effective. 
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Audit Notes Report – a report that shows the changes made to notes attached to records in one panel.  
It does not show deletions of notes attached to clinical data.  For a note to appear in the report, the record 
to which it is attached must itself be eligible for auditing.  
 
Audit Records Report – a report that shows all changes and deletions made to a panel's records after 
the audit start point has been reached. 
 
Automatic Coding Log - a cumulative report that describes the results of the automatic coding process.  
Contains entries for each panel that was coded automatically. 
 
Coded Item Report - a report that provides information about items that were coded interactively for a 
panel, including the verbatim text, thesaurus term, and code applied for each item. 
 
Error Log - a cumulative log of errors that occurred during screening, validation, merging, global change, 
and global deletion.  There is one Error Log per protocol.  Errors are displayed in ascending order by 
panel and subject item.  Each row represents a record in the panel.  When viewing the Error Log, you can 
double-click a record to open that record for editing in a study page. 
 
Global Change Log - a cumulative report that describes the results of global change processes. 
Contains entries for each panel and table that was submitted for global change.  When you change 
enrollment records, this log shows only one record modified, however, records in every panel in which 
that subject item is stored are also modified. 
 
Global Delete Log - a cumulative report that describes the results of global deletion processes. Contains 
entries for each panel and table that was submitted for global deletion.  When you delete enrollment 
records, this log shows only one record deleted, however, records in every panel in which that subject 
item is stored are also deleted. 
 
Merge Log - a cumulative report that describes the results of merging processes.  Contains entries for 
each panel that was submitted for merging. 
 
Screen Log - a cumulative report that describes the results of the screening process after a batch-load.  
Contains entries for each panel that was screened. 
 
SQL Load Log – a report that displays the results of batch-loading. 
 
Validation Log - a cumulative report that describes the results of the validation process.  Contains entries 
for each panel and table that was validated. 
 
To view a log or report, select View from the Reports menu for a log.  It takes several minutes for a log to 
display following notification of completion of a batch process.  If an open log window is empty, wait 
another minute and then select File > Refresh. 
 
Logs can be filtered to show only specific rows.  In the log window, select View > Filter to open the 
Specify Filter dialog box.  Click on Help for instructions.  Click on OK to return to the log window. 
 
Logs can be sorted according to criteria you define.  In the log window, select View > Sort to open the 
Specify Sort Columns dialog box.  Click on Help for instructions in sorting data.  Click on OK to return to 
the log window. 
 
When viewing a log or report, you can navigate between its pages by using the View > First Page, View 
> Prior Page, View > Next Page, and View > Last Page. 
 
You can purge logs of data at any time.  When you purge a log, you can purge all of its records (Purge 
All) or only selected records (Purge Selected) from the Reports menu for the log. 
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3.7 Closure Checks 
 
Not available at this time. 
 



30 

Exam 1 Data Management System Manual.doc 

 

This page is intentionally left blank. 



31 

Exam 1 Data Management System Manual.doc 

 

4.0 PROGRAMMER GUIDE TO RETRIEVING DATA 
 
 
4.1 Overview 

 
SAS Version 8 is being used for retrieval of study data entered in the JHS DMS and stored in the Oracle 
database.  SAS Version 8 can access the Oracle database directly using the new SAS/ACCESS 
LIBNAME statement that can take full advantage of SAS Version 7 and Version 8 enhancements. 
  
The SAS data retrieval program and retrieval process described here are for the second release of the 
JHS_COHORT protocol distributed on December 14, 2000.  The SAS retrieval program will require 
modification after each protocol release for any new form/version. 
 
Earlier versions of this SAS retrieval program used the SAS/ACCESS to Oracle interface to read the 
Oracle data tables.  Due to retrieval constraints using the SAS/ACCESS interface -- limited to SAS 
Version 6 naming conventions and restricted to text value lengths no longer than 200 characters -- the 
program was rewritten to use the new SAS/ACCESS LIBNAME statement to read the Oracle data tables.  
This enables the use of 32-byte names for SAS variables and enables read/write of character data up to 
32,767 bytes using a DBMAX_TEXT option.  And, now there is no creation of access and view descriptor 
files as an intermediate step to creation of SAS analysis datasets. 
 
As an alternative to the SAS data retrieval procedure, a description of the Clintrial Retrieve Query By 
Form (QBF) procedure is also provided. 
 
4.2 SAS Retrieval for Custom Reports 
 
Not available at this time.  Development will be similar to SAS retrieval for data analysis. 
 
4.3 SAS Retrieval for Data Analysis 
 
4.3.1 Overview 
 
The SAS data retrieval program reads data directly from the Oracle data tables with the SAS/ACCESS 
LIBNAME statement and creates output SAS analysis datasets, one dataset per form/version. 
 
Data integrity and security are maintained in this process.  The SAS/ACCESS LIBNAME statement 
requires entry of Oracle username, password, database alias, and protocol name.  A parameter specifies 
access to the Oracle data tables as read-only.  The JHSCC must identify allowable users for data 
retrieval, and the Database Administrator must provide adequate Oracle access rights for these 
users.  These rights must be similar to the Oracle SYSTEM user account for access to data 
entered by any user.  The SAS retrieval program delivered to the JHSCC will include the SYSTEM user 
account as default. 
 
4.3.2 Contents of SAS Retrieval Program 
 
The SAS retrieval program contains the following sections: 
 
1. Documentation block providing a description of the program. 
2. SAS environment options. 
3. Initialization of program macro variables. 
4. Initialization of macro variables for Oracle access. 
5. LIBNAME statements for input Oracle data tables and output SAS analysis datasets. 
6. Program title and footnote statements. 
7. %INCLUDE statement for PROC FORMAT code. 
8. Macros: 
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a. RETRV reads Oracle data tables and creates output SAS analysis datasets, with conversion of 
DATETIME variables to SAS DATE variables and with a %INCLUDE statement for FORMAT and 
LABEL statements by form/version. 

b. RENAME provides original and temporary variable names for a list of variables to convert from 
DATETIME to SAS DATE format. 

c. COUNT counts the number of variables in a list for renaming. 
9. Macro calls to RETRV for each form/version.  Parameter PAGES is the list of page sections (likewise, 

data tables) that comprise a single form, and parameter DVARS is the list of DATETIME variables to 
convert to SAS DATE variables. 

 
4.3.3 Setup of the SAS Retrieval Program 
 
The current version of the SAS retrieval program was developed in SAS Version 8.1 that was installed as 
a standalone program on a workstation connected to the JHS server containing the Oracle database.  
This SAS retrieval program does not need to be called from within Clintrial or the JHS DMS. 
 
Steps to set up the SAS retrieval program: 
 
1. Install the SAS System software, Version 8 or later, according to your site’s software installation 

policy. 
2. Copy the SAS retrieval program file and accompanying files (%INCLUDE source code) to a directory 

on your workstation. 
3. Edit the SAS retrieval program as follows: 

a. Modify the ‘outds’ macro variable to specify the LIBREF name of the LIBNAME statement for the 
output SAS analysis datasets and modify the corresponding LIBNAME statement with the 
directory location of the output SAS analysis datasets.  The SAS retrieval program delivered to 
the JHSCC includes the LIBNAME statement as used at the UNC-CSCC. 

b. Enter the Oracle access information for your site (macro variables ‘username’, ‘userpw’, 
‘database’, and ‘protocol’).  The SAS retrieval program delivered to the JHSCC includes the 
SYSTEM user account information, the database alias ORC0, and the protocol name 
JHS_COHORT. 

c. Modify the ‘home’ and ‘byformcd’ macro variables to specify the directory locations of the 
%INCLUDE source code.  The program delivered to the JHSCC includes the directory locations 
used at the UNC-CSCC. 

 
4.3.4 Generation of %INCLUDE Source Code for Formats and Variable Labels 
 
A process was established to generate PROC FORMAT statements and FORMAT and LABEL 
statements from information in the database to include in the SAS retrieval program.  A single text file is 
created of the PROC FORMAT statements for all codelists in the database, and individual text files for 
each form/version are created of FORMAT and LABEL statements for items in the protocol.  In addition, a 
list of DATETIME variables is generated to update the RETRV macro parameter DVARS for each 
form/version to convert DATETIME variables to SAS DATE variables. 
 
The steps to generate source code for the SAS retrieval program are as follows: 
 
1. Generate the PROC FORMAT code of all codelists in the database from a Clintrial Retrieve module 

query.  To create a format library text file, do as follows:  
a. Select any query type from File > New Query from the Retrieve browser (for example, select By 

SQL). 
b. In the query dialog box (for example, Query By SQL dialog box), do as follows: 

1) Enter a query.  For example, for Query By SQL, enter SQL text ‘select * from 
JHS_COHORT.ABBA1_ALL;’.  Entry of a valid query is required to get to the next dialog box 
to generate the PROC FORMAT code. 

2) Select Results > To SAS Data File. 
3) Select File > Run Query. 
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c. Now in the Create a SAS File dialog box, do as follows: 
1) Check option Generate SAS Format Library.  You do not need to generate a SAS data file. 
2) Click on Browse to select a directory path location and to enter a file name (without 

extension) for the resultant code.  The directory path and file name must not contain 
embedded periods (.), otherwise Clintrial will truncate the path or name at the first period.  
The output text file will have extension FMT (for example, FrmtlibV1-2.fmt). 

3) Click OK to continue. 
4) Close the open windows and exit Clintrial. 

d. To preserve the original version of FrmtlibV1-2.fmt, make a duplicate copy of the file to modify 
for the SAS retrieval program (for example, JHSRetrV1-2PrFormat.sas). 

e. Edit text file JHSRetrV1-2PrFormat.sas to replace single and double quotation marks embedded 
in the value text string with two single quotation marks.  It is not required to remove statements 
for forms or items not in the current protocol. 

f. Include this text file in a %INCLUDE statement in the SAS retrieval program. 
g. Special note: Clintrial uses the following conventions for SAS format names: 

1) 8-character maximum. 
2) Prefix ‘$’ if code is TEXT data type. 
3) The 6-character codelist SAS name assigned in Design. 
4) Suffix ‘V’ if decoding to values or ‘S’ if decoding to short label or ‘L’ if decoding to long label.  

In JHS, we decode to values. 
 
2. Run the following three SQL SELECT commands (in file JHSRetrV1-2Selects.sql) from a SQL 

command window to create FORMAT statements and LABEL statements for all relevant items in the 
current protocol.  You will need to run these SQL commands using an Oracle user account with 
access rights like user SYSTEM.  The PLSQL Developer software is used at the UNC-CSCC. 

  
 For FORMAT statements of character codes: 

SELECT distinct 'format '||a.item_name||' $'||b.sasname||'V. ;' item_code 
FROM ctsdd.item a, ctscodes.code_index b 
WHERE a.protocol='JHS_COHORT' 
and b.codetype='TEXT' 
and a.codename is not null 
and a.codename=b.codelist 
ORDER BY item_code ; 
 

 For FORMAT statements of numeric codes: 
SELECT distinct 'format '||a.item_name||' '||b.sasname||'V. ;' item_code 
FROM ctsdd.item a, ctscodes.code_index b 
WHERE a.protocol='JHS_COHORT' 
and b.codetype='FIXED' 
and a.codename is not null 
and a.codename=b.codelist 
ORDER BY item_code ; 
 

 For LABEL statements: 
(SAS V8 allows up to 40 characters for variable label text.  A blank is added as the last character 
of the label text to handle cases where DESCRIP is null and needs a blank space between 
double quotation marks as label text.) 
SELECT distinct 'label '||item_name||'="'||substr(descrip,1,39)||' ";' item_label 
FROM ctsdd.item 
WHERE protocol='JHS_COHORT' 
ORDER BY item_label ; 

 
a. Run the SELECT commands.  For example, in the PLSQL Developer software, select File > 

Open > Command File, enter the SELECT commands, and then choose Session > Execute.  
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Select all the output statements generated (Edit > Select All) and copy (Edit > Copy) to a single 
text file (for example, Parse_TextV1-2.txt). 

b. Edit text file Parse_TextV1-2.txt as follows: 
1) Modify any variable labels with two consecutive double quotation marks (“”) indicating no 

label text by inserting a blank (" "), otherwise a single quotation mark prints as the label text. 
2) Replace embedded double quotation marks in the label text with single quotation marks. 
3) Remove semicolons embedded in label text. 
4) It is not necessary to remove extra lines of text and underscores generated by a SELECT 

command run, such as the header associated with a page break. 
c.  Continue with step 3. 

 
3. Run the SAS program Parse_TextV1-2.sas to select FORMAT and LABEL statements by 

form/version from input text file Parse_TextV1-2.txt (created in step 2) and create individual output 
text files for each form/version.  Currently this SAS program adds comment delimiters around the 
FORMAT statements in the output text files so that codes and not format values are stored in the 
output analysis SAS datasets. 
a. Check each output text file and remove any unwanted text.  For example, remove any lines that 

do not begin with ‘format’ or ‘label’ or do not contain the comment delimiters. 
b. Include the individual output text files in a %INCLUDE statement in the SAS retrieval program.  A 

single %INCLUDE statement contains the form/version file name as a macro variable. 
c. Special note for FORMAT statements: See step 1 for Clintrial’s naming conventions of SAS 

format names. 
d. Special notes for LABEL statements: LABEL statements for CONTEXT panel items (key field 

items) are hardcoded in the SAS retrieval program.  A label text can contain up to 40 characters 
in SAS Version 8. 

 
4. Run the following SQL SELECT command (in file ItemdateV1-2.sql) to list all DATETIME variables in 

the current protocol to convert to SAS DATE variables in the SAS retrieval program.  You will need to 
run the SQL command using an Oracle user account with access rights like user SYSTEM.  In the 
SAS retrieval program, add the variable names to the RETRV macro parameter DVARS by 
form/version. 

 
SELECT item_name 
FROM ctsdd.item 
WHERE protocol='JHS_COHORT' and dtype in('DATE','DATETIME') 
ORDER BY item_name; 

 
4.3.5 Special Notes on the Current Version of the SAS Retrieval 
 
1. The program contains retrieval code for forms included in the JHS_COHORT protocol as of 

December 14, 2000. 
2. The program retrieves data field values only and does not include retrieval of flags and notes. 
3. The program includes LABEL statements with the label text from the Clintrial item descriptions used 

as screen prompts.  The item descriptions were assigned when the item was created to 
accommodate screen design and to match form layout.  It is recommended that the JHSCC staff 
review and update these variable labels for the SAS retrieval program to meet their analysis 
needs.  Notes on the labels: 
a. Label text lengths are limited to 40 characters, so some labels are truncated. 
b. A label may be blank or abbreviated or the text of an instruction, as per the form layout. 
c. A label may be incorrect if a change was made to the item but was not made also to the item 

description.  A screen prompt can revised directly on the page section, not requiring that the item 
description be changed as well. 

4. The program includes codelist codes and values in a SAS FORMAT procedure and in FORMAT 
statements.  The FORMAT statements currently are within comment delimiters so that the data 
values written to the output SAS analysis datasets are the codes and not the format values. 
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5. Clintrial’s DATE format is stored as a DATETIME format in the Oracle database.  The SAS retrieval 
program converts DATETIME variables to SAS DATE variables using the SAS DATEPART function.  
Only study data dates are converted, not Clintrial-generated system dates. 

6. Although the SAS retrieval program sets the YEARCUTOFF option to 1912 (a UNC-CSCC ARIC 
statistical programming rule), it can only interpret dates as retrieved from the Oracle database.  Note 
the following year cutoff rule for Clintrial data entry (from Clintrial Help): “Years can be entered as two 
digits or four. When a two-digit year is entered, Clintrial stores numbers 00 to 49 as 21st century 
(2049) and numbers 50 to 99 as 20th century (1950).”  The data entry personnel must be 
instructed to enter dates with a 4-digit year to ensure the correct century. 

 
4.4 Clintrial Retrieve Query By Form (QBF) 
 
4.4.1 Introduction 
 
Clintrial Retrieve, one of the Clintrial core modules, can be used to access and extract data from the 
Clintrial database by creating and running queries.  To access the Retrieve module, a user account must 
have the appropriate access rights assigned by the Clintrial Administrator. 
 
Queries are created using the following four types of query tools: 
 
• Query By Form - selecting fields and entering selection criteria directly on a study page (form).  

Requires familiarity with the study forms and with the data entry standards, but does not require 
familiarity with either SQL or with the structure of the Clintrial database. 

 
• Query By Panel – defining detailed search criteria through use of SQL.  Requires familiarity with 

panels and items within Clintrial and with simple SQL syntax. 
 
• Query By SQL – creating SELECT and DESCRIBE statements.  Requires familiarity with the 

structure of the Clintrial database and with SQL. 
 
• Ad Hoc Query - creating subject record lists to retrieve data for those subjects.  It does not require 

familiarity with SQL, but does require familiarity with the structure of the Clintrial database. 
 
Query results can be sent to the screen, to an Oracle database table, or to a SAS data file.  Then these 
data can be used in other applications to perform statistical analysis, create reports, or perform other 
tasks. 
 
You can store the queries in a Query Library where it can be accessed at a later time.  You can modify, 
copy, run, and delete saved queries. 
  
Using the Custom menu in Retrieve and in other modules, a user can access and start up other 
applications to create reports from the study data.  The user has access to the application from within 
Clintrial, but it executes outside of Clintrial. 
  
4.4.2 Using Query By Form 
  
Query By Form (QBF) is a query method that creates a query directly from the same online study pages 
used in Clintrial Enter for data entry.  For the JHS DMS, a single study page is usually equivalent to one 
form.  However in several cases, a JHS form was split into two study pages due to Clintrial design 
limitations, i.e., PACA parts 1 and 2, PDSA parts 1 and 2, PFHA parts 1 and 2, DISA parts 1 and 2, 
MHXA parts 1 and 2, MSRA parts 1 and 2, SSFA parts 1 and 2. 
  
You can create a query from multiple study pages.  The number of study pages available at a time is 
determined by the ENT_OPEN_PAGES preference for the Enter module that is set by the Clintrial 
administrator.   For JHS data entry, the preference is set at 1 (allowable range is 1-10) to limit the number 
of open pages at one time by a single user account in Enter.  Once data have been entered and verified, 
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set the ENT_OPEN_PAGES preference to at least 2 for the Retrieve sessions so that you can add 
multiple study pages to a query for the several JHS forms that are split into multiple study pages. 
  
Below are the steps for using Query By Form.  It is suggested to perform a separate query for each JHS 
form, repeating these steps for each form. 
 
Assumptions are that you have logged into the Clintrial Retrieve module and have selected the correct 
protocol: 
 
• Start the Clintrial Retrieve module from Start > Programs > Clintrial 4.2 > Retrieve.  Login to 

Clintrial with a valid Clintrial user name, password, and database alias (ORC0 for JHS).  You are now 
in the Clintrial Retrieve window. 

• From the Retrieve window menu bar, select File > Set Protocol and protocol JHS_COHORT for 
retrieval of the baseline visit 1 data, if not automatically set at login. 

 
The steps to use Query By Form are as follows: 
 
1. Start Query By Form. 

 
From the Retrieve window menu bar, select File > New Query > By Form (QBF) to start Query By 
Form.  The Select Page dialog box opens. 

  
2. Select study pages. 

 
From the Select Page dialog box, select the study page(s) to include in the query.  Study pages are 
added to a query one at a time.  These study pages do not need to be in the same block (visit) or 
study book (INTERVIEW or EXAM). 
 
To select a study page, do as follows: 
a. Select a study book. 
b. Select a study page from the list, or type the study page name in the Page field. 
c. Click OK to continue.  A Query By Form window opens, displaying the study page you selected. 
 
To open another study page, select Edit > Select Additional Page and repeat a-c above.  If multiple 
study pages are open, you can move to another study page that is open using the commands in the 
Window menu.  If an additional page is selected from the Edit menu that is already open, a new copy 
of the study page opens. 
 

3. Select fields. 
 
For the study page open in the Query By Form window, select either specific fields or all fields for the 
study page.  The selected fields are highlighted on the study page. 
 
To select or deselect all fields on the study page, select Edit > Select All. 
  
To select or deselect a specific field, place the cursor in the field that you want to select or deselect 
using the Tab key or the mouse and then choose Edit > Select Item. 
 

4. Enter criteria in fields to specify a subset of data to retrieve (optional). 
 

If you enter selection criteria for a field, you do not also have to retrieve values for that field when you 
run the query.  Selecting fields and entering selection criteria are separate tasks. 
 
To enter selection criteria for the study page open in the Query By Form window, do the following: 
a. Place the cursor in the field for which you want to enter selection criteria using the Tab key or the 

mouse. 
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b. Enter the selection criteria using one of the following methods: 
1) Enter an exact valid value.  For a text field, enter the value without quotation marks.  For a 

numeric value, enter a numeric value or function without quotation marks.  For a date field, 
enter a date in a valid date format without quotation marks. 

2) Enter a value pattern as an operator and a valid value. No quotation marks are needed for 
text or numeric types, but they are required for date types. 

3) Select a code from the codelist, and optionally add an operator. 
c. To enter a selection criteria for another field, repeat a and b. 

 
5. Create a sort order of retrieved records (optional). 

 
You create a sorting order for the retrieved records by field values.  The default sort order for a field is 
None.  You can specify sort orders for more than one field.  Clintrial sorts the results according to the 
tab order of the fields. 
 
To sort the query results for the study page open in the Query By Form window, do as follows: 
a. Place the cursor in the field whose values you want to sort. 
b. Select Edit > Sort to open the Sort Field dialog box. 
c. Select sort order Ascending, Descending, or None, then click OK to continue. 
 
To remove the sort order for a field, do a-c above and select None. 
  
To change the field sort order, do one of the following: 
a. Select Results > To Window to display the results on the screen, then run the query from File > 

Run Query.  When the results are displayed on your screen, select View > Sort to sort the 
displayed records. 

b. Select File > Convert to SQL to convert the query to SQL code, then change the SQL syntax to 
reflect the order you want. 

 
6. Create flag or note restrictions (optional). 
 

To create a flag or note restriction for the study page open in the Query By Form window, do as 
follows: 
a. Select Edit > Flags/Notes Restrictions. 
b. Select the flag or note category and the flag or note name from the drop down list. 
c. Specify the flag or note level. 
d. Specify the page to which you want the flag or note to be attached.  Note for the JHS DMS, the 

page number is displayed for the open study page and the field is disabled for entry. 
e. If you are creating a restriction at the Item level, specify the item to which you want the flag or 

note to be attached. 
f. Click Add.  Clintrial Retrieve adds the flag or note restriction to the Selection box. 
g. Select whether to retrieve records if the flag or note is present or absent from the drop down list. 
h. To create multiple flag or note restrictions, repeat b-g.  A logical operator field appears in the 

Selection box.  Select the flag or note connector from the drop down list. 
 
To remove a flag or note restriction, do as follows: 
a. Select the flag or note restriction to remove by clicking anywhere within the restriction in the 

Selection box. 
b. Click Delete. 
 

7. Display the query in SQL format (optional). 
 

You can display the SQL for the current query in Query By Form from File > Convert to SQL to 
review a single page query, to review a multi-page query as a whole, or to perform tasks for which 
you must use SQL.  You can display a query in SQL at any time and still return to the Query By Form 
page(s) if you do not alter the SQL.  However, if you alter the SQL in the Query By SQL window, you 
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should not return to the Query By Form page(s).  Any changes you make to the SQL cannot display 
in the Query By Form page(s). 
 

8. Run the query to retrieve the query results, and send the results to various locations in various export 
formats. 

 
To run a query in the Query By Form window, do as follows: 
a. Select the destination for the query results from the Results menu.  Options are To Window, To 

Oracle table, or To SAS Data file. 
b. Select File > Run Query.   
 
After the query runs, your results destination does one of the following: 
a. To Window - displays the results in a Query By Form Results window. 
b. To Oracle table – opens the Results to Oracle Table dialog box. 
c. To SAS Data file – opens the Create a SAS File dialog box. 
 
See the section on saving results to a SAS data file below for details on creating an output ASCII file 
(.DAT) of the study data retrieved from the query and a SAS source code file (.SAS) with the input 
statement containing the variable names and formats to read the ASCII data file. 
 

9. Print the query. 
 

Select File > Printer Setup to specify which local or network printer to use. Depending on your 
printer, you can also adjust certain printer defaults like page orientation, paper size, and print 
resolution. Consult your printer's documentation for more information. 
 
To print a report or window from the Query By Form window, do as follows: 
a. Select File > Print.  At any time the Print command is not available for a displayed window, then 

that window does not have print capability. 
b. The Print Options dialog box opens. Accept default settings or modify any of the values as 

needed. 
c. Click OK to print. 
 

10. Save the query to the Query Library for later use by you or other users (optional). 
 

To save a query in the Query By Form window, do as follows: 
a. Select File > Save Query As. 

1) If you have previously saved this query, Clintrial Retrieve saves the query to the same query 
name automatically. 

2) If you have not previously saved this query, the Save Query As dialog box opens. 
b. In the Save Query As dialog box, do as follows: 

1) If you are saving a Query By SQL, select the protocol under which you want to save the 
query. 

2) Enter the query name 
3) Enter a description for the query. 
4) If you want the security access type for the query to be Public, check Public Query. 
5) Click OK. 

 
To access the saved queries in the Query Library, select File > Query Library from the Query By 
Form window. 
 

4.4.3 Saving Results to a SAS Data File 
 
Query results can be saved to a SAS data file from the Query By Form window in one of two ways: save 
directly to a SAS data file without display, or display and then save to a SAS data file. 
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To run and save the query results directly to an SAS data file (does not display results), do as follows: 
 
1. From the Query By Form window, select Results > To SAS Data file from the menu. 
2. Create or select the query you want to run either for selected items (place cursor on item and then 

select Edit > Select Item) or for all items (select Edit > Select All). 
3. Select File > Run Query to run the query and which opens the Create a SAS Data File dialog box. 
4. From the Create a SAS Data File dialog box, to save the query results to a SAS data file, do: 

a. Specify path, file name, label, and record length for the SAS data file.  Note that path C:\CT42 is 
the default. 

b. To create a PROC FORMAT for this data file (optional), check Make PROC FORMAT.  
c. Click OK.  Clintrial Retrieve displays a confirmation message indicating where the query results 

are stored; click OK. 
 
To run and display the query and then save the results to a SAS data file: 
 
1. From the Query By Form window, run the query in File > Run Query which sends the results to a 

Query By Form Results window. 
2. From the Query By Form Results window, select File > Save Results As. The Save Results As 

dialog box opens. 
3. In the Save Results As dialog box, select SAS Data Files [.SAS] from the File Format drop down list. 

The file name in the File Name field changes to *.SAS, and the SAS fields at the bottom of the dialog 
box become active.  Then, do: 
a. Specify the path, file name, label, and record length for the SAS data file. Note that path C:\CT42 

is the default. 
b. To create a PROC FORMAT for this data file (optional), check Make PROC FORMAT. 
c. Click OK.  Clintrial Retrieve displays a confirmation message indicating where the query results 

are stored; click OK. 
 
4.4.4 Setup and Run the SAS Data 
 
If you have saved the query results to a SAS data file, then you have the following two or three text files in 
the directory that you chose: 
 
1. SAS source code file (.SAS) with a data step that includes an INFILE statement with the location and 

name of the ASCII data file, an INPUT statement with valid variable names and formats, LABEL 
statements for the variables (the prompt used in the data entry window), and optionally FORMAT 
statements for the variables with codelists. 

2. ASCII file of SAS data (.DAT) from the query that corresponds to the SAS source code INPUT 
statement. 

3. Optionally, PROC FORMAT code file (.FMT) with the VALUE statements for all the codelists attached 
to the variables in the query. 

 
To setup a SAS program using these files, do the following: 
 
1. Optionally insert the PROC FORMAT code file into the SAS source code file either directly or with a 

%INCLUDE statement. 
2. Add additional SAS statements to the SAS source code file either to save the data to a permanent 

SAS dataset, to create a report, or to run data analysis. 
 
You can now run the final SAS source code file in SAS.   Consult your local SAS support personnel for 
information on how to run SAS at your site.  
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5.0 ADMINISTRATOR GUIDE 
 
 
5.1 Data Entry Workstation Setup 
 
Setting year format for dates 
 
The format in which dates are entered and displayed in Clintrial is determined by the Window’s date 
setting.  Set the date format (a regional setting) to a four-digit year format (mm/dd/yyyy). 
 
In Clintrial data entry, enter four-digit years for dates to ensure the correct century.  If a two-digit year is 
entered, Clintrial interprets the year as follows: 
• 00 through 49 as the 2000’s 
• 50 through 99 as the 1900’s 
 
Creating a desktop Enter shortcut icon 
 
To put a shortcut on the desktop, do as follows: 
1. In Start > Programs > Clintrial 4.2, right-click on Clintrial Enter and left-click Create Shortcut. 
2. Holding down the left mouse button, drag the new shortcut icon, named Clintrial Enter (2), from 

Start > Programs > Clintrial 4.2 onto the desktop. 
3. To rename the shortcut, right-click the shortcut and left-click Rename.  Type the new name, and 

press Enter. 
4. Double-click the shortcut icon to start the Clintrial Enter module. 

 
To change any settings for the shortcut, right-click the shortcut and then left-click Properties.  
 
To delete a shortcut, drag the shortcut to the Recycle Bin.  The original item still exists on the disk.  
 
Screen resolution and window size 
 
The screen resolution and window size for data entry must be set the same as the setting used during the 
development of the JHS DMS.   The settings are as follow: 
 
• Set the screen resolution to 800 by 600 pixels in Start > Settings > Control Panel > Display.  Click 

on the Settings tab.  Under Screen area, click on the left or right of the arrow to get this resolution. 
• Set the window size to Maximum.  Click the middle windows button on the top right of an open 

window to toggle between maximum full screen and minimum window display. 
• Remove the toolbar buttons to maximize the screen further.  In a window, select the Window > 

Toolbar menu commands and click on Toolbar to remove the check.  Several bugs in Clintrial at the 
time of this writing affects some of the toolbar buttons, so it is recommended to use the menu 
commands or to right-click the mouse for selections. 

 
Installing and Deinstalling Oracle and Clintrial Client Software 
 
Installing the Oracle Client Software: 
 
1. Insert the Oracle CD into the workstation CD-Rom. 
2. Once the Oracle installer main menu appears, click on “Begin Installation”.   If the Oracle installer 

main menu does not appear, you can open the Windows Explorer and access the root directory of the 
Oracle CD-ROM.  From the root directory, double-click on SETUP.EXE. 

3. You are then asked to confirm the installation default settings, then click OK. 
4. You will then be asked to choose the type of installation, click on “Oracle 8 Client” then click on OK. 
5. You will then be asked the type of user you are installing for, choose “Application User” and click OK. 



42 

Exam 1 Data Management System Manual.doc 

 

6. You will then be asked where the Oracle Documentation should be put, choose “CD-Rom” and click 
on OK. 

7. You will then be asked if you would like to view the Oracle documentation from within your browser, 
answer No. The Client installation is complete and the Oracle installer will be exited. 

8. In order to be able to use Clintrial you must now install the Oracle “Required Support Files 7.3.4.1.1” 
to do this repeat steps 1 through 3 above. 

9. You will then be asked to choose the type of installation, click on “Custom Installation” then click on 
OK. 

10. The Software Asset Manager will appear.  Double-click on the All Products entry on the left hand side 
of the Software Asset Manager window.  A scrollable list will be presented; choose “Required Support 
Files 7.3.4.1.1” by clicking on the entry, then click on Install. This will install the Required Support 
Files. 

11. Upon completion of the installation the Oracle Installer will notify you, at this point you must click on 
OK, you will be returned to the Software Assets Manager, click on Exit then Yes, to confirm that you 
would like to exit the Oracle Installer. 

12. Reboot your computer after exit from the Oracle Installer with the resultant changes to your 
AUTOEXEC.BAT (or, you can wait until after Clintrial installation and network connection). 

13. You are now ready to install the Clintrial client software on the workstation. 
 
Installing the Clintrial Client Software: 
 
1. Insert the Clintrial CD into the  workstation CD-Rom. 
2. Open the Windows Explorer and access the root directory of the Clintrial CD-Rom.  From the root 

directory double-click on Setup.exe. 
3. The Clintrial Welcome screen will appear, click Next. 
4. You will be asked for name and company, enter these and click Next. 
5. Clintrial will then ask you to confirm that the client software is to be installed in C:\CT42, click Next. 
6. Choose Typical as the setup type and click Next. 
7. Select Clintrial 4.2 as the Program Folder and click Next. 
8. The installation will then take place, at the end of which you will be asked if you would like to view the 

ReadMe file. Click on Finish. 
9. You are now ready to establish your network connection to the computer where the Clintrial database 

is located. 
 
Establishing Network Connection: 
 
1. Start the Oracle Net8 Easy Config module by selecting the following: Start > Programs > Oracle for 

windows 95 > Oracle Net8 Easy Config . 
2. Click Yes to continue on past the first dialog box with a warning that comment information in the 

Network Configuration files may be lost or repositioned when saving your Network configuration. 
3. Choose action Add New Service (database alias) and enter a name as the New Service Name.  Enter 

ORC0 as the service name (or the current database alias at your site).  Note that .WORLD is 
automatically appended to ORC0 in the display of available Service Names.  Click Next to continue. 

4. Choose TCP/IP (Internet Protocol) to connect to and communicate with the Clintrial database you 
want to use.  Click Next to continue. 

5. Enter the IP address as Host Name of the computer where the Clintrial database is located.  Leave 
1521 as the default Port Number.  Click Next to continue. 

6. Enter ORC0 (or the same name as the current database alias) for the Database SID.  Click Next to 
continue. 

7. Click Test Service to test the connection.  In the database connection dialog box, enter a valid Oracle 
database username (for example, SYSTEM) and its password and click Test.  After the test is 
completed, click Done to continue.  If the connection test was successful, click Next from the Test 
Service dialog box to continue; if not successful, click Back to review and correct previous entries. 

8. Click Finish to save your service name changes. 
9. You are now ready to create new Clintrial user accounts. 
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Setting Up Client User Accounts: 
 
1. Start the Clintrial Admin module by selecting the following: 

Start > Programs > Clintrial 4.2 > Clintrial Admin 
2. In the database connection dialog box, enter the User Name (for example, CTSYS) and Password 

that was set up with system privileges on installation of Clintrial on the server.  For Database, enter 
your service name added in Oracle Net8 Easy Config preceded by @ ( for example, @ORC0). 

3. From the Security menu, select Users to get the User Maintenance window. 
4. From the Edit menu, select Add. 
5. Enter a name (user account) for the new User Name.  A valid user name can be up to 20 characters 

long, alphanumeric, not beginning with a number, and without spaces or other symbols.  User name 
is not case sensitive. 

6. Enter a Password.  When you save the window, you will be prompted to re-enter the password for 
verification.  The password must conform to the parameters as set up by the system administrator 
(currently length set at 6).  A password must consist of alpha and/or numeric characters (other 
symbols and spaces not allowed) and cannot begin with a number.  A password is not case sensitive. 

7. Accept the defaults, or change the values for : 
Default Tablespace: CT_USER 
Temporary Tablespace: TEMPORARY 
Profile: DEFAULT 

8. From the File menu, select Save to save the window. 
9. From the Security menu, select User Access to set access rights and access levels for Protocol, Non-

Protocol, and Panel (to be determined).  Close the User Access Rights window. 
10. From the Parameters menu, select System to define any special characteristics of the work 

environment for the user.  Close the System Parameters window. 
11. Close the Clintrial Admin module after the new user accounts have been created with appropriate 

access rights and system parameter definitions. 
12. Optionally you can place a Clintrial 4.2 icon on the Desktop (for Switchboard with access to all 

Clintrial modules or just for Enter to perform data entry) by doing as follows. Open My Computer or 
Windows Explorer and select Clintrial 4.2.  From the File menu, select Create Shortcut.  Select the 
Clintrial 4.2 shortcut and drag the shortcut onto the Desktop by holding down the left button of the 
mouse. 

 
Deinstalling  Oracle and Clintrial Client Software: 

 
To delete Oracle and/or Clintrial client software from a computer, say, to restart installation after an 
unsuccessful attempt, use the following deinstallation instructions. 
 
To deinstall Clintrial Client Software, do the following. 
1. Double-click on the icon for My Computer. 
2. Double-click Control Panel. 
3. Double-click Add/Remove Programs. 
4. Select Clintrial 4.2 and click Add/Remove. 
5. The directory C:\CT42 can be deleted from Windows Explorer or by the RD DOS command at an MS-

DOS command prompt. 
 
To deinstall Oracle Client Software, do the following. 
1. Start the Oracle Installer module as follows: Start > Programs > Oracle for Windows 95 > Oracle 

Installer. 
2. Select all Oracle modules (shift-down arrow) in the rightmost column labeled “Products Installed at 

C:\ORAWIN95” and click Remove.  The Oracle Installer remains installed and does not need to be 
deleted if Oracle will be reinstalled. 
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5.2 System Parameters 
 
Clintrial system parameters define the characteristics of the work environment for all users of an Oracle 
database to which the users connect through Clintrial.  These system parameters are set in the Clintrial 
Admin module from a user account that has the Admin System access right.  In Admin and in the 
following table, system parameters are grouped by the module to which they pertain. 
 
Parameters of type ‘System’ cannot be overridden.  Those of type ‘Protocol’ can be overridden by 
modifying protocol parameters within the Design module.  Those of type ‘User’ can be overridden by user 
preferences for each module (or Group).  For JHS, the ‘System’ parameters are set for the study and do 
not override the values within protocol or user. 
 
The table below lists the parameter value to be used in JHS and a description of what the value means.  
If the description is blank, no value has yet been determined. 
 
Group Type Name Value Description 
     
Admin System  PASSWORD_ENCRYPTION No  
 System SAVE_STATS Yes  
 System ACTIV_LOG_END   
 System ACTIV_LOG_START   
 System PASSWORD_EXPI RE_DAYS   
 System PASSWORD_MINIMUM 6  
 System USR_DB_PROFILE DEFAULT  
 System USR_DFT_TSP CT_USERS  
 System USR_TMP TSP TEMPORARY  
 
Manage  System ALLOW_MERGE_TO_VALID Yes  
 System AUDIT_REASON_REQD Yes  
 System AUTOCODE_FULL_CNT No  
 Protocol AUTOCODE_RECODE_ALL No  
 System AUTOCODE_SET_FAIL Yes  
 Protocol ENCODE_CLEAR_ITEMS Yes  
 User SELECT_BY_PAGE  Yes  
 User AUDIT_ITEM_LIST   
 User ERRLOG_DISPLAY_ITEM   
 
Entry User  DD_BLANKS_IN_PATIENT No Blank spaces not allowed in 

subject item. 
 User ENT_AUTOSKIP_DFLT  No  
 User ENT_ENTER_AS_TAB  Yes Enter key acts as Tab key. 
 User ENT_FORM_INSERT  Yes Data is saved automatically 

when a page is closed. 
 User ENT_OPEN_NAVIGATOR  Yes  
 User ENT_TAB_PAGE_FORWARD No In last field on page, Tab key 

moves to first item on 
current page. 

 Protocol VERIFY_BLIND Yes  
 System VERIFY_SHOW_TAGS Yes  
 User ENT_ENR_STUDYBOOK   
 User ENT_OPEN_PAGES 1 Number of study pages that 

can be opened concurrently. 
Increase to 10 temporarily to 
print study book or do QBF. 
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Design  System AUDIT_INVNOTES Yes  
 Protocol AUDIT_METADATA Yes  
 System AUDIT_PROTOCOL_MOD Yes  
 System AUDIT_SPONSORNOTES Yes  
 Protocol CONNECT_REQD_DD No  
 Protocol CONNECT_REQD_FRM No  
 Protocol CONNECT REQD VLD No  
 Protocol CREATE OBJ_DD Yes  
 Protocol CREATE_OBJ_FRM Yes  
 Protocol CREATE_OBJ_VLD Yes  
 Protocol DD_AUTOVALIDATE No  
 User DD_SASNAME_UPDATE Yes  
 Protocol DD_STRICT_CODE No  
 Protocol DD_STRICT SEARCH No  
 User FRM_CODEENTRY  No  
 User FRM_OVERRIDE  No  
 User FRM_USE_DESCRIP  Yes  
 System AUDIT_START_DEFAULT  MERGE  
 User DD_DBFMT_FIXED  NUMBER(5)  
 User DD_DBFMT_FLOAT  NUMBER(6,2)  
 User DD_DBFMT_TEXT  VARCHAR2(20)  
 Protocol PROC_ACCOUNT   
 System PROC_SITE_ACCOUNT  CTSITEPROC  
 System PROT_TMP_TSP  TEMPORARY  
 System XFER_TABLESPACE   
 
Retrieve  User RTV_INCL_SYS No  
 User RTV_DEF_DECODE  0 Codelist column used for 

decoding: 0=code, 1=value. 
 User RTV_SAS_RECLEN  80  
 User RTV_DEF_SOURCE  DATA From data tables only.  ALL 

includes both update and 
data tables. 

 User SAS_LIBNAME   
 
Resolve  System CTV_USE_ERRORLOG Yes  
 System CTV_APPL_RES_CODE   
 System CTV_AUTOCLOSED_RES   
 System CTV_OBSOLETE_RES   
 User CTV_FIRST HEADER Company Name  
 Protocol CTV_FIRST_HEADER_PR   
 User CTV_REQUESTER   
 Protocol CTV_REQUESTER_PR   
 User CTV_SECOND_HEADER Discrepancy 

Form 
 

 Protocol CTV_SECOND_HEADER_PR   
 Protocol CTV_SELECT_INVESTIGA See 1 below  
 Protocol CTV_SELECT_SUBJECTS See 2 below  
 Protocol CTV_SELECT_VISITS See 3 below  
 Protocol CTV_SELECT_VI SITS_1S See 4 below  
 User CTV_STARTUP_VIEW ALL   
 Protocol CTV_STARTUP_VIEW_PR   
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1) SELECT UNIQUE CT_RESOLVE_USER.INV_ID(<SUBJECTITEM>, 
'<PROTOCOL>') FROM<PROTOCOL>.SUBSTITUTE*PANEL_ SUBSTITUTE*DBTABLE 
    
2) SELECT UNIQUE <SUBJECT_ITEM> FROM <PROTOCOL>.SUBSTITUTE*PANEL 
SUBSTITUTE*DBTABLE 
WHERE CT_RESOLVE_USER.INV_ID(<SUBJECT_ITEM>, '<PROTOCOL>') = 
'SUBSTITUTE*INVESTIGATOR' 
 
3) SELECT UNIQUE <BLOCK_ITEM> 
FROM<PROTOCOL>.SUBSTITUTE*PANEL_SUBSTITUTE*DBTABLE 
 
4) SELECT UNIQUE <BLOCK_ITEM> FROM<PROTOCOL>.SUBSTITUTE*PANEL 
SUBSTITUTE*DBTABLE 
WHERE <SUBJECT_ITEM> = 'SUBSTITUTE*SUBJECT' 
 
 
Lab 
Loader 

User CTL_TEST_MODE No  

 System CTL_DUPFLAG_LOC DATA  
 
Classify System CTG_ALLOW_CHANGEVEB Yes  
 System  CTG_AUTOACCEPT No  
 System  CTG_EDIT_SYNTEXT No  
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5.3 Adding New User and Usergroup Accounts and Assigning Access Rights 
 
Adding a New User Account 
 
Each Clintrial user must have a user account consisting of an ID and password to work with Clintrial 
modules. Multiple users with similar access needs (for example, data entry personnel) can be assigned to 
a usergroup, which allow you to assign and modify their access rights as a single set. 
 
To add a new user, do as follows: 
 
1. Login to the Clintrial Admin module. 
2. From the Clintrial Admin window, select Security > Users.  The User Maintenance window opens. 
3. In the User Maintenance window, select Edit > Add.  The cursor is placed in the User Name field.  

Do as follows: 
a. Enter a name for the new user for User Name. 
b. Enter a password for Password. When you tab from the field or save the window, you will be 

prompted to re-enter the password for verification.  Follow the password requirements at the 
beginning of this manual.  You may choose to assign a generic temporary password to new 
users, which they can later change themselves. 

c. Accept the defaults for the remaining fields. 
d. Close the window from File > Close or from the window's X button to return to the Admin window. 

 
 
To modify a user password, do as follows: 
 
1. Follow steps 1 and 2 for a new user to login to Clintrial Admin and to open the User Maintenance 

window. 
2. In the User Maintenance window, do as follows: 

a. Select a user in the Select User list. 
b. Enter a new password.  When you tab from the field or save the window, you will be prompted to 

re-enter the password for verification. 
c. Close the window from File > Close or from the window's X button to return to the Admin window. 

 
To delete a user, do as follows: 
 
1. Follow steps 1 and 2 for a new user to login to Clintrial Admin and to open the User Maintenance 

window. 
2. In the User Maintenance window, do as follows: 

a. Select a user in the Select User list. 
b. Select Edit > Delete. 
c. Close the window from File > Close or from the window's X button to return to the Admin window. 

 
Note that upon deletion, the user will automatically be removed from any associated usergroups. 
 
Creating a Usergroup Account 
 
Usergroups are sets of individual user accounts.  Grouping of user accounts provides an easy way to 
manage access rights for multiple accounts with identical access requirements.  Once a group is created 
and its rights defined, its members automatically receive those rights and any subsequent modifications.   
 
Clintrial Help provides the following information about usergroups: 
 
• Belonging to a group does not prevent a user from having individual access rights beyond those of 

the group. 
• Users can be associated with one or more usergroups. 
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• In the case of a user whose individual access differs from that of the usergroup, or in the case of a 
user belonging to multiple usergroups with contrasting access rights, the highest access level always 
takes precedence. 

• Deleting a usergroup does not delete its members' individual user accounts. 
• When planning a usergroup, consider the following: What Clintrial activities will this group perform?  

What study data or metadata does this group need access to?  For the specified data, what tasks 
does this group need to perform, for example, read and write tasks? 

• Clintrial supplies three predefined usergroups.  These groups can be used as is, modified as 
necessary, or deleted altogether.  The groups and their default access rights are as follows:  

 
 Group  Module  Type  Access right Access levels 
 
 ADMIN  Admin  Non-protocol DBA  Full 
       System  Full 
   Design  Non-protocol Global  Full 
       System  Full 
   Tools  Non-protocol SQL  Full 
 
 ANALYSIS Retrieve Protocol Merged  Read 
       Library  Write 
 
 ENTRY  Enter  Protocol Unmerged Full 
 
To create a usergroup, do as follows: 
 
1. Login to the Clintrial Admin module. 
2. From the Clintrial Admin window, select Security > Usergroups.  The Usergroup Maintenance 

window opens. 
3. In the Usergroup Maintenance window, do as follows: 

a. Select Edit > Add.  An Add Usergroup dialog box opens.  Enter a name for the new usergroup 
for Usergroup Name and click OK.  A usergroup name can be up to 20 characters long, must be 
alphanumeric, and cannot begin with a number.  A usergroup name is not case sensitive. 

b. To add or remove group members, see below. 
c. Close the window from File > Close or from the window's X button to return to the Admin window. 

 
To delete a usergroup, do as follows: 
 
1. Follow steps 1 and 2 to create a usergroup to login to Clintrial Admin and to open the Usergroup 

Maintenance window. 
2. In the Usergroup Maintenance window, do as follows: 

a. Select the group you want to delete from the Usergroups list. 
b. Select Edit > Delete. 
c. Close the window from File > Close or from the window's X button to return to the Admin window. 

 
To add or remove group members, do as follows: 
 
1. Follow steps 1 and 2 to create a usergroup to login to Clintrial Admin and to open the Usergroup 

Maintenance window. 
2. In the Usergroup Maintenance window, do as follows: 

a. Select a group from the Usergroups list. 
b. To add users, select from the Non-members list and click <<. 
c. To remove users, select from the Members list and click >>. 
d. Close the window from File > Close or from the window's X button to return to the Admin window. 

 
Assigning Access Rights 
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Clintrial Help provides the following information on access rights: 
 
Once a user account or usergroup has been created, the Clintrial administrator must assign access rights 
for the new account.  Access rights determine a user or usergroup's ability to access data and perform 
tasks in Clintrial. 
 
An access right is composed of the following two parts: 
 
• The access right, which specifies the data type or action in question (for example, merged data). 
• The access level, which specifies what can be done with that right (for example, read or write). 
 
There are the following three categories of access rights: 
 
• Protocol access rights control access to data and actions related to a specific protocol. 
• Non-protocol access rights control access to data and actions independent of specific protocols. For 

example, the ability to use SQL. 
• Protected Panel access rights control access to protocol panels that have been designated as 

"protected" in Design.  To work with a panel of this type, the user must have access to both the 
protocol and the panel itself. 

 
Within each of these three categories, access rights are further grouped by the Clintrial module.  
 
The simplest and most effective way to assign access rights is through usergroups.  Once a group is 
created and its rights defined, its members automatically receive those rights.  Rights for a particular user 
are typically only defined when additional access beyond that of the group is required by a user. 
 
In the case of a user whose individual access differs from that of the usergroup, or in the case of a user 
belonging to multiple groups with contrasting access rights, the highest access level always takes 
precedence.  For example, if user X has write access to Admin, but X's usergroup access is read-only, 
the higher (write) access takes precedence 
 
By default, newly defined users and usergroups have no access rights.  Exceptions are Clintrial's 
predefined user account (CTSYS) and usergroups (Admin, Analysis, Entry). 
 
To assign access rights, do as follows: 
 
1. Login to the Clintrial Admin module. 
2. From the Clintrial Admin window, select Security and the access action you want to take (User 

Access, Usergroup Access, Protocol Access, or Panel Access).  See Clintrial Help for more 
detail. 

3. In an access rights window, select a row to which you are assigning access.  For each Clintrial 
module, select the appropriate access level from the drop-down list.  The list displays automatically 
when you click in a field.  The dash (-) signifies No Access.  If a user belongs to any usergroups, the 
usergroups are listed as unavailable rows under the user's name. 

4. Close the window from File > Close or from the window's X button to return to the Admin window. 
 
To copy settings from one row to another in an access rights window, do as follows: 
 
1. Click a field in the row you want to copy from. 
2. Select Edit > Copy Row. 
3. Click a field in the row you want to copy to, and select Edit > Paste Row. 
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5.4 Administering Clintrial and the Oracle Database 
 
This appendix may later include information on topics such as daily monitoring of data table space, 
installing Oracle and Clintrial service releases, and updating the DMS. 
 
Typical users and of the Clintrial modules 
 
Clintrial consists of five integrated core modules (listed below) and a Clintrial Switchboard that provides a 
single point of access to the Clintrial modules.  Supplemental modules that extend the basic Clintrial 
functionality are also available. 
 
Module  Use to        Typical user 
 
Admin  Create user and usergroup accounts.    Clintrial Administrator 
  Set up and manage access rights for users, usergroups,   or 
      and protocols for all Clintrial modules.    Database Administrator 
  Set system parameters. 
  Monitor database space. 
  Produce reports about system activities.  
       
Design  Design the study database to model your study protocol.  Designer 
  Define data structures for storing study data.   or 
  Create study books that are online representations of   Programmer 
      a set of data collection forms for data entry. 
 
Enter  Add (enroll) subjects to a study.     Data-Entry Operator 
  Enter study data interactively. 
  Verify (re-enter) study data. 
  Edit study data. 
  Add flags and notes to study data. 
  Produce reports about study data. 
 
Manage Batch load study data.      Data Manager 
  Code study data using a coding thesaurus. 
  Validate data (run derivations and rules). 
  Globally change or delete records. 
  Edit records based on an Error Log report. 
  Review an audit report of changes to study data.  
 
Retrieve Extract study data from the Oracle database using SAS.  Data Manager 
  Create simple or complex queries using SQL from Clintrial. or 
          Medical Reviewer 
 
Monitoring data table space 
 
At installation, Clintrial sets default storage parameters for its Oracle tablespaces.  Using the Admin 
module, the Clintrial Administrator can view and modify these storage parameters and can regularly 
monitor the growth of the database (e.g., run Reports > Space Utilization for tables and indexes). 
 
Frequent monitoring of the tablespaces by the Database Administrator is recommended.  Clintrial does 
not recognize when tablespace limits are approached, and a protocol could be damaged if space 
allocations are exceeded. 
 
Manuals on Oracle DBA administration are available from the Oracle Corporation.  Another source for 
information is from books by users such as Oracle Performance Tuning by Mark Gurry & Peter Corrigan 
from O’Reilly & Associates, Inc. 
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5.5 Blind Verification Procedure 
 
Introduction 
 
Verification or double data entry is the process of re-entering study data to compare the old and new 
values, checking for data entry errors or value conflicts.   
 
Clintrial supports two types of verification: interactive verification and blind verification. 

 
For the JHS, selected study data are re-entered using blind verification. The forms that are verified are 
those forms completed on paper (enumeration, home induction interview, Approach to Life A-C, and 
Hassles and Moods A-D forms). 
 
Blind verification is performed in the Enter module, and reports on verification errors are generated in the 
Enter module on ‘unmerged’ data in the update tables. 
 
JHS DMS Form Design and Its Significance in Verification Error Checking 
 
A single form or study page is usually made up of multiple records (panels or page sections), each 
containing a unique subset of items (fields) for the form. 
 
Knowing that a form requires verification, the designer sets the Verify attribute for usually all the panels 
for that form from the Panel Browser in the Design module.   
 
Following blind verification, not all the records (or panels) for a single form may have the same record 
status.  For example, the ELGA Eligibility form is composed of seven records.  If only an item contained in 
the first panel of this form has a value conflict from blind verification, then only the first record for the form 
containing this item receives a record status of Verify Error; the other records for the same form receive a 
record status of Verified. 
 
What is Blind Verification? 
 
In blind verification, Clintrial compares old and new values when you save a study page re-entered in the 
Verify edit mode.  During blind verification, the new values do not overwrite the old ones, nor can you 
choose which value to retain.   
 
If there is a value conflict, a record status is changed from Unverified to Verify Error, otherwise a record 
status is changed to Verified.  Clintrial also attaches a VERIFICATION/AUTOFLAG flag to an item with a 
value conflict.  The VERIFICATION/AUTOFLAG flag comment contains the original and re-entered values 
and the user accounts of the data-entry operator(s) who entered the values. 
 
Reviewing Blind Verification Results 
 
Three Clintrial reports accessed from the Reports menu in the Enter module can provide results on the 
blind verification.  These reports are the Verification Report, Subject Report, and Flag Report.  Only 
subjects in the update tables are included in these reports.  Once created, these reports can be viewed 
online, printed, or saved to a file.   
 
The Verification Report (record level) contains a list of records with a status of Verify Error. 
  
A Detailed Subject Report (record level) can contain a list of all records for a form(s) and their record 
status. 
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A Detailed Flag Report (item level) can include items with a VERIFICATION/AUTOFLAG flag, along with 
the comments containing the original and re-entered values and the user accounts of the data-entry 
operator(s) who entered the values. 
 
The Flag and Subject reports are available in two basic formats: detailed and summary. The detailed 
format provides in-depth information on the attributes of each record that it retrieves. The summary format 
gives a count and categorical breakdown of the records it finds. You can tailor each report by entering 
criteria prior to generating it using the Report Wizard. 
 
The Clintrial Help menu provides in-depth information on these three reports.  Select Help > Help Topics 
in the Enter module.  You can find information under the Contents tab in Enter Reports, and you can find 
information under the Index tab for ‘reports’. 
  
Special note on reviewing verification results: A form with any of its records and items marked with 
verification errors should not be changed and set to Verified until all verification results are reviewed for 
that form.  When you open a form in the Navigator after blind verification and set it to Verified on closing, 
you will lose information on all value conflicts for that form.  That is, all VERIFICATION/AUTOFLAG flags 
on items for the form will be removed and every Verify Error record status for the form will be changed to 
Verified. 
 
Special note on Clintrial reports: The Verification Report and Subject Report may not accurately show a 
record status of Verify Error when an item in that record has a VERIFICATION/AUTOFLAG flag.  The 
Flag Report appears to be the most accurate listing on blind verification errors.  It is advisable to review 
the Verification Report, Subject Report, and Flag Report together for a comprehensive review of all 
records entered (Subject Report) and those with verification errors (all three reports but most accurately 
the Flag Report). 
 
Performing Blind Verification 
 
In preparation for blind verification, the Enter module VERIFY_BLIND protocol parameter must be set to 
Yes in the Admin module by your Clintrial administrator.  You can only open a form for blind verification if 
its panels were set with the Verify attribute in the Design module by the designer.  You can only verify 
forms in the Enter module that are in update tables and that have a panel status of Unverified. 
  
The steps to verify forms using blind verification are as follows: 
  
1. From the File > Edit Mode menu, set the edit mode to Verify. 
2. In the Navigator, select the form (study page) that you want to verify. 
3. Enter data in all fields. 
4. Save the changes when you are done. Once saved, the record(s) for the form have their status 

changed from Unverified to Verified or Verify Error, and the form cannot be verified again. 
 
Flags and notes themselves do not need to be verified.  However, you can attach, modify, or delete flags 
and notes during verification if the system parameter VERIFY_SHOW_TAGS is set to Yes (all flags and 
notes are available) in the Admin module by your Clintrial administrator.  
 
During blind verification, Clintrial automatically attaches a VERIFICATION/AUTOFLAG flag to a field if 
you re-enter a value that is different than the original value or if you leave blank a field that originally had 
a value.  A VERIFICATION/AUTOFLAG flag comment contains the original and re-entered values for the 
field and the user accounts of the data entry operator(s) who entered the values.  
 
Modifying Data after Blind Verification and after Verification Results Review 

 
To change a record status from Verify Error to Verified, open the form after blind verification in Edit 
Update Table mode that is set from the File > Edit Mode menu in the Enter module.  You can add to or 
change the original values of any fields or retain the original values.  When you save the form and set the 
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form to Verified, then all records for the form receive a status of Verified and all 
VERIFICATION/AUTOFLAG flags are removed from fields in the form. 
 
When you modify or delete data in the update tables, you may be required to provide a Reason for 
Change.  A Reason for Change is an explanation appended to an individual record explaining why the 
record was modified.  The Reason for Change dialog box opens automatically when you edit a record.  
Enter an explanation directly into the Reason for Change Text box.  To apply the Reason for Change to 
the current record only, click OK.  To apply the Reason for Change to all modified records for a form, click 
Apply To All Changes. 
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FOREWORD 
 
This manual is one of a series of protocols and manuals of operation for the Jackson Heart Study 
(JHS).  The complexity of the JHS requires that a sizeable number of procedures be described, thus 
this rather extensive list of materials has been organized into the set of manuals listed below.  Manual 
1 provides the background, organization, and general objectives of the JHS Study.  Manuals 2 and 10 
describe the operation of the Cohort and Surveillance Components of the study.  Detailed Manuals of 
Operation for specific procedures, including those of reading centers and central laboratories, make 
up Manuals 3 through 9 and 11. 
 
 

JHS Study Protocols and Manuals of Operation 
 
 

MANUAL TITLE 
  
1 General Description and Study Management 
  
2 Cohort Component Procedures 
  
3 Family Study 
  
4 Blood Pressure  
  
5 Electrocardiography 
  
6 Echocardiography 
  
7 Ultrasound Assessment 
  
8 Pulmonary Function Assessment 
  
9 Specimen Collection and Processing 
  

10 Cohort Surveillance 
  

11 Data Management System 
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1.0 INTRODUCTION AND GENERAL OBJECTIVES 
 
 
Participants in the Jackson Heart Study (JHS) will have an echocardiographic examination as a part of 
their first visit cycle.  A number of these individuals also participated in the Atherosclerosis Risk In 
Communities (ARIC) study, and may have had echocardiography as part of that study during the years 
1993 to 1996. 
 
As its general objectives, the echocardiography study will (1) characterize a variety of cardiac structural 
and functional parameters in a large population-based sample of black men and women, and (2) examine 
these data for relationships with traditional and nontraditional risk factors for cardiovascular disease, 
prevalent cardiovascular disease, and cardiovascular disease incidence, adding to similar information 
collected in other important population-based studies. 
 
The echocardiography protocol will incorporate currently accepted standard echocardiographic 
techniques to enhance comparison with preceding and future studies.  Structural parameters to be 
studied include left ventricular (LV) wall and chambers dimensions, and LV mass (calculated from 
dimensions).  Cardiac functional data will be derived from measurements of systolic performance such as 
fractional shortening, regional wall motion, and wall stress, and from Doppler data describing left 
ventricular diastolic filling. 
 
Responsibility for various procedural aspects of the JHS echo exams will be shared among the JHS 
Examination Center (EC) with its Echo Reading Center (ERC) component and the JHS Coordinating 
Center (CC).  The Echo Reading Center (ERC) is a component of the JHS EC budget in the early phases 
(under the CC in final phases).  The EC, largely through the ERC, and will be responsible for overall 
monitoring of the echo procedures, quality control, clinical interpretation, analytical measurement and 
coding of the echo data, and transmission of the data to the CC. The EC will be responsible for technician 
training, for exam performance, interpretation, and data entry, and for internal quality control functions.  
The Coordinating Center  will be responsible for developing and maintaining the official analysis file and 
for official analyses of the data, and will provide support for publications, including primary responsibility 
for statistical analyses.  Some data analysis may be done locally at the EC as well, and its investigators 
will have primary responsibility for coordinating and producing scientific publications. 
 
The echocardiographic examination will be conducted in the JHS Clinic facilities in Jackson.  Two trained 
cardiac sonographers will perform the echo studies.  The EC and ERC staff will train these technicians in 
the specific protocol for the JHS studies.  
 
Components of the ERC will be at both the JHS clinic site as well as on the main campus of the University 
of Mississippi Medical Center.  Data acquisition, archival, and transmission is described in more detail in a 
subsequent section, but the design for the echo examination as well as the reading process is based on 
an integrated digital imaging network with acquisition nodes attached to each echo machine, a server 
computer with additional hardware for permanent archival, and workstation nodes on the network where 
images are reviewed and analyzed. 
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2.0 SCIENTIFIC BACKGROUND AND RATIONALE 
 
 
Echocardiography Data and Cardiovascular Risk in Population Studies 
 
Left ventricular (LV) hypertrophy detected by electrocardiography is associated with a significant risk of 
cardiovascular morbidity and mortality (1,2).  More recently, echocardiography has provided a more 
sensitive, more direct tool for measurement of LV mass and detection of prevalent hypertrophy.  In 
addition, echocardiography is quantitative, reproducible, and noninvasive (3-6).  Reference values for LV 
mass and criteria for LV hypertrophy were established in the large study population of the Framingham 
Heart Study (7).  Echocardiography provides an objective means of prospectively studying the 
relationship between LV mass and cardiovascular events. 
 
The pathophysiology of LV hypertrophy in a population may be rather diverse.  The impact of age (8), 
obesity (9), alcohol intake (10), body size, physical activity, and blood pressure (11) on LV mass have 
been examined.  A small proportion of LV hypertrophy is associated with valvular heart disease, but most 
is not, and the overall incidence of hypertrophy based on Framingham criteria in their population was 
about 15-20% (12).  Dannenberg (8) concluded that the increase in LV mass associated with aging was 
prominently related to extracardiac factors (such as obesity and hypertension) that accompany advancing 
age and "not by virtue of an intrinsic myocardial aging process". 
 
Importantly, several reports have documented an increased risk of cardiovascular events and mortality in 
subjects with LV hypertrophy and some show the risk to be independent of the other known risk factors 
for coronary heart disease (12-17).  As an example of the magnitude of the risk, one study of 3220 
subjects age 40 or over with no clinically apparent cardiovascular disease (12) reported that increased LV 
mass (indexed to height) was associated with cardiovascular mortality (relative risk 1.73 in men, 2.12 in 
women) and all-cause mortality (relative risk 1.49 in men, 2.01 in women) over a 4-year follow-up period.  
There was an incremental increase in relative risk of cardiovascular disease of 1.49 for each 50g per 
meter increase in indexed LV mass for men and 1.57 for women.  This study contributed to the 
identification of LV hypertrophy as a potent risk factor independent of age, diastolic blood pressure, pulse 
pressure, obesity, and total cholesterol to HDL ratio. 
 
For African-Americans, there are insufficient data on the distribution of LV mass and its association with 
cardiovascular risk.  As the genetic influence of race is seen on some aspects of essential hypertension, 
so might the risk associated with LV hypertrophy in blacks vary from that of a general or predominantly 
white population.  The impact of other factors such as age, blood pressure, sodium intake, alcohol 
consumption and many other factors requires further study. 
 
In essential hypertension, LV hypertrophy may be thought of as one type of end-organ damage often 
leading to two predominant sequelae, congestive heart failure and cardiac arrhythmias (18) including 
sudden death.  Several animal and human studies point to the multiple hemodynamic, humoral, and 
structural factors that influence hypertension and the development of LV hypertrophy and of its sequelae.  
But, as shown in the TOMHS study, lowering high blood pressure by any means tended to allow LV 
hypertrophy to regress.  Data are not yet available from current long-term clinical studies designed to 
assess the change in cardiovascular risk associated with regression of hypertensive LV hypertrophy. 
 
Despite the paucity of intervention data, some authors already suggest that early detection of hypertrophy 
(necessarily by echocardiography) and aggressive antihypertensive therapy aimed at its regression 
should be an important goals of the clinician.  Despite complex interactions among the factors that 
influence it, the presence of LV hypertrophy may be a clinically useful summary of the integrated adverse 
effects of hemodynamic loads and vascular disease on the heart (19). 
 
In the Atherosclerosis Risk In Communities (ARIC) study, echocardiography of the Jackson field center’s 
African-American cohort was done to obtain data on left ventricular mass and prevalent hypertrophy.   
Based on Framingham-defined criteria for LVH, prevalence was dramatically higher for ARIC participants 
in Jackson compared to age-matched Framingham study participants.  The ARIC study group is 
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beginning to look at cardiovascular events that have occurred in the ARIC cohort and has the opportunity 
to evaluate prevalent LVH and its potential association with these events.  This sort of outcome-related 
data is critical to understanding the importance of the high prevalence of LVH in African-Americans.  Is 
this a part of the answer as to why cardiovascular mortality and morbidity are generally higher in the black 
population? 
 
Planning groups for the JHS considered a number scientific questions and research opportunities .  The 
echocardiography study has the opportunity to evaluate questions in the areas of left ventricular 
hypertrophy, congestive heart failure, and coronary artery disease. 
 
I. Left ventricular hypertrophy 

 
What is the typical pattern of progression and regression of LVH, and how do its development, 
progression and regression relate to other risk factors and to antihypertensive treatment or other 
therapy? 
 
What is the pathogenesis of the relation of LVH to adverse outcomes, including arrhythmias and 
sudden death?  What are the risk factors for this progression? 
 
What are the prognostic implications (or predictive value for adverse outcomes), of various patterns of 
LV geometry and hypertrophy? 
 
Are there identifiable genetic factors related to the development, progression and regression of LVH? 
 
What is the temporal relationship between the development of hypertension and LVH (or of other 
structural and functional parameters such as diastolic filling properties) ? 
 
What is the association between LVH and other target organ manifestations of hypertension such as 
renal dysfunction and atherosclerosis measured as the presence and progression of carotid artery 
disease? 
 

II. Congestive heart failure 
 
What are the typical patterns of development and progression of LV dysfunction and CHF, and how 
they relate to traditional and non traditional risk factors and to antihypertensive treatment or other 
therapy? 
 
What is the pathogenesis of CHF, and how is related to traditional and non traditional risk factors? 
 
What is the contribution of normal systolic heart failure to LV dysfunction and CHF in this population, 
and what is its pathogenesis and relationship to other risk factors? 
 
What are the diagnostic and treatment patterns of CHF in this population, and how they differ from 
nationally recognized standards or recommendations, including use of echocardiography, cardiac 
catheterization, and ACE inhibitors? 
 
What are the secular trends in disability, morbidity and mortality from CHF in this population? 
 
Are there identifiable genetic factors related to development and progression of CHF in this 
population? 
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III. Coronary artery disease 

 
What is the typical pattern of development and progression of CHD, and how does it relate to 
traditional and non traditional risk factors, especially hemostatic and inflammatory factors and 
endothelial dysfunction? 
 
What are the prognostic implications (or predictive value for adverse outcomes) of exercise tolerance 
testing, coronary calcium, echocardiography, and other noninvasive measures of CHD? 
 
What are the diagnostic and treatment patterns of CHD in this population, and how they differ from 
nationally recognized standards or recommendations, including use of exercise testing, cardiac 
catheterization, thrombolysis, revascularization , and proven secondary predictive strategies such as 
aspirin and beta blockers? 

 
Echocardiography is a tool which characterizes cardiac structure and function in a way that allows 
quantitative research into questions that may help us better understand, treat, and prevent cardiovascular 
disease in African-Americans. 
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3.0 COLLECTION OF ECHOCARDIOGRAPHIC DATA 
 
 
3.1 Echocardiography Instrumentation and General Operating Features  
 
An “echo machine” is an multipurpose ultrasound system which incorporates technology for image 
optimization and quantification of cardiovascular targets.  The echo machine produces both digital and 
analog outputs.  Analog video is typical stored on videotape but may be captured into a digital imaging 
network as the primary means of data storage and archival.  Some echo machines may use direct digital 
connections to an image server to accomplish the same task.  The echo machine has built-in capabilities 
for image manipulation and measurement, but for the purposes of the JHS echo study, the quantitative 
analyses will be done after the participant examination is complete by means of networked image 
workstations.  On these workstations, the digitally stored images can be reviewed in real-time motion and 
individual frames may be selected for specific quantitative measurements. 
 
In general terms, the echo machine is comprised of a video monitor for viewing the ultrasound data; a 
keyboard for entry of study identification and for selection of system options; a panel containing image, 
Doppler, and recording device controls;  ports for connection of the ultrasound transducers; ECG display 
controls; and recording devices.  The JHS systems will contain, at least, a digital image capture interface 
and may also contain a S-VHS videotape recorder.  Details of the operation of the echo systems are 
found in the vendor-supplied users manuals. 
 
3.2 Echocardiography Instrumentation - Transducers  
 
The echo machine is equipped with phased array ultrasound transducers capable of imaging at various 
ultrasound frequencies.  In general, the studies will be performed with the primary operating frequencies 
near 2.5 to 3.5 MHz.  Steerable 2-D directed M-mode is performed at the same imaging frequency.  The 
transducers also are capable of steerable continuous wave (CW) and pulsed Doppler (including color flow 
mapping).  Two different probes may be connected to the machine and selection between the two is by 
way of a front panel button. 
 
3.3 Echocardiography Instrumentation - Digital Image Storage  
 
The digital imaging system will have specific controls and procedures for patient identification, image 
capture/review, and transmission of images to the image server at the completion of the study. 
 
The echo machine intrinsically produces digital images in a 512 by 512 pixel matrix.  This matrix size 
defines the limits of resolution in the ultrasound image.  The digital image is converted to a standard 525-
line video signal which is made available to the image capture system which is able to retain a high 
degree of resolution and faithfulness to the original image.   Once in digital format, the image is not 
subject to degradation by repeated viewing, copying, or deterioration of media with the passage of time. 
 
The echo images are stored in a computer format which is widely accepted in the computer industry.  
DICOM is the predominant image format used in medical applications.  DICOM compliant images are 
vendor-independent and can be transmitted to other locations and viewed on a variety of compliant 
workstations.  JHS echo studies will be permanently archived on a mass media storage device such as 
digital linear tape (DLT) media.  In addition, compact disk (CD) recording may be used as a universal 
permanent archive media for individual studies. 
 
3.4 Workstation Instrumentation - Analysis At The Reading Center  
 
The echo studies are available on the image network as soon as the study is completed.   The digital 
video will be reviewed to provide a basic clinical interpretation of the study, in particular to look for 
important or unexpected echocardiographic findings (for example, aortic stenosis or insufficiency) which 
may impact on the participant's health care or which may affect the usefulness of the data for the 
purposes of the JHS echo study. 
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In addition to real-time video playback, the echo workstations provide tools to make quantitative 
measurements based on the echo images, and a database in which to store results, format printed 
reports, and package data for export to the ERC database (eventually to the Coordinating Center).    
Details of the operation of the echo workstation software will be found in the vendor’s operator’s manuals.  
Use of the workstation specifically in the context of JHS echocardiograms will be developed in a 
subsequent section of this Manual. 
 
3.5 Reading Center Database for Analysis Results  
 
For the purpose of efficient data management and transmission to the Coordinating Center, the data 
items and pertinent participant information will be entered into a custom database developed and 
maintained in the ERC.   Study identification and tracking data as well as qualitative analysis results will 
be entered by keyboard into the database from the Technician (Appendix 1) and Reader  (Appendix 2) 
Worksheets.  Errors in manually entered data will be avoided by range checking of numeric data, by use 
of pick-lists for discrete data-entry choices, and by other programmed logic in the custom database 
software which comprises the ERC database.  Data generated by the echo workstations may be directly 
exported into the ERC database to avoid manual data entry errors. Additional data fields in the ERC 
database will accommodate the manually entered items.  Participant and study identification data, critical 
to proper data tracking, will be imported from the technician's entries into the digital image network data 
files and will be cross checked from the Technician Worksheet for accuracy during the manual keyboard 
entry of the additional qualitative study results.  This Reading Center Database will provide a versatile 
means of organizing the data, analyzing it for quality control, and formatting the data for transmission to 
the Coordinating Center.   
 



7 

Exam 1 Echocardiography Manual.doc 

4.0 THE ECHOCARDIOGRAPHIC EXAMINATION 
 
This section will give an overview of the instrument preparation, patient preparation, and performance 
standards for the echo examination.  The echo technician will record information on the Echo Technician 
Worksheet. 
 
4.1 Presets on the Instruments  
 
4.1.1 Echo Machine's Application Presets 
 
The echo machine features programmable "application" presets to allow customization of preferred image 
and Doppler settings, and to allow efficient selection of alternate settings if needed, for example, in the 
case of technically difficult imaging studies.   A preset will been defined for the JHS echo study based on 
typical imaging and Doppler parameters for cardiac ultrasound and on the crucial need for high quality M-
mode and 2-D data.  This preset is active automatically when the machine is powered up, and it can be 
re-selected from the keyboard prior to each study.  The technician may modify some parameters during 
the course of a study to optimize data quality but these changes are returned to nominal settings when 
the JHS "application preset" is selected. 
 
4.1.2 Digital Storage System Protocols 
 
The digital image network will obtain participant name and identification from the technicians’ entries on 
the echo machine itself.  There will be no individual settings required on the digital system prior to the 
echo examination. 
 
4.2 Equipment Preparation Prior to Each Study  
 
4.2.1 Echo Machine Preparation 
 
General care instructions are found in the documentation supplied with the machine. Prior to each study 
the transducer heads should be wiped clean in accordance with the manufacturer's instructions.  
Disposable EKG electrodes are snapped onto the three leads of the EKG cable prior to attaching to the 
participant.  If any machine parameters have been altered by the previous study, reactivate the 
"application preset" for JHS.  The technician should be confident that recording device(s) are ready and 
properly positioned to record a new study. The technician should fill in the study identification information 
on the screen and double-check the participant identification before beginning echo study. 
 
4.2.2 Digital Storage System Preparation. 
 
Preparation of the digital imaging network may or may not be required depending on how the selected 
vendor has implemented the interface with the echo machine itself.  Once the participant identification is 
known to both the echo machine and the imaging network, the image acquisition may begin. 
 
4.3 Participant Preparation  
 
The participant should remove all clothing from the waist up and don a clinic gown which will provide 
access to the chest as needed for imaging. 
 
The technician will measure the participant's blood pressure in a comfortable supine position and record it 
on the imaging system’s information screens. 
 
Position the subject in the left lateral position with the head propped up at a slight angle on pillows and a 
wedge behind him to help maintain this position comfortably.  Attach three EKG electrodes as labeled.  
The "arm" leads (RA and LA) may be placed on the upper chest near the shoulders, and the "left leg" lead 
(LL) may be placed on the abdomen.  The leads should be draped without tension in a way that they will 
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not interfere with the subsequent examination.  Check that a clear EKG signal is displayed on the echo 
machine.  The EKG size control on the echo machine is generally best left in the "AUTO" position. 
 
4.4 Imaging Views and Information Sought  
 
This section reviews the standard set of acoustic windows to be used and the data sought from each 
view.  In addition, a list of items to be recorded is given.  In general, for each imaging view and mode 
specified below, the technicians will activate the "record" button to capture images for a period of time that 
will encompass 10-20 heartbeats of relevant data unless otherwise specified.  All recordings will be 
performed at end-expiration, obviating the need for using a respirometer and adding consistency to the 
measurement processes. 
 
4.4.1 Parasternal Views 
 
These views are usually performed in the left 3rd or 4th intercostal space adjacent to the sternum. 
 
4.4.1.1 Parasternal Long Axis View 
 
The ultrasonographer attempts to line the beam perpendicular to the interventricular septum and posterior 
left ventricular wall.  Initially, the focus is on obtaining a clear 2-D image of the aortic valve, aortic root, left 
atrium, right ventricle, left ventricle, and mitral valve.  Color Doppler interrogation is performed to assess 
aortic and mitral regurgitation.   
 
Data recorded in the parasternal long-axis view: 

• 2-D imaging 
• Color Doppler mitral and aortic values 

 
4.4.1.2 Right ventricular inflow view 
 
In a modification of the parasternal long axis view, the transducer is angled to the subject's right, 
demonstrating the tricuspid valve anatomy 
 
Data recorded in the RV inflow view: 

• 2-D imaging 
• Color Doppler tricuspid valve 

 
4.4.1.3 Parasternal Short Axis View 
 
From the long axis position, the transducer is rotated clockwise 90-degrees to obtain the short axis view.  
The exam begins at the left ventricular (papillary muscle) level to demonstrate ventricular anatomy and 
wall motion. 
 
Images are recorded at the mitral valve level to show valve anatomy and motion. 
 
Images are recorded at the aortic valve level to show valve anatomy and motion.  Color Doppler is 
performed at the pulmonary, aortic, and (if adequately visualized) tricuspid valves. 
 
The technician returns to the aortic valve level to perform M-mode recording of the aortic valve and left 
atrium.  M-mode examination is performed at the papillary level taking care to orient the transducer for a 
view perpendicular to the long axis of the ventricle (creating a circular, rather than oblong, shape to the 
tomographic image).  The M-mode cursor is positioned through the center of the chamber and gain 
settings are adjusted to optimize the boundary detection of the walls of the interventricular septum and 
posterior wall.  While optimizing M-mode angle and image quality the echo machine display is a split 
screen showing both M-mode and a miniaturized 2-D image.  When the data are optimal, the M-mode 
display is changed to full screen.  The FREEZE button is pressed after a full sweep is displayed in the 
larger format. 



9 

Exam 1 Echocardiography Manual.doc 

 
The same procedure is carried out for the images at the aortic valve level, described above. 
 
NOTE: If the technician feels that the image data are technically better from the parasternal long-axis 
view, then that view will be used for M-mode data, positioning the cursor just beyond the mitral leaflet tips 
and carefully selecting the image plane to coincide with the long axis of the left ventricle.  The M-mode 
data at the aortic valve level may also be obtained from the parasternal long-axis view if image quality is 
felt to be significantly better than short axis. 
 
Data recorded in the parasternal short axis views: 
 

• 2-D at aortic, mitral, and pulmonary valves 
• Color Doppler of valves at aortic level 
• 2-D images of LV at papillary level 
• M-Mode of LV at papillary level 
• M-Mode of Aortic valve and LA 

 
4.4.2 Apical Views 
 
These views are performed in the interspace where the ventricular apex is felt, usually in the left 5th or 
6th interspace in the between the midclavicular and anterior axillary lines. 
 
4.4.2.1 Apical 4 Chamber View 
 
The technician strives to achieve an imaging plane directly over the left ventricular apex, parallel to the 
interventricular septum, and rotated in a manner to show all 4 chambers and both the mitral and tricuspid 
valves simultaneously. 
 
For efficiency in the protocol, the technician will perform pulsed wave spectral Doppler examinations first.  
 
For mitral inflow data, the range gate is placed near the tips of the mitral leaflets with small adjustments in 
angle to obtain maximum flow velocity data with a narrow spectral dispersion.  After 2-D directed 
placement of the range gate cursor using the split screen (Doppler and miniature 2-D) mode, a full screen 
sweep of spectral Doppler is frozen on the screen. A Doppler range gate is placed in the pulmonary vein 
just posterior to the left atrium, and spectral Doppler recordings are made in the same manner as mitral 
inflow recordings. 
 
For aortic outflow data, the transducer is tipped to image slightly anterior from the 4 chamber view to 
show the aortic valve and outflow tract (the "5 chamber" view).  The range gate cursor is placed in the left 
ventricular outflow tract about 0.5 to 1 cm proximal to the aortic valve, again trying to demonstrate a 
pattern of narrow spectral dispersion and a well-defined velocity profile.  Data are recorded as for mitral 
above.  The Doppler mode is then switched to CW (continuous wave) and the interrogating beam directed 
through the aortic valve to measure peak velocity. 
 
Next the focus in on clear 2-D images of the 4 chambers and AV valves.  This view is recorded with 
particular attention to definition of LV wall boundaries and wall motion. 
 
Data recorded in the apical 4 chamber view: 
 

• Pulsed Doppler of mitral inflow 
• Pulsed Doppler/CW Doppler of aortic outflow ("5 chamber view") 
• 2-D images of 4 chamber view 
• Color Doppler (mitral, aortic, tricuspid) 
• Pulsed Doppler of pulmonary vein flow 
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4.4.2.2 Apical 2 Chamber And Long Axis Views  
 
From the 4 chamber view, the transducer is rotated along its imaging axis 90 degrees counterclockwise to 
show the left ventricle and atrium from the apex (the 2 chamber view).  This view is recorded and the 2-D 
images are captured on the digital system with particular attention to definition of LV wall boundaries and 
wall motion.  The transducer is rotated slightly to simultaneously image the mitral and aortic valves (the 
apical long axis view) and color flow Doppler data is recorded. 
 
Data recorded in the apical 2-chamber and long axis: 
 

• 2-D image of 2-chamber view 
• Color Doppler of mitral/aortic in long axis 

 
4.4.3 Supplementary Views 
 
With the important priority of measuring LV wall and chamber dimensions, inability to obtain useable 
images from other acoustic windows (especially parasternal) should prompt the technician to image from 
the subcostal view.  Both a 4 chamber view and a short axis of the LV at the papillary level should be 
attempted.  Recognition by the technician of significant abnormalities should prompt further examination 
which may require additional views.  For example, a suggestion of aortic root dissection should prompt 
examination from the suprasternal notch.  Sometimes supplementary Doppler interrogation from 
standard views is required, such as with the recognition of valvular aortic stenosis where continuous wave 
Doppler (CW) should be carefully employed to measure peak flow velocity through the valve. 
 
4.5 Completing the Study  
 
4.5.1 Completing Data Storage.  
 
The final procedure for the echo examination is to indicate the completion of the study [by keyboard 
command on the echo machine] so that the images can be transmitted to the network server and 
subsequently to the digital archive. 
 
4.5.2 Completing the Participant Encounter  
 
During the file save operation is a convenient time to disconnect the EKG cable and remove the electrode 
pads.  Provide the participant with a towel to remove any residual ultrasound gel while he/she gets 
dressed. 
 
4.6 Transmittal of Data to the Echo Reading Center  
 
At the completion of the day's studies, any written worksheets and logs are copied and packaged together 
for pickup by the ERC where the data will be analyzed.  It is anticipated that studies will be delivered on a 
daily basis.  The studies will be logged in at the Reading Center using the information on the technician 
worksheets.  The echo study itself is stored on the image server accessible to the ERC over the imaging 
system’s network connections.  Each study's progress through the reading and data entry processes will 
be noted in the logs of the reading center. 
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5.0 ECHO READING CENTER WORK 
 
 
5.1 Overview    
 
The reading protocol is designed with consideration for several important factors.  Foremost, the data 
must be accurate and reproducible.  The techniques used conform to widely accepted standards, where 
they exist; where they do not, data is analyzed in an optimal fashion based on technical calculations, 
validation, and/or recommendations from other laboratories.  In contrast to most previous studies, all the 
quantitative data are computer-driven measurements from digitized images.  This method is consistent 
with the techniques used in the ARIC Study echocardiographic work.  The techniques and computer 
systems used are anticipated to be the most widely applied in both clinical and research 
echocardiography as most methods of "hard copy" are abandoned.  Indeed, routine M-mode 
echocardiography has been largely discontinued in many clinical laboratories because of its technical 
difficulty and because of the widespread acceptance of 2-D image measurements in clinical labs.  M-
mode, however, retains important historical significance and usefulness as a research tool, and care has 
been taken to record optimal M-mode data and to use standard conventions for analysis.  The digital 
imaging system used for the study represents the state of the art in echocardiography storage and 
analysis systems as it has evolved with availability of powerful computer systems, massive data storage 
devices, and fast, scalable networks.  Such systems are widely available to clinical echo labs as well.  
The system has been shown to produce accurate measurements from previous validation studies, and 
the protocols allow rapid, efficient generation of the study data. 
 
We propose a general approach to the recording and scoring of the M-mode, two-dimensional and 
Doppler echocardiographic data. 
 
For M-mode echocardiographic, pulsed and continuous wave Doppler parameters, measurements will be 
made, when possible, from 3 (consecutive) beats.  The American Society of Echocardiography Standards 
will be used for making all M-mode echocardiographic measurements. 
 
For M-mode measurements of the left ventricle, left atrium and aorta, all of which will be derived from a 
cursor positioned on the two-dimensional image, measurements will not be made from beats recorded 
with the cursor at a greater than 20 degrees angle to the meridian.  In addition, in the two-dimensional 
parasternal short-axis view, M-mode left ventricular measurements will not be made when, in the absence 
of wall motion abnormalities, there is an eccentricity index of 1.3 - i.e., when the radius of the left 
ventricular cavity in one axis is less more than 30% larger than the radius of the cavity in another axis. 
 
The criteria for quality control suggested by Schieken and associates will be used as a gold standard to 
determine acceptable quality of M-mode echocardiograms of the left ventricle.  These criteria are:   
 

1. generation of a single dominant line representing each interface being imaged  

2. demonstration of continuous interface lines at least 5mm in length at the point of measurement; and  

3. demonstration of interfaces with the motion pattern characteristic of the specific cardiac structure 
being imaged 

 
For two-dimensional echocardiographic parameters, measurements will be made from a single optimal 
beat.  Criteria for selection of beats will include: 
 

1. recording the image in the proper plane without producing ovoid images from improper angulation in 
the short-axis view, or apical foreshortening from improper angulation in the apical views;  

2. recording the most clearly visible endocardial and epicardial interfaces.  Left ventricular 
measurements will not be made from a given view if at least 80% of the endocardium (or epicardium) 
is not visualized well enough for planimetry.  The black-white interface, rather than the leading edge, 
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will be used to planimeter the endocardium.  For purposes of planimetry, the papillary muscles will be 
included within the left ventricular cavity. 

 
Images will be selected at end-diastole and end-systole for computation of left ventricular diastolic volume 
and mass, end-systolic volume, and ejection fraction.  The video frame closest to end-diastole will be 
identified by reference to the simultaneously recorded mitral valve:  the frame showing initial coaptation of 
the mitral valve marks end-diastole.  The first frame in which QRS complex appears on the EKG channel 
may also be used to mark end-diastole.  End-systole will be determined by locating the frame preceding 
initial diastolic mitral opening.  If the mitral valve is not seen, the smallest visible left ventricular dimension 
will be selected. 
 
For pulsed Doppler measurements of aortic and mitral peak velocities and flow velocity integrals, spectral 
curves will be traced using peak velocity conventions.  Measurements will not be performed from pulsed 
Doppler beats demonstrating maximum spectral dispersion greater than 30% of peak velocity. 
 
5.2 Echocardiographic Findings Triggering "Alert" and "Notification" Procedures  
 
Each echocardiographic study will be interpreted clinically by one of the ERC cardiologists within a few 
days of the examination.  If there is any question raised by the echo technicians regarding clinically 
important abnormalities, the echo study is read immediately following the completion of the study.  This 
approach led to timely detection of the clinically important abnormalities found in the ARIC echo study. 
 
5.2.1 Echo "Alert" (Emergent) Parameters  
 

• Aortic dissection  
• Vegetation 
• Tumor 
• Flail leaflet 
• Thrombus 
• Suspected pericardial tamponade 

 
Suspected pericardial tamponade will be defined echocardiographically as the presence of a pericardial 
effusion with right atrial and right ventricular chamber collapse and respiratory variations exceeding 30% 
in Doppler peak velocities recorded at any cardiac valve site. 
 
"Alert" findings are those echocardiographic conditions (listed above) which will trigger an "urgent" phone 
call by the reading cardiologist to the EC co-investigator oversight of the JHS participants clinical issues.  
The ERC cardiologist will contact the participant’s physician of record, if so directed by the EC physician, 
in order to communicate the findings and the relative urgency indicated by the findings.  
 
5.2.2 Echo "Notification" (Urgent, Not Emergent) Parameters  
 
"Notification" conditions are those echocardiographic findings which will be reported promptly, but not 
emergently to the EC P.I.  These findings should trigger a statement commenting on their presence as 
part of the letter sent to the referring physicians. 
 

• LV ejection fraction less than 30% 
• Aortic aneurysm 
• LV enlargement:  LV end-diastolic dimension greater than 6.5 cm     
• Aortic stenosis:  Aortic valve area less than 1 cm squared (or peak velocity greater than 4 m/sec). 

 
5.3 Quantitative and Qualitative Data Elements Measured and Recorded  
 
The following sections summarize the technical plan for recording, analyzing, storing and transmitting the 
echocardiographic data. 
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5.3.1 Ultrasound Imaging Equipment   
 
Images are acquired using the Agilent (Hewlett Packard) Sonos 4500 imaging system with system 
setting, software, and transducers optimized for cardiac ultrasound imaging.  Two-dimensional and M-
mode imaging is at an approximate frequency of 2.5 megahertz (MHz) using current generation phased 
array transducer.  Internally, the image is a digital matrix.  Digital and analog video outputs are produced 
by the echo machine for recording and archival. 
 
5.3.2 Digital Image Acquisition    
 
The Sonos 4500 is modified with a digital image capture module replacing the traditional video tape 
recorder.  Echocardiographic images are stored chronologically into the digital system in a manner 
exactly like they would be recorded onto videotape.  The technician uses a "Tape" button to start and stop 
recording as the various echo views obtained during the course of the examination.  Study identification 
information and the recorded images are saved onto a central digital image server where they reside on a 
massive array of hard disk drives.  This server is optimized for data storage, fault tolerance, and security.  
Data are stored on a RAID array (Redundant Array of Inexpensive Disks) to virtually eliminate risk from 
hardware failure.  The digital image server automatically records the study onto permanent archive media 
("DLT" or Digital Linear Tape).  The echo studies stored on the image server are available on the network 
for review and analysis by use of image workstations.  These workstations may also be used to record a 
permanent record in DICOM-compliant CD format. 
 
5.3.3 The Reading Workstation   
 
The technician worksheets are delivered to the Echo Reading Center to begin the analysis process.  
Each echocardiographic study will undergo both a clinical reading as well as quantitative measurement of 
specific cardiac findings.  Together these data comprise the echo data set that will ultimately be 
forwarded to the JHS CC.   This workstation is a high-end PC-based workstation with specific hardware 
and software to facilitate the realtime playback of echo studies and to efficiently accomplish the 
quantitative measurements that are to be made.   Both the images and the computer assisted 
measurements are stored on the digital image server. 
 
5.3.4 The ERC database    
 
The final common location for all the non-image data generated by the analysis process is a database 
stored on an network server computer which is located at the Echo Reading Center.  The database, 
written using Microsoft Access, consolidates the various sources of data to facilitate data archival, quality 
control procedures, data transmission to the Coordinating Center, and data analysis.  Keyboard entry is 
required for data items recorded on the Technician Worksheet and the Reading Worksheet.  Quantitative 
data is imported from the network image server's Oracle database to avoid keyboard entry errors.  There 
is at least one form of backup for each type of data, and the entire consolidated database is backed up by 
disk mirroring and magnetic tape archives on a daily basis.  Finally, cumulative data sets are sent to the 
Coordinating Center (CC) on a regular basis to form the study's "official" data files.  The listing of the ERC 
database fields represents the data items that will be collected for transmission to the CC (Appendix 3). 
 
5.4 General Guidelines for Measurements  
 
The following sections discuss the ERC analysis guidelines and processes.  The echo studies will 
undergo clinical as well as analytic review.  In Section 5.2, the issue of alert notifications was discussed.   
 
5.4.1 Clinical Review  
 
Appropriate sections of the Reading Worksheet are completed by the reader during the video review.  
The video is viewed on the workstation's monitor by retrieving the participant from a list of available 
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studies on the image server, and playing the motion video using the playback dial and other controls.  
This process is much like reviewing a videotape on a VCR. 
 
First, view the parasternal long axis 2-D images for evaluation of chambers sizes (LV, LA, and aortic 
root), for LV wall thicknesses, for valvular morphology and motion, and for a general clinical review for 
other abnormalities (right ventricular size, pericardial effusion, vegetation, thrombus, aortic dissection, 
etc.). 
 
Determine the relative angle between the ultrasound beam in the axial direction and the interventricular 
septum.  When the septum is more 20 degrees from being perpendicular to the axial direction, the 
subsequent M-mode data will not be useable due to the artifactual effect of this angulation on dimensional 
measurements. 
 
Evaluate and record regional wall motion.  Normal wall motion requires no entry on the wall segment 
diagram of the Reading Worksheet.  Regional segments with abnormal motion or ones which are not 
interpretable are marked by writing a code letter in that segment of the diagram (H=hypokinetic, 
A=akinetic, D=dyskinetic, and X=not interpretable).  An entire view may be marked as "not useable" by 
marking the appropriate above that view's diagram.  This process will, of course, apply to the 
interpretation of wall motion in each of the four recorded views of the left ventricle. 
 
Next, view the color flow Doppler data for the parasternal long axis view.  A composite interpretation of 
the color flow data will be recorded later after reading data from the other views. 
 
The parasternal short axis 2-D images are viewed next.  Evaluate the technical quality of the study by the 
presence of a circular shape to the chamber at the papillary muscle level; the ratio of the LV diameter in 
the axial direction to the perpendicular LV diameter should not exceed 1.3.  If it does, M-mode data of the 
LV derived from the parasternal window will be marked as "Not Useable" (as described in following 
sections), and 2-D dimensional measurements may not be made from the short axis view but may be 
obtained from the long axis view. 
 
Regional wall motion is recorded for the short axis view at the papillary muscle level.  Examine valve 
morphology and motion in the short axis view at the aortic valve level.  Interpret color flow Doppler data at 
this level. 
 
M-mode recordings of the LV and aorta/LA are generally next on the recording.  Although no clinical 
interpretation is rendered from the M-mode, it is important to examine the recording for proper M-mode 
cursor placement just beyond the mitral leaflet tips (for LV), and for reassessment of the (optimally 
perpendicular) angle between the M-mode cursor (axial) and the septum. 
 
The technician has now switched to the apical window to record pulsed Doppler data of the mitral inflow. 
Although no interpretation is rendered from the videotape, the study is evaluated for technical features. In 
the apical 4 chamber view, the pulsed Doppler range gate should have been placed in a position near the 
mitral leaflet tips during diastole which produces well-defined E and A waves with minimal spectral 
dispersion.  Pulsed Doppler recordings of the left ventricular outflow tract should have been made in the 
apical 5 chamber view with the Doppler range gate in the outflow tract, well away from the mitral inflow 
and about 0.5 to 1.0 cm below the aortic valve.  The ideal apical window places the ultrasound beam 
nearly parallel to each of the two flows measured in this section.  If more than a 30 degree angle is 
present, the data should be marked as "not useable". 
 
Next, evaluate the real-time 2-D images of the apical 4 chamber and 2 chambers views.  Record regional 
wall motion abnormalities and interpret the color flow Doppler data.  At this point, all color flow data has 
been viewed, so that an overall interpretation of each valve's data can be recorded.  Look for other 
abnormalities to complete the clinical interpretation.  Specifically, record the presence or absence of an 
LV aneurysm or thrombus. 
 



15 

Exam 1 Echocardiography Manual.doc 

An abnormal echodense object in or near the apex of the LV is assumed to be thrombus, especially in 
association with abnormal wall motion in that area.  Intracardiac masses located elsewhere in the heart, 
especially those attached to valves, are not assumed to be thrombus and are recorded in the "Other 
findings:" section of the Reading Worksheet.  These findings are examples of  "alert" findings which 
should elicit prompt notification as described in a Section 5.2. 
 
5.4.2 Categorizing Clinical Findings 
 
The recorded echo study has now been reviewed.  Go down the worksheet to record final interpretations 
of qualitative and semi-quantitative data which may require integration of findings from all four views.  The 
Appendix includes a sample of the Echo Reading Worksheet. 
 
The presence and severity of chamber enlargement is based on a clinical interpretation of the videotaped 
data an is not assigned or reassigned based on subsequent quantitative measurements of the digital 
data. 
 
The presence and severity of LV hypertrophy is judged on clinical experience with echo interpretation and 
is not to be assigned based on subsequent quantitative dimensional or mass measurements.   
 
The LV ejection fraction is a visual estimate of normal, borderline, or abnormal overall systolic function.  
Assign an overall regional wall motion interpretation as described above.   
 
Mitral and aortic leaflet morphology is assigned as "None or Minimal Sclerosis" when no more than a 
slight increase in echogenicity of the leaflets is present and valve motion is normal.  "Definite sclerosis" is 
assigned when echogenicity in the leaflets is clearly abnormal and/or there is leaflet thickening with no 
more than mild restriction to leaflet motion.  "Definite stenosis" is assigned when leaflet motion is 
significantly restricted.  The study protocol does not specifically call for continuous wave Doppler data to 
estimate valve gradient or area, but if obtained by the technician as supplemental data, this may be used 
for assignment of valve abnormality. 
 
Record the presence and severity of valve regurgitation based on integration of all the color flow data.   
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5.4.3 Quantitative Measurements  
 
Image workstation software will be used to measure the following parameters. 
 

LV septum thickness - diastole     M-MODE 
LV septum thickness - systole       M-MODE 
LV diameter - diastole   M-MODE 
LV diameter - systole     M-MODE 
LV posterior wall thickness - diastole   M-MODE 
LV posterior wall thickness - systole     M-MODE 
Left atrium diameter  M-MODE 
Aortic root diameter  M-MODE 
Percent fractional shortening of LV  M-mode diameter (calc) 
LV mass from M-MODE data 
LV septum thickness - diastole    2-D 
LV septum thickness - systole      2-D 
LV diameter - diastole     2-D 
LV diameter - systole       2-D 
Percent fractional shortening of LV 2-D diameter (calc) 
LV posterior wall thickness - diastole    2-D 
LV posterior wall thickness - systole      2-D 
Left atrium diameter   2-D 
Aortic root diameter   2-D 
LV mass from 2-D data  (calc) 
Doppler aortic outflow MEAN velocity 
Doppler aortic outflow PEAK velocity 
Doppler aortic outflow Velocity Time Integral 
Heart rate during aortic Doppler study 
Systolic ejection time 
LV outflow tract cross sectional diameter 
LV stroke volume = CSA x VTI (calc from AOVSCSA_V  x  AOSYSVL_V) 
Cardiac output = HR x SV  (calc from AOHR_V  x  AOSTKVL_V) 
Cardiac index = C.O. / BSA 
Doppler mitral inflow peak velocity of E wave 
Doppler mitral inflow peak velocity of A wave 
Doppler mitral inflow ratio of peak E to peak A 
Doppler mitral inflow VTI of E wave 
Doppler mitral inflow VTI of A wave 
Doppler mitral inflow VTI of first 1/3 of diastole 
Doppler mitral inflow Ratio of E-wave VTI to total diastolic VTI 
Doppler mitral inflow Ratio of A-wave VTI to total diastolic VTI 
Doppler mitral inflow Ratio of first 1/3 VTI  to total diastolic VTI 
Heart rate during mitral Doppler study 
Diastolic filling time 
Total diastolic VTI 
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[NOTE: The details of the measurement process will be found in the Operator’s Manual of the image 
workstation software.  Such a manual is available in preliminary form pending final selection and 
purchase of the analysis equipment.  Further details can be developed in this section or obtained from the 
Operator’s Manual after equipment acquisition.] 
 
Measurements will be made by the cardiologist co-investigators.  As technicians gain experience in the 
JHS study protocol, the echo study investigators may choose to implement a protocol allowing some 
measurements to be completed by the echo technicians with subsequent review by the cardiologist co-
investigators.  Such a protocol would be preceded by training of technical personnel, certification of their 
work in a pilot phase, followed by implementation of technician measurements with appropriate quality 
monitoring.  The goals of the study in obtaining consistent, reproducible, and accurate echo data will be 
facilitated by limiting analytical measurement work to one or two highly experienced cardiologists, but 
other large centers such as Framingham have successfully employed technicians to do a significant 
proportion of the measurement work.   
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6.0 TECHNICIAN TRAINING, CERTIFICATION, AND QUALITY MONITORING 
 
 
6.1 Technician Training  
 
The EC will recruit cardiac sonographers in hopes of hiring individuals with strong experience in clinical 
imaging and/or study protocol imaging.  Under direction of the cardiologist co-investigator, two 
sonographers will undergo training to perform echocardiography examinations per the JHS echo exam 
protocol.  Training will begin with basic didactic sessions on the goals of the echo examinations and the 
priorities placed on accuracy and consistency throughout the imaging protocol.  The echo machine 
operation and control settings will be taught during actual examinations by the technicians-in-training 
under cardiologist supervision on JHS staff volunteers.  The cardiologist offers guidance, suggestions for 
improvement, and answers questions as they arise. 
 
6.2 Technician Certification 
 
After the initial training (and in conjunction with the pilot testing procedures), each technician will undergo 
certification by performing 10 complete echocardiogram examinations (performed during the pilot Phase 
I).  The technician's examination will be scored for each 2-dimensional imaging view, M-mode, and 
Doppler examination.  For imaging modes, grading will be based on proper spatial orientation and 
definition of good endocardial and epicardial boundaries.  For Doppler modes, grading will emphasize 
proper orientation of the interrogating beam and measurement gate, and of the ability to obtain clear 
Doppler data demonstrating smooth velocity contours with highest velocity for spectral Doppler, and 
consistent beat-to-beat data for the Doppler color flow mode. 
 
For each imaging view, 2-D, M-mode, and Doppler exams, a quantitative score of 3 is given for “excellent” 
data recordings that provide images and/or Doppler data of unequivocal clarity such that quantitative 
measurements are easily made, a score of 2 is given for “average” quality recordings with data that is 
confidently measurable, a score of 1 is given for “fair” quality recordings which are marginally acceptable 
for measurements, and a score of 0 (zero) is given for an exam component which is not usable for the 
study or not recorded.  A simple average of at least 2.0 will be required for the technician to be certified 
as having adequate skills to perform the study protocol.  Any technician failing to meet certification 
requirements will undergo additional training and re-testing before performing independent examinations 
on study participants. 
 
While the technicians will be expected to complete the echocardiogram study within 30 minutes, a strict 
time limit will not be imposed during certification procedures. 
 
In the event that a new technician joins the study staff, the same initial training and certification 
procedures will be followed as described above. 
 
In addition to these certification procedures, technician training and refinement of techniques will be an 
ongoing process, facilitated by the fact that the ERC cardiologist staff will be a working closely with each 
of the technicians throughout the JHS Visit cycle. 
 
6.3 Monitoring  
 
Echocardiographer performance is monitored throughout the examination cycle.  The cardiologist co-
investigator will record data quality and adherence to the scanning protocol as part of the reading process 
for each echo study.  The appropriateness of spatial orientation, the visualization of the endocardial and 
epicardial boundaries, and the transducer placement will be evaluated and recorded in the echo study’s 
data record. 
 
Quality is monitored throughout the study.  The quality control procedures consist of (a) comparing the 
results given by the same sonographer for repeat studies performed on randomly selected participants; 
(b) monthly reports containing statistics of the frequency of successful examinations by sonographer 
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(grade 2 or 3 on reader evaluation); (c) trending of core data items to evaluate inter-sonographer 
differences and drift. 
 
6.4 Recertification  
 
Recertification will be performed at 12 month intervals for the all technicians. At the certification 
anniversary, five randomly selected scans performed by each technician during the prior month are 
reviewed and evaluated by the cardiology co-investigator.  The results of these evaluations, in 
combination with the monthly quality control reports, are considered for recertification. 
 
A sonographer must complete a minimum of 10 echocardiograms each month to maintain certification.  If 
less than 10 scans are performed for 2 consecutive months (but not more than 2 months), the technician 
must undergo recertification as follows: 
 

A. The cardiology co-investigator updates the technician regarding changes in procedures; 

B. The technician scans 10 participants per month; 

C. Routine quality control checks continue; 

D. The sonographer remains on the current annual recertification procedure. 
 
If the sonographer performs no scans for more than two months, the recertification process is as follows: 
 

A. The cardiology co-investigator updates the technician regarding changes in procedures; 

B. The technician observes a minimum of four scans; 

C. The first four scans performed by the technician are performed under supervision by the  
cardiology co-investigator; 

D. When four consecutive scans are considered acceptable by the reader (cardiology co-
investigator), the technician is recertified. 

 
If a major change in the echocardiography protocol occurs, sonographers will undergo recertification as 
follows: 
 

A. The cardiology co-investigator will update the sonographer on the new protocol; 

B. The technicians will observe at least one scan performed by the cardiology co-investigator; 

C. The technicians perform four scans on JHS participants under the supervision of the cardiologist; 

D. When four consecutive scans are considered acceptable by the reader (co-investigator), the 
sonographer is recertified. 

 
If quality assessment at the reading center indicates significant reduction in a technician's study quality, 
individualized training and/or recertification examinations may be required. 
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6.5 Quality Assessment  
 
 
6.5.1 General 
 
The utility of echocardiographic measures of cardiac anatomy and function has been demonstrated in 
clinical and population studies.  Cardiac abnormalities assessed by this techniques (e.g., left ventricular 
hypertrophy) have been associated with an increased incidence of cardiovascular morbidity and mortality.  
Given the greater sensitivity and specificity of echocardiographic measure in comparison to other indirect 
measures of cardiac abnormalities, the echocardiogram may serve as a surrogate measure of preclinical 
manifestations of cardiovascular disease and as a prognostic indicator for future clinical events (i.e., 
hypertension, myocardial infarction, and/or stroke). 
 
Since this is a large scale population study of African-Americans from which a very valuable data set will 
be generated, quality control is of particular importance.  Previous population studies (ARIC, Framingham 
Heart Study, CARDIA, and CHS) have indicated that considerable training and experience are required to 
assure optimal echocardiographic data acquisition of sufficient quality.  The goals of this strict 
echocardiography quality control program are to (1) provide quantitative documentation of the 
reproducibility of the scanning and reading procedures, and (2) assure the comparability of the JHS echo 
scanning and reading procedures with ARIC and other important echocardiography data sets. 
 
6.5.2 Essential Features of the Quality Control Program 
 

1. To assure adherence to study protocol, supervision of the performance of echocardiographic 
procedures utilized by technicians will be done by the ERC cardiologist staff, each highly experienced 
in echo methodology and research. 

2. Regular meetings among technicians and reading center physicians will be conducted.  At these 
meetings, the staff will critically review studies to identify opportunities for improvement in data quality 
and security, and in efficiency and details of protocol.  The technicians will better recognize the image 
quality and techniques necessary to allow the study readers to obtain accurate, reproducible 
quantitative information.  At the same time, the study cardiologists can provide ongoing feedback to 
improve the technicians' skills, their understanding of ultrasound principles, and their recognition of 
echocardiographic abnormalities. 

3. To identify potential protocol deviations, difficulties, or inefficiencies, consultant experts in the field 
may periodically visit the EC to assess scanning and reading procedures. 

4. Assessment of inter- and intra-technician/reader variability. 
 
6.5.3 Technician Quality Assessment Procedures  
 
6.5.3.1 (Omitted) 
 
6.5.3.2 Assessment of Intra- and Inter-Reader Variability During the Pilot Phase 
 
To provide estimates of intra-reader repeatability, after initial reading of the pilot phase 
testing/certification, 50% of the scans will be reread by the same reader.  The remaining 50% will be read 
by a second reader.  Additional repeat readings will be performed throughout the study. 
 
In addition to the above quality control procedures a random sample of 20 echocardiograms performed 
during the first three months of the study may be sent to consultants for reading. 
 
6.5.3.3 Assessment of Intra-technician Variability During the Examination Period  
 
Intra-technician variability will be assessed throughout the examination period by the performance of 
quality control repeat echocardiograms in a 5% random sample of participants.  The Coordinating Center 
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will generate a list of randomly selected JHS IDs for the purpose of QC repeat examinations.  After the 
initial scan on each participant is complete, the technicians will check the QC master list to determine 
eligibility of the participant for repeat measurements.  If the participant's ID matches the QC list, he/she 
will be asked to volunteer for a repeat echocardiogram. 
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7.0 OVERVIEW OF DATA HANDLING 
 
The study procedures have been designed with consideration for optimizing completeness, integrity, and 
safety of the data collected.  There is redundancy in data collection and storage, automation and/or 
range-checking during data entry, use of analog and digital media in industry-standard formats, and 
appropriate quality monitoring activity. 
 
Technicians record image and Doppler data as digital images which are stored on a digital image server’s 
hard disks.  These massive disk arrays are configured with hardware redundancy so that hardware failure 
will not result in data loss.  In addition, the completed studies are automatically archived, as a background 
task, to permanent storage media.  As previously mentioned, the data are stored in DICOM-compliant 
system to provide the broadest versatility for data exchange and future compatibility. 
 
The Echo Reading Center will maintain a computer database for storage of all the data relevant to the 
echo studies.  Participant identification and qualitative observations made at the examination will be input 
from written data on the technician worksheets. Qualitative data generated by the reading center's review 
of the study will also be entered from written worksheets.  Quantitative results of measurements on the 
analysis workstation will be directly imported into the database without keyboard data entry.  This process 
will not only duplicate other written and electronic records of this information but also consolidate data for 
local analysis and for ease of archiving the study results onto the UMC network servers. 
 
Data on all network servers are backed up on a daily basis by the UMC Department of Information 
Systems (UMC DIS).  Data security and confidentiality are ensured by network and application level login 
requirements.  Access rights are determined by the data “owners” (in this case, the JHS through the EC 
and ERC) and are implemented by UMC DIS network managers. 
 
All data required for analysis will be transmitted to the Coordinating Center where the official analysis files 
will be maintained.  The ERC will develop an export and transmission process to suit the CC’s needs for 
specific data formats. 
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8.0 COLLABORATION WITH JHS CENTERS AND COMMITTEES 
 
The ERC will be primarily responsible for development of the echocardiography protocol, training of JHS 
technicians and other personnel in execution of the protocol, and monitoring of protocol adherence.  In 
these roles, collaboration and coordination of activities with other Examination Center components will be 
required.  The ERC will collaborate with the Coordinating Center in early phases to develop data 
transmission formats and procedures.  The ERC will develop any custom software interfaces or other 
procedures necessary to format and deliver the JHS echo data to the CC.   The ERC will collaborate with 
the CC throughout the study to provide and evaluate quality control data, and to respond to CC requests 
to reassess additional questions that might arise. 
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9.0 TIMING GOALS 
 
The ERC will have a goal for examination and reporting of echo study data within 2 weeks of the 
examination.  Transfer of data to the CC will occur at a frequency requested by the CC but no more often 
than monthly.  The quality checks and data “cleaning” must occur at the ERC with ample opportunity for 
detection of measurement and data entry errors prior to committing the data to the CC’s database.  The 
clinically relevant reading of the echo study will be done within 24 to 48 hours of the examination.  Other 
requirements of the CC, for example quality control reports, will be generated in a timely manner in 
collaboration with the ERC. 
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Appendix 3 Echo Reading Center Database Field Definitions 
 
 
Echo Reading Center Database field definitions 
 
ID JHS ID 
DATE Study Date 
Tech Technician Initials 
Reader Reader Initials 
ReadDate Reading Date 
PTNAME Participant Name 
Archive Disk Disk/tape for permanent archive 
Videotape Videotape if study is recorded 
ReadSeq Reading order (QC) 
Seq Study scan order (QC) 
AGE Age 
HEIGHT Height 
HEIGHT_UNT       units,  CM/IN 
WEIGHT Weight 
WEIGHT_UNT       units,  LBS/KG 
BSA Calculated body surface area 
BPREST_S Systolic BP 
BPREST_D Diastolic BP 
qLADil Left atrial dilation (0=No   1=Mild   2=Mod   3=Sev   9=Can't assess) 
qLVDil Left ventricular dilation 
qAODil Aortic root dilation 
qLVH LV hypertrophy 
qLVEF Degree of LV dysfunction 
qLVRWM Regional wall motion (N=Normal B=Borderline A=Abnl 9=Can't assess) 
qAVLEAF Aortic leaflets  (0=Normal  1=Sclerosis  2=Stenosis  9=Can't assess) 
qMVLEAF Mitral leaflets 
MR Mitral regurgitation  (0=None  1=Trace  2=Mild  3=Mod/Sev  9= ? ) 
AR Aortic regurgitation 
TR Tricuspid regurgitation 
PR Pulmonary regurgitation 
MAC Mitral Anular Calcification  (0=None       2=Mild  3=Mod/Sev  9= ? ) 
MVP Mitral Valve Prolapse 
AoCalcif Aortic root fibrocalcific change 
LVAneurysm LV Aneurysm present?       (N=No   A=Ant/apical  I=Inf/Posterior  9=?) 
LVClot LV thrombus present ?        (N=No   Y=Yes   9=can't assess) 
OtherFindings Other echocardiographic interpretation 
2DDataView View used to measure LV on 2D  (L=para long  S=para short  N=Not done) 
MMDataView View used to measure LV on MM (L=para long  S=para short  N=Not done) 
SeptalAngle Septal angle to echo beam > 30 degrees  ( N=No   Y=Yes ) 
q2DPara Quality of 2D parasternal (3=Ex 2=Good 1=Fair 0=not usable 9=not done) 
q2DApex Quality of 2D apical views 
qMMLV Quality of M-mode of LV 
qMMAOLA Quality of M-mode of Aorta and left atrium 
qPWMitral Quality of pulsed Doppler of mitral valve inflow 
qPWLVOT Quality of pulsed Doppler of LV outflow tract 
qCOLOR Quality of color flow Doppler study 
qALERT Presence of "alert" findings (N=No  Y=Yes) 
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COMMENTS Comments on study, data, or anything other than clinical interp. 
LMIVS_DV LV septum thickness - diastole     M-MODE 
LMIVS_SV LV septum thickness - systole       M-MODE 
LMLVDM_DV LV diameter - diastole   M-MODE 
LMLVDM_SV LV diameter - systole     M-MODE 
LMLVPW_DV LV posterior wall thickness - diastole   M-MODE 
LMLVPW_SV LV posterior wall thickness - systole     M-MODE 
LMLADM_V Left atrium diameter  M-MODE 
LMAORT_V Aortic root diameter  M-MODE 
LMLVDM_PV Percent fractional shortening of LV  M-mode diameter (calc) 
LMLVMAS_V LV mass from M-MODE data 
L2IVS_DV LV septum thickness - diastole    2-D 
L2IVS_SV LV septum thickness - systole      2-D 
L2LVDM_DV LV diameter - diastole     2-D 
L2LVDM_SV LV diameter - systole       2-D 
L2LVDM_PV Percent fractional shortening of LV 2-D diameter (calc) 
L2LVPW_DV LV posterior wall thickness - diastole    2-D 
L2LVPW_SV LV posterior wall thickness - systole      2-D 
L2LADM_V Left atrium diameter   2-D 
L2AODM_V Aortic root diameter   2-D 
L2LVMAS_V LV mass from 2-D data  (calc) 
AOMVELS_V Doppler aortic outflow MEAN velocity 
AOPKVEL_V Doppler aortic outflow PEAK velocity 
AOSYSVL_V Doppler aortic outflow Velocity Time Integral 
AOHR_V Heart rate during aortic Doppler study 
AOEJCTM_V Systolic ejection time 
AOVSCSA_V LV outflow tract cross sectional diameter 
AOSTKVL_V LV stroke volume = CSA x VTI (calc from AOVSCSA_V  x  AOSYSVL_V) 
AOCROUT_V Cardiac output = HR x SV  (calc from AOHR_V  x  AOSTKVL_V) 
AOCRIDX_V Cardiac index = C.O. / BSA 
MIPKVLE_V Doppler mitral inflow peak velocity of E wave 
MIPKVLA_V Doppler mitral inflow peak velocity of A wave 
MIPKE_A_V Doppler mitral inflow ratio of peak E to peak A 
MIVTIEW_V Doppler mitral inflow VTI of E wave 
MIVTIAW_V Doppler mitral inflow VTI of A wave 
MIVTI3_V Doppler mitral inflow VTI of first 1/3 of diastole 
MIVTIET_V Doppler mitral inflow Ratio of E-wave VTI to total diastolic VTI 
MIVTIAT_V Doppler mitral inflow Ratio of A-wave VTI to total diastolic VTI 
MIVTI3T_V Doppler mitral inflow Ratio of first 1/3 VTI  to total diastolic VTI 
MIHR_V Heart rate during mitral Doppler study 
MIFILTM_V Diastolic filling time 
MIDVTI_V Total diastolic VTI 
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FOREWORD 
 
This manual is one of a series of protocols and manuals of operation for the Jackson Heart Study (JHS).  
The complexity of the JHS requires that a sizeable number of procedures be described, thus this rather 
extensive list of materials has been organized into the set of manuals listed below.  Manual 1 provides the 
background, organization, and general objectives of the JHS Study.  Manuals 2 and 10 describe the 
operation of the Cohort and Surveillance Components of the study.  Detailed Manuals of Operation for 
specific procedures, including those of reading centers and central laboratories, make up Manuals 3 
through 9 and 11. 
 
 

JHS Study Protocols and Manuals of Operation 
 
 

MANUAL TITLE 
  
1 General Description and Study Management 
  
2 Cohort Component Procedures 
  
3 Family Study 
  
4 Blood Pressure  
  
5 Electrocardiography 
  
6 Echocardiography 
  
7 Ultrasound Assessment 
  
8 Pulmonary Function Assessment 
  
9 Specimen Collection and Processing 
  

10 Cohort Surveillance 
  

11 Data Management System 
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1.0 BACKGROUND 
 
 
1.1 Description of the Jackson Heart Study  
 
The Jackson Heart Study (JHS) is a single-center prospective observational study of African-
American residents of Jackson, Mississippi. Recruitment for this project will begin in September, 
2000, and continue for a three year period until approximately 6,500 35-84 year old women and men 
are enrolled. This cohort will be contacted annually for information about their health, including new 
cardiovascular disease events. Any indication of incident disease will be investigated through 
physician contact and hospital records. Ascertainment and documentation of incident coronary events 
is a major goal of the project. The purpose of the JHS ECG Manual of Operations is to specify ECG 
acquisition procedures, to facilitate training of ECG technicians, to identify “alert” conditions which 
may require special cautions and to briefly describe ECG coding and quality control procedures for 
JHS. 
 
Two categories of resting ECGs  are collected for the JHS cohort: 
 

1. Standard ECG for every participant at the baseline visit. 
To determine prevalent baseline ECG findings with regard to myocardial 
ischemia, left ventricular hypertrophy, arrhythmias and conduction delays for 
each JHS participant. 

 
2. Ancillary ECGs (A-ECGs) for participants having ECGs recorded outside the 

clinic and including ECGs recorded in-hospital and at local medical facilities. 
To determine if new coronary heart disease event(s) occurred. 

 
ECGs for all participants at baseline, are sent by phone modem to be analyzed by computer at the 
Minnesota Central Electrocardiographic Laboratory (ECGRC), Division of Epidemiology, School of 
Public Health, Minneapolis, Minnesota. Wave voltage and duration measurements are automatically  
determined by the Minnesota Code Modular ECG Analysis System (MC-MEANS)2, which provides 
Minnesota Codes1 (Appendix 1) and other special measurements. A-ECGs recorded at other medical 
facilities including hospitals are visually coded using standardized procedures and will, so far as 
possible, be part of a participant’s record.  These A-ECGs will document the timing, nature and 
severity of coronary events occurring after baseline.  Both baseline and A-ECGs will contribute to the 
participant’s overall cardiac status.  A-ECGs will be compared serially to document new CHD events 
including unrecognized MI, LVH, new bundle branch block and other incident ECG abnormalities 
specified by the study. 
 
1.2 Electrocardiography in the Jackson Heart Study  
 
A single baseline 12-lead electrocardiogram (ECG) will be recorded digitally on all JHS participants 
during a three year recruitment period and classified centrally. Enrollees having ECGs recorded for 
any potential medical problems at outpatient facilities or in-hospital will, so far as possible, have their 
ECGs visually coded centrally as well. 
 
The major aim of the Minnesota ECG Coding Center (ECGRC) for the JHS is to provide reliable ECG 
measurements from digital and paper ECG records which will be used to identify prevalent coronary 
disease (CHD) and new CHD events such as unrecognized myocardial infarction (MI) and in-hospital 
acute MI. The ECGRC will provide ECG documentation of:  
 

1. Prevalent ECG findings reflecting cardiac disease; such as MI, left ventricular 
hypertrophy (LVH), bundle branch block, cardiac arrhythmias and other major or minor 
ECG findings. 
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2. Other prevalent ECG risk indicators such as low heart rate variability, prolongation of the 
heart rate corrected QT interval (QTc).  These ECG findings are defined by the ECGRC 
from specific computer measurements and by application of the Minnesota Code1. 

3. Incident myocardial infarction, symptomatic or asymptomatic. 

4. Estimated left ventricular mass. 
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2.0 JACKSON HEART STUDY CLINIC ECG PROCEDURES 
 
 
2.1 Introduction 
 
At the baseline visit, a standard supine 12-lead resting ECG is recorded after a 12-hour fast and at 
least one hour after smoking or ingestion of caffeine, followed by a light snack. 
 
2.2 Procedures for Recording ECGs 
 
A supine twelve lead digitized ECG will be the standard for the JHS, and the MAC PC Personal 
Cardiographic Computer by Marquette Electronics, Inc., is recommended for the study.  The MAC PC 
is a widely used ECG machine that is approved by the Underwriters’ Laboratory and has been used 
extensively in other epidemiologic studies.  The MAC is the most advanced cardiograph available 
today.  For the JHS, the function of the MAC PC will be used to obtain and store ECG data prior to 
transmission to the ECGRC.  Complete instructions for operating the MAC PC are provided by the 
company and are easy to understand.  The data acquisition manual will contain complete instructions 
for successfully recording an electrocardiogram. 
 
The standard configuration for the MAC PC is shown in Appendix 2. A 12-lead resting ECG tracing is 
obtained consisting of 10 seconds of each of the leads simultaneously (I, II, III, aVR, aVL, aVF, Vl-V6). 
 
2.3 Electrode Position Measuring and Marking 
 
A standard procedure will be followed for location of chest electrode sites and limb leads.  
Measurements taken for chest electrodes will be used for quality control.  This protocol will mimic that 
used in the ARIC Study.  The electrodes are attached to the lead wires of the acquisition module in 
the correct order by using the lead wire labels.  Simultaneous with the digital recording a paper record 
is produced that can be inspected for data quality, lead reversal and alert ECG statements. 
 
Because it is essential for the study to be able to compare baseline ECG data with subsequent 
records, a uniform procedure for electrode placement and skin preparation is required. The method 
and procedure for standardizing electrode locations are outlined below. The participant, chest bared, 
is instructed to lie on the recording bed with arms relaxed at the sides. The individual is asked to 
avoid movements, which may cause errors in marking the electrode locations, but encouraged to 
converse with the technician. Prior experience with electrocardiograms is discussed, as is the 
purpose of the ECG recording. The participant should be told this is a research ECG to be used for 
statistical analysis later in the study. However, the clinic physician can also use it for general 
diagnostic purposes, and a copy can be sent to the individual's private physician if desired. For best 
electrode/skin interface, place the electrodes on the skin at least 2-3 minutes before taking the ECG. 
Participant information can be entered on the MAC PC during this time. 
 
A good felt tip pen is used to mark the six chest electrode positions. Wipe the general area of the 
following 10 electrode sites with a sterile alcohol prep to remove skin oil and perspiration. It is 
extremely important that care be taken to locate these positions accurately. Therefore, the procedure 
given below must be meticulously followed. Electrode positions in women with large, pendulous 
breasts must be determined in relation to the anatomic points described below, as for all participants. 
The electrodes must then be placed on top of the breast (in the correct position).Figure 1 
schematically displays the standard electrode locations.  
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2.3.1 Limb Leads 
 

 Locate electrode LL on the left ankle (inside). 
 Locate electrode RL on the right ankle (inside). 
 Locate electrode LA on the left wrist (inside). 
 Locate electrode RA on the right wrist (inside). 

 
Figure 1. Electrode and Leadwire Placement 
 

 
 
2.3.2 Electrode V2 
 
Locate the sternal angle and second left rib between the index and middle fingers of your right hand. 
Count down to the fourth rib and identify the fourth intercostal space below it. Locate V2 in the fourth 
intercostal space immediately to the left of the sternal border. 
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2.3.3 Electrode V1 
 
Locate electrode V1 in the fourth intercostal space at the right sternal border. This should be at the 
same level as V2 and immediately to the right of the sternum. 
 
2.3.4 Anterior 5th Interspace Marker (E Point) 
 
Identify the fifth rib and fifth intercostal space below V2 by counting down ribs as described for V2. 
Follow this space horizontally to the midsternal line and mark this point. This is the "E" point.  
 
2.3.5 Electrode V6 
 
With the chest square held lightly against the body (see Figure 2) locate the V6 electrode at the same 
level as the E point in the midaxillary line (straight down from the center of the armpit). If breast tissue 
is over the V6 area, mark the V6 location on the breast. Do not attempt to move the breast in order to 
mark V6 on the chest wall. 
 
Figure 2. Location of V6 Electrode using the Chest Square 
 

 
 
2.3.6 Chest Size Measurements 
 
Place the Chest Square firmly on the lower sternum at location E and at location V6. Verify that the 
arms of the square are exactly horizontal and vertical in the horizontal plane of the thorax. Move the 
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square so that the vertical arm at V6 is firmly against the ribcage. Use the appropriate length chest 
square so the horizontal arm rests firmly on the lower sternum. 
 
Now read the distance 0-E and the distance 0-V6 to the nearest 0.5 cm. Write them down on scratch 
paper. 
 
Record the 0-V6 measurement under height and the O-E measurement under weight. Measure to the 
nearest 0.5 cm. and round up. 
 e.g., 11.25 cm. would be 11.5 cm. 
  11.75 cm. would be 12.0 cm. 
 
Enter 3 digits into the MAC PC but do not enter decimal points. 
 e.g., 11.5 cm enter as 115 
  11 cm. enter as 110 
 
Use leading zeros. 
 e.g. 9.5 cm. enter as 095 
 
2.3.7 Electrode V4 
 
Electrode V4 is located using the E-V6 Halfpoint Method3. Using a flexible tape measure, measure the 
distance between the E point and the V6 marking. The tape should be resting lightly on the skin, not 
pressing into the flesh. The E and V6 marks should clearly be seen above the tape. Without moving 
the tape, mark the location of electrode V4 midway between E and V6.  
 
2.3.8 Electrode V3 
 
Using a flexible tape measure, mark the location of electrode V3 midway between the locations of V2 
and V4. 
 
2.3.9 Electrode V5 
 
Using a flexible tape measure, mark the location of electrode V5 midway between the locations of V4 
and V6. 
 
2.4 Skin Preparation 
 
Prepare the skin for applying electrodes by wiping with alcohol, then briskly with a gauze pad. If 
technical problems are observed due to poor electrode contact, it is necessary to do further 
preparation as described below: 
 

1. With the participant's consent, remove any excess hair from each electrode site on the 
chest and legs using an electric or disposable shaver. 

2. At each electrode location in turn, the outer horny layer of the epidermis is removed by 
gentle dermal abrasion with a piece of 6-O (220) sandpaper. Only three passes (in the 
form of an asterisk) at each site using light pressure are required. 

 
If the skin preparation has removed the felt pen marking at any of the electrode sites, these are 
accurately reestablished by carefully repeating the procedure described in Electrode Position 
Measuring and Marking. It is important that the electrode sites be marked using the exact technique 
described. 
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2.5 Application of Electrodes 
 
Disposable electrodes are used in the JHS. Adaptors are used with the leadwires to connect the 
"banana" plug from the MAC PC leadwire to the disposable electrode via a clip. 
 
When placing each electrode, massage it with a small up and down circular motion to maximize the 
pre-gel contact with the skin but avoid overlap of gel from one electrode to the next. 
 
Center the four limb electrodes on the inside of the wrist or ankle with the tab for the clip pointing 
toward the head. Center the six chest electrodes on the chest markings with the tabs pointing down. 
Do not let the electrodes overlap or touch each other if possible. 
 
Clip the appropriate leadwire to each electrode. Do not pull or jerk tangled wires. To untangle wires, 
disconnect lead wires from electrodes. 
 
2.6 Recording the 12-lead ECG 
 
After placing the electrodes on the skin, enter the participant information into the MAC PC (Figure 3) 
according to Appendix 2. Electrodes must be on the skin for at least 2-3 minutes before taking the 
ECG. Make a final check of the electrodes and lead wires. Ask the participant to relax and keep still, 
then press the RECORD key. 
 
Figure 3. The MAC PC Keyboard and LCD Display by Marquette Electronics, Inc. 
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The machine will display "Acquiring Data" and the left side of the display will show a count. If there 
are technical problems the display will show which lead is involved and will keep counting until it gets 
10 seconds of good data. Check electrode contacts and leadwires, then check the display again. If 
the display counts past 45, electrodes likely will need to be re-positioned. Push the STOP key and 
remove the electrodes on limbs first. Prepare the electrode sites as discussed in Skin Preparation 
and follow the above protocol for exact relocation of electrodes. Press RECORD ECG. The machine 
will tell you to "enter a new patient or press RECORD." Press RECORD ECG a second time to start 
the ECG. The machine will automatically print the ECG after it has acquired 10 seconds of good data 
(Figure 4). 
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Figure 4. Typical Electrocardiogram Using the MAC PC 

 
 
Tear the ECG off the machine and file it in your records. Make a copy by pressing "up" arrows with Fl. 
Press Fl under “Storage”, again press Fl under “Plot”. Choose the desired tracing. Press F5 – “Enter” 
- then “Print”. A copy can be printed from the machine's memory any time before deletion of the ECG. 
 
2.7 Fault Detection Procedures 
 
Should problems with noise or drift be encountered, electrodes are replaced. The following is a guide 
for determining which electrodes may be faulty. The underlined electrodes are the predominant 
determinants of the appropriate lead and therefore are most likely to be the faulty electrodes for a 
given lead. After adjustment or replacement of suspect electrodes, the electrocardiograph should be 
able to record 10 seconds of good data.  
 
Table 1. Fault Detection Table 
 

Lead Affected Possible Faulty Electrode 
 I RL, RA, LA 
 II RL, RA, LL 
 III RL, LA, LL 
 aVR RL, RA, LL, LA 
 aVL RL, LL, RA, LA 
 aVF RL, LL, RA, LA 
 Vl RL, LL, RA, LA, V1 
 V2 RL, LL, RA, LA, V2 
 V3 RL, LL, RA, LA, V3 
 V4 RL, LL, RA, LA, V4 
 V5 RL, LL, RA, LA, V5 
 V6 RL, LL, RA, LA, V6 
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2.8 Self Evaluation of Technical Performance 
 
This section allows technicians to monitor their own ECG technique. It is intended to help technicians 
who are having difficulty meeting the quality standards set by the ECGRC. These data are not 
intended to be collected by the study. 
 
The technician examines the ECG tracing to estimate the noise level and baseline drift. Based on the 
requirements of the Minnesota Code, acceptable and unacceptable levels of noise and baseline drift 
have been established. These levels are scored using the following table: 
 
Table 2. Self Evaluation Table 
 
   Overall Beat-to-Beat 
 Quality Grade Noise (mm) Drift (mm) Drift (mm) 
 1 < .25 < 1 < l 
 2 < .50 < 2 < 1.5 
 3 < 1 < 3 < 2 
 4 < 2 < 4 < 3 
 5 => 2 => 4 => 3 
 
The grade levels given in this table are related to the ability of the analysis program to achieve the 
required accuracy. Quality Grade 5 is unacceptable. ECGs of Quality Grade 5 must be deleted from 
the machine's memory and retaken immediately. 
 

1. First, the tracing is examined for obvious errors such as right arm/left arm and other 
common lead misplacements (see Figure 5, negative p-waves in I indicate lead switch). 
These ECGs must be deleted from the machine's memory and retaken immediately. 

 
Figure 5. Common Lead Placement Artifacts 
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2. The Quality Grade for noise is obtained by measuring the noise level as vertical peak-to-

peak values in terms of number of small paper divisions (smallest grid squares). Note 
that recording sensitivity is 1 mm per 0.1mv, (one small paper division = 1 mm = 0.1 mv). 

 
Noise, beat-to-beat drift and overall drift exceed quality level 5 (Figure 6)  
 
Figure 6. Unacceptable ECG Data Quality  

 
3. The Quality Grade for overall drift is obtained by searching each of the 12-leads for the 

maximum and minimum baseline levels within that lead (as determined by the PR and/or 
TP segments) over the 10 second recording and measuring the vertical distance between 
them. A distance of more than 4 small paper divisions is unacceptable (Figure 7). 

 
Figure 7. Unacceptable Overall Baseline Drift 
 

 
 
 

4. The Quality Grade for beat-to-beat drift is determined by searching for the pair of 
successive QRS complexes having the largest amplitude difference (vertical distance) 
between successive PR segments. A difference of more than 3 small paper divisions 
(>0.3 mm) indicates an unacceptable record (Figure 8). 
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Figure 8. Unacceptable Beat-to-Beat Baseline Drift 
 

 
 
Improvement in technical quality will indeed result if the prescribed procedure for electrode position 
marking, electrode and skin preparation, electrode replacement and equipment use are carefully 
followed. Baseline drift problems, which are essentially caused by poor electrode-skin contact are 
particularly easy to remedy, as is 60-cycle interference. 
 
Sixty-cycle interference is characterized by perfectly regular fine oscillations occurring at the rate of 
sixty per second (Figure 9). 
 
Figure 9. Sixty-Cycle Interference 
 

 
 
Electrical equipment of any kind may be the source of AC interference on an ECG in all leads or only 
certain ones. Check quality of skin preparation and electrode contact. Check leadwires and re-secure 
attachment of the alligator clip to the electrode. Make sure participant does not touch any metal part 
of the bed or other equipment. Proximity to a wall with hidden wiring or a partially broken cable may 
also cause this problem. 
 
Muscle tremor causes irregular oscillations of low amplitude and varying rapidity superimposed upon 
the ECG waveform (Figure 10). Muscle tremor is the involuntary muscle activity of a participant 
whose state is tense, apprehensive, or uncomfortable. This is why a clear explanation of the 
electrocardiogram test and reassurance are necessary for the participant. The participant is asked if 
the temperature of the room is too low for her/him and is covered with a blanket if so. 
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Figure 10. Artifact Caused by Muscle Tremor (Possible Shivering) 
 

 
 
2.9 Original Hard Copy Record 
 
The original 12-lead ECG record is filed at the field center, and is read locally by clinic physicians for 
notification and referral if needed. The records are then placed in participants' local data files. Double 
check that the participant is correctly identified. 
 
2.10 Transmission, Confirmation and Deletion 
 
ECGs are transmitted via the phone and are received by the ECGRC’s two MAC 12s.  These two 
machines permit automatic switching to accommodate simultaneous transmission or for backup in the 
event one becomes non-functioning.  In the event both lines are busy, the clinic site is automatically 
notified and must call back later.  The MAC PC indicates when transmission is completed.  Each day, 
the digital ECG information is processed, and transferred to the VAX system.  The ECGRC will 
acknowledge, on the same day, ECGs received from JHS.  The ECGRC uses an automated 
system for logging, tracking, and inventory of received ECGs, and for identification of duplicate ID 
numbers.  The status of any or all ECGs can be ascertained in less than five minutes using this 
approach. 
 
2.10.1 Transmission 
 
The MAC PC will store 11 to 14 12-lead ECGs.  The machine will not store another ECG if the 
memory is full when an ECG is taken.  The machine will ask you to delete an ECG from memory or 
delete the one just taken. For this reason ECGs must be transmitted to the ECGRC every day and 
deleted the next day after confirmation.  
 
The receiving unit at the ECGRC is usually in the "ready" state to receive ECGs. If you get a "no 
connection" message when trying to send ECGs, try again in 10-20 minutes. If there continues to be 
problems with transmitting to the ECGRC, call the ECGRC Coding Supervisor at (612) 626-9681 or 
the ECGRC Manager at (612) 626-8581 to arrange transmission. 
 

1. The phone number for the ECGRC receiving port 612-626-9685 is already programmed 
in the setup menu of the electrocardiograph. 

2. Make sure the phone line is connected. This can be done by moving the jack from your 
regular phone to the port in the back of the MAC PC. 

3. Print one copy of the directory of ECGs in memory (see Appendix 3). To do this: 

a) From the Main Menu press the shift and Fl keys simultaneously to show the system 
functions display. 

b) Press the Storage (Fl) key to display the storage functions display. 

c) Press the Directory (F2) key and a directory will be printed. 
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4. On the directory, put an asterisk by the IDs taken that day which are to be transmitted 
(see Appendix 3). 

5. To complete transmission: 

a) From the Main Menu press the shift and Fl keys simultaneously to show the system 
functions display. 

b) Press the Storage (Fl) key to display the storage functions display. 

c) Press the More (F5) key to show the second storage functions display. 

d) Press the Transmit (Fl) key to show the transmission type display. 

e) Press the Phone (Fl) key. (The ECGRC phone number will show on the display and 
should not need to be reentered). Press ENTER. 

f) Patient data for the first ECG in memory will be displayed. 

g) If that ID had already been transmitted earlier, press NO (F2). If the ECG is to be 
transmitted press YES (Fl). 

h) Each ID on the directory will be displayed. Press NO or YES for each one, referring 
to the printed directory. Note in Figure 10 that ID 15102402 has two different ECGs in 
the machine's memory. This would occur if the technician noticed poor quality in the 
first ECG, and took a second one without deleting the first. Make sure to immediately 
delete tracings that are of poor quality. In doing so, all tracings not previously sent 
can be transmitted each time. 

i) The machine will dial the phone and transmit each ECG. 

j) Watch the display as each ECG is transmitted and check the IDs on the Directory 
List. This way if a problem occurs, the ECG involved can be identified. 

k) After the last ECG to be transmitted is displayed, a message indicating the number of 
ECGs that were transmitted vs. the number you selected to transmit is displayed. If 
the numbers are not the same, the problem ECGs will have been identified on the 
Directory List. These can be retransmitted using the above steps. 

l) Keep the Directory List available for confirmation from Minnesota via electronic mail 
the next morning. 

 
2.10.2 Confirmation 
 
Every morning the ECGRC in Minnesota notifies the JHS Clinic of the IDs received. Notification is by 
electronic mail directly to the JHS Clinic Supervisor. The mailing includes the ID, and date and time of 
each ECG received on the previous evening. Compare the Directory List with the IDs of the mailing. If 
there is a notice of invalid ID tracing on the E-mail confirmation, it must be corrected and 
retransmitted before deletion. See Appendix 3 for an example of e-mail confirmation. If there is an ID 
on the Directory (which had been marked for transmission) that is not on the confirmation mailing, 
retransmit that ID immediately. If there is an ID on the confirmation mailing that is not on your 
Directory List, notify Minnesota of this via electronic mail. 
 
Note: Confirmation of transmission from Minnesota has nothing to do with the confirmed/unconfirmed 
report settings in the MAC PC. 
 
2.10.3 Deletion 
 

To delete ECGs that have been received by Minnesota: 
 

1. From the Main Menu press the shift and Fl simultaneously to show the system functions 
display. 
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2. Press the Storage (Fl) key to display the storage functions display. 

3. Press the Delete (F4) key. 

4. Patient Data for the first ECG in memory will be displayed. 

5. If confirmation from Minnesota has been received, press the Delete (Fl) key, otherwise 
press the Save (F2) key. 

6. Each EGG in the directory will be displayed. Press Delete or Save for each one. 

7. The machine will count the ECGs and the display will ask if you really want to delete 
them. If you are sure you have selected only ECGs confirmed by Minnesota and/or bad 
quality ECGs, press Yes (Fl), otherwise press No (F2) and start over. 

8. You may also press Quit (F4) while any ID is being displayed if you have made a mistake 
and nothing will be deleted. 

 
2.11 Clinic ECG Alerts 
 
The MAC PC has an interpretative program which assigns diagnostic statements to the paper ECG.  
While the technician is not expected to be able to interpret ECGs, they should be familiar with the 
interpretative statements printed on the hard copy.  The interpretative program should be considered 
a screening device, which tends to be overly sensitive.  The following conditions are suggested as 
possible alerts that warrant quick review by the study physician: 
 

1. Heart rate < 40 beats per minute 
2. Heart rate > 150 beats per minute  
3. Ventricular tachycardia  
4. Idioventricular rhythm  
5. WPW pattern 
6. Atrial fibrillation or flutter  
7. Complete heart block  
8. Any statement(s) which refers to acute pattern (injury, ischemia, MI or pericarditis). 

 
2.12 MAC PC Maintenance 
 
2.12.1 Paper 
 
Change the roll of paper as needed. Each roll is 75 feet long; and will print approximately 75 ECGs. 
 
2.12.2 Procedures for charging the battery of the MAC PC 
 
The MAC PC runs only from its battery. The machine may be used with the battery or plugged into a 
wall outlet. The machine must be plugged into an outlet to charge when the battery charge is down to 
20 or less. It holds and stores about 14 ECGs. The amount of charge left is displayed for one-half 
second when the machine is turned on. If the unit is left unplugged, over a period of time it will 
completely drain and will delete stored ECGs. Leave the unit plugged in over weekends and holidays. 
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3.0 JACKSON HEART STUDY ANCILLARY ECG PROCEDURES 
 
 
3.1 Introduction 
 
Ancillary ECGs are obtained for participants having ECGs recorded outside the clinic. This includes 
ECGs recorded in-hospital and at local medical facilities. 
 
3.2 Procedures for Obtaining Ancillary ECGs 
 
For each JHS participant with an in-hospital or clinic ECG, obtain up to 3 ECGs for each event. For 
example, a participant has a two-day hospital stay for chest pain. Ideally, the JHS clinic staff will 
obtain three ECGs; the first ECG upon participant’s admission to the hospital/ER/clinic; the last ECG 
before the participant’s discharge; and one in between. Label each ECG with the participant’s JHS ID 
number, and either F (First), T (in between) or L (Last), indicating the order of the ECGs. 
 
Original ECG tracings are best, otherwise a good photocopy should be taken. Obtain two copies, one 
to keep in the JHS participant’s clinic file, and one to send to the ECGRC.  
 
3.3 Transmission of Ancillary ECGs 
 
Monthly, the JHS will send Ancillary ECGs to the ECGRC. Two copies of a shipping form will 
accompany the shipment, listing the JHS participant IDs. Upon receipt, the ECGRC will initial and 
date the shipping forms and send one back to the JHS. See Appendix 13 for an example of a 
shipping form. 
 
ECGs should be shipped to: Sean Thomas 
    ECG Coding Center 
    School of Public Health, University of Minnesota 
    1300 South 2nd Street, Suite 300 
    Minneapolis, MN 55454-1015 
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4.0 CENTRAL READING OF BASELINE AND ANCILLARY ECGS  
 
 
4.1 Resting 12-lead  
 
Reading of 12-lead ECGs by the ECGRC includes the Minnesota Code1 (Appendix 1) and the 
Performance Grade Level (Appendix 4). Every other week Minnesota sends these data for the ECGs 
received to the JHS on diskette. Wave voltage and duration measurements also taken are detailed.  
An example of the data dictionary created for each study is illustrated in Appendix 5. Established 
ECG criteria for prevalent myocardial infarction at the baseline ECG recording are: 
 

a) any 1-l-X code AND (no 7-l-l or 7-4) 
   OR 
b) any l-2-X (except 1-2-6 or 1-2-8) PLUS (4-1-l or 4-l-2 or 4-2 or 5-l or 5-2) AND (no 7-l-l or 7-4). 

 
4.2 Ancillary ECGs 
 
Whenever hospital ECGs for cohort participants are obtained after the baseline examination, 
photocopies of these records (masked at the field center for all information except ID) are sent to the 
ECGRC and coded by the Minnesota Code. ECGs are read two times, blinded: if the final codes do 
not agree they are adjudicated by a senior coder. Minnesota Code criteria are in Appendix 1. 
 
4.3 Serial ECG Comparison of Ancillary ECGs 
 
Non standard ECGs taken at outside JHS clinic facilities including in-hospital ECGs are compared by 
the Minnesota Serial ECG comparison algorithm.  This procedure takes either the baseline ECG or 
the first A-ECG as reference and compares it to other A-ECGs to determine whether significant 
change in Q-code, ST-depression code, T-wave inversion code, ST elevation code, LVH code or 
Conduction code has occurred. Serial comparison results are significant increase, significant 
decrease, no significant change and technical problem. Serial change triggers, definitions and criteria 
are shown in Appendix 6 and publications of serial change criteria are in Appendix 7. These objective 
rules for side-by-side ECG evaluation are used to determine whether a Minnesota code change 
between ECG pairs is significant. 
 
ECGs that fit the change criteria (i.e., any pattern ED1 through ED7 or EVl through EV8) are 
examined side by side for Serial ECG change. Simultaneous ECG comparison is performed by a 
senior coder on the final Minnesota codes using the first ECG of the hospitalization as the reference. 
Serial change categories are: significant increase, decrease (but not for Q-codes), no change (this 
implies no increase for Q-codes) or technical problem. These objective rules for side-by-side ECG 
evaluation are used to determine whether a Minnesota code change between ECG pairs is 
significant. The ECG findings are combined with presence of chest pain and level of serum enzymes 
to document definite, probable, suspect or no MI (see Appendix 8). 
 
As an example, the ARIC protocol defines a new Minnesota code 1-2-7 as a potential ischemic event. 
Persons with this severity of ECG change will have simultaneous ECG comparison. The ECG 
comparison procedure (for this case) requires a 1 mm R-wave amplitude decrease between 
corresponding leads of the reference and comparison ECGs.  
 
The criterion for 1-2-7 are QS patterns in V1 -V3. If the reference ECG has R-waves that are 1 mm tall 
in V3 , then when comparing these ECGs side by side, the R-waves in the event ECG decrease by 
=>1 mm compared to the reference ECG and a "significant increase" is noted (see Appendix 9).  
 
JHS requires a Minnesota Code change plus agreement by simultaneous ECG comparison 
before declaring that the ECG pattern change meets JHS criteria for an evolving ECG diagnostic 
pattern. 
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5.0 DATA STORAGE AND RETRIEVAL 
 
5.1 Digital Data Storage and Retrieval 
Digital ECGs are stored both on the ECGRC’s personal computer system and the Division of 
Epidemiology’s VAX system.  The latter system uses daily backup and a special server for ECG 
studies.  Either system can retrieve digitized information in about 5 minutes.   
 
5.2 Paper Data Storage and Retrieval 
 
Paper tracings from A-ECGs and those generated from all digital ECGs are stored in locked cabinets 
for immediate access as needed. Only ECGRC staff have access. The ECGs are filed by ID. 
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6.0 QUALITY CONTROL 
 
 
6.1 The 12-lead ECG 
 
6.1.1 Technician 
 

1. All ECG technicians must be certified. See the following section on Training and 
Certification, and Appendix 10 for Certification forms.  

2. Study guidelines on "acceptable" noise levels are given earlier in this protocol under Self 
Evaluation of Technical Performance. 

3. Each technician must take an average of 3 ECGs per week over a two month period to 
remain familiar with procedures and equipment. 

4. Each technician is observed quarterly by the most senior certified technician while taking 
a participant's ECG. The observer checks whether or not each procedure is performed 
(Appendix 11) and makes comments on the sheet if necessary. After the ECG is taken, 
the observer discusses the Procedure Review with the technician, then sends it to the 
JHS. 

 
6.1.2 JHS Clinic Center 
 

1. Each ECG is checked for quality of data in Minnesota. 

2. The technician number and Performance Grade Level (Appendix 6) of each ECG is 
included in the data file that is sent to the ECGRC each month. 

3. The ECGRC reports these findings to the JHS. 

4. Each MAC PC is calibrated quarterly. Procedures are in Appendix 12. 
 
6.1.3 ECG Computer Coding at the ECGRC 
 
Blind rereading of baseline ECGs is performed in two ways: 
 

1. The abnormal quality control ECGs that are retransmitted are returned to the ECGRC 
with the other abnormals. The ECGRC makes no effort to distinguish these returned 
ECGs from the rest of a normal shipment. They are coded and reported in the usual 
manner. Thus, the ECGRC continually rereads the quality control ECGs determined to be 
abnormal. (The quality control ECGs determined to be normal are only sent to the 
ECGRC if they are chosen to be part of the 10% sample of normals that is included with 
the abnormals.) 

 
2. A 25% sample of computer defined abnormals are visually overread . A 10% sample of 

normals are also visually overread. The overreading is done using the same “average” 
beat used by the computer program.  

 
6.2 Ancillary ECGs 
 
The ECGRC will conduct internal repeat quality control on hospital (ancillary) ECGs. 
 
6.3 Data Acquisition 
 
Quality control of data acquisition will be achieved by initial central training of technicians and 
subsequent certification of them and all "new" technicians involved during the course of the study. 
Study guidelines on "acceptable" noise levels are given earlier in this protocol under Self Evaluation 
of Technical Performance. Feedback of clinic quality of ECG recording will also be reported by the 
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ECGRC on receipt of ECGs transmitted by modem. The Performance Grade Level is included for 
every ECG in the monthly diskette sent to the Coordinating Center. 
 
6.4 Training and Certification 
 
The ECGRC will assume responsibility for ECG training and certification.  Central training of ECG 
technical staff will take place in one day.  After completion of training, JHS technical staff will know 
how to reliably position electrodes, how to record and transmit the digital ECG to the ECGRC, how to 
recognize alert conditions and understand the quality requirements for ECGs recorded in the JHS.  
Each technician will have a personal ID coded with the transmitted ECG.  Upon completion of 
training, technical staff must transmit three high quality ECGs to the ECGRC to be certified for 
recording JHS ECGs.  Recertification will take place on an annual basis for those already certified 
and prior to any new technician recording JHS study data. 
 
New technicians hired after central training  are trained by the most senior certified technician. 
Training of new technicians must include observation of at least 6 ECGs being taken by the senior 
technician. Once training is complete, the technician must be officially certified as capable of 
recording high quality ECGs by the ECGRC. Certification ECGs must be done by obtaining 3 ECGs 
on age-eligible participants. Send the ECGs and the certification form (Appendix 10) to the ECGRC. 
The tracing will be "logged in" and evaluated for ECG quality. The ECGRC  will notify the JHS when 
certification is complete. The JHS will notify the technician of certification status. 
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A-1 

Appendix 1 Minnesota Code 1982 
 
 
Q and QS Patterns 
(Do not code in the presence of WPW code 6-4-1.)   To qualify as a Q-wave, the deflection should be 
at least  0.1  mV (1 mm in amplitude). 
 

Anterolateral site (leads I, aVL, V6) 
1-1-1 Q/R amplitude ratio => 1/3, plus Q duration =>0.03 sec in lead I or V6. 
1-1-2 Q duration => 0.04 sec in lead I or V6. 
1-1-3 Q duration => 0.04 sec, plus R amplitude => 3 mm in lead a VL. 
1-2-1 Q/R amplitude ratio => 1/3, plus Q duration => 0.02 sec and < 0.03 sec in lead I or V6. 
1-2-2 Q duration => 0.03 sec and < 0.04 sec in lead I or V6. 
1-2-3 QS pattern in lead I.  Do not code in the presence of 7-1-1. 
1-2-8 Initial R amplitude decreasing to 2 mm or less in every beat (and absence of codes 3-2, 7-1-

1, 7-2-1, or 7-3 between V5 and V6.  (All beats in lead V5 must have an initial R > 2 mm.) 
1-3-1 Q/R amplitude ratio =>1/5 and < 1/3, plus Q duration => 0.02 sec and < 0.03 sec in lead I or 

V6. 
1-3-3 Q duration => 0.03 sec and < 0.04 sec, plus R amplitude => 3 mm in lead aVL. 
 

Posterior (inferior) site (leads II, III, aVF) 
1-1-1 Q/R amplitude ratio => 1/3, plus Q duration => 0.03 sec in lead II. 
1-1-2 Q duration =>0.04 sec in lead II. 
1-1-4 Q duration => 0.05 sec in lead III, plus a Q-wave amplitude => 1.0 mm in the majority of 

beats in lead aVF. 
1-1-5 Q duration => 0.05 sec in lead aVF. 
1-2-1 Q/R amplitude ratio => 1/3, plus Q duration => 0.02 sec and < 0.03 sec in lead II. 
1-2-2 Q duration =>0.03 sec and < 0.04 sec in lead II. 
1-2-3 QS pattern in lead II. Do not code in the presence of 7-1-1. 
1-2-4 Q duration =>0.04 sec and < 0.05 sec in lead III, plus a Q-wave => 1.0 mm amplitude in the 

majority of beats in aVF. 
1-2-5 Q duration => 0.04 sec and < 0.05 sec in lead aVF. 
1-2-6 Q amplitude => 5.0 mm in leads III or aVF. 
1-3-1 Q/R amplitude ratio => 1/5 and < 1/3, plus Q duration => 0.02 sec and < 0.03 sec in lead II. 
1-3-4 Q duration => 0.03 sec and < 0.04 sec in lead III, plus a Q-wave => 1.0 mm amplitude in the 

majority of beats in lead aVF. 
1-3-5 Q duration => 0.03 sec and < 0.04 sec in lead aVF. 
1-3-6 QS pattern in each of leads III and aVF.  (Do not code in the presence of 7-1-1.) 
 

Anterior site (leads V1, V2, V3, V4, V5) 
1-1-1 Q/R amplitude ratio => 1/3 plus Q duration => 0.03 sec in any of leads V2, V3, V4, V5. 
1-1-2 Q duration => 0.04 sec in any of leads V1, V2, V3, V4, V5. 
1-1-6 QS pattern when initial R-wave is present in adjacent lead to the right on the chest, in any of 

leads V2, V3, V4,V5, V6. 
1-1-7 QS pattern in all of leads V1-V4 or V1-V5. 
1-2-1 Q/R amplitude ratio => 1/3, plus Q duration => 0.02 sec and < 0.03 sec, in any of leads V2, 

V3, V4, V5. 
1-2-2 Q duration => 0.03 sec and < 0.04 sec in any of leads V2, V3, V4, V5. 
1-2-7 QS pattern in all of leads V1, V2, and V3.  (Do not code in the presence of 7-1-1). 
1-2-8 Initial R amplitude decreasing to 2.0 mm or less in every beat (and absence of codes 3-2, 7-

1-1, 7-2-1, or 7-3) between any of leads V2 and V3, V3 and V4, or V4 and V5.  (All beats in the 
lead immediately to the right on the chest must have an initial R > 2 mm.) 

1-3-1 Q/R amplitude ratio => 1/5 and < 1/3 plus Q duration => 0.02 and < 0.03 sec in any of leads 
V2, V3, V4, V5. 

1-3-2 QS pattern in lead V1 and V2.  (Do not code in the presence of 3-1 or 7-1-1.) 
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QRS Axis Deviation 
(Do not code in presence of low-voltage QRS, code 9-1, WPW 6-4-1, ventricular conduction defects, 
or 7-1-1, 7-2-1, and 7-4.) 
 
2-1 Left.  QRS axis from -300 through -900 in leads I, II, III.  (The algebraic sum of major positive 

and major negative QRS waves must be zero or positive in I, negative in III, and zero or 
negative in II.) 

2-2 Right.  QRS axis from +1200 through -1500 in leads I, II, III. (The algebraic sum of major 
positive and major negative QRS waves must be negative in I, and zero or positive in III, and 
in I must be one-half or more of that in III.) 

2-3 Right (optional code when 2-2 is not present).  QRS axis from +900 through +1190 in leads I, 
II, III.  (The algebraic sum of major positive and major negative QRS waves must be zero or 
negative in I and positive in II and III.) 

2-4 Extreme axis deviation (usually S1, S2, S3 pattern).  QRS axis from -900 through -1490 in 
leads I, II, and III  (The algebraic sum of major positive and major negative QRS waves must 
be negative in each of leads I, II, and III.) 

2-5 Indeterminate axis QRS axis approximately 900 from the frontal plane.  (The algebraic sum of 
major positive and major negative QRS waves is zero in each of leads I, II and III, or the 
information from these three leads is incongruous.) 

 
High Amplitude R Waves 
3-1 Left:  R amplitude > 26 mm in either V5 or V6, or R amplitude > 20.0 mm in any of leads I, II, 

III, aVF, or R amplitude > 12.0 mm in lead aVL measured only on second to last complete 
normal beat. 

3-2 Right: R amplitude => 5.0 mm and R amplitude => S amplitude in the majority of beats in 
lead V1, when S amplitude is > R amplitude somewhere to the left on the chest of V1 (codes 
7-3 and 3-2, if criteria for both are present). 

3-3 Left (optional code when 3-1 is not present):  R amplitude > 15.0 mm but => 20.0 mm in lead 
I, or R amplitude in V5 or V6, plus S amplitude in V1 > 35.0 mm. 

3-4 Criteria for 3-1 and 3-2 both present. 
 
ST Junction (J) and Segment Depression 
(Do not code in the presence of codes 6-4-1, 7-1-1, 7-2-1 or 7-4.  When 4-1, 4-2, or 4-3 is coded, 
then a 5-code must also be assigned except in lead V1.) 
 

Anterolateral site (leads I, aVL, V6) 
4-1-1 STJ depression => 2.0 mm and ST segment horizontal or downward sloping in any of leads I, 

aVL, or V6. 
4-1-2  STJ depression => 1.0 mm but < 2.0 mm, and ST segment horizontal or downward sloping in 

any of leads I, aVL, or V6. 
4-2 STJ depression => 0.5 mm and < 1.0 mm and ST segment horizontal or downward sloping in 

any of leads I, aVL, or V6. 
4-3 No STJ depression as much as 0.5 mm but ST segment downward sloping and segment or 

T-wave nadir => 0.5 mm below P-R baseline, in any of leads I, aVL, or V6. 
4-4 STJ depression => 1.0 mm and ST segment upward sloping or U-shaped, in any of leads I, 

aVL, or V6. 
 

Posterior (inferior) site (leads II, III, aVF) 
4-1-1 STJ depression =>2.0 mm and ST segment horizontal or downward sloping in lead II or aVF. 
4-1-2 STJ depression => 1.0 mm but < 2.0 mm and ST segment horizontal or downward sloping in 

lead II or aVF. 
4-2 STJ depression => 0.5 mm and < 1.0 mm and ST segment horizontal or downward sloping in 

lead II or aVF. 
4-3 No STJ depression as much as 0.5 mm, but ST segment downward sloping and segment or 

T-wave nadir => 0.5 mm below P-R baseline in lead II. 
4-4 STJ depression => 1.0 mm and ST segment upward sloping, or U-shaped, in lead II. 
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A-3 

 
Anterior site (leads V1, V2, V3, V4, V5) 

4-1-1 STJ depression => 2.0 and ST segment horizontal or downward sloping in any of leads V1, 
V2, V3, V4, V5. 

4-1-2 STJ depression => 1.0 mm but < 2.0 mm and ST segment horizontal or downward sloping in 
any of leads V1, V2, V3, V4, V5 

4-2 STJ depression => 0.5 mm and < 1.0 mm and ST segment horizontal or downward sloping in 
any of leads V1, V2, V3, V4, V5. 

4-3 No STJ depression as much as 0.5 mm, but ST segment downward sloping and segment or 
T-wave nadir => 0.5 mm below P-R baseline in any of leads V2, V3, V4, V5. 

4-4 STJ depression => 1.0 mm and ST segment upward sloping or U-shaped in any of leads V1, 
V2, V3, V4, V5. 

 
T-Wave Items 
(Do not code in the presence of code 6-4-1, 7-1-1, 7-2-1 or 7-4.) 
 

Anterolateral site (leads I, aVL, V6) 
5-1 T amplitude negative 5.0 mm or more in ether of leads V6 or in lead aVL when R amplitude is 

=> 5.0 mm. 
5-2 T amplitude negative or diphasic (positive-negative or negative-positive type) with negative 

phase at least 1.0 mm but not as deep as 5.0 mm in lead I or V6, or in lead aVL when R 
amplitude is => 5.0 mm. 

5-3 T amplitude zero (flat), or negative, or diphasic (negative-positive type only) with less than 1.0 
mm negative phase in lead I or V6, or in lead aVL when R amplitude is => 5.0 mm. 

5-4 T amplitude positive and T/R amplitude ratio < 1/20 in any of leads I, aVL, V6;  R wave 
amplitude must be => 10.0 mm. 
 
Posterior (inferior) site (leads II, III, aVF) 

5-1 T amplitude negative 5.0 mm or more in lead II, or in lead aVF when QRS is mainly upright. 
5-2 T amplitude negative or diphasic with negative phase (negative-positive or positive-negative 

type) at least 1.0 mm but not as deep as 5.0 mm in lead II, or in lead aVF when QRS is 
mainly upright. 

5-3 T amplitude zero (flat), or negative, or diphasic (negative-positive type only) with less than 1.0 
mm negative phase in lead II; not coded in lead aVF. 

5-4 T amplitude positive and T/R amplitude ratio < 1/20 in lead II; R wave amplitude must be => 
10.0 mm. 

 
Anterior site (leads V2, V3, V4, V5) 

5-1 T amplitude negative 5.0 mm or more in any of leads V2, V3, V4, V5. 
5-2 T amplitude negative (flat), or diphasic (negative-positive or positive-negative type) with 

negative phase at least 1.0 mm but not as deep as 5.0 mm, in any of leads V2, V3, V4, V5. 
5-3 T amplitude zero (flat), or negative, or diphasic (negative-positive type only) with less than 1.0 

mm negative phase, in any of leads V3, V4, V5. 
5-4 T amplitude positive and T/R amplitude ratio < 1/20 in any of leads V3, V4, V5;  R wave 

amplitude must be => 10.0 mm. 
 
A-V Conduction Defect 
 
6-1 Complete (third degree) A-V block (permanent or intermittent) in any lead.  Atrial and 

ventricular complexes independent, and atrial rate faster than ventricular rate, with ventricular 
rate < 60. 

6-2-1 Mobitz Type II (occurrence of P-wave on time with dropped QRS and T). 
6-2-2 Partial (second degree) A-V block in any lead (2:1 or 3:1 block). 
6-2-3 Wenckebach's Phenomenon (P-R interval increasing from beat to beat until QRS and T 

dropped). 
6-3  P-R (P-Q) interval => 0.22 sec in the majority of beats in any of leads I, II, III, aVL, aVF. 



A-4 

Exam 1 Electrocardiography Manual.doc 

6-4-1 Wolff-Parkinson-White Pattern (WPW), persistent.  Sinus P-wave.  P-R interval < 0.12 sec, 
plus QRS duration => 0.12 sec, plus R peak duration => 0.06 sec, coexisting in the same 
beat and present in the majority of beats in any of leads I, II, aVL, V4, V5, V6.  (6-4-1 
suppresses 1-2-3, 1-2-7, 1-2-8, 1-3-2, 1-3-6, all 3, 4, 5, 9-2, 9-4, 9-5 codes.) 

6-4-2 WPW Pattern, intermittent.  WPW pattern in => 50% of beats in appropriate leads. 
6-5 Short P-R interval.  P-R interval < 0.12 sec in all beats of any two of leads I, II, III, aVL, aVF. 
6-6 Intermittent aberrant atrioventricular conduction.  P-R > 0.12 sec (except in presence of 6-5 

or heart rate greater than 100);  wide QRS complex > 0.12 sec; normal P-wave when most 
beats are sinus rhythm.  (Do not code in the presence of 6-4-2.) 

6-8 Artificial pacemaker. 
 
Ventricular Conduction Defect 
 
7-1-1 Complete left bundle branch block (LBBB).  (Do not code in presence of 6-1, 6-4-1, 6-8, 8-2-1 

or 8-2-2.) QRS duration => 0.12 sec in a majority of beats (of the same QRS pattern) in any 
of leads I, II, III, aVL, aVF, plus R peak duration => 0.06 sec in a majority of beats (of the 
same QRS pattern) in any of leads I, II, aVL, V5, V6.  (7-1 suppresses 1-2-3, 1-2-7, 1-2-8, 1-3-
2, 1-3-6, all 2, 3, 4, 5, 9-2, 9-4, 9-5 codes.  If any other codable Q-wave coexists with the 
LBBB pattern, code the Q and diminish the 7-1-1 code to a 7-4 code.) 

7-1-2 Intermittent left bundle branch block.  Same as 7-1-1 but with presence of normally 
conducted QRS complexes of different shape than the LBBB pattern. 

7-2-1 Complete right bundle branch block (RBBB).  (Do not code in the presence of 6-1, 6-4-1, 6-8, 
8-2-1 or 8-2-2.)  QRS duration => 0.12 sec in a majority of beats (of the same QRS pattern) 
in any of leads I, II, III, aVL, aVF, plus: R' > R in V1 or QRS mainly upright, plus R peak 
duration => 0.06 sec in V1 or V2;  or V2; or S duration > R duration in all beats in lead I or II.   
(7-1 suppresses 1-2-3, 1-2-7, 1-2-8, 1-3-2, 1-3-6, all 2, 3, 4, 5, 9-2, 9-4, 9-5 codes. 

7-2-2 Intermittent right bundle branch block. Same as 7-2-1 but with presence of normally 
conducted QRS complexes of different shape than the RBBB pattern. 

7-3 Incomplete right bundle branch block.  QRS duration < 0.12 sec in each of leads I, II, III, aVL, 
aVF, and R' > R in either of leads V1, V2 .(Code as 3-2 in addition if those criteria are met.  7-
3 suppresses code 1-2-8.) 

7-4 Intraventricular block.  QRS duration => 0.12 sec in a majority of beats in any of leads I, II, III, 
aVL, aVF. (7-4 suppresses all 2, 3, 4, 5, 9-2, 9-4, 9-5 codes.) 

7-5 R-R' pattern in either of leads V1, V2 with R' amplitude => R. 
7-6 Incomplete left bundle branch block.  (Do not code in the presence of any codable Q- or QS-

wave.)  QRS duration => 0.10 sec and < 0.12 in the majority of beats of each of leads I,  aVL,  
and V5 or V6. 

7-7 Left anterior hemiblock (LAH).  QRS duration < 0.12 sec in the majority of beats in leads I, II, 
III, aVL, aVF, plus Q-wave amplitude => 0.25 mm and < 0.03 sec duration in lead I, plus left 
axis deviation of -450 or more negative.  (In presence of 7-2, code 7-8 if axis is  < -450 and the 
Q-wave in lead I meets the above criteria.) 

7-8 Combination of 7-7 and 7-2. 
 
Arrhythmias 
 
8-1-1 Presence of frequent atrial or junctional premature beats (10% or more of recorded 

complexes). 
8-1-2 Presence of frequent ventricular premature beats (10% or more of record complexes). 
8-1-3 Presence of both atrial and/or junctional premature beats and ventricular premature beats (so 

that individual frequencies are < 10% but  combined premature beats are => 10% of 
complexes). 

8-1-4 Wandering atrial pacemaker. 
8-1-5 Presence of 8-1-2 and 8-1-4. 
8-2-1 Ventricular fibrillation or ventricular asystole. 
8-2-2 Persistent ventricular (idioventricular) rhythm. 
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8-2-3 Intermittent ventricular tachycardia.  Three or more consecutive ventricular premature beats 
occurring at a rate => 100.  This includes more persistent ventricular tachycardia. 

8-2-4 Ventricular parasystole (should not be coded in presence of 8-3-1). 
8-3-1 Atrial fibrillation (persistent). 
8-3-2 Atrial flutter (persistent). 
8-3-3 Intermittent atrial fibrillation (code if 3 or more clear-cut, consecutive sinus beats are present 

in any lead). 
8-3-4 Intermittent atrial flutter (code of 3 or more clear-cut, consecutive sinus beats are present in 

any lead). 
8-4-1 Supraventricular rhythm persistent.  QRS duration < 0.12 sec; and absent P-waves or 

presence of abnormal P-waves (inverted or flat in aVF); and regular rhythm. 
8-4-2 Supraventricular tachycardia intermittent.  Three consecutive atrial or junctional premature 

beats occurring at a rate => 100. 
8-5-1 Sinoatrial arrest.  Unexpected absence of P, QRS and T, plus a R-R interval at a fixed 

multiple of the normal interval, + 10%. 
8-5-2 Sinoatrial block.  Unexpected absence of P, QRS and T, preceded by progressive shortening 

of P-P intervals.  (R-R interval at a fixed multiple of the normal interval, + 10%. 
8-6-1 A-V dissociation with ventricular pacemaker (without capture).  Requires: P-P and R-R occur 

at variable rates with ventricular rate as fast as or faster than the atrial rate, plus variable P-R 
intervals, plus no capture beats. 

8-6-2 A-V dissociation with ventricular pacemaker (with capture). 
8-6-3 A-V dissociation with atrial pacemaker (without capture). 
8-6-4 A-V dissociation with atrial pacemaker (with capture). 
8-7 Sinus tachycardia (over 100/min). 
8-8 Sinus bradycardia (under 50/min). 
8-9 Other arrhythmias.  Heart rate may be recorded as a continuous variable. 
 
ST Segment Elevation 
 

Anterolateral site (leads I, aVL, V6) 
9-2 ST segment elevation => 1.0 mm in any of leads I, aVL, V6. 

 
Posterior (inferior) site (leads II, III, aVF) 
9-2 ST segment elevation => 1.0 mm in any of leads II, III, aVF. 

 
Anterior site (leads V1, V2, V3, V4,V5) 
9-2 ST segment elevation =>1.0 mm in lead V5 or ST segment elevation => 2.0 mm in 
any of leads V1, V2, V3, V4. 

 
Miscellaneous Items 
 
9-1 Low QRS amplitude.  QRS peak-to-peak amplitude < 5 mm in all beats in each of leads I, II, 

III, or < 10 mm in all beats in each of leads V1, V2, V3, V4, V5, V6.  (Check calibration before 
coding.) 

9-3  P-wave amplitude => 2.5 mm in any of leads II, III, aVF, in a majority of beats. 
9-4-1 QRS transition zone at V3 or to the right of V3 on the chest.  (Do not code in the presence of 

6-4-1, 7-1-1, 7-2-1 or 7-4.) 
9-4-2 QRS transition zone at V4 or to the left of V4 on the chest. (Do not code in the presence of 6-

4-1, 7-1-1, 7-2-1 or 7-4.) 
9-5 T-wave amplitude > 12 mm in any of leads I, II, III, aVL, aVF, V1, V2, V3, V4, V5, V6.  (Do not 

code in the presence of 6-4-1, 7-1-1, 7-2-1 or 7-4.) 
9-8-1 Technical problems which interfere with coding. 
9-8-2 Technical problems which do not interfere with coding. 
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Incompatible Codes 
The codes in the left column suppress codes in the right column. 
 

Code Suppress this code(s) 

All Q-, QS-codes 7-6 
Q > 0.03 in lead I 7-7 

3-1 1-3-2 
3-2 1-2-8, 7-3 

6-1 All other codes except 8-2 

6-4-1 All other codes 

6-8 All other codes 

7-1-1 1-2-3, 1-2-7, 1-2-8, 1-3-2, 1-3-6, all 2-, 3-, 4-, and 5- 
codes, 7-7, 9-2, 9-4, 9-5 

7-2-1 1-2-8, all 2-, 3-, 4-, and 5-codes, 9-2, 9-4, 9-5 

7-3 1-2-8 

7-4 All 2-, 3-, 4-, and 5-codes, 9-2, 9-4, 9-5 

8-1-2 8-2-4 

8-1-4 8-1-1, 9-3 

8-2-1 All other codes 

8-2-2 All other codes 

8-2-3 8-1-2 

8-3-1 8-1-1, 8-1-2 

8-3-2 6-2-2, 8-1-1, 8-1-2 

8-3-3 8-1-1, 8-1-2 

8-3-4 6-2-2 

8-4-1 6-5 
8-4-1 + heart rate => 140 All other codes except 7-4 or 6-2 

Heart rate > 100 6-5 

8-4-2 8-1-1 

9-1 All 2-codes 
 
 



 

Exam 1 Electrocardiography Manual.doc 

A-7 

Appendix 2 Marquette MAC PC Setup, Entry and Editing 
 
 
The Marquette MAC PC Operator’s Manual gives detailed instructions for Setup, Entry and Editing. A 
few helpful tips specific to the JHS are included here. 
 
Setup: 
 
1. Phone Setup. Many institutions require dialing a 9 to place an outside call. The “=” or “,” gives a 

pause for outside call dialing.  
 
2. Confirmed/Unconfirmed. For the JHS, report formats should be configured as Unconfirmed. 
 
Entry: 
 
To begin entry of a participant’s data, press F1. 
 
1. Patient, Last Name: Enter first 4 letters of last name 

2. Patient, First Name: Enter complete ID, example J123456 

3. Patient ID:  Enter 9 digit ID, example 00J123456 

4. Referred by:   (always blank) 

5. Location Number: Enter “01” 

6. Room Number:  Enter your Technician ID number 

7. Date of Birth  Enter the participants date of birth 

8. Height:   Enter O-V6 measurement in cm (see 2.3.6) 

9. Weight:   Enter O-E measurement in cm (see 2.3.6) 

10. Sex:   Press either F1 (Male) or F2 (Female) 

11. Race: Press F1 (Caucasian), F2 (Black), F3 (Oriental), F4 (Hispanic), or F5 
(More options) 

12. Medication:  (always blank) 
 
Editing: 
 
With Storage on the screen, press: 
 
1. MORE . . . . . . . . . followed by 
2. EDIT . . . . . . . . . .  followed by 
3. PATIENT DATA . .followed by ENTER 
 
The data for each participant in the MAC PC is now displayed, one at a time, on the screen. If you do 
not wish to Edit the currently displayed participant, respond by pressing . . . 
 
4. NO 
 
If you do wish to Edit the currently displayed participant, respond by pressing . . . 
 
5. YES . . . followed by ENTER 
 
You are now shown the selected participant's Last name. 
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6. If no change is to be made, press . . . ENTER 
 
7. If you want to change the Last name, use the Backspace key to erase unwanted characters and 

type in correct ones. Press . . . ENTER. You are now shown the selected participant's First name. 
Make changes to this field as above. (Remember, the First name is made up of your Center Code 
character plus ID number.) You are now shown the selected participant's ID number. Make 
changes to this field as above. To make changes on other participant information, keep pressing 
ENTER until screen displays information wanted and follow above steps. When the last 
participant has been displayed and dealt with, you must now instruct the MAC PC to save any 
changes you have made. 

 
8. You must Press Shift and Fl together . . . followed by 
 
9. PRINT REPORT . . . followed by ENTER 
 
10. Print a directory to be sure correction has been made. You will note corrected ECG moves to 

bottom of directory. This is useful in the case of deleting every tracing except the one 
corrected -- which is then transmitted again. 
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Appendix 3 Example of MAC PC Storage Directory and E-Mail Confirmation of Received 
ECGS 
 
 
MAC-PC Storage Directory     13-JAN-87  14:38 
 
            
ID Name  Date Time Type U/C Cart Loc Site Room Size 
            
000102479 MESS. J102479 12-JAN-87 14:29 ECG U 006 001 006 36 5% 
000102517 PRIN. J102517 12-JAN-87 14:31 ECG U 006 001 006 36 5% 
000102376 ANDE. J104376 12-JAN-87 14:32 ECG U 006 001 006 36 5% 
000102572 CROS. J102572 12-JAN-87 14:33 ECG U 006 001 006 41 5% 
000109087 JONE. J109087* 13-JAN-87 14:35 ECG U 006 001 006 41 5% 
000102402 SMIT. J102402 13-JAN-87 14:36 ECG U 006 001 006 36 5% 
000102402 SMIT. J102402* 13-JAN-87 14:36 ECG U 006 001 006 36 5% 
000109127 BUCK. J109127* 13-JAN-87 14:37 ECG U 006 001 006 41 5% 
 
     8 ECG(s)     41% Used     59% Free 
 
Example Of E-Mail Confirmation of Received ECGS 
 
From: "Bernadette Gloeb"  <gloeb> 
Date: Thu, Apr 27, 2000 11:11 AM 
To: gloeb 
Subject: Confirmation of ECGs received 
 
The following ECGs were received by the Minnesota ECGRC on Wednesday, April 26, 2000. 
 
ID          DATE          TIME 
 
J109087     13-JAN-87     14:35 
J102402     13-JAN-87     14:36 
J109127     13-JAN-87     14:37 
 
Please call the ECG Coding Supervisor, Sean Thomas, at 612-626-9681 if the above list does not 
match the list of ECGs sent on Wednesday, April 26, 2000. 
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Appendix 4 Performance Grade Levels 
 
 

       DRIFT 
PERFORMANCE NOISE          Beat to Beat (µV) 
GRADE LEVEL  µvrms   Overall (mV)       Rest   
 
1   ≤ 30   ≤ 0.7     ≤190 
2   ≤ 60   ≤ 0.8    ≤250 
3   ≤ 90   ≤ 0.9    ≤ 310 
4   ≤ 120   ≤1.0    ≤ 370 
5   > 120    > l.0    > 370   
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Appendix 5 Example Of Record Format For ECG Coding Lab 
 
 
Column Length Description 
PDUR    3 P Duration 
QRSDUR  3 QRS Duration 
TDUR    3 T Duration 
QTDUR   3 QT Duration 
PAXIS   3 P Axis 
QRSAXIS 3 QRS Axis 
TAXIS   3 T Axis 
QTCDUR  3 QTC Duration 
VRATE   3 V Rate 
QAMPI   5 Q Amplitude in lead I   
QAMPII  5 Q Amplitude in lead II  
QAMPIII 5 Q Amplitude in lead III 
QAMPAVR 5 Q Amplitude in lead AVR 
QAMPAVL 5 Q Amplitude in lead AVL 
QAMPAVF 5 Q Amplitude in lead AVF 
QAMPV1  5 Q Amplitude in lead V1  
QAMPV2  5 Q Amplitude in lead V2  
QAMPV3  5 Q Amplitude in lead V3  
QAMPV4  5 Q Amplitude in lead V4  
QAMPV5  5 Q Amplitude in lead V5  
QAMPV6  5 Q Amplitude in lead V6  
RAMPI   5 R Amplitude in lead I   
RAMPII  5 R Amplitude in lead II  
RAMPIII 5 R Amplitude in lead III 
RAMPAVR 5 R Amplitude in lead AVR 
RAMPAVL 5 R Amplitude in lead AVL 
RAMPAVF 5 R Amplitude in lead AVF 
RAMPV1  5 R Amplitude in lead V1  
RAMPV2  5 R Amplitude in lead V2  
RAMPV3  5 R Amplitude in lead V3  
RAMPV4  5 R Amplitude in lead V4  
RAMPV5  5 R Amplitude in lead V5  
RAMPV6  5 R Amplitude in lead V6  
SAMPI   5 S Amplitude in lead I   
SAMPII  5 S Amplitude in lead II  
SAMPIII 5 S Amplitude in lead III 
SAMPAVR 5 S Amplitude in lead AVR 
SAMPAVL 5 S Amplitude in lead AVL 
SAMPAVF 5 S Amplitude in lead AVF 
SAMPV1  5 S Amplitude in lead V1  
SAMPV2  5 S Amplitude in lead V2  
SAMPV3  5 S Amplitude in lead V3  
SAMPV4  5 S Amplitude in lead V4  
SAMPV5  5 S Amplitude in lead V5  
SAMPV6  5 S Amplitude in lead V6  
R1AMPI  5 R' Amplitude in lead I   
R1AMPII 5 R' Amplitude in lead II  
R1AMPIII 5 R' Amplitude in lead III 
R1AMPAV
R 

5 R' Amplitude in lead AVR 

R1AMPAVL 5 R' Amplitude in lead AVL 
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Column Length Description 
R1AMPAVF 5 R' Amplitude in lead AVF 
R1AMPV1 5 R' Amplitude in lead V1  
R1AMPV2 5 R' Amplitude in lead V2  
R1AMPV3 5 R' Amplitude in lead V3  
R1AMPV4 5 R' Amplitude in lead V4  
R1AMPV5 5 R' Amplitude in lead V5  
R1AMPV6 5 R' Amplitude in lead V6  
S1AMPI  5 S' Amplitude in lead I   
S1AMPII 5 S' Amplitude in lead II  
S1AMPIII 5 S' Amplitude in lead III 
S1AMPAV
R 

5 S' Amplitude in lead AVR 

S1AMPAVL 5 S' Amplitude in lead AVL 
S1AMPAVF 5 S' Amplitude in lead AVF 
S1AMPV1 5 S' Amplitude in lead V1  
S1AMPV2 5 S' Amplitude in lead V2  
S1AMPV3 5 S' Amplitude in lead V3  
S1AMPV4 5 S' Amplitude in lead V4  
S1AMPV5 5 S' Amplitude in lead V5  
S1AMPV6 5 S' Amplitude in lead V6  
R11AMPI 5 R'' Amplitude in lead I   
R11AMPII 5 R'' Amplitude in lead II  
R11AMPII 5 R'' Amplitude in lead III 
R11AMPAV 5 R'' Amplitude in lead AVR 
R11AMPAV 5 R'' Amplitude in lead AVL 
R11AMPAV 5 R'' Amplitude in lead AVF 
R11AMPV1 5 R'' Amplitude in lead V1  
R11AMPV2 5 R'' Amplitude in lead V2  
R11AMPV3 5 R'' Amplitude in lead V3  
R11AMPV4 5 R'' Amplitude in lead V4  
R11AMPV5 5 R'' Amplitude in lead V5  
R11AMPV6 5 R'' Amplitude in lead V6  
QRRATI  5 QR Ratio in lead I   
QRRATII 5 QR Ratio in lead II  
QRRATIII 5 QR Ratio in lead III 
QRRATAV
R 

5 QR Ratio in lead AVR 

QRRATAVL 5 QR Ratio in lead AVL 
QRRATAV
F 

5 QR Ratio in lead AVF 

QRRATV1 5 QR Ratio in lead V1  
QRRATV2 5 QR Ratio in lead V2  
QRRATV3 5 QR Ratio in lead V3  
QRRATV4 5 QR Ratio in lead V4  
QRRATV5 5 QR Ratio in lead V5  
QRRATV6 5 QR Ratio in lead V6  
RSRATI  5 RS Ratio in lead I   
RSRATII 5 RS Ratio in lead II  
RSRATIII 5 RS Ratio in lead III 
RSRATAV
R 

5 RS Ratio in lead AVR 

RSRATAVL 5 RS Ratio in lead AVL 
RSRATAVF 5 RS Ratio in lead AVF 
RSRATV1 5 RS Ratio in lead V1  
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Column Length Description 
RSRATV2 5 RS Ratio in lead V2  
RSRATV3 5 RS Ratio in lead V3  
RSRATV4 5 RS Ratio in lead V4  
RSRATV5 5 RS Ratio in lead V5  
RSRATV6 5 RS Ratio in lead V6  
TRANGI  5 T Range in lead I   
TRANGII 5 T Range in lead II  
TRANGIII 5 T Range in lead III 
TRANGAV
R 

5 T Range in lead AVR 

TRANGAVL 5 T Range in lead AVL 
TRANGAV
F 

5 T Range in lead AVF 

TRANGV1 5 T Range in lead V1  
TRANGV2 5 T Range in lead V2  
TRANGV3 5 T Range in lead V3  
TRANGV4 5 T Range in lead V4  
TRANGV5 5 T Range in lead V5  
TRANGV6 5 T Range in lead V6  
PxAMPI  5 P+ Amplitude in lead I   
PxAMPII 5 P+ Amplitude in lead II  
PxAMPIII 5 P+ Amplitude in lead III 
PxAMPAVR 5 P+ Amplitude in lead AVR 
PxAMPAVL 5 P+ Amplitude in lead AVL 
PxAMPAVF 5 P+ Amplitude in lead AVF 
PxAMPV1 5 P+ Amplitude in lead V1  
PxAMPV2 5 P+ Amplitude in lead V2  
PxAMPV3 5 P+ Amplitude in lead V3  
PxAMPV4 5 P+ Amplitude in lead V4  
PxAMPV5 5 P+ Amplitude in lead V5  
PxAMPV6 5 P+ Amplitude in lead V6  
PRDURI  5 PR Duration in lead I   
PRDURII 5 PR Duration in lead II  
PRDURIII 5 PR Duration in lead III 
PRDURAV
R 

5 PR Duration in lead AVR 

PRDURAV
L 

5 PR Duration in lead AVL 

PRDURAV
F 

5 PR Duration in lead AVF 

PRDURV1 5 PR Duration in lead V1  
PRDURV2 5 PR Duration in lead V2  
PRDURV3 5 PR Duration in lead V3  
PRDURV4 5 PR Duration in lead V4  
PRDURV5 5 PR Duration in lead V5  
PRDURV6 5 PR Duration in lead V6  
QRS_I   5 QRS- Amplitude in lead I   
QRS_II  5 QRS- Amplitude in lead II  
QRS_III 5 QRS- Amplitude in lead III 
QRS_AVR 5 QRS- Amplitude in lead AVR 
QRS_AVL 5 QRS- Amplitude in lead AVL 
QRS_AVF 5 QRS- Amplitude in lead AVF 
QRS_V1  5 QRS- Amplitude in lead V1  
QRS_V2  5 QRS- Amplitude in lead V2  
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Column Length Description 
QRS_V3  5 QRS- Amplitude in lead V3  
QRS_V4  5 QRS- Amplitude in lead V4  
QRS_V5  5 QRS- Amplitude in lead V5  
QRS_V6  5 QRS- Amplitude in lead V6  
QRSxI   5 QRS+ Amplitude in lead I   
QRSxII  5 QRS+ Amplitude in lead II  
QRSxIII 5 QRS+ Amplitude in lead III 
QRSxAVR 5 QRS+ Amplitude in lead AVR 
QRSxAVL 5 QRS+ Amplitude in lead AVL 
QRSxAVF 5 QRS+ Amplitude in lead AVF 
QRSxV1  5 QRS+ Amplitude in lead V1  
QRSxV2  5 QRS+ Amplitude in lead V2  
QRSxV3  5 QRS+ Amplitude in lead V3  
QRSxV4  5 QRS+ Amplitude in lead V4  
QRSxV5  5 QRS+ Amplitude in lead V5  
QRSxV6  5 QRS+ Amplitude in lead V6  
JAMPI   5 J Amplitude in lead I   
JAMPII  5 J Amplitude in lead II  
JAMPIII 5 J Amplitude in lead III 
JAMPAVR 5 J Amplitude in lead AVR 
JAMPAVL 5 J Amplitude in lead AVL 
JAMPAVF 5 J Amplitude in lead AVF 
JAMPV1  5 J Amplitude in lead V1  
JAMPV2  5 J Amplitude in lead V2  
JAMPV3  5 J Amplitude in lead V3  
JAMPV4  5 J Amplitude in lead V4  
JAMPV5  5 J Amplitude in lead V5  
JAMPV6  5 J Amplitude in lead V6  
TxAMPI  5 T+ Amplitude in lead I   
TxAMPII 5 T+ Amplitude in lead II  
TxAMPIII 5 T+ Amplitude in lead III 
TxAMPAVR 5 T+ Amplitude in lead AVR 
TxAMPAVL 5 T+ Amplitude in lead AVL 
TxAMPAVF 5 T+ Amplitude in lead AVF 
TxAMPV1 5 T+ Amplitude in lead V1  
TxAMPV2 5 T+ Amplitude in lead V2  
TxAMPV3 5 T+ Amplitude in lead V3  
TxAMPV4 5 T+ Amplitude in lead V4  
TxAMPV5 5 T+ Amplitude in lead V5  
TxAMPV6 5 T+ Amplitude in lead V6  
T_AMPI  5 T- Amplitude in lead I   
T_AMPII 5 T- Amplitude in lead II  
T_AMPIII 5 T- Amplitude in lead III 
T_AMPAVR 5 T- Amplitude in lead AVR 
T_AMPAVL 5 T- Amplitude in lead AVL 
T_AMPAVF 5 T- Amplitude in lead AVF 
T_AMPV1 5 T- Amplitude in lead V1  
T_AMPV2 5 T- Amplitude in lead V2  
T_AMPV3 5 T- Amplitude in lead V3  
T_AMPV4 5 T- Amplitude in lead V4  
T_AMPV5 5 T- Amplitude in lead V5  
T_AMPV6 5 T- Amplitude in lead V6  
T_xI    5 T-+ in lead I   
T_xII   5 T-+ in lead II  
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Column Length Description 
T_xIII  5 T-+ in lead III 
T_xAVR  5 T-+ in lead AVR 
T_xAVL  5 T-+ in lead AVL 
T_xAVF  5 T-+ in lead AVF 
T_xV1   5 T-+ in lead V1  
T_xV2   5 T-+ in lead V2  
T_xV3   5 T-+ in lead V3  
T_xV4   5 T-+ in lead V4  
T_xV5   5 T-+ in lead V5  
T_xV6   5 T-+ in lead V6  
QDURI   5 Q Duration in lead I   
QDURII  5 Q Duration in lead II  
QDURIII 5 Q Duration in lead III 
QDURAVR 5 Q Duration in lead AVR 
QDURAVL 5 Q Duration in lead AVL 
QDURAVF 5 Q Duration in lead AVF 
QDURV1  5 Q Duration in lead V1  
QDURV2  5 Q Duration in lead V2  
QDURV3  5 Q Duration in lead V3  
QDURV4  5 Q Duration in lead V4  
QDURV5  5 Q Duration in lead V5  
QDURV6  5 Q Duration in lead V6  
RPKDI   5 R Peak Duration in lead I   
RPKDII  5 R Peak Duration in lead II  
RPKDIII 5 R Peak Duration in lead III 
RPKDAVR 5 R Peak Duration in lead AVR 
RPKDAVL 5 R Peak Duration in lead AVL 
RPKDAVF 5 R Peak Duration in lead AVF 
RPKDV1  5 R Peak Duration in lead V1  
RPKDV2  5 R Peak Duration in lead V2  
RPKDV3  5 R Peak Duration in lead V3  
RPKDV4  5 R Peak Duration in lead V4  
RPKDV5  5 R Peak Duration in lead V5  
RPKDV6  5 R Peak Duration in lead V6  
MXRDI   5 Maximum R Duration in lead I   
MXRDII  5 Maximum R Duration in lead II  
MXRDIII 5 Maximum R Duration in lead III 
MXRDAVR 5 Maximum R Duration in lead AVR 
MXRDAVL 5 Maximum R Duration in lead AVL 
MXRDAVF 5 Maximum R Duration in lead AVF 
MXRDV1  5 Maximum R Duration in lead V1  
MXRDV2  5 Maximum R Duration in lead V2  
MXRDV3  5 Maximum R Duration in lead V3  
MXRDV4  5 Maximum R Duration in lead V4  
MXRDV5  5 Maximum R Duration in lead V5  
MXRDV6  5 Maximum R Duration in lead V6  
MXSDI   5 Maximum S Duration in lead I   
MXSDII  5 Maximum S Duration in lead II  
MXSDIII 5 Maximum S Duration in lead III 
MXSDAVR 5 Maximum S Duration in lead AVR 
MXSDAVL 5 Maximum S Duration in lead AVL 
MXSDAVF 5 Maximum S Duration in lead AVF 
MXSDV1  5 Maximum S Duration in lead V1  
MXSDV2  5 Maximum S Duration in lead V2  
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Column Length Description 
MXSDV3  5 Maximum S Duration in lead V3  
MXSDV4  5 Maximum S Duration in lead V4  
MXSDV5  5 Maximum S Duration in lead V5  
MXSDV6  5 Maximum S Duration in lead V6  
QRSDI   5 QRS Duration in lead I   
QRSDII  5 QRS Duration in lead II  
QRSDIII 5 QRS Duration in lead III 
QRSDAVR 5 QRS Duration in lead AVR 
QRSDAVL 5 QRS Duration in lead AVL 
QRSDAVF 5 QRS Duration in lead AVF 
QRSDV1  5 QRS Duration in lead V1  
QRSDV2  5 QRS Duration in lead V2  
QRSDV3  5 QRS Duration in lead V3  
QRSDV4  5 QRS Duration in lead V4  
QRSDV5  5 QRS Duration in lead V5  
QRSDV6  5 QRS Duration in lead V6  
QSPTI   5 QS Pattern in lead I   
QSPTII  5 QS Pattern in lead II  
QSPTIII 5 QS Pattern in lead III 
QSPTAVR 5 QS Pattern in lead AVR 
QSPTAVL 5 QS Pattern in lead AVL 
QSPTAVF 5 QS Pattern in lead AVF 
QSPTV1  5 QS Pattern in lead V1  
QSPTV2  5 QS Pattern in lead V2  
QSPTV3  5 QS Pattern in lead V3  
QSPTV4  5 QS Pattern in lead V4  
QSPTV5  5 QS Pattern in lead V5  
QSPTV6  5 QS Pattern in lead V6  
STSLI   5 ST Slope in lead I   
STSLII  5 ST Slope in lead II  
STSLIII 5 ST Slope in lead III 
STSLAVR 5 ST Slope in lead AVR 
STSLAVL 5 ST Slope in lead AVL 
STSLAVF 5 ST Slope in lead AVF 
STSLV1  5 ST Slope in lead V1  
STSLV2  5 ST Slope in lead V2  
STSLV3  5 ST Slope in lead V3  
STSLV4  5 ST Slope in lead V4  
STSLV5  5 ST Slope in lead V5  
STSLV6  5 ST Slope in lead V6  
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Appendix 6 Serial Change Triggers, Definitions and Criteria 
 
 
Minnesota Code Changes which Trigger Serial ECG Comparison 
 
     
 
ECG Item 

 
Criteria Number 

 Minnesota Code 
on Earlier ECG 

Minnesota Code 
on Later ECG 

     
     
     
Q-QS Patterns 1  None of 1-1 to 1-3 1-1 or 1-2 (Except 1-2-8) 
(major) 2  1-3 or 1-2-8 1-1 
     
Q-QS Patterns 3  None of 1-1 to 1-3 1-3 or 1-2-8 
(minor) 4  1-3 or 1-2-8 1-2* 
 5  1-2 (Except 1-2-8) 1-1 
     
T-waves 6  None of 5-1 to 5-3 5-1 or 5-2 
 7  5-3 5-2 or 5-1 
 8  5-2 5-2 or 5-1 
 9  5-1 5-1 
     
ST depression 10  None of 4-1 to 4-2 4-1 to 4-2 
 11  4-2 4-2 or 4-1 
 12  4-1 4-1 
     
ST elevation 13  No 9-2 9-2 
     
     
 
 
Minnesota Code change of any ECG item may occur within any of the following lead groupings: 
anterolateral I, aVL, and V6; posterior II, III, and aVF; anterior V1-V5.  
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Definitions of Electrocardiographic Criteria 
 
The ECG series is assigned the highest category for which criteria are met, i.e., Evolving Diagnostic 
ECG patterns are greater than Diagnostic ECG patterns are greater than Evolving ST-T patterns are 
greater than Equivocal ECG patterns are greater than Other are greater than Uncodable.  
 
Evolving ECG Patterns (Evolving Diagnostic and Evolving ST-T): 
 
A. Two or more recordings are needed for these classifications.  
 
B. Changes must occur within lead groups i.e., lateral (I, aVL, V6), inferior (II, III, aVF), or 

anterior (V1- V5). 
 
C. Changes must be confirmed for codes by Serial ECG comparison. 
  

To be considered Evolving Diagnostic (pattern ED3) both the l-2-4 and the 5-2 must be 
determined to be Significant Increase by Serial Change rules. If the l-2-4 change is not 
Significant Increase and the 5-2 change is Significant Increase, then the change would fit 
Evolving ST-T (pattern EV3). If the 5-2 change is not Significant Increase, then the pattern 
would be Diagnostic ECG (pattern Dl) because of the 1-2-4,regardless of whether or not the l-
2-4 change is Significant Increase. The complexity of this algorithm precludes determination 
by Minnesota Coders. Determination is made by computer algorithm. 

 
D. The reference ECG for Cohort Field Center Visits is the ECG taken during the first visit. The 

reference ECG for Cohort Hospital ECGs or Surveillance Hospital ECGs is the earliest ECG 
of that hospitalization. 

 
E. Serial ECG Significant Decrease is determined only for cohort hospital ECGs and only for 4-, 

5- and 9-2 codes. 
 
 
Definition of Terms: 
 
No Q Code – No 1-x-x or 1-2-6 
Diagnostic Q Code – Minnesota  Codes 1-1-1 through 1-2-5 plus 1-2-7 
Equivocal Q Code – Minnesota Code 1-2-8 or any 1-3-x code  
Major ST-Segment Depression – Minnesota Code 4-1-1, 4-1-2, or 4-2 
Major T-Wave Inversion – Minnesota Code 5-1 or 5-2 
St-Segment Elevation – Minnesota Code 9-2 
 



 

Exam 1 Electrocardiography Manual.doc 

A-21 

Evolving Diagnostic ECG: 
 
EDl. No Q-code in reference ECG followed by a record with a Diagnostic Q-code (Minn. code l-l-l 

through l-2-5 plus l-2-7) OR any code l-3-x in reference ECG followed by a record with any 
code l-l-x. 

 
ED2. An Equivocal Q-code [(Minn. code l-2-8 in the absence of 7-2-l or 7-4) or any l-3 code] and no 

major ST-segment depression in reference ECG followed by a record with a Diagnostic Q-
code PLUS a major ST-segment depression (Minn. code 4-l-x or 4-2). 

 
ED3. An Equivocal Q-code and no major T-wave inversion in reference ECG followed by a record 

with a Diagnostic Q-code PLUS a major T-wave inversion (Minn. code 5-l or S-2). 
 
ED4. An Equivocal Q-code and no ST-segment elevation in reference ECG followed by a record 

with a Diagnostic Q-code PLUS an ST segment elevation (Minn. code 9-2). 
 
ED5. No Q-code and neither 4-l-x nor 4-2 in reference ECG followed by a record with an Equivocal 

Q-code PLUS 4-l-x or 4-2. 
 
ED 6. No Q-code and neither 5-l nor 5-2 in reference ECG followed by a record with an Equivocal 

Q-code PLUS a 5-l or 5-2. 
 
ED7. No Q-code and no 9-2 in reference ECG followed by a record with an Equivocal Q-code 

PLUS a 9-2. 
 
Evolving ST-T Pattern:  
(This diagnosis cannot be assigned if a 7-l-l or 7-2-l or 7-4 code is present) 
 
EVl. Either 4-O (no 4-code), 4-4 or 4-3 in reference ECG followed by a record with 4-2 or 4-l-2 or 

4-l-l (confirmed by Significant Increase) OR, for hospital ECGs only, 4-2, 4-l-2 or 4-l-l in 
reference ECG followed by a record with 4-0, 4-4 or 4-3 (confirmed by Significant Decrease),  

PLUS 

either no Q-code in both the reference ECG and the follow-up ECG OR Q-code(s) present in 
reference ECG or follow-up ECG but no Significant Increase in Q-code found. 

 
EV2. Either 4-2 or 4-l-2 in reference ECG followed by a record with 4-l-l (confirmed by Significant 

Increase) OR, for hospital ECGs only, 4-l-l in reference ECG followed by a record with 4-2 or 
4-l-2 (confirmed by Significant Decrease),  

PLUS 

either no Q-code in both the reference ECG and the follow-up ECG OR Q-code(s) present in 
reference ECG or follow-up ECG but no Significant Increase in Q-code found. 

 
EV3. Either S-0, 5-4 or 5-3 in reference ECG followed by a record with 5-2 or 5-l (confirmed by 

Significant Increase) OR, for hospital ECGs only, 5-2 or 5-l in reference ECG followed by a 
record with S-0, 5-4 or 5-3 (confirmed by Significant Decrease),  

PLUS 

either no Q-code in both the reference ECG and the follow-up ECG OR Q-code(s) present in 
reference ECG or follow-up ECG but no Significant Increase in Q-code found. 

 
EV4. Code 5-2 in reference ECG followed by a record with 5-l (confirmed by Significant Increase) 

OR, for hospital ECGs only, 5-l in reference ECG followed by A record with 5-2 (confirmed by 
Significant Decrease),  
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PLUS 

either no Q-code in both the reference ECG and the follow-up ECG OR Q-code(s) present in 
reference ECG or follow-up ECG but no Significant Increase in Q-code found. 

 
EV5. Code 9-O in reference ECG followed by a record with 9-2 (confirmed by Significant Increase) 

OR 9-2 in reference ECG followed by a record with 9-O (confirmed by Significant Decrease),  

PLUS 

either no Q-code in both the reference ECG and the follow-up ECG OR Q-code(s) present in 
reference ECG or follow-up ECG but no Significant Increase in Q-code found. 

 
EV6. Code 4-l in reference ECG followed by a record with 4-l (confirmed by Significant Increase) 

OR, for hospital ECGs only, 4-l in reference ECG followed by a record with 4-l (confirmed by 
Significant Decrease),  

PLUS 

either no Q-code in both the reference ECG and the follow-up ECG or Q-code(s) present in 
reference ECG or follow-up ECG but no Significant Increase in Q-code found. 

 
EV7. Code 5-l-l in reference ECG followed by a record with 5-l-l (confirmed by Significant Increase) 

OR, for hospital ECGs only, 5-l-l in reference ECG followed by a record with 5-l-l (confirmed 
by Significant Decrease),  

PLUS 

either no Q-code in both the reference ECG and the follow-up ECG or Q-code(s) present in 
reference ECG or follow-up ECG but no Significant Increase in Q-code found. 

 
EV8. Code 5-l-2 in reference ECG followed by a record with 5-l-2 (confirmed by Significant 

Increase) OR, for hospital ECGs only, 5-l-2 in reference ECG followed by a record with 5-l-2 
(confirmed by Significant Decrease),  

PLUS 

either no Q-code in both the reference ECG and the follow-up ECG or Q-code(s) present in 
reference ECG or follow-up ECG but no Significant Increase in Q-code found. 

 
Diagnostic ECG:  
(any ECG may be used for this classification) 
 
Dl. An ECG record with any Diagnostic Q-code (Minn. code l-l-l through l-2-5 plus l-2-7). 
 
D2. An ECG record with ST-segment elevation code 9-2 PLUS (T-wave inversion code 5-l or 5-2 

in the absence of 7-2-l or 7-4). 
 
 
Equivocal ECG:  
(any ECG may be used for this classification) 
 
El. An ECG record with an Equivocal Q-code [(Minn. code l-2-8 in the absence of 7-2-l or 7-4) or 

(any l-3 code)]. 
 
E2. An ECG record with ST-segment depression (code 4-l-x or 4-2 or 4-3 in the absence of 7-2-l 

or 7-4). 
 
E3. An ECG record with T-wave inversion (code 5-l or 5-2 or 5-3 in the absence of 7-2-l or 7-4). 
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E4. An ECG record with ST-segment elevation code 9-2. 
 
Other ECG: 
 
01. Reference ECG coded 7-l-l. 
 
02. Any ECG coded 7-l-l. 
 
03. Normal ECG(s), defined as 1 in "clear" field of all ECGs. 
 
04. Other findings including l-2-6. 
 
Uncodable ECG: 
 
Ul. Technical errors coded 9-8-l by Minnesota Code. 
 
Absent ECG: 
 
Al. No ECG available for coding. 
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Criteria for Determining Significant ECG Pattern Change 
 
 
Event ECG 
Minnesota Code 
Q-Code Comparison Rules for Determining Significant ECG Pattern Change 
 
1-1-1 Requires => 50% increase in event Q/R ratio or => 1 mm initial R-wave amplitude decrease 

in event ECG compared with corresponding lead(s) of baseline ECG.  If no Q-wave in 
baseline ECG, event record must have codable Q-wave. 

 
1-1-2 Requires => 50% decrease in event ECG Q/R ratio and => 1.5 mm initial R-wave amplitude 

decrease in event ECG compared with corresponding lead(s) of baseline ECG.  If no Q-wave 
in baseline ECG, event record must have codable Q- wave.  New appearance of QS complex 
in leads to the left of V1 when V1 does not show change will also be judged as positive 
evidence of new infarction. 

 
1-1-3 Required > 75% increase in event ECG Q/R ratio or => 1 mm initial R-wave amplitude 

decrease in event ECG compared with corresponding lead(s) of baseline ECG.  If no Q wave 
in baseline ECG, event record must have codable Q-wave. 

 
1-1-4 Requires => 50% increase in event ECG Q/R ratio or => 1 mm initial R-wave amplitude 

decrease in event ECG compared with corresponding lead(s) of baseline ECG.  If no Q-wave 
in baseline ECG, event record must have codable Q-wave. 

 
1-1-5 Requires => 50% increase in event ECG Q/R ratio or => 1 mm initial R-wave amplitude 

decrease in event ECG compared with corresponding lead(s) of baseline ECG.  If no Q-wave 
in baseline ECG, event record must have codable Q-wave. 

 
1-1-6 Requires => 1 mm decrease in event ECG initial R-wave amplitude compared with 

corresponding lead(s) of baseline ECG.  If no QS-wave in baseline ECG, event record must 
have codable QS-wave. 

 
1-1-7 Requires => 1 mm decrease in event ECG initial R-wave compared with corresponding 

lead(s) of baseline ECG.  If no QS-wave in baseline ECG, event record must have codable 
QS-wave. 

 
1-2-1 Requires => 50% increase in event ECG Q/R ratio or => 1 mm initial R-wave amplitude 

decrease in event ECG compared with corresponding lead(s) of baseline ECG.  If no Q-wave 
in baseline ECG, event records must have codable Q-wave. 

 
1-2-2 Requires => 50% increase in event ECG Q/R ratio or => 1 mm initial R-wave amplitude 

decrease in event ECG compared with corresponding lead(s) of baseline ECG.  If no Q-wave 
in baseline ECG, event record must have codable Q-wave. 

 
1-2-3 Requires => 1 mm decrease in event ECG initial R-wave amplitude compared with 

corresponding lead(s) of baseline ECG.  If no QS-wave in baseline ECG, event record must 
have codable QS-wave. 

 
1-2-4 Requires => 50% increase in event ECG Q/R ratio or => 1 mm initial R-wave  amplitude 

decrease in event ECG compared with corresponding lead(s) of baseline ECG.  If no Q-wave 
in baseline ECG, event record must have codable Q-wave. 

 
1-2-5 Requires => 50% increase in event ECG Q/R ratio or => 1 mm initial R-wave amplitude 

decrease in event compared with corresponding lead(s) of baseline ECG.  If no Q-wave in 
baseline ECG, event record must have codable Q-wave. 
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1-2-6 Requires => 75% increase in event ECG Q/R ratio plus the appearance of a codable and 

new Q-wave in aVF OR => 1 mm initial R-wave amplitude decrease in event ECG plus the 
appearance of a new codable Q-wave in aVF compared with corresponding lead(s) of 
baseline ECG. 

 
1-2-7 Requires => 1 mm decrease in event ECG initial R-wave amplitude compared with   

corresponding lead(s) of baseline ECG.  If no QS-wave in baseline ECG, event record must 
have codable QS-wave. 

 
1-2-8 Requires => 1 mm decrease in event ECG initial R-wave amplitude in the “lead to the left” 

compared with corresponding lead(s) of baseline ECG. 
 
1-3-1 Requires => 50% increase in event ECG Q/R ratio or => 1 mm initial R-wave  amplitude 

decrease in event ECG compared with corresponding lead(s) of baseline ECG.  If no Q-wave 
in baseline ECG, event record must have codable Q-wave. 

 
1-3-2 Requires => 1 mm decrease in event ECG initial R-wave amplitude compared with 

corresponding lead(s) of baseline ECG.  If no QS-wave in baseline ECG, event record must 
have codable QS-wave. 

 
1-3-3 Requires => 50% increase in event ECG Q/R ratio or => 1 mm initial R-wave amplitude 

decrease in event ECG compared with corresponding lead(s) of baseline ECG.  If no Q-wave 
in baseline ECG, event record must have codable Q-wave. 

 
1-3-4 Requires => 50% increase in event ECG Q/R ratio or => 1 mm initial R-wave amplitude 

decrease in event ECG compared with corresponding lead(s) of baseline ECG.  If no Q-wave 
i baseline ECG, event record must have a codable Q-wave. 

 
1-3-5 Requires => 50% increase in event ECG Q/R ratio or => 1 mm initial R-wave amplitude 

decrease in event ECG compared with corresponding lead(s) of baseline ECG.  If no Q-wave 
in baseline ECG, event record must have a codable Q-wave. 

 
1-3-6 Requires => 1 mm decrease in event ECG initial R-wave amplitude compared with 

corresponding lead(s) of baseline ECG.  If no QS-wave in baseline ECG, event record must 
have a codable QS-wave. 

 
ST Elevation Code 
 
9-2 Requires baseline record have no 9-2 code, or there is 100% change in event ECG ST 

elevation compared with corresponding lead(s) of baseline ECG. 
 
ST Depression Code 
 
4-1 Requires baseline record have no 4-1 or 4-2, or there is a 100% change in event ECG ST 

segment depression. 

OR 

4-2 Requires baseline record have no 4-1 or 4-2 codes, or there is 100% change in event  ECG 
ST segment depression. 
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T-wave Inversion Code 
 
5-1 Requires comparison record have no T-wave inversion codes, or there is  100% change (as 

in 9-2 codes) in T-wave inversion. 

OR 

5-2 Requires comparison record have no T-wave inversion codes, or there is 100% change (as in 
9-2 codes) in T-wave inversion. 

 
Conduction Delay Codes 
 
7-1-1, 7-2-1, Requires new 7-1-1, 7-2-1 or 7-4 code in event ECG with a QRS duration 
7-4 increased by 0.02 sec in event ECG compared with baseline ECG. 
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Appendix 7 Crow Papers on Serial Comparison 1989 and 1997 
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Appendix 8 Proposed JHS Dx Criteria for Hospitalized MI Incl. Chest Pain, ECG & Enzymes 
 
    
Cardiac Pain ECG Findings Enzymes Diagnosis 
    
Present Evolving Diagnostic Abnormal Definite MI 
 ECG Pattern (ED1-ED7) Equivocal Definite MI 
  Incomplete Definite MI 
  Normal Definite MI 
    
 Diag. ECG Pattern Abnormal Definite MI 
  Equivocal Probable MI 
  Incomplete Suspect MI 
  Normal No MI 
    
 Evolving ST-T Pattern Abnormal Definite MI 
 (EV1 - EV9) Equivocal Probable MI 
  Incomplete Suspect MI 
  Normal No MI 
    
 Equivocal ECG Pattern Abnormal Definite MI 
  Equivocal Probable MI 
  Incomplete No MI 
  Normal No MI 
    
 Absent, Uncodable, Abnormal Probable MI 
 or other Equivocal Suspect MI 
  Incomplete No MI 
  Normal No MI 
    
    
Not Present, Evolving Diagnostic Abnormal Definite MI,  
Unknown or ECG Pattern (ED1-ED7) Equivocal Definite MI 
Missing  Incomplete Definite MI 
  Normal Definite MI 
    
 Diag. ECG Pattern  Abnormal Definite MI 
  Equivocal Suspect MI 
  Incomplete No MI 
  Normal No MI 
    
 Evolving ST-T Pattern Abnormal Probable MI 
 (EV1 - EV9) Equivocal Suspect MI 
  Incomplete No MI 
  Normal No MI 
    
 Equivocal ECG Pattern Abnormal Suspect MI 
  Equivocal Suspect MI 
  Incomplete No MI 
  Normal No MI 
    
 Absent, Uncodable Abnormal Suspect MI 
 or other Equivocal No MI 
  Incomplete No MI 
  Normal No MI 
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Diagnostic ECG: 
(any ECG may be used for this classification) 
 
D1. An ECG record with any Diagnostic Q-code (Minn. code 1-1-1 through 1-2-5 plus 1-2 7). 
 
D2. An ECG record with ST-segment elevation code 9-2 PLUS (T-wave inversion code 5-1 or  
 5-2 in the absence of 7-2-1 or 7-4). 
 
Equivocal ECG: 
(any ECG may be used for this classification) 
 
E1. An ECG record with an Equivocal Q-code [(Minn. code 1-2-8 in the absence of a 7-1-1 or  
 7-3 or (any 1-3-code)]. 
 
E2. An ECG record with ST-segment depression (code 4-1-x or 4-2 or 4-3 in the absence of 7  
 2-1 or 7-4). 
 
E3. An ECG record with T-wave inversion (code 5-1 or 5-2 or 5-3 in the absence of 7-2-1 or  
 7-4). 
 
E4. An ECG record with ST-segment elevation code 9-2. 
 
Other ECG: 
 
01. Reference ECG coded 7-1-1. 
 
02. Any ECG coded 7-1-1. 
 
03. Normal ECG(s), defined as 1 in “clear” field of all ECGs. 
 
04. Other findings including 1-2-6. 
 
Uncodable ECG: 
 
U1. Technical errors coded 9-8-1 by Minnesota Code. 
 
Absent ECG: 
 
A1. No ECG available for coding. 
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Appendix 9 Serial Change Example of Minnesota Code 1-2-7 
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Appendix 10 ECG Technician Certification 
 
 
(TO BE FILLED IN BY JACKSON HEART STUDY) 
 
ECG Technician: ___________________________________Technician No.______________ 
 
Date Certification Tracings Taken: _______________________ 
 
INSTRUCTIONS: 
• Obtain three 12-lead resting ECGs as specified in the JHS ECG Procedures.  Write the Technician 
name on the ECG, the Technician number must be printed by the MAC PC next to the word ROOM. 
 
• Send the ECGs and one copy of this form to the JHS ECG Coding Center: 
 
 University of Minnesota 
 Division of Epidemiology 
 JHS Study Coding Center 
 1300 South Second Street, Suite 300 
 Minneapolis, MN 55454-1015 
 
• Notification of the technician’s certification status is made upon receipt of this completed form at the 
MN ECG Coding Center. 
 
(TO BE FILLED IN BY THE MINNESOTA ECG CODING CENTER) 
 
Date Tracings Received:                                                                                                            
 
Comments:                                                                                                                                
                                                                                                                                                 
 
Certified:  YES (   )    NO (   ) 
 
 
____________________________________ _______________________ 
Signature of Certifying Agent    Date 
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Appendix 11 ECG Technician Procedure Review 
 
 
This form is required for ECG technician certification, recertification, and quality control.  It is to be 
completed by the ECG training supervisor by observing the ECG technician taking an ECG recording.  
Quality control observations should occur every six months. 
 
The ECG training supervisor should not make any comments during the recording. 
 
Identifying Information 
  
ECG Technician:    Technician No.    
 
ECG Supervisor:    Technician No.    
 
Date:     Biannually:  January  July 
 
  YES NO COMMENTS 
Subject asked to disrobe to waist only if back-
opening gown worn 

  
(    ) 

 
(    ) 

 

     
Subject instructed to lie on the recording bed 
with arms relaxed at the sides. 

  
(    ) 

 
(    ) 

 

     
Limb leads correctly marked.  (    ) (    )  
     
Electrode areas wiped with alcohol, then with 
a gauze pad. 

  
(    ) 

 
(    ) 

 

     
V2 position correctly marked.  (    ) (    )  
     
V1 position correctly marked.  (    ) (    )  
     
E point position correctly marked.  (    ) (    )  
     
V6 position correctly marked using chest 
square. 

  
(    ) 

 
(    ) 

 

     
E point to V6 measured with tape measure 
and noted on scratch paper. 

  
(    ) 

 
(    ) 
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ECG Technician Procedure Review (continued) 
 
  YES NO COMMENTS 
Participant information entered into the V4 
position correctly marked using tape measure. 

  
(    ) 

 
(    ) 

 

     
V3 position correctly marked using a flexible 
ruler. 

  
(    ) 

 
(    ) 

 

     
V5 position correctly marked using a flexible 
ruler. 

  
(    ) 

 
(    ) 

 

     
Electrodes applied as in steps 3-6.  (    ) (    )  
     
Appropriate lead wire clipped to each 
electrodes. 

  
(    ) 

 
(    ) 

 

     
MAC PC  (    ) (    )  
     
Electrodes and lead wires checked.  (    ) (    )  
     
Subject asked to relax, lie quietly.  (    ) (    )  
     
Electrodes on skin 2-5 minutes before taking 
ECG. 

  
(    ) 

 
(    ) 

 

     
MAC PC display watched for error messages.  (    ) (    )  
     
If error message(s): electrode contacts and 
lead wires checked, display observed again. 

  
(    ) 

 
(    ) 

 

     
If display counts past 45: repeat skin 
preparation using 2 strokes with fine 
sandpaper.  Replace with new electrodes on 
limb leads first, if necessary, replace all 
electrodes. 

  
 

(    ) 

 
 

(    ) 

 

     
ECG tracing removed from the MAC PC.  (    ) (    )  
     
ECG examined for baseline drift, noise, 60-
cycle interference and muscle tremor. 

  
(    ) 

 
(    ) 

 

     
When technically inadequate, ECG re-
recorded until an acceptable recording is 
achieved. 

  
 

(    ) 

 
 

(    ) 

 

     
Electrodes removed.  (    ) (    )  
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Appendix 12 Procedures for MAC PC Calibration Check 
 
 
1. Minnesota ECG Coding Center Procedures 
 
The ECGRC Coding Supervisor manages the sending and receiving of the Marquette ECG simulator. 
The  JHS Clinic receives the simulator once every three months. The simulator is sent via Certified 
Mail, return receipt requested. 
 
Upon receiving a calibration ECG from a Field Center, the Coding Supervisor measures the waves 
required in the Calibration Check form.  If there is wave distortion compared to the ECG taken at the 
ECG Coding Center on February 20, 1987, the Coding Supervisor contacts the Clinic about 
appropriate action. 
 
The Coding Supervisor enters the data and graphs comparisons of wave height at the end of every 
calendar quarter. These results are sent to the JHS. 
 
2.  Jackson Heart Study Procedures 
 
Within two days of receiving the simulator, take one noise-free 12-lead ECG following the instructions 
below. 
 
Instructions for taking a 12-lead ECG using the Marquette ECG Simulator: 
 
1. Make sure the ECG Simulator switch is above "off" unless actually in use. Leaving it "on" 

drains the battery. 
2. Check the battery: push the switch to "test". The yellow light should go on. If it doesn't, 

unscrew the back of the simulator and replace the old battery with the new battery included in 
the mailing. 

3. Remove the adaptor wires (clips) from the lead wire plugs. 
4. Plug each lead wire into the simulator in its proper hole. 
5. Turn the Heart Rate knob all the way to the left so the white line is at the number 68 (as in 

'beats per minute'). Don't try to line up the line with the dot, just turn it all the way left. 
6. Press Fl (PatInfo). 
7. For Last Name: CALIBRATION TEST.  
8. For First Name: Site Number (MN = 5, NC = 6, MD = 7, MS = 8) 
9. For ID number put Technician ID. 
10. Press Return. 
11. Press the STOP symbol when it asks for Referred by: -_ 
12. Now the screen is back to the Main Menu. 
13. Turn on the ECG Simulator or else you will get a flat line! 
14. Press the 12-lead Record key. Machine will take, print and store an ECG. 
15. Turn off the ECG Simulator. 
 
If you have trouble getting a noise-free ECG, try twisting the plugs in their holes and take another 
ECG. Otherwise, there might be something wrong with your Acquisition Module (the white box with all 
the lead wires coming out of it). 
 
1. Phone the ECG Coding Center and we will send you our Acquisition Module. 
2. Try taking another ECG using our module. 
3. If the tracing is better, contact Marquette about replacing your module. 
4. If you are still getting lots of noise, take the appropriate steps to have your machine serviced.. 
 
Do not take a 2-minute rhythm strip using the simulator. 
 
Transmit the Calibration ECG with your next batch to Minnesota. Delete it upon confirmation. 
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Return the simulator and ONLY ONE 12-lead ECG (the best one if you took more than one) 
immediately via Certified Mail, return receipt requested to: 
 
Mr. Sean Thomas 
ECG Coding Center 
Division of Epidemiology, School of Public Health 
1300 South 2nd Street, Suite 300 
Minneapolis, MN 55454 
 
PLEASE PACK THE SIMULATOR VERY CAREFULLY!  
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Calibration Check Form 
Marquette ECG Simulator Measurements 

 

Study: _______________________________________________ 

Location of Clinic: ________________________________ Date of ECG: _________________ 

Type of Electrocardiograph: _______________________________________________ 

Simulator used (circle one): ARIC TOMHS 

 

PAPER SPEED: 

Overall: Measure from the peak of the R of the first complete R-wave in Lead I to the peak of the 6th 
R-wave, (5 intervals). 
__________mm / 5 intervals = __________ = __________ 

 mm/interval Overall HR 

 

Short Term: Measure interval between first and second complete R-waves. 

__________ mm = __________ 

1st interval Short Term HR 

 

PR Duration: Measure the PR duration of 3 beats in Lead II to the nearest 0.25 mm. 

__________ + __________ + __________ / 3 = __________ average PR duration 

 

VOLTAGE CALIBRATION: 

Measure the last 3 complete waves of the lead in question. If there are only 2 complete waves then 
divide by 2, instead of 3, to get the average. The beats themselves do not have to be complete.  
 

R-wave in I: __________ + __________ + __________ / 3 = __________  

R-wave in II: __________ + __________ + __________ / 3 = __________  

R-wave in III: __________ + __________ + __________ / 3 = __________  

Calibration: __________ + __________ + __________ / 3 = __________  

T-wave in II: __________ + __________ + __________ / 3 = __________  

S-wave in V1: __________ + __________ + __________ / 3 = __________  

 

FREQUENCY RESPONSE: 

Compare closely with the ECG taken by the same simulator on the Floater MAC PC on Feb. 20, 
1987. Note especially ST segment distortion. 
 
Satisfactory? (circle one) YES NO (show to Dr. Crow) 

Comment:

 _____________________________________________________________________ 

_____________________________________________________________________ 
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Appendix 13 Sample Shipping Form 
 
 

JACKSON HEART STUDY SHIPPING FORM 
ANCILLARY ECGs 

 
Date shipped: ____________________________ Prepared by: __________________ 
 
Total number of ECGs in shipment: ___________ Telephone: ___________________ 
 
Instructions: 
Please complete this shipping form and include it with your ECG shipment to the Minnesota ECG 
Coding Center. Enter each participant ID, the date shipped, total number of ECGs in the shipment, 
the name and phone number of the person preparing the shipment. Only accurate shipping forms will 
be accepted, others will be returned for correction. 
 
Once the ECGs are received and verified, ECG Coding Center staff will initial and date the form and 
return a copy to the JHS to verify receipt. 
 
# Patient ID  # Patient ID 
1 00J123456 – F  26  
2 00J123456 – T  27  
3 00J123456 – L  28  
4 00J567890 – F  29  
5 00J567890 – L  30  
6 00J135792 - F  31  
7   32  
8   33  
9   34  
10   35  
11   36  
12   37  
13   38  
14   39  
15   40  
16   41  
17   42  
18   43  
19   44  
20   45  
21   46  
22   47  
23   48  
24   49  
25   50  
 
Shipment received by: ______________________ Date: ________________________ 
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FOREWORD 
 
This manual is one of a series of protocols and manuals of operation for the Jackson Heart Study 
(JHS).  The complexity of the JHS requires that a sizeable number of procedures be described, thus 
this rather extensive list of materials has been organized into the set of manuals listed below.  Manual 
1 provides the background, organization, and general objectives of the JHS Study.  Manuals 2 and 10 
describe the operation of the Cohort Procedures, Family Study, and Surveillance Components of the 
study.  Detailed Manuals of Operation for specific procedures, including those of reading centers and 
central laboratories, make up Manuals 4 through 9. The Data Management System is described in 
Manual 11. 
 
 

JHS Study Protocols and Manuals of Operation 
 
 

MANUAL TITLE 
  
1 General Description and Study Management 
  
2 Cohort Component Procedures 
  
3 Family Study 
  
4 Blood Pressure  
  
5 Electrocardiography 
  
6 Echocardiography 
  
7 Ultrasound Assessment 
  
8 Pulmonary Function Assessment 
  
9 Specimen Collection and Processing 
  

10 Cohort Surveillance 
  

11 Data Management System 
 
 
 
 





iii 

Exam 1 Pulmonary Function Assessment Manual.doc 

Manual 8 Pulmonary Function Assessment 
 

Table of Contents 
 

1.0 FORWARD AND CONTACT INFORMATION ............................................................................. 1 

2.0 BACKGROUND ............................................................................................................................ 2 

3.0 DEFINITIONS ............................................................................................................................... 3 

4.0 EQUATIONS ................................................................................................................................. 5 

5.0 METHODS SUMMARY ................................................................................................................ 6 
5.1 Daily Procedures ...................................................................................................................... 6 

5.2 Weekly Procedures .................................................................................................................. 6 

6.0 DESCRIPTION OF THE PF WORKSTATION ............................................................................. 7 
6.1 Main Menu................................................................................................................................ 7 

6.2 Participant Information (Select/Add Patient ) ........................................................................... 8 

7.0 FORCED VITAL CAPACITY TESTING ..................................................................................... 10 
7.1 Preparation ............................................................................................................................. 10 

7.2 FVC Test Steps ...................................................................................................................... 10 

7.3 Review the Results ................................................................................................................ 11 

7.4 End Test Session ................................................................................................................... 14 

7.5 Print Current Test ................................................................................................................... 14 

7.6 Printing Reports ..................................................................................................................... 14 

8.0 LEAK AND CALIBRATION CHECKS ....................................................................................... 15 
8.1 Leak Test................................................................................................................................ 15 

8.2 Volume Calibration Check ...................................................................................................... 15 

8.3 Linearity Check ...................................................................................................................... 16 

9.0 CLEANING THE SPIROMETER ................................................................................................ 17 
9.1 Clean the Breathing Tubes .................................................................................................... 17 

9.2 Clean the Spirometer. ............................................................................................................ 17 

9.3 Calibration Syringe Care ........................................................................................................ 17 

10.0 TECH CERTIFICATION ............................................................................................................. 19 



iv 

Exam 1 Pulmonary Function Assessment Manual.doc 

11.0 QUALITY CONTROL .................................................................................................................. 20 
11.1 Need for Spirometry QC ......................................................................................................... 20 

11.2 Feasibility of QC Procedures .................................................................................................. 20 

11.3 Implementation of QC Procedures ......................................................................................... 20 

12.0 QC ANALYSIS AND REPORTING ............................................................................................ 22 
12.1 Weekly Biologic Control .......................................................................................................... 22 

13.0 ANNUAL INSTRUMENT CHECKS ............................................................................................ 23 

14.0 REFERENCES ............................................................................................................................ 24 

15.0 EQUIPMENT AND SUPPLIES ................................................................................................... 26 

16.0 COMPUTER INTERPRETATION ............................................................................................... 27 
 
 
 



v 

Exam 1 Pulmonary Function Assessment Manual.doc 

Manual 8 Pulmonary Function Assessment 
 

Appendices 
 

Appendix 1 OMIS98 Spirometry Troubleshooting Guide ................................................................ 1 

Appendix 2   Barometric Pressure Values ........................................................................................ 3 

Appendix 3 Quality Check Messages ................................................................................................ 5 
 

 
 
 
 
 
 

 
Figures 

 

Figure 1.  Entry Screen ...................................................................................................................... 9 

Figure 2. Flow-Volume Curves (#1) ............................................................................................... 13 

Figure 3.  Flow-Volume Curves (#2) ............................................................................................... 13 

Figure 4. Flow-Volume Curves (#3) ............................................................................................... 14 
 
 
 





1 

Exam 1 Pulmonary Function Assessment Manual.doc 

 
1.0 FORWARD AND CONTACT INFORMATION 
 
This manual serves three purposes: 

• a study guide for training of nurses and technicians to perform pulmonary function testing 

• a practical "how-to" reference guide to be used during the study 

• documentation of the pulmonary function testing procedures for analyses and manuscript 
preparation. 

 
Contact information for the Pulmonary Function Reading Center (PFRC): 
 

Paul Enright, MD  (520) 626-6415 
The University of Arizona 
Respiratory Sciences Center, Room 2342 
1501 N Campbell Ave 
Tucson, AZ  85724 
(800) 664-7126  FAX 626-6970 
 
Robert Jensen, Ph.D. 
University of Utah 
Pulmonary Division 
LDS Hospital 
8th Avenue and C Street 
Salt Lake City, Utah  84143 
(801) 408-3146 FAX (801) 408-1671 
e-mail: LDRJENS1@IHC.COM 

 
Contact information for instrument & software vendor (software version 3.18.7): 
 

Occupational Marketing, Inc.  
11211 Katy Freeway, Ste. 130. 
Houston, Texas  77079 
(713) 869-6708 
(800) 869-6783 
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2.0 BACKGROUND 
 
Spirometry is the simplest, most effective test for assessment of lung function (1).  That is why it has 
been included in many cardiovascular epidemiology studies, including the Tecumseh, Framingham, 
CARDIA, ARIC, and Honolulu Heart studies (6-10).  Spirometry and maximal respiratory pressures 
(MIP & MEP) were measured during the CHS baseline exam (2); and reference values for the 65-85 
year-old age group were thereby established from the healthy CHS participants (3-4).  The FEV1, 
FVC, and MIP were found to be associated with cardio-pulmonary symptoms, anthropometric 
measures, past exposures, and sub clinical cardiovascular disease (CVD) and overt clinical CVD and 
lung disease (4). 
 
Spirometry, and ambulatory monitoring of peak flows were measured during CHS exam 6 for both the 
original cohort and the new African American participants.  Spirometry reference values were 
reported from the healthy subset of the elderly black participants.  Spirometry (measuring the FEV1 
but not the FVC) will again be repeated during CHS year 9 to determine change in FEV1, and as a 
disease outcome measure.  In addition, a six minute walk with pulse oximetry will be performed. 
 
Spirometry records the relationship between airflow (FEV1) and the exhaled volume of air during a 
breathing maneuver called the FVC maneuver (forced vital capacity maneuver).  The most common 
lung diseases reduce forced expiratory flows.  Such "obstructive" lung diseases include asthma, 
bronchitis, and emphysema.  The ratio of FEV1/FVC is very sensitive for detecting mild airways 
obstruction, such as that due to mild airway inflammation secondary to exposure to cigarette smoke, 
asthma triggers, and mild pulmonary congestion due to CVD. 
 
 



3 

Exam 1 Pulmonary Function Assessment Manual.doc 

3.0 DEFINITIONS 
 
A/D CONVERTER is a small electronic interface card mounted inside the spirometer which changes 
the analog voltages from the spirometer potentiometer and temperature sensor to digital numbers 
that the computer can understand.  These are transferred to the personal computer via the RS-232 
serial interface. 
 
ARCHIVAL FLOPPY DISK is the floppy disk which stores a backup copy of participant test results, to 
be stored at the Field Center in case the PF Workstation's hard disk crashes. 
 
ATPS is the condition of air inside the spirometer - Ambient Temperature and Pressure, and 
Saturated with water vapor.  The ambient temperature of the spirometer is usually lower than body 
temperature; this has the effect of cooling and contracting the volume of air exhaled into the 
spirometer. 
 
ATS is short for American Thoracic Society.  The ATS promotes accurate spirometers by 
recommending spirometry standards.   
 
BACK EXTRAPOLATION is the standard method used to determine "time zero" when measuring the 
FEV1.  The amount of slowly exhaled volume at the start of the maneuver excluded from the FEV1 by 
this technique is called the back extrapolated volume (BEV or EV).  The BEV should be less than 5% 
of the vital capacity, otherwise the maneuver is considered to have started too slowly. 
 
BTPS stands for Body Temperature (usually 37 degC) and Pressure, and Saturated with water vapor 
(100% humidity), which is the condition of air inside the lungs before it is exhaled into a spirometer.  
ATS standards require that volumes and flows be reported at these conditions. 
 
CALIBRATION SYRINGE is a large cylinder with a rubber sealed piston used to check the volume 
accuracy of spirometers.  The ATS recommends that it be 3.00 liters in size. 
  
COPD stands for Chronic Obstructive Pulmonary Disease, a general term for lung disease caused by 
cigarette smoking - a mixture of emphysema, bronchitis, and hyperreactive airways. 
 
EV (see Back Extrapolation)  
 
FET is short for Forced Exhalation Time.  The FET is displayed on the incentive screen as the 
maneuver "Duration," and should be at least 3 seconds.  
 
FEV1 is the most important spirometry variable, short for Forced Expiratory Volume in one second.  It 
is convenient to think of it as the volume exhaled during the first second of the FVC maneuver.  It is 
reduced with airflow obstruction. 
 
FEV1/FVC RATIO is the most sensitive and specific index of airways obstruction measured by a 
spirometer. 
  
FEV3 is the volume exhaled after 3 seconds.  It is always larger than the FEV1 but smaller than the 
FVC. 
 
FLOPPY DISKS are removable, rather slow, computer storage media.  The personal computer's 
floppy disk (drive A:) uses high density (HD) 3 1/2 inch floppy disks which can each store up to 1.44 
million characters (Mbytes). 
 
FLOW-VOLUME CURVE is the graph obtained from a forced exhalation maneuver plotted with flow 
on the vertical axis and volume on the horizontal axis.  When compared with the traditional spirogram, 
it has the advantage of allowing easy recognition of unacceptable or poorly reproducible maneuvers 
and disease patterns. 
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FVC is the Forced Vital Capacity, the volume of air exhaled during the maneuver named after it.  The 
subject takes as deep a breath as possible and then quickly exhales as much air as possible.  The 
FVC is reduced in obstructive and restrictive disorders. 
  
HARD DISK is the personal computer's fast, mass storage device (drive C:) which stores millions of 
characters. 
 
OBSTRUCTION is a decrease in maximal airflow  caused by airway narrowing.  The FEV1/FVC ratio 
and the FEV1 are both decreased. 
 
PEF stands for Peak Expiratory Flow, the highest flow measured during the FVC maneuver.  It is a 
good index of effort used at the onset of the maneuver. 
 
PF is short for Pulmonary Function (lung tests). 
 
PRED is short for the predicted value of a PF parameter.  It is determined from a regression equation 
from a large population study of supposedly normal people. 
 
RAM is very fast computer memory which "goes away" when the power is turned off.  Results are 
copied from RAM to a disk for permanent storage.  The personal computer has at least 640K of RAM 
memory. 
 
RESTRICTION is a decrease in lung volumes.  Scarring of lung tissue (fibrosis), severe heart failure 
(CHF), pneumonia, and morbid obesity are some of many causes.  The FVC is reduced while the 
FEV1/FVC ratio is normal or increased. 
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4.0 EQUATIONS 
 
BTPS Correction Factor (ATPS to BTPS):  [(273 + 37)/(273 + T)] x [(PB - PH20)/(PB - 47)] 
 
T = spirometer temperature (20-30 deg C) at the end of each maneuver 
 
PB = barometric pressure (625-760 mmHg) 
 
PH2O = water vapor pressure (17-30 mmHg) 
 
Factor to convert inches to centimeters:  Inches x 2.54 
 
To convert degrees F to Centigrade: (5/9) x (degF - 32) 
 
 
Prediction equations for healthy elderly women and men: 
 
   Equation   LLN 
  -------------------------   ----- 
MEN 
FVC  .0567 Ht -.0206 Age -4.37 -1.12 
FEV1  .0378 Ht -.0271 Age -1.73 - .84 
FEV1/FVC%          -.294 Age  +93.8      -11.7 
 
WOMEN 
FVC  .0365 Ht -.0330 Age -0.70 - .64 
FEV1  .0281 Ht -.0325 Age -0.09 - .48 
FEV1/FVC%          -.242 Age  +92.3      - 9.3 
 
volumes in liters, BTPS 
Ratio = FEV1/FVC x 100% 
Ht = height in cm 
LLN = lower limit of the normal range (fifth percentile) 
 
The above equations are from the healthy CHS participants during their baseline exam (3) and are 
valid for ages 65-85 
 
Reference equations derived from the NHANES III spirometry in healthy subjects will be used as well. 
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5.0 METHODS SUMMARY 
 
5.1 Daily Procedures 
 
Calibrate Instruments 

• Power-up computer and spirometer 
• Run leak and volume checks 
• Wash your hands 

 
Identify the participant 

• Enter name, ID number, age, height, weight 
 
Perform FVC maneuvers 

• Demonstrate the FVC maneuver 
• Obtain 3 acceptable FVC maneuvers 
• Review maneuver quality 
• Add comments 
• Print and store the results 

 
Clean Equipment at the end of the day 

• Clean breathing hoses 
• Rinse and dry hoses overnight 

 
 
5.2 Weekly Procedures 
 
Monday mornings 

• Run leak and volume cal checks 
• Perform a biologic control test 

 
Friday afternoons 

• Send data to Salt Lake City, Ut via e-mail attachments to LDRJENS@IHC.COM 
• Remove front plate of spirometer, clean with damp cloth and allow to air dry 
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6.0 DESCRIPTION OF THE PF WORKSTATION 
 
A dry-sealed spirometer is connected to a personal computer using a 12 bit analog to digital (A/D) 
interface. The spirometer is equipped with an optical shaft encoder  which changes the mechanical 
motion of the spirometer bell into a voltage which is proportional to exhaled volume.  An electronic 
sensor measures the spirometer temperature for automated BTPS corrections.  The A/D converter, 
mounted on a board inside the spirometer takes the analog voltages, converts them into digital 
numbers and sends them to the computer via an RS-232 serial interface.  The computer then 
calculates the exhalation time (FET) and airflow rates (FEV1) using a crystal controlled clock and 
stores all the results in RAM memory.  The results are stored on the hard disk, printed, and 
transmitted to the PFRC in Salt Lake City, UT. 
 
6.1 Main Menu 
 
The MAIN MENU is automatically displayed when the OMI software is run from the main windows 
desktop. Moving from one function to another is performed by going back to the MAIN MENU first.  
 
You usually move forward within a program by clicking the mouse when the mouse pointer is over the 
desired option or hitting the spacebar.  If you obtain a program or screen by mistake, you can usually 
get back to the MAIN MENU by clicking on the “CANCEL” or “EXIT” button. 
 
From the MAIN screen enter your 3-digit JHS code.  Please use your code each time you login and 
make sure everyone who uses the system uses their own code as well. 
 
Select the desired option from the MAIN MENU by placing the mouse cursor over the option and 
clicking the left button of the mouse. 
 
Refer to the OMI Spirometry Software Manual for additional information. 
 
6.1.1 Select/Add Patient  
 
Used to enter the name, ID number, age, height, etc for a new participant. 
The name of the "current participant" is then shown on the top colored bar of the program. 
 
6.1.2 Perform an FVC Test  
 
Guides performance of FVC maneuvers.  Flow-volume curves are displayed on the screen for quality 
control. 
 
6.1.3 Print the Report 
 
Prints a report for the participant and his/her physician and a tabular report for the participant's on-site 
JHS chart.  
 
6.1.4 SVC - Slow Vital Capacity 
 
If the participant can't perform good FVC maneuvers, the slow VC test should be done.  It requires 
very little effort. 
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6.2 Participant Information (Select/Add Patient ) 
 
Enter or verify the information requested in each box.  End each entry by pressing the ENTER key.  
All items listed below must be entered in order to calculate predicted values. 
 
Name Enter the participant's First name Last name  Use all capital letters.   
 
ID #   Enter the participant's JHS ID number and verify that it is correct.  If you enter it in error, 

use the backspace key to correct it. 
 
Date  Verify that the computer knows the correct date. 
 
Location Your Field Center's name should be here. 
 
Age  Enter the participant's birth date. 
 
Sex  Press M for male or F for female. 
 
Height  Enter the participant's measured standing height (in stocking feet) in inches. 
 
Weight  Enter their weight in pounds.  If computed BMI exceeds 27, you will be instructed to ask 

the participant to stand during spirometry maneuvers. 
 
Race  Enter the ethnic code: A for Asian, B for Black, C for Caucasian, H for Hispanic, I for 

American Indian, or O for other. 
 
 Note:  When based on standing height, predicted values for Asians and Blacks are 

reduced by 12%. 
 
Baro The average barometric pressure at your location (Barometric pressure should be 

entered in mmHg and is typically between 680 and 760 mmHg).  It should NOT be 
changed during a session, however, if a large storm or weather changes occur during the 
day a second entry should be made. 

 
Temp The spirometer temperature is measured by an internal sensor and displayed here.  Verify 

that it reads within 3 degC of an independent thermometer mounted close to the spirometer.  
Make sure the thermometer is not mounted close to any equipment that is warm or blows 
warm air.  We want to obtain a “Room Temperature” as accurate as possible. 

 
If the readings differ by more than 3 degC, call the PFRC.  If the spirometer temperature is below 17 
degC (60 degF), the room is probably too cold for testing.  Turn up the room's thermostat and blow 
into the spirometer yourself to warm it before testing participants.  
 
6.2.1 Help  
 
Some entries are verified to make sure they are within a reasonable range.  If your entry is rejected,  
a small window will pop-up indicating the error and how to correct it and explains the entry expected. 
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6.2.2 Editing   
 
If a mistake was made when entering information, use the mouse to move the cursor to the error. Then 
begin typing the information.  Press ENTER to complete the line.  The entry screen is shown below: 
 
Figure 1. Entry Screen 
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7.0 FORCED VITAL CAPACITY TESTING 
 
You, the technician, are the critical part of the pulmonary function testing system, since you must 
guide the participant through breathing maneuvers which are highly dependent on participant effort.  
You must coach the participant to inhale maximally and then to exhale maximally.  You also must 
judge the quality of his effort.  To obtain accurate results, the testing must be done in a standardized 
fashion. 
 
Note: This manual refers to the participant as "he" or "him" for easy reading.  Of course JHS 
participants are of either gender. 
 
7.1 Preparation 
 
Wash your Hands  Participants will appreciate your consideration if you make a point of washing 
your hands before testing them.  Do this as you enter the testing room if it has a sink, otherwise, just 
before you enter the room.  Another thing you can do to minimize the risk of cross-contamination is to 
store the fresh mouthpieces in a sanitary plastic box and ask the participant to use a Kleenex tissue 
to remove one for their use.  Then allow them to attach it to the clean breathing tube. 
 
Explain the Procedure  Explain that the purpose of the next test is to determine how fast and how 
much air he can exhale.  Explain that, as before, he should take in as deep a breath as possible, and 
when his lungs are completely full, quickly position the mouthpiece, and then BLAST out as hard and 
fast as possible. 
 
Position the Participant  Testing should usually be conducted in the sitting position; however, 
obese participants (BMI>27) should stand.  A chair (without wheels) should be positioned behind 
obese participants who stand for the test.  Use the chair if the participant becomes light-headed or 
faint during testing.  Ask the participant to sit erect with chin slightly elevated. 
 
Tight clothing, such as a tie, vest, or belt, which might restrict maximal breathing efforts, should be 
loosened.  Dentures, if they are loose, should be removed and placed in a clean denture cup, since 
they will prevent a tight seal from being formed around the mouthpiece.  If dentures are not loose, 
leave them in place. 
 
Always Demonstrate the Maneuver  Ask the participant to watch you perform the FVC maneuver.  
Again demonstrate correct placement of the mouthpiece.  Stand up straight.  Take a deep breath, 
throw back your shoulders, widen your eyes, and stand on your toes to emphasize the maximal 
depth of inhalation.  Then place the mouthpiece and dramatically BLAST out as fast as you can. 
 
Your vigorous demonstration will prevent time and effort from being wasted on unacceptable forced 
expiratory efforts which are caused by the participant's failure to understand a verbal explanation of 
the procedure. 
 
7.2 FVC Test Steps 
 
From the MAIN MENU, select Forced Vital Capacity.  Before the test is performed, the “Pre-Test 
screen” appears where the operator can enter the hose ID and change the type of test or the operator 
initials.  A database grid showing a summary of the previous test session results is also shown.  After 
making any changes or entries on this screen, the operator chooses to “Proceed with Testing”. 
 
The negator is usually engaged with the open circuit method forcing the spirometer piston to returned 
to zero volume.  If the computer detects that the volume in the spirometer is greater than zero, then a 
message will be displayed to either “attach the negator or return the spirometer piston to zero 
volume.”  Operator should assure that spirometer reading is zero or return to main screen and follow 
instructions to “Zero Volume.” 
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Step 1 The FVC Incentive screen will then be displayed. A window will prompt Start Test? When 
ready, the operator clicks OK.  A “Wait, Checking Spirometer” message will appear/flash 
in red on the screen.  Wait until the message disappears. 

 
Step 2 Tell him to "take in as deep a breath as you possibly can, then put the mouthpiece in your 

mouth."  Watch him as he does so and then coach him: "now inhale a little bit more," until 
you are sure that his lungs are full. 

 
Step 3 Shout "BLAST OUT !!! 

Lower your voice a bit and say "keep going for at least 6 seconds" 
 
Watch the body language of the participant as he attempts to follow your instructions.  Pay attention 
to him, not the instrument. 
 
Encourage him to blow out smoothly without re-breathing. 
 
Once a maneuver is completed, depending on the options selected in the “OMI98Setup” menu, the 
parameters are calculated and the various quality checks are applied.  A results screen is then 
displayed on a table that lists: Trial Number, FVC, FEV1, PEF, Corresponding differences from the 
largest observed values (expressed in milliliters and as a percentage), and a 6-item acceptability 
code.  All of the flow-volume curves are also displayed (superimposed on top of each other or offset 
(optional) along with the table of values and quality codes.  The last maneuver is highlighted from the 
other flow-volume curves in blue and the best curve is displayed in lime (green).  All of the remaining 
curves are displayed in black.  Any deleted or unusable curves (cough or large extrapolated volume) 
are displayed in red.  Analyze the flow-volume curve produced by this maneuver.   
 
If after the initial demonstration, the participant fails to perform the maneuver correctly, again 
demonstrate both the error and the correct performance yourself.  You may have to repeat the 
demonstration after every maneuver for some participants. 
 
Your goal is to obtain at least 3 good maneuvers, 2 of which match each other closely.  The quality 
assessments are conducted and corresponding messages displayed for the operator to consider 
when coaching the client on any additional maneuvers.  The quality assessment information should 
be used by the operator to judge whether a curve should be accepted or rejected.   Curves previously 
obtained during the current session may also be reassessed based on better curves being achieved 
after them.   Clicking on the quality code box, a popup window is displayed allowing the user to over-
ride any acceptability code or delete the curve.  This same popup window also provides a legend of 
the acceptability codes.  The reproducibility criteria, selected using the “OMI98Setup” program, is 
applied and a message as to whether the test is reproducible is displayed.  The operator now 
chooses to proceed to perform another maneuver (“Do More Tests”), or proceed to test completion 
procedures (“Done”). 
 
7.3 Review the Results 
 
After the participant has performed three apparently good FVC maneuvers, review the results.  From 
the menu bar “Preform/Review Tests” select “Review Test”.  The “Review Test” menu item is used to 
review the results of a client’s data collected in previous test sessions.  The screen displayed is 
essentially the same screen displayed at the completion of each maneuver during test performance.  
This menu item also is used to edit the acceptability of individual maneuvers performed by a client.  
“Review Test” is when a maneuver which was rejected should have been included in the report.  For 
example, if a maneuver was terminated prematurely and the FEV1 from that maneuver was valid, it 
may be appropriate to include this unacceptable maneuver in the report.  Similarly, this menu item 
can be used to change a maneuver/s rating from “acceptable” to “unacceptable” e.g., in the case of a 
variable effort.  If this editing is performed after a testing session, a record of the operator who made 
the last change is saved in the client information results file -- see Acceptability Screen for additional 
details.   
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The "best" maneuver is the one with the highest sum of FVC + FEV1. 
 
If you still don't have 3 good maneuvers, press the Spacebar twice to perform another maneuver.  If 
the quality and reproducibility of the 3 maneuvers displayed looks good, and you think that you might 
be done testing, press the F10 key. 
 
7.3.1 Maneuver Quality Review Window (F10) 
 
The best three maneuvers are again indicated at the top of the columns.  First look at the bottom row 
marked QC.  Any letters there are maneuver Error Codes which mean that the maneuver was not 
acceptable or reproducible, and that more maneuvers should be performed.  Press the F1 key for an 
explanation of these codes.  Press the Spacebar twice to resume testing. 
 
Numbers listed under the Stored Values column are the highest obtained from all maneuvers 
performed and will be printed on the report.  The number listed under the (%) column for each 
maneuver (Trial) is the percent of the highest value. 
 
If all 3 maneuvers are "Good tests", you have obtained enough FVC maneuvers, and should press 
the Esc key to store the results.  The hard disk light will illuminate as the results are stored, and you 
will be returned to the MAIN MENU. 
 
7.3.2 FVC Maneuver Acceptability 
 
According to the ATS standards, you should coach every participant to obtain at least three 
maneuvers that are "acceptable" and two that are "reproducible."  The criteria for acceptability and 
reproducibility are described below.  The accuracy of results depends much more on the quality of the 
maneuvers than on the instrument calibration. 
 
7.3.3 Acceptability Messages 
 
Errors in FVC maneuver performance are identified by the computer and displayed in the F10 QC box: 
 
QC Message   Criterion 
 
S Start faster   BEV > 5% FVC 
P BLAST out harder  PEFT >120 msec 
C Avoid coughing   >50% drop 
T Blow out longer   FET < 3 sec 
A Blow out more air  Abrupt termination 
 
After the first maneuver, reproducibility messages are also displayed on a line at the bottom of the 
screen prior to the next maneuver if the current maneuver's result was lower than the previous 
highest value from an acceptable maneuver: 
 
d Deeper breath   dFVC  > 0.20 L 
f Blow out faster   dFEV1 > 0.20 L 
h Blow out harder   dPEF   > 2 L/s 
 
Notes:  QC = error code displayed in the Review QC window - F10 key. 

BEV = back extrapolated volume 

dPEF, dFVC, dFEV1 = the difference between the current maneuver's value and the highest 
value from any other acceptable maneuver from the testing session 
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7.3.4 Maximum Number of Maneuvers   
 
Don't exhaust the participant by asking them to perform more than FIVE FVC maneuvers.  If you 
haven't obtained 3 acceptable maneuvers by the time you have done five maneuvers, it is unlikely 
that you will.  Only make 2 additional attempts if you and/or the subject clearly made a mistake such 
as a “false start”.   Make a note of the reason why the participant could not perform the maneuvers in 
the Comment Screen later. 
 
The following figures show examples of flow-volume curves from acceptable and unacceptable 
maneuvers. 
 
 
Figure 2. Flow-Volume Curves (#1) 

 
 
 
Figure 3. Flow-Volume Curves (#2) 
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Figure 4. Flow-Volume Curves (#3) 

 
 
7.4 End Test Session 
 
After you have performed all of the maneuvers, congratulate the participant for a job well done and 
tell him that the results will be explained to him at the end of the visit.  Do not attempt to explain them 
to him yourself. 
 
7.5 Print Current Test 
 
Get the printer ready to print the report.  In general, the printer will be connected to the computer and 
should not require any assistance.  Keep an “eye” out for a toner cartridge that is failing and replace 
as needed.  You can always return to a patient’s data and re-print the report.  
 
The “Print Current Test” menu item allows the operator to immediately print the results for the current 
client, without going to the “Print Report” menu. 
You will then be asked if you have any comments.  If anything unusual happened during the testing, 
enter your comments on the two lines provided. 
 
The report will then be printed to place in the participant's JHS file.  We do not plan to give a full-page 
spirometry report to the participant this year. 
 
7.6 Printing Reports 
 
The “Print Report” main menu item is used to print all tests results.  The “Print Current Test” menu 
item under “Perform/Review Test” is  used, while client information and results are still current in the 
computer.  The right mouse button can also be clicked to display a pop-up menu with the “Print 
Current Test” menu item.  The “Print Report” menu items are most useful for printing results for a 
group of clients or a group of tests conducted on an individual client.  The details of each of the “Print 
Report” sub-menus are described below. 
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8.0 LEAK AND CALIBRATION CHECKS 
 
8.1 Leak Test 
 
This option is a submenu item under the main “Calibration” menu.  The leak test screen is shown on 
the right.  A leak test is performed by checking that the negator (return spring) is engaged and then 
adding approximately 3 liters of air into the spirometer with a calibrating syringe (or pulling the piston 
back, adding volume and placing a stopper in the hose.)  Click on “Start Timing” The computer will 
then monitor the spirometer volume for 60 seconds and determine if the volume is maintained. (no 
excessive leak within user-selectable acceptable limits, default 76 milliliters.)  A progress bar shows 
the time left until completion of the leak test.  The results of the leak test are written to a 
calibration/leak test log file, including the date and time of the test, by clicking on the “save” button.  
Because of the possibility of a leak in the hose, the hose identification number should be entered and 
is saved in the calibration log file. A warning is displayed if a leak larger than the “Leak Tolerance” is 
observed.   
 
If a Leak is Detected  Determine whether the leak is in the breathing tube, the blue internal tube, or 
in the spirometer bell as follows: 
 
1. Disconnect the breathing tube from the spirometer.  Pull the spirometer guide bar back halfway 

and insert a rubber stopper into the metal breathing tube connector at the front of the spirometer. 
 

2. Start the leak test again. 
 

If the Leakage Rate is now less than 40 cc/min, then the breathing tube is the source of the leak.  
Discard it and check the new one for leaks.  If, however, the Leakage Rate is still larger than 40 
cc/min, then the rolling seal or the front plate is leaking. 

 
3. First remove the front plate and re-grease the large O-ring with a light grease (petroleum jelly or 

equivalent) and retighten the plate.  Rerun the leak tests. 
 

If this does not remove the leak, the rolling seal is probably at fault and you need call OMI at 
(800) 869-6783 for technical assistance. You can also phone the PFRC at (801) 408-3146, or 
(801) 408-3142.  

 
8.2 Volume Calibration Check 
 
“Calibration Check” can be accessed using the “Perform Cal Check” button on the main screen or in 
the “Calibration” menu.  A calibration check should be performed daily, using a 3-liter calibrating 
syringe. (NOTE: When injecting air from the syringe, do not “Slam” the syringe at the end of the 
injection by pushing the air out too vigorously as this may cause erroneous calibrations.)  Check that 
the “Current Volume” is zero before adding any air into the spirometer. Fill the calibrating syringe and 
connect it to the spirometer hose. Click on “OK” or type any key, inject the full 3-liters from the syringe 
into the spirometer, and then pull back on the syringe. The computer determines the volume injected. 
The operator then verifies the calibrating syringe’s volume and the computer compares this volume 
with the volume measured by the spirometer.  If a chart drive is available, the operator can enter and 
“Save” the chart drive reading as well.  The American Thoracic Society recommends an acceptable 
limit of  + 3 percent of the syringe volume.  The computer displays the difference between the syringe 
and spirometer-determined volume in both absolute volume and as a percentage.  As with the leak 
test results, the calibration test results are written to the calibration database file as “Save” is clicked.  
A warning is displayed if there is a failure in the calibration check. 
 
Possible reasons for the volume check to fail (in order of decreasing likelihood) include: 
 

• Failure to completely fill and/or discharge the syringe into the spirometer.  Make sure the 
syringe clicks against the stops with each stroke. 



16 

Exam 1 Pulmonary Function Assessment Manual.doc 

 
• Differences in the air temperature between the spirometer and the syringe.  Reflush and 

repeat the check. 
 

• An air leak in the calibration syringe.  Fill the syringe, plug the end with the rubber stopper 
and try to empty the syringe.  If the plunger moves inward, this indicates a leak in the syringe 
seal.  Call the PFRC to replace the syringe. 

 
• A large flow number (beyond -20 or +20 liters/sec) may indicate a problem with the 

A/D interface.  Call the PFRC to discuss this. 
 
8.2.1 Print Calibration 
 
This option, under the “Calibration” menu, will print the calibration results to the printer using all dates 
or a selected date range.  This report includes leak, volume calibration check, linearity and time check 
results. 
 
8.3 Linearity Check 
  
This option, under the “Calibration” menu, allows the operator to conduct a linearity check of the 
spirometry system.  Linearity checks are usually performed quarterly.  The definition of Linearity is: of 
or pertaining to a straight line. The SensorMedics 922 measures volume using a digital encoder or a 
potentiometer. If this volume is displayed on the chart recorder graph paper 1 liter is equal to 10mm, 
therefore 2 liters equals 20mm and 3 liters equals 30mm, etc.  If graphed, these volumes would be a 
straight line graph. The significance of the linearity check is to show that the spirometer is in 
calibration along its entire volume range,  This means if a person blows into the spirometer his or her 
volume will be measured accurately across the entire graph.  Daily calibration checks the range from 
0 to 3 liters.  The OMIS98 linearity calibration checks the volume from approximately 2.5 to 5.5 liters 
or across the middle portion of the spirometer volume measurement.  This measures the linearity 
over the most significant portion of the volume most people can expire.  Linearity calibration can be 
performed using any volume intervals. (However, when using initial volumes other than 2 to 2.5 liters, 
a red line will appear indicating the initial volume, but the blue line on the screen will not disappear.) 
 
NOTE:  This procedure is most easily performed with two people.  One to pull the spirometer piston 
back to the desired initial volume and hold it until the other connects the syringe to the spirometer 
tubing. The 3 liter syringe volume is then injected and withdrawn from the spirometer.  If only one 
person is available to perform this procedure, the negator (return spring) may be disengaged so when 
the spirometer piston is pulled back it will remain at the selected volume while the syringe is attached 
to the spirometer. If the negator is disengaged, remember to re-engage it before testing. 
 
On the first screen after checking that the “Current Volume” is zero, click “OK.”    Fill the spirometer with 
approximately 2 to2.5 liters of air by pulling the spirometer piston back from the rear of the spirometer (or 
by using  a one-way valve and a calibrating syringe.)  When the correct volume of air is added the blue 
line on the left of the screen will disappear.    Maintain this volume of air in the spirometer by holding the 
piston rod (or disengaging the negator).   Attach a full syringe of air to the spirometer hose.  Following the 
instructions on the computer screen, inject and then withdraw the 3-liter syringe volume.   The computer 
will determine the volume injected and compare this volume with the volume measured by the spirometer.  
The linear calibration test results are written to the calibration database file as “Save” is clicked.  A 
warning is displayed if there is a failure in the calibration check 
 
 



17 

Exam 1 Pulmonary Function Assessment Manual.doc 

9.0 CLEANING THE SPIROMETER 
 
9.1 Clean the Breathing Tubes 
 
This should be done at the end of each day of testing.  First wash them in warm soapy water, rinse, 
roughly dry, then soak them in the disinfectant solution for at least 30 minutes.  Be sure to wear 
protective rubber gloves and eye protection when using the disinfectant since it causes a rash in 
some persons.  Rinse thoroughly and hang them to dry completely overnight before reusing.  These 
procedures should be done in accordance with the established procedures in you institution. 
 
9.2 Clean the Spirometer 
 
This should be done every Friday afternoon following these steps: 
 
1. Disposable gloves should be worn when cleaning.  Eye protection should also be worn when 

handling the dilute bleach solution.  The disinfectant used will be a standard commercial liquid 
bleach (5.25% sodium hypochlorite) diluted 1:10 with water (1 part bleach to 9 parts water). 

 
2. Unplug the power cord and remove any electrical connections to external devices.  Detach the 

breathing tube. 
 
3. Clean external surface with a mild detergent and warm water; rinse and wipe dry with a soft cloth. 
 
4. Disconnect the auto-return negator. Remove the front plate of the spirometer by loosing the 

thumb screws on the front.  Carefully reach inside the spirometer and push the piston back to its 
maximum position. 

 
5. Wash the front plate with a small amount of mild detergent on a wet cloth.  Then rinse the front 

plate and wipe dry with a clean cloth. 
 
6. Carefully clean the inside of the with a damp cloth that has been dipped in a 10% bleach solution 

and squeezed dry.  Wipe the inside walls of the spirometer using a light touch.  Warning: do not 
get water or bleach solution in the joint of the rolling seal.  Wipe again with a cloth 
moistened with clean water (squeeze dry each time) to remove the bleach solution and dry 
with a  dry soft cloth. 

 
7. Allow the front plate and spirometer to air dry for the weekend. 
 
8. Once the cylinder is dry, lubricate the cylinder with a small amount of starch-base powder 

(SensorMedics, Part No. 768541).  Apply sparingly using a gloved hand.  Remove excess with a 
small vacuum. Warning: do not use talc-based powders.  Inhalation of talc may cause lung 
injury. 

 
9. Replace the front plate.  You should place a small amount of silicone based lubricant on the O-

ring before, reposition the plate and tighten the thumb screws gradually in a clockwise fashion a 
little at a time until they are “firm” 

 
 
9.3 Calibration Syringe Care 
 
The 3.00 liter calibration syringe should be stored next to the spirometer so that it remains at the 
same temperature as the spirometer.  Store the syringe with the plunger pushed all the way in.  Take 
care not to drop the syringes. 
 
DO NOT attempt to make any adjustments to the syringe.  Do not loosen the metal rings on the 
shafts, since this will spoil the factory calibration.  The accuracy of each syringe will be verified by 
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returning it to the manufacturer for measurement of its water displacement at the beginning of the last 
year of testing or whenever any evidence of physical damage to the syringe is noticed. 
 
You should periodically check each syringe for leaks.  Fill it with air, hold your palm against the outlet 
snout, and try to empty it.  If you can expel any air with the outlet plugged, the syringe has a leak and 
must be repaired. 
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10.0 TECH CERTIFICATION 
 
The certification examination includes 50 multiple choice questions based on this Manual of 
Procedures, and a practical demonstration of skills including leak and calibration checks, cleaning, 
and testing of a naive subject (50 points).  A passing score of at least 75 points is necessary for 
certification.  Only certified technicians will perform pulmonary function testing in this study. 
 
Certification of new technicians after the initial central training session may be performed by a 
centrally trained, certified PF technician.  The written exam will be administered locally, and the first 
10 PF tests performed will be observed by a certified PF technician and then examined by the PFRC 
and found to be satisfactory before the new technician is certified.  The results of the first 50 
spirometry test sessions performed by each technician will be closely examined  at the PFRC.  
Copies of sub optimal quality test sessions with comments for improvements will be mailed to the 
technician the same day as they are evaluated. 
 
A site visit to the clinical center may be made early during the exam year.  Complete calibration, leak, 
and complete PF testing of at least three participants by each PF certified technician will be observed.  
Copies of sub optimal quality test sessions will be reviewed.  More efficient methods as well as 
protocol violations will be discussed during the site visits and later in a written report. 
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11.0 QUALITY CONTROL 
 
11.1 Need for Spirometry QC  
 
Examination of spirograms from the Framingham study revealed that more than 18% were of clearly 
unacceptable quality (11).  Two more recent studies, with over 12,000 adults each, found that 40 - 
50% of the spirometry maneuvers were of unacceptable quality (12-14).  Manual measurements from 
spirograms are tedious and prone to error (15), and deviations in test performance and lack of regular 
leak checking and calibration can result in loss of study data (16-18). 
 
The Epidemiology Standardization Project (19), the new American Thoracic Society spirometry 
standards (20), and recent evaluations of commercially available spirometers emphasize the importance 
of spirometry quality control procedures.  Factors which affect spirometry quality (22) include: 
 
1. Participant 
2. Maneuvers 
3. Technician 
4. Equipment 
5. Analysis 
 
11.2 Feasibility of QC Procedures  
 
Personal computer systems, such as the S&M Instruments system used by the JHS, have been 
developed and validated by an unbiased University testing program (21).  The software assists the 
pulmonary technician with quality control of maneuvers, calculates the PF variables, suggests 
interpretations, formats and prints reports, and compresses graphics data for transmission and archival 
storage (23).  The Lung Health Study (24), Cardiovascular Health Study, Framingham Study, and ARIC 
studies have used similar systems and procedures since 1987.  The computerization of spirometry QC 
procedures dramatically decreases the overhead time associated with spirometry testing. 
 
11.3 Implementation of QC Procedures  
 
There are five separate levels of quality control implemented for spirometry testing which address the 
five factors known to influence the results: 
 
1. Daily spirometer leak and calibration checks using a 3.000 liter syringe as the "gold standard" 

check the equipment accuracy. 
 
2. Eight computerized checks of FVC maneuver acceptability and reproducibility check every 

maneuver immediately after it is performed. 
 
3. The PF technician is trained to recognize the patterns of unacceptable maneuvers, watching 

the participant during the performance, and reviewing the colorfully displayed flow-volume 
curves on the computer monitor. 

 
4. The results of the leak and calibration checks and the FVC maneuvers are stored and sent to 

the PFRC for review by the PF QC Supervisor.  Monthly reports are compiled for each 
technician's performance. 

 
5. Results from all of the above are taken into account during the analysis of the data by the 

PFRC (3,24).  The calibration factors, PF tech's impression of participant and maneuver 
quality, and the QC supervisor's impression of test session quality are all integrated to obtain 
the final FEV1 and FVC results reported to the Data Coordinating Center. 

 
6. Replicate testing will be performed on a total of 30 participants scattered throughout the 

recruitment period.  Choice of the participants will be by the Field Center staff, usually a 
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participant who did not complete an exam and must return on another day to finish it.  
Spirometry should then be performed again by a different PF technician.  The PFRC will then 
examine the two sets of results for reproducibility. 

 
7. After instrument QC checks, a biologic control subject (nonsmoker without asthma) will be 

tested each Monday morning (the Field Center Supervisor is preferred).  The results will be 
compared with their prior mean values for FVC and FEV1.  
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12.0 QC ANALYSIS AND REPORTING 
 
Each week the Field Center will backup all PF data for participants tested during the previous week 
and the calibration result files.  These backup files will be e-mailed to the PFRC.  The e-mail address 
is LDRJENS1@IHC.COM.  This is Dr. Jensen’s address. 
 
At the PFRC, the result files are read by the PF QC workstation.  The PF QC workstation displays the 
FVC maneuvers from a test session as differently colored flow-volume curves superimposed at the 
onset of each maneuver.   
 
The field center and the PF technician who performed the testing are hidden from the QC Supervisor 
to avoid bias.  The spirometer temperature is displayed and is highlighted if it falls outside the 17-33 
degree C range, since BTPS corrections for volume spirometers become less accurate outside of this 
"normal" range (27). 
 
After evaluating the flow-volume curves and the array of results, the QC supervisor indicates her 
choice of the single best maneuver, and enters a test session QC grade from A to F for flow (PEF), 
FEV1and volume (FVC).  A flow grade of A is entered if at least 3 maneuvers demonstrate sharp 
peak flows and if the best two have very reproducible PEFs.  A FEV1 grade is given when the 
difference between the two best test is less than 100 ml, and a grade of A is given to FVC (volume 
score) when the difference between the two best FVCs is less than 100  ml. 
 
After over reading a batch of test sessions, the QC grades are added to a QC database.  All sessions 
with either a volume or flow grade of C or less or with a spirometer temperature outside the normal 
range are printed, comments are added by the QC Supervisor, and a cover letter is added and mailed 
to the technician who performed the test.  The final, over read PF results are generated and sent by 
mail to the Coordinating Center at least monthly. 
 
At the end of each month, a report is generated from the QC database, summarizing the performance 
of each PF technician.  For each PF technician, the report includes the number of sessions reviewed 
and their average QC grades.  The report is mailed each month to the Principal Investigators and to 
all PF technicians. 
 
12.1 Weekly Biologic Control 
 
Perform a normal FVC test. Use the same technician and the same ID number for all tests.  It should 
be 999xxx where xxx is the technician's 3 digit ID code.  Perform FVC maneuvers as if testing a 
participant.  Store the results and then review the trends.  Ensure that your current FEV1 is within %5 
of the mean of your previous values. 
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13.0 ANNUAL INSTRUMENT CHECKS 
 
Prior to the onset of each exam year, the following items will be checked by the PFRC to ensure 
spirometer accuracy: 
 
1. Spirometer temperature sensor accuracy - A thermometer accurate to within 0.1 deg C is 

placed inside the spirometer bell and allowed to equilibrate for an hour.  The temperature 
displayed by the spirometer on the INF screen is then compared with it.  If there is more than a 
0.3 deg C discrepancy, the correct temperature is entered by using the up arrow to move the 
cursor to the temp box and entering the correct temperature.  The new temp cal factor is then 
noted using the EQU command. 

 
2. Volume linearity - The linearity of the spirometer throughout its volume range is checked using 

a 1.00 liter calibrated syringe with internal one-way valves (Vitalograph).  The LIN command 
invokes a program which directs the operation of this check.  A worst-case linearity of 0.2% is 
the threshold of acceptability. 
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15.0 EQUIPMENT AND SUPPLIES 
 
Attach the spirometer cable to the computer with the two screws on the connector, otherwise it will fall 
off easily.  Attach the printer cable to the rear of the PC.  Attach all power plugs to the switched outlet 
strip. 
 
PF Workstation Major Components 
 
1. OMI dry rolling seal spirometer 

• optical shaft encoder, temperature sensors,  
• serial data cable 

 
2. 3.00 L calibration syringe 
 
3. Personal computer, Windows OS 

• OMI S98 Spirometry Software 
• At least a 1GB Hard Disk 

 
4. Inkjet printer 

• parallel cable, power strip 
 

5. Color monitor with cables 
 
Spirometry Supplies 
 
• Mouthpieces, 1 & 3/8 inch cardboard (regular size), qty 500 
• Small mouthpieces, 1 inch (optional size), qty 100 
• Sanitary clear plastic storage box for mouthpieces 
• Noseclips (qty 10) 
• Breathing hoses, 36" long (qty 10) 
• Denture cups (qty 30) 
 
The tool kit includes 
 
• Small screwdriver 
 
Other supplies to be purchased locally 
 
• Standard size copier paper for the printer 
• Detergent and cleaning bucket 
• Disinfectant solution (5% bleach mixed 1:10 with water) 
• White vinegar, Distilled water 
• Alcohol wipes, Cleaning cloths, Q-tips 
• Water pitcher, 1 quart size 
• Spare inkjet cartridges 
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16.0 COMPUTER INTERPRETATION 
 
 
The Printer Workstation will compare the observed values to those predicted by the JHS baseline 
data from the healthy participants (27), and then interpret them based on the American Thoracic 
Society recommendations for disability testing (28): 
 
Interpretation:                   Criteria 
--------------------------  ------------------------------------- 
Normal spirometry:  FEV1/FVC ratio >70% and FEV1>80% pred 
     and FVC >80% pred 
 
Borderline obstruction:  FEV1/FVC ratio < 70% but FEV1>80% pred. 
 
Mild obstruction:  FEV1/FVC ratio < 70% and FEV1 60% to 79% pred. 
  
Moderate obstruction:  FEV1/FVC ratio < 70% and FEV1 of 41% to 59% pred. 
 
Severe obstruction:  FEV1/FVC ratio < 70% and FEV1 < 40% pred.  
 
Reduced vital capacity:  FVC < 80% pred, in addition to obstruction. 
 
Mild restriction:   FVC 60% to 79% pred, with FEV1/FVC ratio > 70% 
 
Moderate restriction:  FVC 51% to 59% pred, with FEV1/FVC ratio > 70% 
 
Severe restriction:  FVC 50% or less than pred with FEV1/FVC ratio > 70% 
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Appendix 1 OMIS98 Spirometry Troubleshooting Guide 
 
 
 

 
PROBLEM 

 
POSSIBLE SOLUTION 

 
OMIS98 Setup Program asks for password. 

 
The default system password is omisetup - all 
lower case letters, all one word.  It is suggested that 
you do not change this password. 

 
Cannot enter OMIS98 Spirometry Program 
because it asks for a password. 

 
Screen 3 of the OMIS98 Setup Program sets 
option for use of password or no password. .  If you 
do not want to use password uncheck the option. If 
you choose to use passwords set up passwords on 
this screen. Exit and save data after making choice. 

 
When performing calibration get Waiting 
Interface slow to respond window. 

 
Computer is not able to read interface. 1.)Check all 
connections to make sure they are correctly 
installed and are firmly connected.  (See hardware 
installation diagram.) 
2.)Is the green light on the interface lighted? (If not, 
is the power cord plugged into a power source?) 
3.)Is the Communications Port selected in the 
OMIS98 Setup Program menu the correct port that 
the serial cable is plugged into?  (Screen 2 in 
OMIS98 Setup Program) 

 
Volume zero must be established, position 
spirometer to zero or attach negator message. 

 
Check to make sure that spirometer piston is 
pushed all the way in and pen is reading zero.  On 
main OMIS98 Spirometry screen select the 
Setup menu.  Select Zero Spirometer  Click 
on OK to reset zero. 

 
Warning: Ambient temperature:___, Spirometer 
temperature:___.  These should be within 3 
degrees message. 

 
This alerts you that the temperature where your 
spirometer is located has changed from the range 
preset to represent your normal ambient 
temperature. You may reset the ambient 
temperature or the preset limit of variation using the 
Setup menu on the main OMIS98 Spirometry 
screen.  Select Enter Ambient temperature or 
Enter Temperature Limit selections. 

 
Leak Check failure 

 
1) Check connections: between syringe and 
spirometer tubing;  between spirometer tubing and 
spirometer.  
2) Change to a different spirometer tube. 
3) Remove spirometer tube and perform leak check 
by manually adding air to spirometer and sealing at 
snout plate using a rubber stopper. 
4) Check snout plate where spirometer tube is 
attached to see that all screws are finger-tight plus 
another 1/4 to  turn.  
5) Remove snout plate and check o-ring. Lightly 
lubricate o-ring and replace.  Rotate snout plate 
one-third turn. 
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6)Check the screws around the middle of the 
spirometer that they are not loose or overly 
tightened. 

 
Calibration failure 

 
1. Check that beginning volume is zero. 
2. Be sure that you are injecting the full syringe 
volume and that you do not slam the syringe at 
the end of calibration. 

 
Predicted and % Predicted values do not appear on 
report. 

 
1) Were predicted tables chosen in the OMIS98 
Setup Program?  Before using program, you must 
choose Caucasian predicted table and/or predicted 
or scale factor for other races. 
2) Did you enter all of the following parameters 
correctly: Race, Age, Sex, Height? 
3)Does the age exceed the limits of the predicted 
tables? (Too young or too old) 

 
Observed values do not appear on report but 
predicted values are there. 

 
None of the client curves performed were 
acceptable curves.  At least one of the curves 
MUST be acceptable for the values to be saved.  1) 
Repeat test after re-instructing the client. Or 
2) Override a unacceptable curve if in your opinion 
it is the best the client can do.  To override an 
unacceptable curve see 7.04 Acceptability Screen 
Codes. 

 
Entered wrong Social Security Number or ID 

 
This number CANNOT be changed.  Double check 
this number before entering and testing.  Test 
values can be manually entered using the OMIS98 
Utility program but the graphs cannot be transferred 
to the manually entered test results. 

 
Entered wrong client information other than ID. 
(Wrong age, height, weight, race, gender, etc.) 

 
These can be corrected on the Client Information 
Screen.  Entering the correct information will correct 
on any future tests but will not correct tests already 
completed. To correct previously completed tests 
you must Edit Session Summary Data in the  
OMIS98 Utility Program.   

 
Program already running! Check icon bar 
message. 

 
1) Close program using x in upper right of 
screen.  Check icon bar to see if program running.  
Open from icon bar if it is present there. 
2) If problem continues, reboot computer. 

 
Printer problem 

 
1)Check printer is on.    
2. Check printer cartridge or ink. Check paper 
supply and path. 
2)Check printer setup in Windows program. 
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Appendix 2   Barometric Pressure Values 
 

Note: If as an alternative, you choose to obtain and enter barometric pressure directly, make certain 
that it is not corrected to sea level, which is the way that the weather service normally reports it. 

Elevation Pressure  
 

Elevation Pressure 
(feet) (mmHG)  (feet) (mmHG) 
-1000 790  

 
7200 582 

-800 784  
 

7400 577 
-600 778  

 
7600 573 

-400 772  
 

7800 568 
-200 766  

 
8000 564 

0 760  
 

8200 560 
200 754  

 
8400 556 

400 749  
 

8600 551 
600 743  

 
8800 547 

800 738  
 

9000 543 
1000 733  

 
9200 539 

1200 727  
 

9400 535 
1400 722  

 
9600 531 

1600 717  
 

9800 527 
1800 711  

 
10000 523 

2000 706  
 

10200 519 
2200 701  

 
10400 515 

2400 696  
 

10600 511 
2600 691  

 
10800 507 

2800 686  
 

11000 503 
3000 681  

 
11200 499 

3200 676  
 

11400 495 
3400 671  

 
11600 491 

3600 666  
 

11800 487 
4000 656  

 
12000 483 

4200 651  
 

12200 479 
4400 647  

 
12400 475 

4600 642  
 

12600 471 
4800 637  

 
12800 467 

5000 632  
 

13000 463 
5200 628  

 
13200 459 

5400 623  
 

13400 455 
5600 618  

 
13600 452 

5800 613  
 

13800 449 
6000 609  

 
14000 446 

6200 604  
 

14200 443 
6400 600  

 
14400 440 

6600 595  
 

14600 437 
6800 591  

 
14800 435 

7000 586  
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Appendix 3 Quality Check Messages 
 
After test completion the screen will appear. On this screen the operator indicates client effort, testing 
position, reactions, and adds any comments he/she would like to make.  

 
Extrapolated volume too large 

Either 5% of FVC or 150 (100 milliliters optional) milliliters, whichever is greater.  Since a 
curve with a large extrapolated volume cannot be used, the operator is notified 
immediately during the testing procedure if the extrapolated volume is excessive.  Since 
FVC must be used to calculate excessive extrapolated volume, the largest FVC 
previously observed for this client is used.  This immediate check is not possible for the 
first maneuver performed by the client. 

 
Plateau not detected 

If a plateau is not detected during the FVC maneuver, then the plateau not detected 
message is displayed.  

 
FET Less < 6 s 

If the forced expiratory time of the test is less than six seconds and the user has selected 
this option, then the message is displayed. 

 
Low Peak Flow 

A low peak flow message appears if a maneuver with a low peak flow is detected. 
 
Cough 

If the client has coughed during the first second of exhalation, then the Cough message 
is displayed.   

 
Time-to-PEF 

The time required to reach PEF is measured and a message displayed if it exceeds the 
cutoff value established in OMI98Setup program. 
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